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FEATURES AND AREA OF APPLICATION 

T-FLEX CAD is a parametric design and drawing system. T-FLEX provides high levels of drawing flexibility 

and supports modifications of the drawings while maintaining constraints imposed by the designer on 

the drawing elements. The unique parametric engine and a complete set of professional tools for 

computer-aided design simplify the design workflow and speed up preparation of drawing materials. T-

FLEX CAD gives a designer a familiar feel of working with traditional paper and ruler equipment. 

Associative design driven by assigning and modifying variable parameters is the way to follow by all 

design and drawing automation systems. The particular success of T-FLEX CAD is based, in the first place, 

on the new paradigm of geometric modeling. This paradigm is about a new, deeper, level of 

parameterization, compared to other systems. The idea of parameterization itself has nowadays become 

a standard in CAD. By “parameterization” we usually mean a provision for a drawing extensive reuse by 

means of modifying its parameters. Virtually all CAD vendors claim parametric capabilities of their 

systems. However, these systems, originally introduced long before parameterization was adopted, often 

use their legacy data structures that are inherently non-parametric. This causes their solutions to suffer 

from ineffectiveness or limited range of applicability. The T-FLEX CAD’s revolutionary approach to the 

idea of parameterization and the fact that the drawings are based on inherently parametric models 

provide a new dimension for parametric design.  

T-FLEX CAD uses concepts and practices that are familiar to designers. At the same time, the user does 

not need to care about making a precise drawing at once. The modification capabilities via both 

dimensioning and free dragging are unmatched across other CAD systems. 

The assembly drawing environment is unique in its wide range of capabilities. T-FLEX CAD permits 

creating complex drawings where certain fragments can be bound by relations. A relation can be 

established either via geometrical properties or by parameters. The system correctly handles lines 

visibility throughout modifications, if some portions of the drawing overlap the others, with no limitation 

on the number of overlaps. It takes seconds to create drawings of a new product in a family by varying 

assembly drawing parameters. The modifications instantly reflect not only on the assembly but also on 

the member fragments (parts) and all the rest of the related documentation. 

One typical attribute of the parametric CAD systems is a language for programming parametrical 

relations. T-FLEX CAD has another advantage in this area. The engineer is not required to have any 

training in programming. The drawing parameters can be represented by variables. These variables can 

be related in simple mathematical expressions. This is done without using any programming language. 

The variables can be assigned either at creation of an element or while editing an existing one. The 

values of the variables can be obtained from other drawings or automatically input from a database. This 

provides for unlimited modification capabilities in drawing. 

Along with parametric design, T-FLEX CAD supports wide usage of quick drawing producing non-

parametric sketches. This approach allows creating drawings in a way similar to major CAD systems by 

using a standard set of tools for drawing, i.e. various primitives, as arcs, circles, line segments, etc. The 
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snapping mechanism is provided for easy sketching of new entities, such as horizontal and vertical 

alignment of the cursor with the existing entities or their ends, center-of-arc and center-of-circle 

snapping, etc. When creating arcs, snapping occurs around the 90, 180 and 270 degrees. The cursor also 

snaps to horizontal and vertical alignments with the arc center. The system automatically identifies 

multiple pairs of same-object snappings. Snapping to any object can be locked with the Function key, 

and the cursor will follow to the locked snapping condition. Thus, the sketcher provides a way of quick 

drawing, however, such drawings do not take full advantage of parametric dimension modifications. 

Therefore, this method is only recommended when no substantial modifications are expected on the 

drawing. 

Creation of parametric construction-based drawings can be accelerated with the special parametric 

sketch mode. This mode combines efficiency of non-parametric drafting with flexibility of parametric 

construction. This goal is achieved by simultaneous actions of a user and the application: user creates his 

drawings using ordinary sketch features, and application “puts” geometrically related construction 

elements under the sketch lines thus producing a parametric drawing. 

The highly effective functionalities of T-FLEX CAD make the system usable in a wide range of situations. 

The system can well be used in mechanical design, such as design of industrial equipment and tooling, 

development of molds and stamps, design of consumer goods, etc. It also supports development of 

manufacturing process flow charts and BOM, numerically controlled machining and other technological 

procedures. Other possible application fields include construction and architectural design, charting 

various types of graphs, dynamical visualization of processes and mechanisms, industrial and graphic 

design. The most effective uses of T-FLEX CAD occur when the parametric design paradigm dominates 

the design process, and when all stages of design are involved, from sketch to scratch drawing to 

production drawing. T-FLEX CAD facilitates considerable speed-up of graphic design and documentation 

cycle. 

T-FLEX CAD offers a complete range of drawing tools, such as creating various-type line drawings, 

hatches, dimensions, text, roughnesses, special symbols, etc. Important that all these design attributes 

can be associated with the parameters of the drawing. This means, modifying a drawing parameter would 

cause adjustment of the design attributes. The drawings follow the user-specified international standard. 

T-FLEX CAD also supports instant switching from one drawing standard to another. 

The three-dimensional version CAD 3D is intended for making parametric 3D models. The 3D solid 

bodies authored by the system can easily be modified. Parametric modifications of the 2D drawings 

propagate on the model's 3D representation, and vise versa.  

T-FLEX CAD can be used as a base for developing specialized CAD systems. The system supports 

exporting parametric drawing data to custom processing modules. Vise versa, externally generated 

parameter values can be imported into the system and assigned to the drawing parameter variables.  The 

model is then automatically regenerated, and the new design drawing is ready.  

The system software utilizes the latest GUI standards. Even a novice user can easily start working with the 

system. The menu and icon layout is easy to use. The command dialog boxes are intuitive. The various 

drawing elements and the libraries of drawings allow effortless manipulation.  The built-in context-
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dependent Help facilitates quick learning. Every command is realized in a way that provides users – 

engineers and designers - with confidence in operating the system.  

The theory and algorithms used in the system are unique yet unambiguous to end-users. 
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CONVENTIONS ADOPTED IN THE T-FLEX CAD 

GUIDELINES 

The following standard conventions are adopted in this document: 

<Enter>, <L>, <Esc>, etc. – notations for the keys on the computer keyboard. 

[OK], [View], etc. – notations for graphic buttons in the dialog boxes.  

 - Left mouse button click. 

 - Right mouse button click. 

 - Left mouse button double-click. 

, , etc. – icons on a toolbar, ribbon or automenu. 

File > Open… etc. – selection of a textual menu bar item File, followed by a pull-down menu item Open…. 

 

Properties > Product structure properties > Don’t include invisible objects, etc  means that you select 

Don’t include invisible objects item in the Product structure properties group of the Properties tab in 

the dialogue window. 

 

O: Open Model, EL: Construct Ellipse, etc. – names of T-FLEX CAD commands. Note that the character 

combinations before the colon define the keystroke accelerator sequences for invoking commands by 

typing in the status bar. 

A command can be invoked in T-FLEX CAD by the following three ways:  

By typing, 

By selecting the toolbar item, and 

By selecting the textual menu/ribbon item. 
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The system manuals describe the commands in a table. For instance, the command QL: Layers would 

appear in a table as follows: 

 

Icon Ribbon 

 

Edit → Document → Layers… 

Keyboard Textual Menu 

<QL> Customize > Layers 

This means, the command can be invoked in the following ways: 

1. Press the key <Q> then <L> on the keyboard, 

2. Select Customize item in the text menu and activate Layers… command from the drop-

down list. 

 

3. Select the icon  in the appropriate toolbar. 

 

4. Select Layers command in the Document group of the Edit tab. 

 

 

Certain most common commands can also be invoked with the function keys. For instance, 

pressing <F7> causes Redraw operation. 

 

Select an element instruction in the manuals means placing the cursor over the element and pressing 

left mouse button  or <Enter>. 
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Select an icon, press an icon, select an input box, press a button 

instruction means placing the cursor over the item (icon, input 

box, dialog box button) and pressing left mouse button . 

Point at an element, point at an icon, point at a button means just 

placing the cursor over the item.  

 

Each command usually brings a list of options available under this 

command. An option is one specific action performed within the 

command, as delete an element, select an element of a particular 

type, switch to another mode, etc.  

Each option is represented by a button and an icon in the 

automenu. 

Invoking an option via the keystroke mechanism might be 

different than by selecting the icon. Typing the keystroke 

sequence instantly invokes the action, while selecting an icon may 

work in two ways. First possibility is – an instant action occurs, as, 

for instance, when specifying parameters of an element via .  

Second – after selecting the icon, the system waits for a specific user action, 

with the cursor being modified with a glyph corresponding to the action. The 

action completes when the cursor is pointed at an appropriate element and 

left mouse button  pressed.  For instance, this can be a selection of a 

construction line – .  

The command description contains various ways of creating elements. For instance, the following 

sequence describes creation of a construction circle: 

The command description contains various ways of creating elements. For instance, 

the following sequence describes creation of a construction circle: 

<L>, <L>, <L> - a circle tangent to three lines.  

The above sequence uses a typical notation which implies that the respective 

automenu icon picks can be used instead of the keystrokes, for instance,   

<L>, , <L> is a way of creating a three-line-tangent circle using both the keystrokes and the icon. 

, ,  is a way of creating a three-line-tangent circle via the automenu icon picks.  

, <L>, <L>, etc. – other possible combinations. 

In the system description, “Press ” usually means that either left mouse button  or <Enter> key can be 

pressed. The <Enter> key works as  while working within the command dialog box. 

In the system description, “Press ” means that either right mouse button  or <Esc> key can be 

pressed. This convention about  also holds when working in the drawing area of the application. Use of 
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 in other areas of the screen follows the standard conventions of Windows (usually, this invokes the 

context-sensitive menu). 
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GETTING STARTED 

This chapter contains sections helpful in getting started with the system setup and basic operation: 

“System Requirements”, “T-FLEX CAD System Setup”, “Basic Terms and Drawing Techniques”, “Quick 

Reference on User Interface”. 

SYSTEM REQUIREMENTS  

Hardware Requirements 

Software Requirements Windows XP (Service Pack 3), Windows Vista, Windows 7, 

Windows 8/ Windows 10 

Minimum Processor: 

Recommended Processor: 

 

32-bit or 64-bit Intel or AMD processor with SSE2 support 

 

Core i7 processor or equivalent 

Videocard: 

 

 

 

Recommended videocard: 

Videocard with OpenGL 3.3 support is recommended for efficient 

work with assemblies.  

OpenGL 4.2 – for improved visualization of models in 3D scene.  

OpenGL 1.0 allows to work with 3D models, but with restrictions 

(threads, welds, graphic sections and textures will not display). 

Videocard supporting CUDA 2.3 or higher is required for creation 

of photorealistic images with NVIDIA Optix technology. 

 

High-performance NVIDIA videocard with 1GB of memory or 

higher and with Open GL 4.2 support or higher 

Minimum RAM: 

Recommended RAM: 

1G 

4G or more* (for very large assemblies) 

* 32-bit operating systems Microsoft Windows have a limitation of 4GB of memory address space. 

This 4GB space is evenly divided into two parts, with 2GB dedicated for kernel usage, and 2GB left 

for application usage. Each application (including T-FLEX CAD) gets its own 2GB, but all 

applications have to share the same 2GB kernel space. For Windows XP and Windows Vista it is 

possible to increase the default allocation capabilities up to 3GB (3GB for user mode, 1GB 

reserved for kernel). Such capability requires additional tunings in order to be effective (see 

http://support.microsoft.com for more information). 
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64-bit operating system Windows does not have limitations in terms of size of random access 

memory and does not require any additional settings to control it. Up to 4GB of memory is 

automatically allocated for 32-bit applications (such as T-FLEX CAD).  

To fully exploit the capabilities of 64-bit operating system, there is a special 64-bit version T-FLEX 

CAD x64. Combination of T-FLEX CAD x64 with Windows x64 allows using unlimited amount of 

random access memory in working with T-FLEX CAD. 

T-FLEX  CAD  SYSTEM SETUP  

Protection keys 

Security keys are created by the Sentinel HASP technology and serve to protect T-FLEX CAD from 

unauthorized usage. There are two types of protection keys: hardware and software.  

The hardware protection key is recorded on a physical device that is inserted into the computer USB port. 

The key has its own memory, which contains information about the available user licenses.  

Software protection key is a program and does not require the physical device. It is associated with a 

specific computer. 

The hardware and the software key may be network or local. 

Local software protection key is installed on a single computer and can be re-hosted to another one, if it 

is necessary. 

Local hardware protection key allows you to work on any computer that is connected to the physical 

device with the recorded key. 

If you are using a network security key of any type, the network administrator is granted access to 

manage available licenses and information about these licenses. Access to the network key license 

management is allowed through the program Sentinel Admin Control Center. 

Software for the protection key is installed automatically as part of the T-FLEX CAD installation process.  

Installing Software and Hardware Protection Key 

If you use the hardware protection key do not insert it into USB-port until T-FLEX CAD installation 

complete. 

T-FLEX CAD installation with examples, libraries and auxiliary utilities is available on DVD.  

Perform the following steps to install T-FLEX CAD on your PC: 

1. Insert DVD-disk with T-FLEX CAD installation into DVD-drive. 

2. Run Setup.exe file from T-FLEX Prerequisites folder.  

This installation should be performed one time even after T-FLEX CAD reinstalling or uninstalling. 

3. Run T-FLEX CAD.msi from “T-FLEX CA” folder and follow installation wizard instructions. 

You can install either T-FLEX CAD x32 or T-FLEX CAD x64 running msi file from appropriate folder. 

Installation wizard will install examples and standard parts automatically. 
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4. Run appropriate msi files to install tutorials and necessary add-ons. 

Press [Cancel ] button to interrupt installation process. 

After installation complete new folder will be created in Program Files directory on your PC. 

 

What is Going on in Setup? 

The T-FLEX CAD application files on the CD ROM are in a compressed format. The installer extracts and 

copies these files into the specified folder on your PC’s hard disk. The memory and disk space are 

monitored during the installation, and an error message is displayed if these are insufficient.  

T-FLEX CAD is distributed with a set of sample drawings, and a library of standard elements. The installer 

program creates appropriate subfolders under the installation home folder. The data structure of these 

subfolders is as follows: 

 

\T-FLEX Parametric CAD\   

 PROGRAM The T-FLEX CAD system files 

 Libraries The library element files 

 Documents The system reference files 

 API Examples on Open API and Application Wizard 

usage for developing T-FLEX CAD add-on 

applications. 

The T-FLEX CAD Main Window Layout 

After launching of T-FLEX CAD the dialog box “Start Page” opens up. It includes several sections. In the 

section Recent Documents a list of recently used documents is shown. To open any of these documents, 

it is sufficient to point the cursor at any of them and press . The button [Open…] can also be used. 

The section Create New Document allows creating a new document on the basis of any of the existing 

templates. For convenience all templates are divided into groups (“Common”, “BOM”, “Ray Tracing”).  

The content of these sections duplicates the functionality of the menu File > Recent Files and the 

command FP: Create New Document Based on Prototype. More details on how to use these 

capabilities will be given in the chapter “Main Concepts of System Operation”.  

The chapter What’s new contains information about the installed version. 

When you select Resources tab, tflexcad.ru page opens in the browser. Here you can download the 

sample files, libraries, etc. 

The chapter Tutorial contains basic information about T-FLEX CAD. The information is useful for novice 

users. 
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The dialog box Start Page is always visible on the screen when the standard settings of the system are 

used. Its tab will be aligned with the tabs of the open documents of the system (see below).  

The window can be controlled by the Customize > Tool Windows > Start Page item. 

In ribbon interface, you need to choose a special icon in the top right part of the window. 

 

Control of the displaying of the dialog box Start Page during all sessions can be carried out 

through the dialog box of the command SO: Set Systems Options parameter Show Welcome 

Page at Start on the tab Startup. 
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INTERFACE  

There are two interfaces in T-FLEX CAD: ribbon and textual. Ribbon interface offers a convenience of 

commands usage and their easy searching. Textual interface was used in previous versions of 

the system. 

You can use flag Ribbon mode in the Customize system command on the Options tab. 

 

Ribbon 

All commands on ribbon are distributed on tabs. Name of each tab reflects the content. Commands icons 

are grouped. 

 

The Quick Access Toolbar containing main commands for document management is located in the 

header of the window. The commands are: 2D Drawing, Assembly drawing, 3D Model, 3D Assembly, 

Open, Save, Undo, Redo. These commands are always available and do not depend on the active tab. 

The Set Document Parameters command  is also located here. 
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The File  button contains commands for operating with the document. 

 

Text menu, which contains the full set of commands, can be accessed by clicking on the  button. 

In the upper right corner are: a field for displaying of integration with T-FLEX DOCs , a 

drop-down menu of help information , a drop-down menu of system settings , a command for 

the start page displaying , a command for the full screen mode activation . 

 

In the  drop-down menu you can specify displaying of the tabs.  
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A help drop-down menu  contains commands for invoking help information about the system. 

  

The customize drop-down menu  contains commands for changing various system settings.  

Ribbon adapts to the current mode. For example, when switching between 2D and 3D views, tabs are 

also switching between Draw tab and 3D Model tab. 

Ribbon remembers the tab where the last selected command was located. If you choose a command 

from "Measure" tab in 3D view, and then continue operating in 2D view, the next activation of the 3D 

view will re-enable the "Measure" tab. 

You can hide Ribbon by double-click on any tab to release a work space. Ribbon appears again in case of 

any of its tabs choice. It is possible to recover Ribbon by double-clicking on any of its tabs. 

 

Tabs can be switched by means of a mouse wheel if you put the cursor at them and rotate the wheel. 

 

If some equivalent commands in Ribbon are united in the drop-down list, the last chosen command is 

remembered and displayed in the Ribbon. 
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For personal setup it is possible to edit existing tabs and to create your own tabs with necessary 

commands and operations. 

Textual interface 

 

Main Menu contains the textual menu of the T-FLEX CAD commands by groups. 

Main Toolbar contains icon buttons for T-FLEX CAD commands. Besides the main toolbar, the 

application window of the system can contain several toolbars (including the toolbars created by the 

user). Toolbars can be docked along one of the main window borders, or stand alone as floating 

windows. 

System Toolbar contains the fields for modifying current settings of entities, such as color, line type, 

level, and layer. Also contains controls for modifying layer configuration, level configuration of the 

current document, and selector settings. 
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Elements of T-FLEX CAD Control 

  

 

Ruler indicates current X and Y coordinates in the active drawing. 

The active drawing window - the graphics window for displaying the drawing. Drawings can only be 

created and edited in this window.  

Automenu - a menu of icon buttons for the options available within the current command. If no 

command is current, the automenu is empty. 

Status bar contains the name of the current command, a prompt for the expected user action, the 

current X and Y coordinates, and the command-dependent auxiliary coordinate. 

Pages Tabs provide quick access to the desired page in a multi-page document. To activate a page, 

select the respective tab. Tabs are not shown for the hidden pages.  

Documents Tabs help quick navigation through the open documents. To activate a document, select the 

respective tab.  

The user can reconfigure the layout (position and visibility) of the dialog boxes and various control 

bars on the main T-FLEX CAD window. Use the menu Customize > Tool Windows or Customize > 

Customize…”. 
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Tool Windows 

Properties Window 

 

Is used for specifying parameters in transparent mode within most 2D and 3D commands. This window 

can be docked along one of the main window borders, or float. 

Bird’s Eye View Window 

 

Displays the fitted view of the drawing, regardless of the current pan/zoom in the drawing window. Helps 

to quickly pan to any portion of the drawing. The window can be docked along one of the main window 

borders, or float. 
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Library Explorer Window 

 

Contains graphical and textual representation of the libraries and the drawings in the current library 

configuration. Helps quick loading of a desired drawing and browsing drawing libraries. The window can 

be docked along one of the main window borders, or float. 

3D Model (only for 3D release) 

 

This window displays the structure of the 3D model, such as the existing workplanes and other auxiliary 

3D entities and their dependencies, and the operations used for creating the model. The window can be 

docked along one of the main window borders, or float. 

Diagnostics Window 

 

Displays messages about errors or failures that may occur during T-FLEX CAD operation. The window can 

be docked along one of the main window borders, or float. 
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Variables  Window 

 

An additional window of variables editor which enables to work with the variables in an transparent 

mode, and simultaneously work with the drawing window or 3D model window. Upon changing the 

value of the variable, the model is regenerated transparently in the current window. All changes are 

immediately reflected on the drawing. This window can be docked along one of the main window 

borders, or float. 

Macros Window 

 

This window displays macros of the current document and macros from T-FLEX installation folder 

“…\Program\ Macros”. The window helps to start macros for execution. 

Materials Window  

 

Window for working with the materials of 3D model and also with the material libraries of T-FLEX CAD. 
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Model Elements Window 

 

All created in document elements are shown in the Model Elements window. Context menu is available 

for each of them. 

External Links Window 

 

External Links window allows to manage existing files links used in the current document. 

Window “Product’s structure” 

Displays the model’s structure. It allows us to add annotation elements to the product’s structure, 

transforming it to the form of a single or group bill of materials. 

Studies Window (only for 3D release) 

The window displays data of the current document FEA and Dynamics studies. This window can be used 

for operations with studies. 

Weld Window 

This window contains lists of welds created in the current document. 

Structural Elements Window 

Used for existing structural elements displaying. 

Working with Tool Windows 
The system tool windows (the properties window, “3D model”, “Library Explorer”, the Bird's eye view 

window, “Macros”, the diagnostics window and other windows) can be positioned in the main application 

window in various ways. Those can be “docked” at the side of the working window, made “hideable” or 
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set to “floating” mode. To save the workspace, some windows can be joined in one group window. 

Unused tool window can be turned off. 

 

To engage a tool window, use the menu Customize > Tool Windows. The same dialog can be accessed 

by right clicking  over an automenu of any other toolbar. Windows are closed by the button  located 

on the title bar of the tool window. 

In controlling the service windows, the context menu accessed by clicking  on the heading or the tab of 

the window can be used. The menu has several commands for controlling the state of the window: 

 Hide. Remove the window from the screen; 

 Set floating. Turn on the “floating” mode for the window (see below); 

 Auto Hide. Turn on/off the auto hide mode for the window. 

A set of commands available in the context menu is dependent on the state of the current window. 
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Upon the first launch of the system, the “3D Model”, “Library Explorer” and “Properties” windows are 

already present in the application workspace. Those are placed in the docked mode along the left border 

of the workspace and are joined in one group window. If necessary, the two windows can be moved to 

any location along the perimeter of the application workspace. To display one of the joined windows 

separately, grab that window at its tab by pressing  and “drag” to the desired position. 
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To add a tool window to an already existing or a new group window, 

grab the intended window by pressing  and dragged to the title area 

of the other window or to the tabs area of an already existing group 

window. 

Upon dragging the windows several prompt signs will emerge 

showing where the window will be placed when the mouse is released. 

In the cases when most of the workspace is needed, you can set the 

“auto hide” mode for the tool windows. In the auto hide mode, the 

window will appear as a tab located along the perimeter of the main 

application window. The window will appear automatically as you 

point the mouse to this tab. Once the pointer leaves the window area, 

it will automatically collapse.   

To turn on the auto hide mode for the window, the context menu Auto Hide accessed by clicking  on 

the header or the tab of the window can be used. Moreover, when the service window is in fixed position 

on one side from the main window of the program, the button  appears on the header of the window. 

Pressing this button also turns on the auto hide mode for the window. 

 

“Properties” window tab in the autohide mode 

 

“Properties” window expands when pointed by mouse 

The auto hide mode can be canceled by right clicking  on the window tab and clearing the flag of the 

“Auto hide” parameter. This mode helps save significant space on the screen while maintaining benefits 

of the tool window functionality. Also, to turn off the auto hide mode, the button  on the header of the 

window can be used. 

It is often convenient to set some of the tool windows or a whole group window into the floating mode. 

In this way, the tool window can be placed anywhere within the application workspace without being 

docked. 
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Setting a tool window into the floating mode is done by grabbing the window title or tab in the group 

window by pressing  and dragging into the drawing area of the application window. You can set to this 

mode not only separate windows, but group windows as well. To do this, grab a group window at the 

title by 

pressing  drag into the drawing area of the application 

window in the same way. 

To turn on the floating mode for a window the command 

Set floating in the context menu of the given window can 

be used. Note that if a window, for which the context menu 

is called, was grouped with other service windows into a 

group window, then the floating mode will be applied to the 

whole group window. 

To cancel the floating mode, grab the window at the title 

and by pressing  drag it to a side of the drawing window. 

As you do this, the outline of the dragged window will be 

changing depending on available snapping: separately 

(right, left, bottom, etc.) or in a group window. To suppress 

snapping to sides, while moving the window hold <Ctrl> 

the key. 

 

WORKING WIT H MULTIPLE  MONITORS  

You can open multiple windows for one document and operate with it on multiple monitors. 

 

For example, if your computer is connected with two monitors, you can display a 3D model on one of 

them and a drawing with the same model projections on the other. Changes in the model are displayed 

in all main windows that are associated with the same document. So that, changes in the model made on 

the first monitor are immediately displayed on the projections at another monitor after the Shift+f7: 

Regenerate all command activation. 
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New main windows are independent from each other. Each of the windows has commands, input 

parameters, and other user interface elements.  

The system will ask you about saving of the document only when you close the main window with 

its last open copy. 

 

You can copy document to a new main window via command New Main Window: 

Icon Ribbon 

 

View → Window → New Main Window 

Keyboard Textual Menu 

 
Window > New Main Window 

 

You can transfer document to a new main window via command Move to Main Window: 

Icon Ribbon 

 

View → Window → Move to Main Window 

Keyboard Textual Menu 

 
Window > Move to Main Window 

 

The commands are also available in the document tabs context menus. 
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Before new main window opening, you can specify the Views placement for it. 

 

The main windows related to a single document are numbered. Number of a window is displayed in its 

title in parentheses. It helps to choose the window if you want to copy or transfer the document. 

 

DRAWING BASIC TE RMS  

Drawing in T-FLEX CAD involves using several types of entities. 

Construction entities. These make the framework of a drawing. The graphic entities of the actual drawing 

are drawn over the construction entities. The construction entities include construction lines and nodes.  

These construction lines and nodes are the principal elements for defining the parametric layout of the 

drawing. The analog for these in the conventional drawing is the thin pencil lines to be later marked in 

ink. The parametric behavior of the drawing will be driven by the relationships between the various-type 

construction lines and the nodes. This will result in a particular way in which the drawing geometry will 

adjust to changing parameters. The construction entities are displayed solely for user reference. They do 

not appear on printouts or plots, and are not exported.  
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Graphic Entities. These constitute the actual drawing of the drawing. The graphic entities include the 

graphic lines, dimensions, text, hatches, GD&T symbols, etc. These entities may be “snapped” to 

respective construction entities. In this case, modifications in the construction entities and nodes 

propagate on the corresponding graphic entities. This is the main technique for parametric design in T-

FLEX CAD. The graphic entities constitute the drawing image on a printout or a plot.  

The Auxiliary Entities of T-FLEX CAD are variables, databases, reports and other certain system data. 

Construction Entities 
 

Construction Lines are the core elements of the T-FLEX CAD parametric model. 

These are “thin” base lines that define the parametric framework of a drawing. The 

construction lines include infinite straight lines, circles, ellipses, splines, offset lines, 

function curves, and paths. They are displayed as dashed lines. 

The in-depth description of the construction line types and their creation 

techniques is given in the following chapters. The particular ways of creating 

construction lines define the behavior of the drawing as the user modifies location 

of any construction line. This is due to interdependencies among the construction 

lines that are established at their creation. 

A Node is a point whose placement is defined by a particular way of creation and 

by interdependencies with other entities in the model. Nodes are also the core 

elements of the T-FLEX CAD parametric model. 

Typically, nodes are created at construction line intersections. 

 

 

The nodes are directly involved in defining the parametric model that will drive other construction 

entities. Examples of such situations are: a line passing through a node at a specified angle to another 

line, a circle passing through two nodes, etc. Modifying the location of one of the lines defining the node 

will cause the node to adjust. This change will propagate on other construction entities related to the 

node. The nodes are also used for defining the ends of the graphic line segments and other graphic 

entities. 

Besides the nodes that are defined by intersections of pairs of construction lines, T-FLEX CAD supports 

several other types of nodes whose creation techniques are described below. For now, let’s consider only 

the difference between the “snapped” and “free” nodes. 

The typical technique of creating a parametric model implies creating nodes at construction line 

intersections. This technique is called constrained drawing mode. While in “constrained drawing” mode, 

creating a node at some location will undergo automatic snapping to the nearest to cursor pair of 

construction lines and their intersection.  

Creating “free” nodes is a special drawing technique used in non-parametric drawing, such as sketching. 

This will further be referred to as free drawing mode. While in “free drawing” mode, the nodes are 

created exactly under the cursor, without snapping to construction line intersections. 

The “constrained drawing” mode is indicated by the icon  of the T-FLEX CAD automenu. 
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The “free drawing” mode is indicated by the icon  of the automenu. Switching between these modes 

is done with <Ctrl><F> or by picking the respective automenu icon. 

The recommended drawing technique is using the “constrained 

drawing” mode. Avoid using mixed modes on the same drawing, 

as this may cause errors in parametric modifications of the 

drawing. 

Fixing Vector is a construction entity that helps defining the 

location and orientation of the drawing that is used as a 

fragment in an assembly drawing. 

 

Connector is a construction entity that provides a placement 

reference for 2D fragments. Besides the geometrical location 

(the origin of the coordinate system and the axes orientation), a 

connector can keep additional data (both the dimensional and 

non-dimensional) that is necessary for “plugging in” the 2D 

fragments. These data are stored as a list of named values that 

can be either fixed constants or modifiable parameters. As for 

the parameters, their names within the connector are significant 

in the following way: assigning same names to the external 

parameters of the element to be connected makes these 

parameters assume the values of their counterparts in the 

connector. 

 

Graphic Entities 
 

 

Graphic Lines are the lines constituting the actual drawing of the 

drawing. Graphic lines include straight segments bound by a pair of 

nodes, full entities, such as circles, closed splines and so on, except for 

the infinite straight lines, and the portions thereof bound by pairs of 

nodes, also splines through nodes. 

The graphic lines may be of various types (main solid, thin solid, 

dashed, dotted etc. They are snapped to nodes and construction lines. 
 

Hatches and Fillings are closed-contour single-connected or multiple-

connected areas filled with various patterns or colors. 

Hatch contours are snapped to nodes and construction lines. They 

adjust to node location modifications. The filling pattern also 

regenerates automatically as the contour changes. 
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Text is a single-line or multi-line textual data input via a text editor or 

directly in the drawing window. Either way of input supports various 

fonts. Besides, T-FLEX CAD supports use of paragraph formatting and 

other operations. A text can either be located in absolute coordinates 

and thus independently from the construction entities, or be snapped 

to construction lines and nodes. ТЕXТ
 

Table is an element of drawing layout. It is composed of lines and 

textual data. Tables are created by the same command as text. A table 

can either be located in absolute coordinates and thus independently 

from the construction entities, or be snapped to nodes. 

Table

 

Dimension is a standard element of drawing layout. It is composed of 

lines and textual data. A dimension is created with respect to 

construction lines and nodes. T-FLEX CAD supports several 

dimensioning standards, including ANSI and Architectural ANSI. 

Dimensions automatically adjust to parametric modifications of the 

drawing.  

Roughness Symbol is a standard element of drawing layout. It is 

composed of lines and textual data. A roughness symbol can either be 

located in absolute coordinates, or be snapped to a node, construction 

or graphic line, and to a dimension. 

 

Geometric Datum and Tolerance Symbol (GD&T Symbol) is a 

standard element of drawing layout. It is composed of lines and textual 

data. A GD&T symbol can be snapped to a node, construction or 

graphic line, and a dimension, or located in absolute coordinates. 

 

Leader Note is a standard element of drawing layout. It is composed 

of lines and textual data. A leader note can either be located in 

absolute coordinates, or snapped to a node, construction or graphic 

line. 
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Section symbol is a standard element of drawing layout. It is 

composed of lines and textual data. This symbol marks various views, 

sections and cuts. The element can either be located in absolute 

coordinates, or snapped to a node. 

 

Fragments are T-FLEX CAD drawings that are used in other drawings in 

subassemblies and assemblies. Any T-FLEX CAD drawing can be used 

as a fragment. 

A parametric fragment in T-FLEX CAD is a drawing that can be inserted 

(assembled) into another drawing to a specified location and with 

modified parameters. The fragment appearance shall change to satisfy 

the parameter values. In order to create parametric fragments, the user 

needs to follow certain rules described below. 
 

Pictures are graphic images saved in various file formats.  

 

Copy is an element duplicating the original, except for the different 

transformation parameters. 
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Controls are special elements in T-FLEX CAD used for creating user-

defined dialog boxes customized for controlling external parameters of 

a parametric model. 

 

Drawing View is a T-FLEX CAD entity that displays the content of one 

drawing page on another page, appropriately scaled. This is a 

rectangular area of specified size that will contain the other page 

image. The main purpose of this element is combining in one drawing 

several elements of different scale. A common use of the Drawing View 

is for creating enlarged detail views. 

Drawing View

 

Auxiliary Elements 

Variable is a system element for specifying non-geometrical dependencies between the various 

parameters. One main use of the variables is assigning their values to the construction line parameters. 

Consider, for example, a line parallel to a given line, at a certain distance. This distance can be defined 

not only by value, but via a variable as well. 

Database is a table of information ordered in a certain way. Databases are used for storing information 

required in the drawing.  

Reports are textual documents that are created with the T-FLEX CAD text editor. Reports can include the 

system variables and are used for creating various text documents. 

DRAWING TECHNIQUES  

A T-FLEX CAD drawing can be created in one of the following ways: 

Parametric Drawing. This is the recommended drawing technique in T-FLEX 

CAD. Take the advantage of parametric design capabilities of T-FLEX CAD 

to create a drawing that can be easily modified according to your design 

intent. Such a drawing can also be added to a parametric model library to 

be later used in other, more complex drawings. In the latter case, one can 

specify a new location for the drawing as a fragment, and modify 
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parameters to obtain a desired shape. 

Non-parametric Drawing (Sketch). This is a conventional drawing similar to 

those created by most CAD systems. This drawing is created by using the 

standard set of functions for plotting different basic entities (straight lines, 

arcs, circles, ellipses, splines etc.) and by using the mechanism of objects 

snaps. These drawings do not have advantages of parametric drawings as 

far as efficient modification of parameters (dimensions) is concerned, 

however, in certain cases creating these drawings saves time and can give 

the benefit when significant subsequent modification is not required. 

 

Creating Parametric Drawing in T-FLEX CAD 

Creating a drawing in T-FLEX CAD begins with creating construction 

entities. Construction entities can be created by various means. First, create 

the base construction lines that will be used as a reference for additional 

construction lines. The base lines can be vertical or horizontal. Next, create 

straight lines and circles dependent on the base lines. For instance, 

construct parallel lines, tangent circles, etc. The way in which additional 

lines are created is stored in the model. The line intersections provide 

reference locations for nodes that need to be created for further 

construction.  

 

More straight lines and circles can then be created referencing the earlier ones in various ways. A line, for 

instance, can be created through two nodes; a circle can be drawn through a node and tangent to a line. 

All these construction steps are stored, and in future the thus created entities will be adjusting to the 

base and other entity modifications according to their creation history.  

Thus, the early stage of creating a drawing involves building parametric 

dependencies among construction entities that become the parametric 

framework of the drawing. 

Once the construction framework is built, proceed with drawing the graphic 

entities. Create line segments, arcs and circles by drawing over the 

construction lines, snapping to nodes.   

Once the actual drawing graphics is complete, proceed with the drawing 

layout arrangement. Create dimensions referencing construction lines and 

nodes. Define hatch contours, their filling patterns and other particulars. 

Add text entities. When placing text use snapping to nodes and 

construction lines if desired. This would be necessary if a text is supposed 

to move together with the drawing graphics. 
 

Further, define GD&T symbols, roughnesses and leader notes. Finally, a complete parametric drawing is 

created and can further be modified. One can vary construction entity parameters, such as distances 

between parallel lines, angles between lines, radii of circles. 
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The graphic entities will subsequently adjust with the construction ones they reference. Thus, a family of 

variations of the original drawing can be created. All the rest of the drawing layout will also adjust 

accordingly, all done in an instant.  

Note that the above scenario for creating a parametric drawing in T-FLEX CAD is just one 

recommended technique. One can create construction entities and graphic entities in an arbitrary 

sequence. What is important is that the graphic entities are constrained to the construction ones.  

The following chapters will tell how to use variables as drawing parameters, how to create an assembly 

from fragments, and much more. 

Creating Non-Parametric Drawing (Sketch) in T-FLEX CAD 

This technique implies quick sketching of the drawing graphics, completely avoiding preliminary creation 

of the construction entities. 

Sketching supports object snapping and provides dynamic hints that 

make the drawing process simple and slick. However, thus created 

drawings do not share the advantage of parametric drawings in the 

capability of parameter (dimension) modifications. Creating non-

parametric drawings may be somewhat preferable in the cases when no 

significant modifications are expected. 
 

Fast Drawing Creation. Automatic Parametrics 

Another method of drawing creation combines the previously described methods – it is used for creating 

construction-based parametric drawings using commands of non-parametric sketch. The user creates 

only image lines, using object snapping. T-FLEX CAD automatically “puts” necessary geometrically related 

construction lines under these image lines. The program defines construction types from the snapping 

used on creation. For example, for a straight image line parallel to another line the program creates 

construction line parallel to the construction line of the original image line. The resulting image line will 

lie on the new construction with parametric relation to the original image line. 

QUI CK REFEREN CE ON USE R INTERFACE  

This section provides quick reference to T-FLEX CAD while assuming user familiarity with PC operation in 

general, and some CAD experience as well.  
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Getting Help 

The answers to the questions arising during operation can be got by the following means:  

 The current command help can be invoked by pressing <F1> key, or by selecting menu “Help > 

Current. Pressing <F1> key when no command is active, or selecting “Help > Contents invokes the 

help contents. 

 While within a command, the status bar displays hints and prompts. 

 Pop-up help appears when the mouse is placed over an icon, a toolbar or other control element for a 

brief time. This help message tells the name of the element pointed at, or other related information. 

Mouse Interface. Context Menu 

T-FLEX CAD operation is mainly performed by mouse. The keyboard is used for inputting numerical 

values, names, and, in certain situations, for keyboard command accelerators (see below). 

Using Left Mouse Button 

 Pointing cursor at an icon and pressing  invokes the respective command. 

 Pointing cursor at an item of the textual menu and pressing  also does the command call. 

 Pointing cursor at a 2D construction or graphic entity in the drawing window and pressing  selects 

this entity and activates its editing command. 

 Pointing cursor at a 2D entity and double-clicking  invokes the “Entity Parameters” dialog box. 

 Pointing cursor at an entity and depressing and holding  while moving the mouse (“dragging”) 

moves the entity.  

 Subsequent clicking  on 2D or 3D entities while holding left <Shift> key selects a group of entities.  

 A group of 2D entities can be selected by “box selection” that occurs when the mouse with the 

depressed  is dragged across the drawing window. The entities will be selected that are entirely 

within the selection box. 

If the mouse is moved from left to right the entities will be selected that are entirely within 

the selection box. The box is drawn with continuous line.  

When mouse moves from right to left, the entities are selected with the “cutting” box. This 

means that the elements both entirely and partially within the selection box will be selected. 

The box is drawn with the dashed line in this case. 

 To unselect one entity in a group of selected, click on it with  while holding left <Ctrl> key. 

 Pointing cursor at a selected group of entities and clicking  or double-clicking  starts moving the 

selected entities. 

 Managing libraries and arranging toolbars can be done using Drag&Drop mode. This is done by 

pointing cursor at an element, depressing and holding , and moving to a new location.  

For more information, refer to the appropriate volumes of the documentation. 
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Using Right Mouse Button 

 While within most commands, pressing  cancels the last action or quits the command. Certain 

commands, as, for instance, the spline creating command or the hatch creation, allow user 

customization of the action performed by the command on the  click. This could be quitting entity 

creation, canceling last selection, or completing a sequence of inputs. 

 If no command is active, pressing  invokes context menu. This menu consists of the currently 

available commands for the given entity. The set of items of the context menu will depend on 

elements the cursor is pointing at. Thus, it will be different when the cursor is pointing at drawing 

entities from when the cursor is over a menu area, or toolbar area, or control window area of T-FLEX 

CAD, etc. To launch a command, point the cursor at the desired line of the context menu and press .  

 

 The context menu can also be invoked while working with dialog boxes (see the topic “Context Menu 

for Dialog Box Items” in the chapter “Customizing Drawing”). 
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The described right mouse button actions are set as defaults, but can be customized. To do so, 

go to Customize > Options… (Preferences tab). For more information, refer to the chapter 

“Customizing System”. 

Additional Functions: 

If the mouse has a wheel middle button then zooming in/out on the drawing can be done by scrolling 

the wheel, and panning – by dragging the mouse with the wheel button depressed. 

Calling a Command 

A command call in T-FLEX CAD can be performed by the following means: 

 Using an icon on a toolbar; 

 Selecting an item in the textual menu; 

 Typing a keyboard accelerator sequence. 

In this volume, any T-FLEX CAD command description will begin with a table describing these three ways 

of calling the command. For instance, consider the command ESA: Select all elements in current View. 

The table will appear as follows: 

Icon Ribbon 

 

Edit → Edit → Select All 

Keyboard Textual Menu 

<ESA>, 

<CTRL><A> 
Edit > Select All 

 

The three columns of the table contain the respective calling instructions. 

The first column indicates the keyboard accelerator for the command for inputting the command from 

the keyboard. All key strokes are shown together within one pair of angle brackets. Also, if defined for 

the command, a standard function key combination is entered next. Each key in the function key 

combination is shown in its own angle brackets.  

The second column contains the access sequence for the command via the textual menu. The name 

before the dividing line is the name of the appropriate group item in the menu bar. It is followed by the 

item name in the pull-down menu that stands for the command. The menu item name may be different 

(abridged) from the full command name, as is, for instance, the item name “Select All” versus the 

command name “Select all elements in current View”.  

The third column of the table contains the icon image for the command. Normally, the particular toolbar 

containing the icon has the same name as the menu bar group item. For user convenience, a popup with 

the command name appears when the cursor is briefly held over an icon. Once a command is activated 

by pressing  on its icon, the icon stays “pushed” up until completing the command or switching to 

another command. 
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Note: the keyboard accelerator combination is input by pressing the keys sequentially, while the 

function key combination is pressed simultaneously, i.e. the first key is depressed and held while 

pressing the second key. 

The accelerator sequence for a command can be watched in the prompt field of the status bar when 

selecting the command in the T-FLEX CAD menu bar or a toolbar. If a function key combination is 

defined, it is shown on the textual menu item button at the right of the name. Any command allows 

defining or modifying such combination.  

See “Customizing System” chapter, “Customizing Toolbars and Keyboard” topic, “Keyboard” 

tab.  

When inputting a command by typing, make sure the system is not within another command, and the 

status bar is empty. 
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Each command has an additional set of options and 

subcommands that can be accessed via the automenu or from 

keyboard. The keyboard accelerators appear on the pop-ups 

by the respective commands. 

Some commands can be conveniently accessed from the 

context menu. The context menu is invoked by pressing  after 

selecting one or several elements. The context menu contains a 

list of commands available with the given selected group. 

 

Canceling a Command 

The last action can be cancelled by pressing  in the drawing area or <Esc> key. Repeated pressing quits 

the command. Alternatively, use the  icon of the automenu. Canceling a command clears the 

command field in the status bar and the automenu. 

Starting System, Saving Drawing, Exiting System 

Upon the start of the system the dialog box “Start Page” appears on the screen. It has been explained 

how to work with this dialog box at the beginning of this chapter. It is worth mentioning again that this 

dialog box allows creating new documents on the basis of templates already existing in the system, and 

it shows the list of the recently used documents (with the possibility of opening them). Also, this dialog 

box has various links, which can be useful in working with the system. 

 

In addition to the dialog box “Start Page”, to create new documents and open already existing ones, the 

system commands gathered in the textual menu File can be used. 

FN: Create New Model command allows to create a new document: 

Icon Ribbon 

 

Get Started → Files → Drawing 

Keyboard Textual Menu 

<FN>, 

<Ctrl><N> 
File > New > Drawing 
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FP: Create New Document Based on Prototype command displays a dialog box that allows to select a 

prototype file for the new document: 

Icon Ribbon 

 

Get Started → Files → New From Prototype 

Keyboard Textual Menu 

<FР> File > New > From Prototype 

 

O: Open Model command brings up the standard “Open” dialog box to open a document for editing: 

 

Icon Ribbon 

 

Get Started → Files → Open 

Keyboard Textual Menu 

<O>, 

<Ctrl><O> 
File > Open 

 

SA: Save Model command saves the current document: 
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Icon Ribbon 

 
 

Keyboard Textual Menu 

<SA>, 

<Ctrl><S> 
File > Save 

SV: Save Model As command allows the user to save the current document into a new file with a 

different name without changing the original document: 

 

 

Icon Ribbon 

 

 

Keyboard Textual Menu 

<SV> File > Save As 

SL: Save All Modified Models command saves all currently open documents: 

 

Icon Ribbon 

 

 

Keyboard Textual Menu 

<SL> File > Save All 

 

 SY: Save current document as prototype for new documents command saves the current document as 

a prototype for creating new documents: 
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Icon Ribbon 

 

 

Keyboard Textual Menu 

<SY> File > Save as Prototype 

 

Once this command is called, a dialog box appears on the screen. This dialog allows the user to specify 

the name for the prototype file, specify the tab in this dialog box for this prototype or create a new tab if 

desired, and also delete unnecessary files and tabs. 

The prototype files are located in the “Prototypes” folder under the “Program” folder off the T-FLEX CAD 

home. This is exactly the folder whose content is displayed in the dialog box by default. 

 

A prototype folder can be specified by the command SO: Set System Options, Folders tab. 

 

Save document copy to file with different name command allows to save copy of the document without 

opening the copy. In this case you can continue working in the source document. 
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Icon Ribbon 

 

 

Keyboard Textual Menu 

 
File > Save Copy 

 

PS: Show Model Properties command displays all properties of the current document, and allows to 

input a brief comment: 

 

 

Icon Ribbon 

  → Properties 

Keyboard Textual Menu 

<PS> File > Properties 

File > Recent Files displays the list of files open during previous sessions. Select a file name in the list to 

open. The number of displayed recent files can be set via the Customize > Options > Preferences 

command. 

 

“FCL: Close Model” command closes the current document: 

 

Icon Ribbon 

  → Close 

Keyboard Textual Menu 

<FCL> File > Close 

 

A document can also be closed using the button , located in the top-right corner of the document 

window. 
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“FI: Exit system” command closes the T-FLEX CAD session: 

Keyboard input Textual Menu Icon 

<Alt><F4> File > Exit  

The system queries the user whether to save modified documents (if any) before exiting.  

 

Function Keys 

Certain frequently used commands are bound to function key combinations, as follows: 

<F1> Get reference information (help) on the current command 

<Alt><F1> Get information on the selected element(s) 

<Ctrl><S> Save document 

<Ctrl><O> Open document 

<Ctrl><N> Create new document 

<Ctrl><P> Print document 

<Ctrl><F7> Recalculate parameters of the current document 

<Alt><F7> Regenerate 3D model 

<F3> 

Call ZW: Zoom Window command. This is an instant command that 

can be called while within another command. The previously active 

command continues after this command.  

<Ctrl><Shift><PgUp> Zoom in 

<Ctrl><Shift><PgDown> Zoom out 

<Ctrl><Shift><Left> Pan left (moves the model left) 

<Ctrl><Shift><Right> Pan right (moves the model right) 

<Ctrl><Shift><Up> Pan up (moves the model up) 

<Ctrl><Shift><Down> Pan down (moves the model down) 

<Ctrl><Shift><Home> Fit to page 

<Ctrl><Shift><End> Fit all objects 

<F7> Call RD: Update Model Windows command 

<Alt><BackSpace> or 

<Ctrl><Z> 
Call UN: Undo Changes command 

<Ctrl><BackSpace> or 

<Ctrl><Y> 
Call RED: Redo Changes command 
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Please note that the above command bindings can be changed via the Customize > Customize… > 

Keyboard command. 
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BRIEF INTRODUCTORY COURSE 

This chapter introduces various drawing techniques. The manual describes all necessary steps in the 

drawing process. Once you start drawing with T-FLEX CAD, you will have an opportunity to fully 

appreciate the advantages of this system. Further you will learn the basic commands and principles of 

creating a drawing with the aid of T-FLEX CAD. 

T-FLEX CAD supports creation of two types of drawings: parametric and nonparametric (sketches). The 

mainly used type is the parametric drawing.  

It takes somewhat more time resources to create a parametric drawing; nevertheless, later on such 

drawing will be easily modifiable as you desire. A nonparametric drawing (sketch) can be created faster. 

Its creation method is similar to the ways of drawing in some other CAD systems. However, 

nonparametric drawings do not possess the advantage of effective parameter (dimension) modification. 

Therefore, this method is recommended to use in the cases when no significant modifications to a 

drawing are expected. 

To speed up creation of parametric drawings, the system supports the use of automatic 

parameterization. This mode allows constructing not too complicated parametric drawings just like 

nonparametric ones: all you do is create graphic lines using object snapping. The construction lines 

constrained by the parametric relation will be automatically “slipped under” the graphic lines by the 

system. 

Three approaches to creating a T-FLEX CAD drawing will be reviewed below: creating a parametric 

drawing by the traditional method (that is, with the manual creation of construction elements), creating a 

nonparametric sketch drawing, and creating a parametric drawing in the automatic parameterization 

mode. 

CREATING PARAMETRI C DRAWING  

The following diagram shows a drawing to be created. It is a plate with a through hole of conical shape. 

The drawing will be defined parametrically so that any modifications will automatically reflect on all 

projections. 

Let’s begin with the main (elevation) view of the plate. First, create the necessary “thin” construction lines, 

and then draw the graphic lines on top. Next, create the other two views using the construction lines of 

the main view. This creates a dependency between the views so that the two views automatically adjust 

to the main view modifications. Finally, apply text and dimensions. 

As was mentioned, any command can be called by a number of ways. It can be typed on the keyboard, 

selected from the textual menu, or picked on a toolbar. 
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Let’s begin with the command L: Construct Line. To invoke the command, use: 

Icon Ribbon 

 

Draw → Construct → Line 

Keyboard Textual Menu 

<L> Construct > Line  
 

Pick the icon  at the top of the automenu. A crosshair appears that 

follows cursor dynamically. The current coordinates of the crosshair 

crossing point are displayed in the status bar. There are several ways to 

define the crossing point. One is to simply place the cursor near the center 

of the drawing window and press . To define the crossing point more 

precisely, specify its coordinates in the property window. The coordinates 

can also be specified via a parameter dialog invoked by typing <P> key or 

picking the icon  in the automenu. 

 

 

As a result, two crossing construction lines will be created. Besides, a node is created at the intersection 

point. These lines make the basis of the view being created. The line parameters represent the absolute 

coordinates. The view can be moved around on the drawing by moving the base lines. 

Do not use more than two base lines on the main (independent) view, and more than one base 

line on the views defined by projections. This will insure freedom in placing the drawings. 

A T-FLEX CAD command stays active up until it is quit or another command is called. Quitting the 

crosshair mode (as by pressing  once) cancels the crosshair rubberbanding, but the line creation 

command stays active. After canceling the crosshair mode, move the cursor close to the vertical line. The 

line will get highlighted, and a pop-up help will appear next to cursor displaying the name of the 

highlighted entity.  This is object snapping in action. This behavior relieves the user from typing on 

keyboard or using the automenu buttons. 
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The object snapping is on by default when starting the application. To set or unset this mode 

manually, use the button  on the “View” toolbar. 

Pressing  now starts rubberbanding of a line that follows the cursor while staying parallel to the 

selected one. We are now creating a line parallel to a vertical line. Such a relationship between the two 

construction lines, established at the creation time, is an example of an important feature of T-FLEX CAD 

system. This defines behavior of a set of construction entities under parametric modifications. 

Place the new line at the left of the highlighted vertical line by pressing . The exact value of the distance 

can be specified in the property window or parameter dialog box. The newly created line will become the 

left-hand side of the part. 

Pressing  once cancels the parallel line creation mode, yet the line 

creation command stays active. (Otherwise, call it again.) Next, move the 

cursor toward the horizontal line and press . The line is selected as a 

reference for a parallel line to be created. Move the cursor up, specify an 

exact value of the distance, if desired, using the property window, and 

press  fixing the top side of the part.   

The next step is to round a corner of the plate with a fillet. For this purpose, let’s use the command 

C: Construct Circle. Call the command via 

Icon Ribbon 

 

Draw → Construct → Circle 

Keyboard Textual Menu 

<C> Construct > Circle 
 

To draw the fillet at the upper-right corner of the plate, construct a circle 

tangent to the top and the right-hand-side lines. Move the cursor to the 

top line and press  or <L>. This starts rubberbanding of a circle whose 

radius adjusts as the circle follows the cursor while the line tangency stays 

intact. This means a circle is being constructed that is tangent to the top 

line. Any future modifications of the top line location will not break the 

circle tangency condition. 

Next, move the cursor to the right-hand-side line and again press  or <L>. 

Now, the circle becomes “tied” to the two construction lines and keeps the 

tangencies while being rubberbanded. Pressing  fixes the current circle 

radius. The exact value of the radius can be specified in the property 

window. 

 

 

If the resulting construction does not match the illustration, use UN: Undo Changes command, 
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Icon Ribbon 

 
 

Keyboard Textual Menu 

<UN>, 

<Ctrl><Z>, 

<Alt><BackSpace> 

Edit > Undo 

Each call to this command brings the system one step back. If this command was called mistakenly, its 

action can be reversed with the command RED: Redo Changes, 

Icon Ribbon 

 
 

Keyboard Textual Menu 

<RED>, 

<Ctrl><BackSpace> 
Edit > Redo 

This command restores the action that was mistakenly undone.  

One can remove all construction lines and start creating a drawing from the beginning with the 

command  PU: Delete Unused Construction: 

 

Icon Ribbon 

 

Edit → Additional → Purge 

Keyboard Textual Menu 

<PU> Edit > Purge 

This command will delete all construction entities and allow to start drawing anew. A specific 

construction entity can be deleted using command EC: Edit Construction:  

 

Icon Ribbon 

 

Draw → Additional → 2D Construction 

Keyboard Textual Menu 

<EC> Edit > 2D Construction 

Once the command is called, select the entity and delete it by pressing <Delete> key on the keyboard or 

by picking the icon  in the automenu.  

 

Now, draw the graphic lines on top of the completed construction portion of the drawing. To do so, let’s 

create graphic lines by calling G: Create Graphic Line. Call the command via 
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Icon Ribbon 

 

Draw → Draw → Graphic Line 

Keyboard Textual Menu 

<G> Draw > Graphic Line 
 

Note that the previous command is automatically terminated when calling 

another command via the toolbar icon button or the textual menu (no need 

to cancel the previous one explicitly). 

Start drawing solid lines from the upper-left corner of the plate. The 

graphic lines snap automatically to a closest intersection of the 

construction lines. Simply move cursor to an intersection and press . The 

line will be rubberbanded after the cursor. Just keep selecting nodes or 

construction line intersections. 

 

It is not recommended to select multiple (more than two) line intersections neither by pressing 

<Enter> nor by . In this case, we recommend creating nodes at such intersections first. The 

graphics can then be applied using the <N> key. When using the <Enter> key in “free drawing” 

mode, a “loose” node will be created that is not constrained to any construction line. Following 

these tips insures correct parametric function of the drawing under modifications. 

Move cursor to the tangency point between the top line and the circle, and 

press . What you see on screen now should be similar to the illustration at 

right. Note that T-FLEX system automatically adds nodes to the end points 

of the graphic lines, unless already created.  

 

Now let’s draw a graphic line along the circle to construct an arc between 

the two tangency points. To do so, move the cursor to the circle and press 

<C> key. The circle will then get highlighted. The direction of arc creation 

depends on the position of the cursor when selecting the circle. To change 

the arc direction, press the <Tab> key. 

Place the cursor just above and to the left of the second tangency point as 

shown.  

 

 

Then press , and the graphic arc will be created in the clockwise (CW) 

direction, spanning to the second tangency point. The result should look 

like on the diagram. 
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Continue drawing. Select with  the lower-right corner of the plate, then 

the lower-left one, and finish the construction in the upper-left corner 

where the drawing started. To complete the command press . 

The drawing should look as shown here. 
 

If applying graphic lines did not come out as desired, edit the graphics using the command EG: Edit 

Graphic Line. Call as follows, 

Keyboard Textual Menu Icon 

<EG> Edit > Draw > Graphics 
 

Move the cursor to one of the lines to be edited, and press . This selects the line. It can then be deleted 

by pressing <Delete> key or picking the icon  in the automenu. Repeat for each line to be edited. If a 

whole area is to be edited, use box selection. To select by box, press  where one of the box corners 

should be, hold and drag to the desired location of the opposite corner, then release the button. As you 

drag the cursor, it rubberbands a rectangle of the selection box. The elements will be selected that are 

fully within the box. All these elements can be deleted at once. 

To apply graphic lines again, call the command G: Create Graphic Line. To redraw the screen at any 

moment use the <F7> key, in case not all lines are displayed properly after editing.  

Once the desired image is obtained, proceed to the next step of drawing creation. The drawing can be 

saved preliminary with the help of SA: Save Model command: 

Icon Ribbon 

 
 

Keyboard Textual Menu 

<SA> File > Save 

 

Congratulations! You have accomplished your first drawing in T-FLEX CAD. Now let us briefly describe 

the system editing capabilities. 

The current drawing uses five construction entities that define the shape and size of the part. These are 

the left-hand side, the right-hand side, the top, the bottom and the fillet radius. To modify construction 

entities call the command EC: Edit Construction: 

Icon Ribbon 

 

Draw → Additional → 2D Construction 

Keyboard Textual Menu 

<EC> Edit > 2D Construction 

Move the cursor to the left-hand-side vertical line and press . The line gets highlighted. As you move 

the cursor left to right, the line will move along. Specify the new position of the line by pressing . The 
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width of the plate will change. Note that modifying locations of construction entities causes instant 

update of their respective “snapped” graphic lines. If you try to move the right-hand side of the plate 

then the whole plate will move. This is because the left-hand side was created as a dependent of the 

right-hand one, and the dependency stays as the right-hand side is modified. However, the left-hand 

side can move independently of the right. Try such manipulations with other construction entities, 

including the circle. As the construction entities move the size and shape of the plate will be changing 

while maintaining the dependencies defined at the construction time. 

After testing modification capabilities of the system please bring the drawing back into an approximately 

original configuration as shown on a diagram above. Let’s proceed with the next element of the drawing, 

which is the conical hole in the middle of the plate. 

First, let’s define the center of the circle to be constructed. To do so, let’s do auxiliary construction to 

define the center point of the plate. T-FLEX CAD provides a handy command to create a line in the 

middle of two others. For two parallel lines, this command creates a parallel line in between at equal 

distances to the two. For intersecting ones, the resulting line passes through the intersection at equal 

angles to the two original lines. Thus, the new line appears as the symmetry line for the two. 

Call the command “L: Construct Line” and choose the icon  in the automenu. Move the cursor to the 

right-hand side of the plate and select the vertical line by . A parallel line appears rubberbanding after 

the cursor. Move the cursor to the left-hand side of the plate without fixing the rubberbanded line. Now, 

select the left-hand-side vertical line with . This creates a new vertical line on the drawing that is the 

symmetry line for the two selected ones. 

Follow same way to create a horizontal line as the symmetry line for the top 

and bottom sides of the plate. The intersection point of the two new lines 

will be the center of the hole to be constructed. 

Next, call the circle creation command, move cursor to the intersection of 

the symmetry lines, and press . This starts rubberbanding of a circle with 

the fixed center, with the radius adjusting to the cursor position.   

The circle center snaps to the node created automatically at the intersection of the symmetry lines. Fix 

the circle with . Just like line-to-line distances, the circle radius (diameter) can be defined approximately 

by mouse operation, and exactly in the property window. Note that after pressing  the command “C: 

Construct Circle” stays active. 

The second circle of the conical hole can be constructed as concentric to 

the first one. To do so, pick the icon  in the automenu or type <O>. 

Then select the existing circle with . The new circle starts rubberbanding 

after the cursor. Place the cursor so that the rubberbanded circle is slightly 

bigger than the original one, and fix with . The exact radius difference can 

be managed via the property window.  

Proceed with the command G: Create Graphic Line, move cursor to the bigger of the two circles, and 

press  or <C>. The circle gets drawn in solid. Then, move the cursor to the smaller circle, and again 
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press  or <C>. Now both circles are drawn solid. From this point, we can proceed with the two other 

views of the plate. 

The two other views are not required for constructing a parametric drawing in T-FLEX CAD. In this 

example, creating the side and the plan views simply help demonstrating additional advantages of 

parametric modeling using T-FLEX CAD system. 

Since the straight lines are considered infinite, one can see that the other views (side and plan) are 

already partially created. To finalize the drawing, we will need to establish additional dependencies 

between the construction lines. These additional steps are described next. 

Activate the line creation command and move the cursor to the 

construction line defining the right-hand side of the plate. Select 

it with . This highlights the vertical construction line and starts 

rubberbanding of a new line parallel to the selected one. This 

line will be the right-hand side of the plate side view. Fix it at a 

desired location by pressing . As before, the exact distance 

from the selected line can be specified in the property window.   

The new line is created relative to the right-hand side of the plate on the main view. Therefore, when the 

right-hand side of the plate is moved, the new line will follow, staying at the same distance. To place the 

new line at a different distance, use the command for editing construction lines. After that, moving the 

right-hand side of the plate will again preserve the new distance. The dependencies between 

construction entities stay valid until redefined in the construction line editing command. 

The next step is creating the line of the left-hand-side edge of the part on the side view. After 

completing one line, a new line rubberbanding began automatically. 

Note that the currently rubberbanded second line is also a 

dependent of the plate right-hand-side line as the latter is still 

highlighted. This is not our intention; therefore, press  to start 

line creation anew. Select the last created line – the one marking 

the right-hand side of the side view - by clicking  on it. 

Rubberband the new line up to the approximate location, and fix 

with , or enter exact value in the property window.  

We recommend using specifically the right-hand side of the part main view as the base line, and 

construct all the rest vertical lines with respect to it. In this way, the line-to-line distances will be positive 

which is preferable in some situations. 

Now let’s proceed with constructing the projection of the conical 

hole. First, let’s create horizontal lines tangent to the top and 

bottom of the inner and outer circles of the hole. These lines will 

be used as guides for the side view of the hole. 
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Press  once to restart line creation, move the cursor to the 

horizontal symmetry line, and select it by pressing  or typing 

<L>. The line gets highlighted. Rubberband the new line by 

moving cursor to the outer circle and type <C>. The line is 

created parallel to the horizontal symmetry line and tangent to 

the circle. 

Repeat the same sequence of actions three more times: for the 

top tangency with the inner circle, and the two bottom 

tangencies. 

 

 

Now we have the necessary guides for applying graphics on the 

side view.  

Call G: Create Graphic Line command and apply solid lines 

between the four corners of the plate side view. Simply move the 

cursor from corner to corner clicking  on each corner node, and 

then quit with .  
 

Next, apply the two lines representing the conical hole. The view 

is now almost complete, with only the hatch yet to be created. 

 

The hatch is created by H: Create Hatch command. Use 

 
 

Icon Ribbon 

 

Draw → Draw → Hatch 

Keyboard Textual Menu 

<H> Construct > Hatch 

Set the following option, unless on by default, 

 <A> Automatic Contour search mode 

Then move the cursor to the top portion of the side view, place within the area to be hatched, and press 

. The top contour gets highlighted. Next, type <P> to invoke the hatch area parameters dialog. Specify 

the type and scale factor of the hatch. Pressing  in the automenu completes hatching of the selected 

area. 
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Repeat the same actions to hatch the bottom portion of the plate. 

 

It is also possible to create a single hatch consisting of two contours, instead of creating two separate 

hatches. To do so, one could select the second contour right after the first one, and then press <End> 

key or pick  icon in the automenu. 

 

Once the hatch is created, proceed with the plan view. Call the line creation command “L: Construct Line”. 

Select the bottom line of the main view in order to create dependency of the plan view on the main view. 

Rubberband the new line to a location below the main view and fix with . Then quit next parallel line 

creation with . 

 

Let’s try creating the plan view in such a way that modifications of other views propagated on the plan 

view via the established dependencies. The simplest way to create a dependency in projective drawing is 

creating a slanted line at 45-degree angle to the side lines of the side and plan view. The rest of auxiliary 

construction is done with respect to this slanted line. 

 

Let’s again use the symmetry line creation functionality, this time with a slanted symmetry line in mind. 

Since the lines of the side and the plan views are orthogonal, the resulting symmetry line will pass at the 

intended 45-degree angle. 

Call the option . Point at the right-hand-side line of the side view and select with  or <L>. The line 

will get highlighted. Next, select the bottom line of the plan view by same means. A new line will be 

created passing through the intersection of the two selected lines at 45 degree to each. 
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Let’s create all necessary nodes at intersections while within the line creation command. The relevant 

intersection points are those on the right-hand-side line of the side view and the newly created slanted 

line. To create a node, place the cursor at an intersection and press the <Space> bar. 

 

Another way of creating nodes is using command N: Construct Node via: 

Icon Ribbon 

 

Draw → Construct → Node 

Keyboard Textual Menu 

<N> Construct > Node  

You should still be within the command “L: Construct Line”. Point the cursor at and select the bottom line 

of the plan view. This way we can create a line parallel to the bottom-side one. Now, move the cursor to 

the newly created node and type <N>. This creates a line parallel to the selected one and passing 

through the specified node. Thus, the top and the side view become parametrically related. 

To witness this, call the construction line editing command EC: Edit Construction. Try changing location 

of the left-hand-side line of the side view. To do so, select it, move and fix in the new position. Note now 

that the corresponding line on the plan view moves accordingly. 
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Construction of the conical hole on the plan view follows the same steps as on the side view. Select a 

vertical line while in the construction line creation command, and create four parallel lines tangent to the 

two circles. 

 

Now one can draw all graphic lines on the plan view. Use the command “G: Create Graphic Line” to draw 

the perimeter of the plan view. 

 

 

Next step is to apply the two dashed lines corresponding to the conical hole. Set the “HIDDEN” line type 

in the system toolbar. 

 

Then create the two dashed lines representing the conical hole. 
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Now, let’s create centerlines. Call “AX: Create Axis” command: 

Icon Ribbon 

 

Draw → Draw → Axis 

Keyboard Textual Menu 

<АХ> Draw > Axis 

Set the automenu option: 
  

 <I> Create Axis of two Graphics lines 
  

Use  to select the left and then the right-hand side of the elevation view. Push the  automenu 

button. This creates a centerline on the elevation view. Similarly, create a horizontal centerline on the 

elevation view and those on the side and plan views. 

One could notice that all construction lines created so far were infinite. For convenience, an option is 

provided in the command “EC: Edit Construction” for trimming construction lines at outermost nodes. 

This works as follows, 

 

1. Call EC: Edit Construction command. 

2. Selecting one particular line and typing <T> or pushing  trims this selected line only. 

3. Using option  trims all lines. 
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4. If you want to revert to the infinite line setting, call the command ST: Set Document 

Parameters: 

Icon Ribbon 

 

Edit → Document → Document Parameters 

 

Keyboard Textual Menu 

<ST> Customize > Document Parameters 
 

Go to the parameter View > Construction Lines > Length and 

set it to “Default infinite”. Alternatively, enter the command 

EC: Edit Construction, select desired lines, type <P> and 

specify an appropriate setting.  

The diagram shows a drawing with construction lines trimmed. 

It appears less crowded, although all necessary construction 

entities are present. By default, construction lines are not 

output to the printer or plotter, regardless of their length. 

Next, let’s create the necessary dimensions on the drawing as 

follows:  

1. First, let’s create linear dimensions. Call the command D: Create Dimension: 

Icon Ribbon 

 

Draw → Title Block → Dimension 

Keyboard Textual Menu 

<D> Construct > Dimension 

 

One can select any pair of construction lines or graphic lines to create a linear or angular dimension. 

Select the two outermost lines on the main view by . This starts rubberbanding of a dimension 

following the cursor motion. To change any dimension parameter, type <P> or push the  button in 

the automenu. The dimension parameters dialog box will appear on screen. Specify the desired 

parameters, close the dialog, and fix dimension placement with . To change the size of the dimension 

string font, use the command ST: Set Document Parameters, the Font tab. The font parameters can be 

specified on this tab for the elements that did not have such parameters set originally.  

2. Repeat the steps of the item 1 for the rest of the linear dimensions. 

3. Diameter and radius dimension creation is also straightforward. While in D: Create Dimension  
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command, move the cursor to a circle to be dimensioned, and 

type <C> or click . The circle gets selected, and a dimension 

begins rubberbanding after the cursor. Switch between the 

radius and diameter dimension types by typing <R> and <D> or 

picking  and  buttons of the automenu as appropriate. 

Typing <M> loops through the possible witness/leader line 

configurations for the entity to be dimensioned. The <Tab> key 

handles the direction of the dimension leader line jog. Point the 

cursor at the desired location and press . The newly created 

dimension will be displayed on the screen. Repeat this 

procedure to dimension all circles. 
 

After finishing construction of all major elements, one can hide all construction entities using the 

command SH: Set Levels: 

Icon Ribbon 

 

Edit → Document → Levels 

Keyboard Textual Menu 

<SH> Customize > Levels 

This command controls visibility of various elements. An element visibility depends on the “level” at 

which it is residing. 

After calling the command, a dialog box appears on screen that allows setting a range of visible levels for 

each element type of the model. 
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Think of levels as transparent films with images drawn on them. The complete drawing consists of all of 

them overlapped. The system permits making one or more levels invisible, displaying only intended ones. 

A drawing may consist from up to 255 levels enumerated from -126 to 127. 

All elements in T-FLEX CAD are automatically created on the level “0”. One can re-assign any element to 

another level at any time. In our example, we did not change levels of any element; therefore, all created 

elements fell in the level “0”. 

As appears on the diagram above, all elements are visible by default 

whose level is in the range from 0 to 127. Setting the low limit of 

the visible range to 1 for construction lines and nodes hides the 

construction lines and nodes, because they reside on the level 0 

which is not within the new range.  

A simpler way to hide construction lines and nodes is to use a 

dedicated command. This command hides or shows all construction 

entities in the current window. It is preferable in the situations when 

hiding construction should not affect the document data, rather, 

the current window only. 
 

It is thus possible to open the same document in several windows, and have construction entities 

displayed in some windows, and hidden in others. 

 

Call the command via 

Keyboard Textual Menu Icon 

<Ctrl><Shift><C> View > Hide Construction  

5. Let’s make a line of text containing the name of the drawing using command “TE: Create Text”. Call 

the command via 

Icon Ribbon 

 

Draw → Title Block → Text 

Keyboard Textual Menu 

<TE> Construct > Text 

In the automenu of the command, turn on the option: 

 <D> Create string text 

A text can be “snapped” to any construction entity on the drawing in order to have it move together with 

the drawing elements being modified.  
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Move cursor to the intersection of the vertical centerline and the 

top line on the main view. Type <N> in order to snap the text to 

the node at the intersection. Move the cursor to the text placement 

point and press . The text editor window appears on screen. Type 

a line of text “Sample Plate Drawing” and push [OK] button. 

Should the text not be placed as intended, this can be corrected 

easily. Quit the text creation command. Point and click  at the text. 

This automatically starts the editing command ET: Edit Text. The 

selected text starts moving after the cursor. Locate it as desired and 

click .  

To explicitly call the text editing command, use 

Keyboard Textual Menu Icon 

<ET> Edit > Draw > Text  

In this case, select the text to be edited after launching the command. 

There is another way of creating a text, which is typing it directly in the drawing area. To do so, 

enter the “TE: Create Text” command and set the option <Т> - “Create paragraph text” (icon 

). Move the cursor to the intended location of the text and press . A rectangle starts 

rubberbanding on screen that defines the text box. Define the intended area and click , then 

push the  icon. A blinking cursor will appear in the box. Make sure of the correct input locale 

and enter the intended text. Then push the  icon or <F5> key. 

The drawing is now finished. One can try moving construction lines using construction editing command. 

When editing, fix line new placement by either using  or specifying exact line location in the property 

window or parameters dialog (the latter accessible via the  pick). Note that the whole drawing, 

including dimensions, adequately responds to modifications. Changing diameters of the conical hole 

instantly reflects on the two other views. Hatches also adjust to their defining contours. Now one can 

easily witness the powerful capabilities brought in by the parametric technology. 

From now, we will assign variables and expressions to the various drawing elements. Select the left-hand-

side line on the main view by clicking . 

The line will get highlighted, along with the one it is dependent on 

by construction. Line editing command will automatically activate as 

well. The two parameters are displayed in the property window. The 

first one is the original distance, and the second is the current value 

according to the cursor position. 
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Since the line was originally created as parallel to the left-hand side of the plate, the displayed distance is 

the distance  between  the right  and  the  left-hand side of the plate.  Instead of a specific value, one  

can  input a 

variable. Type a variable name “w” instead of the value and press 

<Enter> or [OK]. 

A new dialog window will appear requesting a confirmation for 

the new variable to be created. 

Please note that the variable naming is case-sensitive. A variable 

“w” is not the same as “W”. 

The created variable «w» and the value assigned for this variable 

can be seen in the window “Variables” located, by default, under 

the properties window. Point with a cursor at the number in the 

column “Expression”, press  to enter the edit mode and specify 

the value for the variable, for example, «170». The line will move 

to a different location corresponding to the new value of the 

plate width. 

 

 

The same operations can be carried out in the dialog window of the command “V: Edit Variables”: 

Icon Ribbon 

 

Title Block → Additional → Variables 

Keyboard Textual Menu 

<V> Parameters > Variables 

 

Similarly, define a variable “H” as the distance from the base line to the top side of the main view. Select 

the line on the drawing by clicking  and enter the variable name in the property window. Now there will 

be already two variables in the window “Variables”, and you can, by modifying their values, observe the 

change in the drawing. 

Try making an expression. In the window “Variables” place the cursor in the field “Expression” of the 

variable «H» and press  to enter the edit mode. Specify the expression «w/2» instead of the numerical 

value. This means that the value of “H” will be equal to the half of “w”. From now on, changing just the 

value of “w” will automatically reflect on the value of “H”.  

Next, let’s assign an “R” variable to the radius of the circle defining the fillet at the upper-right corner of 

the plate. Select the circle on the drawing by . In the property window specify the radius as “R” variable. 

After confirming its creation, in the window “Variables” set the variable to the following expression: w < 

100 ? 0 : 6 

This expression means that “R” equals 0 when “w” is less than 100, and equals 6 otherwise. 
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Let’s briefly explain the syntax of the expression. Its members are described as follows. 

< - is the “less than” sign 

? - means “then”, “in such a case” 

: - means “else”, “otherwise” 

The complete expression is written as 

R = w < 100 ? 0 : 6 

The value of “R” equals 0, if “w” < 100, and equals 6 for any other value of “w”. Therefore, there are only 

two possible values of “R” - either “0” or “6”. 

Check this on your drawing. Try setting “w” values greater or less than 100, and watch what’s happening. 

Note that when the radius of the fillet equals 0, then the radial dimension automatically disappears. The 

system does it for the user. 

Therefore, one can create a variety of relations between variables, including quite complex ones, using 

just a few basic terms. You will get to know all capabilities of the variables functionality in later chapters. 

CREATING SKETCH ,  NON-PARAME TRIC  DRAWING  

We will use the same familiar drawing example of the plate with a conical hole. Let’s begin with 

constructing the main view. Thereafter, we will create two projections, the “Left Side View” and the “Plan 

View”, using object snapping mechanism.  

In this case, all construction is done using the command SK: Create Sketch. Call the command via 

Icon Ribbon 

 

Draw → Sketch 

Keyboard Textual Menu 

<SK> Construct > Sketch 

 

This command can be used to create either a sketch (nonparametric drawing) or a parametric drawing 

in the automatic parameterization mode. Since we are going to create specifically a sketch, please  

make sure that the automatic parameterization icon is switched off on the “View” toolbar 

 Automatic parameterization on/off 
 

When creating a sketch, object snaps are widely used. 

The control over snaps is performed with the “Snaps” 

toolbar. To access this toolbar, press the icon  on the 

toolbar “View”. 

All snaps turned on by the present moment correspond 

to the toolbar icons which have been pressed.  
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To turn off a pushed option, point at and click  on the respective icon. To turn off snapping completely, 

set the option: 

 
 Clear all sketch Snaps 

Unsetting this option sets all snaps on. In our exercise, the following snaps will be used:  

 
 Line Midpoint 

  Horizontal / Vertical 

  Orthogonal 

  Line Intersection 

  Horizontal/Vertical tangent 

Push these icons on the Snaps toolbar. The object snaps can also be managed within the command 

SO: Set System Options, using Snap tab.  

When creating line segments, arcs and circles, the point coordinates can be defined by simply clicking  

in the drawing area. To specify exact node coordinates, one can use the property window.  

The two options are turned on automatically in the automenu while within the sketch creation command: 

 <J> Continuous creation 

 <S> Line 

The first icon allows drawing continuously, so that the end of a just created line becomes the start of the 

new line. This mode will stay active until the user turns it off by pointing at the icon and clicking . We 

recommend keeping this option on for speedy sketching. The other option sets the segment input mode. 

A black triangle in the lower-right corner of the icon marks availability of more options. To access these 

encapsulated options, press  and hold a bit longer, and a menu of options will appear.  

 

Attention: the automenu may display any of the encapsulated option icons in the given position. 

Usually this is the icon of the last used option among the encapsulated set.  

In “Sketch” automenu, each set of encapsulated options corresponds to a group of actions related to 

same-type element creation, such as creating segments, arcs, or circles.  
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The cursor on screen appears as a little square. Move the cursor to the 

intended location at the lower-right corner of the main view, near the middle 

of the screen, and press . This creates the first node of a line segment and 

starts rubberbanding the segment to be created. At the same time, the fixed 

coordinates of the first point are displayed in the property window.   

While sketching, consider leaving sufficient margins. This space will later be used for creating 

dimensions. 

Move the cursor upward. Note that the coordinates of the cursor are 

dynamically updated in the property window, along with the vertical and 

horizontal shifts from the start node of the segment. We can use the 

property window for specifying exact location of the segment end. The end 

node can be defined in several ways. One way is to enter absolute Cartesian 

coordinates (X, Y) of the segment end node. Another way is specifying X and 

Y shifts of the end node from the segment start (dx, dy). Yet another way is 

to define the end of the segment in polar coordinates, or as a combination 

of the other ways.  
 

Let’s create the end of the segment by specifying its shift from the start 

point. Make “dx” value equal to 0, and “dy” parameter equal to 100. The 

parameters “X” и “Y” will instantly update with the absolute coordinates of 

the segment end and get checkmarked. Checkmarking locks the value of the 

respective coordinate in spite of cursor movements. The end node of the 

segment will be displayed in the drawing window per the entered 

coordinate values.  
 

To complete the end node input, press [Enter] or click  in the drawing area. 

The first segment will be created. Move the cursor leftwards and place it so 

that it snaps to the horizontal constraint with respect to the last created 

node. The snap will be indicated by the specific glyph next to the cursor, and 

a pop-up help message saying “Horizontal”. 
 

 

To lock this snap, press <Space> bar. Then, a horizontal helper line will be 

displayed passing through the node snapped to. The cursor will keep sliding 

along this helper line as an unattached node. The same effect can be 

achieved by setting the “dx” shift to 0 in the property window and locking 

the X coordinate with the checkmark. 
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Place cursor on the side of the segment intended direction. Type the value 

of the “dx” shift for the end node of the segment being created in the 

property window. In our case, this value represents the width of the part and 

is equal to -150, while “dy” equals 0. The new segment will be created upon 

confirmation by pressing [Enter] or . 
 

 

You are still within the segment creation mode. For further construction, you 

need to move the cursor downward to a point where snapping occurs to 

both horizontal and vertical constraints simultaneously. This will be indicated 

by a special glyph next to cursor and pop-up help message. Press  . A new 

segment is created. 

 
 

Move the cursor rightward to snap at the very first created node, as indicated 

by a glyph and the pop-up help, and press . We have thus completed the 

perimeter of the main view. We are still in line rubberbanding mode, with a 

new line stretching from the last created node to the cursor. Quit this line 

rubberbanding by clicking . 

Now you are still within continuous segment input mode, with snapping 

active but no line rubberbanding after the cursor. 
 

The next step is to round the corner of the plate. To do so, set the option: 

 <Ctrl+A> Fillet 

This option belongs to an encapsulated set and may not necessarily be displayed in the automenu. 

Instead, it may be under the fillet/chamfer icon group (see explanation above). 

Once the option is set, the property window changes appearance. 

Now it provides the input box for the fillet radius. Set the radius 

value equal to 31.  

What is left now is to select two segments to be filleted. In our case, it is the top and the right-hand-side 

segments of the plate. Once the second segment is selected, the fillet is created, and the segments 

trimmed appropriately.  

             

Now let’s draw the conical hole on the main view. To do so, let’s create two centerlines whose 

intersection will define the exact location of the center of the hole. Set the option 
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 <S> Line 

Once this is set, rubberbanding resumes with a line attached to the last created node. Reject this line by 

clicking . To create centerlines, set the appropriate line type. Set the line type to DASHDOT in the 

system toolbar or in the graphic line parameters of the dialog box. Call the dialog box by 

 <Р> Set Graphic line Parameters 

Then move the cursor to the left-hand-side graphic line segment to get vertical snapping to one of the 

segment nodes, and slide the cursor along the segment to its midpoint. When the cursor reaches the 

midpoint, the glyph beside the cursor will change to indicate this, along with the pop-up help. 

 

Press  here. A node will be created at the midpoint, and a line will start rubberbanding from this node. 

Move the cursor horizontally to the right-hand-side graphic segment and stop at the intersection of the 

horizontal and vertical projections of the two nodes as shown on the diagram.  

 

Press , creating a centerline and a node. Rubberbanding resumes from the latest node. As we do not 

intend to construct another line through this node, quit rubberbanding with . Then follow the same 

steps to create the vertical centerline, beginning at the bottom segment.  

                        

Now, let’s create circles. First, reset the line type to CONTINUOUS by selecting in the system toolbar or in 

the command parameters dialog box. Call the dialog by typing <P>. Then pick the option: 

 <O> Circle By Center And Radius 

This is also an encapsulated option that may not be shown on the automenu, rather, be within a group of 

options.  
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After activating the option, move the cursor to the intersection 

of the two centerlines. Both centerlines will get highlighted, and 

the cursor will gain a glyph and a pop-up help of the graphic 

line intersection snap. Press  here. A circle starts 

rubberbanding on screen. 
 

 

Enter the value of the radius of the smaller circle of the cone 

equal to 25 in the property window, and press [Enter] key. A 

full circle is now fixed on screen. Now you are still in the circle 

creation mode. Select the node at the two centerlines 

intersection and create a circle of a bigger radius, 35. This 

mostly completes creation of the main view of the part.  
 

Now, let’s construct the left side view. Again, set the line 

creation mode via the  option. Line rubberbanding resumes 

on screen with the line attached to the end node of the last 

created segment. Since we are not making a line from this 

node, quit with . Move the cursor to the right of the drawing 

area and place it so to snap to the horizontal constraint with 

respect to a node of the top line of the main view. 
 

Click here , and move the cursor horizontally rightwards. In the property window, set the end node 

shifts. Set the Х equal to 35, Y to 0. Press [Enter] or . The new segment will be fixed on screen, and 

rubberbanding resume from the last created node. Next, move the cursor vertically downward 

maintaining the “vertical” snap, up to the point when snapping occurs with a node of the bottom line of 

the main view. Click there , then move the cursor leftwards to snap against the left-hand-side end of 

the top segment. 

       

Click . Now close the perimeter of graphic lines by moving cursor to the first created node on this view, 

and clicking , and then . 

One-degree-of-freedom snaps can be locked by pressing <Space> bar. 

Next, we need to create the image of the conical hole on the side view. Without quitting the current 

command, move the cursor to the right-hand-side segment of the side view, and move along the 

segment until it snaps to horizontal tangency against the top of the bigger circle 
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Click  at this spot, then move the cursor to the left-hand-side segment of the side view and locate so to 

get it snapped against the smaller circle. 

 

Click , and a segment will be created, with rubberbanding resuming from its end node. For now, quit 

rubberbanding by clicking . Then construct the lower segment of the hole view in the same way. Next, 

using already familiar snapping constraints, construct the centerline, setting the line type to DASHDOT in 

the graphic line parameter dialog box (the key <Р>) or in the system toolbar. 

 

Proceed with the plan view. This view can be created in the same way as the side view. However, for 

deeper exploration of non-parametric drawing capabilities, we will follow a different approach. Set the 

option: 

 <D> Parallel Line 

This is an encapsulated option in the segment creation group. If this icon is not displayed in the 

automenu, find it under one of the group icons marked with a black triangle (see explanation above).  

Once this option is set, the cursor starts rubberbanding an auxiliary infinite line parallel to the last 

created segment. The reference segment is highlighted. The current reference suites us. Otherwise, we 

would reject the system-selected segment with  and select an intended one to construct a parallel line. 

Make sure the line type is back to CONTINUOUS in the graphic line parameter dialog (the key <P>) or in 

the system toolbar. Move the cursor to get a snap against a node of the main view, and click . A node 

will be created at this point, and the auxiliary line will get fixed. Slide the cursor along the line up to the 

point of another vertical snapping, and again click . 
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Thus, we have created the top segment of the plan view. A new auxiliary line starts rubberbanding after 

the cursor, parallel to the newly created graphic segment, as indicated by highlighting. Move the cursor 

down, and set the desired distance, equal to 35, in the property window, thus defining the thickness of 

the plate. This will fix the auxiliary line with respect to the reference segment. Slide the cursor along the 

line, locating as shown on the diagram. 

 

Click , fixing the start node of the segment being created. Slide the cursor rightwards to get vertical 

snap against the end node of the reference segment, and again click . The bottom segment will be 

created. At this moment, parallel line rubberbanding resumes. Now, set the option , thus switching to 

normal continuous line input mode. A line will start rubberbanding, attached to the last created node. 

Move the cursor upward to the top segment node, and click , and then . Next, connect the left-hand-

side ends on the plan view with another segment. Create the centerline and the lines of the conical hole 

projection in the same way as on the side view. Doing so, maintain the appropriate line types. 
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What is left now is to apply hatch on the side view. Call the command “H: Create Hatch”: 

 <Н> Create Hatch 

Set the option: 

 <A> Automatic Contour search mode 

Then move the cursor to the top portion of the side view, place it in the middle of the area to be 

hatched, and click . The closed contour will be highlighted. Now move the cursor to the lower portion 

of the view, and similarly select the other contour to be hatched. Then pick the  button. 

 

Now, let’s create the necessary dimensions on the drawing. Dimensions are created on a sketch in the 

same way as on a parametric drawing. One can select graphic lines instead of construction lines in this 

case. Let’s skip the detailed description of this functionality, as it was described in depth as part of the 

main drawing technique. 
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This completes creation of the non-parametric drawing. Further modification of its elements will not 

affect the whole drawing. One would have to modify each view separately. The elements of such a 

drawing cannot be related by variables. All other functionalities such as use of visibility levels, layers, 

hide/show construction entities, etc. are fully supported. 

CREATING A PARAMET RIC  D RAWING IN THE AUTOMATI C 

PARA METERIZATI ON MODE  

We will use the same drawing as an example. The sequence of constructions will be the same as 

described in the previous section of this chapter. 

When working in the automatic parameterization mode, we will be creating only graphic lines (as when 

constructing a sketch). Meanwhile, the system will be automatically "slipping" nodes and construction 

lines with parametric relations underneath those graphic lines. What constructions to create and what 

dependencies to use in relations is determined by the system based on the user-selected snaps and 

parameters defined in the command's property window when creating sketched lines.  

Call the command “SK: Create Sketch”. Make sure that the following snaps are enabled: 

 Construction 

 Line Midpoint 

 Horizontal/Vertical 

 Orthogonal 

 Graphic Line Intersection 

 Horizontal/Vertical tangent 
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To create a parametric drawing, the automatic parameterization mode must be turned On in the system. 

This mode is enabled with the icon on the “View” bar: 

 Automatic parameterization On/Off 

We will start with creating the main view of the plate. If necessary, enable the line segment creation 

option  in the command's automenu (if desired). Create the first point of the segment, corresponding 

to the lower-right corner of the plate's main view. Please note that it was not a free node that was 

created at the location of the click, rather, there are two crossed lines (vertical and horizontal), and a 

node at their intersection.  

For the second node of the segment, define the Y-

axis offset (100) in the properties window. The 

cursor will start moving along a horizontal auxiliary 

line. Move it to the vertical construction line going 

through the first segment node. When the snap to 

the latter line engages (“Line …”), click . 

As a result, the second node of the created 

segment will also be constructed as snapped. It will 

lie on the intersection of the vertical line created at 

the time of constructing the first node, and a line 

parallel to the horizontal line of the first node. 
 

Please note, that, when selecting a snap, the system may offer the vertical snap to the first segment node 

rather than snapping to the line (the order of displaying snaps is determined by the settings in the 

command SO: Set System Options). To select the desired snap, do the following: briefly rest the cursor at 

the location of the snap activation. After a brief while, the cursor will change its shape: the mark  and 

a tooltip will appear next to it, showing the total number of object snaps found at this point. Using the 

mouse wheel, you can scroll through those snaps. In the ongoing construction, select the desired snap 

from the list of possible ones at a given point using the same method. 
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Create the second, horizontal, line segment with the length 150. 

When constructing it, specify the desired offset along the X-axis 

and use a snap to the line again.  

If all was done correctly, then the created line segment will lie 

on the line created at the time of constructing the second node 

of the previous segment. Meanwhile, the second node of the 

current segment will be constructed as one lying on the 

intersection of the same line and a new line parallel to the very 

first vertical line. 
 

The third line segment, again vertical, is constructed by 

snapping to two existing lines at once. 

 

The fourth segment must be closing the described rectangle. 

After that, move the cursor rightward up to the first created 

node, as indicated by a special mark in the dynamic tooltip, and 

click . This completes the base for the part's main view. 

 

Please note, that the resulting drawing we obtained is the same 

as when constructing a parametric drawing by the conventional 

approach (as was described in the first section of this chapter). 

Just like when creating a sketch, to create a fillet one would 

need to quit the continuous line input mode (using ). 

To create the fillet, let's use the option . After activating the 

option, set the fillet radius equal to 31 in the properties window.  
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After that, select two segments, at whose intersection the fillet 

needs to be constructed (the top and the right-hand-side 

segments of the plate) or the node (the rectangle vertex) at 

their intersection. 

This will result in constructing a graphic line – a circular arc with 

a "slipped underneath" construction line-circle. Just like when 

creating a common sketch, the extra pieces of the fillet 

segments will be automatically trimmed. 

Next, we will create the image of the conical hole.  

 

We will start with creating the axes. To create the axes, enable the  option again. Set the “Axis” line 

type in the system panel or in the graphic line parameters (the option ). 

Move the cursor to the middle of the left-hand-side segment of the plate's main view image. Construct 

the first node of the axis using the line midpoint snap. Move the cursor horizontally to the right-hand-

side segment of the image and stop it at the intersection of the two lines as shown on the figure. Click . 

The created segment will lie on the line that divides the segment (the left-hand side of the main view) in 

the 0.5 ratio. 

                  

Similarly construct the vertical axis. 
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Now, let's create the circles. Set the normal graphic line type. 

After that, select the option . Move the cursor to the 

intersection of the axial lines, wait until the tooltip appears 

indicating the available snapping to the intersection lines. Click  

right there. A rubberbanding circle will appear on the screen. 

Set the radius value equal to 25 for the smaller circle of the 

conical hole and click  or press the button [Enter]. Similarly 

construct the second circle with the radius equal to 35. 
 

Please note that the construction result is not just free graphic lines representing the circles. The system 

constructed them as lying on the construction lines-circles. 

  

Now let's create the left view. To do that, enable the segment creation mode again (the option ). If 

the system offers creating a segment from the last created node, refuse that by right-clicking . Move 

the cursor to the right-hand side of the drawing and set it so as to maintain the snap to the top line of 

the main drawing view. 

 

Click there . The first node of the new segment will be constructed as lying on the selected construction 

line. 

Move the cursor horizontally rightward. In the properties window set the offset of the second point along 

the X-axis equal to 35. Then move the cursor so as to pick the snap to the top line of the main view. Click 

. As a result, the second segment node will also lie on the top line of the main view at the distance 35 

from the first node. 
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Then move the cursor downward vertically to the last created node up until a snap to two lines appears 

on the screen.  

 

Click  and move the cursor leftwards till snapping to two other lines. 

 

Click . Now, close the created graphic lines by moving the cursor to the first created node on this view, 

and click , then  (to cancel the mode of continuous line input). 

After that, we will create the lines belonging to the conical hole, on the left view. Move the cursor to the 

right-hand-side segment of the left view, and then move it along that segment up until establishing the 

relation between the line underlying that segment and the greater circle. Click  right there. 
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Move the cursor to the left-hand-side segment of the same view so as to establish the relation between 

the smaller circle and the line underlying that segment. Click . 

 

As a result, a segment will be created. No construction line will be underlying that segment. Nevertheless, 

each segment node will be constructed as a node at an intersection of the selected line and the line 

tangent to the circle. 

Next, use the same method to construct the lower line of the conical hole. Then create the centerline by 

snapping to the middles of the lateral sides of the left view. Do not forget to also set the dash-dot line 

type in the graphic line parameters (the option ) or on the system panel. 

 

Let's proceed to creating the top (plan) view. We will create it a little bit different then when creating a 

simple sketch. We will not use the option of constructing a parallel segment. Now there is no practical 

necessity in defining that particular relation. When using the automatic parameterization mode, the use 

of that option will make the system try to create a construction line beneath the segment parallel to a 

line beneath another segment. As a result, relations would be created that we didn't need. Therefore, we 

will continue using the option . 

Do not forget to reset the normal line type after finishing the creation of the centerline (in the 

graphic line parameters or on the system panel). 
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Move the cursor to the drawing area below the main view so as to invoke the desired relation with the 

line of the main view. Click . The first segment node will be created as lying on the intersection of the 

main view line and the horizontal line. 

 

Next, move the cursor rightward up until hitting the snap to another line of the main view. Click  again. 

We have just created the upper segment of the top view. 

 

Next, we will have to temporarily quit the sketching command. The reason for that is that it is impossible 

to create a relation between the left view and the top view by the common means of automatic 

parameterization. Such relation can be achieved only by various workaround methods (for example, 

introducing variables as the parameters of the segments being created). But we will simply use the 

command L: Construct Line and create an auxiliary line at the angle of 45° to the outer lines of the left 

view and top view (just as we did in the conventional creation of the parametric drawing). 

So go ahead and call the command L: Construct Line. With the help of the option , construct a line – 

the symmetry axis between the left-hand-side vertical line of the left view and the horizontal line of the 

top view. Place the cursor at the intersection point of the created line and the right-hand-side vertical 

line of the left view, and then press the button <Space>. 
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After that, call the command SK: Create Sketch again. We will create the next segment of the top view. 

Select the end node of the last created segment as the first node of the next segment. Then move the 

cursor up until reaching the intersection between the line and the horizontal through the node as shown 

on the figure. Fix the achieved point by clicking . 

 

 

The next segment is constructed by snapping to two lines. 
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Next we need to close the created graphic lines of the top view by moving the cursor to the first created 

node of the view and clicking , followed by  (to cancel the continuous line input mode). 

Create the centerline and the lines defining the conical hole (just like that on the left view). 

 

Create the hatch on the left view and the dimensions in the same way as in the previous cases. 
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This completes the creation of a parametric drawing in the automatic parameterization mode. From now 

on, such drawing will behave just as a common parametric drawing. 

To test, move the cursor to the segment that makes up the left border of the main view, and click . The 

command will be launched to edit the selected graphic line. If you click  on the line once again, the 

system will automatically go into the command of editing the construction line underlying this graphic 

line. Move the line around, define the new position by . The width of the plate main view shall 

automatically change. Besides that, the top view should change as well, since it was constructed by 

snapping to the lines of the front view. 

 

Similarly, try to edit the position of the right boundary of the main view. In this case, the entire plate 

drawing will move. Try the same with other drawing elements, including circles. As construction elements 

are moved, the shape and dimensions of the plate will be changing so as to maintain the relations 

defined by the construction. 

This completes the brief introductory course. Please feel free to refer to the rest of T-FLEX CAD 

documentation for detailed description of various system functionalities. 
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MAIN CONCEPTS OF SYSTEM OPERATION  

DOCUMENT MANAGEMENT  

Creating New Document 

For creating new documents the dialog box “Start Page” can be used (see the chapter “Getting Started”). 

This dialog box is always present on the screen when the standard settings of the system are used. This 

dialog box enables to create new documents on the basis of the templates and also open already 

existing documents from the list of recently used ones. In addition to the dialog box “Start Page”, the 

commands grouped in the textual menu File can also be used for creating new documents. 

To create a new drawing, use the command FN: Create New Model: 

 

Icon Ribbon 

 

Get started→ Files → Drawing 

Keyboard Textual Menu 

<FN>, 

<Ctrl><N> 
File > New > Drawing 

A command F3: Create New 3D Model allows to create a 3D model: 

Icon Ribbon 

 

Get started→ Files →3D Model 

Keyboard Textual Menu 

<F3> File > New > 3D Model 

To create a new assembly drawing, use the command: 

Icon Ribbon 

 

Get started→ Files → Assembly Drawing 

Keyboard Textual Menu 

 
File > New > Assembly Drawing 

To create a new 3D assembly, use the command: 

Icon Ribbon 

 

Get started→ Files →3D Assembly 

Keyboard Textual Menu 

 
File > New > 3D Assembly 
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Product structures of assembly documents include records for an assembly forming. It’s their only 

differ from the standard documents. 

A created document name depends on the document prototype. Forstly created drawing will be called 

“Drawing 1”, firstly created detail – “Detail 1”. You can assign any other name upon saving the document. 

 

T-FLEX CAD does not distinguish between the 2D drawing and 3D drawing files. In the document 

created as a 2D drawing, the 3D model can be generated afterwards. In the document created 

with the use of the command F3: Create new 3D model the new 2D drawings could be generated. 

To create new documents, template files are used that are defined in the command Customize > 

Settings…, the tab “Files”. They contain elements and settings for the new document. 

 

You can change prototype manually by editing of the respective template file or enter another template 

file name. 

The prototype files should be placed in the folder “…T-FLEX CAD\PROGRAM\Template”. The name 

of the directory for the template files is set in the command Customize > Options…, the tab 

“Folders”. 

 

A user on his own can create an arbitrary number of prototype files. 

A new file can be created from an existing prototype using the option “New document” of the dialog box 

“Start Page”. Otherwise, use a similar dialog “New From...” by calling the command FP: Create New 

Document Based on Prototype. 

Opening Document 

A T-FLEX CAD document can be opened using the command O: Open Model. Call the command using: 

Icon Ribbon 

 

Get started→ Files → Open 

Keyboard Textual Menu 

<O>, 

<Ctrl> + <O> 
File > Open 

The new window Open will appear on the screen. This is a standard Windows dialog box for opening 

application files. 

The command allows you to open not only *.grb format files, but also open files in formats of other 

systems. 
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When you open the file of another system format, you can select the Open or Open with parameters 

option. 

 

If you select Open with parameters, a dialog similar to the import dialog for the specified format opens. 

In this way, you can open the model with the specified parameters. 

More details about Import can be found in the "Exporting And Importing Documents" chapter. 
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Panning and Zooming in Active Drawing Window 

The drawing image can be panned and zoomed in and out in the active drawing window. Zooming 

effectively changes the size of the working window of the drawing. The easiest way to do these 

manipulations is using a mouse with a middle wheel. Alternatively, the working window size can be 

changed by using the rulers as described below. Besides, a command is provided for this purpose, ZW: 

Zoom Window. Call the command via: 

 

Icon Ribbon 

 

View → Scale → Zoom Area 

Keyboard Textual Menu 

<ZW>, <F3> View > Scale > Zoom Area 

 

The following options are provided with the command: 

 <P> Set command options 

Selecting this option brings up a dialog box on screen with the following parameters: 

Pan percentage. Defines the percentage of the working window shifting left/right and up/down.  

Zoom in/out percentage. Defines the percentage of the working window magnification. 

 

 <A> Zoom All 

This option redraws the working window according to the drawing format size. The latter is set in the 

command ST: Set document parameters. 

 <M> Zoom Limits 

This option calls the command ZM: Zoom Limits that fits the full image to the drawing area. 

 <T> Actual Size 

This option calls the command ZТ: Actual Size the drawing and 3D model in accordance with their real 

dimensions. 

 <I> Zoom In 
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 <O> Zoom Out 

These options respectively magnify and shrink the drawing image each time by a fixed percentage ratio 

specified in the command parameters. 

 <L> Pan Left 

 <R> Pan Right 

 <U> Pan Up 

 <D> Pan Down 

These options move the drawing image by a fixed percentage ratio specified in the command 

parameters.  

 <W> Set absolute window coordinates 
 

 

Calling this option brings a dialog box on screen for inputting window 

coordinates. The user can type in the coordinates of the two opposite 

corners of the working window. 

 
 

 <<Backspace> Zoom previous  

This option resets the active drawing window coordinates to the previous settings. 

 <S> Save current window coordinates 
 

This option allows saving the working window coordinates and assigning an Id to the saved 

configuration. A dialog box appears on screen for entering an Id from 0 to 9 to be assigned to the saved 

window configuration. To return to a saved window, type the number key of the desired Id (<1>, ...). 

 
 

  
Set the working window size by dragging selection 

box 

An arbitrary area of the drawing can be zoomed on by specifying two opposite corners of a box. Move 

the cursor to one corner of the area to be zoomed on, and press and hold . A rectangle starts 
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rubberbanding after the cursor. Drag it, selecting the desired area by box, and then release the button . 

The selected area will be displayed zoomed on. A one-time call to any option of the ZW: Zoom Window 

command can be done asynchronously from within any element creation or editing command by typing 

<F3> function key or selecting the  icon. 

The options of the ZW: Zoom Window command are also accessible via the View > Scale menu and the 

View toolbar. 

 

Status Bar 

The status bar is located at the bottom of the application window. 

 

The status bar has the following fields (left to right): 

The current command name field. This field displays the full name of the current command.  

The field can also be used as the input box for calling a command by typing on keyboard. Type 

the reserved keyboard accelerator sequence or press a function key combination. This can be 

done only when the field is empty, containing only the prompt symbol “>”. Typing a sequence 

that is not part of any command name automatically clears the field. If so, type again. A correctly 

typed accelerator sequence causes the full command name and a brief description to be 

displayed. For instance, type the following sequence, <R><O>. Once typed <O>, you entered the 

command for creating roughness symbols, and the field will display RO: Create Roughness Symbol. 

In the command descriptions down the manual, the respective keyboard accelerator sequences 

will be printed in a single, common pair of triangular brackets, as in <RO>. We will thus 

distinguish those from simultaneous double- or triple-key combinations for calling commands, as, 

for example, <Ctrl><O>. 

Help field. This is an information field displaying help messages and prompts for user. If the cursor 

is within the active drawing window, this field displays suggested user actions. When the 

cursor is pointing at other fields on screen, information is displayed about their purpose. While 

within a command, pointing at an icon of the automenu brings a help message in the field, 

describing the action performed by the option. 

X-coordinate field. 

Y-coordinate field. 

Auxiliary coordinate field. 

Toolbars 

A toolbar is a set of icon buttons for calling the application commands. There can be several toolbars on 

screen simultaneously.  
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In the standard package of the T-FLEX CAD there are five toolbars: “Main toolbar”, “System 

toolbar”, “View”, “Full screen mode”, “Context” (toolbar which appears when entering fragment 

editing mode in the assembly context). In addition to that, any number of user-defined toolbars 

can be created (via the command SB: Show Toolbars). With the help of the same command the 

structure of user-defined and several standard toolbars can be modified as well (for example, of 

the toolbar “View”). 

What toolbars to display is defined in the command “Customize|Customize…” on the “Toolbars” 

tab. Besides, a desired toolbar can be accessed via the context menu by pressing right mouse 

button while over any toolbar.  

Any toolbar can be docked along any of the application 

window borders, or floating within. When floating, a toolbar 

window is titled, and can be resized. 
 

Embedded toolbars 
Several command pictograms in the instrument toolbars can be grouped on the principle of similarity of 

performed functions. In this case the instrument toolbar will show only one pictogram of the given group 

(the rest are not shown), and the button  will be placed on the right side from the pictogram. By 

pressing this button the “embedded” toolbar with the rest of the pictograms of the given group will 

emerge. 

 

The embedded toolbar can be converted into the ordinary instrument toolbar. To do that, it is necessary 

to place the cursor on the header of the embedded toolbar, press  and, without releasing the mouse, 

drag the toolbar to any place of the T-FLEX CAD window.  

 

The buttons of the embedded toolbar can be placed directly on the main toolbar. To do that, it is 

sufficient to press the button on the right end of the embedded toolbar. 
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System Toolbar 

 

The system toolbar is a set of tools for quick definition of element parameters at creation and editing 

time. 

 

Following is the description of the functions of the system toolbar fields and buttons. 

 Layer configuration command button . 

 Layer name box . Displays the layer name of the model elements 

being created and edited. 

 Button for setting visibility levels of the model elements . 

 Level input box . This box displays the current level of the model elements. Changing 

levels can be done within element creation and editing commands. Clicking inside the box sets a 

text cursor. Type in the element level. Confirm the input by pressing <Enter> or clicking  within 

the drawing window. 

 Priority input box . This box displays the current priority of the model elements. 

Changing priority can be done within two-dimensional element creation and editing commands. 

 Color selection box . This box displays the color of the element being created or edited.  

 These are the main items that are always present on the system toolbar. The rest of elements 

replace depending on the application state.  

When in command waiting mode, the system toolbar contains selector controls, as follows: 

 Button for calling selector configuration dialog . Used for specifying exact settings of the 

selector and defining named selector configurations. 

 Button for calling named selector configuration . Brings a pull-down list of available 

configurations. 

Quick selector setup buttons: 
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 The buttons  and  help to quickly allow/disallow selection of all types of elements; 

 The buttons , , , , , , ,  и  define and edit the current set of 

elements allowed for selection. The pushed icons represent the elements allowed for selection. 

The set of buttons will be different when working in the 3D window. 

Other various items may be added to the system toolbar while working with various 2D 

commands. For instance, a line type box appears on the system toolbar while creating lines, along 

with the line start and end arrow type boxes. When creating text, the font name and size boxes are 

displayed. 

Main Toolbar 

 

The main toolbar has a set of buttons which, depending on the currently solved problem and the settings 

of the system, can be selected by the user or automatically activated. 

The button sets in the main toolbar are aimed at solving different problems – geometric 

construction, 3D modeling, analysis, geometric construction on the workplane, operations with 

sheet metal, editing specifications etc. Internal specialized modules, which are included into the T-

FLEX CAD package, can add their own button sets into the main toolbar. For example, the 

application “T-FLEX CAM” adds to the main toolbar a set of buttons which perform the functions 

of this particular application.  

 

Switching between the button sets in the main toolbar occurs automatically depending on the 

operations performed in the working window of the T-FLEX CAD.  

For example, upon opening of the 2D document the set “2D” is turned on automatically, and upon 

transition to the 3D window – the set “3D”. When a drawing is made on the workplane, the set 

“Workplane” or “Workplane (Sketch)” becomes active (depending on what has been used last time 

in the given situation).  

At the beginning of the BOM editing, the button set “BOM” is activated. Upon the exit from the 

BOM editing, the set, which was active before the editing was started, turns back on in the main 

toolbar. 

Some of the standard sets of the main toolbar are invisible by default and shown only upon activating 

the corresponding command of the T-FLEX CAD. For example, the set “Text” is by default not present in 

the list of the main toolbar modes, but upon entering the mode of creating/editing the text, this 

particular set will appear on the main toolbar. 

When the set “Compatible” gets active, the main toolbar itself represents a copy of the standard toolbar 

existing in the earlier versions of the T-FLEX CAD. 
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Switching between the button sets can be done manually by using the button 

on the left side of the toolbar . Upon pressing this button the list of 

available sets pops up.  

The desired set can be chosen with the help of . In addition, several sets can 

be activated from the keyboard with the help of the specified for them key 

combinations.  

By default, the key combinations are assigned only for the sets “2D”, “Sketch”, 

“3D”. In the dialog of the command SB: Show Toolbars it is possible to assign 

key combinations for other sets of the main toolbar as well. 

The user selected set is stored in the window of the current document and 

automatically recovered when the window becomes active. The given setting is 

stored in the document and gets activated when the file is open. 

 

 

It is possible to decline automatic switching between the main toolbar sets by setting on the flag Lock. 

This flag can be found in the context menu, called with the help of  in the auto-menu field or any other 

instrument toolbar. After turning on the flag, the main toolbar state is going to be modified only upon 

manual switching between its sets. 

 

One more flag is available in the same context menu which allows controlling the view of main toolbar – 

Show Tabs. It controls visibility of the tabs on the main toolbar. The tabs allow quick switching between 

the button sets of the toolbar. The tab of the active set is marked with the color. 

 

 

The flag Show Labels enables to add annotations to the buttons of the main toolbar. This can be 

convenient at the first acquaintance with the system or while working with the high resolution monitor. 
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The flag “Large icons” allows turning on the mode of the large icons for the main toolbar (no matter 

what the size of the icons in other system toolbars is). 

 

The command SB: Show Toolbars provides with additional possibilities for controlling the main toolbar. 

Via the tab “Main Toolbar” of the dialog of this command, it is possible to do the following: 

 Hide/show main toolbar sets in the list of sets (displayed upon pressing the button ); 

 Rename the main toolbar sets; 

 Create and remove user's defined sets; 

 Create a separate toolbar on the basis of any set of the main toolbar. 

Bird’s Eye View Window 

The “Bird’s eye view” window helps quick navigation 

around the drawing. It always displays the whole 

drawing image, regardless of the working window size 

currently set for the active drawing window.  

Visibility of the “Bird’s eye view” window can be 

controlled by the textual menu item “Customize|Tool 

Windows|Bird’s Eye View” or via the context menu 

coming up on right mouse button click over any of the 

toolbars.  

The “Bird’s eye view” window can be docked along any 

of the application window borders or stay floating. 
 

The modes of the “Bird’s eye view” window can be controlled via the context menu coming up on right 

mouse button click within the window. 
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Pan. In this mode, a box follows the cursor within the “Bird’s eye view” window indicating the area 

of the drawing to be displayed. The size of the box can be changed by switching to zoom mode. 

To select the area to be viewed on the drawing, press . Dragging the box across the “Bird’s eye 

view” window panes the actual drawing dynamically according to the box movement. 

Zoom. In this mode, no box is displayed on entering 

the “Bird’s eye view” window. Press  in the “Bird’s 

eye view” window to define one corner of the 

viewing box and drag the cursor, rubberbanding the 

box. Doing so, define the area of the drawing to be 

zoomed on, and then release . 

Once defined, the viewing area will be highlighted in 

the “Bird’s eye view” window, and the respective 

portion of the drawing will be zoomed on in the 

active drawing window. 

Properties. Selecting this item brings up a dialog box 

for defining the window update parameters and the 

pan vs. zoom mode selection. 

 

Using Library Explorer 
 

The library explorer window can be used for opening documents for 

editing, along with the O: Open Model command. It comes up on starting 

the application and docks by the left border of the application window. It 

also can stay floating.  

The user can control visibility of the Library Explorer window via the textual 

menu item Customize > Tool Windows > Library Explorer or in the context 

menu on right mouse button click over any toolbar. 

The library explorer shows the content of the open libraries. It allows to 

select libraries, open documents for editing and insert documents into the 

current one as fragments or pictures. 

The library explorer window may have a preview pane at its bottom or 

right-hand side. This pane will display the preview image or the properties 

of the selected document. 

The library explorer window can have various different settings accessible 

by .  

More details on working with the model window and library configurations 

follow in later chapters.   



Main Concepts of System Operation 

105 

External Links 

A T-FLEX CAD document can have links to other files: T-FLEX CAD documents (fragments), graphics files 

(pictures), database files, etc. 

To ease working with composite documents, T-FLEX CAD provides a mechanism of links management. A 

link is a T-FLEX CAD object containing the path to an external file (the target of the link). 

Links are used when creating fragments, pictures and other T-FLEX CAD elements for specifying the 

source of external data. The same link can be used by different elements; for example, several fragments 

based on one file will refer to one link. 

The links management mechanism allows managing the way of storing the link targets. T-FLEX CAD 

allows storing the link targets either outside a T-FLEX CAD document as a conventional external file 

(“external link”), or directly within the file of the composite document (“internal link”). The internal 

storage of the link increases the size of the composite T-FLEX CAD document, but allows dealing with it 

as with one file. 

The links management mechanism solves the problem of moving large assembly documents. By using it, 

you do not have to search for all fragments files that may be located in different folders, on different 

disks, in libraries, etc. All you need to do is to “zip” the assembly model into one file with a provision of 

future unzipping, and move it to another place in the file system or into a storage of a document 

management system. 

Links window serves for managing links in a composite document. To call the window use Customize > 

Tool Windows > External Links command. 

Links window appears upon calling the command. It includes list of all links, existing in the document. 

 

Toolbar 
Some commands for operating with the window are located on a toolbar. 

 

Columns are used to receive information about files included into the document. The columns may be 

selected from the drop-down list. 
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Columns: 

Link. Displays link to the file according to the location of the composite document. If the composite 

document and the file are in the same folder, only the filename will be displayed in the column. 

File Type. Displays the file format. 

Link Type. Displays the link type:  

Embedded  is a link to the document saved within the file of the current document. 

External  is a link to the document stored in the standard filesystem. 

Substitute is a link to an external document whose location was automatically defined by the 

system at the time of running the AM: Move Assembly command with the Substitute setting. 

More information about the command can be found in “Links. Managing Composite Documents” 

chapter. 

 

Full Path. Displays a full path to the file. 

Actuality. Displays file link actuality. 

The  icon indicates that the link is actual. 

The  icon indicates that the file on a given link is not found. 

The  icon indicates that the changes from the file have not been put in the assembly and the 

document needs to be updated. 

Object Type. Shows a type of the object. 

You can customize display of object types, external and internal links in the window using  filter. 
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Links to new files are displayed in the window after activating  option. 

Files associated with one link unite when the  button is active. 

 

 

You can search for files using a search bar. 

 

Update Links  option allows to reload data from all external files contributing to the composite 

document. 

Update Assembly  option starts the converter that converts and saves all the fragment files that are 

included in the assembly 

Refresh files  is provided for updating the fragment document per the changes in the assembly when 

working by “Top – down” approach or in the assembly context. 

Context menu 
Commands for working with elements in the Links window are available in the context menu.  
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Open file. Allows to open one or several selected files in T-FLEX CAD. 

Open with. Allows to open the selected file with the help of an external application. The application can 

be selected from a coming up window. 

Show in Folder. Opens Windows folders with the selected files. 

Select file. Option allows to select the file which will replace one or several selected files. 

For example, if the file name was changed and the file dissappeared from the assembly, you can select 

the renamed file using the Select file command.  

Change link type allows to change one or several links types. For example, setting the type “Embedded” 

for an “External” link will put the external file, which is the link target, into the current T-FLEX CAD 

document, all data included, so that the file ceases being external.  

An embedded link can be used for temporary storage of fragments data within an assembly 

document. For example, this is necessary when you need to move an assembly document to 

another computer. “External” link can be re-assigned afterwards to return back the external 

storage of fragments in the separate files. 

Change Link command calls Change Link dialog window. You can change name, path or name and path 

for the link here. 
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The command can be used for multiple links. For example, if you change paths to several fragments, they 

will refer to files with the same name located in another directory.  

 

 

 

 

 

 

If there are no files with desired name in the specified directory, a warning will be displayed in the 

diagnostics window. 

Optimize path. All absolute paths will be replaced by relative path. 

Rename/Move file. Allows to specify a new directory for fragment file storage and to rename the file. 

The file will be still associated with the current assembly. 

 

Rename file. Allows to rename the fragment file associated with the link. 

 

Update dublicates the  option from the toolbar. 
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A drop-down list with commands for working with the selected file is located in the bottom part of the 

context menu. 

Additional columns appear in the window if integration with T-FLEX DOCs is enabled. These columns are 

used for team development. 

 

Sorting and grouping are available for records of the Links window. 

More information about sorting and grouping can be found in “Variables” chapter. 

Model Elements 

A Model Elements window is used to display all elements in the document. 

 

Both 2D and 3D elements may be displayed in this window. Context menu with the corresponding set of 

commands is available for each element. 
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When you select elements from the list, they are highlighted on the drawing and in the 3D scene. 

 

In the window, you can select elements to be used in the current operation, for example, select graphic 

lines for the Copy operation. 

 

This window is particularly useful when working with drawings. It provides information on each element 

of the drawing on the current page or on all pages of the document.  

Toolbar 
The toolbar is used for the window management. 

 

To update the content of the window option  is used. 

Option  helps to enable or disable the grouping of elements by type. 
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The drop-down list is used to configure the display of elements in the window.  

 

Current view – shows elements in the current active view. 

2D Elements – show all 2D elements, existing in the document. 

3D Elements - show al3D elements, existing in the document. 

All Elements - show all elements, existing in the document. 

In the right corner of the window, you can select a column, which will display information about 

elements: type, ID, name, page and layer. 

 

You can search for elements using the search bar. 

 

Sorting and grouping are available for records of the Model Elements window. 

More information about sorting and grouping can be found in “Variables” chapter. 

 



Main Concepts of System Operation 

113 

Rulers 
 

The rulers display X and Y coordinates of the current drawing window. 

Ruler properties can be set with the help of the context menu. 

 

 

Ruler visibility can be set via the textual menu Customize > Tool Windows > Rulers or the context 

menu coming up on clicking  over any toolbar. 

Rulers can be used for navigating around the drawing. In the mode when there is the  button in the 

corner between the vertical and horizontal rulers, the horizontal ruler can be dragged by pressing and 

holding  and moving the cursor right and left. The drawing image moves together with the ruler and 

cursor. 

Release  to fix the image in the current location. Similarly, the drawing can be moved up and down by 

dragging the vertical ruler. 

Pressing the button at the horizontal and vertical rulers crossing with  switches to 

another button mark. In this mode, the rulers can be used for zooming the drawing in 

and out.  

To zoom the drawing in, point the cursor at the horizontal or vertical ruler, press and hold , and drag 

right or up respectively. To zoom out, drag  left or down, respectively. Releasing  fixes the drawing 

image in the current zoom.  

To switch the mode back to panning, press the button at the rulers intersection once again. 

Rulers can be displayed in 3D window. In this case, they allow you to better navigate in 3D space, 

estimating distances and sizes. Ruler shows 3D coordinates of the window on an imaginary plane 

parallel to the screen. 

With the help of rulers in 3D window, you can move and copy the workplane. More information 

can be found in the "Workplanes" chapter of the "3D Modeling" book. 

Property Window 

The property window is used for setting and modifying various parameters. One way to use it is in the 

command-waiting mode for quick editing of the selected element properties. The other way is using it 

within various 2D and 3D commands for setting various parameters of the elements being created or 

edited. 
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This window can be floating or docked along one of the 

application window borders. Its visibility is controlled by the icon 

 (it can be found on the toolbar “Main” in the mode 

“Compatible”), as well as via the textual menu item Customize > 

Tool Windows > Properties Window or via the context menu 

coming up on  click over any toolbar. 

This window comes up automatically on entering the commands 

that use it. Upon leaving such a command, the property window 

will automatically disappear, unless was docked by the 

application window or open prior to entering the command. 

The title and the content of the window depend on the current 

command and option. The parameters displayed in the window 

can be input directly by typing on keyboard. The current input 

box in the dialog can be set by pointing cursor and clicking , or 

via the keyboard. The key sequence for jumping to a particular 

input box is shown in a pop-up help coming up while resting 

cursor over the entry.  
 

The property window may be expandable. In many commands, 

portions of the property window dialog box may be collapsed by 

default. The special buttons -  and  are provided for expanding 

and collapsing such portions. Once a portion of the dialog was 

“expanded” while in some command, this setting will be remembered 

specifically for the given command. 

A special provision is made for the property windows in the 

commands that allow variables and expressions as parameters. The 

current value of such a parameter is calculated and displayed at the 

right of the parameter input box. 
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Automenu 
 

Automenu is a special toolbar that contains icon buttons of the 

available command options. Automenu is context-sensitive. This 

means, its content changes depending on the current command and a 

state of the command. 

Two outcomes are possible when selecting an action-starting icon in 

the automenu. First – the result comes right after selecting the icon. 

For instance, selecting the parameters setting icon , instantly brings 

up the parameter dialog box on screen. Second – the cursor changes 

the shape according to the selected option. To obtain the result, the 

user needs to move cursor to an appropriate location and press . For 

instance, selecting the construction line -  - adds a line mark to the 

cursor. The cursor then should be moved to a line to be selected, and 

the button  pressed. Only then, the construction line will be selected. 
 

Dynamic Toolbar 

In the command anticipation mode, upon selecting elements with the help of , 

a special dynamic toolbar will appear on the screen. It contains the icons of 

frequently used commands for the elements of the given type. The dynamic 

toolbar disappears automatically after some time has passed or after moving 

the cursor to a certain distance from the toolbar. 

The presence of the dynamic toolbar, while choosing 2D and 3D elements, 

depends on the settings of the command SO: Set System Options. For 3D 

elements the dynamic toolbar will be shown if the flag Use Dynamic Toolbar is 

turned on in the given command dialog box on the tab Dynamic Toolbar. 

 

In addition to that, while working with 2D elements, the parameter “Transparent Element Editing” has to 

be turned off. By default, the dynamic toolbar appears on the screen only for 3D elements. 

In addition to the icons of frequently used commands, the button  for calling the list of additional 

commands will be shown in the dynamic toolbar. Upon calling a command from the additional list, the 

selected command is automatically transferred to the main set of buttons of the dynamic toolbar (for the 

elements of the given type). Modifications in the dynamic toolbar are retained in the current 

Environment of the system. 
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To cancel changes in the set of buttons of the dynamic toolbar, it is possible to use command “Reset 

Command Usage” in the context menu of the dynamic toolbar. 

 

 

 

 

In the context menu of the dynamic toolbar, the flag Use Transparency is also available. When this flag is 

set on (for default settings), the toolbar looks semitransparent when it appears on the screen. The 

semitransparency diminishes as the cursor moves closer to the toolbar. When the flag Use Transparency 

is turned off, the toolbar is always displayed as nontransparent. 



Main Concepts of System Operation 

117 

ACTIVE DRAWING W INDOW  

The T-FLEX CAD allows the user to work with several documents 

simultaneously. There is a separate window for each open 

document. This allows working simultaneously with several 

drawings or 3D models, switching from one document window to 

another as required. 

The commands designed for working with document windows are 

grouped in the submenu “Window” found in the textual menu. 

 

Document tabs 

For controlling windows the document tabs can be used. Visibility of the tabs is controlled by the flag 

Customize > Tool Windows > Document Tabs.  

 

By using these tabs it is possible to switch from one open document window of the T-FLEX CAD into 

another – for this purpose it is sufficient to point the cursor at the desired tab and click .  

Also, with the help of tabs it is possible to change the arrangement of document windows. To do that, 

the cursor of the mouse should point at the tab of the document, which needs to be moved. Then  

should be clicked, and without releasing the pressed mouse, the tab of the document should be moved 

to the required location in the row of tabs. 

With tabs, you can also close the document window. On the right side of each tab there is button . 

Clicking this button will close the current window. Moreover, you can close tab by clicking mouse wheel 

on it. 

 

By default the document tabs (if they are visible in the T-FLEX CAD window) are placed above the 

upper border of the document window. Their location can be changed if desired. For that, it is 
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necessary to point at the tab of any document with the cursor and with the help of  call the 

context menu. Here you need to select the Placement item. 

 

All unsaved documents are marked with “*” symbol on their tabs. 

Close document option allows to close all tabs that belong to similar document. 

 

Close Window option allows to close current document window. 

 

Fixed width option allows to set similar width to all opened tabs. 

 

New main window option allows to create a new main window and copy the selected tab in it. 

Move to main window option allows to move tabs between main windows. 

 

More information about main windows can be found in “Quick start” chapter. 

Windows… command opens dialog box for managing opened tabs. 

 

More information about the Windows… command can be found in “Selection of active window” 

section. 

 

Document Window View with Turned on/off Document Tabs 

The view of the open documents with turned on tabs is different from that with turned off tabs. 

When window tabs are on, the windows of open documents occupy the whole space of the T-FLEX CAD 

working window. The active window, (i.e. the window of the current document) is on the top of other 

documents.  
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When the tabs are turned on, it is not possible to minimize the window or change its size.  

When the tabs are turned off, the windows of open documents can be in one of the three states: 

1. Maximized. The window occupies the whole working area of the T-FLEX CAD, and the 

document title is not shown. The name of the active document appears in the title of the T-

FLEX CAD window.  

2. Minimized. The window represents itself a status bar with the name of the document and 

system buttons for controlling the window.  

3. Arbitrary. The window has a smaller size than that of the working window. It has a title area, 

in which the name of the document is shown. 

Regardless of the window size, with the tabs turned off, the document window has three buttons 

enabling to control its state and close the current window. 
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When the window is maximized, these buttons are located under the respective ones of the application 

window.  

Pay attention as to what button to use when closing a window. 

An alternative way of maximizing a window is double-clicking  on 

the window title. 

If a window has a title bar, that is, it is not maximized, then the 

window management context menu can be called by pointing at the 

icon at the left end of the title bar and clicking . For a maximized 

window, this icon is located in the very left of the application textual 

menu bar. 

The terms “collapse” and “expand” will further be used along with 

“minimize” and “maximize” respectively. 

When a window is restored down, its size can be modified. Simply 

move the cursor over any window edge until it changes to a double-

headed arrow, and then drag the edge of the window to the desired 

size. 
 

Selection of active window 

The active window (i.e. the window of the current document) can be selected in a number of different 

ways. When the document tabs are turned on, the corresponding tab should be simply pointed at with 

the .  

If the document tabs are turned off, use key combinations <Ctrl><F6> or <Ctrl><Tab> for 

consecutive switching from one window to another. 

Also, the list of open documents found in the textual menu “Window” can be used. The window that is 

currently active will be marked by tick in this list. To make another window active it is sufficient to point 

at it with the cursor and click . 
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The number of windows, shown in the list, cannot exceed ten. If there are too many documents open at 

the moment, the command Window > Window List… can be used for selection of the specific window.  

After calling this command, the dialog box “Arrange Windows” pops up. The desired window can be 

chosen in this dialog box from the full list of open windows. Note that the set of available buttons in this 

dialog box depends on the presence of document tabs. 

  

With document tabs Without document tabs 

When the tabs are turned on, there is one more way for switching between the windows. In the 

upper right corner of the current window (with the document tabs arranged in a standard way – 

along the upper border of the window) there is a button . When this button is pressed, the list of 

all open documents pops up, in which the desired window can be selected. 

Drawing Window Scrollbars 

The system supports drawings of any format. However, the screen size is fixed. For working convenience, 

drawings are displayed by selected portions zoomed on screen. The scrollbars help quick navigation 

around the drawing page. 

Calling the command WSS: Show/Hide Window Scrollbars toggles on/off visibility of the active window 

scrollbars: 

Icon Ribbon 

 

View → Window → Show Scrollbars 

Keyboard Textual Menu 

<WSS> Window > Show Scrollbars 

Hiding scrollbars increases the window working area. The function of the scrollbars is not available 

via keyboard input. However, there is a number of tools offering similar function, and in large 

variations. See, for instance, the rulers functionality described above, or the use of the mouse 

wheel. 
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Arranging document windows with turned on document tabs 

When the window tabs are turned on, the document windows can be grouped into horizontal or vertical 

groups. Any number of document groups can be created simultaneously, however all groups must be 

either horizontal or vertical. 

 

 

 

To create a new group it is sufficient to move the tab of one of the windows to the lower or upper border 

of the working window of the system. To move tabs, one has to point at the document tab with a cursor, 

click , and without releasing the mouse, move the cursor to the required place. 
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When the tab is moved to the right border of the working window, the new vertical group is created, to 

the lower border – the new horizontal group. When the tab is moved to the upper or right border region 

of the working window the command menu pops up, which duplicates commands for creating groups 

from the textual menu “Window”. 
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For moving windows from one group into another it is sufficient simply to place a document tab to the 

desired group of tabs. For removing a group it is enough to move all windows of this group into another 

group.  

Besides the tools described above, to create or change the groups the commands of the textual menu 

can also be used. The commands Window > New Horizontal Tab Group and Window > New Vertical Tab 

Group make new horizontal/vertical group, respectively. The document window that is active at the 

moment of calling the command is placed into that group. The commands Window > Move to Next Tab 

Group, Window > Move to Previous Tab Group allow moving the window of the current document into 

another group. 

Arranging Document Windows with Turned off Tabs  

If the tabs of the documents are turned off, the document windows can be expanded to the entire region 

of the T-FLEX CAD working window, can be diminished to the arbitrary size, can be minimized. 

The document windows in this mode can be arranged in any of the traditional ways: 

1. Tile Horizontally. Do this by the command WHT: Tile Windows Horizontally. Call the command 

using: 

Icon Ribbon 

 

View → Window → Tile Horizontaly 

Keyboard Textual Menu 

<WHT> Window > Tile Horizontally 
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2. Tile Vertically. Do this by the command WVT: Tile Windows Vertically: 

 

Icon Ribbon 

 

View → Window → Tile Vertically 

Keyboard Textual Menu 

<WVT> Window > Tile Vertically 

 

3. Cascade. Do this by the command WCA: Cascade Windows. Call the command using: 

 

Icon Ribbon 

 

View → Window → Cascade 

Keyboard Textual Menu 

<WCA> Window > Cascade 
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The commands WHT: Tile Horizontally, WVT: Tile Vertically, WCA: Cascade are also available when 

the tabs of the documents are turned on. Using these commands in this case entails a forced 

transition into the mode of the turned off tabs. 

When the windows of all documents are minimized, they can be placed along the lower border of the 

working zone with the help of the command Window > Arrange icons. 

 

Additional window of document 

T-FLEX CAD enables to create additional windows for already opened documents. The name of 

document and the serial number of the given window appear in the title bar of such windows, for 

example: “3D Drawing 3:1”.  
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All operations with the drawing/model, performed in one window of the given document, will be 

transferred to other windows, opened for the document. For example, if an element for editing has been 

selected in one window of any document, the same element will be selected in another window. 

Additional windows can be conveniently used when the drawing contains small elements, separated from 

each other at significant distances, but upon constructing a drawing both types of elements are used 

simultaneously. It is possible to adjust the first window with the required magnification to the first group 

of elements, the second – to another group. And upon creating new elements it is possible to make a 

simple transition from one window to another and select necessary elements. 

To achieve the same purpose, splitting the document window into several panes can be applied. 

When this is done, inside the same document window two or four 2D or 3D windows are created, 

in which the drawing or 3D model of the given document will be displayed. It will be described 

below how to use this option. 

A new window can be opened with the command WO: Open New Window. Call the command using: 

 

Icon Ribbon 

 

View → Window → New Window 

Keyboard Textual Menu 

<WO> Window > New Window 

After calling this command: 
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 If option Set as default is active, it automatically creates windows with preset parameters 

without appearance of the dialog box. 

 If option Set as default is inactive, it works the same way as command Views Placement. 

“Views Placement”: 

 

Icon Ribbon 

 

View → Window → Views Placement 

Keyboard Textual Menu 

<WSV> Window > Views Placement 

 

You can choose the arrangement of 2D and 3D views from the dialog box Views Placement with the help 

of corresponding buttons or by selection from four different types of view using pull-down lists. 

     

Splitting Drawing Window 

An active window can be split horizontally into two views by calling the command WSH: Split Window 

Horizontally: 

 

Icon Ribbon 

 

View → Window → Split Horizontally 

Keyboard Textual Menu 

<WSH> Window > Split Horizontally 
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To remove the horizontal split, toggle the icon off. 

To split the current window vertically into two views, call the command WSR: Split Window Vertically: 

 

Icon Ribbon 

 

View → Window → Split Vertically 

Keyboard Textual Menu 

<WSR> Window > Split Vertically 

 

To remove the vertical split, toggle the icon off. 

Consequent calling the two commands splits the active window into four panes. 

 

To split a window into two panes, one can also use the split boxes on the scrollbars. The split box at the 

left of the horizontal scrollbar divides the window into two panes horizontally. 

       

Once the window is divided into two panes horizontally, the split box disappears. The size of the panes 

can be controlled using the vertical split bar. Place the cursor over the split bar. As it changes to “adjust 

split” arrows, press and hold , and drag to the desired location of the split. To close a pane, drag the 

cursor beyond the respective border of the drawing window.  

 

A window can be divided vertically into two panes in the same way. 
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2D windows have additional buttons for dividing a window into two or closing one of the two windows. 

These buttons are located on the rulers, one on the horizontal ruler at its right end, the other on the 

vertical one at the bottom. 

 

The button on the horizontal ruler works as follows. If there is currently a single window,  then  pressing  

the button splits  the window vertically into two equal panes. The user is not prompted for the window 

type, instead, a 3D window pane is created on the right-hand side. 

 

If the window is split horizontally into two panes, then two more 3D window panes will be instantly 

created by pressing the button. If the window is already split vertically into two panes, pressing the 

button closes the second window. If the window is split both vertically and horizontally into four panes, 

pressing the button will close the right pair of the panes at once. The button on the vertical ruler works 

accordingly. Such buttons exist in 2D windows only.  

 

 

If a window is split into panes, for example vertically, then the vertical ruler is used for both parts. Actions 

performed with this ruler are reflected in the pane which is currently active. In the case of vertical division 

each pane has its own horizontal ruler. If the window is split horizontally, then two vertical and one 

common horizontal rulers are used. If the window is split into four panes, then four rulers work, their 
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actions are reflected in the pane which is currently active. To make a certain window pane active point at 

it with a cursor.  

 

To get rid of window splitting it is enough to reduce the size of one of the panes up to zero. By reducing 

the size in this way the pane will be removed. 

 

Splitting of the document window can be retained for further sessions with the document. To do so, 

enable the Fixed set of windows flag in the dialog box of ST: Set Document Parameters (the 3D tab) 

and save the document. When you reopen the document, the window will be divided as it was at the 

time you saved the document after setting the above parameter. You will not be able to change the 

document splitting by changing windows size to zero (moving the window's separator), or by adding a 

new split bar. 

 

You can split the current 3D window, using special buttons in the left bottom corner. 
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Closing document window 

To close the window of a document the button  in the right upper corner of the window is used (with 

standard arrangement of document tabs). Upon pressing this button the current window will be closed. If 

for the given document several windows were open, then the rest of the windows remain open. 

To close all windows of the current document at once the command FCL: Close Model can be used: 

 

Icon Ribbon 

 

File → Close 

Keyboard Textual Menu 

<FCL> File > Close 

To close all windows of all open documents the command WCS: Close all Windows can be used: 

 

Icon Ribbon 

 

View → Window → Close All 

Keyboard Textual Menu 

<WCS> Window > Close All 

 

After calling these commands the windows in which the drawings were not modified will be 

automatically closed. System will offer you to save changes for unsaved modified documents 

before their closing. 

Flagged Commands 
 

In the textual menu, the icons on the left of command names 

indicate the command on/off status. Thus, for instance, the 

following diagram represents a situation when the active window is 

split vertically, its scrollbars being hidden.  

Managing Multi-Page Documents 

A T-FLEX CAD document may contain multiple 2D pages. The 2D window may be displaying all or only 

selected document pages, depending on the drawing settings. When working with a multi-page 

document, the user can manage the visibility of pages by removing from display those not being 

currently worked on. 

If a T-FLEX CAD document contains several pages, then the tabs with the names of the visible pages may 

be shown in the lower part of the drawing’s window (with the default settings; the arrangement of the 

page tabs can be modified). One can switch from page to page using those tabs, by clicking them with , 
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or by using the keys <Page Up>, <Page Down>. The tabs can be hidden/shown using the command 

Customize > Tool Windows > Page tabs. 

See details on working with multi-page documents in the chapter “Pages”. 

INFORMATION W INDOW  

 

Keyboard Textual Menu 

<Alt><F1> Help > Information 

 

Calling this command brings up a dialog box that provides access to all current document elements for 

editing and information querying. Unlike the “3D Model” window, this dialog box displays all 2D and 3D 

elements. 

 

The current document elements are displayed in a large pane on the left-hand side. The hierarchic 

structure is represented by the tree, with the base elements of the drawing or the model at the root. (The 

base elements are those created in absolute coordinates and not referencing any parents.) To select an 

element, click it with . The selected element will be highlighted on the drawing or in the 3D window. 

The following buttons become accessible for selected elements: 

[Parents] reformats the model tree, leaving only the selected element and those elements 

referenced by this one. 
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[Children] reformats the model tree, leaving only the selected element and the elements that 

reference this one. 

[Delete] closes the dialog box and calls the deletion command on the selected element. 

[Edit] closes the dialog box and calls the editing command on the selected element. 

[Show] closes the dialog box and zooms the active drawing (model) window on the selected 

element. 

[Select] closes the dialog box, leaving the element selected for further manipulations.  

[Measure…] calls the “Measure Element” dialog box for reading geometrical data of the selected 

element. The Model Tree dialog stays on screen for further actions. 

[Properties…] calls the parameters dialog of the selected element. The Model Tree dialog stays on 

screen for further actions. 

[Close] closes this dialog box. 

[<<] [>>] hides/shows the following additional panes in the “Information” dialog box: 

Information. This pane displays brief information about the selected element. 

Attributes. This pane displays information about the attributes of the selected element. 

CREATING AND EDITING DRAWING ELEMENTS  

The system provides a specific command for creating and editing each type of model elements. This 

section describes main concepts of using these commands, as well as general principles of creating and 

editing a 2D drawing. 

Snapping Mode. Snap Types 

T-FLEX CAD system supports two distinct modeling modes: 

 One is free mode in which the elements are selected within commands using the automenu 

and the keyboard.  

 The other, object snapping mode, provides pre-highlighting of the elements available as 

references in element creation and editing commands. The latter mode is enabled by 

default on starting the application. 

The pictogram , located on the toolbar “View”, controls the snapping modes. Use this icon to enable 

or disable the object snapping mode. 

An element is pre-highlighted in the object snapping mode as the cursor approaches the element. 

Meanwhile, the cursor itself gains a mark corresponding to the pre-selected element, and a popping up 

help message displays the name and Id of the element. On the screen this looks like the following 

diagram: 
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The pre-highlighted element can be selected using the mouse. This relieves the user from using the 

automenu or the keyboard in most cases.  

Various construction and graphic elements are pre-highlighted in creation and editing commands only 

when it makes sense. Thus, for instance, in spline creation, only nodes will be pre-highlighted, as the 

spline is created based on a set of nodes. No other elements will be pre-highlighted on cursor 

approaching, as this does not make sense for spline creation. 

Please note that the current documentation refers to the element selection mode with disabled 

object snapping when describing commands (implying only the use of automenu options). 

To temporarily disable object snapping within a command, hold the <Ctrl>  key down. Snapping is 

suspended as long as the key is held. 

When defining positions of various 2D elements in their creation/editing commands, with the object 

snapping enabled, not only can you use the existing elements (construction lines, graphic lines, nodes 

etc.), but also select characteristic points defined by object snaps. Nodes can be automatically created in 

the selected points. Those could be nodes at intersection of construction lines, nodes from fragments, 

nodes on dimensions, leader notes, tolerances and text entities, nodes aligned vertically/horizontally with 

another 2D node, nodes at the center of a graphic circle line or circular arc, etc. 

The most number of object snaps is used in the sketch-creating command SK: Create Sketch. 

Some of the object snaps may be unavailable in other 2D commands. Besides that, the use of 

snaps is affected by the settings made in the command SO: Set System Options. You specify what 

snap types can be used when working with a 2D drawing on the Snaps tab of this command. 

There you can also set the priority for each snap. Snap priorities determine, in what order the 

system will offer them to the user (in the cases when several snap choices are found).  

A detailed description of setting up snaps in the command SO: Set System Options is given in the 

chapter “System setup”.  
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Most of the object snaps can also be managed using the specialized “Snaps” toolbar. By default this 

toolbar is “hidden” inside the toolbar “View”. To get an access to this toolbar, press the button . 

 

For displaying this toolbar in an “independent” mode, move the cursor to the title area of the toolbar, 

press  and, without releasing the mouse, drag the toolbar into the desired location. In the future this 

toolbar can be left in the floating mode or snapped at any place of the T-FLEX CAD window. 

 

Using this toolbar, one can set and unset the snapping modes by clicking the desired icons with . All 

snappings can be simultaneously turned on or off by the button  - “Clear all sketch Snaps”. Also, all 

snapping modes except the required one can unset by clicking appropriate icon with <Ctrl> button 

pressed. 

Listed next are the main types of object snaps used in T-FLEX CAD: 

- Snapping to a point on a graphic line or construction line – , ; 

- Snapping to graphic line intersection – ; 

- Snapping to construction line intersection  ; 

- Snapping to the coordinate system origin ((0,0) point) – ; 

- Snapping to the midpoint of the graphic line – ; 

- Snapping to graphic line end points – ; 

- Snapping to the center of an arc or circle – ; 

- Snapping to arc angles 90, 180, 270 – ; 

- Vertical/horizontal tangency to circle – ; 
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- Cursor becoming aligned horizontally or vertically to another element point or 2D node – ; 

- Automatic definition of a line normal – ; 

- Cursor becoming aligned to the extension of a graphic line – ; 

- Automatic definition of a tangency to an arc or circle – . 

                           

                            

                                

              

In the creation/editing process, the system automatically finds the 

allowed snaps and offers them to the user (by flashing a snap type 

next to the cursor). Besides that, the system monitors for a 

coincidence of two object snaps, for example, vertical – horizontal, 

perpendicular – horizontal, etc.  

If several object snap choices are found at a given point, the system lets the user select the desired snap 

(or a combination of two snaps). To do this, you need to place the cursor at the desired location and rest 

it for a while. Then the cursor changes its appearance: the mark  appears next to it together with a 

tooltip showing the total number of object snaps found by the system. Use the mouse wheel to scroll 

through those snaps. Clicking  determines the snap that will be used in the creation or editing of the 

current 2D element. 
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A system-offered object snap can be locked by the <Spacebar> function key. 

For example, let's fix horizontal snapping to one of the segment 

nodes. To do this, get horizontal snapping with this node and press 

the key <Shift> or <Spacebar>. A temporary dotted line will be 

constructed through this node, the cursor sliding along as a free 

node.         

Snapping that are turned on on the sketch snapping toolbar stay active continuously throughout the 

sketch command session. If snappings are adjusted often, one can use temporary object snappings -the 

“one-action” snappings. 

Such a snapping can be turned on by several means: 

By the button  on the snappings toolbar. This brings up a context menu for specifying a temporary 

snapping (just one); it also lists key combinations that can be used for invoking a temporary snapping 

without calling the menu. To define several temporary snappings, use the item [List]. Upon picking 

the item, the context menu is replaced by a dialog box that allows turning on several temporary 

snappings simultaneously. 

By pressing and releasing the middle mouse button or the wheel button while keeping the mouse 

pointer still in the working window area. As a result, the same menu will appear on the screen as 

when using . 

By pressing key combinations assigned to each snapping. 

When temporary object snapping is turned on, all permanent snappings are ignored. The described 

temporary snappings act until the first click . 
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Using Grid 

When creating a drawing, it is sometimes helpful to use a grid of dots. In this way, snapping will occur to 

the grid dots while creating various drawing elements. The precision with which you create drawing 

elements can be controlled by specifying the appropriate grid step.  

           

The grid can be turned on for the active page by the command QG: Change Grid Settings: 

 

Icon Ribbon 

 

Edit → Document → Grid 

Keyboard Textual Menu 

<QG>, 

<ALT><F6> 
Customize > Grid 
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The following required parameters are defined in the Grid Properties dialog box: 

Visible. Sets the display mode of the grid. The grid color is 

defined in the system options (the SO: Set System Options 

command). 

Snap to grid. Sets the element snapping to grid mode.  

Drawn last. Defines the order of drawing the grid on screen. 

Step X. Defines the grid step along the X-axis of the drawing. 

Step Y. Defines the grid step along the Y-axis of the drawing. 

Offset X. Defines the grid shift along the X-axis of the drawing 

with respect to the origin (0,0). 

Offset Y. Defines the grid shift along the Y-axis of the drawing 

with respect to the origin (0,0).  

The grid options are saved with the drawing. 

The grid management commands are accessible via the textual menu Customize > Snap: 

 <Ctrl><G> Grid Snap On 

 - Enlarge Grid Step (doubles) 

 - Reduce Grid Step (halves) 

If the grid snap is turned on then the grid knots serve as the snapping nodes for the drawing elements. 

General Concepts of Element Creation 

Placement of any element on the drawing can be defined in the following ways.  

Independent of other elements. This kind of placement is defined by the absolute coordinates of the 

element on the drawing, independently of other element locations. Placement of such elements is usually 

set by clicking  or by assigning exact values of snapping coordinates in the command’s properties 

window. 

Dependent on reference elements. The element location will depend on the location of the reference 

element this one is related to. When the location of the reference elements is modified, the current 

element will relocate accordingly. 

 

To select the reference elements to snap to, the options are provided for selecting a line, a circle, a node, 

etc. in most 2D element creation commands. The variety of available options depends on the element 

being created. The most commonly used snapping options are presented below: 

 <L>  Select Line 
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 <C> Select Circle 

 <N>  Select Node 

 <E> Select Ellipse 

 <S> Select Spline 

When the object snapping is on, use of these options is not essential. However, using the options 

in this case helps narrow down the range of elements available for snapping. Thus, for instance, 

with the option  active, only circles will be pre-highlighting when moving the cursor around 

the drawing. 

When creating and editing elements, an earlier created relation of this element with another element can 

be abolished by the following option: 

 <K> Break (kill) relations 

Object snaps can be used in both ways of defining the 2D element position. The set of the available 

snaps depends on the current command. By using snaps, a 2D element being created can be tied to: 

 a free 2D node automatically created at the specified location (that is, not tied to objects 

used for snapping); 

 a tied (constrained) 2D node automatically created at the specified location (the tie of the 

node with the source elements is maintained); 

 in free coordinates (snaps define only the absolute coordinates of the element being 

created). 

Tied nodes are always created when having snaps to a construction line intersection, circle center, 

end points of graphic lines, characteristic points of drawing annotation elements (dimensions, 

leader notes, roughness symbols, tolerances), as well as 2D fragments. 

When using all other snap types, the status of the auto-parameterization mode is regarded (the 

icon  on the “View” toolbar). If the auto-parameterization mode is enabled, then a tied node is 

created. Upon disabling the auto-parameterization mode, either a free node is created, or a point 

is picked with appropriate coordinates (when creating a leader note, roughness symbol, tolerance, 

section view and 2D fragments). 

Most creation commands allow setting parameters of all newly created elements. To do that, parameters 

need to be set right after the input of the command, before the start of element snapping and assigning 

its location. Assigning parameters can be done in either command’s properties window, or in a special 

parameters’ dialog box, called by the following option: 

 <P>  Set parameters 
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The parameters of a particular element being created can be defined in the command's properties 

window during its creation. One can also use the option , but only if calling it during an element 

creation process after defining its position and snapping. 

 

Commands for creating some of the 2D elements (dimension, roughness, leader note) provide option of 

assigning parameters from already existing element of the same type: 

 <Alt+P> Copy Properties from Existing Element 

Values of the copied parameters can be set as default parameters (parameters that will be assigned to 

the newly created elements of this type). 

 

Any creation or construction command allows calling the editing command from within, using the 

option: 

 <F4>  Execute Edit Element command 

You will return into the original element creation or construction command after completing editing in 

the editing command. 

 

In the number of 2D commands for completion of element creation you must use option: 

 
<Ctrl+Enter

>  
Finish input 

Canceling an element selection performed within a creation or editing command is done by the option: 

 <Esc>  Cancel selection 

This option does not cancel the command itself. 

To quit a command, use the option: 

 <Esc>  Exit command 

General Concepts of Editing Elements 

In editing commands, element selection is done by the cursor. To select, move the cursor to the element 

and click  or press <Enter>. Different elements are highlighted in different ways. Some are painted with 

colors, others surrounded by a frame. To relocate a selected element, move the cursor to the desired 

position and click . The element will relocate (if the method of its snapping allows that). 

If a wrong element was selected, cancel the selection with the option: 

 <Esc>  Cancel selection 
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or select the next nearest one using the option: 

 <I> Select Other Element 

 

The subsequent elements of the given type can be selected by using this option repeatedly. 

In editing commands, the user can select multiple elements using box selection. To do so, move the 

cursor to the intended location of one corner of the box, press and hold , and drag the cursor to the 

location of opposite corner of the box, then release. If the cursor was moved left-to-right when marking 

the box, all elements that are fully within the specified region are selected. In this case the selection box 

is painted with a green color. If the cursor was moved right to left, the objects are selected by the 

crossing frame. That means that not only the objects that are entirely within the selection box, are 

selected, but also the objects intersected by the box. In this case the selection box is painted with a pink 

color. 

                   

          

A group of elements can also be selected by subsequent picks with the <Shift>+  combination. An 

element can be excluded from selected by picking it with the <Ctrl> +  combination. 
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All existing elements of the given type can be selected at once using the option: 

 <*> Select All Elements 

Selecting an element from a list is done using the option: 

 <R> Select element from list 

The list can be composed differently for elements of different types. For instance, when editing 

fragments, the list will contain all model fragments, while when working with nodes, the list will contain 

only the named nodes. 

All editing commands allow deletion of a single or multiple selected elements, using the option: 

 <Del> Delete selected Element(s) 

The following option is available within common 2D element editing commands: 

 <O> Create Name for selected Element 

This option allows assigning a name to the selected element. The name is a unique attribute of an 

element and can be used, for instance, for searching elements using the command FD: Find Element, for 

selecting elements in a list, and for creating nodes from fragments within the EN: Edit Node command. 

When the entered name is the same as a one already assigned to another element, the system will 

output the message “Incorrect Element Name or Name already exists”.  

The 2D node editing command allows assigning names to multiple selected nodes simultaneously. In this 

case, the names are made by appending subsequent numbers to the entered name, for instance, 

“name1”, “name2”, etc. 

When 3D elements are constructed or created, the system assigns them “default” names. If necessary, the 

user can change a name in the element parameters window.  

Editing commands allow the user to change selected element parameters. This can be done directly in 

the command properties window (just like at the time of creating this 2D element), if only one element 

was selected for editing. 

If several elements are selected, use the option: 

 <P>  Set parameters 

After calling the option, a dialog box comes on screen first, offering to select the parameters to be 

modified. Next, the parameters dialog appears. Any changes to parameters not selected for editing in the 

previous dialog, will be ignored. Some parameters of the selected elements can be modified using the 

system toolbar. 

When editing dimensions, roughness symbols, leader notes, just like at the time of their creation, you can 

copy parameter values for the edited element from another element of the same type, using the option 

. 
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Selecting elements outside any command 
Elements can be selected for editing even outside any command, when the system is in the command-

waiting mode. 

Selecting an element with  automatically starts the given element editing command. Double-clicking 

 will start the editing command and bring up the element parameters dialog box.  

The context menu of an element can be accessed by right-clicking  on 

the element. The menu contains items for editing, deleting, moving and 

copying the element, as well as changing its properties by calling the 

parameters dialog box. One can also view the information about the 

selected element, measure it, and change the selector settings. 

When working with complex drawings, several elements might be near 

the cursor. To select the desired element in this situation, use the 

“Other…” item in the context menu for selecting the element from list. 

The list contains the elements nearest to the cursor. Only the elements 

allowed by the selector settings are included in the list. The number of 

the nearby elements in the list can be set in the selector settings dialog 

box. This dialog also provides the options for the list representation. The 

latter can appear as a context menu or as a resizable dialog box floating 

on screen, providing the user better view of the drawing elements. 

 

              

A group of elements can be selected in the command-waiting mode as well. Just like in the case of 

the editing commands, various methods can be used for the group selection: selecting by box left 
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to right (selected are all elements that are fully within the specified region); selecting by box right 

to left (selected are all elements that at least partially enter the specified region); a serial selection 

of elements using <Shift>+ , <Ctrl>+ . The context menu will contain the commands for 

moving/copying, deleting and modifying properties of the selected elements. 

Changing various type element parameters outside any command 
Use the properties window to simultaneously change parameters of multiple elements while in the 

command-waiting mode. In this way, unlike using the specific element editing commands, one can 

change parameters of various type elements simultaneously. 

While in the command-waiting mode, the property window contains a dialog box for changing 

parameters of the selected element. The dialog is inactive by default. To activate the dialog, enter the 

properties window and expand the group Parameters. After that, upon selecting any element, the 

element parameters will be displayed in their property window. To open the dialog box automatically, 

select elements and call the Parameters command in the context menu. 

To turn off the active mode of the dialog, close the “Parameters” group.  

Note: upon single element selection, the Parameters command call from the context menu will 

open the parameters dialog box for the given element. 

The properties dialog box for the selected elements consists of 

two parts. The main part is “Properties”, and the auxiliary one is 

“Property Sets”. 

The main part contains the property table for the elements being 

edited. By default, all selected elements are subject to editing. The 

box “Selected” in the upper part of the dialog box displays the 

number of the selected elements. The list of elements to be 

edited can be limited to elements of one type by selecting the 

type in the pull-down list off the mentioned box. In this case, the 

table will contain only the properties of the selected type 

elements. The entered changes will also affect the elements of 

this type only rather than the whole selected group.  
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By default, the table displays all properties of the elements being edited. Checking the Only Common 

box limits the table contents to the common properties only. 

To change properties of the elements, select the desired properties in the table, enter the required values 

in the cells on the right-hand side, and press the  or  button in the upper part of the dialog 

box. 

Upon picking the  (“End edit”) button, the entered changes are applied to the selected elements. 

The element processing ends and the elements get de-selected at this point. 

The  (“Apply Changes”) button applies the entered changes to the elements as well. However, 

element processing continues in this case. This button is handy in the cases when various parameters are 

to be assigned to different element groups within the selected set.  

 

The  (“Cancel edit”) button can be used to abandon the entered changes and finish processing the 

selected set of elements. Abandoning changes and finishing the selected element set processing can also 

be done by simply clicking  within the drawing area. 

 

An additional button [From Element] allows selecting an element on screen whose properties will be 

used as current properties of the edited elements. To use this option, first select the properties in the 

table whose values are to be taken from the element. Then press the button and select with  the 

desired element on the screen. The parameter values will assume those of the selected element. 
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An auxiliary part of the dialog box, the “Property Sets”, 

allows to save the current set of properties under a 

specific name for their later reuse. 

To save the composed combination of parameters as a 

set of properties, press the [Save] button. A “Save as” 

dialog box will come up on screen for specifying the 

name of the new set. All existing named property sets 

are listed in a box in the upper part of the dialog box. 

A set can be deleted from the list by selecting with  

and pressing the [Delete] button. 

The name of the set to be saved is entered in a box in 

the bottom part of the dialog box. Upon entering the 

name, press the [Save] button. The “Save as” dialog 

box will close, and the saved set name will appear in 

the pull-down list. The [Cancel] button closes the 

window without saving the new set. 

 

 

 

To load a saved set, simply select it in the pull-down list of sets. 

 

Copying element properties through clipboard 

In the context menu for any 2D element the command Copy Properties is available. When this command 

is called, parameters of the selected element are copied into the internal clipboard. After that, upon 

selecting any other 2D elements the command Paste Properties will be available in the context menu. 

When this command is called the parameters copied into the clipboard will be applied to selected 

elements. 
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Limiting Element Selection. Using Selector and Filter 

When working with a dense drawing, it is often difficult to select the desired element on the screen. In 

this case, it may be necessary to limit the list of the elements available for selection. This can be done in 

several ways. Some of them, such as using the level and layer mechanisms, were already mentioned in 

the “Brief Introductory Course” volume. However, these mechanisms either modify the drawing, or allow 

to temporarily hide construction elements only.  

 

The most general and convenient way that does not require drawing modifications is using the selector 

and the filter. These tools perform similar functions of limiting selection, however, the selector does this 

based on element types, while the filter – on the element parameters. Besides, changing selector settings 

is only available in command-waiting mode, while the filter works in transparent mode. The latter means, 

the filter settings can be modified at any time, without quitting the current command. The selector and 

filter settings work independently, adding to each other’s function. The elements, whose selection is 

disallowed by either the selector or the filter, can’t be selected on the drawing neither by , nor via the 

creation and editing command options described above. 

 

Selector 
The selector settings are managed by the command FT: Set Selector Configuration. This command can be 

called only in the command-waiting mode from the toolbar or the textual menu as follows: 

 

Icon Ribbon 

 
 

Keyboard Textual Menu 

<FT> Edit > Selector 



T-FLEX CAD Brief Introductory Course 

150 

 

Upon calling the command, the selector configuration dialog box comes up on screen. The main field of 

this dialog, Select Elements of Types, contains the list of all system element types. The elements allowed 

for selection are checkmarked at the left of their type names. By default, all elements are allowed for 

selection. To disallow selection, un-check the respective type with the  click.  

The buttons ,  and  help quickly set, clear and invert checkmarking of the element types.  

A specified combination of settings can be saved as a named selector configuration. To do so, check the 

Save as Configuration item and enter the name for the new configuration in the box on the right-hand 

side. 

 

Additional items in the selector configuration dialog box, such as Number of Elements in ‘Other’ List and 

Show ‘Other’ List as, allow setting different modes of the list display. The list comes up for a selected 

element upon calling the Other command in the context menu. The effect of these settings was 

described above, in the “Selecting elements outside any command” topic.  
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Pressing the [OK] button saves the defined settings and closes the command. The [Cancel] button closes 

the dialog box without saving changes. 

 

The selector can later be quickly set up based on a saved configuration. This is done using the  

button on the system toolbar. Pressing this button brings up a pull-down list containing all available 

selector configurations. Selecting a configuration in the list automatically sets up the selector per the 

configuration parameters. 

There are several additional buttons on the system toolbar for controlling and quick adjustment of the 

selector settings. 

The  and  buttons are used to quickly allow/disallow selection of all types of elements. 

The buttons with various element type symbols, such as the , , , , , , ,  and 

 buttons in the 2D window, other in the 3D window, define the current set of the elements allowed 

for selection. The “pushed” icons correspond to the element types allowed for selection. Besides, one can 

quickly allow/disallow selection of the respective element types by pressing these buttons. Pressing any 

of these buttons toggles its setting to opposite. This allows or disallows selection of the respective 

element type in the selector settings. Pressing any of these buttons while holding the <Ctrl> key down, 

turns on selection of exclusively the given element type. Selection of other element types simultaneously 

turns off. The same result can be achieved by double clicking   the required button. 
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Filter 
Filter parameters can be set or modified either in the command-waiting mode or in the transparent 

mode within any command. Call the command using: 

 

Icon Ribbon 

 
 

Keyboard Textual Menu 

<FL> Edit > Filter 

 

Managing the filter involves setting one or more conditions on the parameters of the objects to be 

selected. The elements are disallowed for selection whose parameters do not satisfy any of the filter 

conditions. This is so even for elements allowed for selection by the selector. 

Calling the command brings up the filter parameters dialog box. 

 

The current filter parameters, which are the currently active condition set, are displayed in the lower part 

of the dialog. This set consists of one or several conditions joined by Boolean “OR” operator. Thus, an 

element is allowed for selection if at least one of the conditions is satisfied among the current set. 

Each condition in a set is written out on a separate line. It consists of limitations on the element 

parameter values. The limitations are joined in a condition by Boolean “AND” operator. To satisfy a 

condition, the element must comply with all and any of the limitations thereof. 

To create a condition, use the main pane of the filter dialog box. This is a table of properties of all 

elements in the current document.  
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To define a limitation on the value of some parameter you need to select the parameter in the table and 

to press  button in the middle column. The drop-down list will appear. Here you can select limitation 

type of the parameter value: Equal, Not Equal, Greater, Less. 

 

The parameter value for the selected limitation is specified in the right column. Numeric and text 

values are specified manually. If in the system there are values lists for a parameter, you can select 

a value from the drop-down list. The drop-down list appears automatically when you press  on 

the field. 

 

Once all limitations are defined, press the [Add] button. The just created condition will appear in the 

lower pane of the dialog box. If there was already a set of conditions at the time of the new condition 

creation, the latter becomes part of this set. 

When creating a condition, the parameter values can be read from a specific element. To do so, 

checkmark the necessary properties, and then press the [From Element] button. The dialog box will 

temporarily disappear from screen, making possible selection of the desired element in the drawing 

window using . Once an element is selected, the filter parameters dialog box comes back on screen. The 

checked parameter values will be the same as those of the selected element.  
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To delete the current condition set or a part thereof, use the [Delete] button. To do so, first highlight 

with  one or several conditions. Then press [Delete], and those will be deleted. 

A current condition set can be saved under a specified name for further reuse. To do so, use the [Save…] 

button. Upon pressing the button, a “Save as” dialog box will come on screen for saving the condition 

set. 

 

Specify the name of the set to be saved in the lower pane of the dialog box. After entering the name, 

press the [Save] button. The name can be selected from the list of the existing set names in the upper 

pane, using . Besides, this dialog allows deleting a previously saved set. To do so, select one in the list 

and press the [Delete] button. The [Cancel] button allows to disregard the deletion and quit the dialog.  

To use an earlier saved condition set, press the [Load…] button. After pressing the button, the “Load” 

dialog box will come up on screen for loading the named condition set. Working with this dialog is 

similar to the set saving dialog. The upper pane of the dialog contains the list of available sets. Use  to 

select the desired set from the list. The name of the selected set is displayed in the lower pane of the 

dialog. 

 

Once selection is done and the [Load] button pressed, the dialog closes and the contents of the selected 

set are added to the list of the existing sets of conditions. This dialog also allows deleting any of the 

existing named sets using the [Delete] button. 

 

The specified set takes effect after closing the filter dialog. Only the elements satisfying the current filter 

settings will be available for selection in any mode of T-FLEX CAD system.  

Element Search 

Sometimes, the system might fail to calculate location of some element during regeneration. In such a 

situation, the system will display an appropriate message with the Id of this element. To find this element 

on the drawing, one can use the command FD: Find Element: 

 

Icon Ribbon 

 

Edit → Additional → Find 

Keyboard Textual Menu 

<FD> Edit > Find 
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Upon calling the command a dialog box comes up on screen 

for searching a 2D or a 3D element. An element can be 

searched by either of the two ways as follows. 

One way is to use the input box in the upper part of the 

dialog. Enter the Id or the name of the searched element. If 

such element is found, the buttons in the right part of the 

dialog box will become accessible. Meanwhile, the element 

may be marked on the screen, depending on the Mark on 

screen attribute. Pressing the [OK] button closes the dialog 

window, while highlighting (selecting) the found element on 

the screen. Pressing the [Information] button opens the 

element information window. If the element is not found, the 

buttons remain inaccessible. 
 

A pull-down list of the input box in the upper part contains the previous queries. An Id or name can be 

selected from this list if desired.  

Another way of searching for an element is using the tree in the main pane of the dialog box that 

contains all model elements. When an element is selected in the tree, the upper input box displays its Id 

or name. The buttons in the right part of the dialog become accessible as well. 

An additional Sort flag serves to sort elements in the tree by the name or by the ID in the desired order 

(ascending or descending). 

The search command can be called in transparent mode from within any other command. In this 

case, the total list will only contain the elements that are allowed for selection in the current 

command. 

Moving, Copying, Transforming Elements. Working with Clipboard 

New drawing elements can be created using already existing ones.  

For this purpose, use the general move/copy command. It was described in the chapter “Moving 

and Copying Drawing Elements. Arrays. Use of clipboard”. This command can be called either from 

the textual menu and keyboard, or from the context menu for the elements to be transformed. 

To call the command from the context menu, select the necessary drawing elements and right-click . 

The context menu will be containing commands by groups for calling various modes of the move/copy 

command, specifically, Move, Copy, Array. 
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The modes under the “Move” group allow changing location and size of the selected elements. Besides, 

an option is provided for moving all related elements. For example, moving some construction element 

will be affecting the placement of all related elements to this one, either the construction or the graphic 

ones.  

 

Meanwhile, all parametric dependencies between elements will stay intact.  

The “Copy” group provides the modes for creating a copy of the selected elements (as well as all related 

ones) at any location of the current document. The created copies can be made associatively related to 

the original objects, or become independent elements. 

The linear and circular array creation modes are provided under the “Array” group. Similar to simple 

copying, the created result can be either an array with associative relation to the original objects, or a set 

of independent elements.  

T-FLEX CAD also works with the clipboard. Clipboard commands can also be called either from the 

textual menu, or using the context menu for the selected elements (Copy, Copy with Point, Paste, Paste 

Special…). Thus, selected elements can be copied into another T-FLEX CAD document or into an external 

application. One can also insert a picture or text from an external application into a T-FLEX CAD drawing. 

Undoing User Actions 

Errors unavoidably occur when working with any system, especially while learning. Correcting errors takes 

time. T-FLEX CAD system helps simplify this process. A certain number of latest user actions are 

remembered by the system. The length of the undo and redo buffers is set in the command SO: Set 

System Options, on the Performance tab, in the Undo/Redo buffers box.  

The user actions remembered by the system can be undone by a certain number of steps back. This can 

be done by repeatedly calling the command UN: Undo Changes, that brings the system back by one 

step. The UN: Undo Changes command can be called from any other command using 

<Alt><BackSpace> or <Ctrl><Z> combination. 

If the command UN: Undo Changes was called in error, there is the RED: Redo Changes command in the 

system, which restores the undone action. The RED: Redo Changes command can be called from any 
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other command by <Ctrl><BackSpace> or <Ctrl><Y> combination. Repeatedly calling the command 

RED: Redo Changes brings the system into the state when undoing began. 

The UN: Undo Changes command can be called as follows: 

 

Icon Ribbon 

 
 

Keyboard Textual Menu 

<UN>, 

<Alt><BackSpace>, 

<Ctrl><Z> 

Edit > Undo 

The RED: Redo Changes command is called via: 

Icon Ribbon 

 
 

Keyboard Textual Menu 

<RED>, 

<Ctrl><BackSpace>, 

<Ctrl><Y> 

Edit > Redo 

 

To cancel or repeat several actions at once, press the button  to the right of the icon of the 

corresponding command. After pressing the button the dropping list of actions which can be canceled or 

repeated will pop up. Then it is enough just to select the desired group of actions with the help of . 

General Principles of Assigning Parameters. Assigning Variables to Parameters 

General principles of assigning parameters 
Various ways of assigning parameter values are used in element creation and editing commands. These 

include using parameter dialog box and property window, as follows: 

A parameter can be assigned a constant value. For example, the parameter "Rotation angle" of a text can 

be assigned 0. 

A parameter value can be substituted by the string “Default”. This means, the parameter value will be set 

from the respective parameter of the command ST: Set Document Parameters. For example, the 

parameters on the Font tab in the parameter dialog box for dimensions, roughnesses and notes will 

be substituted from the Font tab of the command ST: Set Document Parameters when the 

respective elements are displayed. 

Using default parameters helps quickly modify elements of the whole drawing. For example, 

using default parameters for dimensions allows to instantly change dimension display and, 
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therefore, the whole drawing. This can be done by modifying parameters on the Dimensions 

tab of the ST: Set Document Parameters command.  

The values of most of various element parameters defined by number can be set using string variables 

and expressions. In this case, the parameter value will be driven by the value of the variable or 

expression. In this way, the value of the parameter can be changed by varying the respective variable 

value. This mechanism allows changing any parameters of the following T-FLEX CAD elements: the 

size of text boxes, the slanting angle, the size of arrows of the dimension leaders and graphic lines, 

etc. You can use variables to define drawing parameters that are defined in the ST: Set Document 

Parameters command, such as scale, paper size, font size, etc. Variables can also be used for defining 

the system visibility levels of the elements set in the command SH: Set Levels. 

Assigning variables to parameters 
When assigning a variable to a numeric parameter, enter the variable name or expression without any 

special symbols. Examples: A or A+B 

When assigning a variable to a string parameter, enter the variable name or expression in braces. 

Examples: {$NAME} or {A+B} 

When assigning string parameters in braces one can enter either the real variables or textual variables. 

If a new variable name was entered when assigning a parameter, the value of this variable must be set 

after leaving the menu. 

 

When a variable is introduced, the format of its value representation can be specified along. Use the 

following syntax for typing variable values: 

 

{<variable name>} or {<format>,<variable name>} 

 

The following example demonstrates use of formatted variable representation.  

 

Today {”%lg”,DAY}, {”%s”,$MONTH}, {YEAR} 

 

Note that the textual variable $MONTH begins with the ‘$’ character, as this is the prefix for all textual 

variables. 

 

The format structure, used for the T-FLEX variables, follows the syntax of the input/output formats 

in  “C” programming language.  

Using formats will help you control the appearance of the variable value on screen. For example, formats 

can control the number of displayed decimal digits or justification of the displayed value.  
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Context menu for dialog input boxes
When working with dialog boxes, an additional set of commands is available in context menus. A context 

menu can be called by placing cursor within an input box of the dialog and right-clicking : 

Undo. Undoes the last change. 

Cut <Ctrl+X>. Cuts selected text to clipboard.  

Copy <Ctrl+C>. Copies selected text to clipboard. 

Paste <Ctrl+V>. Pastes text from clipboard.  

Delete <Del>. Deletes selected text. 

Select All <Ctrl+A>. Selects all text in the current input box. 

Insert Symbol… <Alt+F9>. Inserts a symbol from a special 

symbol table. The symbol code is actually entered in the 

input box instead of the symbol itself, for example, %%066 

for the diameter symbol. 

This may be used for entering symbols in some textual input 

boxes. The data from these boxes will be inserted in the 

drawing. See, for example, the “Text before dimension” 

input box. 

Repeat Symbol <F9>. Inserts last symbol again. 

Insert Variable… <F8>. Inserts an existing variable from list. 

The variable name is inserted in the input box in braces. The 

drawing will display the actual value of the variable. The 

variable values can be changed in the variable editor or, in 

some cases, directly on the drawing (see the section 

Paragraph text of the Text chapter). 

 

Dictionary <F6>. Inserts text from dictionary. For detailed information, see the topic Working with 

dictionary of the Text chapter. 

Insert Fraction… <Ctrl+F>. Inserting the fraction into the 

dialog box. Can be used, for instance, for assigning the 

content of text fields in dimensions, leader notes, text, etc.  

Upon calling the command the window of an auxiliary 

dialog is displayed for setting the parameters of the 

fraction.  
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Edit Value List… <F2>. Value lists can be created for the 

dialog input boxes. The lists are preset for some boxes, for 

example, the input boxes “Datum” and “Value” in the 

GD&T Symbol Parameters dialog box. The command brings 

up a window for editing the values list.  

The list can be divided into columns. Entries in a column can 

be grouped between horizontal dividers. 

Insert Value to List <F3>. This command adds the current 

value from the dialog input box into the list. If the list did 

not exist, it will be created.  

Copy Value List <F5>. This command copies the list of values of the given dialog field into the 

clipboard. 

Replace Value List <F6>. This command replaces the list of values assigned to the given dialog field 

by the list of values from the clipboard. The list must be copied to the clipboard in advance using 

the command Copy Value List. 

Spin Bars. This command enables the stepper – the way to modify the parameter in the respective 

field using the mouse wheel or the button . 

Spin increment… <F4>. You can define the parameter 

value increment of the stepper. One of the three 

settings can be chosen in the spin increment control 

dialog box: “Default”, “Value”, “By Value List”. 

Value. Set a numeric value of the increment.  

By Value List. Setting this option will allow to scroll 

through the list of values in the case the list was created 

for this input box of the dialog. 

Enter Angle… <F11>. This command allows converting an 

angle value to the decimal format. The command 

brings up a dialog box. The respective input boxes of 

the dialog allow entering an angle value in degrees, 

minutes and seconds. This value will be converted into 

the decimal format.  

 

 

Measure. <F12>. This command allows reading geometric data from existing drawing elements 

and using it for creating new elements. Parametric dependencies can also be introduced between 

the elements. For more information, see the chapter “Measuring Elements and Relations between 

Them”. 

Check Spelling. <Ctrl+F11>. Checking the spelling of the content of the dialog field, for which the 

context menu has been called. 
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SET TING COMMON PARAMETERS OF SYSTEM ELE MENTS  

Each T-FLEX CAD system element, whether a construction or a graphic one, has its own set of parameters 

that the user can define and modify. In particular, the color, level and layer parameters are present in 

each set of parameters. Defining and using these parameters will be described here so not to repeat the 

description for each element.  

Color 

Each element has a color. The parameter dialog includes the input 

box “Color:”. 

This box shows the color used for displaying the given element of 

the model. The color can be changed by selecting from the list.  

An element color can also be set using the system toolbar. 

Setting colors via the system toolbar is available in creation 

and editing commands. 

 

You can select color from the catalog of colors. Use special button  next to the drop-down list of 

standard colors in the properties dialog to open appropriate color selection dialog. 

Also you may use appropriate button  in the system toolbar to open convenient color selection 

dialog. 
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Color catalog contains a set of pages (the list on the left) containing colors. Color is defined as RGB 

components and name. 

Besides the list of colors, the dialog contains 10 selected colors, which user may add using them to have 

for faster and direct access. 

Each color catalog is stored in a separate file with the .acb extension. To edit a color catalog you can use 

any text editor, or one of the editors of available for working with .acb file format. By default, available 

catalogs of colors are located in system folder Program/ColorBooks. You can change the path for 

searching catalog of colors at "Folders" tab of "Customize | Options" command dialog. 

L AYER  

A layer is a parameter of any drawing element. It defines the element association with a particular group 

of the model elements. 

The user can define the layer name for each system element to belong to. A layer name is a string of up 

to 20 text characters.  

An element layer can also be set on the system toolbar. 
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Drop-down part of the control is resizable. The list can be sorted according to various parameters of 

layers. Clicking an icon can modify layer parameter without leaving the current command. The list has 

item "New Layer ...» which allows you to create a new layer without exiting the command and to make it 

active. 

Layer parameters can be created, deleted and modified using the command QL: Configure Layers: 

Icon Ribbon 

 

3D Model → Style → Layers 

Keyboard Textual Menu 

<QL> Customize > Layers 

After calling this command the dialog window Layers appears. In the window of the given dialog box the 

list of the layers existing in the given document and their parameters are shown. Under this list there are 

fields for assigning parameters of the layer and buttons for performing different actions with the fields.  

The button [New] creates the new layer in the document. After pressing this button the system asks to 

give a name to the created layer.  

The button [Delete] removes unused layer (it becomes available only upon selecting from the list the 

layer marked with the sign ).  

The button [Rename] allows assigning the new name for the layer selected from the layers list. 
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The [Information] button allows to display the list of objects located on the selected layer. 

 

 

For changing parameters of any layer it is necessary to select it from the list of the layers and set on/off 

the required flags under the list. You can also set parameters by clicking on the corresponding icon field. 

By entering layer parameters you define the properties of the elements belonging to this layer. You can 

select several layers simultaneously and set parameters for them all.  

The following parameters can be defined for each layer: 

Hidden. A layer can also be assigned invisible property by using a variable. The variable can have 

two values: 0 – the layer is visible, and 1 – the layer is invisible.  

The variable values different from 0 and 1, are processed by the system as follows: the fractional 

part is dropped, and the resulting number is matched with 0. If matching, the layer will be visible, 

otherwise – invisible. 

Frozen. When set, no element on this layer will be allowed for selection during element creation 

and editing. 

Screen only. When set, all elements on this layer will be displayed on the screen only, but will not 

be printed, plotted or exported. 

Hidden when model is used as a Fragment. When set, the elements on this layer will not be 

displayed when the drawing is used as a fragment. 

Visible only when model is used as a Fragment. When set, the elements on this layer will only be 

displayed when the drawing is used as a fragment of an assembly. 
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Color. When set, all elements on this layer will be displayed in the specified color after the redraw. 

The color is selected from the color menu. 

Line thickness. Upon enabling this flag, the same thickness will be set for all graphic lines in the 

given layer. 

Level 
 

Each model element is assigned a level. The level of an element is an integer. It defines whether the 

element will be displayed on screen after the redraw. In other words, it defines the element visibility.  

 

 

The level value can be within the range from -126 to 127. Each element level is connected with the 

system element visibility range that is set in the command SH: Set Levels: 

 

Icon Ribbon 

 

3D → Style → Levels 

Keyboard Textual Menu 

<SH> Customize > Levels 

 

After calling the command, a dialog box comes up for specifying the ranges of element levels.  
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The level visibility range is defined by two numbers in the range from -126 to 127 for each element type. 

An element visibility upon redraw is defined in the following way:  

If the element level value is within the range defined for this type of elements, then the element will be 

displayed upon redraw.  

If the element level value is outside the range defined for this type of elements, then the element will not 

be displayed upon redraw. 

An element level can be defined by a constant, variable or expression.  

Advanced usage of element levels in a drawing requires knowledge of working with variables and 

the command V: Edit Variables. Therefore, continue studying level setting after gaining the 

required knowledge.  

When using a variable for defining a level, enter the variable without braces, for example, LEVEL1. 

 

After exiting the parameters dialog box of the given element, another dialog box will come up on screen 

for setting the value of the variable LEVEL1. 
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Using a variable as an element level allows modifying the way in which the drawing is displayed 

depending on specific conditions. 

As an example, create a drawing shown on the following diagram. 

 

Set the level of the rectangle diagonals using the variable “A”. Set the value of the “A” variable equal to 

“1”. In the command SH: Set Levels set the visibility range for the graphic lines from 0 to 127. In the 

variable editor create a variable “B” with the initial value “1”. Enter the following expression in the variable 

editor for “A”: “B == 0?-1:1”. 
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Thereafter, set the value of “B” first equal to “1”, and then “0”. 

With the first value, the created line will be present on screen, while absent with the second value.  

  

Thus, using variables as levels of various elements, you can create different variations of the same 

drawing.  

Priority 

When creating assemblies, especially, in engineering industry, it is often necessary that one element be 

drawn on top of others. This behavior is easy to realize using parametric fragments, hidden line removal, 

and an additional special parameter of graphic elements – the priority.  

 

The fact is, the model elements are drawn on the screen or other graphical devices in a certain order. This 

order normally corresponds with the element types and the order of element creation. However, this 

order can be changed using priorities.  

 

A priority, just like a visibility level of an element, is an integer from -126 to 127, which can be specified 

by a variable value or an expression. The order of drawing elements follows the rule: elements with lower 

priority are drawn before elements with higher priority. Therefore, an element with a high priority 

“obstructs” the elements drawn earlier. For fully benefiting from the hidden line removal functionality, the 

system provides a special attribute of the hatch contour: “Use for hidden line removal”. When this 
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attribute is turned on, the area of the hatch is filled with the background color. Therefore, using priorities 

and special hatches allows creating assemblies using overlays.  

An example of using hidden line removal could be any assembly of co-axial parts, created from 

fragments. In this case, the fragment parts are created without hidden line removal required in the 

assembly. Simply set their correct priorities when assembling.  

Using this method helps significantly speed up the process of creating assembly models and minimizes 

the necessity for editing elements when modifying the assembly model parameters. 

CONTROLLING ELEMENT V IS IB IL IT Y 

Additional tools for controlling element visibility on the drawing are provided by the commands SI: Hide 

Construction, Show Relations, SN: Hide 3D Annotations и ESO: Hide/Show Elements. These commands 

are available at the instrument toolbar “View” and in the menu “View”. 

 

Command SI: Hide Construction: 

Icon Ribbon 

  
Keyboard Textual Menu 

<SI>, 

<Ctrl><Shift><С> 
View > Hide construction 

The command hides all construction elements in the current window (the 2D view or the 3D view). A 

second call to the command restores the construction element display on the screen. 
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Command Show Relations: 

Keyboard Textual Menu Icon 

<-> -  

This command enables to hide temporarily all relations (see the chapter “Relations”), created in the 

current 2D window. The repeated call of the command restores the relations. 

Command SN: Hide 3D Annotations: 

Icon Ribbon 

  
Keyboard Textual Menu 

<SN> View > Hide 3D Annotations 

This command is available only for 3D version of the system. It enables to hide all 3D annotations (3D 

dimensions, notes etc.) in the current 3D window. 

Command ESO: Hide/Show Elements: 

Keyboard Textual Menu Icon 

<ESO> -  

This command controls visibility of particular drawing elements. The command automenu contains the 

following icons: 

 <S>  Show Element types possible to select 

 <L> Show hidden Element list 

 <*>  Show all hidden Elements 

 <Esc> Exit command 

The  option calls the selector dialog box defining the list of elements allowed for selection within the 

current command. The selector settings made within a command do not affect the settings made via the 

FT: Set Selector Configuration command. Upon entering a command, the selector default settings allow 

selection of all elements. 
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To hide an element, simply click it with . This hides 

the element on screen, making it a hidden element of 

the drawing. Hidden elements are assigned the 

“Hidden” attribute by the system. These are not 

displayed on screen but can be selected in 2D element 

creation and editing commands. 

The option  brings up a window with the list of all 

hidden elements.  

To restore visibility of an element, uncheck the box 

before the element name. The graphic buttons “+”, “-” 

clear/set checkmarks for all elements in the list.   

Calling the option  makes all hidden elements visible. 

D IAGNOSTICS  WINDOW  

Messages about errors and various warnings of the system are shown in the special service window – 

diagnostics window. In addition to the cause of occurrence of the error, the system also shows 

information about the “faulty” element. The diagnostics window is created independently for each 

document opened in T-FLEX CAD application. 

 

The appearance of the table of messages in the diagnostics window is determined by the user. It is 

possible to select the columns which will be displayed in the table, modify the rules for sorting and 

grouping the messages. All these actions are carried out with the help of the context menu of the bar of 

headers of the diagnostic window. 
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The context menu that is invoked inside the table of messages will have another view. If the diagnostics 

window is empty (no errors), only the service commands will be accessible in the context menu: 

 

Hidden Errors List. This command invokes the dialog window with a list of hidden messages. To 

cancel the locking of messages of a certain type, it is sufficient to clear the flag to the right of 

the message. 

Show Window Automatically. If this flag is enabled, the diagnostics window will automatically 

open when the new messages arise. This mode can be useful when combining several service 

windows (including diagnostics windows) into the one common window with tabs. 

Hide Window. This command closes the diagnostics window. The user can again open the 

window with the Customize > Tool Windows > Diagnostics Window command. 

Enable Sound. This command turns on/off the sound signal when the error arises. 
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Group Fragment Messages. This flag of the context menu controls the grouping of messages that 

come from one fragment. When the flag is enabled, the messages from different fragments are 

grouped by folders. 

 

The context menu that is invoked upon pressing  on the error message also contains the set of 

standard commands of editing a faulty element of a 3D model or a 2D drawing. For example, it is 

possible directly from the diagnostics window to launch the Change command for a faulty element. 

 

In the context menu that appears upon selecting one error message, the following command is also 

accessible: 

Hide this message. This command allows us to hide the message in the diagnostics window. 

When invoking this command, the dialog window with additional query appears: “Hide Message 

only For Selected Element? Yes/No/Cancel”. Depending on the answer of the user the following 

variants of the command's action are possible: 

Yes. All messages of the selected type for the same object (2D or 3D element) will be 

suppressed (2D or 3D element); 

 

No. All messages of the selected type for all objects will be suppressed (in the framework of 

the current T-FLEX CAD document). 
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Cancel. The execution of the command is canceled. 

 

Hidden messages are put into the list of hidden messages. They will not be displayed in the 

diagnostics window until the mode of locking is canceled. The action of this command is also 

extended to the subsequent sessions of work with the given file/system. It is possible to view the 

list of hidden messages of the current document and, if necessary, edit it with the help of the 

Hidden Errors List command. 

 

In the diagnostics window it is possible to select several messages simultaneously by using <Ctrl>+ . 

When selecting several messages the following command will appear in the context menu: 

Delete linked elements. This command allows us to delete all 2D and 3D elements linked with the 

selected messages. 
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CHE CKING SPELL ING FOR D RAWING  

T-FLEX CAD allows checking the spelling of any texts in the drawing. Checking is carried out by tools of 

Microsoft Word. 

 

To check the spelling of texts in the drawing the following command should be called: 

 

Icon Ribbon 

 

Tools → Tools →Check Spelling 

Keyboard Textual Menu 

<Ctrl><F11> Tools > Check Spelling 
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After calling this command it is necessary to indicate the text, which needs to be checked, with the . The 

command enables to select and check the spelling of several texts simultaneously on the current page of 

the drawing. With the help of the following option all texts in the drawing can be selected: 

 <*>  Select all Elements 

While the spelling is being checked it is possible to move from one checked word to another with the 

help of  or buttons in the window of command’s properties.  

The command for checking the spelling of texts can also be called from the context menu. 
 



Customizing System 

177 

CUSTOMIZING SYSTEM 

T-FLEX CAD provides a wide range of system customization capabilities. You can set color preferences, 

customize dialog boxes appearance, define function key combinations for quick command access, set 

tool windows location on the screen. To define this kind of parameters, a customization group of 

commands is provided. 

 

The information about the application settings is stored in the system registry. Different application 

settings for different users are supported on the same computer. To restore default system settings, use 

the item Reset Settings. The drop-down list is in the upper right corner. 

 

SET TING OPTI ONS .  D IALOG OF “SE T SYSTEM OPTIONS”  COMMAND  

The command for customizing the system is SO: Set System Options: 

 

Icon Ribbon 

 

 → Options 

Keyboard Textual Menu 

<SO> Customize > Options 

 

The command brings up a dialog box with various groups of parameters available on the respective tabs.  

 

When you select any parameter its tip appears in the bottom part of the screen. Such tips are 

available for the most of parameters. 
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“User” Tab 

 

This tab of the dialog specifies the user name, the name of the company using the system and its license 

number.  

The user name and the company name are saved in each newly created document file. Additionally, 

these parameters, along with the license number, are automatically included in the text of the message 

to the technical support group generated by the command Help > Technical support…  

License. License number automatically included in the text of the message to the technical support group 

generated by the command ? > Technical Support…. 

A message to the technical support group is based on a template whose location is defined by the 

parameter Technical Support Message Form. 
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“Startup” Tab 

 

Load Previous Session Document on Start. If this flag is set, then upon the next start of T-FLEX 

CAD the documents will be automatically loaded that were open at the time of closing the 

previous system session. 

Disable macros automatic execution. Allows to disable automatic macros execution, appointed to 

document events (opening, closing, saving and so on). This mode can be useful when user is 

debugging macros. 

Number of “Recent Files” in menu. Defines the number of items in the list of files opened in recent 

sessions. The number should not be greater than 16. This setting affects the menu File > Recent 

Files and the Start Page dialog box. 

Show welcome page at startup. Defines whether to launch the “Start Page” dialog box on the 

application startup. 
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“2D” Tab 

 

Node construction is transparent. Setting this parameter allows calling the node creation command 

from within any other command. To do so, type “N”. This will not abort the current command. 

Dimension edit is transparent. This option toggles on/off the transparent mode of the command 

Parameters > Dimensions. The latter command allows selecting dimensions on the drawing and 

editing their nominal values. The construction entities that are driven by the dimension are being 

identified and relocated (if possible) according to the new value. 

“Transparent“ Element Editing. When this parameter is turned on, upon selection of 2D elements in 

the command waiting mode with the help of , the command of editing a selected element is 

automatically started. If this parameter is turned off, nothing is happening after choosing a 2D 

element, the system just waits for the user's commands. This parameter is turned on by default. 

Left mouse button action. This parameter defines the action performed for drawing views on the left 

mouse button push while in commands. The action is selected from the pull-down list.  
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At your choice, pressing  in different modes will either bring up a context menu or cancel the 

current command. For example, if the entry Menu in command… is selected, then the context menu 

on pressing the right button will be duplicating the automenu while in a command. 

Node join distance. Sets the radius in pixels for locating nodes on the screen. The join distance radius 

is used when creating new nodes in the “free drawing” mode. If the cursor is within the join distance 

of some node then this node will be selected instead of creating a new node.  

Node size. Sets the size in pixels of a node on the screen. 

Grid point size. Sets the size of grid points on the page in pixels. Grid on the page can be customized 

by Edit>Grid command. 

Position marker size. Specifies the size of position marker. The position marker specifies position of the 

dimension and value on it upon editing. 

“Paper size list” Tab 
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Paper Sizes. In the section you can edit the list of drawing paper sizes. This list can be edited in the 

drawing customization functionality (the Document Parameters dialog box, Paper tab under the ST: Set 

Document Parameters command). 

In the section you can set Name, Width and Height of a general or custom format. It also defines the 

measurement Units of the T-FLEX CAD system. 

Besides, one can set the parameters for dividing the drawing into Zones: 

Step. Defines the X and Y dimensions of one zone. 

Offset. Defines the X and Y offsets of the area being divided into zones with respect to the point (0,0). 

First char, X and Y. Define the characters to begin with when itemizing the zone columns and rows 

respectively. 

Number, X and Y. The number of zone columns and rows respectively. 

Direction. Defines the itemization direction for zones: left to right or right to left, top down or bottom 

up. 

First displayed symbol. Defines, which of the zone-defining symbols (in the X or Y axis), will stand first 

in its notation. 

“3D” Tab 

This tab is specific to the three-dimensional version of the system. It defines the settings used while 

working with a 3D model. 
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The Workplanes group of settings define various parameters of workplanes:  

Standard. Defines the situation of the three default workplanes per the selected standard as follows: 

ANSI – frontal elevation view, bottom-up plan view, right-hand side view; ISO - frontal elevation view, 

top-down plan view, left-hand side view. 

Font. The selected font is used for displaying the name of the workplane or workplane's type 

(depending on settings) in a 3D window. 

Number of grid lines. This parameter defines the number of intermediate lines in the image of a 

workplane in the 3D view representation.  

Selection of workplanes in the 3D view by default is restricted to picking at the outer lines (the border) 

of the workplane. If necessary, the selection can be expanded on all the lines of the workplane image, 

both the border and the inner grid, by setting the flag Select by all grid lines. 

Brightness of 3D elements when drawing on a workplane, % specifies brightness of 3D elements, 

when drawing on a face or surface. 

The following group of parameters allow setting the Size of coordinate system image on the 3D scene. 

Dragger. Defines the size of coordinate system-like draggers used in various 3D commands. 

Scene. Defines the size of the coordinate system image displayed in the lower-left corner of the 3D 

window. 
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The Scene rotation group defines the modes of spinning the 3D scene by certain increments, as follows: 

 

Using Arrows. Defines the angle in degrees of rotating the 3D scene per a keystroke when using the 

two pairs of arrow keys, plus the third pair <Page Up> and <Page Down>. 

 

Using Ctrl+Arrows. Defines a second spin-with-key mode for rotating the 3D scene by a different 

angle. This is similar to the “Using Arrows” parameter, except is used in combination with the <Ctrl> 

key. 

 

Smooth rotation. This flag sets the smooth 3D scene rotation mode during reorientation to a standard 

view. The input box on the right-hand side defines the reorientation duration in seconds.  

Note that setting the mode of rotating the 3D scene with respect to the global axes (the 

command 3RS: Rotate About Global/Local axis) makes the 3D scene spin with respect to the axes 

of the world coordinate system. Otherwise, the 3D scene will spin with respect to the axes of the 

screen coordinates. 

Turn Workplane on Activation. If this flag is set, the 3D scene will be reoriented on calling the Activate 

Workplane command so that the active workplane becomes parallel to the screen. 

3D group 

When object is Created. This attribute defines the system behavior upon creating a 3D element as 

follows: 

Continue. The system remains within the current 3D command after creating 

any element. 

Exit. The current command automatically completes upon creating any 

element. 
 

Select object. The command automatically completes upon creating any element. If the created 3D 

element is a construction one, it is placed on the clipboard (gets selected). This mode may be 

convenient when the user creates an element and instantly proceeds working with it. The following 

is an example of such common sequence of actions: create a workplane – activate it – use it for 

creating an extrusion profile. 

Color for clip plane. You can select Section color, Body color or Body material from the drop-down 

list. It will be used for clip plane displaying. 

Projections group: 

Don’t show warning messages while creating projections. If this flag is set, the warning message will 

not be displayed while creation of 2D projection on the plane created on the base of all elements of 

3D scene. 
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“Graphics Settings” Tab  
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Graphics Parameters group: 

Mode. The option allows us to select one of the two modes: Hardware or Software. The software mode 

is suited for the case when the graphic card is outdated or absent (the mode of remote desktop) and 

graphics is not accelerated by the board. 

The hardware mode provides more efficient and productive work of the system. 

When choosing a parameter of the “3D graphics parameters” dialog the information about 

application of the selected parameter will be available for the user in the lower part of the dialog 

window 

Group of parameters General. 

Antialiasing. This parameter controls the number of pixels used for drawing the smoothed image. This 

parameter allows us to decrease the “saw-toothed nature” of the line on a 3D model. The 

“Smoothing” parameter is available only when using the Hardware mode. By default the “Smoothing” 

parameter is disabled. . 

Display graphics performance data. If the given mode is enabled then in the upper left corner of the 

work window are displayed the graphics system’s current parameters that affect the system’s 

productivity. By default this parameter is disabled.  

Don't display hidden objects. Enabling this option allows us to speed up rendering the image due to 

ignoring the scene’s objects that are totally hidden by other objects. This parameter is available only 

when using the Hardware mode. 

Don't Create Cosmetic Threads. When this option is activated, the cosmetic threads are not displayed 

in 3D models. This option has action only on the image created in the 3D window and does not affect 

2D projections and dimensions on the threaded surfaces. 

 

Group of parameters Small objects. 

The Small objects size parameter allows us to manually select the maximum size of objects on the 

screen in pixels which will not be drawn in the mode of the given optimization. 

Enabling the Don’t display small objects mode does not allow the system to draw the objects with 

sizes smaller than the given maximum size. 

 

Group of parameters Simplifications. 

The settings parameter Target frames per second gives us a capability of setting up the optimum 

speed for redrawing 3D bodies.  

The Simplify geometry option allows us to simplify the visible geometry depending on the size of 

objects on the screen. When for specified values of frequency of frames per second the detailed 

image of the model cannot be formed, the system determines which bodies have the images taking 

the smallest area in the frame. These bodies (their images) are drawn in a simplified manner in the 
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form of parallelepipeds. Thus, the image of the entire model is simplified until the time of rendering 

the frame is smaller than the frequency of redrawing the screen. 

The Maximum size of objects parameter allows us to manually select the maximum size of objects in 

pixels which can be rendered as parallelepipeds when enabling this optimization. 

Hide edges. If this flag is set, then the outline edges will not be drawn in dynamic picture mode and in 

automatic rotation mode. 

Hide constructions. If there are many constructions in the assembly (for example LCSs from 3D 

fragments), the scene rotation can be slowed down because of their rendering. If the flag is set, the 

constructions will be suppressed.  

 

Stereo group allows to setup stereoscopic images viewing. For viewing of stereoscopic images of 3D 

models, it is required to use 3D glasses.  

 

Enable Stereo. Activates stereoscopic displaying of models. 

Stereo Mode. You can select mode of stereoscopic images creation from the drop-down list. 
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Active mode uses quad buffering to receive stereoscopic image. Quad buffered stereo provides 

each eye a unique view from a slightly different perspective by using four buffers (front left, front 

right, back left, back right) rather than the traditional two buffers (front, back). 

Vertical. Images for right and left eyes are placed under each other. 

Horizontal. Images for right and left eyes are placed horizontally near each other. 

Screen Width - width of the display or projection (if you use a projector) in millimeters. 

Virtual screen plane offset specifies the offset of the stereoscopic image plane in percent according to 

the current position. 

Invert swaps the images for right and left eye. 

“Windows” Tab 

 

Move automenu buttons. Places automenu options in columns if there is no space for the whole 

automenu. 

You can setup the following parameters for ribbon mode using the drop-down lists: 

Automenu toolbar position, View toolbar position, Selector toolbar position allows to select a 

location of the corresponding toolbars on the screen. 

Use double buffering on redraws. This flag sets the double buffering mode for redrawing 2D 

document windows that enhances perception of redrawing by removing flickering. 

Halftone Bitmap Drawing. This option turns on the halftone mode of displaying bitmaps: raster 

pictures, inserted into T-FLEX CAD documents, ray-tracing results, etc. By default this parameter is 

turned on. 
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Scale percentage. Specifies percent for zooming of the current window visible part. 

Shift percentage. Specifies percent for panning of the current window visible part. 

These parameters can be also set in ZW: Zoom area command. 

When new windows are created group of parameters defines the following modes: 

Add Scrollbars. Displays scrollbars when opening document windows. 

Create Rulers. Similar to the previous, if unset, the rulers are not created on opening the window. 

 

“Folders” Tab 

 

 

Folders group: 

Colors Catalog. This setting specifies the path to the folder that contains colors catalogs. For example, 

the colors are used to create color-based materials and set colors on the “Colors” tab. 
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Macros setting specifies the path to the folder, which content will be displayed in the Macros window. 

Prototype Folder. This setting specifies the path to the folder whose content will be displayed in the 

“Welcome” dialog box on the application startup and in the FP: Create New Document Based on 

Prototype command dialog box (File > New From Prototype…). 

Font Folder. This parameter indicates the path to the folder in which the files of description of SHX 

fonts are located. If necessary, the user can select the fonts which are not from the standard folder. 

Structural elements group: 

Types Catalog. This setting specifies the path to the folder which content will be displayed in the 

Editor of structure elements types. 

“Database”, “Documents”, “Bill of Materials”, “Texture”, “Fonts” tabs 
These tabs are used to define a list of additional folders for searching files that could not be found in the 

standard folders. 

 

The  button adds a new string for search folder. The  button brings up a browser window for 

selecting the desired folder on the disk. Select the folder on the tree using the cursor. Upon confirming 
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the selection with the [OK] button, the browser window closes and the name and path to the selected 

folder will appear in the selected file type input box. 

The  button allows deleting a folder selected from the list of defined folders. 

The  and  buttons move the selection frame up and down the list of defined folders. 

To work with search folder strings using the clipboard use buttons , , . 

Example: suppose we open a drawing file with a fragment assembled in it, while the path to the 

fragment has changed. In this case, a message will be displayed about an error opening the fragment file. 

The fragment itself will not be displayed on the drawing. This error can be fixed by either changing the 

path to the fragment, or using the described tab and defining an additional folder where the fragment 

file is located. In that case, the system will be automatically searching for the fragment file in the 

additionally defined folder as well, and the error opening the file will not occur. 

 “Bill of Materials” Tab 
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Folders Group: 

BOM Sections. Defines the name and the path of the database file keeping the set of BOM groups. The 

specified database will be the one used in creating new and reading already created BOMs. 

BOM Prototypes. Defines the path to the folder of template files used for creating new BOMs. The files 

from this folder will be displayed in the BC: Create Bill of Materials command dialog box. 

Product structure Types. Defines the path to the folder where XML files with product structures 

descriptions are saved. 

BOM/Report Templates. Documents from the folder will be displayed in the templates list when you 

create a new report based on the product structure. 

 

Colors Group: 

Hidden Records Background Color. Defines hidden records background color. Hidden are considered 

the records deleted from the BOM but yet still stored in its inner data structure. The way of displaying 

hidden records in a BOM is defined accordingly. 
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“Files” Tab 

 

 

 

Templates group: 

Drawing. A prototype is a T-FLEX CAD drawing file, whose data is used for initializing a new drawing. 

You can create several prototype files. In the case the path is not specified with the name of the 

prototype, the system will search for it in the application folder (PROGRAM). 

One can save a prototype file using the command File > Save as Prototype. In this case, the prototype 

will be saved in the folder …\PROGRAM\ Template. To create a new drawing with the same settings as 

in this prototype, use the command File > New From Template… 

Assembly Drawing, 3D Assembly. A product structure of each assembly template includes records for 

assembly forming. It’s their only differ from standard templates. 

Assembly drawing template 
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3D Model. This is the prototype file with the 3D window settings used for creating a new 3D model. 

3D Model in Context. This is the prototype file that contains the settings of the 3D window that are 

used upon creation of a new 3D model of the fragment in the context of the assembly. 

Annotation. This is the prototype file for creating a new annotation using the annotation editor. The 

file path is automatically assigned upon installing the Annotation Editor.  

Files group: 

Hatch pattern. The system uses hatch pattern files corresponding to the respective AutoCAD “.PAT” 

files. The file TCAD.PAT, included with the system installation, defines the hatch filling patterns. You 

can define any hatch pattern file of your own. 

Line type. The system has several built-in line types (continuous, thin, waves). The rest of types are 

defined by the line type file. The system uses the file TCAD.LIN. Its format complies with the line type 

files of the AutoCAD system. You can define any type file of your own. 

Function spline. This special file contains data for setting up the menu of the Function Spline creation 

command. (A function spline is a kind of a construction line.) To create new functions, modify the 

standard file named “FUNCTION.DAT” or create a new file by sample, and set its name in this input 

field of the dialog box. 
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“Fragments” Tab 

 

This tab defines the options used in inserting and editing fragments. Parameters on this tab can also be 

set from the fragment parameters modified under the fragment insertion and editing commands using 

the [Options…] button. 

 

Keep Library Names. If set, library names will be saved on inserting a fragment from a library. 

Otherwise, the absolute path of the respective library folder will substitute the library name. 

 

Optimize File path. If set, the library name or the path will not be entered in the case the current 

assembly document and the respective fragment are in the same folder. This helps moving both the 

document and the fragment file to another folder without changing folder settings.  

 

Input. This group defines the flags used while assembling fragments: 
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Create Named Nodes Automatically. This flag defines whether the new nodes will be created on the 

current assembly drawing based on the named nodes from the fragments being inserted. The nodes 

created from fragments can be used for further construction, dimension placement, etc. 

Substitute Variable values. In case this parameter is set, upon the fragments' insertion, their external 

variables are automatically set equal to the values, assigned for these variables in the model of the 

fragment. Otherwise, the values of the variables are not prescribed. 

Edit. Examples of editing fragments: 

 

Double click action. This attribute defines what kind of action occurs on the left mouse double-click 

during fragment editing. 

 

Fragment Actuality Check. This group of parameters defines the system behavior when the files are 

modified of the fragments that enter the current document (the current 3D assembly), in various 

situations: 

 

On Open Document. The parameter defines the system behavior upon opening a 3D assembly (if it 

was found that a fragment files were modified since the time of saving the assembly). The following 

choices can be made from the list: Update - the fragments will be updated, Don't Update - skip 

updating fragments, Ask – prompt the user about how to proceed upon finding modified fragments. 

The default setting is “Ask”. 

 

On Document Activation. This parameter defines the system behavior upon returning to a document 

window (when simultaneously working with multiple T-FLEX CAD documents). In this case, the state 

of the current 3D assembly is also checked for the consistency with the fragment documents stored 

on the disk. If the check finds fragments, whose documents were modified after the last check, the 

system will proceed according to this parameter setting: Update, Don't Update, Ask. The default is 

“Ask”. 
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“Snap” Tab 

 

This tab serves to define parameters that are used when working in the object snapping mode (including 

the cases of sketch creation). 

Search radius. Sets the radius in pixels for searching the elements of the system on the screen. This 

parameter is used in new element creation in object-snapping mode. Keep in mind that this 

parameter setting overrides the Node join distance parameter defined on the “Preferences” tab. 

Select Graphic Lines when creating hatch contours instead of Construction Lines. Setting this 

parameter allows selecting graphic lines when constructing hatches and 2D paths. This is required in 

cases when the construction lines coincide with graphic lines. This option helps set up object 

snapping so as to have the desired elements selectable in the complicated cases upon the cursor 

approaching,– for example, graphic lines (if the parameter is set). At the same time, it is still possible 

to select other elements by using the keyboard commands (<C> – select a circle, <L> – select a line, 

etc.). 
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Show Tooltips. Sets the pop-up tooltip display mode when selecting elements on the drawing while in 

object-snapping mode. 

Enable Snap to Nodes on Frozen Layers. If this flag is turned off, snapping to nodes, located on 

“frozen” layers is not possible. Upon turning on this flag, snapping to such nodes becomes possible. 

Priority Tab 
Priority Tab determines, what snap types can be used in the object snapping mode. 

Most snaps can be managed even outside the command SO: Set System Options – by using icons 

on the “Snaps” toolbar. 

 

For example, suppose, a tolerance needs to be placed next to a dimension. To achieve that, enable the 

flag Enable snaps to/Dimensions. Call the command Draw > Tolerance. As the cursor approaches a 

dimension defining point, it becomes marked with a rectangle. If you then click , a node will be created, 

and an annotation element – tolerance will be created. 
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To snap a tolerance to the midpoint of a graphic line, enable the flag Enable snaps to/Graphic 

Line Middle Points. In this case, while in the tolerance creation command, midpoints of graphic 

lines will be getting highlighted upon cursor approaching. If you then click , a node will be 

created, and the tolerance annotation element snap to it. 

            

A 2D node created using any-type snap can be free (not maintaining a relation with the elements 

based on which it was constructed, after the creation) or constrained (tied) - where the node 

relation with the source elements is maintained. 

When using snaps to a construction line intersection, a circle center, end points of graphic lines, 

defining points of drawing annotation elements (dimensions, leader notes, roughness symbols, 

tolerances), as well as 2D fragments – then constrained nodes are always created. 

When using all the rest snap types, the state of the auto parameterization mode is significant (the 

 icon on the “View” panel). If the auto parameterization mode is enabled, then a constrained 

node is created. With the auto parameterization mode disabled, either a free node is created, or a 

point with appropriate coordinates (when creating a leader note, roughness, tolerance, cropped 

view symbol and 2D fragments). 

The buttons  and  serve to modify the priority of object snaps. Snap priorities determine, in what 

order the system will be offering them to the user in the case when several snap possibilities are found. 

The list Enable snaps to has the snaps positioned in the decreasing priority order. 

For example, snapping to construction lines has higher priority then “Vertical/Horizontal” snapping (this 

can be seen by their position in the list). Therefore, when constructing 2D elements using snaps, the 

system will first offer the user snapping to construction lines, and only after that - snapping to 

vertically/horizontally aligned nodes. 
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Dynamic Toolbar Tab 

 

Use Dynamic Toolbar. This parameter controls the image of the dynamic toolbar upon selection of 2D 

and 3D elements in the command waiting mode with the help of . This toolbar includes commands 

frequently used for the selected element. For 2D elements the dynamic toolbar is displayed only 

when the parameter “Transparent Element Editing” is turned off. 

Visibility Range – defines a zone around the dynamic toolbar in pixels. The dynamic toolbar is 

displayed on the screen if the cursor is inside this zone. As soon as the cursor goes outside of this 

zone, dynamic toolbar disappears. 

Transparency. If the flag is active, the transparency of the dynamic toolbar depends on the position of 

the cursor. The farer the cursor is the more transparent is the toolbar. If the flag is off, the 

transparency is not changed when moving the cursor. 

Always visible. If the flag is active, the dynamic toolbar is visible on the screen until the command is 

finished. The cursor position does not affect displaying of the toolbar. 
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“Colors” Tab 

 

This tab defines the colors used for drawing 2D and 3D model elements on the screen, as well as the 

application window colors. 

The “Common” group of colors defines the default colors of various elements of the 2D document 

window. It also includes such common parameters as the background color of the application windows 

and the frame color of the active pane in the case the document window is split. These settings do not 

affect the documents whose respective colors are explicitly defined by the command ST: Set document 

parameters. 

Additional groups, such as 3D, 3D Elements Highlighting, 3D Draggers and Decorations, 3D Rulers are 

specific to the 3D version of the system, and define various colors of the 3D scene visualization. 

 

The entered settings can be saved into an external file with the extension “*.tfc” for future reuse. This can 

be done using the [Save…] button. To load color settings from an external file, use the [Load…] button. 
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“Additional Options” Tab 

 

Diagnostics group 

Beep Noise - Messages in Diagnostics window will be accompanied by a beep noise. 

 

 

Right mouse button action. The parameter specifies action type, which is performed upon pressing . 

You can select one of the types using the drop-down list. According to your choice after pressing  

in different modes the corresponding context menu will appear or the current command will be 

cancelled. 

For example, if the Menu in commands… item is selected, the context menu duplicates the automenu 

upon pressing  during the command execution. 

Invert Mouse Wheel Direction on Zoom. This option serves to switch to the opposite the zooming 

direction in the system windows with the mouse wheel spinning. 

Enable Dynamic Deletion. This flag allows us to activate the mode of “quick deletion”. To delete any 2D  

element, it is sufficient to move the cursor to the element (the element will be highlighted) and press 

<Del>. 

Print Group 

Legacy printing. Use legacy Print command. 
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Preview timeout. If the maximum drawing time at print preview exceeds the specified value 

(milliseconds), redrawing is not performed and Show button appears. 

“Performance” Tab 

 

Regenerate model automatically. When this flag is set, the 3D model will be regenerated automatically 

in case of parameters change (upon exiting the variables editor, changing construction line positions, 

etc.). If the flag is cleared, then the automatic regeneration does not occur in such cases. To 

recalculate the model, you would have to manually call the model recalculation command Tools > 

Regenerate or <Alt><F7>. 

Limit Memory for Calculation of Projections, МB. This parameter enables to set the upper bound on 

the size of the memory allocated for recalculation of 2D projections. By default, the following 

limitation is set: 

- For 32-bit operating system Microsoft Windows – 300 МB; 

- Upon using 32-bit version of the T-FLEX CAD with Windows x64 – 1000МB; 
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- For 64-bit version of the T-FLEX CAD x64 with Windows x64 – no limitations. 

Use Multithreading on Calculations. This flag activates the mechanism of multithreaded calculations 

inside the system on computers having multi-core processors or on multiprocessor systems. This 

enables to increase the speed of regenerating the models. Multi-threaded data handling is used 

upon calculating geometry of 3D operations, calculating finite-element meshes. 

Undo/Redo buffers. You can specify the maximum number of user actions to be remembered by the 

UN: Undo Changes and RED: Redo Changes commands. This parameter should be specified before 

opening a file.  

Maximum volume of RAM for temporary unloading parts in large assembly mode, MB. Upon 

working with large assemblies some of their files are unloaded to the hard drive and some are stored 

in the RAM. This parameter allows you to specify maximum RAM to operate with large assemblies. 

Don’t display 2D objects smaller than, pixels. Objects, which size is smaller than the specified value, 

will not be displayed on the drawing. This option helps to speed up manipulations with the large 

drawings. 

“Save” Tab 

Autosave every. When set, the current document is automatically saved after the specified period of 

time. Saving the model occurs only when switching from one command to another, and is not done 

while working within the same command, in order to preserve the model data integrity. 

 

Create Backup copies. This flag sets the mode of creating backups on saving document files. The 

parameter can take the following values: 

None – no backup. 
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On first save – A “.BAK” file is created on the first save of a document after opening it for editing. 

On every save – The previous saved file version becomes the backup copy on every document save.  

New on every save – backups are created on each save with different extensions, as “.B01”, “.B02”, 

etc. 

«T-FLEX DOCs» Tab 

This tab defines parameters of the joint work of T-FLEX CAD and T-FLEX DOCs system. The settings for 

the given tab are available for editing only if T-FLEX DOCs system is installed on a given work place. 

 

The T-FLEX DOCs Integration parameter specifies one of the modes of work with T-FLEX CAD: 

 

No — the system works in the regular mode. This mode is chosen by default; 

With files and documents of DOCs – the system supports the work with both types of documents: 

T-FLEX CAD and T-FLEX DOCs ; 

 

Only with documents of DOCs – control over opening and saving the documents is carried out by 

T-FLEX DOCs system. 
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Update product structure automatically on saving file. If this flag is enabled, when saving a file the 

command of saving the product's structure into DOCs is automatically invoked. 

 

The Update files of fragments when opening assembly parameter sets up the mode of verification 

of the actuality of files of fragments, pictures, etc., upon opening and regeneration of the assembly: 

 

Don't update – The file will be downloaded from the server only if it is absent. This is the most 

optimal variant in terms of efficiency but there is no synchronization during the joint work. 

 

Update –  All files that lack actuality are automatically synchronized. This variant works more slowly 

but it always guarantees the actuality if something has changed on the server. 

 

Check and ask – The actuality of all files in the assembly at all levels will be checked and the 

question will be asked if DOCs has files newer than they are in the work folder. This is a compromise 

variant. 

 

Update product structure automatically in case of document saving. If the flag is set, the command 

for saving product structure into DOCs is automatically called upon file saving. 

 

Integration rule. The parameter allows to select a rule from the T-FLEX DOCs “Application integration 

rules”. 

Integration rule can be selected only after the integration is done, since integration rules are stored in 

the DOCs.  

Therefore, you need to select integration type and press [OK]. After that you should wait for the 

integration to happen, reopen dialog using the SO: Set System Options command and select one of 

the integration rules from the list. 

“All” Tab 

All existing parameters are displayed on the All tab.  
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The parameters can be sorted by categories  or alphabet . 

You can enter parameter name or part of the name into the search bar to find it. 

 

CUSTOMIZING TOOLBARS AND KEYBOARD  

To move a toolbar, depress  over the area of the toolbar free of buttons, and drag the toolbar to the 

desired location. While being dragged, the toolbar may dock at any border of the main application 

window or remain floating over the application. In the floating state, the toolbar has a title bar with its 

own title. 

 

Floating toolbars can be resized. To do so, place the cursor over the toolbar window border (the cursor 

will assume “resize” shape), and drag the border as desired. 



T-FLEX CAD Brief Introductory Course 

208 

 

To switch between docked and floating state of a toolbar, double-click   over the area of the toolbar 

that is free of buttons. 

Standard toolbars (“Main” and “View”) include into themselves several “embedded” toolbars. At the same 

time, in the main toolbar, by default, only one icon of the “embedded” toolbar (the rest are hidden) is 

displayed, to the right of which there is a button . Upon pressing this button the “embedded” toolbar 

is opened together with the remaining icons of the given group. 

 

The embedded toolbar can be turned into the regular toolbar. To do this, it is necessary to place cursor 

into the title area of the embedded toolbar, press  and, without releasing the pressed button of the 

mouse, drag it to any place of the T-FLEX CAD window. 

 

The buttons of the embedded toolbar can be also placed directly on the main toolbar. To do this, it is 

enough to press the button  at the right end of the embedded toolbar. 

 

 

Controlling Toolbar Visibility 

To show or hide the desired toolbar, one can do  over any displayed toolbar. The context menu will 

appear with the first item containing the list of all available toolbars. 
 

The currently visible toolbars are checkmarked. To show or hide 

the desired toolbar, select the respective menu item. 

To show or hide several toolbars at once, one can use the item 

“Customize…” in this same menu, or the command SB: Show 

Toolbars: 
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Icon Ribbon 

 
 → Customize 

Keyboard Textual Menu 

<SB> Customize > Customize 

 

This command brings up a dialog box with tabs supporting various manipulations over toolbars and 

binding any key combinations to the application commands.  

“Options” tab 

On the tab Options there are parameters controlling the display of the textual menu and toolbars of the 

system. 

 

The group Personalized Menus and Toolbars includes into itself parameters determining the way the 

textual menus are displayed: 

 

Always show full menus. By default, this flag is turned off. In this case the T-FLEX CAD textual 

menu are displayed in a shortened version, hiding the menu items which have not been used for 

a long time. For accessing the hidden items of the textual menu, the button  found in the 

lower part of  the menu is used. 

If the flag is turned on, the textual menus are displayed to the full size. 
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Show full menus after a short delay. This parameter is available only when the flag “Always 

show full menu” is turned off. By default, this parameter is turned on. It enables to display the 

hidden commands in the menu just by holding the cursor over the button  for some time 

(without pressing it). 

 

The button [Cancel] cancels all changes made in the settings of the standard toolbars by the user. 

 

The group “Other” combines the following parameters: 

 

Ribbon mode. Allows to switch between ribbon and textual interfaces.  

 

More information about interfaces can be found in “Quick start” chapter. 

Icons size. Magnifying the size of the buttons in the toolbars and automenu. You can select small 

(16x16 pixels), medium (24x24 pixels) and large (32x32 pixels) icons from the drop-down list. 

 

Show Tooltips on toolbars. This parameter activates the mode of displaying tooltips upon 

pointing with the cursor at the buttons of the toolbars. 

 

Show shortcut keys in tooltips. This option turns on/off the mode, in which not only the name of 

the command but also the shortcut keys are shown in the tooltip. This option is available only 

when the flag “Show ScreenTips on toolbars” is on. 

 

Menu animations. This drop down list defines a special effect used upon opening the textual 

menu: System default (in accordance with the general settings of the Windows), Random, 

Unfold, Slide, Fade, None. 

 “Ribbon” Tab 

You can add commands to the Ribbon and Quick access toolbar on the Ribbon tab  



Customizing System 

211 

 

All existing commands are listed in the field to the left. You can select displayed commands using the 

drop-down list above the field. 
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All existing ribbon tabs are listed in the right field. To add a command to the tab you need to: 

- Select a command from the left field. 

- Select a group on a tab in the right field.  

- Press the [>>] button. The command will be added to the group. 

 

Use the drop-down list above the right field to switch between Ribbon and Quick access list. 

 

Add tab button  allows to add a tab to the ribbon. 
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Add group button allows to create a new group on the selected tab. 

Rename/Delete buttons  allow to rename/delete the selected element. 

Import/Export buttons  allow to import/export ribbon parameters from/to the XML file. 

“Toolbars” Tab 

The Toolbars pane lists the standard (available) toolbars used in T-FLEX CAD. A toolbar visibility is 

controlled by setting or clearing the checkmark in the box before the name of the respective toolbar. 

 

The buttons at the right side of the dialog box are used for creating and editing the user's own toolbars, 

and also for restoring the settings of the standard toolbars (canceling changes made by the user). 

Creating user's toolbar. Defining toolbar name 
To create a new toolbar, use the button [New]. In the coming up dialog box, define the new toolbar 

name and press [OK] button. A floating toolbar comes on screen. Then, open the “Commands” tab. 

Select the desired toolbar name from the “Toolbars” list and the button from the “Buttons” area, and 

drag the button into the newly created toolbar using . 
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The name of the user's toolbar can be also modified after creating the toolbar. To do this, it is enough to 

select a desired toolbar in the list and press the button [Rename…]. This makes the window for assigning 

the name of the given toolbar appear on the screen again. 

Creating new toolbars can be also carried out on the tab Main toolbar (see below). 

Changing toolbar content 
While in the command Show Toolbars with the “Toolbars” or “Commands” tab brought up, one can 

remove or move icon buttons from visible toolbars to other toolbars by dragging with the cursor, using 

. Separators can be inserted to and removed from toolbars. This is done by selecting a button and 

dragging it a bit aside. The same action can be done outside any command, by additionally holding 

down the <Alt> key. 

Any icon button on a visible toolbar can be duplicated by dragging it with the cursor, using  while 

holding down the <Ctrl>+<Alt> combination, to any other toolbar or to an isolate location, thus 

creating a new floating toolbar.  

Deleting toolbar 
To delete a toolbar, use the [Remove] button after selecting the intended toolbar in the list. Note that 

only user-defined toolbars can be deleted. Standard toolbars can’t be deleted.  

Restoring content of modified toolbar 
To cancel all changes, made in the standard toolbars, the button [Cancel] can be used. Pressing this 

button restores the initial state of the selected standard toolbar. 

“Commands” Tab 

The list “Categories:” contains the set of categories of the T-FLEX CAD commands. The sets of icon 

buttons in the “Commands” area are updated upon categories selection. 
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A special category “User Commands” includes into itself user's commands, defined in the dialog box of 

the command Setting > User Commands… (see below). 

The tab “Commands:” contains the list of the commands, included into a selected category. To add a 

command to a toolbar, simply drag the button by the cursor, using , to the desired toolbar. 

“Keyboard” Tab 

This tab defines control key combination bindings of the system commands. The tab provides for 

creating new key combinations, assigning them to commands, deleting previously assigned bindings, 

and resetting (restoring the original system settings) of all key combinations. 
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The drop down list “Category:” enables to choose a category which contains the command being edited. 

The commands, included into the selected category, are shown in the list “Commands:”. 

The “Keys Assignments” pane displays all control keys for each particular command currently selected in 

the “Commands” list. If the pane stays empty upon selecting a command, no key combination is assigned 

to this command.  

To assign a control key combination to a command, enter the new combination in the “Press new Key” 

input box. 

Creating a new control key combination 
1. Choose the commands' category in the list Category:. 
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2. Select the desired command in the Commands list. 

3. Place the cursor in the “Press new Key” input box and click . 

4. Set the new key combination using the keyboard, for example, simultaneously press 

<Ctrl><Alt><F12>. The input box will read, “Ctrl+Alt+F12”. If a wrong combination is entered, 

simply enter the right combination over again, without trying to delete anything. 

5. Press the [Assign] button. The new combination will then appear in the current keys list. 

Several control key combinations can be assigned to the same command.  

Deleting control key combination 
1. In the list Category: choose the commands' category. 

2. Select the command in the Commands list whose control key binding is to be deleted. 

3. Select the intended key combination in the Keys Assignments list. 

4. Press the [Remove] button. 

Reset all key combinations to the original state 
To delete all manually assigned key combinations, simply press the [Reset All] button. All key bindings 

will then be restored to the original state, the way they were assigned at the initial system installation. 

“Environment” Tab 

This tab serves to work with Environments. 

Environment is a set of system settings that can be saved in the Windows Registry or in an external file 

with the purpose of a future quick system setup. An environment may include the following settings: the 

visibility and composition of toolbars, special system windows, library and folder windows; the system 

settings, default customizations of various commands, etc. 

The list of existing Environments is displayed in the left part of the dialog. Initially, the only item in the list 

is “Current Environment”. It denotes the current system settings. In the future, all user-created 

Environments are added here. 

Already existing Environments can be renamed or deleted. To do that, select them in the list (using ) 

and click the respective button ([Rename] or [Delete]). 

To apply an existing environment, select it in the list and click [Apply]. 
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You can create a new Environment either based on the current system settings (“Current Environment”), 

or based on another existing Environment. 

To create a new Environment, you need to: 

 Select and Environment in the list, whose settings need to be copied to the new Environment. 

You can also select the “Current Environment” for this purpose – in this case, the current 

system settings will be saved in the newly created Environment; 

 Once an Environment is selected, you will see the list of setting groups stored in it. By default, 

all parameter groups are marked with checks in the list. That means, all of that will be copied 

to the new Environment. To avoid copying some settings, clear the checks before the 

respective group names; 
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The list of setting groups is closed upon another click  on the selected Environment. The changes 

made in it (changes in the setting groups selection) will be remembered until selecting another 

Environment in the list. To close the list, you can also use <Left>, <Right>. 

 Click the button [New]. A new Environment with the standard name "Environment 1 (2, 3, …)" 

will be created. Right after the Environment creation, the system goes into its name editing 

mode. You can cancel that by clicking  outside the Environment name input field. You will be 

able to edit an Environment name in the future using the button [Rename].. 

An existing Environment can be altered by overwriting the settings stored in it by the current ones. To do 

that, select it in the Environments list, mark the groups of settings in its settings list, which you need to 

replace, and click [Overwrite]. Please note that this button is unavailable for the “Current Environment” 

item. 

To save an existing Environment in an external file, use the button [Export…]. Upon clicking the button, a 

standard file-saving window appears. The file name default is the same as the Environment name. The file 

extension is – "*.2Denv" for the 2D system version, "*.3Denv" for the 3D system version. 

To import an Environment from an external file, use the button [Import…]. Upon clicking it, the standard 

file-opening dialog appears, in which you need to select an Environment file. The Environment imported 

from the file appears in the Environments list. Besides that, upon importing an Environment the system 

will offer to apply it. 

The Environment files created in the 2D system version will not be recognized in the 3D version, 

and vice versa. 

The buttons [Apply], [Delete], [Rename], [Overwrite] are inaccessible for the “Current Environment” 

item. But the latter is provided the Reset Settings command, using which replaces the current settings by 

the default ones. 
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 “Main toolbar” tab 

 

This tab displays the list of all main toolbar sets that are defined in the system. The sets marked in the list 

by the tick are displayed on the toolbar, unmarked sets are hidden. It is possible to control visibility of 

the sets independently, by removing/putting the tick (with the help of ) located next to the name of the 

corresponding set. 

Double pressing  on the name of any set activates the set on the main toolbar. 

The button [Rename] enables to assign another name to any set of the main toolbar. After pressing this 

button, the window for assigning the new name of the set appears. 

Buttons [Up] and [Down] allow changing the order in which the sets follow in the list. 

To add the new (user's) set to the main toolbar the button [New] is used. After pressing this button the 

system prompts to assign the name of the set being created. Also, the prompt to add the standard 

buttons (i.e. related to command used for working with new documents, files etc.) to the new set will 
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appear on the screen. In case of negative answer, an empty set is created, in case of positive one, the set 

containing only the standard buttons is created. Other buttons can be added to the created set via the 

tab “Commands” (by using “drag&drop” method). 

It is possible to remove the previously created user's set by selecting it in the list and pressing  the 

button [Remove] (for standard sets this button is not available). 

The button [Create toolbar] enables to create a single toolbar on the basis of the set selected in the list. 

Upon creating the toolbar, it is possible to automatically remove the standard buttons from it (by default, 

these buttons are present practically in all standard sets of the main toolbar). 

To make the work more convenient, several sets of main toolbar commands were assigned the key 

combinations for quick call with the help of the keyboard (by default, these sets are “2D”, “Sketch”, “3D”). 

If necessary, the key combinations can be also assigned for other sets (including user's defined ones). To 

do it, the buttons [Assign] and [Reset] in the group “Keyboard” are used.  

After pressing the button [Assign] the window opens up in which the required key combination for the 

selected set has to be specified. For specifying the combination, it is just enough to press the 

corresponding buttons simultaneously. If the combination is specified incorrectly, it is sufficient to press 

the correct combination again. After closing the window with the help of [OK] the specified key 

combination will be displayed in the list to the right of the name of the corresponding set. 

 

To modify already defined key combination for some set, it is enough to press the button [Assign] and 

specify new combination.  

For removing the assigned key combination without specifying a new one, it is necessary to press the 

button [Reset] after selecting a set in the list. 

The Show labels flag controls how the labels to the buttons of the main toolbar are displayed. By default, 

the flag is disabled, i.e., the labels are not shown.  

The “Show Labels” flag has a similar action in the context menu that is invoked with the help of   

in the domain of the automenu or any toolbar. These two flags (“Show Labels” in the SB: Show 
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Toolbars command and “Show Labels” in the context menu of toolbars) work in a synchronized 

manner. 

Additional flag called Use standard font affects how the labels to the buttons of the main toolbar are 

displayed when working in Windows Vista. If in the settings of Windows Vista the large font size is 

selected and the “Use standard font” flag is disabled, the labels to the buttons of the main toolbar will be 

displayed larger than the labels in the text menu. If the flag is enabled, the font size on the main toolbar 

is the same as that in the text menu. 

  “3D Input Device” Tab 

T-FLEX CAD supports three-dimensional 

multifunctional manipulators compatible with the 

standards Spaceball and SpaceMouse (for example, 

the products of 3Dconnexion, a Logitech Company, 

http://www.logicad3d.com). The 3D manipulators 

allow panning, spinning and zooming objects in the 

3D window. 

Once such a device is attached, the SB: Show 

Toolbars dialog box gains another tab, “3D Input 

device”. 
 

This tab is used for setting up 3D device working environment. The user can set up device operating 

options in three modes: for working with 2D drawings, for working in the 3D model window, and for 

working in the 3D model window in the active workplane mode. Selection of a working mode to set up is 

done in the pull-down list of the parameter View mode. 
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The user can change: 

- Mapping of the device axes on those of the T-FLEX CAD global coordinate system; direction 

of action (translation or rotation) along each axis; sensitivity of the device to impacts for 

each type of input (the Axes group). The device sensitivity is adjusted by the appropriate 

sliders. The more a slider shifted to the right the less impact is required on the device for 

translating/rotating the model along this axis; 

- The level of filtration from accidental device disturbance (the Filtering parameter). The 

slider position defines the filtration coefficient in the range from 0 (all impacts handled) in 

the left-most position to 100% (only strongest impacts are handled) in the right-most 

position. 

With simultaneous impacts on several axes of the 3D device, the axis of the maximum 

impact is determined by the system. This impact is considered primary and is handled 

always. Other impacts are handled only when they exceed the product of the maximum 

impact and the filtration coefficient; 

- Mapping of the device buttons. Each device button can be mapped on a T-FLEX CAD 

command (the dialog button ), or a keyboard key press (the button ). To cancel a 

mapping, use the  button. 

The buttons [Reset], [Save…], [Load…] allow respectively resetting the changes to default settings, saving 

the new settings in an external file (“*.t3d”) and load device settings from an external. 

SAVING USE R SET TINGS .  ENVIRONMENTS  

Settings made in the commands SO: Set System Options and SB: Show Toolbars, as well as in some 

other commands, can be saved using the Environments mechanism. Created Environments are used to 

quickly set up the system. 

Environment is a set of system settings that can be saved in the Windows Registry: the visibility and 

composition of toolbars, special system windows, library and folder windows, the system settings, default 

customizations of various commands. An Environment may also include the settings made in various 

system windows (variables editor, databases, etc.) and, as was already mentioned, all settings defined in 

the commands SB: Show Toolbars and SO: Set System Options.  

Environments are created by the user. Created Environments can be edited and deleted. 

By using Environments you can quickly set up the system in a desired way by simply applying an earlier 

saved Environment. You can create an unlimited number of Environments. In this way, for example, you 

can arrange convenient working of several users on one work seat: save each user's Environment with 

one's personal settings and apply it when needed. Besides that, Environments can be stored in external 

files and, therefore, be loaded from external files. This allows porting T-FLEX CAD settings from one work 

seat to another one. 

The main work with Environments (creating, editing, deleting, applying, export/import from an external 

file) is done in the SB: Show Toolbars command dialog on the “Environment” tab. This was described 
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earlier in this chapter, the section “Customize Toolbars and Keyboards”, the topic “'Environment' Tab”. 

Here we will describe the method to quickly apply already created Environments. 

The Environments existing in the system can be quickly loaded using the textual menu Customize > 

Environment. All Environments existing in the system are added there automatically.  

 

To use any of the Environments, you just need to go into the said menu and select the desired 

Environment from the list.  

Customize > Environment > Customize… command serves to quickly open the SB: Show Toolbars 

command dialog on the “Environment” tab. 

ADDING USER 'S COMMANDS  

T-FLEX CAD lets a user add to the textual menu of the system or on the toolbars his own commands that 

enable him to start external applications and macros, open a document, a window with a folder or a 

library. For the added command an icon can be assigned (file “*.ico”). 

For adding user's command the following command is used: 

Keyboard Textual Menu Icon 

- Customize > User Commands… 
 

After calling this command the dialog window User Commands will appear on the screen. In this window 

the following items are defined: the command's type (what sort of operations this command will do), 

command call parameters, command name, a line of a tooltip for a command and its icon for displaying 

in the textual menu or on the toolbars of the system.  

To add the command, it is necessary to press the button [Add]. 
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Upon pressing this button a drop down list for choosing the type of the command being added will 

emerge: 

 Macro – adding the command for calling a macro. When this item is selected, a window of 

an auxiliary dialog box for choosing a macro is opened. A macro can be selected from the 

list or assigned manually; 

 

 External Application – adding the command for calling an external application (without 

exiting the T-FLEX CAD). When this item is selected, a window of an auxiliary dialog box for 
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selecting an external application and start-up parameters will emerge. An additional flag 

Wait for application completion prohibits continuation of work in the T-FLEX CAD before 

closing the window of external application; 

 

 Open Document – adding the command for opening the T-FLEX CAD document. When this 

item is selected, the standard file selection dialog box will appear; 

 Open Folder Window – adding the command for opening a certain folder with the T-FLEX 

CAD documents. Upon choosing this item, the standard folder selection dialog box will be 

opened; 

 Open Library Window – adding the command for opening the T-FLEX CAD library. Upon 

choosing this option, the dialog box for assigning the library name will appear. 

 

For each command being added it is possible to assign a name, a brief tooltip and an icon. To do this, it 

is necessary to choose a desired command in the list and put the required information into the fields 

“Command Name”, “Prompt”, “Button Image”. 

To remove an unnecessary command, one can select it in the list and press the button [Remove]. 

For the command selected in the list, the button [Properties…] calls for the same dialog box as the one 

used upon addition of the given command. Thus, one can change parameters of the command (for 

example, indicate another file for opening or another macro). 

The button [Run] calls for the command selected at the moment in the list of the commands.  

Upon defining user's commands one should keep in mind that the commands defined in the 

dialog box “User Commands”, by default, are not added to the textual menu or toolbars of the 

system. Access to these commands is possible only with the help of the button [Run] of the given 

dialog box. To simplify an access to the user's commands, it is possible to add them to the textual 

menu or toolbars of the system with the help of the command SB: Show Toolbars (tab 

“Commands”). 
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The list of the user's commands can be saved in the external file “*.tfcmd” with the help of the button 

[Export…]. The list of the user's commands can be read from the external file with the help of the button 

[Import…]. 

MAIN WINDOW DESIGN ST YLES 

T-FLEX CAD has a capability to modify the 

design style of the main window of the 

system. In the context menu of the main 

window (textual interface) and in drop-

down menu the “Theme” submenu is 

available which allows us to select the 

desired style of design. 
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CUSTOMIZING DRAWING 

Each T-FLEX CAD drawing has its own settings. These settings include a variety of definitions of both 

general nature and specific to particular elements. Examples of the former include setting drawing 

boundaries and scale, while the latter – dimension standards, line thickness, etc. These settings can be 

defined not only at the beginning, but also at any moment while working on a drawing. All settings are 

saved with the drawing. IN the case of multi-page document, settings can be defined separately for each 

page. When creating a new page, its settings are copied from the currently active page. 

One can create a prototype drawing with its specific settings. To do so, use the command File > Save as 

Prototype… The prototype file will be saved in the folder …“…\AppData\Local\Top Systems\T-FLEX CAD 

3D 15 x64\Eng\Templates” (see "Getting Started"). To create a new drawing with the settings as in a 

prototype, use the command File > New From Prototype. The desired prototype file can be selected 

from the list. (multiple prototype files can be created.) 

Any T-FLEX CAD document can be used as a prototype. Initially, the system is shipped with several 

prototype drawings “*.GRB”. These are located in the system folder (…\Program\Template). Their settings 

comply with several drawing standards. Depending on the choice of the particular drawing standard, new 

drawings created via File > New will assume all settings from the respective prototype. The name of the 

prototype drawing can be redefined using the command SO: Set System Options, on the Files tab. 

CUSTOMIZING D RAWING.  D IALOG OF “  DOCUME NT PARAMETE RS”  

COMMAND  

 

The following command is used for defining drawing parameters, ST: Set Document Parameters. 

Icon Ribbon 

 

Edit → Document → Document Parameters 

 

Keyboard Textual Menu 

<ST> Customize > Document Parameters 

 

The command brings up a dialog box with tabs holding various groups of parameters.  

When you select a parameter its tip appears in the bottom part of the screen. Such tips are 

available for the most of the parameters. 

In the Document Parameters window it is possible to adjust the parameters relating to a whole 

document or to its pages. For these purposes bookmarks Page and Document are used. 
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A page can be chosen in the drop-down list in the top of the window. It is possible to set displayed 

pages type for the drop-down list using Filter list: 

 

By means of the [Copy to…] button it is possible to transfer parameters of one page to another. It is 

possible to copy all page parameters at once or parameters from chosen bookmarks. 
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You can select several pages at once to copy. 

“DOCUMENT”  GROUP  

“3D” Tab 

This tab collects general parameters related to 3D modeling: 

  

Units section. Defines measurement units of the elements and operations on the 3D scene. 

Mass. Defines mass units for solid objects of 3D scene. 

Length. Defines length units for 3D objects. 

Force. Defines force units for 3D objects. Used in Measure command and loads definition in Analysis 

studies. 
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Scale Value. Parameter is used when the value of Length parameter is set to “User”. In this case, any 

arbitrary number of units per meter can be defined. 3D object will take into account this value for 

Length units. 

 

The Workplanes group defines the mode of displaying the workplane names and types. These 

parameters are displayed in the upper-left corner of the respective workplanes. 

3D Triad Orientation. Defines orientation 3D model views in the world coordinate system.  

The value “XY-Top” corresponds to the choice when axes direction of the “Top view” coincides with 

the directions of X and Y axes of the world coordinate system.  

The “ISO” setting defines the ISO standard orientation. 

Selected orientation is used when creating projections and in the commands of 3D window viewpoint 

definition («Front View», «Left View», «Right View», «Axonometric View», etc.). 

Display Options. Allows you to display/hide workplane types and names in 3D scene: 

Don’t display. Workplane name and type are not displayed. 

Draw Name. Sets the mode of displaying the workplane name according to the workplane type. Note 

that changing the workplane type does not affect the name. The name can be changed manually 

under the workplane parameters. 

Draw Type. Sets the mode of displaying the workplane type (Front, Left, etc.). 

Draw name and type. Both workplane name and type are displayed. 

Workplane font. Defines font size for workplane names. 

Mesh Quality: 

Image Quality. This parameter allows us to specify the degree of refinement of the model mesh 

consisting of planar triangular faces upon displaying the image in the 3D window. Higher quality of 

the image of the model increases the number of planar faces which slows down the work for large 

models or for insufficiently powerful video cards. If possible, it is recommended to minimize the 

quality of the image of the model. 

 

How many triangles are used for discretization of a specific model given a specific value of the 

mesh quality parameter can be determined with the help of the “Display Statistics Information” 
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option in the “Graphics Settings” dialog. This dialog is invoked by pressing the “Graphics 

Settings…” button on the “3D” tab of the Customize > Options command. 

Edge Tolerance – the maximum distance between the curves of the model and edges of the mesh 

which approximate these curves; 

Face Tolerance – the maximum distance between the surfaces of the model and planar faces of the 

mesh which approximate these surfaces; 

Angle Tolerance – the maximum angle, specified in degrees, between the curves of the model and the 

edges of the mesh which approximate these curves. The angle is equal to the sum of angles between 

the edges of the mesh and the tangents to the original curve at the end points of the edges. This 

parameter also defines the maximally admissible angle between the surfaces of the model and the 

planar faces of the mesh which approximate these surfaces (i.e., the angle between the normals to 

the surface or face). 

3D: 

Main View Coordinate System. This parameter defines the orientation of 3D model views, i.e., location 

of views (“Front view”, “Top view” etc.) in the world coordinate system. Its orientation is used when 

creating projections, as well as in the commands of 3D window view direction («Front View», «Left 

View», «Right View», «Axonometric View», etc.). This option can be helpful when working with 

imported geometry, parts created in context of assembly or other analogous cases, when model is 

oriented discordantly to main directions. 

 

Local coordinate system selected as the main view coordinate system cannot be deleted. 

Edit parameters after creation if file is used as template. The given parameter is also used only for the 

document which will become a prototype. Moreover, the document-prototype must have a set of 

external variables. Then, if the flag is enabled, upon creation of a new document on the basis of this 

prototype will immediately appear the window of the editor of external variables of the document 

being created. 

 

Fixed set of windows. When the given parameter is set up, the current set of views (i.e., 2D and 3D 

windows) is getting fixed in the document. Upon subsequent openings of the document, 

modification of this set of views will not be possible. It will not be possible to delete one of the 

windows by reducing its size to zero (when moving the window's separator), or add a new view (the 

button of creation of a new view will not be available). This functionality is convenient for creation of 

templates with a set of views defined in advance. 
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The “Selection of Transparent Faces” group of parameters allows us to control selection of transparent 

faces in the 3D scene: 

Transparency limit. This parameter can take values ranging from 0 to 1. It is possible to specify the 

transparency limit with the help of a variable. If transparency of some face of a body is higher than 

the indicated transparency limit, this face will be ignored when it is selected in the 3D scene. 

Recall that transparency 0 corresponds to the absolutely opaque body (face), 1 – absolutely 

transparent. Transparency which is larger than 1 is impossible, therefore the value of the limit equal 

to 1 (default value) corresponds to the standard behavior of the system. 

Select by Edges. If this flag is enabled, those faces whose transparency is larger than the specified limit 

can be selected by their edges (as in the wireframe mode). When the flag is disabled, such faces 

cannot be selected. 

 

“Mates” group of parameters define performance of mates solver only for regenerating a 3D model. 

Time (0-1). Defines the time limit of mates solver calculations. The limit is set as factor between 0 and 1 

corresponding to “less” and “more” respectively. 

Calculation method. Sets one of two available methods of calculation – precise or fast. 

More information about calculation methods can be found in “3D Assemblies - Mates” chapter. 

Precision. Specifies precision of mates calculations when regenerating a model. The parameter value 

can be specified from 0.000001 (10-6) to +∞. The precision value specifies the minimum value of 

mates deviation. If mates deviation exceeds the specified value, all mates will be recalculated. If there 

are no mates, which deviation exceeds the specified value, the recalculation will not be performed. 

This reduces model recalculation time. 
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“Annotations” Tab 
Font, Dimensions, Alternative dimensions, Symbols and Leader notes and text tabs are described in the 

“Page Group” section. The group sets parameters for elements in 3D scene. 
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“View” Tab 

 

Selection: 

Element selection. Defines element selection modes while in drawing and editing commands. Select 

one of the two modes: 

All. When creating and editing elements, all existing elements will be allowed for selection. 

Visible only. When creating and editing elements, only the visible elements will be allowed for 

selection. The element  visibility  is determined   based  on element levels and visibility intervals 

defined in the command SH: Set Levels (Customize > Levels…), as well as layer configurations 

defined in the command QL: Configure Layers (Customize > Layers…). 

View: 

Environment texture. File of the image containing the picture of the texture. This parameter allows us 

to virtually surround the objects of the model by a 3D image which will be displayed on the faces of 

the model. To specify this texture the format hdr is used. 

Surrounding can be also specified in the properties of a 3D view or with the help of moving the 

texture file from the Windows Guide to a 3D window. 

In all windows of a 3D model the same texture of the surrounding is used. In one specific window the 

use of the texture can be blocked by the corresponding flag in the properties dialog. 

Parameters of the material such as "Gloss" and "Reflection" strongly affect visual properties of the 

material when using the texture of surroundings. 

In case when these parameters have zero values, the surrounding texture will not affect the 

appearance of the model. 

Background texture. File of the image containing the picture of the texture. Reference to this file can 

be specified in the Document Paramers dialog on the 3D > View tab, in the 3D window properties 
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dialog or by the method of moving the file of the raster image from the Windows Guide to the 3D 

window. This parameter allows us to use the texture as a background of the current drawing’s 

window.  

The same background texture is used for all windows of 3D model. In one specific window the use of 

the texture can be disabled; to do so there is a corresponding parameter (flag) in the properties of a 

3D view. To specify the texture the files of the formats bmp, jpg, jpeg, gif, tga, tif, tiff, png can be 

used. 

The Size group includes definitions of 3D node size (in pixels), and the sizes of coordinate systems and 

arrows (in respective measurement units). 3D element sizes can be arbitrarily defined at user preference. 

Color: 

One color. Sets the display mode of using one color for all 3D elements. This color overrides element 

own settings. 

Color. Defines the color for all 3D elements when one color mode is set. The color can be selected from 

the menu of colors. 

 “2D Fragment” Tab 

On 2D Fragment tab you can define the fragment attributes on inserting the document as a fragment. 
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Priority. Setting this attribute allows to define a priority value to be assigned to the fragment on 

inserting into an assembly drawing. 

Disable Edit In Place. When set, editing this document in the assembly context is prohibited. 

Enable Draggers on Edit. If set, the draggers will be enabled for this assembled 2D fragment in the 

fragment editing mode. The draggers allow modifying the external variables of the fragment by using 

the mouse. 

Don’t show Variables List on Edit. This option hides “Preview” and “Variables List” flags in the fragment 

parameters dialog box on editing. The option works only for the custom dialog boxes of fragment 

variables. 

Use Parameters of. This parameter allows specifying what settings of the drawing will be used upon 

inserting the given document into the assembly as a fragment: 

Default. The default settings specified in the assembly for the parameters of the 2D fragment will be 

used; 

Fragment Document. The settings of the current document will be used; 

Current Document. The settings of the assembly drawing will be used. 

Default Fixing Vector. This parameter sets the main fixing vector used upon insertion of the given 

document as a 2D fragment. This parameter duplicates the corresponding flag in the properties of 

the fixing vector. 

Insert on layer. This parameter specifies the name of the layer on which a 2D fragment will be placed 

when the given document is inserted into the assembly. 

Create dimensions in assembly. Option is used to insert dimensions existing in 2D fragment into an 

assembly. When 2D fragment with dimensions is inserted into the assembly drawing, the dimensions 

are transformed to separate elements as if they were created right in the assembly drawing. There are 

three options: 

No. Dimensions that already exist in fragment file will be included into assembly. Such dimensions 

can’t be edited because they are part of the fragment. 

Automatically. Dimensions will be automatically created after the fragment insertion. When 2D 

fragment with dimensions is inserted into the assembly drawing, the dimensions are transformed to 

separate elements as if they were created right in the assembly drawing. These dimensions will not 

be inserted from the fragment file; they will be created directly in the assembly document. The 

dimensions will be created according to the dimensions from the fragment file, i.e. their locations 

and attachments will be inherited from the fragment. You can edit the dimensions. The dimensions 

will be correctly displayed if you rotate fragment using fixing vector.  

The dimensions will be created only if they are based on graphic lines. Dimensions based on 

construction lines or nodes will not be created.  

If the dimension is considered to be driving in the fragment file, i.e. it’s nominal size is set by an 

external variable, you can change the variable value in the assembly. The fragment and its 

dimensions will be recalculated according to the new value. 
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Manually. After fragment insertion, its dimensions won’t be created in the assembly. To add 

dimensions into the assembly you need to use Create dimensions in assembly command in the 

fragment context menu. 

 

The dimensions will be created in the same way as for Automatically.  

Explode fragment. Allows to explode 2D fragment when it is inserted into an assembly. The fragment is 

deleted after explosion and all its visible elements copies will be created in the assembly. 

No. The fragment won’t be exploded after insertion. 

Without construction. Only copies of all visible graphic elements from source document will be 

created. 

With construction. Copies of all visible graphic and construction elements from source document 

will be created. 

Group. All fragment elements will be automatically grouped after fragment explosion. 

The option is used only for exploded elements. 

Never include in BOM –fragment data is not included into product structure and corresponding BOM 

table when the flag is set. 

“3D Fragment” Tab 

3D fragment tab in ST: Set Model Parameters command provides possibility to specify default LCS used 

for fragment fixing, specify type of insertion, set parameters for automatic Boolean operation. 

 



Customizing Drawing 

239 

Automatically create Boolean Operation 

When inserting a 3D fragment, one can automatically create a Boolean operation of a specified type. The 

target body will be the selected body in the assembly, while the tool body - one of the bodies of the 3D 

fragment, or all fragment bodies at once. 

Setting up automatic creation of Boolean operation is performed with the help of several parameters: 

Operation Type. This parameter defines the type of the Boolean operation (addition, subtraction, 

intersection) that will be created upon inserting the fragment in the assembly. The type can be 

selected from the list. 

Create operation with: 

When 3D fragment is inserting, Boolean operation of specified type can be applied automatically. 

Selected body in 3D assembly will be used as a first Boolean operand, as a second operand – one or 

all bodies of 3D fragment. 

Use the whole Model. With this option checked, the whole 3D model of the fragment will be used 

as the target body of the Boolean operation. 

Use single operation. Selecting this option makes the Boolean use just a single operation within the 

fragment. The desired operation can be selected from the list of all existing operations. 

In the case when a body is used in the Boolean, that is not visible when working with the 

document of the 3D fragment, it is possible to place it in a special layer marked as Visible only 

when model is used as a Fragment. 

Let’s review an example of automatic creation of a Boolean operation on inserting a fragment. 

Suppose, there is a 3D model of a building wall, and we need to insert a window in it as a fragment. 

To do so, let’s create the window model in a special way. Create a tool block as a dummy for cutting 

the opening in the wall for inserting the window. Then call the Insertion of 3D Model as Fragment” 

dialog box (see above). Set the operation type – Subtraction, Use single operation. From the list of 

operations select the one that created the tool block. 

         

3D Fragment: 

Fragment name. This parameter defines the name with which the fragment will be displayed in the 

assembly’s model tree. 

Folder Name. This parameter specifies the name of the folder into which the fragment will be placed in 

the assembly’s model tree. 
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Fragment’s name and folder’s name are read from the fragment’s file only upon creation of the 

new fragment. If the values of these parameters are changed, then upon update of the fragment 

in the assembly the name and the folder will remain the same. 

Copy fragment file to assembly folder. If this parameter is turned on, the file of a fragment that is 

inserted into the assembly is automatically copied into the folder of the assembly document (or its 

subfolder). A link to the file that has been copied and not to the original one is written in the 

properties of the fragment. 

You can specify a name for the subfolder to the right of the flag. The subfolder will be created inside 

the folder of the assembly document into which the file of the fragment will be copied. If this field is 

empty, the file is copied directly into the folder of assembly. 

Default LCS used for Fragment fixing is selected from the list. The list contains all local coordinate 

systems of the model that have the flag Use for Fragment insertion set. When inserting such 

document as a 3D fragment, the thus defined coordinate system will be automatically offered as the 

source LCS. 

If necessary, the permitted degrees of freedom can be set in the properties of the prepared 

coordinate system, which will insure the correct behavior of the given 3D fragment in an assembly in 

the mode of moving mated elements (see the chapter “Mates and degrees of freedom”). 

For uncomplicated parts, which can be conveniently inserted into the assembly in the mode of 

dynamic snapping, the given mode can be turned by default. 

Insert 3D fragment on layer. This parameter defines the name of the layer onto which the fragment 

will be placed upon its insertion into the assembly. If in the fragment’s document the Insert on layer 

parameter is enabled, but upon insertion of the fragment into the assembly this layer does not yet 

exist, then this layer is created automatically upon request. 

Don’t show the message Fragment doesn’t have bodies. By default this parameter is disabled. In this 

case the system does not allow for insertion, into the 3D assembly, of the fragment in which the 3D 

model is absent or suppressed. The corresponding message in the diagnostics window appears as 

comments.  When this flag is enabled the system allows for insertion of “empty” fragment without 

issuing any messages. 

Set Autosave Parameter. If the given parameter is set up, then upon insertion of the current document 

as a 3D fragment into the assembly, the “Auto Save” parameter is automatically enabled in the 

parameters of the fragment. The file of such a fragment will automatically be saved upon each saving 

of the assembly, with the substitution of the values of external variables and adaptive parameters. 

Type of Insertion (for application). The chosen way defines behavior of a 3D fragment at an insert into 

3D assembly. 
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 Standard. Upon insertion into the assembly the translation of the fragment is possible only with 

the help of the manipulator of LCS  (dynamic translation is disabled); 

 Fastener. When inserted into the assembly the fragment dynamically moves after the cursor of 

the mouse; 

 3D arrangement. This method of insertion is used for quick creation of the arrangement in 3D 

scene. In the fragment’s file special attachments to the floor, walls, ceiling, horizontal surfaces must 

be created. These attachments are defined by means of connectors with the specific parameters; 

 By points. A fragment can be fixed to the selected in the 3D scene points upon insertion. Its size 

changes according to the distance between the points. 

 Smart fragment (macro). This method of insertion is used for parametric fragments whose 

insertion scenario is described in the program (macro) stored directly in the file of the given 

fragment or in the external module (DLL). When inserting the file as a fragment the user-specified 

macro will be executed. 
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“Sections” Tab 
You can define options for section views on 2D projections on the Sections tab. 

 

For some models (future components of assemblies) it can be helpful to define special settings for 

preventing their cutting when used in section views of 2D projections. For example it is known that bolts 

should not be cut on section views of assembly drawings. This option will help to avoid time consuming 

manual customization of 2D projection parameters for assemblies that contain such parts. 

New condition can be created with the help of  button. Section Application Condition section will 

appear with the lists of conditions and LCS names.  

 

Conditions are organized in relation to the alleged source fragment LCS that exists in a document of a 

future 3D fragment. For example a part may remain uncut if a section plane goes through a specified axis 

of the source LCS, or coincides with one of the main LCS planes. 
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 “Large Assembly Management” Tab 

“Large Assembly Management” tab serves to define parameters that optimize the use of computational 

resources and RAM when working with a large assembly model. You can set the following resource-

saving modes: 

 

Unload Body Geometry Automatically. When this parameter is set, the model enters the Large 

Assembly Mode. In this mode, some information about the assembly model geometry is dumped on 

the hard drive. This information will be loaded as it becomes necessary. A detailed information about 

the large assembly mode is provided in the chapter “3D Assemblies Creation” of the T-FLEX CAD 3D 

modeling user manual. 

Don't show Parts Smaller than. If this parameter is set, then 3D objects with the size less than the 

specified (in model units) will not be displayed in the 3D model. 

“Performance” Tab 

Save calculation results of intermediate operations. Enabling of this option speeds up entrance to 

editing commands of the intermediate operations, but it slows down the total time of recalculation 

and allocates more RAM. 
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Saving step. System will store intermediate calculation results not for all operations, but for particular 

operations with the specified step, e.g. for each 5-th operation. 

 

Maximum number of saved results - maximum number if intermediate operations for which the 

geometry will be saved. 

 

Save results to model file. Store geometrical data of intermediate operations in file, if these operations 

have such data at the time of document saving. This parameter may speed up entrance to editing 

commands of intermediate operations after document opening, but will increase file size and 

opening time. 

 “External Variables” Tab 

 

 

External variable editor. This parameter defines the means of editing external variables in the 

command M: Model Parameters. 

If Internal Editor is set, the model variables are edited using the “Variables Editor” built in the 

T-FLEX CAD system. 

If External Program is set, you can define a means of editing model of your own. This implies 

the user writing a custom application for editing external variables. An example of such 
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application is the format creation functionality that provides a dialog box for filling in the format 

template. You can use Open API for this purpose. 

More information about OPEN API can be found in API help. 

Control. This option is used if a custom dialog is created in the document, containing parameters 

to edit external variables. The document pages to be displayed in the dialog window must be 

checked in the list of pages. 

If there are “Dialog”-type pages in the document that were created within the command 

TR: Create Control, then this parameter setting is applied automatically, and the respective page 

is marked in the list. 

 

Regenerate 3D Model. When this flag is enabled, the 3D model of the document is automatically 

regenerated upon editing of external variables. 

A detailed description of creating a custom dialog and its handling techniques are provided in the 

chapter “Control Elements. Creating User Defined Dialog Boxes”.  

Naming rules Tab 

On this tab you can set names and numbering for the following pages: Normal, Workplane, Dialog, 

Auxiliary and Bill of materials. 
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The following numbering can be set: 

Sequential numbering within page type. Pages are numbered according to their types. 

 

 

Consecutive numbering of all pages. Pages are numbered regardless to their types. 

 

 

 “Save” Tab 

This tab defines automatic creation of a preview and an icon for the current drawing. The preview and 

the icon can both be created using this tab. 

 

The Icon group defines parameters for creating the icons of the document. The document icons will 

appear in all places where the display of the document icon is foreseen (on the tab of the document 

upon its opening in the T-FLEX CAD, in the model menu, etc.). 

Save. Defines mode of document icon creation. This parameter can assume the following values: 

None. The icon is not saved. In this case, an earlier saved icon will remain with the file (if any). 

To check existence of a icon in the file, see document properties on the “Preview” tab. 
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Auto – 2D. An icon with the 2D image is saved automatically on each document save. 

Auto – 3D. This icon with the image of the 3D model will be saved automatically each time the 

document is saved. 

Manually. In this mode, the icon can be created manually using the command PV: Save Preview 

(Tools > Special Data > Preview). Unless using the latter command, this setting is equivalent to 

“None”. 

Size. Defines the size of the icon. The size can be selected from the list, as follows: Maximize Image, By 

paper. 

 

The Image group defines the parameters of the drawing preview image for its quick display in the 

document preview pane of the File > Open… command dialog box. 

Save. This parameter defines the preview saving mode. The parameter can assume the following values: 

none, auto, manually. 

None. Preview is not saved. In this case, an earlier saved preview image will remain with the file (if 

any). 

To check existence of a preview image in the file, see document properties on the “Preview” tab. 

Auto. Preview is saved automatically on each document save. 

Manually. In this mode, the preview image can be created manually using the command PV: Save 

Preview (Tools > Special Data > Preview). Unless using the latter command, this setting is equivalent 

to “None”. 

Size. Defines the size of the preview image. The size can be selected from the list as follows: 

Maximize Image. With this value, the created preview is restricted to the actual drawing image limits. 

By paper. With this value, the created preview covers the whole page according to the paper size 

defined on the “General” tab of the same dialog box. 

Format. Defines the preview file format. A format can be selected from the list: T-FLEX CAD Metafile 

(BMF), Windows Bitmap (BMP) – 2D, Windows Bitmap (BMP) – 3D. 

Width and Height. These parameters define the sizes, in pixels, of the bitmap image. 

 Save: 

The Model configuration regeneration on save defines the system behavior on saving a document 

with configurations. The following modes are possible when document saved: 

- Ask about regeneration – if the document contains outdated configurations, then the user 

will be asked at the time of saving the document, whether or not to regenerate 

configurations. 

- Regenerate all model configurations – on saving the document, all configurations will be 

regenerated and saved automatically. 

- Don’t regenerate model configurations.  
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Save 3D Picture data in model file. Sets the mode of saving the 3D image in the document file. This 

saves the regeneration time on opening the file while taking more disk space for the file. Besides, a 

file with the saved 3D image can be used as a 3D picture (see the command Operation > 3D Picture).  

Save active window settings in model file. This parameter allows retaining and saving the current set 

and position of drawing windows in a document file. For example, if you divided the window into two 

panes, one of which contains the 3D model, then after loading the file, the sizes and locations will be 

restored. 

Save new file after creation if used as a template. This flag is useful if the current document is 

intended to be used as a prototype. If this flag is enabled, upon creation of a new document on the 

basis of this prototype the window of saving the file will immediately appear. When saving is rejected, 

the new document won’t be created. 

“PAGE”  GROUP  

“Paper” Tab 

This tab defines main drawing parameters. The preview of the document layout with the specified 

parameters is available in the preview pane. 

Paper size. This group of parameters defines the drawing boundaries. 

Format. Provides selection from the list of main formats defined by common standards, such as ISO, 

ANSI, etc. If a standard format is selected then the Width and Height parameters are set 

automatically. If the Custom format is selected, then the sizes can be defined manually.  

Width. Defines the paper format width. The value is set automatically when the format is selected from 

the list. If format is “Custom” the size can be defined manually. 

Height. Defines the paper format height. The value is set automatically when the format is selected 

from the list. If format is “Custom” the size can be defined manually. 
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Paper group 

Orientation. This parameter defines the orientation of the drawing format. The orientation can be 

Portrait or Landscape.  

Scale. Defines the drawing scale. An arbitrary value of the scale can be defined, or otherwise be 

selected from the list. It is recommended to use scale only when actually necessary. In most cases, 

scaling is not necessary for the following reasons: 

1. When outputting to a plotter or printer, the drawing size is not a concern. 

2. Special tools are provided for scaling dimension notations of the whole drawing or a portion 

thereof, as described below. 

If it is still necessary to set a scale, it is better be done before starting creating the drawing. 

Changing the scale setting on an existing drawing may require manual editing of some of its 

elements. This is because scaling does not merely a proportional modification of all drawing 

element sizes.  The scale in T-FLEX defines only the drawing lines locations, while, for instance, the 

size of dimension arrows and text will stay unchanged.  
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Units. Defines the measurement units used by T-FLEX CAD. This parameter is selected from the list. 

 

This parameter affects several issues, such as the following: 

- Calculating dimension tolerances that is done differently in metric and inches systems; 

- The menu settings when defining roughness parameters and GD&T symbols for surfaces; 

- Output to a plotter; 

- Exporting different formats; 

- The way of converting dimension values, if a conversion system is assigned on the 

Dimensions tab in groups Scale or Alternative scale to the Scale parameter. 

Origin. The following parameters define the location of the origin of the drawing coordinate system. 

X. Defines the X coordinate of the drawing lower-left corner.  

Y. Defines the Y coordinate of the drawing lower-left corner. 

The coordinate values are defined in the same units as used for creating the drawing. These are 

defined under the Units item. 

When defining document parameters, one can use variables that will be stored in the drawing file. 

To do so, enter a variable name instead of a particular parameter value, whether numerical or 

string. The variable name must be entered in {braces}. If it is a string variable, its name must begin 

with “$” character. Pressing <F8> while in the intended input box allows selecting the variable 

from the list of already created ones. The variable values can be modified using the variable editor. 

“Zones” Tab 
The Zones tab is used for defining parameters of dividing a drawing page into zones. For standard 

formats, the default zone parameters are preset and can be accessed via the ST: Set Document 

Parameters command on the Paper > Zones tab. In the dialog box brought up by the command one can 

redefine these parameters for the current drawing. 

Detect Zones for Bills of Materials. The set attribute commands relation between assembly zones and 

the “Zone” column of the standard BOM. 

Color. Defines the color of the zone border lines. 

Show first symbol. Specifies, which of the zone-defining symbols, (the one of the X or Y axis), will come 

first in its marking. 
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Visibility. Defines zones visibility on the drawing. This parameter has three values: 

Yes or No – defines zone visibility on the drawing. 

Visible when zones for bill of materials are turned on – provides zone visibility only when the 

parameter Detect Zones for Bills of Materials is set. Otherwise, the zones are not displayed on the 

drawing. 

Number, X and Y. The number of zone columns and rows respectively. 

Direction. Defines the itemization direction for zones: left to right or right to left, top down or bottom 

up. 

First char, X and Y. Define the characters to begin with when itemizing the zone columns and rows 

respectively. 

To keep in mind: the Document parameters command settings affect only one page. Therefore, 

for drawings spanning over multiple pages, the division into zones should be defined separately, 

taking into account the through notation of zones along the horizontal (X axis).  
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Offset. Defines the X and Y offsets of the area being divided into zones with respect to the point (0,0). 

Step. Defines the X and Y dimensions of one zone. 

“Font” Tab 

 

This tab defines font parameters for all standard detailing elements unless already defined within the 

detailing elements themselves. These detailing elements are text, dimensions, roughnesses, leader notes 

and tolerances. 

Name. Defines name and type of the default font that will be used on text objects creation. T-FLEX CAD 

supports two types of fonts: TrueType fonts ( ), that are standard for Windows, and vector fonts in 

SHX ( ) format. The TrueType and SHX fonts are distinguished in the font menu by the respective 

icons before the names. 

Size. Defines the vertical size of the font by capital letters, as, for instance, the height of the character 

“A”. Any font size is allowed, except 0. 

Line Spacing. This is the distance between two neighboring lines of a multi-line text. Line interval is set 

in relative units. To calculate the absolute value of the line interval, multiply this parameter by the 

font height. 

Character Spacing. Defines the additional distance between two neighboring characters in a string. 

This parameter value is also relative. To calculate the absolute value of the additional interval, 

multiply this parameter by the font height. 

Stretch. Defines the scale factor for the width of the font symbol. It is possible to specify any value for 

this factor except 0. 
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Style (TrueType). Defines the font style. This is a standard parameter of fonts and assumes the values 

supported by Windows, namely normal, semi-bold, italic, semi-bold italic. 

Index scale. Defines the scale factor for calculating the size of the subscript and superscript fonts from 

the normal font size. Subscripts and superscripts are used, for example, for dimension tolerances and 

other indexes. 

Oblique Angle (SHX). Defines the font tilt angle. Any angle value is allowed, except 0, 180, 360, etc. The 

normal (upright) font has the tilt angle value of 90 degrees. 

Line Width. This parameter defines thickness of character contour lines for the SHX fonts.  

Fill. If set, then the characters are filled with color when 

applicable. Otherwise, they are drawn by contours only.   

The Oblique Angle, Line width and Fill parameters affect only vector fonts of the SHX format.  

The settings on this tab affect the size of all detailing elements of the drawing (dimensions, text, 

roughnesses, GD&T symbols, leader notes), whose Font tab settings are displayed in the square brackets, 

that is taken from the document parameters. The elements will not be modified whose Font tab settings 

are explicitly defined.  

“Dimensions” Tab 
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Linear Dimensions. This group contains the following parameters: 

Units. Defines the linear dimension value representation. This is mostly relevant to dimension values in 

inches. 

 

 

 

Accuracy. Defines rounding accuracy of the linear dimension values. For example, the accuracy "0.01" 

means the dimension values will be rounded to the second decimal digit. The "0" accuracy means the 

dimension values will not be rounded. 

Minimum digits. Sometimes, a certain number of decimal digits are required to be displayed on a 

dimension, including trailing zeros. This can be insured with the “Minimum digits” setting. For 

example, setting the value “3”, then the dimension value 28.5 will be shown on the drawing as 28.500. 

Scale: 

Scale factor. Reflects the scale factor of dimension value conversion per the dimension scale 

parameter. All dimension values will be multiplied by this scale factor. If Dimension scale is Custom, 

one can enter your own scale factor for converting dimension values of linear dimensions. 

Scale. Defines the way of converting dimension values of the linear dimensions. The following 

conversion systems can be selected from the list:  

No. No dimension conversion is done. 

Inch/Metric. In this case, conversion of the dimension values will be done per the parameter Units 

on the General tab. If the inches system is set, then the linear dimension values will be converted to 

millimeters, that is, multiplied by the scale factor of 25.4. If the metric system is set, then the 

dimension values will be converted into inches, that is, multiplied by the scale factor of 1/25.4. 

Thus, one can work with a drawing in metric system while applying dimensions with values in 

inches, and viсe versa.  

Custom. With this setting, an arbitrary dimension value conversion factor can be specified. 

Apply scale to projections. This parameter is used in the 3D version of the system only. It has an effect 

on dimension creation within 2D projections in the case when a dimension scale is defined in the 

command ST: Document Parameters for the 2D page that contains the projection. When the flag is 

set, then the specified scale is applied to the dimensions on a 2D projection with a scale; if the flag is 

cleared, the scale is ignored. 



Customizing Drawing 

255 

Dimensions:  

Standard. Defines the appearance of dimensions on a drawing. A dimension standard can be selected 

from the list. Three standards are provided in the list – ANSI, BS-308 and DIN/ISO. 

BS-308 stands for ANSI standard for architects or British standard. Upon changing the dimension 

standard, the dimensions automatically redraw to comply with the new standard. 

 

Alignment spacing. Specifies spacing when aligning dimensions with offset. 

Tolerance grade. Defines the tolerance grade for dimensions on a drawing. If the accuracy parameter 

of the dimension is set equal to this parameter then the tolerance string and limits will not be 

displayed as part of the dimension. 

 

Angular Dimensions. This group contains the following parameters: 

Units. Defines the angular dimension value representation. 

 

Minimum digits. Defines a certain number of decimal digits, which are required to be displayed on a 

dimension, including trailing zeros. 

Accuracy. Defines rounding accuracy of the angular dimension values. Accuracy “0” means that 

dimension values will not be rounded. Value “0.5” = 30 minutes, «1/60» = 1 minute, «1/360» = 1 

second. 

Spacing in tolerance text. When this option is enabled, tolerances of dimensions are separated with 

spaces for easy reading. 

Alternative scale.  

Scale. Defines the way of converting dimension values of the alternative dimensions. The following 

conversion systems can be selected from the list: 

No. No alternative dimension conversion is done. 

Inch/Metric. In this case, conversion of the dimension values will be done per the parameter Units 

on the General tab. If the inches system is set, then the alternative dimension values will be 
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converted to millimeters, that is, multiplied by the scale factor of 25.4. If the metric system is set, 

then the alternative dimension values will be converted into inches, that is, multiplied by the scale 

factor of 1/25.4. This allows setting both metric and inches value using dual dimensions. 

Custom. With this setting, an arbitrary scale factor can be specified for converting an alternative 

dimension value.  

Scale factor. Reflects the scale factor for converting alternative dimension values per the alternative 

scale parameter.  

 “Alternative Dimensions” Tab 

 

Parameters defined on this tab will only affect those alternative dimensions whose parameters are 

marked Set as default. 

The group of parameters Dual Dimensions defines the presence and location of alternative dimensions 

on the drawing. 

Add Alternative Dimension. This attribute sets the presence of alternative dimensions on the drawing. 

If alternative dimensions are not required, clear the check in the attribute field. 

Location. Defines the location of alternative dimensions on the drawing with respect to the primary 

dimension value. 

According to the selection choice, the alternative dimension value may be displayed After, Before, 

Under or Above the primary dimension value on the drawing. 
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Linear Dimensions. This group includes: 

Accuracy. Defines rounding accuracy of the alternative linear dimension values. 

Units. Defines the alternative linear dimension value representation. 

Minimum digits. Defines the minimum number of decimal digits. 

Separator: 

Separator. Parameters of the given group define separating characters that separate the value of the 

alternative dimension from the primary one. In the drop-down list the following variants are available: 

 

None. The alternative dimension value will be displayed without separators. 

[]. The alternative dimension value will be displayed in brackets. 

{}. The alternative dimension value will be displayed in braces. 

 ( ). The value of the alternative dimension will be shown in circular brackets. 

User. . The value of the alternative dimension will be displayed with the help of arbitrary separators 

that are specified by the user in the identically-named input fields of the given group. 

 

 

Before. If “Separator” is "User", it is possible to enter any character as separator, for example, ‘*’. 
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After. If “Separator” is "User", it is possible to enter any symbol as separator, for example, ‘*’. 

Text  group: 

Before and After. Defines the text strings to precede and follow the value string of an alternative 

dimension. The strings can be entered explicitly or substituted by numerical or string variables.  

The variables for the strings must be entered by their names in braces. For example, suppose, a 

variable “A” is introduced in the drawing, and we want its value to be displayed as part of an 

alternative dimension value string. Enter the variable name in braces, {A}, as one of the strings, 

“Before” or “After”. If this is a string variable with the value being a character string, then the first 

character in its name must be the dollar sign, for example, {$Text}. 

 “Lines” Tab 

Lines: 

Thick lines. Defines the thickness of the main solid graphic line (CONTINUOUS). 

 

Other lines. Defines the thickness of all the rest of graphic lines and detailing elements (the lines of 

tolerances, roughnesses, leader notes and dimensions). 

Construction drawn last. If set, the construction elements will be drawn last upon redraws (see the 

diagram on the left). Otherwise, they are drawn first (right) and may be hidden by other system 

elements (fills, graphic lines, etc.). 
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Remove hidden lines. If set, the hidden lines will be removed from display. These are the lines behind 

the fragments with hidden line removal contours. The lines will be removed according to the 

fragment priorities. 

 

Line style: 

Scale factor for dashed lines. Defines the scale factor for dashed lines with respect to the dash size 

described in the file of line types (TCAD.LIN). Does not affect the display of solid lines. The file format 

is the same as the format of the AutoCAD line description file. 

Arrow (end) size. Defines the size of arrows (ends, tips)of the dimension leader and witness lines and 

graphic lines. Any desired size can be set by the user.  

 

Line thickness representation. This parameter defines the graphic line appearance on the screen. The 

parameter can be selected from the list: 

Not more than three pixels. All graphic lines will be displayed no more than three pixels thick. This 

parameter is relevant to the lines whose line thickness is greater than three pixels. 

Actual thickness. All graphic lines will be displayed as thick as actually are. The actual line thickness 

is defined by the Line thickness” item on this tab.  
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Always three pixels. All primary graphic lines will be drawn with a thickness of 3 pixels, and all thin 

graphic lines – with a thickness of 1 pixel regardless of the scale of the drawing. 

One pixel. All graphic lines will be displayed one pixel thick. 

 

“ View ” Tab 

The View group of parameters defines the modes of displaying linear and angular values and the means 

of searching and selecting elements. These parameters do not modify the drawing graphic elements. 

Rather, these are system settings specific to the particular drawing. 

 

Selection: 

Element selection. Defines element selection modes while in drawing and editing commands.. Select 

one of the two modes: 

All. When creating and editing elements, all existing elements will be allowed for selection. 

Visible only. When creating and editing elements, only the visible elements will be allowed for 

selection. The element  visibility  is determined   based  on element levels and visibility intervals 

defined in the command SH: Set Levels (Customize > Levels…), as well as layer configurations 

defined in the command QL: Configure Layers (Customize > Layers…). 

Linear: 

Units. Defines the way of displaying linear coordinates in the information fields of the application, as, 

for example, X and Y coordinates in the status bar. The parameter does not affect the display of 

dimensions and other graphic elements. 
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Accuracy. Defines the accuracy of displaying linear coordinates in the information fields of the 

application, as, for example, X and Y coordinates in the status bar. The parameter does not affect the 

display of dimensions and other graphic elements. 

Angular: 

Units. Defines the way of displaying angular coordinates in the information fields of the application. 

The parameter does not affect the display of dimensions and other graphic elements. 

 

 

Accuracy.  Defines the accuracy of displaying angular coordinates in the information fields of the 

application. The parameter does not affect the display of dimensions and other graphic elements. 

Construction Lines: 

Search. Defines the mode of selecting straight construction lines. One of two modes can be selected, as 

follows: 

 

In limits. The lines will be selected according  to their length defined by the Length parameter on this 

tab. If construction lines are displayed as finite line segments, then the nearest segment will be 

selected. 

Infinite. The lines will be selected as infinite lines, regardless of the Length parameter value on this 

tab and the way of displaying the lines. 

Length. Defines the way of displaying the straight construction lines. Construction lines are displayed 

as either infinite lines, or finite segments bounded by their end nodes. To refresh the lines display per 

the new settings, use the command EC: Edit Construction under the icon  (use the option “Update 
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all Line extents” under the icon  in the automenu). One can set one of the following construction 

line display modes: 

 

Default truncated. Affects the construction lines whose Length property is Set as default. Such lines 

will be displayed as segments bounded by two end nodes. 

Default infinite. Affects the construction lines whose Length property is Set as default. Such lines will 

be displayed as infinite lines. 

All truncated. With this value, all construction lines will be displayed as segments bounded by two 

end nodes.  

All infinite. With this value, all construction lines will be displayed as infinite lines. 

                  

Extents. Defines extension of construction line overhangs beyond the end nodes when displaying as a 

finite segment. 

             

Text: 

"Transparent" text editing allows to edit paragraph text right after clicking the element with left mouse 

button. If the attribute is not set, then only the variables inserted in the paragraph text can be edited in 

this way. 

 

“Fragments” Tab 

Dynamic Fragment Editing. When this parameter is set, dynamic regeneration of the model and 

redrawing of the image occur upon inserting and editing 2D fragments. This makes the work 
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with fragments clearer. However, this is not suitable for drawings with large number of elements 

since it slows down the work. 

 

Insert Fragment on new Page creation. In the provided input box, enter the path to the fragment 

to be automatically inserted upon new page creation. If the fragment is a multi-page document, 

then the first page will be inserted. This parameter is defined automatically when creating BOM. 

 “Symbols” Tab 

Font. Defines the font for special symbols used on the current page. 

Code for Degree. Defines the symbol to substitute instead of the "%%d” key in text strings on the 

drawing. Default is the degree symbol code, which is 119. 
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Code for Diameter. Defines the symbol to substitute instead of the "%%c” key in text strings on the 

drawing. Default is the diameter symbol code, which is 066. 

Code for Plus/minus. Defines the symbol to substitute instead of the "%%p” key in text strings on the 

drawing. Default is the plus/minus symbol code, which is 116. 

When changing the font, a new symbol code can be defined manually by typing the appropriate value 

or by selecting a symbol from the menu “Insert Symbol” after pressing the button [Select]. When 

selecting a symbol from the table, the symbol code is entered automatically. 

“Detailing elements“ Tab 

Leader Notes: 

Standard. Defines the appearance of leader notes on a drawing. A leader note standard can be selected 

from the list. Two standards are provided – ANSI and BS/DIN/ISO. 

 

Upon changing the leader note standard, the leader notes automatically redraw to comply with the 

new standard. 

 

Text: 

Fast text mode (draw as rectangles). If set, all text are displayed as rectangles of the text size. 

Meanwhile, the text itself will not be displayed. This setting helps speed up display of large drawings.  
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  2D Section View: 

Automatic designation of letters. Automatic assignment of letters sequence for detail, section and 

auxiliary views. 

Do not designate. You can assign the same letters for different section views. 

For page only. Section views on the page will always have different letters. 

For the entire document. Letters that are used for section views will differ in the entire document. 

Add scale automatically. When this flag is set, scale will be drawn on the projections automatically, if 

scale was changed. 

Add sign of rotation angle automatically. When this flag is set, sign of rotation angle will be drawn on 

the projections automatically, if rotation angle was changed.“Colors” Tab 

 

Defines the color palette of the drawing and allows saving it with the drawing. These settings override 

the system settings of the respective parameters done by the command Customize > Options > Colors. 

One color group defines color in the case of using one color throughout the drawing. 

One color. Sets the drawing mode of using one color for all drawing elements. This color overrides 

element own settings. 

Color. Defines the color for all drawing elements when one color mode is set. The color can be selected 

from the menu of colors.  

Set colors group allows to define a color scheme that shall be stored together with the particular 

drawing. 

Set colors. Setting this attribute allows to define colors for the following drawing elements: 

Construction Line color. Defines the color of construction lines for the current page. 

Outline color. Defines the color of the border of the drawing area (also called “format”). 
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Grid color. Defines the color of the grid display. 

Node color. Defines the color of nodes. 

The colors can be selected from the color menus for each item separately. 

Note that “One color” setting overrides the individual color settings for the elements with the 

background color, construction lines and nodes. 

Background color. Defines the color of the current drawing background. 

Elements with background color. Defines the color of elements whose color is the same as the current 

drawing window background. Important to keep in mind that each color in the system has an Id. 

Altogether there are 256 standard colors (Ids 0-255). It is possible that two colors visual perception is 

same while the Ids differ. For example, suppose, the background color is set to black with Id equal 0, 

while the element color is gray 100% that is also black, however, with Id 226. In this case, the element 

will not be identified as an element with the background color. 

 

Colors: 

Background color. Defines the color of the current drawing background: 

Everywhere. Background color is displayed inside and outside drawing border. 

In Page Limits. Upon turning on this parameter, only the region inside the drawing border will be 

painted with the background color of the drawing. 

In Page Limits with shadow activates the mode of displaying shades around the drawing border. 



Customizing Drawing 

267 

“ALL”  TABS  

All existing in the current group parameters are displayed on the All tab.  

 

The parameters can be sorted by categories  or alphabet . 

You can enter parameter name or part of the name in the search bar to find it. 

 

DEFAULT PARAMETE RS  

For convenience of drawing creation, common parameters can be defined for 2D and 3D drawing 

elements, such as color, layer, level and priority, and, additionally for 3D operations, the material. The 

selected parameters are assigned to the newly created elements by default, but only for those whose 

types were selected from the list.  

The following command is used for setting the default parameters: PD: Set Default Parameters: 
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Icon Ribbon 

 

Edit→ Document → Defaults 

Keyboard Textual Menu 

<PD> Customize > Defaults 

 

The command brings up the “Default 

Parameters” dialog box. 

The pane on the right-hand side of the dialog 

box contains the list of all drawing element 

types – construction, graphic, detailing 

elements, etc. Checkmark the elements 

intended for setting new parameters. To check 

all elements at once, use the [+] button. Vise 

versa, to clear all checks, press the [-] button. 

The [+/-] button inverts element checkmarking.  
 

To change a parameter, set the checkmark before the parameter name. Otherwise, this parameter will not 

be accessible for editing. Each parameter affects its specific group of elements. For example, a material 

can be defined only for 3D operations, while the “Color” parameter does not affect construction entities. 

Should different default parameters be assigned to different elements, call the “Default Parameters” 

dialog box over again. 

For example, suppose, we need to set the default color blue for graphic lines. Besides, let the newly 

created detailing elements be moved on a new special layer. To do so, call the command Customize > 

Defaults… twice. On the first time, checkmark only the graphic lines in the list, check the “Color” 

parameter and define the desired setting which is the blue color. Then complete the first round by 

pressing [OK]. On the second time, checkmark the detailing elements – “GD&T Symbols”, “Roughness 

Symbols”, “Leader Note”, “Dimensions”, and clear the check on the “Graphic lines” element. Then check 

the “Layer” parameter and set as desired. Remember to first uncheck the “Color” parameter. To complete 

the second round, press [OK]. Now, when creating graphic lines, call the Graphic Line Parameters dialog 

box by typing <P> key and see that the “Color” parameter is set to blue color. Similarly, watch the new 

default parameters of the detailing elements. 

It is possible to define the complete set of default parameters for a particular type of elements. To do so, 

call the element creation command. Then immediately call the “Parameters …” dialog box of this element 

and do the desired settings. Keep in mind that the “Parameters …” dialog box shall be called before 

creating a new element. In this way, the element parameters will assume the new default settings upon 

creating new elements of the given type. Otherwise, the  item needs to be checked in the 

lower-left corner of the “Parameters …” dialog box.  

While creating elements, some parameters can be modified on the system toolbar. If the parameters on 

the system toolbar are modified while within a creation or construction command (check the automenu), 
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then these parameter settings are set as default for the current element type. In the case when the 

automenu is empty (no command is active), then after modifying a parameter the “Default Parameters” 

dialog box appears (see above) in order to define what types of elements are to assume the modified 

parameters as the default. 
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LIBRARIES 

When working with assemblies, standard elements are often used as fragments or pictures. Libraries 

provide an orderly way of managing sets of standard element files.  

A T-FLEX CAD library keeps the path to the folder with the standard element files. When selecting a file, a 

document preview and document properties preview are available in a separate window.  

Sometimes, simultaneous access to several libraries is needed. T-FLEX CAD allows composing library 

configurations. Each configuration can include an unlimited number of libraries groups, each group 

containing a set of libraries. 

L IBRARY CON FIGURATIONS AND L IBRARY EXPLORER  

A library configuration is a convenient means of managing numerous documents and libraries of 

parametric elements that can be used as fragments. 

Library configurations are stored in “.tws” files. A library configuration can consist of libraries or groups of 

libraries. Groups can include other groups or libraries. Therefore, library configurations can be structured 

hierarchically. A library contains data about paths to a folder on the disk, containing the document files. 

Therefore, for documents files to be included in the library simply place the files in the appropriate folder 

on the disk.  

The actual management of libraries and included there document files is done via the library explorer.  

 

The library explorer is a window displaying the open library configurations with all its files. The user has 

access to files for opening and for inserting fragments and pictures in the commands FR: Create 

Fragment, IP: Insert Picture, 3F: Insert 3D Fragment, 3MO: Insert External Model. 

Icons of library explorer elements: 

 Configuration  Library 

 Active configuration   Not found library 

 Libraries group  Duplicated library 

Icon created in command IC: Create/Edit icon is displayed for files. 
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Library explorer window can be activated via  > Tool Windows > Library explorer. 

 

TOOLBAR OPTIONS  

There is a special toolbar for Library explorer window. 

 

The toolbar allows to: 

1. Create a new configuration . 

2. Open a configuration . 

Drop-down list of all installed library configurations appears after pressing down arrow next to Open 

Configuration command icon . It is helpful for opening and closing existing library configurations. 

 

3. Use search bar . 

When you start search, all documents, which names satisfy the search request are shown in the Library 

Explorer. 
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4. Show/hide elements information columns . 

Columns contain information about library explorer elements. The information can be edited. Records 

can be sorted by columns. 

 

“Visibility” column allows to hide configurations, libraries and files in the window. You need to click  

icon next to the element for this purpose. You may control visibility of the hidden elements by clicking 

icon in the column header. 
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“Path” column displays path to the library and allows to change it manually. There is an option  in the 

column, which allows to select a new directory for the library. 

 

You can insert information for configurations, libraries and libraries groups in “Author”, “Company” and 

“Comment” columns. The information will be stored in a configuration file. 

CONTEXT MEN U COMMANDS  

Library configurations are filled via the library explorer. The library explorer commands are called by 

mouse right-clicking in the “Library explorer” window. The menu of the currently available commands 

pops up on the screen. The context menu contents depend on where the mouse cursor is pointing to at 

the moment (the window title, the name of a library configuration, a group name, a library name, 

filename, etc.). 

Common Commands of Context Menu 

Context menu commands that can be used for different type of library explorer elements are described in 

the section. 

 

 

Open Window . Opens a separate library window. This command is available in the context menu of 

libraries and libraries groups. You can also simply drag and drop the icon of the desired library from the 

library explorer into the document window. 
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Individual windows can be opened for several libraries. Like any service windows, windows with libraries 

can be combined into a common window with tabs. 

 

Add Library /Add group . Allows to add a new library/libraries group. The commands are available 

in the context menu of configurations or libraries groups. 

Open Folder . The command is available in context menu of configurations, libraries and files. A 

Windows folder with the selected configuration, library or document will be opened after the command 

activation. 

 

Delete . The command deletes groups, libraries or library elements. 

If you delete a group, all libraries and groups included in it will not be deleted from the configuration. 

If you delete a library, its folder will not be deleted from the disk. 

If you delete a file, it will be deleted from the library explorer and from the disk. 

Rename . Use this command to rename library, group of libraries or file. 

Library Configuration. Set of commands that allow to work with libraries configurations. 

 New. Creates a new library configuration. The command brings up a dialog box for inputting the 

name of the newly created configuration file and defining saving location on the disk. 

 Open. Opens the library configuration file. Several configurations can be opened in the Library 

explorer window. 

 Save All. Saves all open library configurations. 

 Close All. Closes all open library configurations. If changes were made to some library configuration, 

a query about saving changes will be made before closing. 

The commands for managing configurations and libraries can be called from the main menu File > 

Libraries.  
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Note that in absence of the Library explorer window in display, library configuration creation 

and loading operations will not be noticeable until the user opens the “Library explorer” window 

on the screen.  

Exclude/Include. The option Exclude allows to hide selected files and folders. The option Include allows 

to show the hidden elements in the library explorer, 

Show excluded/Hide excluded. When the option Show excluded is enabled, all hidden elements are 

shown in the library explorer with grey. Use the Hide excluded to hide them again.  

 

View: 

Tree. Preset hierarchy of configurations, libraries groups, libraries and files is displayed in this mode. 

 

Libraries Only. Only libraries and their content are displayed in this mode. 

 

Preview. The library explorer window allows opening an additional preview pane. The preview pane 

displays the file image or content of libraries/libraries groups.  

Position of the preview pane can be controlled by choosing the way the windows are split: vertical or 

horizontal. 
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Note that for the preview to appear in the preview pane, it needs to be created first. The image 

can be saved either as a bitmap, or as vector graphics. Different way of saving preview may be 

preferable in different drawing situations. Parameters for saving the drawing preview can be 

specified in the command ST: Set Document Parameters on the tab Save.  

For detailed information on saving a preview or icon image refer to the chapter “Preview/Slide”. 

You can change preview window size or hide it by moving separation line. 

 

Show invisible elements / Hide invisible elements .The option appears in the automenu if there 

are any invisible elements in library explorer. The option allows show/hide the elements in the list.  
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Library Configuration Management Commands 

Active Configuration . Marks selected configuration as active. 

The search for a fragment file when opening or regenerating the document begins in the active library 

configuration. If the element is not found, the search continues in all the rest of open configurations. 

If several library configurations are open then one of those is the active one, with the icon outlined in 

red. 

 

 

 Save. Saves the changes in the current library configuration.  

 Save As. Saves the current library configuration in a new file.  

 Close. Closes the current library configuration.  

Alternative file names. The command is used when you want to rename a file in the library and save links 

of the file with already existing assemblies. You should specify new and alternative names of the file in 

the command dialog.  
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Assemblies will use the alternative name to search for the file, so it should match the old name. 

Library Context Menu 

New command allows to create a new file in the library. You can select prototype from the drop-down 

list. 

Create Toolbar . This command adds a new toolbar to the application interface. A separate button 

corresponds to each file from the selected library. If the document has an icon it will be displayed on the 

button. Name of the file is displayed on the button if there is no icon. Pressing the button will insert 

appropriate library element into the document as a fragment. This feature allows you to create 

customized toolbars based on standard and custom libraries. 
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Delete from hard disk . The option allows to delete libraries folders from the disk. An empty library 

will exist in library explorer. Its folder is colored grey. This library can be linked with folder on the disk 

again. For this purpose you can manually insert new path to the folder or use option . 

 

If there are libraries with duplicated names in library explorer, they are pointed with blue folder icons. 

 

Replace command appears in context menu when you select several libraries. It allows to change path or 

its part for all the selected libraries. 

 

Replace Library Path dialog apears after its activation. 
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File Context Menu 

Open command allows to open the selected file in T-FLEX CAD. 

 

Insert as Picture  activates IP: Create Picture command and inserts the selected file as a picture into 

the current open document. 

Insert as Fragment  allows to insert the selected file as a fragment into the current open document. 

3F Insert Fragment or FR: Create Fragment command is activated according to the active - 2D or 3D - 

view in the document. 

A library name can be used in the commands for inserting external files into a T-FLEX 

document, such as FR: Create Fragment, IP: Insert Picture, 3F: Insert 3D Fragment. For 

example, if a fragment drawing fragment.grb is located on the hard disk in the catalog 

C:\TFW32\LIB\FRAG, and there is a library named “Parts” referencing this path, then the 

following name can be used for inserting the fragment:  “<Parts> fragment”. This way is 

convenient not only in that it replaces a long and possibly kludgy path with a slick one, but 

also helps to save paths to fragment files upon transferring documents to another disc or 

computer. You just need to open the library configuration. 

Properties. Calls the property dialog box of the selected file. 
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To have complete information displayed about the drawing, fill the informational fields PS: Show Model  

Properties. To make a preview appear in the preview pane, create it by the command PV: Save Preview. 

CREATION OF CONFIGURATI ONS ,  GROUPS OF L IBRARIES  AND 

L IBRARIES  

You can use option New configuration  on the toolbar to create a new library configuration. You can 

also use Library configuration > New item from the context menu. 

Command Add Library / Add Group  adds a new library/libraries group. The commands are 

available in context menu of configuration or libraries group. The element is created on the current 

library configuration hierarchy level. 

When you create library it is necessary to select folder with necessary files. 

An example of library explorer elements creation can be found in “Example of configuration 

creation” section. 
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ADD F I LES  TO L IBRARIES  

There are several ways to add a new GRB file into the library: 

1. Add file to the catalog, which is linked with the library. 

Library Explorer window is automatically updated if document files included into library were deleted, 

added or renamed. Thus, files added to the folder in Windows Explorer are displayed in the Library 

Explorer window. 

2.  Transfer files from Windows explorer to Library explorer window using Drag’n’drop or 

Copy/Paste options. 

 

 

3. Create a new file using one from the prototypes using option Create from the context menu. 
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MOVING OF L IBRARY EXPLORER ELEMENTS  

You can move libraries groups, libraries and files using Drag’n’Drop mechanism. For example, to move 

several files into another library, first select the group of files (hold down <Shift> or <Ctrl> key as 

appropriate). Then, move the cursor over the highlighted files and press . Next, hold the left mouse 

button down and drag the group of files into another library. This amounts to performing first Cut, and 

then Paste command. 

Cut , copy , paste . These commands are available in context menus to move/copy libraries, 

libraries groups and files.  

If a file is dragged into the drawing window, it will be inserted as a fragment.  

Dragging a file icon into the menu or toolbar area opens it for editing. 

EXAMPLE OF CONFIGURAT ION CRE ATI ON  

We need to create a new configuration and add “Bolts Library” and “Screws Library” into it. The folders 

include all necessary files and are stored on the disk. 

 

1. Create a new configuration using New Configuration  command from the toolbar.  
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2. Create libraries group using Add group  from the configuration context menu.  

 

3. Rename the created libraries group using Rename  command from the context menu. 

 

4. Select Add Library  item from context menu of the libraries group. Select Library Folder 

dialog will appear. Select folder and press [Select folder]. The selected folder with all its files will be 

added to library explorer. 

 

All the files that will be subsequently added to the selected catalogs will also be displayed in library 

explorer. 

5. Save the configuration after adding all necessary libraries. Configurations are stored in textual 

TWS file, which contains information about included libraries. To save the configuration, use Save as 

command from the context menu of the configuration and select folder where it will be stored. You can 

also change name of the configuration upon saving. 

It is recommended to store configuration files and their libraries folders on the same level. 

 

SPECIFYING REL ATIVE PAT HS TO T HE CATALOG  

A relative path to the library or libraries group catalog can be specified with respect to the installation 

home of the T-FLEX CAD application, or with respect to the configuration file that includes this library. A 

relative path allows use of symbols “*”, “..” and “.”. 

The symbol “*” in the beginning of the path stands for the path to the T-FLEX CAD home. 

The symbol “.” denotes the path to the folder of the library configuration file. 
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The symbol “..” means ascending one level up the folder. 

Suppose, for example, that the T-FLEX CAD application is installed in the С:\Program Files\T-FLEX 

Parametric CAD 3D folder, and a library configuration is stored in the file С:\Library\A 

library1.tws. In this case, the relative paths to libraries and groups of libraries are written out as 

follows: 

Path relative to T-FLEX CAD home 

folder 

Path relative to the 

library configuration 

file 

Absolute path 

*\Library\Bolts 

.\..\ Program 

Files\T-FLEX 

Parametric CAD 

3D\Library\Bolts 

C:\Program Files\T-FLEX 

Parametric CAD 

3D\Library\Bolts 

*\..\..\Screws .\..\Screws C:\Screws 

*\..\..\Library\Rods \Rods С:\Library\Rods 

*\..\..\Library\Bolts\Normal \Bolts\Normal С:\Library\Bolts\Normal 

In the case of inputting a path to a non-existent folder, the system changes library icon to grey 

folder. 

 

You can change paths using one of the following ways: 

Activate “Path” column displaying in library explorer. Here you can change path to the folder. 

 

Configuration file is located on the disk on the same level with its libraries. So that you can change path 

from “C:\Examples” to “.”. 

 



T-FLEX CAD Brief Introductory Course 

286 

 

Or 

Change paths for several libraries at once. You need to select the libraries with hold down <CTRL> 

button and select Replace… item in their context menu. 

 

Replace Library Path dialog appears. Here you can input an old path or its part and replace it with a new 

one. 

 

After that select Save option in the context menu of the configuration to save configuration changes. 

Relative paths will be saved in the configuration file. 
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PAGES 

For working convenience, T-FLEX CAD system provides a capability of creating multi-page documents. 

For example, it is handy to have in one file, yet on separate pages, auxiliary 2D constructions used in the 

main 3D model, as well as projections and sections of the 3D model with dimensions, or the BOM, etc. 

The elements can meanwhile interact with each other via the created relations, variables, databases, etc. 

GENERAL INFORMATION  

A T-FLEX CAD document can have an arbitrary number of pages. Each created document has at least one 

page. 

 

Pages in T-FLEX CAD are divided into six types, depending on their purpose and the way of creation: 

“Normal”, “Auxiliary”, “Controls”, “Workplane” , “Text”, “Bill of Materials”. Such division is not strict: the 

type of a page in most cases can be changed by the user. Types help controlling page display. 

Depending on the drawing settings, the 2D window will display all pages in the document, or only the 

pages of certain types. Therefore, the user can manage page visibility while working with multi-page 

documents, hiding from display those unused at the moment. 

 

Each page uses its own drawing settings defined in the command ST: Set Document Parameters, such as 

the paper format, drawing scale, font parameters, detailing elements, colors, properties of element 

display, etc. The settings made in the command Customize > Levels… also affect only the page that was 

current when the settings were made. When calling File > Export command, the system processes the 

current page of the drawing (except exporting to the AutoCad format, when all pages of the documents 

are getting converted). 

 

Modifications of “default” parameters affect all pages (see “Default parameters” section of the 

“Customizing Drawing” chapter). The same is true for managing layers in the command 

QL: Configure Layers. 
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If a T-FLEX CAD document contains several pages, the tabs with names of visible pages are displayed in 

the bottom of the drawing window. Visibility of the tabs can be controlled with the help of the flag 

Customize > Tool Windows > Page Tabs found in the textual menu. 

 

Switching pages is done without leaving the current command. This help creating, say, a copy or a detail 

view by selecting elements located on different pages. 

MANAGING DOCUMENT PAGES  

Working with Page Tabs. Tabs Control 

Page tabs, by default, are located along the lower border of the T-FLEX CAD document window. If 

necessary, their location can be changed by moving the page tabs upwards, as it was done in the 

previous versions of the T-FLEX CAD. To do it, it is enough to point with the cursor at the page tab, call 

the context menu with the help of  and change the value of the toggle Tabs placement to the required 

one (Top or Bottom). 
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Page tabs are used for quick shifting between pages of the current document. For shifting to the 

required page of the document, it is enough to point with the cursor at its tab and press . Moreover, for 

shifting between pages the keys <Page Up>, <Page Down> can be used as well. 

If the <Page Down> is pressed while being on the last page of the current document, the system will 

offer to create a new page. The created page will be placed at the end of the list of pages of the given 

document. It is also possible to create a new page by using the command New Page found in the 

context menu for the tab of any page. 

On each page tab, the page name as well as the symbol showing its type are displayed. By default, the 

system gives to the pages the names “Page 1”, “Page 2”, etc. , however, afterwards these names can be 

changed to more meaningful ones to make the work more convenient. To rename the page, the 

command Rename can be called from the context menu of the page tab. After calling this command, the 

system will shift to the mode of editing the text shown on the tab. 

 

The order in which the pages of a document are arranged can be changed. It is possible to quickly sort 

the pages by names or by types with the help of the commands Sort Pages > Name and Sort Pages > 

Type found in the same context menu called for any tab of the current document. 
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An arbitrary change in the page arrangement can be carried out just by dragging the page tab to 

another place. To do it, bring the cursor to the required tab, press  and without releasing the mouse 

button, drag the cursor to the required position in the list of tabs. 

Let's talk more about the context menu for the page tabs. With the help of the command Font… it is 

possible to modify font parameters used for displaying the text on the page tabs. Upon calling this 

command the standard window of font parameters opens up.  

The command Delete allows removing the page on the tab of which the context menu has been called. If 

the page being removed contains some drawings, the system will inform about that and ask a user to 

confirm the necessity of page removal and all its contents. 

The command Pages… invokes the dialog for controlling pages of the document. This dialog allows 

performing all possible operations with pages: create and delete pages, rename, change the type of page 

and its location in the list of pages. We will tell more about working with this dialog in the section 

“Working with Dialog «Pages»” below. 

The last command of the context menu – Hide Page Tabs – turns off the display of the page tabs for the 

document. After the tabs were turned off, it is possible to turn the display of the page tabs back on with 

the help of the flag Customize > Tool Windows > Page Tabs. 

Creating New Pages 

Additional pages can be created in a T-FLEX CAD document by the following means: 

1. Using the <Page Down> key. When created, such pages are automatically assigned the type 

“Normal”. 

2. Via the help of the command New Page in the context menu of the page tabs; 

3. Via the command PG: Pages (see the section “Working with Dialog «Pages»”); 

4. Automatically while working in the certain commands. The type of a thus created page 

depends on the actual command. For example, the TR: Create Control command allows 

creating a page of the type “Controls”, while the command SD: Create Darwing View– a page 

of “Auxiliary” type. The command 3W: Construct Workplane creates pages of the type 



Pages 

291 

“Workplane”, while “Normal” type pages are created under BC: Create Report/Bill of Materials 

and BM: Reports/Bills of Materials.  

The quickest way of creating a new page is use of the <Page Down> 

key. To create a new page, go to the last page of the drawing and press 

the <Page Down> key. After that, confirm the new page creation query. 

The new page is created as a result. It is automatically assigned a new 

name “Page N”, where N is the page number. 

At creation, the page settings are copied from the last active page. 

These settings can later be modified by activating the page and calling 

the command ST: Set Document Parameters. 
 

Creation of pages as per the item 3 is described in the respective chapters of the mentioned commands. 

Working with Dialog «Pages» 

The dialog “Pages” allows performing practically all possible operations with the pages of the current 

document. Several options are available to call this dialog. First of all, it can be called with the help of the 

command: 

Icon Ribbon 

 

Edit → Document → Pages 

Keyboard Textual Menu 

<PG> Customize > Pages 

Moreover, the dialog “Pages” can be called via the toolbar “View” and from the context menu for the 

document tabs. 

The main pane of the dialog contains the list of pages displayed in the 2D drawing window: names and 

types of pages. 

In the bottom portion of the dialog box is the “Show Pages” group of flags for managing the list 

contents (and, therefore, the 2D window display) regarding the pages of a certain type, as follows: 

“Workplanes”, “Controls”, “Auxiliary”, “Text”, “Bill of Materials”. 

Pages of the type “Normal” are always present in the list and in display in the 2D document window. 

Having selected a page in the list by clicking , you can change its type by choosing the required value 

from the drop down list “Page Type”. 

Pages of the type “Workplane” are created only with a workplane creation by the appropriate commands. 

Their type can’t be changed. 
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The graphic buttons at the right-hand side of the dialog box allow the following actions over the 

selected page in the list: 

[New]. Creates a new page of the drawing. Upon pressing the button, a new page is added in the 

document, launching the name editing mode. The page type is “Normal” by default. If necessary, 

you can assign the desired type via the parameter “Page Type”. 

[Copy] Creates copy of the selected page with its parameters. 

[Delete]. Deletes the drawing page selected in the list. If the page is not empty (i.e. contains some 

elements), the system queries the user whether to delete objects on the page or associated with 

the page. Positive answer results in deleting the page and all associated objects, the negative 

one cancels deletion. 

[Rename]. Changes the name of the page. The page name is displayed on the tab. Clicking on the 

name of the selected page entry in the list highlights the name and allows its editing. When 

pages of the type “Workplane” are renamed, the “Name” parameter of the workplane changes 

according to the new name of the page. 

[Up]. Moves the selected page entry in the list one line up. 

[Down]. Moves the selected page entry in the list one line down. 

Note that the order of pages in the document, as reflected by the tabs, corresponds with their 

positions in the list being described. 

[Select]. Activates the selected page. Opens the selected page in the 2D drawing window. 
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[Close]. Closes the “Pages” dialog box. Completes the command. 

Modifying Page Parameters 

Each page has its own settings defined via the command ST: Set Document Parameters. The page size 

can also be modified directly in the 2D window by the command PZ: Set Paper Size: 

Icon Ribbon 

 

Workplane → Modes → Page size 

Keyboard Textual Menu 

<PZ > Customize > Page Size 

The command is used for modifying the size of a page and its position. Modifying the page size 

parameters affects the Paper size parameters on the  Paper tab of the command ST: Set Document 

Parameters. 

Upon calling the command, the borders of the current page highlight, outlined by a box with graphic 

controls of a square shape along the perimeter for resizing. If pointed to one of these squares, the 

mouse cursor changes to . It can be dragged now with the left mouse button depressed, modifying 

the size of the box diagonal. If pointed to a box mid-side square, the mouse cursor changes to  and 

can be dragged now with the left mouse button depressed, modifying the vertical or horizontal size of 

the box, respectively.  If within the box, the mouse cursor changes to  and can be dragged now with 

the left mouse button depressed, modifying the box position. 

The following options are available in the automenu in this mode: 

 

<Ctrl+ 

Enter>  
Finish input 

 <P>  Set page size 

 <Esc>  Exit command 
 

The option  allows entering numerical values of the page corners 

in global coordinates. Upon modifying the size and/or position of 

the page, confirm the input with the option . 

The grid can be brought up on the active page, and grid snapping 

turned on, by using the command “QG: Change Grid settings”. 
 

SPECIAL  HANDLING OF MULTI-PAGE DOCUMENTS  

As mentioned above, each page of a multi-page document in T-FLEX CAD can be used for creating 

various elements: nodes, construction and graphic entities, hatches, text, etc. if necessary, elements can 

be moved/copied from one page to another. 
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Elements located on different pages of the same document can be totally independent of each other, or, 

vise versa, related by various means: by the copy operation, by projective relations, via variables and 

databases. Besides, T-FLEX CAD allows creating elements located on several pages simultaneously. When 

creating text or BOM elements, one can define transition to the new page if the element being created is 

getting out of current bounds. As a result, each page will display the respective part of the multi-page 

element. Editing and parameter modification commands work on the whole element, regardless of the 

portion selected in the command.  

A multi-page document, just as any other T-FLEX CAD document, can be inserted into another document 

as a fragment or picture, exported in other graphic formats or printed. Each of these situations will be 

reviewed separately. 

When using a multi-page document as a fragment in an assembly, only 

one page of the fragment document is inserted. Therefore, when 

inserting, the user can specify the particular page of the fragment 

drawing to assemble, along with specifying fixing points or vector 

and defining the fragment variables 

When inserting a multi-page document in another drawing as a picture 

only one page of the selected document is inserted as well. The 

required page is determined by the user upon inserting a picture. 
 

When exporting a multi-page document into another graphic format, the output graphic file will contain 

the document page that was active when the export command was called (except exporting to the 

AutoCAD format). 

When printing a document, the user can specify the pages to print in the print parameters dialog box. 

 



 

 

DRAWING CREATION 
 



 

 

CONSTRUCTION ENTITIES 
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LINES 

By “line”, we mean infinite lines that belong to construction entities and serve as the parametric 

framework of a drawing. Lines are displayed as thin dashed lines.  

Constructing Lines 

To construct a line, call the command L: Construct Line: 

Icon Ribbon 

 

Draw → Construct → Line 

Keyboard Textual Menu 

<L> Construct > Line  

 

The following options become available: 

 <P> Set Line Parameters  

 <X> Creates two crossing Lines and Node 

 <H> Creates horizontal Line 

 <V> Creates vertical Line 

 <L> Selects related Line  

 <N> Selects Node 

 <C> Selects tangent Circle 

 <E> Selects ellipse to create Line 

 <S> Selects spline 

 <O> Create orthogonal Line 

 <T> Creates Proportional Line 

 <U> Create Axis of Symmetry 

 <A> Selects Axis of Symmetry (straight Line) 

 <W> Select 2D projection 

 <O> Create two Lines and Node in (0,0) 
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 <Space> 
Creates a node at the nearest intersection of 

construction lines 

 

<F>  

or 

<Ctrl><1>  

Create insertion Point for Fragment (xn, yn) 

 <F4> Executes edit Construction command 

Some of these options become available only after selecting certain construction entities. 

There are different techniques of creating lines. Some lines are independent of other construction 

entities. These could be a standalone horizontal or vertical line. Usually, these are the very first lines on a 

drawing. By creating a vertical and a horizontal line, you define the base lines, to which all the rest will be 

related.  

Other lines require the related elements to be selected at the time of creation. For example, a line 

tangent to two circles requires the circles to be selected and the tangency condition defined.  

                        

                        

A number of line creation techniques require a certain geometric parameter to be defined. For example, 

consider constructing a line parallel to another line and passing at a certain distance from the other line. 

In this case, it is necessary, besides selecting the original line, to define the distance between the lines. 

Exact values of the numerical geometric parameters can be entered in the property window in 

transparent mode. Besides, one can use the line parameters dialog box under the option , that, 

besides the geometric parameters, also allows defining general system ones, as level, layer, etc. If exact 

value is not required, one can simply point at the desired location on the drawing and click . In this 

case, the numerical parameter value is defined by the cursor position. 

When constructing lines, one should keep in mind that after creating one line the command sticks in the 

selected line type creation mode. For example, once a pair of crossing lines was created under the <X> 

option, another pair of crossing lines can be created again without re-selecting the option. This feature 

helps speed up constructing same-type lines. To quit such a mode, right-click . 

The line creation command allows making a variety of construction line configurations by combining the 

limited set of options, as follows: 
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<X>,<P>  
Crossing (vertical and horizontal) lines with a node at the intersection 

and exactly defined placement coordinates  

<H>,<P>  Horizontal line with exactly defined coordinates 

<V>,<P>  Vertical line with exactly defined coordinates 

<L>,<P>  Parallel to a line, the specified distance away  

<N>,<P>  Line at a specified angle with respect to X axis 

<N>,<L>,<P>  Through a node, at a specified angle with respect to a line 

<N>,<L>,<O>  Through a node, orthogonal to a line 

<N>,<N>  Through a pair of nodes 

<H>,<N> or <N>,<H> Horizontal line through a node 

<V>,<N> or <N>,<V> Vertical line through a node 

<L>,<N>  Parallel to a line, through a node <*> 

<C>,<C>  Tangent to two circles  

<N>,<C> or <C>,<N> Through a node, tangent to a circle 

<A>,<L>  Symmetrical to another line <L> with respect to a specified axis <A> 

<C>,<L>,<P>  Tangent to a circle, at a specified angle with respect to a line 

<U>,<L>,<L>  Symmetry axis for a pair of lines  

<L>,<C>  Parallel to a line, tangent to a circle <*> 

<T>,<N>,<N>,<P> 
Line orthogonal to the segment spanning two nodes, dividing the 

segment in specified proportion 

<E>,<C> Line tangent to an ellipse and a circle 

<E>,<E> Line tangent to two ellipses 

<E>,<S> Line tangent to an ellipse and a spline 

<S>,<S> Line tangent to two splines 

<L>,<E> Line parallel to another line and tangent to an ellipse 

<E>,<P> 
Line tangent to an ellipse, at a specified angle with respect to another 

line 

<*> - Use of <L> equivalent to <Enter> or . 

Note: Whenever the property window or the parameters dialog box is used for defining a 

numerical parameter of the line being constructed, variables or expressions can be entered as well 

as fixed values.  

Whenever the <P> option is not present, the line does not have numerical parameters. For example, this 

would be a line trough a pair of nodes. 

Let’s review in details each of line creation techniques mentioned above. In following examples, we will 

show how to define these relations using the keyboard. Alternatively, one can work with the options via 
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the automenu icons. Additionally, if object snapping is turned on, then the described actions of the 

command can be performed without use of icons or keyboard.  

Line Construction Techniques 
Follows is the description of various line construction techniques. Each technique implies using a 

sequence of certain options that include keyboard input and automenu icon picks.  

The <P> option notation in the descriptions of line constructions means a numerical parameter is to be 

input. In this case, instead of calling the parameters dialog, one can use the property window or simply 

click  within the drawing. 

<X>, <P> 

These options are used for creating a set of construction entities in one action, namely, a horizontal line, 

a vertical line and a node at their intersection.  

First type <X>, then <P>. 

X

                                                            

 

 

<H>, <P> 

This option sequence creates horizontal lines at a specified distance from the X-axis. Type <H>, and then 

<P>. 

H

                                                        

 

<V>, <P> 

This key sequence creates vertical lines at a specified distance from the Y-axis. Type <V>, and then <P>. 
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V

                                                                

 

<L>,<P> 

This key sequence creates a line, parallel to the selected line at a specified distance. Type <L>, and then 

<P> for defining the distance from the selected line. 

As a rule, this line type is used in drawings most often. This is because the lines on a drawing 

usually make parallel pairs, with the distance between them being a design parameter. 

                                                  

 

<N>, <P> 

This key sequence creates a line at a specified angle to horizontal. Type <N>, and then <P>. The angle is 

entered in degrees. 

N
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<N>, <L>, <P> 

These options define a line passing through a node at a specified angle to a selected line. Move the 

cursor to the node and type <N>, and then to the line and type <L>. Thereafter, specify the angle 

between the lines (in degrees). 

N
         

L

                 

                                          

<N>, <L>, <O> 

These options define a line passing through a node and orthogonal angle to a selected line. Move the 

cursor to the node and type <N>, and then to the line and type <L>. Thereafter, type <O>. 

N
       

L

       

O

       

<N>, <N> 

This combination defines a line passing through a pair of nodes. Move the cursor to the first node and 

type <N>. Repeat the same for the second node. 

N
                        

N

                      

<N>, <H> or <H>, <N> 

These option sequences create a horizontal line passing through a node. Move the cursor to the node 

and type <N>. Next, type <H>. These actions can be reversed. 

H
                    

N
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<N>, <V> or <V>, <N> 

These option sequences create a vertical line passing through a node. Move the cursor to the node and 

type <N>. Next, type <V>. The actions sequence can be reversed. 

V

                          
N

                          

<L>, <N> 

This option sequence creates a line parallel to a selected line and passing through a node. Move the 

cursor to the line and type <L>. Next, move over the node and type <N>. 

L                      

N

                        

<C>, <C> 

This combination defines a line tangent to two circles. Move the cursor to the first one and type <C>, 

then move to the second and type <C> again. Generally speaking, four distinct lines can be created in 

this situation, all of which would be two-tangent to the circles. 

C

         

C

                  

<C>, <N> or <N>, <C> 

Using these combinations creates a line tangent to a circle and passing through a node. Move the cursor 

to the circle and type <C>, then move over the node and type <N>. Two distinct possibilities exist in this 

situation. One can do selections in the reversed order as well. 

C

       

N

                    

<A>, <L> 

Use of such options creates a line (or lines) symmetrical to another one with respect to the selected axis. 

The symmetry axis is selected by typing the first key, <A>. Then, one can create a single line or multiple 

lines symmetrical with respect to the axis. A line to be mirrored is selected by typing <L>. Note that after 

typing <L> key once, the symmetry axis first stays selected, ready for mirroring more lines.  
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This mode stays active until canceled via <Esc> or . 

A

                

L

                

<C>, <L>, <P> 

This combination creates a line tangent to a circle and passing at a specified angle to the selected line. 

Move the cursor to a circle and type <C>, then move over the line and type <L>. You will then see the 

angle value displayed in the coordinate field of the status bar. This is the angle between the selected and 

the rubberbanded lines. Now you have a choice of setting the parameter according to the cursor position 

or edit the parameter by entering a value, variable or expression. In the first case, simply click , and in 

the second – use the property window or the parameters dialog box for editing the angle parameter. 

Note that the angle value is entered in degrees. 

C
        

L

                      

<U>, <L>, <L> 

Use these options to create a line that is the symmetry axis for the two selected lines. In the case of 

intersecting lines, turn on the option <U>, move the cursor over one of them and type <L>. Then move 

over the other line and type <L> once more. A newly created line will bisect the angle between the two 

lines, acting as the symmetry axis. The same command works on parallel lines as well. After activating the 

option <U> move the cursor over one line and type <L>, then move over the other and again type <L>. 

A third parallel line will be created bisecting the distance between the two selected. 

L
                    

L

                   

L

                     

L

                     

<L>, <C> 

These options help define a lane parallel to a selected line and tangent to a circle. Move the cursor over a 

line and type <L>. Then move over a circle and type <C>. A new line will be created, parallel to the 

selected line and tangent to the circle. 
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Note: In this situation, as in some other cases, there are two possibilities for the line placement 

with respect to the circle. The system distinguishes them and at the creation instance settles with 

the configuration in which the line is closer to the selection point on the circle. 

L                 

C

                           

<E>, <C> 

The options allow creating the line tangent to an ellipse and a circle at the same time. For constructing 

the line, bring the cursor to the given ellipse and press <E> (if the object snap mode is on, then it is 

sufficient just to press  pointing at the ellipse). After that, dynamic image of the created line will end up 

being tangent to the ellipse for any cursor translations. Then point at the circle and press <C>. Tangency 

points with an ellipse and a circle (in case of non-uniqueness of the solution) will be selected by the 

system from the condition of maximum closeness to the cursor location upon selecting the ellipse and 

the circle. 

                          

<E>,<E> 

With the help of these options the line tangent to two ellipses can be constructed. For constructing the 

line, point at two ellipses successively: bring the cursor to the first ellipse and press <E>, then repeat the 

same operations for the second ellipse. 

                                            

 

<E>,<S> 

This option sequence allows creating a line tangent simultaneously to an ellipse and a spline. Bring the 

cursor to the required ellipse and press <E>. Dynamic image of the cursor will become tangent to the 

selected ellipse. After that, move the cursor to the spline, which a created line should be tangent to, and 

press <S>. 
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<S>,<S> 

By using the option <S> twice, the line tangent to two splines will be created. For constructing the line, 

bring the cursor to the first spline and press <S>. Then repeat the same for the second spline. Similar to 

two previous cases, if different solutions for touching the splines and a created line can be found, 

tangency points will be selected by the system from the condition of maximum closeness to the cursor 

location upon selecting the splines. 

                                        

 

<L>,<E> 

This option sequence allows creating the line parallel to another line and tangent to an ellipse. Bring the 

cursor to the line, which has to be parallel to the new line, and press <L>. Then move the cursor to the 

ellipse which a created line has to touch and press <E>. 

                                

 

<E>,<L> 

For constructing a line tangent to an ellipse and angular to another line, bring the cursor to the ellipse 

which the created line has to touch and press <E>. Then point with the cursor at the line at an angle to 

which the created line has to be drawn, and press <L>. After that, it is necessary to specify the angle 

between two lines (in degrees) directly in the drawing window or in the properties window. 
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<T>, <N>, <N>, <P> 

This sequence defines a line orthogonal to the imaginary segment spanning two selected nodes. The line 

is constructed so as to divide the segment in specified proportion. This proportion value is the parameter 

of the line being created, defined in dimensionless units. For example, with the parameter equal 0, the 

line will be passing through the first node, with the value 1 – through the second one, while the value 0.5 

sets the line through the midpoint between the nodes. Should the nodes change location, the line will 

adjust, keeping the defined proportion. This kind of construction is used, for example, for drawing a 

spring with a fixed number of coils and variable length. The distance between the coils of such a spring 

will vary in a fixed proportion to the total length. 

To create this kind of line, in the automenu turn on the option <T>, move the cursor to the first node 

and type <N>, then over the second node and type <N>. A line starts rubberbanding after the cursor 

orthogonal to the segment spanning the two selected nodes. The coordinate field will be displaying the 

current proportion value. Use the property window or the parameters dialog box to specify this value, or 

simply click , if satisfied. 

N
                                

Lines Created from 2D Projection, 2D Fragment, or Copy 
Such lines can be created in object-snapping mode, when the respective flag is set on the Snap tab of 

the SO: Set System Options command. Move the cursor to a graphic line that is a part of a 2D 

projection, 2D fragment or a copy. The line will get pre-highlighted. Click . A construction line will be 

created on top of the selected graphic line. Besides, nodes will appear by the end points of the graphic 

line. Meanwhile, the system will assume the parallel line creation mode. 
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If the object-snapping mode is off, such lines can be created only based on 2D projection lines. To do so, 

select a desired projection on a drawing using the  option. The selected projection will be 

highlighted, and the cursor will gain a glyph . To create a line, simply point the cursor at a line on the 

projection and click . 

In this case, the following options will be accessible in the command automenu: 

 <P> Set Line Parameters 

 <Esc> Cancel selection 

Line Parameters 

When creating and editing lines, it is often required to define various line parameters. The geometrical 

parameters, such as coordinates, the distance or the angle to the related line, can be entered in 

transparent mode in the property window. However, in order to define the general system parameters of 

the line, one has to use the option  to bring up the dialog box of all line parameters. 

Distance. This is the distance between the newly constructed 

line and the line selected as the reference for the 

construction. 

Level. Places the line being created on the particular visibility 

level. Levels help hiding certain elements from display. The 

level parameter can be assigned a variable.  

Layer. This parameter allows placing the line being created on 

a certain layer.  

Line length. Defines the way of construction line 

representation in display. The detailed description of this 

parameter follows below. The available values of this 

parameter, provided in the list, are: 

Default (From Document); 
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Truncated; 

Infinite. 

Color. This parameter defines the color used for displaying the 

line. 

 

Set as default. Setting this flag means, the current parameter settings in this dialog box will be used from 

now on in construction line creation, with the exception of the “Distance” parameter. 

Truncated Lines 
Normally, construction line entities appear on a drawing as infinite lines. However, as a drawing grows 

crowded, managing it becomes difficult. A means is provided for setting shortened representation of 

construction lines that allows working with lines as segments of limited length. 

A trimmed, or truncated, construction line is bound by its two end nodes. 

The extents of trimmed construction line overhangs can be defined in the 

command ST: Set Document Parameters the parameter View > Extents.  

 

If a construction line does not have nodes, then it will always appear as an infinite line. If a construction 

line has only one node then the “Extents” parameter should better be set greater than zero, as otherwise 

the line will disappear from display. 

The line display gets up to date after executing the following options of the EC: Edit Construction 

command: 

 <T> Update selected Line(s) extents 

 <Q> Update all Line extents 

          

The function of the “Line length” parameter significantly depends on the settings under the ST: Set 

Document Parameters command parameter View > Length. 

Four ways of line display are supported by the ST: Set Document Parameters command: 

Default truncated. If a particular line has the parameter “Line length” set to “Default” value, then 

this line is displayed as a segment.  

Default infinite. If a particular line has the parameter “Line length” set to “Default” value, then this 

line is displayed as an infinite line. 

All truncated. Any and all lines will be displayed as segments, regardless of the “Line length” 

parameter settings. 
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All infinite. Any and all lines will be displayed as infinite lines. 

Another special parameter under the ST: Set Document Parameters command is View > Search. It 

defines the line selection mode. The lines are selected either within the displayed limits or as infinite 

lines, regardless of other parameter settings. 

Using Numerical Parameters 
Entering the “Distance” parameter is a most common case of working with construction line parameters. 

The positive values of this parameter correspond to locations above the reference horizontal line, while 

the negative are below, respectively. 

                                      

                                 

In the case of a vertical reference line, the positive values of this parameter are for the left hand-side 

locations, while the negative are for the right hand-side locations, accordingly.  

                                     

                                   

These rules result from the use of the coordinate system in T-FLEX CAD. That helps keeping the once set 

relations between construction entities under any modifications of the parameter values.  

Note that the “-” sign may be preset by the system before the parameter input box in the property 

window. The system is monitoring the rubberbanded line position with respect to the reference parallel 

line. When the new line is rubberbanded in the area of negative offsets, the negative sign is automatically 

set, and the user needs to enter only the absolute distance. 

As an alternative to entering a specific distance value, one can use variables. The name of a variable is 

defined as a US ASCII string of no more than 10 characters. The names are case-sensitive, therefore, for 

example, the two names “Width” and “width” are different. Let’s assign the distance between the two 

lines a variable “W”. 

                      

P
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A dialog box will come up then, for defining the value of 

the variable. The variable being created can be flagged 

as “External”. The variable can have a positive or negative 

value, or assume the value of another variable or 

mathematical expression based on other variables. Let’s 

enter the value “50” for the variable. 

If we flagged the variable as “External”, then in future it 

will be accessible for assigning values from outside the 

document.  

Such situations include, for example, use of external applications, or assigning a value from an assembly 

document upon inserting the present drawing as a fragment. In our particular example, the variable is 

not required to be external. 

Once the value has been assigned to the variable, a line is created, parallel to 

the reference one, at the distance of 50 units on the left-hand side of the 

reference.  

Now, one can verify the just defined relation between the lines. Enter the 

command V: Edit Variables: 
50

 

 

Keyboard Textual Menu Icon 

<V> Parameters > Variables  

The Variable editor dialog box will come up on the screen. The only variable displayed in the dialog box 

will be the just created “W”, with the value “50”. The Variable editor has four fields (columns): “Name”, 

“Expression”, “Value” and “Comment”. Since we entered a numerical value for the variable, the “Value” 

and “Expression” readings are the same. 

The quantity in the “Expression” field can be modified as 

necessary. After that, exit the editor by pressing [OK]. The 

drawing will instantly update per the new value of the “W” 

variable. 

An expression can be used for the parameter “Distance” 

just in the same way. For example, suppose, the new line is 

constructed on the right-hand side of the vertical line. 

Then, to work around the “-” sign in the value of the 

variable, the variable can be assigned the expression “-W”. 

Generally speaking, one can use formulas with several 

variables in the expressions. 
 

For viewing and editing the values of the variables, one can use an additional window “Variables” 

which allows working with variables in transparent mode. 
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Editing Lines 

The EC: Edit Construction command is provided for editing construction lines. It is one of most often 

used commands. This is the command that supports creation of new drawing configurations by 

providing a dialog box for varying necessary construction parameters. The command allows editing all 

kinds of construction entities. 

The command is called as: 

Keyboard Textual Menu Icon 

<EC> Edit > Construction > 2D Construction  
 

To modify location of some construction entity, simply select 

it using , move the cursor over the desired location, and click 

 again. To specify the exact value of the placement 

parameter, use the property window or the parameters dialog 

box via the  option.  

 
 

If the entity was driven by a variable, the system will output a 

warning. To avoid the system warnings, call the option  before 

selecting any entities. A dialog box will come up, in which the item 

Auto change Variables needs to be checked. 

 
 

When modifying the values of construction parameters it is 

possible to use Relations that appear on element selection. 

These Relations are temporary. They will automatically 

disappear on editing finish. To modify the values of 

construction parameters with the help of Relations it is 

necessary to turn off “Dynamic recalculation” mode (option 

, see below).      

It is possible that some construction entity can’t be recreated after modifying parameter values due to 

geometrical incompatibilities among the entities. In such a case, the system will output an error message 

and specify the particular failing relation. 
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The selected line is highlighted on the drawing. Besides, other construction entities are highlighted that 

were used as references for the line creation. The following options are available in the command 

EC: Edit Construction: 

 <> Dynamic model regeneration mode 

 <P> Set command options 

 <O> Create Name for selected Element 

 <M> Modify Construction Line relations 

 <T> Update selected Line(s) extents 

 <Q> Update all Line extents 

 <K> Break link with variable 

 <I> Select Other Element 

 <R> Select element from list 

 <*> Select All Elements 

 <Del> Delete selected Element(s) 

 <Esc>  Cancel selection 
 

<Shift><Enter>  Add Construction Element to Selected for Editing 
 

<Ctrl><Enter>  Exclude Construction Element from Selected List 

The option  (<K>) allows switching all parameters of the selected construction line from dependency 

on variables to the constant values. 

The option <O> allows specifying names for construction lines in order to define advanced parametric 

dependencies. Such a name will help exactly identify a construction line and, in particular, directly access 

certain proprietary data of the line in the variable editor via the command V: Edit Variables, using the 

function “get”. The name is not required for common situations of parametric design. 
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Modifying Relations between Construction Lines 
 

If for some reason you would like to modify the existing relations between the 

construction lines, this can be easily done using the  option. Let’s review an 

example of using this option. 

The line 1 is created at a given angle to a vertical line. Besides, it is passing through a 

node at the intersection of the vertical and a horizontal line. The circle 2 was 

constructed tangent to the lines 1 and 4, while the line 3 tangent to the circle 2. 

3 2

14

 
 

Suppose, you would like to make the line 1 parallel to the vertical 

line. Since other construction entities are created using the former 

line as a reference, the line may not be simply deleted and then 

differently created anew. The deletion of this line would require also 

removing the line 3, followed by removal of the circle 2. This is 

exactly the case when the option <M> is to be used. Enter the 

command EC: Edit Construction and select the line 1 for editing. This 

line will get highlighted along with another line and the node used as 

references for this line creation. 

3 2

14

    

3 2

14

 

 

After selecting the line, type <M> for modifying the definition of the 

line 1 construction. Note that the system brought you into the 

construction line creation command, L: Construct Line. Now you can 

create this line as if anew. The difference from constructing a line 

without using the <M> option is that both the line being modified 

and the reference line are both highlighted on the screen. Select a 

line - the reference for the line 1 to be parallel to. Then rubberband 

the new line to the desired distance from the reference and fix that 

location by clicking . 

3 2

14

   

3 2

14

 

 

Line 1 will appear in the new position, while all the rest of entities using the line as 

a reference will keep their relations with the line, as, for instance, the circle 2 will 

remain tangent to the line 1. 

The only restriction on modifying relations between construction lines is a ban on 

recursive definition, that is, the line may not reference itself. Should this occur, a 

message will be displayed about recursion, and the modification will be cancelled. 

With this exception, any relations between lines and circles may be modified at any 

time. This functionality is especially useful on importing drawings from other 

systems, such as, for example, *.DXF or *.DWG files of the AutoCAD system. 

3 2

14
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Deleting Construction Lines 
To delete a construction line, simply select the line using  and call the <Del> option. If the line is not 

referenced by any other drawing elements, it will be deleted. Should there be other elements defined 

based on the selected line, a warning will appear about deletion of all elements related with the line. 
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CIRCLES  

Circles in T-FLEX CAD are constructed similarly to lines, that is, by defining their geometrical relations 

with other construction entities. Examples of such relations include placement of the circle center at a 

node, tangency to a line, tangency to a circle, passing through a node, concentricity with another circle, 

symmetry to another circle.  

The T-FLEX CAD circles can be divided into two main groups: 

- circles, whose radius can be assigned a number (for example, a circle with the center placed at 

a node, or a circle tangent to two non-parallel lines); 

- circles, whose placement and radius are defined by construction (for example, a circle passing 

through three given nodes). 

If a circle has a numerical parameter (the radius), then the parameter can be defined by a constant, a 

variable or an expression. To assign the numerical parameter, one can use the property window. The 

circles are created in the command C: Construct Circle. The relations defined at the time of circle 

construction can be modified in the command EC: Edit Construction in a similar to line way of handling. 

Circle Construction Examples 

Before discussing all capabilities of the command C: Construct Circle, let’s consider examples of 

constructing most common types of circles. Additionally, the command L: Construct Line will be used in 

constructions. This command was described in the previous chapter. 

Enter the command L: Construct Line. Select the option <X>, represented in the automenu by the icon 

. Move the cursor over the center of the graphic window and click . This creates two lines, a vertical 

and a horizontal one, and a node at the intersection. After that, enter the command C: Construct Circle. 

Icon Ribbon 

 Draw → Construct → Circle 

Keyboard Textual Menu 

<C> Construct > Circle 
 

Move the cursor to the just created node and click . Thus you define the circle 

center. Internally, the system stores the relation between the circle center and the 

node. The node will be highlighted, and a circle will start rubberbanding after the 

cursor. Meanwhile, the radius of this circle will be dynamically updating on the 

status bar (“R=...”). 

Clicking  completes construction of the circle with the current radius.  
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For a simple way of defining an exact value of the circle radius while 

rubberbanding, use the property window in transparent mode. Besides, 

one can call a dialog box with the complete set of circle parameters via 

the  option of the automenu.  
 

 

The parameters dialog box allows defining, besides the radius, the 

circle’s general system parameters, such as visibility level, layer and 

color. For instance, the default drawing settings of visibility are such 

that construction entities with the level defined in the range 0-127 are 

visible (see the command SH: Set Levels). This means, changing the 

level value of the circle being created to “-1”, will hide the circle from 

display, as the level value is not in the range 0-127. 

For already created circles, in command waiting mode point the cursor 

at the circle and  double-click .  The circle parameters dialog box  will  

appear on  the screen.  Change  the level  value to  “-1” and 

 

 

press [OK] to confirm the input. Note that the circle disappeared from display. However, this does not 

mean that the circle is completely removed from the model Move the cursor to the location where the 

circle used to be, and once again click . The circle will be selected, in spite of being invisible. Call the 

parameters dialog box again and set a different value for the visibility level, for example, “0” (zero). Now, 

as you press [OK], the circle becomes visible again. 

Note: to actually make the hidden drawing elements unselectable, set the appropriate value for 

the parameter View > Element selection in the Customize > Set Document Parameters 

command. 

Another way of making a circle invisible is by using layers. Place the circle on a certain layer, and then set 

the layer invisible in the command QL: Configure Layers. To place the circle on a layer, enter the layer 

name either in the Layer entry of the circle parameters dialog box, or in the respective field of the system 

toolbar. 

Another type of a circle often used in base geometry construction is a circle tangent to two lines. In order 

to try creating this type of a circle, begin again with the C: Construct Circle command.  

First, move the cursor over the vertical line that already exists on the 

drawing, and type <L>. The line will get highlighted, and the cursor will 

start rubberbanding a circle locked tangent to the selected line. 

Now move the cursor over the horizontal line and once again type <L>. 

The second line will be selected, and the rubberbanded circle will now be 

tangent to two lines. 
 

The dynamically changing circle radius will be displayed in the coordinate field of the status bar. Note 

that you can move the cursor to any of the four quadrants defined by the lines, and the rubberbanded 

circle will correctly follow the cursor. 
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Now, you can set the circle radius by simply clicking , or by inputting in the property window or the 

circle parameters dialog box (<P>). 

Once the circle is created tangent to two lines, this relation will always be maintained. To witness this, do, 

for example, the following. Exit the command C: Construct Circle. In command-waiting mode, move the 

cursor over the created circle and click . The system will enter the editing command (EC: Edit 

Construction). The circle will be highlighted. Now the user can easily modify its radius by moving the 

cursor. Meanwhile, the tangency to the lines will be maintained. Try doing this several times, moving the 

circle over other quadrants. 

At any moment while rubberbanding the circle in the command 

EC: Edit Construction, one can modify the parameter value (the radius). 

This can be done in transparent mode in the property window, or in the 

parameters dialog (the option ) Instead of a numerical value, a 

variable name or an expression can be used. For example, instead of 

the radius value, one can enter a variable name “R”. 

 

 

After pressing [OK] the system will request the value for the newly 

created variable “R”. One can accept the system default value or 

modify it as desired. 

In future, this will allow using the variable for data exchange with 

external applications or for configuring the drawing when inserting 

into an assembly. Upon confirming the value of the new variable, 

the drawing will be regenerated per the entered radius value.  

From now on, the circle radius is driven by the variable “R”. The value of this variable can be easily 

modified in the command V: Edit Variables. Call the command V: Edit Variables.  

Icon Ribbon 

 

Title Block → Additional → Variables 

Keyboard Textual Menu 

<V> Parameters > Variables 

The variable editor window will come on the screen (see the chapter “Variables”), containing four 

columns: Name, Expression, Value, Comment. The Name entry contains the only existing variable, the 

“R”. The Expression entry displays the number defined at variable creation. The same number is 

displayed in the Value field. Let’s change the value of this variable. Enter a new value, say, “50”. Upon 

confirming the input by <Enter>, the new value will be displayed in the third column, titled Value. 



Circles 

319 

The Comment field may be used for entering information text 

about the current variable. This information is called “the variable 

comment”. The comment is not used in defining geometrical 

relations or regeneration per se, however, it may be quite helpful 

to the user at the time of modifying the drawing. 

Modify the “R” variable several times, exiting the variable editor 

each time by pressing [OK]. The drawing will regenerate each time 

according to the new entered value of the variable. 
 

Constructing Circles  

The command C: Construct Circle provides various options from the following list, depending on the 

current state: 

 <Enter>  Select a node as the circle center 

 <P>  Set circle parameters  

 <L>  Select tangent line  

 <N>  Select a node for the circle to pass through 

 <C> Select tangent circle  

 <E> Select tangent ellipse  

 <S> Select tangent spline  

 <A>  Select symmetry axis (line) to mirror the circle. 

 <O>  Select concentric circle 

 <W> Select 2D projection 

 <Z> Change construction tangency 

 <Space> 
Construct a node at the nearest intersection of two 

construction entities 

 <F4>  Execute Edit Construction command  

 <Esc>  Cancel selection 

 <Esc>  Exit command 

T-FLEX CAD supports the most common circle construction modes, which are: 

-  constructing a circle with the center at a selected node 

-  constructing a circle passing through a selected node  
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The following options initiate these modes: 

 <T> Select a node as the center of the circle 

 <T> Select a node for the circle to pass through 

Upon calling the command, one of the modes is activated by default, as indicated by the pushed icon in 

the automenu. 

Just as with the construction lines, various combinations of a small set of options with a specific circle 

construction mode yield a variety of geometrical dependency sets in the constructed circles: 

<Enter>, <P>  Circle with center at a node, with a specified radius <*> 

<Enter>, <С>  Circle with center at a node, tangent to a circle 

<Enter>, <L>  Circle with center at a node, tangent to a line 

<Enter>, <N>  Circle with center in the nearest node, passing through a node 

<L>,<L>,<P>  Circle tangent to two lines, with a specified radius <*> 

<N>,<L>,<P> 
Circle tangent to a line, passing through a node, with a specified radius 

<*> <**> 

<N>,<C>,<P> 
Circle tangent to a circle, passing through a node, with a specified radius 

<*> <**> 

<N>,<N>,<P> Circle passing through two nodes, with a specified radius <*> <**> 

<C>,<L>,<P> Circle tangent to a line and a circle, with a specified radius <*> <**> 

<C>,<C>,<P>  Circle tangent to two circles, with a specified radius <*> 

<N>,<N>,<N>  Circle passing through three nodes 

<L>,<L>,<L>  Circle tangent to three lines 

<N>,<L>,<L> Circle tangent to two lines, passing through a node <**> 

<C>,<L>,<L> Circle tangent to two lines and a circle <**> 

<C>,<C>,<N> Circle tangent to two circles, passing through a node <**> 

<C>,<L>,<N> Circle tangent to a circle and a line, passing through a node <**> 

<N>,<N>,<L> Circle tangent to a line, passing through two nodes <**> 

<N>,<N>,<C> Circle tangent to a circle, passing through two nodes <**> 

<L>,<S>  

<L>,<E> 
Circle tangent to a line and a spline or ellipse <**> 

<C>,<S> 

<C>,<E> 
Circle tangent to a circle and a spline or ellipse <**> 

<S>,<S> Circle tangent to two splines 

<E>,<E> Circle tangent to two ellipses 

<S>,<E> Circle tangent to a spline and an ellipse <**> 
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<O>,<P>  Circle, concentric with another circle, with a specified radial offset  

<A>,<C> A circle mirrored about a symmetry axis 

<*> - Use of <P> equivalent to <Enter> or . 

<**> - The options <C>,<L>,<N>,<S>,<E> can be used in any order, besides the listed. 

In both circle construction and editing, typing <Z> can be conveniently used for traversing 

configurations within the chosen type of circle construction. For example, two configurations are possible 

when constructing a circle tangent to a line and another circle, with the same cursor position.  The <Z> 

key can be used for switching between these two configurations. 

Tab

               

Similarly, during editing, a circle configuration can be flipped as well. 

Let’s review each way of constructing circles in details. 

Various Ways of Constructing Circles 
Begin with setting the option: 

 <T> Select a node as the circle center 

<Enter>, <P> 

This combination creates a circle with the center in the selected node and the radius defined by either 

placing the cursor and clicking  or entering an exact value in the property window or parameters dialog 

box (the option <P>). To create this type of a circle, point the cursor at the desired node and click . The 

node will be highlighted, and a circle with the center in this node will start rubberbanding. The circle can 

then be fixed manually, by clicking , or exactly, by specifying the radius value in the property window or 

parameters dialog box. 

                                

<Enter>, <С> 

This combination creates a circle with the center at a specified node, and tangent to another circle. Move 

the cursor to an existing node or use the <Space> option for creating a node at the nearest intersection 

of construction entities. Click . This results in rubberbanding a circle with the center in the selected 

node. Move the cursor to a circle to become the tangency reference for the one being created, and type 

<C>. The required circle will be created. Two different configurations are possible, depending on where 

on the tangent circle the cursor was pointing at the time of entering the <С> option. 
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                   or       

<Enter>, <L> 

This combination creates a circle with the center at a node, tangent to a construction line. Move the 

cursor to an existing node or use the <Space> option for creating a node at the nearest intersection. 

Click . A circle will start rubberbanding with the center in the selected node. Move the cursor over the 

line to become the tangency reference for the circle, and type <L>. The required circle will be created. 

                                     

 

<Enter>, <N> 

This combination creates a circle with the center at a node, passing through another node. Move the 

cursor to an existing node or use the <Space> option for creating a node at the nearest intersection. 

Click . This allows you to rubberband a circle with the center in the selected node. Move the cursor to 

the node for the circle to pass through, and type <N> or . The required circle will be created. 

                                     

 

<L>, <N>, <P> for use in the mode of constructing a circle with the center at a node. 

<N>, <L>, <P> for use in the mode of constructing a circle passing through a node. 

Either of the two option combinations creates a circle of a specified radius, tangent to a line and passing 

through a node. Subsequently select a line and a node, using the options <L> and <N> respectively. 

Then specify the radius either by a click  or by inputting the exact value in the property window or 

parameters dialog box (the option <P>). 

                                 

Please note that the node may belong to the line, which is often the case in drawings. 
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<C>, <N>, <P> for use in the mode of constructing a circle with the center at a node. 

<N>, <C>, <P> for use in the mode of constructing a circle passing through a node. 

Either of the two option combinations creates a circle of a specified radius, tangent to a circle and 

passing through a node. Subsequently select a circle and a node, using the options <С> and <N> 

respectively. Then specify the radius either by a click  or by inputting the exact value in the property 

window or parameters dialog box. Please note that different configurations are possible, depending on 

where on the entities the cursor was pointing at the selection time. 

                  

                 

 

Now set the option: 

 <T> Select a node for the circle to pass through 

 

<N>, <N>, <P> 

This combination creates a circle of a specified radius, passing through two nodes. Move the cursor over 

the first node and type <N>. Repeat for the second node. Then define the circle radius. Do this by 

specifying approximately by clicking  or exactly in the property window or parameters dialog box (the 

option <P>). 

                             

 

<N>, <N>, <N> 

This combination creates a circle passing through three nodes. Move the cursor over the first node and 

type <N>. Repeat for the second and third node. 
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<L>, <L>, <N> for use in the mode of constructing a circle with the center at a node. 

<N>, <L>, <L> for use in the mode of constructing a circle passing through a node. 

This combination creates a circle tangent to two lines and passing through a node. Move the cursor over 

the first line and type <L>. Repeat for the second line. Then specify the node via <N>. Note that the 

order of typing the option keys may vary. 

                                 

 

<L>, <N>, <N> for use in the mode of constructing a circle with the center at a node. 

<N>, <L>, <N> for use in the mode of constructing a circle passing through a node. 

<N>, <N>, <L> for use in the mode of constructing a circle passing through a node. 

This combination creates a circle tangent to a line and passing through two nodes. Move the cursor over 

the line and type <L>. Then use the option <N> twice for selecting the nodes. Note that the order of 

typing the option keys may vary. 

                                   

 

Regardless of what construction mode the system is in, the circles can also be created in the following 

ways: 

<L>, <L>, <P> 

This combination creates a circle of a specified radius, tangent to two non-parallel 

lines. To create a circle, move the cursor over the first construction line and type 

<L>. Repeat for the second line. Then define the circle radius either by clicking  or 

by inputting in the property window or parameters dialog box (the option <P>). 

Four various configurations are possible. 

 

                                       

<L>, <С>, <P> 

<С>, <L>, <P> 

Either of the two option combinations creates a circle of a specified radius, tangent to a line and a circle. 

Subsequently select a line and a circle, using the options <L> and <С> respectively. Then specify the 

radius either by clicking  or by inputting in the property window or parameters dialog box (the option 

<P>). Various tangency configurations are possible. 
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<С>, <С>, <P> 

This combination creates a circle of a specified radius, tangent to two 

circles. Move the cursor over the first circle and type <С>. Repeat for 

the second circle. Then specify the radius – approximately, by clicking 

, or exactly, by inputting in the property window or parameters 

dialog box (the option <P>). This type of circle construction is most 

plentiful in resulting circle configurations. 

Getting the desired one among various tangency types is done by 

appropriately positioning the cursor when selecting. In some cases, as, 

for instance, in the case of a surrounding circle, an appropriate 

selection gets easier when zoomed well out with the command “ZW: 

Zoom Window”. 

 

                                         

 

<L>, <L>, <L> 

This combination creates a circle tangent to three lines. Move the cursor over the first line and type <L>. 

Repeat for the second and the third line. When selecting the lines, pay attention to the cursor position, 

which should be on the side of line intended for the circle location.  

                                       

 

<L>, <S>, <P> or <S>, <L>, <P> for constructing a circle tangent to a line and a spline. 

<L>, <E>, <P> or <E>, <L>, <P> for constructing a circle tangent to a line and an ellipse. 

This combination creates a circle tangent to a line and a spline or an ellipse. Subsequently select a line 

and a spline (ellipse), using the options <L> and <S> (<E>) respectively. Then specify the radius either by 

a click  or by inputting in the property window or parameters dialog box (the option <P>). 
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<C>,<S>,<P> or <S>,<C>,<P> for constructing a circle tangent to a circle and a spline. 

<C>,<E>,<P> or <E>,<C>,<P> for constructing a circle tangent to a circle and an ellipse. 

This combination creates a circle tangent to another circle and a spline or an ellipse. Subsequently select 

a circle and a spline (ellipse), using the options <C> and <S> (<E>) respectively. Then specify the radius 

either by a click  or by inputting in the property window or parameters dialog box (the option <P>). 

                        

 

<S>,<E>,<P>  or <E>,<S>,<P>  for constructing a circle tangent to a spline and an ellipse. 

<S>,<S>,<P>                for constructing a circle tangent to two splines. 

<E>,<E>,<P>                     for constructing a circle tangent to two ellipses. 

This combination creates a circle, tangent to two splines or ellipses. Subsequently select the intended 

entities, spline(s) and/or ellipse(s), using the options <S> and/or <E>. Then specify the radius either by 

clicking  or by inputting in the property window or parameters dialog box (the option <P>). 

                           

 

<O>, <P> 

This combination creates a circle, concentric to a selected one, with the specified radius offset. Move the 

cursor over a circle and type <O>. Then define the radius offset by a click , or by an input in the 

property window or circle parameters dialog box (the option <P>). 

                        

The offset is considered negative for the circles within, positive for the ones outside the defining circle. 
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<A>, <C> 

This combination creates a circle, mirrored from another circle about a straight line. To select the 

symmetry axis, move the cursor over a line and type <A>. Then select a circle using <С>. 

                             

Circles Constructed Based on 2D Projection, 2D Fragment or Copy 
Such circles can be created in the object snapping mode, if the respective flag is set in the command 

SO: Set System Options on the Snap tab. Move the cursor over a graphic entity – a circle or an arc on a 

2D projection, 2D fragment or a copy. The entity will be pre-highlighted. Clicking  at that moment 

creates a circle based on the selected entity. 

              

If the object-snapping mode is off, then circles can be created based on 2D projection entities only. To 

do so, use the option  and select the desired projection on the drawing. The selected projection will 

be highlighted, and the cursor will gain the glyph . Now, to create a circle, simply point the cursor at a 

projection entity – arc or circle - and click . 

The following options will then become available in the automenu: 

 <P> Set Circle parameters 

 <Esc> Cancel selection 

Circle Parameters 

Various parameters need to be defined when creating or editing circles. The geometrical parameters – 

the radius or the offset for concentric circles can be defined in the transparent mode via the property 

window. However, the general system parameters can only be accessed via the  option that provides 

access to all circle parameters via a dialog box. 
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Radius. Defines the circle radius. Allows numerical value, 

variable or expression input. 

Level. Places the circle being created on a certain visibility level, 

used for hiding certain elements from display when 

necessary. 

Layer. Is used for linking the circle being created to a certain 

layer. 

Color. This parameter defines the color of displaying the circle 

on the screen. 

Set as default. When this flag is set, the parameters defined in 

this dialog box will be used in creation of new construction 

entities (except the Radius parameter). 

 

Editing Circles 

The same command EC: Edit Construction is used for editing circles as for any other construction 

entities. We have already reviewed the capabilities of this command on the example of editing 

construction lines in the previous chapter. Editing circles is done in a similar way. 

Besides, when editing a circle tangent to two lines, the automenu gains additional options for setting and 

clearing a “link” with a node: 

 <G> Link Arc or Circle to Node 

 <B> Break Link with Node 

The option  is used for constraining a circle, tangent to two lines, by an additional node defining the 

tangency configuration. Upon calling the option, select the desired node by clicking . The circle will be 

reconstructed as the result of using this option to pass as close to the node as possible. This allows to 

uniquely define the circle location with respect to the reference lines. 

The example below explains the use of this capability. The location of the lines on the drawing is defined 

with respect to the symmetry axis using a parameter K. Both circles are constructed tangent to the two 

lines. Besides, the solid-drawn circle is “linked” to the highlighted node. Meanwhile, no reference node is 

defined for the second circle. Originally, with the variable K=1, the drawing looks like shown on the 

diagram on the left-hand side. The right-hand side diagram shows the drawing modification per the new 

variable value К=-1. The circle linked to the node adjusted correctly. The second circle that did not 

reference any node, flipped with respect to the symmetry axis. 
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To release or re-assign a link with a node, use the option . 



T-FLEX CAD Brief Introductory Course 

330 

ELLIPSES 

Ellipses in T-FLEX CAD are constructed similar to circles - by defining their geometrical relations with 

other construction entities. Examples of such relations are the ellipse center being snapped to a node, 

tangency to a line, tangency to a circle, passing through a node, symmetry with another ellipse. Ellipses, 

like other construction entities, are displayed in a thin dashed line. 

Ellipses in T-FLEX CAD can be divided into two types: 

- Ellipses whose size is defined by numerical parameters; 

- Ellipses whose position and size are defined by geometrical relations. 

Constructing Ellipses 

To construct an ellipse, use the command EL: Construct Ellipse. The command can be called by one of 

the following means: 

Icon Ribbon 

 

Draw → Construct → Ellipse 

Keyboard Textual Menu 

<EL> Construct > Ellipse 

 

T-FLEX supports most common ellipse creation modes, that are: 

- Constructing an ellipse with the center at a node; 

- Constructing an ellipse passing through a node. 

These modes correspond to the following options: 

 <T> Select Centre Ellipse Node 

 <T> Select Node of Ellipse 

Upon calling the command, one of the modes activates automatically, as indicated by the pushed icon in 

the automenu. 

Ellipses Construction Techniques 
The following techniques can be used in the mode of constructing ellipses with the center at a node: 

1. Center at node, through node, using parameter 

This way of constructing an ellipse is realized in the following sequence of options: 

<Enter><Enter><Enter> or <Enter><Enter><P> 

This combination creates an ellipse with the center at a node, with the first semi-axis ending at a node, 

and the second defined by a parameter. To create this type of ellipse, select the desired node. The node 
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will highlight and an ellipse begin rubberbanding with the center at the selected node. After that, select 

another node for the ellipse’s first semi-axis to pass through. Then move the cursor over desired position 

and click  or use <P> option.  

                   

In the latter case, the parameters dialog box will appear on the screen allowing to enter an exact 

parameter value. If the mouse click  was used for defining the ellipse then the numerical value for the 

ellipse parameter is derived from the cursor position. The property window can be used for defining the 

geometrical parameter of the ellipse (the semi-axis length) in transparent mode instead of using the 

option <P>. 

The same way of constructing an ellipse can be realized by the following sequence of options: 

<Enter><N><Enter> or <Enter><N><P> 

      

N

             

2. Center at node, through two nodes 

Upon calling the command, use the following sequence of options: 

<Enter><Enter><N> or <Enter><N><N> 

These combinations create an ellipse with the center at a node, the first semi-axis ending at a node, and 

the second through another node. To create this type of ellipse, select the desired node as the ellipse 

center. Next, select another node for the ellipse’s first semi-axis to pass through. The node can be 

selected using the option <Enter> or <N>. Then move the cursor over the node defining the position of 

the second semi-axis and type <N>. The required ellipse will be created. 

            
N

       

3. Ellipse with the center at a node, passing through node, tangent to line 

Upon calling the command, use the following sequence of options  

<Enter><Enter><L> or <Enter><N><L> 

These option combinations create an ellipse with the center at a node, the first semi-axis ending at a 

node and the second semi-axis defined by tangency to line. To create this type of ellipse, select the 



T-FLEX CAD Brief Introductory Course 

332 

desired node as the ellipse center, then use the option <Enter> or <N> and select another node for the 

ellipse’s first semi-axis to pass through. Then move the cursor over the line to be making tangency with 

the ellipse and type <L>. The required ellipse will be created. 

            

L

       

4. Ellipse with the center at a node, tangent to line, using parameter 

Upon calling the command, use the following sequence of options: 

<Enter><L><Enter> or <Enter><L><P> 

These option combinations create an ellipse with the first semi-axis defined by tangency to a line at the 

tip of the semi-axis and the second semi-axis driven by the parameter. To create this type of ellipse, first 

select the desired node as the ellipse center. Next, use the <L> option and select the line making 

tangency with the ellipse at the tip of the semi-axis. Then move the cursor over desired position and click 

. The exact value of the second semi-axis length can be entered in the property window in transparent 

mode or in the parameters dialog box (the option <P>). The required ellipse will be created. 

      

L

             

5. Ellipse with the center at a node, tangent to line, passing through node 

Upon calling the command, use the following sequence of options: 

<Enter><L><N> 

This combination of options creates an ellipse with the first semi-axis defined by tangency to a line at the 

tip of the semi-axis and the second semi-axis ending at another node. To create this type of ellipse, first 

select the desired node as the ellipse center, and then select the line making tangency with the ellipse at 

the tip of the semi-axis. After that, select a node to define the position of the ellipse’s second semi-axis. 

The required ellipse will be created. 

      

L

      
N
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The following techniques can be used in the mode of constructing ellipses passing through a node: 

1. Ellipse passing through two nodes, using parameter 

Upon calling the command, use the following sequence of options: 

<Enter><Enter><Enter> or <Enter><Enter><P> 

or <N><N><Enter> or  <N><N><P>  

These combinations create an ellipse, passing through two nodes, with the second semi-axis defined by a 

parameter. To create this type of ellipse, move the cursor over the first node and press the option 

<Enter> or <N>. Next, with the same options select the second node. Then move the cursor over desired 

position and click . To enter the exact value of the second semi-axis length, use the property window or 

the parameters dialog box (the option <P>). The required ellipse will be created. 

                     

2. Ellipse passing through three nodes 

Upon calling the command, use the following sequence of options: 

<Enter><Enter><N> or  <N><N><N>  

These option combinations create an ellipse passing through two nodes, with the second semi-axis 

defined by the condition of passing through the third node. To create this type of ellipse, select three 

nodes using the  <N> option (the first and second nodes can also be selected by the option <Enter>). 

                 

N

           

3. Ellipse passing through two nodes, tangent to line 

Upon calling the command, use the following sequence of options: 

<Enter><Enter><L> or  <N><N><L>  

These option combinations create an ellipse, passing through two nodes, with the second semi-axis 

defined by tangency to the line at the tip of the semi-axis. To create this type of ellipse, use the option 

<Enter> or <N> and select the first node, then, using the same options, select the second node. After 

that, move the cursor over the line that will be making tangency with the ellipse at the tip of the second 

semi-axis. The required ellipse will be created. 
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L

             

Another two types of ellipses can be constructed in any ellipse creation mode: 

1. Ellipse tangent to a circle, passing through node 

Upon calling the command, use the following sequence of options: 

<C><N> 

This set of options creates an ellipse with the first semi-axis defined by the radius of a circle concentric 

with the ellipse. The second semi-axis is defined by selecting its end node. To create this type of ellipse, 

select an existing circle using <C> option, and then move the cursor over the node to become the end of 

the second semi-axis, and type <N>. The required ellipse will be created. 

C

        

N

         

2. Ellipse, tangent to a circle and a line 

Upon calling the command, use the following sequence of options: 

<C><L> 

This set of options creates an ellipse with the first semi-axis defined by the radius of a circle concentric 

with the ellipse. The second semi-axis defined by tangency to a line. To create this type of ellipse, select 

an existing circle using <C> option, and then move the cursor over the line to define tangency to the 

ellipse, and type <L>. The required ellipse will be created. 

C

        

L

          

When creating ellipses by any of the above means, you can select elements using the following icons: 

 <N> Select Node 

 <C> Select tangent Circle 

 <L>  Select tangent Line 

 <A> Select axis of symmetry (straight Line) 
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Object snapping mode can be used as well. 

Ellipses Created from 2D Projection, 2D Fragment or Copy 
Such ellipses can be created in object snapping mode, provided that the appropriate parameter is set on 

the Snap tab of the command SO: Set System Options. Move the cursor over a graphic entity – full 

ellipse or elliptic arc that is part of a 2D projection, 2D fragment or copy. The line will highlight. Click . 

An ellipse will be created on top of the selected entity. 

              

If the object-snapping mode is off, then only 2D projection entities can be used for creating an ellipse. 

This is done by selecting the desired projection on the drawing using the  option. The selected 

projection will highlight and the cursor will gain a glyph . To create a construction line now, simply 

point the cursor to a projection entity – ellipse or elliptic arc and click . 

 

The following options will become available in the automenu: 

 

 <P> Set ellipse parameters  

 <Esc> Cancel selection 

Ellipse Parameters 

When creating or editing ellipses, one can control various parameters. The geometrical parameter (the 

semi-axis length) can be defined in transparent mode using the property window. The general system 

parameters are controlled via the complete ellipse parameters dialog box via the option: 

 <P> Set ellipse parameters 
 

Axis. The length of one of the ellipse’s semi-axes. The input can be a number, a variable or an 

expression. 

Value. Displays the numerical value of the “Axis” parameter. 

Level. Places the ellipse on a certain visibility level. 

Layer. The name of the layer the ellipse belongs to. 

Set as default. Setting this flag means, the current dialog box settings will be used as the defaults 

for ellipses creation in future. 
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Editing Ellipses 

Editing ellipses, just like any other construction entities is done via the command EC: Edit Construction. 

Keyboard Textual Menu Icon 

<EC> 
“Edit > Construction > 2D 

Construction”  

This command allows changing ellipse parameters, assigning a name to an ellipse and deleting it.  

An ellipse can be selected by pointing at with the cursor and clicking  or via the option: 

 <E> Select Ellipse 

The ellipse editing command, EC: Edit Construction, can also be accessed from within the command 

EL: Construct Ellipse via the option: 

 <F4> Execute Edit Construction command 

Detailed description of the command EC: Edit Construction can be found in the earlier chapter “Lines” 

(section “Editing Lines”). 
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NODES 

Node is a point whose coordinates are calculated depending on the node parameters or position of 

other model elements. Nodes are important construction elements in T-FLEX CAD. They represent start 

and end points of graphic lines. Nodes are directly involved in creation of most of the graphic elements. 

They also play an important role in creation of construction entities. 

Creating Nodes 

T-FLEX CAD supports nodes of various types, depending on the relation with other model elements. 

Most common are nodes constructed at an intersection or at a tangency point between two construction 

lines. Such nodes are displayed as small x-shape crosses.  

                     

Other types of nodes are displayed differently on the screen. 

There are following types of nodes: 

Node at intersection of construction lines. Such nodes are used most often in creation of 

parametric models. Its position is defined by the position of two construction entities and 

their intersection to which the node is related. In the case of multiple intersections between 

the entities, the particular intersection shall be identified. 

Free node is defined by the absolute X and Y coordinates in the model coordinates. The values of 

a free node coordinates can be defined by variables. Such nodes are of limited use in 

parametric models being created, however, these are widely used in development of 

sketches, various diagrams and technical figures. Free nodes are useful in the cases when 

there is no strict requirement on positioning points of the image. 

Node from fragment is defined by the position of another node located on a fragment of an 

assembly. This type of node is necessary for creation of parametric assemblies. It is used for 

relating some element of an assembly with a point on a fragment of this assembly. 

Node created relative to another node. Its position is defined by an offset from another node. 

The offset values can be defined by constants or by variables. A node of this type can be 

used as an auxiliary fixing point in the cases when some element should be snapped at an 

offset position of the base node rather than to that node directly. 

Node lying on a construction entity, at the specified distance from another node along the 

entity. 

Node – a characteristic point of a construction entity. Among this type are nodes lying at a 

circle or ellipse center, at a start or end point of a spline or other curve. 

Node on a curve, dividing the curve in a specified proportion. 
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Nodes placed at characteristic points of elements. This type includes nodes on dimension 

witness lines, on leader notes, at the ends of lines created by copying, etc. 

Node dividing the distance between two other nodes in a given ratio. 

For a point to become a node, the node needs to be created. This can be done in various ways: 

By the command N: Construct Node, specifically designed for creating nodes. 

By the option <Space> in the commands L: Construct Line and C: Construct Circle. In these commands, 

you can move the cursor over an intersection point of construction entities and press <Space>. 

In the command G: Create Graphic Line when creating a graphic line. 

In the command H: Create Hatch when creating a hatch. 

In the command FR: Create Fragment. As you add a drawing as a fragment into the current drawing, you 

can automatically create nodes from fragment in the drawing.  

The last three techniques are described in the chapters that follow. In this chapter we will review in 

details the command N: Construct Node.  

Icon Ribbon 

 

Draw → Construct → Node 

Keyboard Textual Menu 

<N> Construct > Node  

Upon calling the command, the following options become available in the automenu: 

/  <Ctrl><F> Free mode on/off toggle 

 <P> Set Node parameters 

 <L> Select Line to create Node 

 <C> Select Circle to create Node 

 <E> Select Ellipse to create Node 

 <S> Select Spline to create Node 

 <N> Select Node for relative Node creation 

 <F> Select Fragment to create Node 

 <R> Select Fragment from list 

 <W> Select 2D Projection 

 <F4> Execute Edit Node command 

 <Esc> Exit command 
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The option /  allows selecting the drawing mode - “free” or 

“constrained”. The current mode is indicated by the kind of the 

option icon displayed in the automenu. 

The option , called prior to node creation, opens a dialog box 

for defining the system-wide parameters, such as layer, level, color 

for new nodes. The same dialog allows to define position of various 

types of nodes being created. 

 

Clicking  constructs a node at the nearest intersection point of construction entities, while in 

“constrained” drawing, or construct a node at the position on the drawing directly under the cursor in 

“free” drawing. 

 

The options , ,  and   allow creating nodes lying on the selected entities. 

 

To construct a node relative to another node, and also a node dividing the distance between two other 

nodes in a given ratio, the option  is used. 

The options ,  and  help creating nodes based on fragments and on the lines of 2D 

projections. 

Nodes Based on Construction Entities 

There are two main ways of creating nodes at intersections of entities in the command N: Construct 

Node: 

1. Move the cursor over an intersection of two 

entities and click . A node is created at this 

point.                  

2. Subsequently create two construction entities. The node is created at their intersection point. 

Should there be two or more intersections, the one is used that was nearest to the cursor at 

the time of the last entity selection. The options used for selecting various-type construction 

entities are , ,  and . 

3. The second way of creating nodes is recommended on crowded drawings and in the cases 

when more than two entities intersect in one point. 
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Examples of node creation: 

<L>,<L> 

                         
 

<L>,<C> 

                    
 

<C>,<C> 

                        
 

To create a node on a construction circle, select the circle using the option . 

A node will start rubberbanding along the circle. The position of the node on the 

circle can be defined roughly by mouse clicking , or exactly in the property 

window or in the parameters dialog box (the option ). 
 

To construct a node at a circle center, select the circle and then use the option 

 again. With snapping turned on, move the cursor over the center of the 

circle. The cursor will get the circle mark and the respective tooltip. Clicking  

now creates the node. 
 

To construct a node at the start or end point of a spline or other curve, select the curve by clicking it with 

. A cross-shape node will start rubberbanding along the curve. Move the cursor over one of the 

endpoints of the selercted curve and engage the option 

 <Т> Select Curve to create end Node 

To construct a node on a curve, select the curve, and then define the position of the node on the curve. 

The position of the node can be roughly defined by , or specified exactly in the property window or the 

parameters dialog box (the option ) by entering the parameter of the node on the curve in the range 

from 0 (the start point of the curve) to 1 (the end point). 

            

Т
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To construct a node relative to another node, with the specified offsets, select 

the reference node for offsetting using the option . A cross-shape node will 

start rubberbanding on the screen with a dashed rubberband connecting it to 

the reference node. The offsets can be defined freely by clicking  or entered 

exact in the property window. The offset values in the property window can be 

specified by constants or variables. 

 

                             

or 

                                  

To construct a node that divides the distance between two other nodes in a given ratio, it is necessary to 

successively select two original nodes by using the  option. After selection of the second node, on the 

screen will appear the image of the node in the form of a small cross dynamically following the cursor. 

The node will move strictly along the line that goes through two selected nodes. The location of the 

node along the line can be set arbitrarily by pressing  or by specifying in the properties window the 

exact value of the coefficient according to which the node being created will divide the segment between 

two original nodes.  

                                

The node that divides the distance between two other nodes can also be constructed in case when the 

original nodes lie on the same line. The resulting node will also belong to this line.  To create such a node 

it is required to successively select the first node (the  option), then select the line (the  option), 

then the second node (the  option). Location of the node is specified in the same way as in the 

previous case. 

In the command of node editing ЕN: Edit node there is a capability of selection of node’s snapping: the 

snapping can be associated with intersection of construction lines, circle center, intersection of two snaps 

(for example, two perpendicular lines), etc. Possible snaps are highlighted with a color when the cursor of 

the mouse points at them and the command ЕN: Edit node is active. 

To delete a node or change its parameters, use the command ЕN: Edit Node: 
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Keyboard Textual Menu Icon 

<EN> “Edit > Construction > Node”  

Selecting a node by  highlights the node and the construction entities whose intersection defines the 

node position. At an attempt to delete a node referenced by other drawing elements, a dialog of the 

command for deleting the elements will emerge on the screen with specification of dependent elements 

and a list of possible actions of the system. 

 

One can also select a node for editing from the command EC: Edit Construction. Using the option <N> 

in the command EC: Edit Construction automatically brings the system into the command ЕN: Edit 

Node. 

Nodes and other construction entities can be hidden at any time. To do this, enter the command 

SH: Set Levels and set the lower limit of the visible levels for “Construction” greater than the 

“Level” parameter value assigned to these entities. By default, all elements have level “0”. Setting 

the lower limit of the visibility range simply to “1” hides construction entities from display. 

One can also use layers for making construction entities invisible. Place those on some layer, for 

example, “Construct”, and then make this layer invisible in the command QL: Configure Layers. 

The display size of node symbols can be modified. To do this, use the command SO: Set System Options. 

The size in pixels can be specified in the item 2D > Node size in the command dialog. 
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If extra nodes or construction entities were created for some reason along the design process, these can 

be quickly deleted using the command PU: Delete Unused Construction. 

Icon Ribbon 

 

Edit → Additional → Purge 

Keyboard Textual Menu 

<PU> Edit > Purge 
 

This command will delete all construction entities that 

are not used in the model for defining graphic 

elements. 

       

“Free” Nodes 

The main approach to creating drawings in T-FLEX implies use of nodes on the 

intersections of construction entities. However, the system also supports so-

called “free” nodes. These nodes are not the points of entity intersections; rather, 

these are defined in absolute coordinates. Such nodes can be used just as well as 

usual “constrained” nodes for creating either construction entities or graphic 

elements. Free nodes are displayed as squares. 

 

To create such nodes, turn on “free” drawing mode in the command N: Construct Node by using the 

option / . 

Object snapping engages in free drawing mode similar to that provided in the sketching command. 

Besides, one can use the grid, with its settings defined in the command QG: Change Grid settings. The 

grid helps positioning created nodes more accurately. 

To create a node, point the cursor to the desired location on the drawing and 

click . The node will be created right under the cursor. The exact position of 

the node on the drawing can be specified in the property window. 
 

A feature of “free” nodes is the provision for moving such node or a group of nodes and, therefore, all 

elements related to them, by the command ЕN: Edit Node. 

          

This is impossible for “constrained” nodes. The latter can only be moved by relocating construction 

entities used for the nodes creation. 
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As in the case of other drawing elements, multiple selection is done by the option <*>, or by clicking  

while holding down the <Shift> key (adding to the list of selected), or <Ctrl> key (excluding form the list 

of selected). Generally speaking, the following options are available in the command ЕN: Edit Node: 

 <P> Set selected Element(s) Parameters 

 <V> Dynamic model regeneration mode 

 <O> Create name for selected element 

 <J> Join free nodes 

 <B> Break node 

 <F> Convert to free node 

 <N> Select existing node 

 <I> Select Other element 

 <Del> Remove selected Element(s) 

 <Esc> Cancel selection  

The mode of dynamic recalculation is enabled by the  option. When enabling this mode the node’s 

editing automatically leads to redrawing of the elements connected with the node. At the same time 

preview of the elements is shown with the same quality as the final result. The mode of dynamic 

recalculation of the model enhances the editing’s process intuitiveness. It can be used for editing, for 

example, schemes, plans, etc. 

Let us elaborate on the options  and . These options affect a group of nodes, one of which can be 

constrained, and the rest - “free”. The option  unites several nodes into one, adjusting the graphics 

accordingly. 

              

The option  splits a node at a meeting point of multiple graphic entities. Each of the entities gets its 

own node whose position you can modify.  

Keep in mind that “free” nodes are not recommended for use in parametric drawings. Drawings based on 

free nodes are similar to those supported by other CAD systems, and lack the advantage of parametric 

geometrical relations. 

The option  is available for nodes, not related to construction entities (for example, nodes from 

fragment or from 2D projection). This option allows breaking the relation between the node and its 
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original references by converting it into a free node, whose position will not change under modifications 

to the original reference elements. 

The option  is an additional tool for multiple selections. To add a node to the list of selected, simply 

engage this option and pick the desired node. 

Nodes from Fragment. Node Names 

This way of node creation is quite important for support of parametric assemblies. The nodes from 

fragments provide the means for “tying up” construction entities and graphic elements of the current 

assembly to the fragment. 

Nodes from a fragment can be created automatically when inserting a fragment if in the settings 

of the system (the SO: Set System Options command, the Fragments tab) the Create named 

nodes automatically flag is enabled. In this case while inserting the fragment the nodes will be 

created on the basis of all named nodes of the fragment. 

In addition, nodes from a fragment can be created automatically while creating dimensions and 

other elements with the use of object snapping if in the SO: Specify system settings command, 

the Snaps > Priority tab, the Fragment nodes parameter is enabled. When this flag is disabled, 

then for creation of nodes on the fragments we need to perform the actions described below. 

For example, you assembled a bushing on your drawing by the command FR: Create Fragment, and now 

want to create a dimension on the outer diameter of the bushing. 

                        

Since a dimension can’t be created without nodes, you need to create two nodes from this fragment. 

Nodes from fragment can be created in the command N: Construct Node. With the object snapping 

mode engaged and the flag Fragment Nodes set (the tab Snap > Priority of the command SO: Set 

System Options), a node from fragment is created as follows. Move the cursor over an end of a fragment 

graphic line. A node will highlight at the end of the line, with a tooltip saying “Fragment Node”. Clicking 

 creates a node from fragment. 

With the object snapping mode off, first select a fragment via either of the options,  or . The 

selected fragment will be highlighted. 

 

If the fragment contains the named nodes, they will immediately be seen on the drawing. If necessary, it 

is also possible to display on the drawing the names of these nodes by enabling the option: 

 <M> Show Fragment Node Names 
 



T-FLEX CAD Brief Introductory Course 

346 

After that, nodes from the fragment can be created by pointing the cursor to the desired 

nodes among the highlighted ones and clicking . 

Created nodes from fragment are displayed as crossed diamonds. 

 

The option <A> highlights and makes available for selection all nodes that exist in the fragment. 

 <A> Show all Fragment Nodes 

To assign a name to a node of a fragment drawing, use the following option under the command 

ЕN: Edit Node: 

 <Ctrl><N> Create Name for selected Element 

 

Any name is allowed. The node now becomes named and can later be “exposed” upon assembling this 

drawing elsewhere. 

Once the nodes from fragment are created, make the dimension via the command D: Create Dimension: 

             

Nodes from 2D Projections 

To create nodes based on the entities of 2D projections, one can use the option . Upon calling the 

option, select the desired projection by . The selected projection will be highlighted.  After that, moving 

the cursor over the endpoints of graphic entities on the projection will highlight their nodes. Clicking  

creates a node from projection. 

 

Option  allows the user also to project nodes from a 3D model. After calling the option and selection 

of projection, it is sufficient to indicate a required 3D node (in 3D window or in the tree of a 3D model). A 

free node, which is a projection of the given 3D node, will appear on 2D projection. 
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Nodes Lying on Characteristic Points of Entities 

Such nodes can only be created in the object snapping mode. This type of nodes includes nodes lying on 

dimension witness lines, leader notes, tolerances, as well as on the endpoints of graphic lines copied 

from or belonging to 2D projections; and also the nodes at the center of the construction line of a circle 

or an ellipse, the nodes at the end/start points of the spline and other curves. The respective option 

should be checked on the Snap > Priority tab under the command SO: Set System Options. 
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SPLINES 

Main Concepts 

The construction spline entities allow creating various curves. Unlike the straight construction lines, the 

splines have finite length. In general, spline-handling techniques are not different from those used for 

other construction entities. Nodes are created at intersections and tangency points. Graphic entities and 

hatch contour segments can be constructed along splines. Spline selection is done in many commands 

using the <S> option (the same key is used for selecting other curves as well, such as functions, offset 

curves and paths). T-FLEX uses NURBS-type splines. 

A spline is created based on a set of nodes that represent the defining points of the spline. Therefore, 

modification of the node positions will result in a change to the shape of the curve constructed based on 

these points. 

Splines belong to two main types: passing through the nodes directly and using the nodes as vertices of 

the control polygon. 

                               

There are also closed splines. 

 

End-point conditions can be defined for splines through points via 

tangency vectors that are constructed based on nodes as well. 

 

The control polygon nodes can be assigned weights. The more the 

node’s weight, the closer the curve will pass to this node than to the 

neighboring ones. Vise versa, the lesser the weight, the smaller is the 

influence of the node on the curve shape. 
 

Splines appear on the drawings as polylines made of numerous straight segments. The number of 

segments and, therefore, the accuracy of the output can be controlled by specifying the number of 

tessellation segments between a pairs of neighboring defining nodes. Each section of the spline will be 

tessellated by this number of segments when output. The more segments are used, the higher quality 

and accuracy will be achieved in the image. However, a too high number of segments may cause delays 

in spline handling by the system. 
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Constructing Splines 

When creating spline, one can either use the existing nodes or automatically create new ones (free nodes 

or at construction line intersections).  

Call the command SP: Construct Spline: 

Icon Ribbon 

 

Draw → Construct → Spline 

Keyboard Textual Menu 

<SP> Construct > Spline 

The following options become available to the user: 

,  <Ctrl><F> Free mode on/off toggle 

  <N> Select Node  

  <P> Set Spline parameters. 

 <T> Click to select tangent Node. 

 <O> Create Spline in Polar Coordinate System 

 <A> Select axis of symmetry (straight Line) 

 <G> Select Graphic line 

 <F4>  Execute Edit Construction command 

 <Esc>  Exit command 

Upon entering spline creation command, the user can use  or <N> in 

order to set the defining nodes of the spline. The curve being created will 

be rubberbanding on the screen. In the case of control polygon type 

splines, the polyline will be displayed along with the spline curve. 

Now, the option for finishing the spline input becomes available in the 

automenu that can be used for completing spline creation. 

N
 

 

 

<Ctrl+ 

Enter> 
Finish Spline input 
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When creating a control polygon type spline, the weights of each particular point can be defined with the 

help of <P> option. 

To define a spline with end-point tangency conditions, follow these steps: 

Use the option  to define start tangency direction. 

 

Specify the desired sequence of nodes (two minimum). 

 

Use the option  and define the end tangency condition. 

 

To construct a spline in a polar coordinate system, use the option . This option allows creating a 

spline passing through two points with tangency directions defined there. To create such a spline, define 

a coordinate system, the start and end points of the spline and the tangent angles at the ends. The 

angles are defined in the polar coordinate system by the ratio of degrees to millimeters. This way of 

defining a construction entity may be used, for instance, in camshaft design. 

                             

To create symmetrical splines, first engage the option  and select the symmetry axis, and then select 

the desired spline. 

A

                           

Please note special issues in creation of closed splines. If the start point was selected as the end point as 

well, the spline will be closed yet not necessarily smooth at the start-to-end connection. To impose such 

smoothness, set “Closed” option in the parameters dialog box and do not connect the rubberbanded 

spline to the start point. 
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Spline Parameters 
 

 

The parameters of a spline created in a Cartesian coordinate system 

can be defined or modified via the  option. 

Type. This parameter defines the spline type (By polygon, Through 

nodes). The type can only be selected at creation time.  

Next stands the spline option – Open or Closed. 

Number of segments defines the number of tessellation segments 

between two neighboring spline nodes on a plot. This parameter 

can be defined by a variable. 

Point weight. This item is used in creation of splines by control 

polygons. The weight parameter must be greater than zero. 
 

 

Level, layer and color are defined and used in the same way as in 

all the rest construction entities. 

A different set of parameters is used for splines defined in polar 

coordinates, as follows: 

Spiral. With this flag set, a spiral is constructed with the center in 

the first point, start in the second point, and the end in the third 

point. Without this option, the following two parameters are 

used: 

Tangency at start. Tangency at end. Define the angles from 

horizontal of the tangencies in the spline end points. 

Level, layer and color are defined and used in the same way as in 

all the rest construction entities. 

 

Editing Splines 

Editing splines includes changing spline shape, adding or deleting defining nodes and modifying various 

parameters. 
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Spline editing is done in the command EC: Edit Construction. 

Once a particular spline is selected for editing (by pointing to with the cursor and 

clicking ), then the spline curve will be highlighted together with the defining 

nodes. 

The following options become available in the automenu: 
 

 

 <Enter> 
Select the nearest defining node of the spline to 

modify  

  <P> Set construction Line parameters 

 <V> Dynamic model regeneration mode 

 <Y> Create Name for selected Element  

 <I> Selected Other Element 

 <Del>  Delete selected Element(s) 

 <Esc>  Cancel selection 

Once a defining node of the spline is selected by clicking , it can be reassigned by selecting another 

node, delete, or add a new one. Once a defining node is selected, the spline begins rubberbanding, 

following the cursor, just like at creation time. A following mouse click  selects another node or creates 

a new one. For convenience, the old node gets deleted if it was not referenced by any other element. 

                   

Note that the node position and, therefore, the shape of the curve, can be modified in the node editing 

command EN: Edit Node. 

To add a new defining node use the option <I>. 

 <I> Switch to “Insert Point” mode 

Note that the insertion of the new node will be before or after the selected node, depending on where 

the cursor was at the instant of option activation. 

I

   

I

 

To fix the new node, click . 

If the node selected for editing is part of the control polygon, its weight can be modified by typing <P>. 

When editing defining nodes of a “through nodes” spline, this option is unavailable. 
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OFFSET CURVES  

Offset curves are created by offsetting an arbitrary geometrical object by a specified amount. Offset 

curves are created based on existing curves (splines, ellipses, functions). The shape of an offset curve 

depends on the shape of the original curve and the amount of offset. The latter can be defined by a 

variable. 

For such system entities as a circle and a line, offsets can be created on the fly together with the original 

entity creation. 

A most typical application of offsets is pipe modeling. It is quite convenient for the user to draw just the 

centerline, and then create the offset lines of the pipe silhouette. Offsets are also widely used in 

developing structural and architectural drawings. 

Creating Offset Curves 

Offset curves are created in the command TO: Construct Offset Curve. The command is called as follows: 

Icon Ribbon 

 

Draw → Construct → Offset Curve 

Keyboard Textual Menu 

<TO> Construct > Offset Curve 

Upon entering the command, the following actions become available: 

 <Enter> Select element 

 <P> Set Construction Line parameters 

 <S> Select Spline 

 <E> Select Ellipse 

 <F4> Execute Edit Construction command 

 <Esc> Exit command 
 

 

Offset curve creation begins with the selection of the reference element to 

use for offsetting. The reference element is selected by the cursor. For an 

accurate selection, use the options <S> “Select Spline” or <E> “Select 

Ellipse”, while pointing the cursor to the respective element. 

The selected element will highlight, and the offset curve will start 

rubberbanding. Move the cursor over the desired position and click  use 

the option <P>. 

In the latter case, the parameters dialog box will appear. 

 

or P  
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The offset distance can be entered in the “Offset” input box of the 

element parameters dialog. Positive offset values correspond to outer 

positions of the offset curve with respect to the reference element, 

while the negative – to inner positions, respectively. In the case of 

using the mouse input  in offset creation, the parameters dialog is 

not displayed, and the value of the “Offset” parameter is derived from 

the cursor position. The offset curve is created on the side of the 

reference object pointed to by the cursor. 

 

Offset position can also be defined using an existing node. To do this, select the reference element for 

the offset curve. This brings the following option in the automenu: 

 <N> Select Node 

Use this option for selecting a node the offset curve will be passing through. 

S

   

N

     

To reject a reference element selection, use the option  

 <Esc> Cancel selection 
 

Offsets can be constructed to composite objects made of various-type entities, such 

as a spline and a line. To do this, first create a 2D path along the desired contour, 

and then use the path for offsetting. The corners of the reference curve become 

rounded on the offset curve, as rounding is adopted for handling offset corners in T-

FLEX CAD. 

When a spline offset is generated, self-intersection loops may occur in the offset 

contour. The offset parameters dialog box provides the option for loops stripping. 
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Offset Parameters 

Offset parameters can be defined at creation or editing time. The parameters dialog box is called by the 

option . 

Offset. Defines the distance between the reference element and its 

offset curve. The input can be a number, variable or expression. 

Extra Loops Cutting. This parameter turns on the loop stripping 

mode. In this mode, all self-intersection loops are stripped off the 

offset contour. 

Precise Circle and Arcs Calculation. This parameter is material only 

for creating an equidistant line with respect to a given 2D path. 

When activating this flag, instead of an equidistant construction 

line, the 2D path with more accurate processing of arcs and circles 

will be constructed. 

Level. Places the offset curve on a certain visibility level. 
 

Layer. The name of the layer the offset belongs to. 

Set as default. Setting this flag means the current dialog box settings will be used as defaults for 

newly created construction entities. 

Editing Offsets 

Editing offsets, as well as other construction entities, is done in the command EC: Edit Construction: 

Icon Ribbon 

 

Draw → Additional → 2D Construction 

Keyboard Textual Menu 

<EC> Edit > 2D Construction 

An offset can be selected by pointing the cursor and clicking it , or using the option  

 <S> Select Spline 

The selected offset curve gets highlighted. 

The following options become available in the automenu: 

 <P> Set Construction Line parameters  

 <V> Dynamic model regeneration mode 

 <Y> Create Name for selected Element 

 <K> Break link with variable 
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 <I> Select Other Element 

 <Del>  Delete selected Element(s) 

 <Esc>  Cancel selection 

Editing of an offset is none different from its creation. 

The offset editing command EC: Edit Construction can also be accessed from the command TO: 

Construct Offset Curve using the option: 

 <F4> Execute Edit Construction command  
 

The third way of selecting an offset curve for editing is available while 

no command is active (in the command waiting mode). Move the cursor 

over the offset and right-click  for the context menu. 

Selecting the menu item “Edit” launches the offset editing command. 

The item “Delete” allows deleting the selected element. Selecting the 

“Parameters” command opens the offset parameters dialog box. 

Detailed description of the command “EC: Edit Construction” can be 

found in the earlier chapter “Lines” (section “Editing Lines”). 
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FUNCTIONS 

T-FLEX CAD supports construction lines defined by explicit mathematical formulation. Such construction 

lines are called functions. To define a function, specify its definition type (parametric, plain, etc.), the start 

and end of the parameter range, various display parameters of the curve. 

You can work in two modes: either using a predefined formula from the provided set, or creating a new 

function. The set of predefined functions is stored in the file “function.dat”. The file name is defined in the 

item Function spline files of the command SO: Set System Options tab Files. The file “function.dat” can 

be edited or replaced, if desired. Notations for the parameters, accepted in the file, are as follows:  #1 – 

first parameter, #2 - second parameter of the function (can be optional). Follows is a detailed description 

of these parameters. 

The system treats the resulting construction line of the function as a spline, therefore, the <S> key is 

used for its selection in various commands. 

Defining the Function 

The entities defined by a function are input via the command FU: Construct Function Spline”  

Icon Ribbon 

 

Draw → Construct → Function Spline 

Keyboard Textual Menu 

<FU> Construct > Function Spline 

 

The following options are available to the user: 

 <Enter> 
Select nearest node or create node defining the 

function coordinate system 

,  <Ctrl><F> Free mode on/off toggle 

  <N> Select Node  

  <P> Set entity Parameters 

 <A> Select axis of symmetry axis (straight line)  

 <F4>  Execute Edit Construction command 

 <Esc>  Exit command 

The function spline construction entity allows defining construction entities of virtually any kind. The 

main condition is possibility of defining construction entities in a form of functional relation between the 

coordinates. 
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The system provides an option of selecting predefined functions defining various curves, such as 

parabola, evolvent, spiral, etc. You can also define your functions independently, and then use them. For 

this purpose, create a descriptor file or append an already existing one with new formulas and values of 

other parameters defined in the function parameters dialog box. 

The definition procedure includes two stages: 

1. Defining the coordinate system position (X and Y). The coordinate system helps defining the 

desired position of the resulting entity on the drawing. The coordinate system is defined by 

sequential selection of two nodes. The first node defines the origin (0,0). The second node 

defines the direction of the X-axis. The Y-axis is defined automatically based on the origin and 

the X-axis positions. 

2. Defining the functional relation and other parameters. This is done in the function parameters 

dialog box that appears on the screen after selecting the second node. 

The following parameters are defined in the function 

parameters dialog box: 

Name of the formula. One can select from the list a name 

of a standard function or define an arbitrary name for 

creating a new function.  

Type, or the way of defining the function. Four different 

types of definition can be used: 

 Plain definition in Cartesian coordinates (Y = f (X)) 

Example: Y= #1**2 defines a parabola. 

The notation #1 is used for the variable parameter (in this 

case - X). This special notation is used to avoid confusion 

with the system variable names that can be used in the 

expression defining the functional relation. 

Besides variables, functions can be used as well as they are 

supported for use in the variable editor. 

 Parametric definition in the Cartesian coordinate (X = f(t), 

Y = f (t)). 

Example: X = #1, Y = #1 defines a straight line. 
 

 

One can create, for instance, a database of cam coordinates, and then use a 

parametric definition for the cam contour. Use the database access functionality and 

define a parametric relation where the variable parameter #1 is the record number in 

this database. The specified number of steps must necessarily equate with the 

difference between the end and start values of the function variable parameter.  

The indicator of the end value, or the end record, in the database named “q” can be conveniently 

entered as the expression “q.#”, returning the number of the last record in the database q. 
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- Function in Polar coordinates (P = f (A)) 

Example: P = #2 defines a circle with the radius equal to the value of the parameter #2. #2 – is 

the second special notation that can be used in function defining expressions. It is equal to the 

distance between the nodes that define the coordinate system. 

-Parametric definition in Polar coordinates (A = f(t), P = f(t)). 

In T-FLEX system, such definition of functional relations may be convenient in a number of 

situations. For example, suppose, a database stores the values of angles and distances of a 

cam coordinates. Use the database access functionality and define a parametric relation where 

the variable parameter #1 is the record number in this database. 
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X=, Y= (or A=, P=) Depending on the type of the function being defined, these two fields describe 

the expressions defining Х and Y (for functions in Cartesian coordinates) or A, P (for functions in 

Polar coordinates). The following notations are used: #1 – the first parameter, #2 – the second 

parameter of the function (can be optional). 

The resulting function construction, as in the case of splines, is a polyline. The “Start” and “Finish” 

parameters define respectively the start and end values of the variable parameter, defining the beginning 

and the end ranges of calculating the polyline coordinates.  

The “Polyline generation” group of parameters defines the way of calculating the intermediate point 

coordinates when creating the polyline: 

Equal steps. This way implies the variable parameter to change from the start to the end value in 

equal increments. The number of steps is specified by the user. It defines the number of 

segments in the polyline being created. The more the number of steps, the higher-accuracy will 

be the polyline representation along the bends and the longer time will take various operations 

handling the created polyline. 

The number of points used in the polyline creation is always equal to the number of segments 

plus one, and, therefore, is greater by one than the specified number of steps. The first point 

always corresponds to the start value of the variable parameter. The coordinates of the rest of 

points are based on the values of the variable parameter defined by the formula: 

Current value = Start value + I * Step  

Step = (End value – Start value) / Number of steps, 

I is the current step number (1,2,…, Number of steps). 

If polyline point coordinates are calculated using a database, the value of the variable parameter is 

usually the line number in the database. In this case, the current value of the variable parameter is 

replaced by the largest integer less than or equal to it. As a result, data could come at uneven 

steps from the database. To avoid this, always define the function parameters in such a way that 
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the number of steps was equal to the difference between the end and the start values of the 

variable parameter. 

Optimized to curvature. One could notice that the above approach is not always convenient for 

curves of complex shape, as the tessellation density was constant along “smooth” and “curved” 

zones unnecessarily. Optimization to curvature yields finer tessellation along high-curvature 

zones and, respectively, coarser otherwise. The criterion of the accuracy and quality in this case 

is the “Tolerance” parameter that defines the maximum permitted deviation of the calculated 

polyline coordinates from the true curve coordinates. The lesser is the tolerance, the more 

segments will be in complicated zones of the curve. 

Once the polyline is built, it can directly be used as a construction entity. However, a possibility is 

provided for using the calculated polyline points for spline creation. For this, turn on the option 

“Generate spline from polyline”, define its type and the number of tessellation segments between two 

neighboring points of the spline for the spline tessellation polyline. This tessellation polyline will be the 

final output construction entity. Spline generation may be needed when a smooth curve is desired, while 

the number of defining points is limited. 

                 

The “Symmetry About Axis X” flag among the 

function spline parameters allows mirroring of 

the created entity about the X-axis of the 

function local coordinates. (The X-axis passes 

through the two nodes selected at function 

spline creation). 

 

If in future this construction line will be subjected to a symmetry transform (for instance, in 

copying or in translation), then the state of the flag of the transformed line may be changed by 

the system automatically. 

To construct a spline symmetrical to a given one about an arbitrary line, use the option . 

Additional parameters Scale of Axis X (Y) allow 

changing the scale along each axis of the function 

local coordinate system. The coordinate of each 

point used in the function creation is multiplied be 

the specified scale factor. 

The “Change on Transformation” flags, to the right 

of the respective axis scale input boxes, 

allow/disallow automatic change of scale when 

subjecting the given entity to a scaling transform  
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(as in copying or translation). The cleared flag 

prohibits automatic change of the respective scale 

factor, while the checked item allows it. 

Note that special-type nodes are created at end points of function spline construction entities (as 

well as in other curves). These are created by using the option  of the node creation command. 

Evolvent Creation Example 

As an example, let’s create a profile of a cogwheel. First, let’s make all necessary calculations and 

constructions: circles, cog size, etc. relating these parameters by variables. 

 

Then, using the “Evolvent” function, specify two points for defining the Х-axis of the evolvent. Besides, 

the first point also defines the center of the main circle (rb). Each equation among the function 

parameters needs to be multiplied by the main radius of the wheel or by the #2 parameter, the latter 

being the case when defining the main circle radius by the second point. 
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Besides, the start and end points (angles) can be defined among the evolvent parameters. This is 

optional, since the evolvent will be bounded by the specified radii of the wheel being created.  

In the reviewed example (see the diagram) a general case 

of evolvent is limited to sampling an upper portion of a cog 

profile. This drawing is located in the folder 
“Examples/2D Design/ Function 

Spline/Evolvent.grb”. 

Do not use this file as a template for designing cogwheels. 

Follow the design insights of this document and use 

refined formulas to create a complete profile of a cog. Use 

this drawing in future for creating other cogwheels. 
 

Editing Function Spline 

Editing of the function spline construction entities is supported by the command EC: Edit Construction. 

Keyboard Textual Menu Icon 

<EC> 
“Edit > Construction > 2D 

Construction”  

After entering the command, you can reassign the defining nodes of the coordinate system or modify 

parameters. As for splines, use the option <S> for selecting function spline construction entities. 
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PATHS 

A path is a construction line passing through a sequence of nodes. The segments between the nodes can 

be straight lines or a portion of a construction entity between two given nodes. The following 

construction entities can be used: lines, circles, ellipses, splines and other paths. 

Constructing 2D Paths 

The command PA: Construct Path is provided for constructing a 2D path. 

The command is called by: 

Icon Ribbon 

 

Draw → Construct → Path 

Keyboard Textual Menu 

<PA> Construct > Path 

The following actions become accessible upon entering the command: 

 <Enter> 
Select a node or create a node at the nearest 

construction line intersection 

/  <Ctrl><F> Free mode on/off toggle  

 <P> Set selected Element(s) Parameters 

 <N> Select Node 

 <L> Select Line 

 <C> Select Circle 

 <E> Select Ellipse 

 <S> Select Spline 

 <F4> Execute Edit Construction command 

 <Esc>  Exit command 

The 2D path creation procedure consists of selecting 2D nodes forming a sequence. After selecting the 

start node, you can select a construction line that connects this and the next node. Both nodes must 

belong to this construction line. 

The step-by-step process is as follows: 

1. Select the start node; 

2. Select a construction line connecting the start node with the end node (optional); 
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3. Select the end node. 

Selecting the start node of the path as the end node completes the path creation. 

4. Confirm path creation or repeat the step 2. The end node selected in the step 3, becomes the start 

node for the next segment of the path. 

Upon selecting the start node and the first segment, you can do the following: 

 <Space> Select Graphic line 
 

This option allows defining a path contour along graphic lines. 

Keep in mind that this approach can only be used when the path 

segments coincide with the graphic lines. In the case of multiple 

selection choices, the cursor should be pointing to the desired 

graphic line when using the <Space> option.  

To speed up the process, one can use the option: 

 <A> Find contour automatically 

This option will search for the next path segment automatically until the contour is closed (in the case of 

the closed path) or until reaches a dubious situation (when the path is ending or forking). 

In both cases (when using the option <Space>, and upon 

automatic selection of the contour with the help of ) the 

system can select, as a next segment, the graphic line located at 

some distance from the last selected segment. This happens 

when the distance between neighboring nodes of graphic lines 

does not exceed the search tolerance. It determines the 

maximum allowed distance between nodes – line ends, for 

which these nodes are considered coinciding, and the graphic 

lines – connected. The search tolerance can be changed with 

the help of identically named parameter in the properties 

window. 

 

 

 

 

 

One can define a path using the same operations as in graphic 

line creation. In other words, one needs to define a sequence 

of path segment lines each having the start and the end node. 

To define the start or the end of a path segment line, select 

existing nodes (the key <N>) or create new ones (the key 

<Enter>) at intersections of construction line pairs.  

As in the case of graphic entity creation, an arc is defined by first selecting a node, and then the 

construction circle by typing <C>.  
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Otherwise, a straight line will be created between the two 

nodes as the path segment instead of the arc. 

Including an elliptical arc or a spline or other curve 

segment in a path is similar to creating a circular arc. 
    

 

To define a path represented by a full circle, then without 

selecting any nodes point the cursor to the circle and type  

<С>. 

One can also construct a path from an ellipse, spline or 

other curve by using the options <E> and <S>, 

respectively.      

In complex cases, when more than two construction lines intersect in one point, resulting in multiple 

overlapping nodes, the ending nodes of the path segments should be specified by selecting the 

intersecting line pairs hosting the desired node. This is done by using the keys <L>, <C>, <E>, <S>, 

standing for the respective types of construction entities. 

                   

In the cases when more than two construction lines intersect in one point but no nodes are created, the 

recommended technique is to create all necessary nodes by the command “N: Construct Node”. In this 

way, specify the exact lines whose intersections yield nodes. After that, the path segments can be input 

using the <N> option. 

To reject the last input path segment line, use the option  

 <BackSpace> Delete last Contour segment 

All three above-mentioned techniques can be combined when defining a path. 

If the end node of a closed path coincides with the start node, then the contour automatically closes and 

dehighlights, and an arrow is displayed in the end node indicating the direction of the defined path. This 

signals that the path has been completed.  
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A path can also be closed by using the option 

  <Home> Close Contour 

To complete definition of an open path, upon defining all segments use the option  

 

<Ctrl+ 

Enter> 
Finish input 

To cancel an action of path input, use the option  

 <Esc> Cancel selection 

Whenever two or more path segments are input in the command “PA: Construct Path”, the right-click  

brings up the Right button action dialog box (this overrides the system settings). 

In this dialog box one can: “Cancel element creation”, which is 

equivalent to <Esc> option; “Cancel last element selection”, 

which is equivalent to <BackSpace> option; “Finish element 

creation”, which is equivalent to <End> option. One can also 

set the flag “Don’t show this dialog in future”. In this case, the 

dialog box will not come back again, and the right-click  

action will be the one set last together with the “Don’t show 

this dialog in future” flag, per the system settings.  

The button [Return to Edit] brings the user back to 2D path creation mode. 

Note that the same dialog is used in the H: Create Hatch command. A default  action setting 

made in this dialog box in one of these commands will work in both commands. The selected 

option will be used in all newly opened documents until the end of the application session. To 

change the setting, close and reopen the application. 

If the dialog box does not pop up upon  while in the command being described, and some action is 

performed instead, then a default  action was already assigned earlier in the session within this 

command or in “H: Create Hatch”. 

2D Path Parameters 

2D path parameters can be defined during its editing. The 2D path parameters dialog box is called by the 

option  

 <P> Set path parameters 
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Number of Point for Circle Approximation. This parameter defines 

the accuracy of drawings of circles and circular arcs that are 

components of 2D paths. 

Level. Places the path being created on a certain visibility level used 

for hiding some elements from display as necessary. 

Layer. This parameter assigns the path being created to a certain 

layer. 

Color. This parameter defines the color used for the path display.  

Set as default. Turning on this flag means the current dialog parameter settings will be used in 

future for constructing new construction lines. 

Editing 2D Paths 

By editing a path, one can add or delete nodes, select a different construction line to connect the end 

nodes of a particular path segment, as well as define new parameters. 

Editing is done in the command EC: Edit Construction.  

Keyboard Textual Menu Icon 

<EC> “Edit > Construction > Path”  

A path can be selected by pointing the cursor and clicking , or by the option: 

 <S> Select Spline 

As a result, the selected path gets highlighted, and its nodes marked. 

Editing the Type of a Particular Path Segment  
To modify the type of a particular path segment, do the following steps:  

Select a path; 

Using the mouse, select the path segment whose type needs to be modified;  

Select a construction entity defining the new type of the path segment: line, circle, ellipse and spline 

(including other 2D paths). Selection of a construction entity is done using the appropriate option. 

The end nodes of the path segment being edited must belong to the selected construction entities; 

Exit the particular path segment editing mode by right-clicking  or pressing <Esc> on the keyboard. 

Confirm changes by the option: 

 

<Ctrl+ 

Enter> 
Finish input 
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Let’s review an example explaining the process of editing a particular 

segment of a path contour. The diagram shows the original path. 

The wave segment is to be replaced by a straight line. 

Call the command “EC: Edit Construction” and select the path. The next 

diagram shows the situation after selecting the path.  
 

 

The contour is highlighted, and the end nodes are marked by small boxes. 

Move the cursor over the contour segment to be edited (the wave line in 

this case) and click . The selected contour segment will be highlighted and 

its nodes marked with larger boxes. This state is shown on the next 

diagram.  
 

Select the straight line passing through the edited contour nodes by 

moving the cursor over and typing <L> key. The edited path segment now 

assumes the desired shape. The system still remains in the selected path 

segment editing mode. If transforming this segment is over, quit the 

current segment editing mode by right clicking  or pressing <Esc> on the 

keyboard.   

L

 

The icon  becomes then accessible in the automenu. If there are no more modifications to the path, 

push  or <End> key. What is left is just changing the graphic line type, if necessary. 

Similarly, one can replace a path segment with a circular or elliptic arc, or a spline segment, or a 

part of another path, if the circle, ellipse, spline or path is constructed based on the marked nodes. 

Simply use the appropriate option among <C>, <E> and <S>. If the new path segment was not 

created based on the marked nodes yet passes through them, then editing such path segment 

can be done using the option “Switch to ‘Insert Point’ mode” (the icon  or the <I> key). This 

option will be fully described below. 

The selected segment of the path between two nodes can be replaced as many times as necessary. The 

path segment will stay selected until the user quits by right clicking  or pressing <Esc>. If a contour 

segment was modified using the option “Switch to ‘Insert Point’ mode” (the icon  or <I> key), then 

the selected contour segment gets unselected after the change (no need to press <Esc>). Meanwhile, the 

system will remain in the path contour editing mode until the confirmation by  or <End> key. 
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Deleting a Node inside Path Contour 
 

To delete a node inside a path contour, do the following steps: 

Select a path (point at by the graphic cursor and click ); 

Select the path segment the node belongs to (point at by the graphic cursor and click 

); 

Select the node to delete (point at by the graphic cursor and click ); 

Delete the selected node (the icon  or the <Del> key); 

Confirm changes (the icon  or the <End> key). 

As a result, the new path segment passes through the two neighboring nodes. 

 

 

Modifying a Node Position within Path Contour 
 

To modify position of a node within a path, do the following steps: 

Select a path (point at by the graphic cursor and click ); 

Select the path segment the node belongs to (point at by the graphic cursor and 

click );  

Select the node to move (point at by the graphic cursor and click ); 

Move the node to the desired position (the segments connecting the node to 

neighbors will rubberband as the node is moved); 

Fix the node (point the cursor at an intersection of construction lines and click , or 

type <N> in the case of using an existing node). 

Confirm changes (the icon  or the <End> key). 

As a result of moving, the node will be connected with the neighbors by straight 

line segments, regardless of the former types of connecting entities). 

 

 

Creation of Additional Nodes on a Path Contour 
To create additional nodes on a path contour, do the following steps: 

Select a path (point at by the graphic cursor and click ); 

Select the contour segment to split by new node(s) (point at by the graphic cursor and click );  

Turn on the point insertion mode (the icon  or the <I> key), and click on a contour segment. The 

segment becomes split in two, with the new node between them. The node and the segments 

rubberband with the cursor, the solid line segment connecting to the previous node and the dashed 

line to the next one. The order of the nodes after the insertion will be determined by the system 
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automatically, depending on the path contour direction. Do not click on a segment near a vertex, as, 

instead of adding a node, this will start moving the existing node; 

Close the contour between the newly created node and the successive one. A shortcoming of the 

functionality is unavailability of the option “select graphic line”; 

Contour input is complete once the closing node is selected, or the icon  or the <End> key is 

pressed.  

The system returns to the mode “Contour selected for editing”. One can do other modifications, 

and then confirm all changes. 

Confirm changes (the icon  or the <End> key). 

Let us illustrate the above with a specific example. Suppose, a 

path contour is to be modified as shown on the diagrams. 

To get the result, begin with calling the command EC: Edit 

Construction. Then, using the option “Select Spline” (the icon , 

or the <S> key), select the path contour to be modified. Now, to 

get the result, perform the steps shown on the following 

diagrams.       

                       

I

        

C

                

What is left is to press twice the  icon or <End> key, and the contour editing task is complete. Then, 

adjust the graphic lines accordingly, if necessary. 
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Displaying the Contour Point Numbers 
To toggle the display of the contour point numbers of a 2D path, use the option: 

 <Q> Show/Hide Contour Point Numbers 
 

With the option turned on, the points in the path are enumerated based on their 

position in the path and the path direction. A point number is displayed next to the 

respective node. When several subsequent points of a contour coincide, their numbers 

are displayed next to each other, separated by commas. 
 

 



 

 

CREATING DRAWING LINES 
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GRAPHIC LINES 

Graphic lines are the base graphic elements that constitute the drawing image. The analogy for the 

graphic lines found in conventional drafting is the lines drawn in ink. Graphic lines are created based on 

construction lines and nodes. By “lines”, we mean straight or curved line entities described below. 

The various types of graphic lines can be defined by:  

A line segment between two nodes. The graphic line limits are defined by the location of these nodes. 

A full construction entity. This graphic line can only be defined by the underlying construction entity. 

The construction entity can be of any type except straight line as the latter is infinite. 

A portion of construction entity between two nodes. This type of graphic entity is defined by the 

underlying shape-defining construction entity and two nodes defining the line limits. 

Graphic entities can be created with user-defined line types. 

Creating Graphic Lines 

Graphic lines are created in the command G: Create Graphic Line. Call the command via: 

Icon Ribbon 

 

Draw → Draw → Graphic Line 

Keyboard Textual Menu 

<G> Draw > Graphic Line 

On entering the command, the following options will be available in the automenu: 

 ,  <Ctrl><F> Free mode on/off toggle 

  <P> Set Graphic line Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Tab> Change arc direction 

  <N> Select ending Node of Graphic line 

 <L> Select straight Construction Line 

  <C> Select Construction circle 

 <E> Select full Ellipse Contour 

 <S> Select full Spline or Polyline Contour 

 <Q> 
Creation of graphic lines between two 

intersections of construction lines 
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 <BkSpace> Delete last Contour segment 

 <F4> Execute Edit Graphics command 

  <Esc>  
Cancel selection (available only when selecting a 

construction entity) 

 <Esc>  Exit command 

To create a segment: 

1. Select start node. If the selected node is on the intersection of several lines, then use the <L> 

option for specifying the line to apply graphics at. If upon typing <L> key the construction line 

is not highlighted, the selected node may not belong to the line. This means, a wrong node 

was selected. 

2. Select end node. This completes creation of the graphic line between two nodes. 

                     

After creating a segment, the end node stays highlighted and becomes the start node for the next 

graphic line. If you want to create a graphic line starting elsewhere, press <Esc> or  for 

canceling the current node selection. 

 

To define the start or end point of a graphic entity, simply place the cursor at the desired location and 

click . In “constrained” drawing mode, clicking  selects the node at the nearest intersection of 

construction entities, if exists; otherwise, a node will be created at this intersection and then get selected. 

In “free” drawing mode, either a new node is created, or an existing one is selected. An existing node is 

selected if the graphic cursor is within the “finding” zone around the node. The size of this zone is 

defined by the parameter Node join distance in the command Customize > Options… > Preferences. 

The size is defined in pixels. 

 

Automatic Creation of Graphic Line between Two Intersections of Construction Lines 

In the Drawing > View command there is a mode of creation of graphic lines between two intersections 

of construction lines. 

 

To use this option, it is required to press the  button, move cursor to the construction line (line, circle, 

ellipse, spline, polyline) that is intersecting with other construction lines and press . Depending on 

location of the cursor the system finds the two nearest points of intersection of construction lines and 
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creates the graphic line and nodes on its ends. When several lines are intersected at one point, the node 

is created between the lines that are created earlier than the others. 

 

If, in this mode, by pressing the left button of the mouse we translate the cursor along the construction 

line, the construction line being created will automatically be continued (or shortened) in the desired 

direction. 

Double clicking on the construction line will lead to creation of the graphic line on the entire 

construction line (except the straight line). 

If there is graphic line already created with the help of this option, you can’t create line of the 

same color on the same place again. If necessary, you can change graphic line color or hide 

previously created line. 

The  option works similar to the click , however, unlike the latter, it only allows selection of existing 

nodes. New nodes won’t be created. 

 

The options , ,  and  allow selecting construction 

entities of the respective types. The option behavior depends on 

the current state (whether there is already a pre-highlighted node 

or construction line). 

The following is the way to create a full curve: 

Select a respective construction entity by typing <C>, <E> or <S>, 

in a state when no node is selected. 

   

 

To create a graphic line as a segment of the underlying construction line, do the following: 

 

1. 1. Select the start node for the segment (arc). 

2. 2. Select the intended construction entity. If a construction line does not get selected, that 

means the selected node does not belong to the line, and the arc can’t be created starting from this 

node. 

3. 3. Select the end node of the segment (arc). 
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Then the arc will be created from the start to the end node. Please keep in mind that closed curves, such 

as a circle, are divided by two nodes into two arcs. The arc will be created nearest to the cursor at the 

time of selecting the end node. 

 

        

Switching Drawing Mode. “Free” and “Constrained” Drawing Modes 

The option /  allows switching between the two modes of creating the construction elements – 

nodes. One of these is the “constrained” drawing mode (recommended), in which the nodes are created 

at intersections of construction entities only. The other is “free” drawing mode, in which the nodes are 

not related to other construction elements and their location is defined solely by the absolute 

coordinates of the drawing. The same drawing may contain both “free” and “constrained” nodes. Nodes 

may be created automatically while creating graphic entities. Therefore, it is important to know what 

drawing mode is currently set. The option icon in the automenu and the buttons on the “Modes” toolbar 

are not only for switching the mode. They also indicate the current mode. The  icon in the automenu 

indicates that the “constrained” drawing mode is active, while the icon  corresponds to the “free” 

drawing mode. Besides the icons, the mode can be determined by the appearance of the cursor and the 

nodes being created. If the cursor and the nodes are displayed as crosses, this means, the “constrained” 

drawing mode is on, while the “box” shape indicates the “free” drawing mode. 

                            

1 - constrained node;  

2 - highlighted constrained node; 

3 - cursor in the “constrained” drawing mode 

1 - free node;  

2 - highlighted free node; 

3 - cursor in the “free” drawing mode. 
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Graphic Line Parameters 

The option  calls the graphic line parameters dialog box. 

        

When the dialog of parameters is invoked before creation of a line has begun, it will contain the 

additional parameter called Color for the current page only. This parameter is used only for drawing on 

pages of the workplanes (see the manual on three-dimensional modeling). When the flag is enabled, the 

specified color will not be used for all new lines in the document, but only for those lines that are created 

on the current page of the workplane. 

 

“Standard” Tab 

Line Style: 

Type. Defines the line type for drawing graphic entities. The line type is selected from the list. The list 

includes both the standard (included in the system distribution) and the user-defined line types. 

Standard line types are defined in the file TCAD.LIN. Their description is compatible with that of AutoCAD 

system. The template files for user-defined types are located in the folder …\Program\LinePatterns. 

Scale factor. Defines the Scale factor for dashed line types with respect to the dash size defined in the 

line type descriptor file (TCAD.LIN). Does not affect display of solid lines. If the scale is 

not defined (Default), then the scale factor will be taken from the Scale factor for dashed lines 

parameter of the Lines tab in the command ST: Set Document Parameters. 
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Thickness. Defines the thickness of the graphic entities. If undefined (Default), then the 

thickness for the solid thick line (CONTINUOUS) will be taken from the parameter Line thickness 

> Thick lines, while all the rest – from the parameter Line thickness > Other lines on the Lines 

tab in the command ST: Set Document Parameters. 

When selecting the “Waves” line type, then, additionally, 

the [Waves…] button becomes available. This button 

allows setting waves line parameters: Number of Periods 

or Period Length of the line, and the line Wave Height. 

The Wave Height is entered as percentage of the period 

length. 
 

 

The line start and end parameters: 

Start and end arrow type (arrow/symbol type). Each graphic line can have 

its start and end marked by a special symbol. The symbol type is selected 

from the list. 

Start and end arrow size (size of start and end symbols). The sizes of the 

start and the end symbol are defined independently. Any size can be set 

at the user’s preference. 

If the symbol size is not defined then the symbol is drawn proportional to 

the font size defined for the drawing on the Font tab in the command 

ST: Set Document Parameters. 

An additional button  serves to quickly swap the line start and end 

parameters. 

 

 

All above parameters are set by default when using one of the 

standard system line type. The style and ending type are defined 

for each standard type. A standard line type can be selected from 

the list coming under the  button.  
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The description of the standard line types is stored in the file SPECLINE.DEF. By default, the file contains 

the following entries:  

Thin THIN 0 0 

Continuous CONTINUOUS 0 0  

Center CENTER 28 28 

Hidden HIDDEN 0 0 

The file can be appended by the user as desired. The first parameter is a comment, the second is the line 

name (this name is used for identifying the line in the line descriptor file), the third and the fourth 

parameters are the Ids of the start and end symbols (per the enumeration in the endings list). 

Color. The graphic line color. 

Level. The value of the visibility level of the graphic line. 

Priority. The value of the graphic line priority. 

Layer. The name of the layer of the graphic line. 

Some parameters of graphic lines can be entered in the system toolbar. Specifically for graphic lines, the 

system toolbar provides a button for defining graphic line types, and the buttons for defining the graphic 

line start and end points. The thickness of the line being created can also be specified with the help of 

the system toolbar. 

 “Advanced” Tab 

The “Advanced” tab allows setting the following parameters: 

The line display mode: 

Solid line. The lines whose “Width” parameter is not 0, will be drawn filled with color. 

Double line. The lines whose “Width” parameter is not 0, will be drawn as a contour without 

filling. 

Align. Defines centering of the graphic line with respect to the reference nodes: Center, Left, Right. 

Width. Defines the width of the graphic line: constant or 

variable. 

In the case of the constant width, the parameter Value 

defines the line width. 

If variable width is set then the line width values On start 

and On end need to be defined. 
   

The Start and End parameters define the shape of the start and the end of the line, as follows: 

None, Round, Square. 

Joints. This parameter defines the shape of joints of a graphic line created from a 2D path, as 

follows: Round, Sharp, Mitered.  

The size of the rounds and miters depends on the line width setting. If “Round” attribute is set, 

the segment joints will be rounded with the radius equal to the line half-width. With the 
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“Mitered” setting, the corners at the segment joints are mitered. The distance from the joint 

node to the miter top is defined by the parameter Miter limit as a ratio of the line half-width. 

                        

Copying Parameters from Existing Lines 
The values of parameters of the graphic line being created can be quickly copied from already existing 

line. To do so, use the following option: 

 <Alt+P> Copy Properties from Existing Element 

This option can be accessed in the automenu of the command before creation of the line or in the 

process of creation. 

After this option is invoked, it is sufficient to specify the graphic line whose values of parameters must be 

transferred to the line being created. 

To assign the copied values of parameters to all new lines, before selection of the original graphic line it 

is required to enable the additional option: 

 <S> Set Properties as Default 

When this option is enabled, all copied parameters will be stored as default parameters. 

The given option simplifies creation of the graphic lines having the same parameters. However, it 

does not allow us to copy individual parameters or parameters from an object of another type. In 

such cases it is more convenient to use the general mechanism of editing parameters of elements 

in the window of properties. 

Using Construction Entity Selection Options 
Next, we will describe uses of the listed options in various situations. 

Clicking  in the situations described in the headings, accounts for the following actions: 
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1. Neither nodes nor construction lines are selected 

The  action selects the nearest node. Line 

rubberbanding begins from the highlighted 

node. This option is sensitive to the drawing 

mode. In the “constrained” drawing mode, the 

nearest node is selected, or created in the 

nearest construction lines intersection 

(whichever is closer). In the “free” drawing mode 

the nearest node would be selected only within 

the zone around the cursor defined by “node 

join distance”. If such node exists then it will be 

selected. Otherwise, a new “free” node will be 

created. 

      

       

2. The start node alone is selected  

The action  creates a graphic entity – straight 

line segment from the start node to the node 

defined by this step. The end node is then 

highlighted, and new rubberbanding begins 

from it.       

3. A single straight construction line is selected 

A node will be selected with the  action, 

located at the nearest intersection of the 

highlighted line and some other construction 

entity (either a line or a circle). The line will stay 

highlighted, and a new graphic line will begin 

rubberbanding after the cursor from the 

highlighted node as the start. 
     

4. The start node and a construction entity are selected 

The action  creates a graphic line entity – a 

straight line segment or a curve from the start 

node to the node defined by this step. The type 

of the created graphic entity depends on the 

selection of the underlying construction entity – 

line, circle, spline, or ellipse. On completing the 

step, the last selected node stays highlighted, 

with rubberbanding resuming from there.  

      

The selected node must lie on the selected construction line. 
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The option  in all the above situations acts in the same way as the action . The only difference is, the 

option <N> can only select existing nodes.  

The option  acts as follows in the described situations: 

1. No nodes neither construction lines are selected 

The option <L> highlights (selects) the nearest 

straight construction line. Highlighting the 

construction line in this case means the start 

node of the graphic line being created will be 

constrained to this line. A node will begin 

rubberbanding, constrained to sliding along the 

selected line. This indicates that a node can be 

selected only at an intersection of this line and 

some other construction entity. 

        

2. The start node alone is selected 

The option <L> highlights a straight 

construction line. The start node stays 

highlighted, and a new line begins 

rubberbanding, constrained to stretching along 

the selected line. This indicates that the end 

node of the new graphic line can be selected 

only at an intersection of the highlighted line 

and some other construction entity. 

      

3. A single construction entity is selected 

The option <L> selects the node at the 

intersection of the already highlighted 

construction entity and the newly appointed 

construction line. The selected node becomes 

the start node for the graphic line being created. 

The new line begins rubberbanding, constrained 

to the selected construction entity. If the two 

selected construction lines do not intersects, no 

action occurs. 

      

4. The start node and a construction entity are selected 

The option <L> selects the node at the 

intersection of the already highlighted 

construction entity and the newly appointed 

construction line. A graphic entity is created 

from the start node to the newly selected node,      
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which may be a straight line segment or an arc 

of a circle, depending on the selected 

(underlying) construction entity. The newly 

created node and the last selected construction 

entity stay highlighted, and new line 

rubberbanding begins along the latter entity. 

If the two selected construction lines do not intersect, no action occurs. 

The option  is insensitive to the “free” versus “constrained” drawing mode. In either case, its use 

implies selection of a construction circle entity as the underlying entity for creation of a graphic entity – 

circle or arc. The option acts as follows in the described situations: 

1. No nodes neither construction lines are selected 

The option <C> creates a graphic entity – circle 

over the selected underlying construction circle 

entity. 

          

2. The start node alone is selected 

The option <C> selects a construction circle 

entity. The start node stays highlighted, and an 

arc starts rubberbanding along the selected 

circle. An additional option appears in the 

automenu for flipping the direction of the arc 

creation:                   

  <Tab> Change arc direction 

3. A single construction entity is selected 

The effects of using the <C> option in this case are quite similar to the use of the option <L>. 

4. The start node and a construction entity are selected (line or circle) 

The effects of using the <C> option in this case are quite similar to the use of the option <L>. 

The options  and  are used similarly to the option . 
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Example of Creating a Chain of Graphic Lines 
Create a few construction lines. On top of them, draw the graphic lines: 

                      

                      

To delete the last created graphic line, one can use the option . 

A Few Tips on Creating Graphic Lines 
It is not recommended to use the  action for defining the start node of a graphic entity where there are 

more than two intersecting construction lines. This is because the node may get created at unintended 

lines intersection. 

In the special case of two or more coinciding nodes, use an appropriate option for selecting construction 

entities (<L>,<C>,<E>,<S>). First, specify the construction entity to underlie the graphic one, and then 

either select the node, using the <N> option, or specify the intersecting entity, depending on the 

situation. 

It is a good idea to initially create a node at the intersection of construction lines, using the command 

N: Construct Node. In this way, you can precisely specify what lines intersection to use for the node 

creation. Later, when applying the graphic line, this node can surely be selected using the <N> option.  

Consider a simple example illustrating the approach. There are several construction lines on the drawing 

below. Line 1 is constructed vertical, parallel to the Y axis, line 2 is a horizontal, parallel to the X axis, line 

3 is constructed parallel to line 2, and, finally, circle 4 is constructed with the center snapped to a node, 

tangent to line 3. Now, try to apply a graphic arc using the <Enter> option. Note that the created node 

will not necessarily snap to the intersection of the line and the circle. The node may actually be, for 

instance, at the intersection of lines 1 and 3. In this case, the circle can’t be selected for creating an arc. 
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A properly built model helps avoid annoying errors. If a node is supposed to be on the intersection of the 

circle and the line, then it ought to be constructed as such.  

Basic Rules of Graphic Line Creation 
The user is encouraged to follow a few rules when creating graphic line entities: 

To avoid errors when creating a parametric drawing, use the option <N> for applying graphic lines. 

Do not use the <Enter> option if there are more than two construction entities intersecting in 

one point.  

If there is a selected node, then it will be used as the start for a graphic line. 

If a node is selected and user attempts to select a construction line entity, it has to be a line 

passing through the selected node. 

If a node and a construction line are selected, and the user selects another construction line, then a 

graphic line will be created, starting in the selected node and ending at the intersection of the 

selected lines. 

If two construction entities intersect in more than one point (for example, a line and a circle), then 

the nearest intersection is selected to the graphic cursor location at the time of pressing the 

option key. 

If selecting a construction line entity results in nothing, that means, the lines do not intersect and 

the graphic line can’t be created. 

Using Grid in “Free” Drawing Mode 
If snapping to grid is turned on, then the start and end nodes of the graphic line will be snapping to 

nearest grid knots. The grid parameters can be defined using the command “Customize|Grid…”. The grid 

can be assigned different steps in the vertical and the horizontal directions, and different shifts with 

respect to the origin in each direction. When creating a graphic line, the status bar displays the 

coordinates of the nearest grid knot to the current mouse cursor location. In the “free” drawing mode 

with grid snapping turned off, a graphic line can be created at an arbitrary location in the drawing area. It 

does not require constraining to any construction lines. 

Editing Graphic Lines 

Editing graphic lines is done by the command EG: Edit Graphic Line. Call the command via: 

Keyboard Textual Menu Icon 

<EG> Edit > Draw > Graphics  

The following options become available upon calling the command: 

 <*> Select All Elements 

 <R> Select element from list 

 <Esc> Exit command 
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When in the command, one can select a graphic line entity by pointing the cursor and clicking . Several 

graphic lines can be simultaneously selected by box. The graphic lines will be selected that are 

completely within the box. 

All graphic lines can be selected at once by typing <*>. To add a graphic line to the set of already 

selected ones, use the combination <Shift> + . To exclude a graphic line from the selected set, use 

<Ctrl>+ . 

The following options become available after selecting one or several graphic lines: 

 <P> Set selected Element(s) Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <I> Select Other Element 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

If only one graphic line is selected, then the following option is available: 

 <O> Create Name for selected Element 

If a graphic arc entity is selected, the following additional options become available in the automenu: 

 <Tab> Change arc direction 

 <A> Link Arc or Circle to Node 

 <B> Break Link with Node 
 

If the selected graphic line is created based on a construction 

line, then Relations for the parent construction line will 

appear in the 2D window. Those relations are temporary, 

meaning that those are created by the system automatically 

upon entering the mode of editing a graphic line, and are 

automatically deleted upon exiting the mode. Using 

Relations, you can modify geometrical parameters of the 

parent construction line in the transparent mode. 
      

Besides that, if the selected graphic line is created based on a construction line, then the second click  

after selecting the line (while the cursor is pointing at the line) will invoke the command of editing the 

original construction line. 

To modify parameters of the selected graphic line, use the option . The initial parameters are taken 

from the last selected graphic line. 
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If the user needs to bring the parameters of a graphic line in accord with a given line parameters, then 

the latter should be selected the last before proceeding with the modifications. This will automatically 

pre-set the desired parameters in the dialog. 

If more than one graphic line is selected then another dialog box comes 

on the screen before the parameters dialog box. Its purpose is to define 

what parameters of the selected graphic lines are to be modified. 

After that, the graphic line parameters dialog box will appear. Now, only 

the parameters will be modifiable that were specified in the previous 

dialog box. For instance, if in the previous dialog only the line type was 

checkmarked for modification, then only this parameter can be modified. 

Other parameter modifications will be discarded. 

Object properties can be also set from another object (including image 

line) in command waiting mode with the help of the Properties window. 

See more details in “Main Concepts of System Operation” chapter. 

The current set of graphic line parameters defined during the editing can 

be saved. New graphic line creation would then be based on this 

particular set of parameters. 

 

To open the parameters dialog box for a single graphic line, one can simply double-click it (  ). 

The option  is used for assigning a name to the selected graphic line. The name is unique and 

provides unambiguous identification to the line. The graphic line name can be used instead of its Id 

number. For example, the function GET() can be used in the variable editor to query a graphic line, 

named NAME, as follows: GET(“NAME”, “LENGTH”). 

The option  allows flipping the direction of graphic arc entity creation. 

 

The following options are available in the automenu for graphic arc entities,  and . These options 

manage a locking node of graphic arcs constructed on top of a construction entity. Throughout 

modifications of the drawing, the graphic arc will stay over the sector of the underlying construction 

circle that is closer to the locking node. 

Let’s review the following example. When moving one of the original lines, the part is supposed to get 

mirrored. However, the graphic arc will stay in its original orientation as the vertical line is moved, 

resulting in the wrong final shape of the part. This can be fixed by using a locking node.  
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To keep the arc always in the correct sector of the circle, link it to a node. After calling the command 

EG: Edit Graphic Line select the arc and use the option . The cursor will change to “finger” . Then, 

select the locking node using .  

                     

Now, as the vertical line is moved, the whole drawing will be flipping, maintaining the original relative 

configuration. 

                    

To release the link with the node, use the option . 

To cancel the last graphic line selection and select the next nearest graphic line to the current cursor 

position, use the option . This option is convenient when there are several closely located or 

overlapping graphic lines, and the first selection attempt yielded the wrong graphic line. 

The option  deletes all selected graphic lines. The option  cancels the current selection of graphic 

lines. 

Besides, a capability is provided for reassigning the start and end nodes of the graphic line. Reassigning 

the nodes is possible for a single selected graphic line. Once the line is selected, the nodes get 

highlighted. Now, you can move the cursor over one of the highlighted nodes and click it .  

                              

The line will then start rubberbanding after the cursor, with another option becoming available: 

  <N> 
Select existing Node as the start or end of the 

graphic line 
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You can select a node for the graphic line to snap to. 

               

To change parameters of the selected graphic line, the system toolbar can also be conveniently used. 

With the help of the system toolbar it is possible to change color, type, thickness and ends of the line. 

For example, for changing the type of the line with the help of the system toolbar – first select the 

graphic line. Move the cursor to the line type input box on the system toolbar  and click . A 

menu of line types will appear on the screen. Select a new line type by . As the result, the appearance of 

the graphic line will change. 

                                

The graphic line endings can also be modified in a 

similar way. Use of endings is important, for instance, 

when applying centerlines. These are drawn in a dash-

dotted style. To create centerlines with hanging 

extents, you would not need to create additional nodes 

beyond the circle (as shown on the diagram). Rather, 

select the start and end types of the graphic line as 

shown on the diagram. The size of the extents can be 

defined explicitly in the parameters of the graphic line, 

or left as Default. In the latter case, the size will be 

defined by the parameters in the command ST: Set 

document parameters the tab Font, Size parameter. 

 

The same can be done easier. While in the command G: Create Graphic Line or EG: Edit Graphic Line, 

press the graphic button  on the right-hand side of the system toolbar. The list of the most often 

used lines with extents will appear. 
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SKETCH.  CREATING A NON-PARAMETRIC DRAWING.  

AUTOMATIC PARAMETERIZATION MODE 

T-FLEX CAD allows creating a drawing similar to most well-known CAD systems, using standard 

functionalities for creating various primitives, such as: line segments, arcs, circles, ellipses, splines. 

Sketcher functionalities, including object snapping and dynamic tooltips, significantly simplify and speed 

up the process of creating a non-parametric drawing. Such drawings do not share the advantage of 

parametric drawings in the effective usage of modifiable parameters (dimensions). However, in certain 

cases, development of such drawings is faster and can bring certain benefits, when large modifications 

are not expected. 

Quick creation of graphic lines in a drawing is done with the “Sketch” command. This command can work 

in two modes: in the sketching mode and in the automatic parameterization mode. 

Creating Lines in a Drawing 

To quickly create graphic lines use the command SK: Create Sketch: 

Icon Ribbon 

 

Draw → Sketch 

Keyboard Textual Menu 

<SK> Draw > Sketch 

Upon calling the command, the options appear in the automenu that allow creating various lines in a 

drawing. You can use all object snaps available in the system to make your constructions. 

Two working modes of the command “SK: Create Sketch” 

The SK: Create Sketch command can work in one of the two modes: in the sketching mode and in the 

automatic parameterization mode. Switching between the modes is done with the icon  on the 

“View” panel. When the icon is switched off, a plain sketch is created. When the icon is On, the automatic 

parameterization mode is at work. 

In the sketching mode, only the graphic lines based on free nodes are created. To create graphic lines, 

the user selects the desired type (a line segment, an arc, circle, etc.) and defines the position of the line 

defining points using  or by entering coordinates/parameters in the command's properties window. 

When specifying the positions of the defining points of the lines being created, one can use object snaps 

to existing drawing elements (a vertical/horizontal relation, tangency, perpendicularity, etc.). As a result, 

you get a nonparametric drawing without construction lines (a “sketch”).  

In the automatic parameterization mode the user also builds up a drawing as a sketch, using all available 

command tools. Instead of the free nodes, the system automatically creates construction elements 

beneath the graphic lines, that are tied by parametric relations. 
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The types of relations introduced by the system depend on: 

 the options of the command that was used to create a graphic line; 

 the object snaps used when creating the line; 

 parameters defined in the command's properties window. 

As a result, a fully functional parametric drawings is built. At the same time, you need to note that the 

system automatically defines the types of parametric dependences created between elements, which 

may not always meet the user's preferences. 

Details on working in the automatic parameterization mode are provided at the end of this chapter, in 

the section “Working in the Automatic Parameterization Mode”. 

Using Property Window 
When sketching lines, the point coordinates can be simply defined by clicking  in the drawing area. To 

enter exact node coordinates, the property window is used in this command. It allows defining absolute, 

relative, or polar coordinates of the elements being created and their parameters. 
 

When the pointer is in the drawing area, the property window tracks the 

current coordinates of the pointer. If necessary, those can be changed in 

transparent mode by typing the desired value directly from the keyboard. The 

active input box can be set by pointing and clicking , or from the keyboard. 

The key combinations for switching to one or another input box are displayed 

in the ToolTips as the pointer is rested over the desired field. When entering a 

value in the property window, a flag before the input box is automatically set 

that blocks modifications of the value via the pointer in the drawing area. 

 

To complete the point creation, simply press [Enter] or  in the drawing area after entering the 

coordinates. 

Either Cartesian or polar coordinates can be used for creating elements, separately or in combination.  

That helps creating various configurations of points in the most convenient way for the moment. 

For example, when specifying the second point of 

the segment, one can enter the value of the 

distance and the length of the vector. Auxiliary 

elements will be displayed in the drawing: a circle 

with the center at the segment start, of the radius 

equal to the specified distance, and a horizontal line 

offset from the segment start at the distance equal 

to the Y shift (“dy”). The intersection points of the 

circle and the line define the possible configurations 

for the second point of the segment under the 

specified parameters.  
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As the pointer moves around the drawing, this point will appear as a free node jumping from one 

intersection point to the other and back. Selecting the desired point and clicking  completes the 

segment creation. 

Continuous Line Input 
Continuous input of sketch elements is supported by the automenu option: 

 <J> Continuous creation 

In this case, the end point of the last created element (segment, arc) becomes the start point of the next 

one. 

This mode does not affect closed elements (circle, rectangle, polygon, ellipse, closed spline). 

Using Offset from Node 
When creating sketch elements, the position of any point of the elements being created can be defined 

relative to another point. To do this, use the automenu option 

 <Z> Offset 

This option can be called in transparent mode at any stage of creating sketch elements. Upon selecting 

the option, select the point to offset from. Then, the offset distance is defined in relative or polar 

coordinates, using the pointer and/or the property window. The system then returns to element creation. 

Creating Line Segments 
Any time the command is called, the system is ready for inputting line segments, as indicated by the 

pushed icon in the automenu: 

 <S> Line 
 

A black triangle in the lower right corner of the icon indicates presence 

of a pull-down list of options. Holding the button  depressed over the 

icon a bit longer opens the menu with more options. 

To create a simple line segment (the option ), one needs to define 

two points. The points can be specified arbitrarily by pointing in the 

drawing area and clicking  or by entering the exact coordinates 

(offsets) in the property window. One can specify point coordinates 

relative to the selected point or node in the drawing using the option 

<Z> ( ). 
 



T-FLEX CAD Brief Introductory Course 

394 

                                    

When creating a line, existing nodes can be selected as the line ends. 

Parallel line 

To create a parallel line, select the option: 

 <D> Parallel Line 

In this case, select a line by the mouse, to be used as the reference for constructing a parallel line. A line 

will start rubberbanding on the screen parallel to the selected line. If the continuous input mode is used, 

then this line will be parallel to the last input segment. To cancel a segment selection, right click . 

After selecting the reference line segment, specify the distance to the segment being created, the start 

point and the length of new segment. This can be done freely by moving the pointer and clicking  at 

the desired positions in the drawing, or input exactly in the property window. 

The property window allows entering coordinates of the start point of the 

parallel line. This also defines the distance between the lines. A node will be 

created in the specified point. From now on, the rubberbanded line will pass 

through this node.  

 
 

The line end can be input arbitrarily by moving the pointer along the line and 

clicking , or by exact value in the properties window, entering either line 

length or second point coordinates.  

The distance between the lines can also be entered in the property window. In 

this case, the rubberbanded line will be fixed at the specified distance from 

the original line segment. A node will rubberband along the line, following the 

cursor, defining the start of the new segment. Its position is defined by 

clicking . After that it is necessary to set the line length or its second point 

coordinates. 
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Perpendicular line segment  

A perpendicular line segment can be created using the option: 

 <F> Perpendicular Line 

In the continuous input mode, upon this option selection, an infinite line will be displayed that is 

perpendicular to the last input line segment and passing through its end node. The latter node will be 

used as the start of the segment being created. In this case, use the mouse pointer for fixing the 

rubberbanded node position by clicking  or entering a value in the property window. 

 

 

 

 

To create a line perpendicular to another segment or to the same segment that is not passing through 

the end node, the current system selection can be rejected by right clicking  while in the continuous 

input mode. One right click  cancels the selection of the start point of the segment being created. The 

second right click  cancels the selection of the reference segment, allowing manual selection of the 

desired segment. The further construction steps in this case are similar to creation of a parallel line. 

Slanted line 

To create a line segment at the specified angle to another segment, use the automenu option: 

 <G> Line at angle 
 

This kind of line is constructed similar to the perpendicular type, except that the 

angle can be entered in the property window. 

The icon  in the property window helps quickly change the specified angle for 

the complementary one based on 1800. 

 

Line tangent to an arc and passing through arc end 

This configuration is supported by the automenu option: 

 <H> Tangent Line 

First, select the tangency arc. An auxiliary line will be displayed in the screen, tangent to this arc. The line 

will be snapped to the end of the arc nearest to the pointer at the time of arc selection. Move the pointer 

with the rubberbanded node along the line and fix the second node position by clicking  or by input 

into property window. 
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Line tangent to a circle or arc 

 <К> Tangent Line through point 

With this option, select a circle or arc (other elements are disallowed from selection), to which the 

tangency line is to be constructed. The selected element will be highlighted, and the arc will be extended 

by an auxiliary circle. An auxiliary node will be rubberbanding along the circle. This will be the first node 

of the line segment, defining the tangency point between the line and the circle. The line will be 

rubberbanding between the node and the pointer. To complete the tangent line, fix the position of the 

second node outside the circle. 

The position of the second node can be defined arbitrarily by clicking  (use 

object snapping as appropriate), or select an existing node. Besides, one can use 

the property window by specifying coordinates of the node or the length of the 

line or else the angle to the horizontal of the radius pointing to the tangency 

point between the line and arc. 

The position of the first line node will be defined automatically.  

                      

Constructing Arcs 
As is the case of line segments, the set of icons for creating various 

types of arcs is in the pull down menu. Any of the enclosed icons 

can be displayed at the top level of the automenu when sketching. 

Usually, it is the icon corresponding to the last used option in this 

command. 

 

Arc by three points 

 <C> Arc by three points 
 

This option defines the mode of creating an arc by three points. The first and third points are the end 

points of the arc. The second point defines the arc position. 
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The arc can be arbitrarily input by selecting three points with the mouse, or specified exactly in the 

property window. In the latter case, the second point is defined in absolute coordinates or by the offsets 

with respect to the first point of the arc. To define the third point, one can use absolute coordinates, the 

radius, the diameter or the angular length of the arc in various combinations. 

The coordinates of any point of the arc can be specified by offsets with respect to a selected point 

or node in the drawing with the option <Z> ( ). 

 

          

 

             

 

               

Arc by two points and radius 

To create and arc by two nodes, turn on the automenu option: 

 <V> Arc by two points and radius 
 

Use the mouse or the property window to define the two end points of the 

arc being created. After that, the arc will start rubberbanding on the screen 

following the pointer. To fix the arc, move the pointer to the desired 

position and click , or enter the value of the angle or the arc radius 

(diameter) into the property window. 

 
 

       

 

                

 

             

Arc by center and ends  

Creation of an arc with the specified center is done in the mode provided by the option: 

 <B> Central Arc 
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To construct a central arc, specify the center and radius (diameter), as 

well as the start and end angles of the arc. This can be done freely by 

using , or exactly in the property window. After defining the center, a 

circle starts rubberbanding on the screen. The input boxes become 

accessible in the property window for entering the radius (diameter) and 

the start angle of the arc. Those can be defined by moving the pointer to 

the desired position and clicking . Next, move the pointer along the 

fixed circle in the desired direction of the arc, and once more click . 

 

To quickly flip the arc direction, one can use the <Tab> key. Besides, the arc angle can be defined in the 

property window after fixing the input radius and the start angle of the arc with the [Enter] key or 

clicking  in the drawing area. 

 

      

 

         

 

           

At the third step of the arc construction, the system offers snappings to 

typical angles of the arc. 

 

Tangent arc 

To create an arc, tangent to a graphic entity (an arc or a line segment), start the respective mode with the 

icon: 

 <E> Tangent Arc 
 

After that, select a graphic line. The arc will originate in the end node of the 

selected line nearest to the pointer position at the time of selection. In the 

continuous input mode, the arc originates in the end node of the last created 

element. The rubberbanding arc can be moved by the mouse to the desired 

position and fixed. The position of such arc can be specified in exact values. To 

do this, select a graphic line, and then specify the end point coordinates of the 

arc in the property window. Alternatively, one can specify the radius (diameter) 

and the arc angle. In the latter case, first use the mouse to specify the direction 

of the arc.  
 



Sketch. Creating a Non-parametric Drawing. Automatic parameterization mode 

399 

      

 

      

Arc tangent to another arc 

 <N> Arc tangent to arc 
 

This automenu option allows selecting an entity (a line segment, circle or 

arc), to which the arc being created should be made tangent. The selected 

element will be highlighted and projected (extended) up to the full line or 

circle. A rubberbanding circle will appear on the screen, tangent to the 

selected element. The position and the size of the circle change as the 

pointer moves.  
 

The second step is constructing the end node away from the tangency entity, 

for the arc being created to pass through.  This node can be freely defined by 

placing the pointer at the desired position, by watching the coordinates 

displayed in the status bar , or by defining the offsets from 

another node or point (the option <Z>) or by entering exact coordinates in the 

property window. As a result, the rubberbanding circle will pass through the 

specified node, while staying tangent to the entity defined by the step one.  
 

Next, specify the radius (diameter) of this auxiliary circle, either by entering a specific 

value in the property window, or freely by clicking . As a result, the position of the 

auxiliary circle will be fixed. A node will be created at the tangency point between the 

circle and the selected entity.  

What is left is defining the direction of the arc on the auxiliary circle between the two 

nodes. To do this, simply point with the mouse at the desired position.  The 

rubberbanding arc will be flipping following the pointer. After selecting the desired 

position, click , and the arc will be fixed. 

 

    or                                        

Arc tangent to two entities 

 <M> Arc tangent to two elements  
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This automenu option allows creating an arc tangent to two entities simultaneously (circles, arcs or line 

segments). The arc construction begins with subsequent selection of two reference entities defining the 

tangency with the arc. As in the previous case, the selected elements are highlighted. A circle will start 

rubberbanding on the screen, tangent to the selected entities. The position and the size of the circle 

change as the pointer moves. The circle position and size can be modified using the <Spacebar> key. 

Next, define the radius (diameter) of the auxiliary circle, by either entering a specific value in the property 

window or by clicking . As a result, the position of the auxiliary circle will be fixed. The nodes will be 

created at the tangency points between the circle and the entities. 

                     

What is left is to define the position of the arc itself in the auxiliary circle between the two nodes. To do 

this, simply move the pointer to the desired position - the rubberbanding arc will be flipping with the 

pointer. Select the desired position and click . This will fix the arc. 

  or                          

Creating a Circle 
This option, just like previous ones, contains a pull-down list of 

options for constructing various types of circles. 

 

Circle by center and radius  

This type of circle can be created using the automenu option: 

 <O> Circle by center and radius 
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To create a circle, specify the position of the center and the radius (diameter). This can be done freely by 

the mouse , or, alternatively, by entering the exact values of the center coordinates and the radius 

(diameter) in the property window. 

                               

Circle through two points 

 <T> Circle through two points 

This option is intended for creating a circle passing through two points. The two points for the circle to 

pass through can be defined by clicking  or by entering coordinates in the property window. Next, 

define the radius (diameter) of the circle. To do this, specify the third point with the mouse , defining 

the position and the radius of the circle, or, again, resort to the property window. 

 

Circle tangent to one entity 

To create a circle tangent to one entity (an arc, circle or line segment), use the automenu option: 

 <U> Circle tangent to one element 
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The circle construction begins with selecting the element to which the circle will be 

tangent. The selected entity will be highlighted, and a circle will start 

rubberbanding on the screen, tangent to the selected entity. The position and the 

size of the circle change as the pointer moves. Meanwhile, the property window 

allows entering the exact coordinates of a point away from the tangency entity 

defining the circle being created. The position office point can also be specified by 

clicking , or using the option <Z>. Next, define the radius (diameter) of the circle 

by clicking  or in the property window. 

 

 

Circle tangent to two entities 

To create a circle tangent to two entities, use the option: 

 <I> Circle tangent to two elements  

The first step of creating the circle is subsequent selection of two tangency entities. The selected 

elements are highlighted, and a circle starts rubberbanding on the screen, tangent to those entities. The 

position and the size of the circle change as the pointer moves. The position and the size of the circle can 

be changed using the <Spacebar> Key. The position and the radius of the circle can be fixed by clicking 

 at a point away from the tangency entities or via the property window. 

Creating Polygons 

This option also contains a pull down list of icons that allow 

creating a common rectangle, as well as an arbitrary 

equilateral polygon. 

The created polygons are combinations of separate 

segments. Each segment can be edited as a separate entity. 

 

Creating Rectangle by Two Vertices 

To construct a rectangle by two vertices we use following option: 

 <Shift+P> Rectangle by two vertices: 

To construct a rectangle it is sufficient to specify the location of its two opposite corners. The points can 

be defined arbitrarily either with the help of  or by specifying precise coordinates in the properties 

window. 

Creating rectangle by center and vertex  

To construct a rectangle by center and vertex we use the option: 

 <Shift+С> Rectangle by center and vertex 

Construction of a rectangle starts with indication of a central point. Location of the point can be specified 

directly in the drawing’s window with the help of  or by specifying precise coordinates in the properties 

window.  
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Then it is required to specify location of the remaining vertices of the rectangle. This can be done by 

simply indicating location of one of the vertices of the rectangle on the drawing with the help of . It is 

also possible to specify in the properties window the precise values of the height and width of the 

rectangle, but in this case to complete element’s creation it is required, after parameters specification, to 

execute “confirmation” by pressing  in the drawing’s window.  

It is also possible to combine these two methods: to enter, for example, only the height in the properties 

window, and define the width by indicating the point on the drawing. 

                              
or 

                        

Before completion of rectangle’s creation – i.e., before indication of the coordinates of the second point 

(vertex), or the values of the height and width of the rectangle – it is also possible to additionally indicate 

the rotation angle. 

It is possible to define the rotation angle for the rectangle by precise value in the properties window (the 

Angle parameter) or directly on the drawing. By default the Angle parameter in the properties window is 

checked, i.e. the rotation angle is specified only as a numeric value. To specify it in the drawing’s window 

it is required to uncheck it. After that it is possible to specify the rotation angle in the drawing’s window. 
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Creating equilateral polygon  

To create an equilateral polygon, use the option: 

 <Shift+R> Polygon 
 

To first step in creating a polygon is defining its center. The point position 

can be defined either by clicking  or by entering the exact coordinates in 

the property window. In the same window, one can specify the number of 

sides and the type of the polygon (inscribed or circumscribed). Next, 

define the radius and the rotation angle of the polygon. To do this, either 

define a point by clicking , to become a polygon vertex, if inscribed, or a 

midpoint of a side, if circumscribed, or else explicitly enter the radius and 

the polygon rotation angle in the property window. 

 

    or    

Creating Ellipses and Elliptical Arcs 
 

This option, just like previous ones, has a pull down list of icons for 

creating an ellipse or elliptical arc. 

 

Elliptical arc 

To create an elliptical arc, use the option: 

 <Ctrl+M> Elliptical Arc 

After calling the option, define four points: the center of the ellipse, the start point of the arc, the end 

point of the arc and an additional point in the elliptical arc defining its position. The point positions can 

be freely defined by clicking , or entered exactly in the property window. 
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After defining the center and endpoints, an elliptical arc will start rubberbanding 

on the screen following the pointer. The pointer defines position of the additional 

point in the arc. If the rubberbanding arc disappears, that means, the arc cannot 

be created at this pointer position. The point coordinates can also be entered in 

the property window. In a special pane provided in the window, a relevant warning 

message is displayed upon an attempt to enter inadmissible point coordinates. 

 

                                         

Ellipse by center and point  

 <Ctrl+T> Ellipse by center and point  

This option allows creating an ellipse by subsequently defining its center, a point defining the length of 

one ellipse semi axis, and the length of the second semi axis (the radius). As for other sketch entities, the 

point positions can be specified by simply clicking  within the drawing area or by exact values in the 

property window. 

                           

 

                                       

Ellipse through two points 

 <Ctrl+U> Ellipse through two points 

The option allows creating an ellipse by specifying subsequently two points as the ends of one of its semi 

axes and then defining the length (the diameter) or half length (the radius) of the second axis. 
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Constructing Splines 
 

The following group of options provides for constructing splines of 

two main types: those directly passing through the defining nodes, 

and those using the nodes as vertices of the control polygon. Either 

type splines can be either closed or open. Creating sketch splines is 

mostly similar to creating construction spline entities. 

After defining the first node of any spline, the following options 

become available in the automenu: 
 

 

 

<Ctrl+ 

Enter> 
Finish Spline input 

 <P> Set graphic line parameters 

 <Z> Offset 

/  <T> Set direction at Spline start/end 

 <Esc> Cancel selection 
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When defining spline nodes, the curve being created will be 

rubberbanding with the pointer. When creating a spline by control 

polygon, the control polygon will also rubberband. To complete 

spline creation, use the options , . One can also right click  

in the drawing area and select the desired action: cancel spline 

creation, reject selection of the last spline node, finish spline input. 

 

When creating a spline, the property window can be used to define 

the absolute coordinates over current node being created, the 

number of spline segments and the weights (for splines by control 

polygon). 

 

 

Open splines through nodes  

An open spline passing through nodes is constructed using the option: 

 <Shift+H> Open spline through node 

When creating this kind of spline, one can additionally specify end point conditions by using tangency 

vectors. The vector directions are defined by specifying an additional node using the option . If called 

right after specifying the first spline node, the option creates the tangency vector for the spline start. 

Calling the option in the situation, when more than one spline node has been already defined, creates 

the tangency vector for the end of spline. In this case, the last defined node of the spline is considered its 

end, and spline creation completes automatically at this point. 

 

                       

Open spline by control polygon 

An open spline by control polygon is constructed using the option: 

 

 <Shift+J> Open spline on polyline 
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Closed spline through nodes  

A closed spline passing through nodes is constructed using the option: 

 <Shift+K> Closed spline through node 

                         

Closed spline by control polygon 

A closed spline by control polygon is constructed using the option: 

 <Shift+L> Closed spline on polyline 

                            

Creating Fillets and Chamfers 

The options for constructing chamfers and various kinds of fillets between two 

existing entities are also united in one pull down menu. 
 

 

 
<Ctrl+A> Fillet 

 <Ctrl+B> Chamfer 
 

When constructing chamfers and fillets, the existing graphic lines are modified, 

and new ones are created. 

Constructing chamfers and fillets itself is done by simply selecting two 

intersecting segments, or the segments whose extensions intersect. 

Meanwhile, the property window allows defining the width for symmetrical 

chamfers, or the angle for asymmetrical ones, or the fillet radius. 

 

 

Center Lines 
To create center lines for such entities as arcs, circles and ellipses, enter the appropriate mode by calling 

the automenu option: 

 <Ctrl+Q> Axis lines 
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After the, simply select any circle, arc or fillet, and center lines will be created automatically. 

            or             

Creating Offsets 

 <Ctrl+J> Offset of a group of Graphic Lines 

This option is provided for creating offsets to a group of connected graphic entities. The group of 

entities can include line segments and arcs connected into a continuous sequence. 

The offset type is defined in the property window. The flag Automatic selection 

sets the mode of automatic search for line sequences. In this mode, simply select 

by clicking  at least one line in a continuous sequence, and all the rest will be 

found automatically. Should forks be encountered, the automatic search stops. It 

will resume only after specifying the continuation for the search. If the automatic 

search mode is off, each line needs to be selected manually. 
 

Setting the flag Round corners causes automatic filleting of the chain being created. The flag Copy style 

allows transmitting the original line properties onto the offset lines (the type, width, color, etc.). 

In the process of offset creation, the offset being created will be rubberbanding following the pointer. 

The offset position can be defined freely by clicking  or exactly by entering the offset value in the 

property window. 

Manipulations with Line Segments 
Existing line segments can be modified using the option: 

 <Shift+I> Trim Graphic Line 

To trim off a piece of a line segment or any other sketch entity, use the mouse and select the piece to 

trim off. If a free end of a segment was selected, it will be cut off by the nearest intersecting line. If the 

selected portion of a segment or arc is between two intersections, then the selected entity will be cut at 

those intersections. 

                               

The following option allows modifying any sketch entities except a full circle: 

 <Ctrl+I> Extend Graphic Line 
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In this case, the selected entity will be extended or shortened. The position of the pointer at selection 

time is important. The selected element and its extension will be highlighted. If a line segment was 

selected, then the infinite line extension will be highlighted. If it was an arc, then the extension circle will 

be highlighted. The end node nearest to the pointer at the time of selection will also be highlighted. This 

node can be moved by the mouse to either side. The node position and, hence, the new image of the 

entity can be fixed by clicking . Alternatively, you can select a graphic line to which the current entity 

needs to be extended or shortened. 

                                        

To divide existing graphic lines into several pieces, use the options in the 

respective pull down menu. 

To divide an existing graphic entity into two at the specified point, use the 

option:  
 

 <Ctrl+K> Split graphic line 

To do this, select any graphic entity created by the command SK: Create Sketch or G: Create Graphic 

Line. The selected entity will be highlighted, with a node rubberbanding along the entity, dividing the 

entity into two. Clicking  fixes the node position. The node can also be specified as an intersection point 

of the selected entity with another graphic entity (a line segment, circle or arc). To do this, selecte a 

graphic line, whose intersection with the current entity will be the dividing point of the current entity. 

As a result, a node will be created at the specified position, dividing the original entity into two. 

                         

To divide an entity into an arbitrary number of equal parts, use the automenu option: 

 <Ctrl+L> Split to ‘n’ parts 

 

Upon calling the option, specify an entity to divide. If a closed entity was selected (a circle, ellipse or a 

closed spline), additionally specify the start point of division. As a result, the selected entity will be 

divided into the specified number of equal parts. The nodes will be created at the division points. 

 

The number of division parts of the entity is specified in the property window.  
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Modifying splines 

Spline modifications are done somewhat different then other sketch entities. Let's review an example of 

trimming spline using the option . Upon calling the option, pick on the spline near one of its ends 

hanging off the intersection with another graphic entity - a line segment. As a result, the spline will be 

trimmed up to the intersection point. However, the geometrical characteristics of the spline are not 

modified by the section. The spline keeps the same set of defining nodes, it is only the visible image that 

has been trimmed. Instead of a node (that would disturb the spline geometry), a special section point is 

created at the intersection, called a “graphic line intersection”. This point becomes visible only when the 

spline is selected. 

                     

Shortening a spline (the option ) is done in the same way as the trimming – the spline geometry is 

not modified, however, an intersection point is created in the specified position, limiting the spline visible 

image. 

When dividing spline into parts (the options  and ), the new geometrically coinciding splines are 

created, based on the same nodes as the original spline. The number of created splines will correspond 

to the number of divisions. The visible image of each spline will be limited by the trimming points 

according to the bounds of the respective parts of the original spline. In this case, the spline may have 

two trimming points limiting its image. 

The position or the trimming point of a spline can be modified when editing the spline (see the section 

“Editing sketch”).  

Graphic Line Parameters 
Parameters of a graphic entity can be defined or modified at any moment of sketch creation or editing. 

The dialog box defining the parameters is called by the option: 

 <P> Set Graphic Line Parameters 

Detailed description of graphic entity parameters can be found in the chapter “Graphic lines”. 

Working in the Automatic Parameterization Mode 

Let's review in detail working in the auto-parameterization mode. The general rules of creating lines in 

the drawing are the same here as in the sketching mode. Those fully correspond to what was said in the 

previous sections of this chapter. What is different is the result of construction – construction lines and 

based on them constrained nodes are automatically created instead of free nodes.  
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The constructions created by the system in the auto-parameterization mode depend on the type of the 

line being created, the object snaps used in its creation and the line parameters defined in the 

command's properties window. Let's review working in the auto-parameterization mode using several 

simple examples. 

Let's start with constructing a simple segment. To construct such a segment, we need to specify the 

positions of its two nodes. In the sketching mode, the system will create two free nodes in the specified 

points, and a graphic line between them. In the auto-parameterization mode, the created nodes will be 

constrained. The method of constructing constrained nodes may vary.  

For example, if no snaps are used for creating the nodes of such a segment and you do not enter 

parameters in the properties window, then the segment nodes are constructed as follows: 

- For the first node, a vertical and a horizontal line are created at the specified point, whose 

intersection will be the node position; 

- For the second node, two lines are created as well. The first is constructed as going through the 

first segment node at an angle to the horizontal. The second is constructed perpendicular to 

the first line at a distance from the first segment node. 

Using snaps and defining parameters in the properties window could change the described rules when 

constructing a segment. 

Suppose, when defining the second segment node, a horizontal snap aligned to another node was used. 

As a result, the node will be created different from the described above; it will be constructed at the 

intersection of the horizontal line going through the snap node and a line perpendicular to it. If a double 

snap to a circle was used in the same situation, such as “Vertical tangency-Horizontal tangency”, then the 

segment node will be created at the intersection of the lines, which are the horizontal and vertical 

tensions to the given circle. 

 

Parameters defined in the command's properties window have a similar effect on the result of auto-

parameterization. 



Sketch. Creating a Non-parametric Drawing. Automatic parameterization mode 

413 

For example, if the user defines the X or Y coordinate of the node in the 

properties window, then the node will be constructed on the vertical or 

horizontal construction lines with the specified coordinate. 

If, on the other hand, the offsets dx or dy were defined, then the lines for the 

node construction will be created parallel to the vertical or horizontal line 

going through the first node (from which the dx or dy offset was counted). 

The parallel line parameter will have the value from the respective field of the 

properties window. If no horizontal or vertical lines go through the node, 

from which the offset was counted, then those will be automatically created 

by the system.  
 

When defining an angle value, a line will be created going at the angle to the horizontal; when defining a 

length value - a circle of the respective radius. 

If some parameter value is defined by a variable or expression in the properties window, then that 

variable or expression will be entered in the parameters of the respective construction line. This 

rule is applied to all sketch options.  

In the case of a combination of any of the described possibilities, a node is created at the intersection of 

the respective construction lines. 

This approach (defining parameters in the properties window) can be combined with using snaps. For 

example, if only one of the node position-defining parameters is entered in the properties window, and a 

snap is caught, then, after clicking , the node will be created at the intersection of the construction lines 

corresponding to the parameter defined in the properties window, and the snap. 

It is also possible to define only one of the parameters in the properties window and not use any snaps 

(the precise point position in this case is set by clicking  in the 2D window). In this case, the first of the 

construction lines, at whose intersection the created node will be positioned, is defined by the specified 

parameter. As for the second construction line, the following can be used: 

- a vertical or horizontal line (if the X, Y, dx, or dy value was entered in the command's 

properties window); 

- a line at a distance from the start node and perpendicular to the first line (if an angle value was 

entered in the properties window). 

For the second example, let's review constructing a circle tangent to one element. When creating such a 

circle, a node is constructed after selecting the tangency element, through which the circle should go. In 

the sketching mode, then the node is created free. In the auto-parameterization mode, it is created as 

lying on the intersection of two lines (a vertical in the horizontal), or defined by the snaps used in its 

creation. For example, if snapping to a straight construction line was used to define the node position, 

then the node will be created lying on the intersection of that line and a horizontal/vertical line going 

through the specified point. After that, a construction circle is created through the resulting node, 

tangent to the selected element; it is then used to create a graphic circle. 
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Consider another example - constructing a rectangle. In this case, the user needs to define the nodes of 

its diagonal corners. The two other nodes, the rectangle side graphic lines and all necessary constructions 

will be created by the system automatically. The dialog layout in the properties window is fully analogous 

to the dialog for a simple segment. 

The first node of the rectangle is created as a node at the intersection of a vertical and horizontal lines (if 

its position was picked with  in the drawing window or X, Y coordinates entered in the properties 

window), or based on the used snaps. 

The type of other constructions depends on the method of defining the second rectangle node. If it was 

defined by simply clicking in the drawing window with  or by defining the dx, dy offsets in the 

properties window, then the other lines will be created based on the lines of the first node as parallel to 

them. When defining the position of the second node using the “Length” or “Angle” parameters, then the 

construction will be created by being also based on the lines of the first node, but according to the 

specified parameters (similar to the rules described for a segment). Such construction allows obtaining a 

parametric model of a rectangle with a pair of base lines. 

When the second node position of the rectangle is defined by the X, Y coordinates in the properties 

window or using snaps, the constructions are created independent (or just partially dependent) on the 

lines of the first node. For example, if the second node of the rectangle was defined with the absolute 

coordinates in the properties window, then it is created on the intersection of another pair of vertical and 

horizontal lines. Two other nodes of the rectangle are constructed on the lines parallel to the lines of his 

first node in going through the second node. As a result, a parametric model is obtained with two pairs 

of base lines. When editing such a rectangle, two its diagonal nodes will move independent from each 

other. 
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Auto parameterization of other line types is done according to similar rules.  

Please note that snapping to graphic lines (snapping to a graphic line itself, to an intersection of graphic 

lines, to a midpoint of a graphic line, etc.) with the purpose of creating nodes and lines of the drawing is 

implemented by using construction lines underlying the selected graphic lines. By a “construction line 

underlying a graphic line” we mean a construction line that is geometrically aligned with the given 

graphic line and serves as its parent.  

If a graphic line without a parent construction line was selected for snapping, the system will create the 

construction line automatically. The created construction line becomes the parent of the graphic line. For 

example, if a graphic circle line was selected, with a certain radius and the center aligned to a node, then 

the system will create a construction circle with the center at the same node and the same radius. The 

new construction line becomes the geometrical basis for the graphic circle line. Similarly, a spline graphic 

line is converted to a graphic line lying on a construction spline going through the same nodes. For a 

segment with no underlying construction lines, a line is created that is going through the two segment 

end nodes.  

Another common situation is when the general snapping rules in the auto parameterization mode 

require creation of a new construction line which would coincide with an existing one. In such a case, the 

system will be using the already existing line, which helps reduce the number of created construction 

lines. For example, when making a vertical snap to a node, the system must construct a vertical line going 

through the selected node. But if there is already a vertical line through that note, the system will use it 

without creating a new line. 

The drawing process in the automatic parameterization mode can be combined with the conventional 

method of creating a parametric drawing. 
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Editing Sketch 

Sketch editing is done by the command ESK: Edit Sketch. The command is called by one of the following 

ways: 

Keyboard Textual Menu Icon 

<ESK> Edit > Draw > Sketch  

The command can also be called by pointing at a sketch entity in the command waiting mode and 

clicking , or right clicking  and selecting the item “Edit” in the context menu. Alternatively, the editing 

command can be accessed directly from the sketch creation command by selecting the option . 

Sketch lines are treated as regular graphic lines. Thus, for their editing it is also possible to use the 

command EG: Edit Graphic Line. 

After invoking this command, the following choices become available: 

 <*> Select All Elements 

 <R> Select element from list 

 <Esc> Exit command 

After invoking this command, a user can select the sketch line by pointing at it with the cursor and 

pressing . Selected element will be highlighted. Several elements can be chosen either by using 

selection with a window or by selecting successively several elements with the help of <Shift>+ . To 

undo selection of the element, the mouse  together with the pressed left key <Ctrl> can be used. 

After choosing one or several sketch lines the following options will be available in the auto-menu: 

 <P> Set selected Element(s) Parameters 

 <D> Copy Properties from Existing Element 

 <I> Select Other Element 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

If only one line is selected, the following option also appears in the automenu: 

 <O> Create Name for selected Element 

When editing sketch lines, please pay attention to the status of the  icon in the system panel. If it is 

disabled, then editing will be done in the sketching mode. When the option is enabled, editing will be 

done in the automatic parameterization mode. In this mode, just like when creating a sketch, the system 

will be slipping construction elements tied by parametric relations beneath the edited lines. In addition, 

the system will attempt to parameterize not only the edited elements themselves, but also the lines that 
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will be employed for the editing. For example, if the position of one of a sketched line segment nodes is 

changed in the automatic parameterization mode by defining its new position with an object snap to 

another sketched line, then construction lines will be slipped beneath both segments. 

To delete selected elements, use the option . 

Editing a Line Segment 
After selecting a line segment, select one of the segment nodes, the one to move. At this moment, new 

coordinates can be defined for the selected node in the property window. Besides, after selecting the 

node, the segment starts rubberbanding. The rubberbanding image defines the new position of the 

segment being edited. Rubberband the segment by the mouse to the desired position and click . This 

fixes the segment in the new position. 

Editing a Circle, Ellipse, Arc and Elliptical Arc 
If the selected element is a circle, ellipse or an arc (except an arc through three points), the second click  

on the selected entity launches the mode of editing the radius of the circle, ellipse or arc. A new value of 

the radius (diameter) can also be assigned via the property window or by rubberbanding the entity 

image to the desired position and clicking . 

This way of editing is not suitable for an arc constructed through three points, and an elliptic arc. In this 

case, after selecting the arc, you need to select a node the arc is passing through, and move it to the 

desired position or enter the new placement coordinates of the node in the property window. 

There is yet another way to modify any type of an arc or fillet. Select one of the end nodes of the 

selected arc, and then move the rubberbanding image of the arc into the desired position. 

After selecting the arc of a circle an additional option becomes available in the automenu: 

 <Tab> Change Arc Direction 

This option replaces the selected arc with another arc of the same circle. When applying this option to 

the arc constructed by 3 points, the middle (second) node of the initial arc is automatically removed. 

Editing Spline 
After selecting a spline, the automenu gets an additional option: 

 <Ctrl+X> Switch to “Insert Point” mode 

This option allows adding an additional point to a spline. After calling the option, select a spline node 

nearest to the additional node location. Then pick the side where the new node should be created with 

respect to the selected node, and then define its position. 

To edit an existing node, select it after selecting the spline. The node and the whole spline will start 

rubberbanding following the pointer. The new position of the node can be specified by simply moving 

the pointer to any location and clicking , or by specifying new coordinates of the node in the property 

window. The same window provides for entering the new weight value of the node (for splines by control 

polygon), as well as the number of spline segments. 
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To delete an existing spline node, select the node and then use the option . 

When editing a spline that was divided or trimmed, one can also change the position of the trimming 

points (the intersection points) of the spline image. These points are highlighted when the spline is 

selected, and become available for selection. The selected point can be moved along the spline and fixed 

at a new position by clicking . 

                     

            

When selecting the open spline for editing by nodes, the options for specifying directions of the tangent 

vectors for the spline end points will be also available in the automenu: 

 <F> Set direction at Spline start 

 <E> Set direction at Spline end 

 



 

 

DETAILING ELEMENTS 
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HATCHES AND F ILLS 

Hatches and fills are created by the command H: Create Hatch. Hatches are used, besides the primary 

purpose, as a means of various manipulations: as contours for hidden line removal, as profiles and as 

base data for creating three-dimensional models (in T-FLEX CAD 3D only). 

The hatch or fill area may consist of a single or 

multiple contours. The left diagram shows a single-

contour hatch, and the right one – a three-contour 

hatch.               

Since the contour lines are “tied” to construction 

elements, modifications of the latter result in 

appropriate adjustment of the boundaries of hatch 

contours. 
     

Various hatch attributes provide control over the contour filling pattern, ranging from standard to special 

technical ones to even various artistic types. Fills provide filling of the profile area with the specified 

color. 

Custom hatch types can be defined if not found among the standard ones provided by T-FLEX CAD. See 

details in the chapter “Creating user-defined lines and hatches”. 

Applying Hatches 

Enter the command H: Create Hatch. The command is called as: 

Icon Ribbon 

 

Draw → Draw → Hatch 

Keyboard Textual Menu 

<H> Construct > Hatch 

 

The following options are available to the user: 

,  <Ctrl><F> Free mode on/off toggle 

 <P> Set selected Element(s) Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <F5> Preview mode 

 <X> Automatic Contour search parameters 

 <A> Automatic Contour search mode 
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 <A> Manual Contour input mode 

 <N> Select Node (in Manual Contour input mode) 

 <C> 
Create full Circle Contour (in Manual Contour 

input mode) 

 <E> 
Create full Ellipse Contour (in Manual Contour 

input mode) 

 <S> 
Create full Spline or Polyline Contour (in Manual 

Contour input mode) 

 <F4> Execute Edit Hatch command 

 <Esc>  Exit command 

Hatch Parameters 

To define hatch parameters, call the option <P>. This will bring a dialog box on the screen, named “Area 

Parameters”. Some of the hatch parameters can be defined on the system toolbar (see the topic 

“Defining Hatch Parameters on the System Toolbar”). 

Note that defining parameters prior to inputting the hatch contour makes the settings default for all 

future hatch creations. To set parameters for one particular hatch, do so in the middle of the hatch 

creation. 

“Filling” Tab 
Common parameters for all types of filling 
 

Filling method. This item defines the way of 

filling the contour. The parameters for 

each of the ways are described below. 

Use for hidden line removal. In this case, 

the contour will be used for removing 

hidden lines. Any elements with lower 

priority will be hidden behind the hatch. 

This is true for assemblies as well. 

Profile. With this parameter set, the hatch 

will be used as a profile for generating a 

profile file in the command PR: Write 

Profile. This is necessary for displaying 

geometrical information about the 

contour of a part for further processing.  
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Level. This is an integer in the range from -126 to 127. The level defines whether the hatch will be 

displayed upon a redraw. 

Priority. This is an integer in the range from -126 to 127. The priority defines the order of drawing 

graphic elements on the screen (the greater the priority, the “more prominent” is the element). 

Layer. Defines the name of the current layer. 

Color. The hatch color can be selected from a table or by number (0-256). 

Hatch parameters 

A hatch can be filled with solid lines with any slant angle in one or two directions. 

Angle. The slant angle in degrees with respect to the X-axis. 

Step. The distance between hatch lines. 

Second hatch. With this attribute set, hatching is done in two directions. 

Line thickness. Defines the hatching line thickness. 

Circular. With this flag on, hatching is done in concentric 

circles with specified parameters (step, color, line 

thickness, etc.). In the case attachment point is not 

selected, the position of the center is defined by the 

system automatically. Otherwise, the center is placed in 

the attachment point.  

Fill parameters 

 

A fill type is defined by the Blend Colors options. You can make the 

following choices in the drop-down list: 

No. Filling is done with solid color. This hatch does not have 

additional parameters, besides the common ones for all 

filling methods. 
 

Linear. This fill uses a linear color transition. The scale displayed in the parameters dialog shows 

the fill palette. By default, a scale of gray is used for the color transition (from white through 

tones of gray to black). 
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The scale palette can be modified by defining arbitrary colors in arbitrary quantities. 

 

To define a new color, double-click  anywhere on the scale. A standard Windows dialog for 

defining color will appear. After selecting a color and closing this window, the specified color will 

appear on the scale. A color position on the hatch transition scale is indicated with a triangular 

marker below the scale. Using the marker, you can set the new position of the color on the scale. 

To do this, point to the desired marker, depress  and, while holding the button down, drag the 

marker to the desired position. 

To delete a color from the transition scale, drag its marker out of the scale. To modify one of the 

transition scale colors, double-click  on the respective color marker. 

You can also use the context menu accessible by right clicking  on the scale image in order to 

set up the color transition scale. 

 

A color scale setting can be saved into an external file “*.col” in order to quickly load it in the 

future. 
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An additional parameter Angle defines the fill rotation angle. 

Circular. This is a fill with a circular color transition. Its parameters are similar to those of a fill with 

the linear color transition, except for the fill angle (it is not defined for a circular hatch). 

You can define the center of a fill with a circular transition. To do this, when editing such a field, 

define its start point. For details, refer to the section “Editing Hatches and Fills”, the topic “Defining 

the Hatch Start Point”. 

Filling pattern parameters 

With this area filling method, the hatch type is defined by a description stored in a file of a special 

format. The descriptor file of the standard T-FLEX CAD hatches is stored in the “PROGRAM” folder under 

the name “TCAD.PAT”. The name of the standard hatch pattern file is defined in the command Customize 

> Options….  

The same format is used for the hatch pattern descriptor file as in AutoCAD system. If some type 

of hatching is not available, it can be created by the user or copied from AutoCAD system. 

In the cases when standard hatches do not suit the user, then user-defined hatch types can be created. 

Special format files “*.grb” are used for the user-defined hatch descriptors. These files are located in the 

…/Program/HatchPatterns folder. More on this is in the chapter “Creating user-defined lines and 

hatches”. 

The additional parameters of filling by pattern include: 

Type. Defines the filling pattern. The type is selected from a 

list containing standard and user-defined hatch types. 

Size. Defines the scale factor of the pattern hatch. With a very 

small scale factor the hatch may appear as a solid fill.  

 Angle. Defines the slant angle of the hatch. 

 Line thickness. Defines line thickness, used when drawing a hatch by pattern. 

Not Visible hatch 

With this hatch type set, the hatch will not have its own graphical representation on the drawing. This 

may be necessary if the hatch is used solely for hidden line removal, or for creating a 3D profile or a 3D 

model. 

“Outline” Tab 
The hatch contour can additionally be outlined with lines. This is handy when the hatch contour is 

defined based on construction lines and nodes, in the absence of graphic lines. The hatch outline lines 

are set up in the same way as common graphic lines. 

Defining Hatch Parameters on the System Toolbar 
When creating and editing a hatch, some of the parameters can be defined directly in the system toolbar, 

without using the <P> option: 

Color box . Indicates the line color of the hatch being created or edited. 
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Fill method box . Defines the hatch contour filling method. 

“Use for hidden line removal” icon .  

Depending on the fill method setting, the system toolbar may have additional fields: 

Hatch: 

Hatch slant angle input box . 

Hatch line step input box . 

By pattern: 

Hatch slant angle input box . 

Hatch scale factor input box . Defines the scale factor of the hatch. 

Pattern type input box . 

Copying Parameters from Existing Hatches 
The values of parameters of the hatch being created can be quickly copied from an already existing 

hatch. To do so, use the option: 

 <Alt+P> Copy Properties from Existing Element 

This option is available in the automenu of the command before creation of the hatch has started 

or during the process of its creation. 

After the option is invoked, it is sufficient to indicate the hatch whose parameters' values must be 

transferred to the hatch being created. 

To assign the copied values of parameters to all new hatches, enable the additional option before 

selection of the original hatch: 

 <S> Set Properties as Default 

When this option is enabled, the copied parameters will be stored as default parameters. 

This option simplifies creation of hatches with identical parameters. However, it does not allow us 

to copy individual parameters or parameters from an object of another type. In such cases, it is 

more convenient to use the general mechanism of editing parameters of the elements in the 

properties window. 

Hatch Result Preview 
There is an option to view the result of hatching without confirming the operation’s creation in the 

command: 

 <F5> Preview mode 
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When this option is enabled, in case of presence of a closed contour or contours, the hatch being 

created is immediately displayed on the screen with the same parameters as defined in the 

command. 

Defining Hatch Contour 

The hatch contour can be defined in two modes, the automatic contour search mode and the manual 

contour input mode. 

Automatic Hatch Contour Search Mode 

To activate this mode, press the  icon in the automenu or type <A> on the keyboard. This mode 

works only with the graphic line contours. To find a hatch contour, position the pointer at a point lying 

inside the anticipated hatch contour, and click . The found contour will be highlighted. If automatic 

contour search lasts longer than three seconds, a window is displayed with the [Cancel] button. 

Successful definition of a hatch contour requires the graphic lines to 

form “tight” contour (with no gaps). 

The result of the automatic tracing is affected by the parameters set for 

this mode. The automatic search parameters are defined in a dialog 

called by the option . In this dialog window, first of all specify the 

types of the graphic lines to be considered in the automatic search for 

the hatch contour.  

The threshold value of the gaps between graphic lines is determined by 

the parameter “Gap”. If the graphic lines pass at the distance, which is 

less than or equal to that defined by the given parameter, then the 

system will assume that they have an intersection point and may 

therefore include them in the hatch contour.  

The Search: parameter allows defining more specific requirements to the result of tracing a hatch 

contour. If this parameter has the External contour value, then the system will search for the largest 

closed contour. The internal contours are ignored in this case. When using the Internal Contours value, 

the system finds the minimal contour which still contains the position of the pointer while searching. The 

internal contours processing depends in this case on the state of the additional flag Search for Islands 

(Holes). If this flag is set, then be found internal contours are included in the resulting hatch contour (so 

that the identified islands are not filled with a hatch). When the flag is cleared, the internal contours are 

ignored. 

Scanning for hatch contours may take a while on very crowded drawings. Search can be restricted per 

the Only on Visible Part of Page flag. In this case, only the entities will be processed whose outline boxes 

overlap with a portion of the drawing display on the screen. An outline box is the least horizontally 

oriented rectangle that fully covers the entity. Examples of outline boxes and contour processing 

situations are shown on the following diagrams. 
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Scan Fragment Lines flag will add lines of 2D fragments for scanning the hatch contour. This flag is set 

off by default meaning that lines of the fragments will not be considered when searching the closed 

contours. 

Several contours can be selected subsequently. Should there be common graphic lines between different 

contours, the contours get automatically joined along these lines. 

Manual Hatch Contour Input Mode 
When manually defining a hatch contour, object snapping is active. Moving the cursor over a drawing 

element modifies the cursor appearance accordingly and pre-highlights the element. The object 

snapping can be turned off by pressing on the icon on the “View” toolbar. In complicated situations, 

when snapping to the right element is difficult, the elements can be selected by typing commands on the 

keyboard as described below. 

If you would like to use already created construction entities as a contour, make sure to be in the 

constrained drawing mode rather than in free drawing. See that the icon  appears in the automenu. 

The first step in the manual definition of a hatch contour is selection of the start point. One can select an 

appropriate 2D node, or create one by clicking at an intersection of construction lines. Next, define the 

contour sequentially.  

The following options become available after selecting a node: 

,  <Ctrl><F> Free Mode On/Off toggle  

 <End> Close Contour 

 <Tab> 
Change arc direction (available when making 

contour along a circle) 

 <Space> 
Select Graphic line (available after selecting a 

node) 

 <N> Select Node 

 <L> Select Line 

 <C> Select Circle 

 <E> Select Ellipse 
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 <S> Select Spline 

 <A> Select contour automatically 

 <BackSpace> Delete last Contour segment 

 <Esc> Cancel selection 

The simplest way of defining a hatch contour is using the <Space> bar that will let you traverse the 

contour by following graphic lines. Note that this way can only be used when the hatch contour follows 

graphic lines. In the case of multiple choices, the cursor should point at the desired graphic line when 

pressing the <Space> bar. 

                       

For faster selection, use the <A> option that automatically searches for the next contour line until the 

contour is closed or a dubious situation is encountered (such as branching lines). 

The system can be set up for selecting only construction lines when defining a hatch contour in snapping 

mode, and not graphic lines. This option can be set in the system customization dialog box under 

Customize > Options…, the Snap tab. 

A contour can be defined using the same actions as in graphic 

line creation. That’s defining subsequently the lines of the 

contour, each having the start and end nodes and is constrained 

to construction entities – a line, a circle, an ellipse or a spline. To 

define the start or end of a line of the contour, select existing 

nodes (the <N> key) or create new ones (the <Enter> key or ) 

at two-line intersections. 
 

As in graphic entity creation, to define an arc one needs first select a start node on the arc, and then 

select the circle by typing <C>. Otherwise, the contour will gain the segment between the two nodes 

instead of the arc.  
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When creating a contour along an arc, the arc direction can be flipped by the option . 

To create a full circle contour, point at the circle and type 

<С>. 

Similarly, ellipses, splines, 2D paths and functions can be 

included in a contour. 
        

In complex cases, when several nodes coincide, the end nodes of the contour lines can be specified by 

selecting two construction lines whose intersection yields the desired node. This is done in object 

snapping mode via the options <L>, <C>, <E>, <S>, for lines, circles, ellipses and splines respectively. 

        

In dubious cases, when several construction lines intersect in one point, all necessary nodes can better be 

created in advance by using the command N: Construct Node. The contour then can be defined using 

the option <N>. 

To cancel the last contour line input use the <BackSpace> key. 

If the end node of a contour line coincides with the start node then the contour automatically closes, as 

indicated by a changed color of contour lines display on the screen.  

The contour can also be closed using the option: 

 
<End>, 

<Home> 
Close Contour 

This closes the contour with a straight line from the current node to the contour start. 

If the hatch contains several contours then the next contour can be input after closing the current one. 

To complete hatching, upon defining the contours use the following option: 

 <End> Finish input (creates hatching) 

The hatch area then gets filled according to the defined hatch parameters. 

To confirm the hatch user can also apply the dynamic toolbar. 
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In case if the user wants to refuse the usage of this capability in the given mode, it can be disabled by 

using the "Do not use in current command" command found in the context menu invoked for the given 

toolbar. 

To cancel an action of a contour segment input or the whole 

contour definition, right-click  or press <Esc> key. Upon clicking 

 the “Right button action” dialog box pops up. You can select the 

command to execute in this dialog: 

Cancel element creation. This cancels hatch contour input. 

Cancel last element selection. This cancels the input of the 

last segment of the hatch contour, bringing the contour 

definition one step back. 
 

Finish element creation. This command closes the contour automatically with a straight line. 

The dialog box won’t be displayed again if the option Don’t show this dialog in future was set. The right 

mouse button click will in this case execute the command checked in the dialog box last time it was used. 

Editing Hatches and Fills 

To modify hatches or fills, use the command “EH: Edit Hatch”: 

Keyboard Textual Menu Icon 

<EH> “Edit > Draw > Hatch”  

Select a hatch or a fill by clicking . One can also use element selection from list, if the element was 

named. Upon selecting a hatch or fill, the following actions can be performed: 

Modifying Hatch or Fill Parameters 
This is done via the option <P> that lets modifying hatch (fill) parameters (see parameter description 

above). One can change the hatch type, for example, from pattern to solid fill. This will fill the contour per 

the settings for new fill creation. 

As in hatch creation, some of the parameters are accessible from the system toolbar upon hatch 

selection. 
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Deleting the Whole Hatch or Fill  

To do this, press the <Del> key (the icon  in the automenu).  

In the case when a hatch is referenced by the 3D model, its direct deletion is impossible. The user will 

have to delete all dependent elements referencing the hatch, which may not be desirable. In such cases, 

it may be possible to edit the hatch contour. This opportunity is described below. 

As in the case of any other model elements, multiple selection of hatches is supported for simultaneous 

deletion or modifying their parameters. 

Adding a Contour to a Hatch or Fill 
This is done similar to hatch (fill) contour initial input. Suppose, given a hatch, we’d like to make a hole 

within. To do this, select the hatch and turn on the contour addition mode (the icon  or <M> key). 

Then, using the option <С>, input the additional contour – a full circle, and press <End>. The result will 

be a hatch with a “cut” hole. 

  

C

   

Redefining Hatch Contour 
Select the hatch whose contour is to be redefined, and use the option  

 <К> Redefine Hatch Contours 

To input a new hatch contour, using manual or automatic contour input mode. The edited hatch will 

assume the new shape upon confirming the input with the  option. 

Defining the Hatch Start Point 
A start point can be defined for a hatch (either the regular or by pattern or for a fill with a circular color 

transition). The start point defines the location from which hatching begins.  

 

The start node can be defined by the option: 

 <O> Select Starting Node of Hatch 

Upon calling the option, simply click the desired node with . 

To reject the start node input, use the option:  

 

 <T> Cancel selection of starting Node of Hatch 
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Displaying the Contour Point Numbers of a Hatch 
To toggle the display of the contour point numbers of a hatch, use the option: 

 <Q> Show/Hide contour point numbers 
 

With the option turned on, the points in the all hatch contours are enumerated based on 

their position in the contours and the contours direction. Points, belonging to the 

different contours, are enumerated independently. The point numbers are displayed next 

to the respective nodes. When several subsequent points of a contour coincide, their 

numbers are displayed next to each other, separated by commas. 
 

Editing a Particular Contour  

Note: only manually defined hatch contours can be edited. 

First, select the hatch that includes the desired contour. Then, turn on the contour editing option using 

the option: 

 <М> Contour edit mode 

Now, select the desired contour. The selected contour can be deleted or edited. To delete it, press the 

<Del> key. When picking a contour, the segment of the contour nearest to the cursor gets automatically 

selected. Now, the necessary modifications can be done with the help of the automenu. 

The following options become available upon selecting a contour segment: 

 <I> Switch to “Insert Point” mode 

 <Q> Show/Hide contour point numbers 

 <Del> Delete selected Contour 

 <R> Change Contour direction 

 <F> Move Contour starting point forward 

 <B> Move Contour starting point backward 

 <N> Select Node 

 <L> Straighten Contour Segment 

 <C> Select Circle 

 <E> Select Ellipse 

 <S> Select Spline 

 <Tab> 
Change arc direction (available when editing an arc 

segment of a contour) 
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 <A> Link Arc or Circle to Node  

 <K> Break Link with Node  

 <Esc> Cancel selection 
 

Note: the options  and  only are available for editing the contours defined automatically 

with the option , constructed on top of 2D projections or as a copy of an existing hatch. 

When editing a contour, the following actions are supported: node deletion, node addition and 

redefinition of the type of lines connecting the nodes. Besides, one can change the contour direction, 

move the start point back and forth, link arc segments of a contour to nodes. 

Flipping contour direction to the opposite 

The contour direction is an important hatch property when creating 3D elements. This parameter is 

inherited by the 3D profiles created based on hatches. For example, the 3D operation Loft matches 

profiles by the start points of the respective contours and requires matching of contour directions as 

well. 

To change the direction of a 3D profile constructed based on a hatch, you need to change the hatch 

contour direction. 

The contour direction is shown by the arrow displayed upon selecting the contour. This arrow also 

indicates the start point of the contour. 

The following steps are to be done in order to change a hatch contour direction: 

- Call the command EH: Edit Hatch; 

- Select a hatch for editing; 

- Turn on the contour editing mode (the icon  or <M> key); 

- Select the contour (point the graphic cursor at and click ); 

- Flip the contour direction (the icon  or <R> key); 

- Confirm changes by the   icon or <End> key. 

Moving around contour start  

The contour start is the first node selected during the manual hatch contour input. 

If the contour is defined automatically or without node selection (as by a full circle), the start point is 

defined automatically. 

The start point placement and contour direction (see above) can only be changed for the contours 

defined manually. 

To move the contour start point, do the following steps: 

- Call the command EH: Edit Hatch; 

- Select a hatch for editing; 
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- Turn on the contour editing mode (the icon  or <M> key); 

- Select the contour (point at it with the graphic cursor and click ); 

- Move the start point forward (the icon  or <F> key) or backward (the icon  or <B> key); 

- Confirm changes by the  icon or the <End> key. 

Editing a particular segment in contour 

To edit a contour segment, do the following steps: 

- while in contour editing mode, select the desired contour segment; 

- select the construction element defining the new contour segment: line, circle, ellipse or spline (use the 

appropriate option for element selection). The end nodes of the contour segment must be snapped to 

the selected construction element; 

 - confirm changes by the  or <End> key. 

Let’s review an example illustrating a particular contour segment editing. The 

diagram shows the original hatch constructed along construction lines using 

the “Outline” option. Here, a straight-line segment is to be replaced by a 

spline. 

To do so, call the command EH: Edit Hatch and select the hatch. Then, turn on 

the contour editing mode using the option: 
 

 

 <M> Contour edit mode 

Select the hatch contour. The following diagram shows the situation after the hatch selection. The 

contour is highlighted, and the nodes are marked by little boxes. Move the cursor over the desired 

segment of the contour and click the left mouse button. The selected contour segment also gets 

highlighted, and the nodes marked by larger boxes. This state is shown on the center diagram. Move the 

cursor over the spline constructed through the nodes of the contour being edited, and select it as a 

contour segment by typing <S>. 

  
S

   

Similarly, one can replace a contour segment by an arc or ellipse, if the respective circle or ellipse 

is constructed based on the marked nodes. Simply use the appropriate option: <C> or <E>. If the 

new contour segment was not constructed based on the marked nodes yet passes through them 

then the contour segment editing should be done via the option “Switch to ‘Insert Point’ mode” 

(the icon  or <I> key). This option functionality is described below. 
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The edited segment will then assume the desired shape. The system is still in the mode of modifying the 

selected contour segment. If the manipulations with this segment are over, complete the contour 

segment modification mode. To do so, press the  icon in the automenu. 

The option <Space> is not available for editing the contour. Therefore, it is impossible to snap a 

contour line to a graphic line. If a contour segment is to be replaced by a graphic line while 

editing, as, for instance, a wave line, then you need to construct a spline based on the wave line. 

The intended hatch contour segment can then straightforwardly be replaced by the spline. 

Linking arc contour segment to helper node 

If the edited contour segment is an arc then the option for linking to a helper node  becomes 

available in the automenu. This node will be defining the choice of an arc constructed on top of the circle 

to be used for the hatch contour. As the drawing gets modified, the hatch contour will pass by the arc 

nearest to the linking node. 

Let’s review an example where a construction line position is modified with respect to a reference line 

driven by a variable “K”. Both circles here are linked to a node on the drawing in order to ensure correct 

position. The left diagram shows the hatch contour in the original configuration (K=1). Let’s link the arc 

segment of the hatch contour on top of the outer circle to the marked node. To do this, do the following 

steps once in EH: Edit Hatch command: 

- Call the hatch contour editing option ; 

- Select the arc; 

- Call the option ; 

- Select the linking node. 

The right diagram shows the modified drawing with the “К” key equal to (-1). The contour segment on 

top of the upper circle was linked to the marked node and adjusted correctly. The contour segment on 

top of the second circle was not linked to the node, which resulted in an incorrect configuration. 

            

To clear or redefine the linking node, use the option . 

Deleting a node on a contour  

To delete a node on a contour, do the following steps: 

- Call the command EH: Edit Hatch; 
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- Select a hatch for editing; 

- Turn on the contour editing mode (the icon  or <M> key); 

- Select the contour segment the node is snapped to (point at with the graphic cursor and click ); 

- Select the node (point at with the graphic cursor and click ); 

- Delete the node (the icon  or <Del> key); 

- Confirm changes (the icon  or the <End> key). 

The resulting new hatch contour passes through two adjacent nodes. 

             

 

Modifying a contour node position 

To modify a contour node position, do the following steps: 

- Call the command EH: Edit Hatch; 

- Select a hatch for editing; 

- Turn on the contour editing mode (the icon  or <M> key); 

- Select the contour segment of the node (point at with the graphic cursor and click ); 

- Select the node (point at with the graphic cursor and click ); 

- Move the node to the desired position (the contour rubberbands after the cursor as the node is being 

dragged); 

- Fix the node (click  over an intersection point or type <N> key for an 

existing node); 

- Confirm changes (the icon  or the <End> key). 

As a result of moving, the node point will be connected with the 

neighbor nodes by straight line segments belonging to the contour 

(regardless of the former adjacent segment entity types). 
          

Creation of additional nodes on a contour  

To create additional nodes on a contour, do the following steps: 

- Call the command EH: Edit Hatch; 

- Select a hatch for editing; 

- Turn on the contour editing mode(the icon   or <M> key); 

- Select the contour segment to split by new node(s) (point at with the graphic cursor and click );  
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- Turn on the point insertion mode (the icon  or the <I> key), and click on a contour segment. The 

segment becomes split in two, with the new node between them. The node and the segments 

rubberband with the cursor, the solid line segment connecting to the previous node and the dashed line 

one to the next. The order of the nodes after the insertion will be determined by the system 

automatically, depending on the hatch contour direction. Do not click on a segment near a vertex, as, 

instead of adding a node, this will start moving the existing node; 

- Close the contour between the newly created node and the successive one. 

Contour input is complete once the closing node is selected, or the icon  or the <End> key is 

pressed. 

The system returns to the mode “Contour selected for editing”. One can do other modifications, 

and then confirm all changes. 

- Confirm changes (the icon  or the <End> key). 

Let us illustrate the above with a specific 

example. Suppose, a hatch contour needs to be 

edited that was originally constructed along 

construction lines using the “Outline” option. The 

original and target configurations are shown on 

the diagrams.        

To get the result, begin with calling the command EH: Edit Hatch. Next, select the hatch and turn on the 

contour editing mode. Select the hatch contour to be modified. Now, to get the result, perform 

manipulations shown on the following diagrams 1 – 8. 

        

A

 

I

     

C

    

Upon selecting the closing node (see diagram 8) the contour automatically closes, and the point 

insertion mode exits. What is left is to press the  icon or the <End> key, and the contour editing task 

is completed.  

One comment to the described procedure: as the contour segment to be modified is selected (see 

diagram 5), the system will define the previous and the next nodes in the sequence, depending on the 
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hatch contour direction. These will be identified by the dashed and solid rubberbanded lines. In this 

particular example, the hatch contour direction is clock-wise. 
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D IMENSIONS 

T-FLEX CAD supports all types of dimensions, recommended by the standards ISO, ANSI and AR_ANSI.  

T-FLEX CAD dimensions are tied to straight construction and graphic lines and nodes, except for the 

radius and diameter dimensions, whose position is defined by the circle they dimension. 

Applying Dimensions 

To apply a dimension, use the command D: Create dimension: 

Icon Ribbon 

 

Draw → Title Block → Dimension 

Keyboard Textual Menu 

<D> Construct > Dimension 

The user then gets access to the following options: 

  <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

  <N> Select Node  

  <L> Select Line  

 <C> Select Circle  

 <Y> Create radial Dimension with stepped line 

 <A> Create Arc dimensions 

 <Q> Create Dimensions by one Image Line 

 <F> Angular Dimensions by Four Nodes 

 <T> Linear Dimensions by Three Nodes 

 <O> Set Cone Dimension 

 <B> Create Dimensions from one baseline 

 <Ctrl+B> Create Dimension Chain 

 <S> Create ordinate dimension 

 <E> Leader Dimension 

 <X> Dimensions from Axis 

 <Shift+C> Dimension between two circles 
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 <F4> Edit Dimension 

 <Esc> Exit command 

Upon calling the dimension creation command, one can click  near any construction or graphic line. The 

line will be highlighted. Alternatively, point the mouse at a line and type <L>. In addition, one can select 

a node (the key <N>) or a circle (the key <C>).  

Depending on what was selected at this step, different options are provided for further construction. 

Dimensions between Two Straight Lines or between Line and Node 
If the first selected element was a line, proceed with defining the second 

dimension reference element. 

To construct a linear dimension, the second element can be another line parallel to 

the first one, or a node. To construct an angular dimension, select another line 

positioned at an angle to the first line.   

Upon drawing dimension between two lines, the system itself finds the nearest nodes lying on these lines 

and ties the origins of the extension lines to them. While doing it, however, there is always a possibility to 

reassign the nodes to which the dimension will be tied. 

The following set of icons will be available in the automenu: 

  <L> Select Line  

  <N> Select Node  

 <Esc>  Cancel selection 

Obviously, the second dimension reference element can be selected using the common T-FLEX 

technique. One can click  or type <L>, while pointing the mouse at a construction line. One can select a 

node using the option . This creates a dimension between the line and the node. 

Once the second dimension reference element was selected, regardless of the selection technique, a 

dimension will start rubberbanding on the screen following the pointer movement. The start point and 

the end point of the dimension line will be marked by numbers: “1” – the start point of the dimension 

line, “2” – the end point of the dimension line. 

 

You may use special floating toolbar with options - icons and markers that allow changing dimension 

position, arrows style and dimension text. 



Dimensions 

441 

 

You can enter text Before, After and Under on the toolbars that appear after clicking on one of the  

icons. Drop-down lists  includes standard texts Before, After and Under. Context menu appears, when 

you press right mouse button in the text field. 

 

You can apply Before and After text insertion by pressing <Enter>. You can cancel text insertion using 

<Esc>. 

You can select sign for the dimension value from the drop-down list after clicking  icon. 

 

You can set parameters for the  arrows in the special toolbar that appears after clicking  icon under 

the arrow. 
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Option  allows to clear background. Option  enables/disables the same arrows for the 

dimension. 

You can move toolbars. Place cursor on  icon and move cursor, holding  button.  

Dynamic toolbar with Place leader , Center dimension text , Dimension with jog  options 

appears under the dimension, when you place cursor on it. 

 

To specify dimension location and to align it according to another dimension you can use the special 

control marker. 

 

If dimension is on a jog, you can specify the jog length using special control marker. 

 

Options Hide jog  and Remove jog  are available for the dimension with jog. 

 

Option Remove leader  is available for dimension on leader. 
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The new options that appear in the automenu, hint of further possible actions. This relates to either the 

linear or the angular dimension (in the case when the two selected lines intersect). 

The available options after specifying the dimension references are: 

 <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

 <Z> Change leader line jog orientation 

 <Z> 
Change Dimension Orientation (for angular 

dimension) 

 
<Spacebar

> 
Place Dimension in absolute coordinates 

 <T> Tie Dimension to Node 

 <J> Center Dimension Text 

  <D> Change Sign 

 <N> Select insertion Node 

 <M> Change Dimension Type 

 <K> 
Break relations 

(available if dimension is tied to the node) 

 <Esc> Cancel selection 

After selecting two lines to be dimensioned, one can click , while pointing the mouse at the desired 

position of the dimension. Before clicking, one can define parameters of the given dimension by calling 

the option , as well as specify position of strokes of the dimension entity. This can be done primarily 

with the options <Spacebar> and <T>. Presented below are several examples of dimensions that can be 

created between two lines or a line and a node. Parameter definition is described below, after the 

description of other dimension types. 
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Let’s review the process of tying the dimension witness lines using the options  <Spacebar> and 

<T>. This process is optional and necessary only when the dimension entity strokes must be strictly 

tied to the construction elements in the drawing. 

Example of option Tie Dimension to Node  usage: 

Let's create a dimension by two lines and press <T> once. The dimension will be fixed in the position 

next to the node. After that we move cursor up and create a leader line extension.  

The Center Dimension Text  option should be disabled. 

If we press <T> one more time, the leader will be tied to the nearest node. 

 

Example of option Place Dimension in absolute coordinates  usage: 

When you type <Spacebar> for the first time the dimension will be fixed at the specified distance from 

the object. If you move cursor up, create a leader line extension and press <Spacebar> again, a leader 

jog will be created. 
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If the Center Dimension Text  option is enabled, the second spacebar pressing will create a 

leader line extension. 

 

The third subsequent use of the option <Spacebar> causes creation of the leader jog attached to the 

center of the leader line. 

The fourth subsequent use of <Spacebar> will switch dimension into “invisible leader” mode. There will 

be no leader lines but text will remain and will behave like if it is located on a leader. This mode allows 

locating text in arbitrary place. 

 

The fifth subsequent use of <Spacebar> reverts the dimension to the original state. 

Note, that use of options <Spacebar> and <T> is recommended, when you want to strictly define the 

dimension position through parametric modifications of the drawing. When modifying positions of the 

nodes to which the dimension strokes are tied, the dimension position will be changing accordingly.  

To break a tie to a node, use the option . If you click on the marker that indicates node to which the 

dimension is tied, the relation will be broken automatically and the option will not appear. 
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The option  allows explicitly assigning the tying nodes for dimension strokes created on the 

construction lines (by default, the system selects the node on the selected line nearest to the dimension 

position). Suppose, the lower witness line in the first drawing is tied to the default node. Let's specify 

another tying node using the option <N>. The modified dimension is shown on the right hand side 

diagram. 

 

With the option  turned on, the dimension text will be centered between the witness lines. Without 

the option, the dimension text is positioned wherever the mouse click occurred. 

The option  allows quickly changing the dimension prefix symbol (“R”, “”, “M”, “”, “”), without 

calling the dimension parameters dialog box. 

 

When creating a dimension with a jog, the option  (<Z>) will help changing the shape and position of 

the jog. 

Pressing  (<Z>) results in a change of a quarter in which the dimension is drawn. In this case, the 

mouse should be pointing to the quarter where the dimension should be placed. 
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Dimensions between Two Nodes 
Creating a dimension between two nodes is mostly similar to creating a dimension between two lines. 

The exception is multiple possibilities for the witness line positions. These possibilities are shown on the 

diagram below. 

 

To select nodes, use the option: 

  <N> Select Node 

If two nodes to be dimensioned are connected by a graphic line, the option  is used. Upon calling the 

option, select the desired segment, and its end nodes will be automatically selected for dimension 

creation. 

 

To toggle through the various types of dimensions between two nodes, the option <M> is provided in 

the automenu: 
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 <M> Change Dimension Type 
  

 

This option toggles the various dimension types. 

Besides, the desired dimension type can be selected 

from the pull-down list. 

The parameters of the dimension being created can be 

defined using the option:  
  

 <P> Set Dimension parameters 
  

Angular Dimension by Four Nodes 

Placing a dimension by four nodes represents itself basically a variation of 

the angular dimension between two segments (lines). The lines between 

which the dimension will be drawn are defined by the end nodes. 

 

For drawing the dimension by four nodes the following option is used:  
 

 <F> Angular Dimensions by 4 Points 

After choosing this option in the automenu, the option for selecting the nodes appears: 

 <N> Select Node 

Tooltips in the status bar show the order in which nodes are selected. The dimension will be tied to the 

first nodes of both lines. 

After specifying all nodes, it is necessary to indicate location of the created dimension with the help of . 

While doing it, the following options will be available in the automenu: 

 <P> Set dimension Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Z> Change leader line jog orientation 

 <Shift+D> Select Linked Dimension 

 <Z> Change Dimension Orientation 

 
<Spacebar

> 
Place Dimension in absolute coordinates 

 <T> Tie Dimension to Node 

 <J> Center Dimension Text 
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 <K> 
Break relations 

(available if dimension is tied to the node) 

 <Esc>  Cancel selection 

The use of these options has been described above. 

Linear Dimension by Three Nodes 

Linear dimension by three nodes represents itself a variation of the linear 

dimension between a line (a segment) and a point. This means that the 

dimension will be drawn between the line defined by first two nodes (end 

points of the segment of the line) and the third node selected. 

 

For drawing dimension by three points, the following option is used: 
 

 

 <T> Linear Dimension by Three Nodes 

After choosing this option in the automenu, the option for picking the nodes appears: 

 <N> Select Node 

Tooltips in the status bar indicate the node selection order. After specifying all nodes, it is necessary to 

indicate the location of the dimension being created with the help of . While doing it, the following 

options are available in the automenu: 

 <P> Set dimension Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

  <D> Change Sign 

 
<Spacebar

>  
Place Dimension in absolute coordinates 

 <T> Tie Dimension to Node 

 <Z> Change leader line jog orientation 

 <J> Center Dimension Text 

 <K> 
Break relations 

(available if dimension is tied to the node) 

 <Esc>  Cancel selection 



T-FLEX CAD Brief Introductory Course 

450 

The use of these options was described above in the section “Dimensions Between Two Straight Lines or 

Between a Line and a Node”. 

Creating Arc Length Dimension 

To dimension the length of a circular arc, use the option . The following items become available in the 

automenu after selecting the option: 

 <N> Select Node 

 <Esc> Cancel selection 

Dimensioning a whole arc starts with selecting an appropriate graphic entity.  

In the case of dimensioning a portion of an arc or circle between two nodes, subsequently do the 

following: 

1. Select the start node of the arc being dimensioned. 

2. Select the end node of the arc being dimensioned. 

3. Select the arc or circle passing through these nodes. An additional option is provided in the 

automenu: 

 <C> Select Circle 

After selecting the arc by any means, the automenu provides the options: 

 <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

 <Z> Change leader line jog orientation 

 
<Spacebar

> 
Place Dimension in the absolute coordinates 

 <J> Center Dimension Text 

 <T> Tie Dimension to Node 

 <K> 
Break relations 

(available if dimension is tied to the node) 

/  <H> Parallel/Radial Dimension Lines 

 <Esc> Cancel selection 
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As in the case of creating a dimension between two lines, the option <Spacebar> allows specifying the 

positions of dimension strokes. The option  is used for tying the dimension to a node, while the 

option  - for breaking the tie. To set parameters of the dimension being created, use the option .  

The option  allows flipping the orientation of the dimension leader line jog. 

With the option  turned on, the dimension text will be centered between the witness lines. With the 

centering off, the dimension text is position wherever the mouse click occurred. 

Additionally, one can choose between the types of the dimension 

witness lines (parallel or radial) by using the options / . 

To complete a dimension creation, click its position by . If the 

dimension is already tied to a node, clicking  simply confirms its 

creation. 
 

Creating Dimension by Cone 
A dimension by cone is created based on two non-parallel graphic lines. The selected lines are 

considered silhouette edges of a cone (cone projection). In this case, the dimension measures the 

distance between the ends of the selected lines, in the direction orthogonal to the cone axis. Thus, one 

can dimension a cone base on a projection view without creating additional nodes at the line ends. 

To create a dimension by cone, use the option . After selecting the option, the following items are 

available in the automenu: 

 <G> Select Line 

 <Esc> Cancel selection 

The dimension creation starts with subsequent selection of two non-parallel graphic lines.  Once the lines 

are selected, the following options appear in the automenu: 

 <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

 <Z> Change leader line jog orientation 

 
<Spacebar

> 
Place Dimension in the absolute coordinates 

 <J> Center Dimension Text 

 <D> Change Dimension sign 
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 <M> Change Dimension type 

 <T> Tie Dimension to Node 

 <K> 
Break relations 

(available if dimension is tied to the node) 

 <Esc> Cancel selection 

Line ends selection for attaching a dimension is done automatically by the system. However, if necessary, 

this can be modified using the option <M> ( ) that helps quickly toggle through all possible pairs of 

line ends. 

As in the case of creating a dimension between two lines, the option <Spacebar> allows specifying the 

positions of strokes of a dimension. The option  is used for tying a dimension to a node, while the 

option  – for breaking such a tie. The option  serves for specifying dimension parameters. 

The option  allows flipping the dimension leader jog orientation, and the option  – quickly 

changing the dimension prefix (the default symbol is “”). Centering dimension text is set by the option 

. 

 

Dimensioning a Single Graphic Entity 

To dimension a single graphic entity (a line segment or an arc), you do not have to call the option  or 

. You can simply select a line segment or an arc by clicking . Then, while still holding down the left 

mouse button, slightly move the pointer. The command will then automatically assume the mode of 

creating a line segment length or an arc dimension. 

Creating Dimension Chains 

The option  allows creating dimension chains for a group of parallel lines, as well as appending 

dimensions to already existing chains. Upon selecting the option, the following icons become available in 

the automenu: 

 <D> Select Dimensions in Chain 

  <L> Select Line 

  <N> Select Node 
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 <Bkspace> Сancel last element selection 

 <Esc> Cancel selection 

To create a new dimension chain, select subsequently the construction lines, the graphic lines or the 

nodes to be dimensioned. Complete the entity sequence selection by pushing the option: 

 <E> End Dimension Chain input 

After that, the following options will appear in the automenu: 

 <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <T> Tie Dimension to Node 

 <K> 
Break relations 

(available if dimension is tied to the node) 

 <Esc> Cancel selection 

The option  help tying dimension position to a node, while the option  breaks this tie. To define 

parameters of a dimension being created, use the option . 

To complete a dimension chain creation, specify its position by 

clicking . If the chain was tied to a node, then clicking  simply 

confirms the creation. 

Note that each dimension in the chain referencing a pair of lines, 

is a separate entity and can have its own parameters. 

 

To add more dimensions to an existing chain of dimensions, upon calling the option  select one of 

the dimensions in the chain to be appended. By doing so, you define the base for the dimensions to be 

created. The further steps will be similar to the previous case. The chains can have gaps. Should this be 

the case, select a line or node as the first entity of the chain continuation that is not referenced by the 

last existing dimension in the chain. 

Creating Dimensions from One Baseline 

The option  serves for creating dimensions from one base. The creation procedure for this dimension 

type is mostly similar to the previous case (creating a chain of dimensions from the common base), 

except the number of additional features. 
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The following items are available in the automenu after selection of lines and nodes for the dimension 

creation and pressing : 

 <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Z> Show/Hide zero at baseline 

 <S> Sign of dimensions direction 

 <Space> Leaders auto correction 

 <M> Change Dimension Type 

/ /

 

<L> 
Nominal near Jog/Nominal at Jog/Nominal at jog 

inside lines 

 <T> Tie Dimension to Node 

 <K> 
Break relations 

(available if dimension is tied to the node) 

 <Esc> Cancel selection 

Option  allows showing or hiding zero mark for the dimensions chain. When option  is enabled, 

dimensions are created with negative nominal values. This option works only for dimensions that were 

created from top to bottom or from right to left. 

Option / /  is toggled cyclically and allows to choose variant of placement for dimensional size: 

nominal near jog/nominal at jog/nominal at jog inside lines. 



Dimensions 

455 

 

   
Nominal near Jog Nominal at Jog Nominal at jog inside lines 

Dimensions from one base can be of two types:  normal and ordinate. The dimension type can be 

modified either at the time of creation or at editing. This is done by the option: 
  

 <М> Change Dimension type 
  

In the case of ordinate dimensions, only the witness lines are drawn, while the leader lines are not. 

  
Normal dimension Ordinate dimension 

  

 <Space> Leaders auto correction 
  

This option helps avoiding overlapping text of the dimensions from one base when those are placed near 

to each other. A jog is introduced in the dimensions that “creep” on the predecessors. 
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Autocorrection is off  Autocorrection is on 
 

In the process of creating a dimension chain 

or base dimensions, pressing <Esc> or  

displays a dialog box for selecting the action 

to execute. 

 

Creating Ordinate Dimensions (Level Markers) 

To create a ordinate dimension, use the option . Upon calling the option, the following icons become 

available in the automenu: 

 <D> Select ordinate dimension 

 <L> Select Line 

 <N> Select Node 

 <Esc> Cancel selection 
 

Creating a series of dimensions from the same base starts with selecting the base (“zero”) 

dimension. To do this, upon calling the option  simply select a horizontal ordinate or 

graphic line, or a node. As a result, a dimension starts rubberbanding on the screen, 

following the pointer. Meanwhile, the following options become available in the 

automenu:  
 

 <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 
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 <Z> Change leader line jog orientation 

 <T> Tie Dimension to Node 

 <K> 
Break relations 

(available if dimension is tied to the node) 

 <Esc> Cancel selection 

As in the case of a normal dimension creation, the option  flips the orientation of the dimension 

leader jog. The option  allows defining the positions of the dimension strokes by tying them to 

drawing nodes. In the letter case, use of the option <T> for the first time defines horizontal positioning, 

that is, the position of the vertical stroke of the dimension jog. The second use of the option <T> defines 

the dimension height, that is, the level of the horizontal stroke of the jog. To undo a tie, use the option 

. The dimension creation can be completed by pointing the mouse at the desired position and 

clicking . 

The thus created dimension becomes the base dimension. Meanwhile, the 

option of creating ordinate dimensions stays active, with the automenu 

providing the options for a line  and node  selection. By selecting next 

horizontal line or node, you begin creation of another dimension relative to 

the base. It's creation steps are same as the described above. 

To complete creation of a series of base dimensions, return from the option 

 into the main command menu. On a subsequent call for the option, 

selecting a horizontal line or a node will create a new base, with the 

subsequently created dimensions referencing the new base. 

 

To create dimensions relative to an existing base, upon calling the option, select the desired base 

dimension, or a dimension referencing the base. All dimensions created thereafter will be referencing 

that base. 

Dimensioning a Circle 
When dimensioning a circle, there is only one reference, which is the circle being 

dimension.  

After calling the command D: Create dimension, point the mouse at the desired 

circle and click  or <C>. The circle will be highlighted, and a radius or diameter 

dimension will start rubberbanding with the pointer.  
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The following set of options will become available in the automenu: 

 <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

 <Z> Change leader line jog orientation 

 
<Spacebar

>  
Place Dimension in absolute coordinates 

 <T> Tie Dimension to Node 

 <D> Change Dimension Symbol 

/  <M> Change Dimension Type 

 <Esc>  Cancel selection 

The type of the dimension being created is chosen in the drop-down list of the option Change 

Dimension Symbol. The following types are available , , , , .  

The type of the dimension may be selected from the drop-down list  Change Dimension Type , 

, . The list differ for the radial dimension  and includes the following options: , , . 

 

Once the necessary settings are defined, the created dimension will appear on the drawing. Follows are 

some types of dimensions on a circle supported by the system. 

 

Creating Radial Dimension with Jog on Leader Line 
For circles of a large radius, a radial dimension can be created with a jog on the leader line. To do this, 

use the option  of the command top-level automenu. Upon calling the option, select the circle to be 

dimensioned. As a result, the select a circle will be highlighted and a dimension will start rubberbanding 

following the pointer. As the pointer moves, the end of the leader line and the whole dimension position 

will be adjusting accordingly. Meanwhile, the following options are available in the automenu: 

 <P> Set Dimension parameters 
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 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

 <K> 
Break relations 

(available if dimension is tied to the node) 

 <X> Create Group of Radial Dimensions 

 <Esc>  Cancel selection  

To create the dimension, move the pointer to position the dimension as desired, and click . In this case, 

the default size and position of the dimension jog are set. 

 

If necessary, the size and position of dimension components can be arbitrarily modified, including tying 

nodes. Use special markers for this purpose. Upon selecting the circle, a fixation marker appears. You 

need to select a node to which the dimension will be tied. 

After the dimension position selection, you may change the dimension leader jog position. Select the 

special marker on the dimension leader jog, press  and move the cursor. The dimension leader jog will 

follow the cursor along the dimension line. 

 

The additional option  turns on the mode of continuous radius dimension creation at a common 

fixing point. This mode can be used for creating radius dimensions, originating at the same point, on 

several concentric circles. With the option on, upon completing one dimension creation (the one on the 

first circle), the system waits for dimensioning another circle. 
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If the fixing point of the first circle dimension was tied to a 2D node, then 

the dimensions on all following circles are tied to this node 

automatically. However, if the first dimension was fixed arbitrarily, then a 

free node is created at that point, with all the rest of the dimensions tied 

to it. 

 

Drawing Leader Dimension 
For drawing dimension similar to one shown on the picture on the right, the 

option  is used. 

After calling this option, it is necessary to indicate the fixing point (2D node) 

for tying the dimension. In the automenu the following option for picking the 

node appears: 

R0.5

0.6 x 45

 
 

 <N> Select Node 

After specifying the fixing point, it is necessary to specify location of the leader of the dimension. 

Dimension parameters are specified manually in the dialog of the command's properties or with the help 

of the option . 

In addition, the following options are available in the automenu: 

 <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

 <Z> Change leader line jog orientation 

 <D> Change Sign 

 <T> Tie Dimension to Node 

 <Ctrl+T> Link String to Node 

 <Esc>  Cancel selection 

Creating dimensions from Axis 
Diameter dimensions, which are created from the axis, look like standard linear dimensions with diameter 

sign and doubled nominal values set in their parameters. There is no arrow near axis; it is replaced with 

the outline with length half of the font size. 
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The  option is used for creation of such dimensions. After activation, you should define axis for the 

dimension creation. The following option is used for this purpose: 

 <L> Select Line 

Straight construction or graphic line can be chosen as axis.  

When axis was selected, you should define object for creation of the dimension. It can be a construction 

line, a graphic line or a 2D node. The following items become available in automenu: 

 <L> Select Line 

 <N> Select Node 

After defining axis and object used for creation of dimension, it is necessary to set its location. 

Parameters of dimension can be set manually in the dialog box of the command properties or with the 

help of option  

The following options are available in automenu: 

  <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

 <Z> Change leader line jog orientation 

 <Space> Place Dimension in absolute coordinates 

 <J> Center Dimension Text 

 <D> Change Sign (change prefix) 

 <T> Tie Dimension to Node 

 <K> 
Break relations 

(available if dimension is tied to the node) 

 <Esc> Cancel selection 
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Dimensions Between Two Circles 

The command  allows creating linear dimensions between two circles. After activation of the 

command, you need to select two circles between which the dimension will be created. 

The following options are available in automenu: 

  <P> Set Dimension parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Shift+D> Select Linked Dimension 

 <Z> Change leader line jog orientation 

 <Space> Place Dimension in absolute coordinates 

 <J> Center Dimension Text 

 <D> Change Sign (change prefix) 

 <T> Tie Dimension to Node 

 <Esc> Cancel selection 

There are three dimension types for non-coaxial circles dimensions: 

 Distance between centers 

 Distance between the closest points of the circles 

 Distance between the farthest points of the circles 

Use  option to change the dimension types. 

 

Difference of the radii is measured for coaxial circles. You can use special control marker on the larger 

circle to move dimension. 
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Dimension Parameters 

Dimension parameters are defined in the command's properties window before finishing dimension 

creation (or editing). 

Dimension parameters are arranged by several sections in the properties window according to the 

parameter type. Depending on the type of the created dimension (angular, linear, radius, ordinate, arc 

length), the sets of parameters in the sections may vary. 

«Value» section 
 

Value. This group parameters determine, how the nominal dimension 

value will be defined. You can select the following choices from the 

drop-down list: 

Auto. The dimension value is calculated automatically based on 

drawing elements on which it is created. This allows a dimension 

to automatically change its value upon any modification to the 

drawing. The field on the right-hand side for the manual 

dimension value input is inaccessible.  
 

Manual. The dimension value is defined by the user manually in the input field at the right of the 

drop-down list. Regardless of drawing modifications, such dimension value will stay unchanged. 

This option is used when you need to introduce a dimension value in the drawing, that does not 

match the calculated dimension value. 

Manual with Corrections. The dimension value is specified manually by a user similar to the 

previous case. However, on the drawing the dimension value for the given dimension will be 

shown taking into consideration the specified scale and corrections (see below). 

By Source Lines. This option is available for 2D dimensions, drawn on the elements of any 

associative copy. Upon selection of this option, the dimension value is determined by the 

original elements of the copy (if for such dimension the case “Auto” is selected, then the value 

of the dimension is evaluated on the basis of those elements of the copy to which the 

dimension is tied to).  
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The option “By Source Lines” can be used, for example, for dimensioning on the lines of the 

associative copies (including the drawing views) without taking into account the scale of the 

copy. 

None. The dimension value string does not show on the dimension. 

From Lines. This option is available for dimensions created manually on the 2D projection lines 

(or their associative copies) corresponding to the thread (special 3D operation created with the 

help of the command 3AT: Create Thread). Also, this option is available for 3D dimensions 

drawn on the threaded surfaces of the 3D model. When selecting this option, the text displayed 

on the dimension originates from the thread parameters (that is, the thread notation is 

displayed instead of the dimension value string). 

From 3D parent. This option is available only for dimensions created manually on the 2D 

projection lines (or their associative copies) and on condition that 3D dimensions are drawn on 

the corresponding to those lines faces, edges and vertexes of the original 3D model. Upon 

selection of this option, the text and parameters of the dimension will be inherited from the 

parameters of the 3D dimension. 

The inaccessible for editing field found below the group “Value” is informative. It shows how the 

dimension has been created and how its value and parameters have been determined: 

 

 “On Drawing” – standard 2D dimension drawn by nodes or by lines of a 2D drawing. The 

value of the dimension is evaluated by the geometry of the drawing or specified manually; 

 “On Drawing ” – standard 2D dimension drawn by nodes or by lines of a 2D drawing. The 

value of the dimension is evaluated by the geometry of the drawing or specified manually; 

 “On Copy: On Drawing” – dimension is drawn on the elements of the associative copy of the 

nodes and the lines of a 2D drawing. Similar text string also appears if the dimension is drawn 

on the elements of the associative copy of the 2D projection lines, and for this dimension the 

field “Value” has an arbitrary value except “By Source Lines” (that is, the value of the 

dimension is determined either by the elements of the copy itself or specified manually); 

 “On Copy: On Projection” – dimension is drawn on the elements of the associative copy of the 

2D projection lines and for this dimension the field “Value” has the value “By Source Lines”. In 

this case, the value of the dimension is evaluated by original objects of the copy, i.e. by the 

2D projection lines; 

 “On Projection” – dimension is drawn on the 2D projection lines. If on the faces of a 3D model 

corresponding to given projection lines there is a 3D dimension, and for the 2D dimension 

the field “Value” has the value “From 3D parent”, then “(*3D)” is added to the information 

string; 
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 “On Operation” – this text string appears for 3D dimensions drawn on the vertexes, edges and 

faces of a 3D model (see the chapter “3D Annotations” of the manual on 3D modeling) 

 “Projected” – this string appears for 2D dimensions created via the command of auto-

dimensioning of 2D projections (see the chapter “3D Annotations” of the manual on 3D 

modeling). 

Correction. This parameter defines the correction amount that will always be 

added to a dimension value. It is available only if the options Auto or Manual 

with Correction were chosen for specifying dimension value. 

In the case when a scale is defined, the correction is added to the already scaled 

dimension value. 
 

The info field at the end of the Value group indicates the position of the dimension placement: On 

drawing (for the dimensions created on common construction or graphic elements), On projection (for 

dimensions on 2D projections), On operation (for 3D dimensions). 

The Scale group serves to define the value of the scale factor. The scale factor provides control over the 

dimension value. For example, suppose, some portion of a drawing was performed to a different scale. 

Since the units are the same throughout the drawing, you shall specify a scale factor for the dimensions 

in the said portion of the drawing. Then the dimension value will be displayed according to the specified 

scale (that is, multiplied by the specified scale factor). The value of the scale is not taken into account if 

the parameter “Value” was set the value “Manual”. 

You can select the desired option from the drop-down list: 

Default. The dimension value will be affected by the settings made on the Dimensions tab of the 

ST: Set Document Parameters command dialog. 

None. The dimension doesn't have a scale factor. 

Inches/Millimeters, Millimeters/Inches. These are the 

standard scale factors introduced for the user 

convenience. When selecting one of those items, the 

appropriate scale factor is set automatically to make the 

conversion to other units. 
 

Custom. This option is used when it is necessary to set an 

arbitrary scale factor. The factor value is entered in the 

input field to the right of the drop-down list. For 

example, the case shown on the figure at the right has 

the, specified scale factor equal to “5” for both 

dimensions (the top dimension also having the 

correction of “100”). 
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«Strings» section 
 

This section of the properties window collects the parameters that serve 

to define the text that shall be placed before, after or under the 

dimension value string.  

 

 

Those strings can be defined manually, or substituted by numerical or text variables. Besides that, one 

can use all capabilities of text line formatting described in the “Text” chapter. 

To insert a variable into one of the dimension strings, you need to enter its 

name in the respective string, surrounded in braces. For example, if you need 

to make the “A” variable value appear in the dimension text on the drawing, 

enter {A} in the respective dimension string. 

For example, in the string “Before” enter the desired text: “width {A} mm” 

 

 

Note that the variable “A” is entered in braces. Suppose, its value is equal to 100. Set the parameter 

“Value” (described above) to the value “No”. As a result, the dimension on the drawing will appear as 

shown on the diagram at the right. 

For complete information on use of the variables, refer to the chapter “Variables”.  

Besides, special symbols can be entered in the text strings via <Alt><F9>. To do this, click inside a text 

string input box and press <Alt><F9>. Then, select the desired symbol and hit <Enter>. 

Special symbols are various conventional textual and drawing notations. The symbols are 

represented by the textual font used in the parameter dialog box. On selecting a special symbol 

from the dialog box, it will be entered in the parameter string input box as a double percent 

character (%%) followed by the symbol code. However, upon placing the cursor into the 

parameter string which contains special symbols, a popup tooltip with a real image of the line 

contents will appear on the screen. On the drawing the special symbols will be also displayed 

precisely. 

Note that the special symbols can be used as part of any parameter, which is a textual string, for 

various system elements. 

String parameters of the dimension may be set using other parameters of the same dimension. You need 

to use $(VALUE) record, where VALUE – name of the parameter (as it is called in the PM: Measure 

operation) 
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«Tolerance» section 
This section of the properties window defines the tolerance zones and deviation limits. 

The “Text” parameter, which is coming first in the section, defines what parameters will be displayed 

together with the dimension nominal value: 

 

Nominal. Only the dimension value is displayed. 
 

 

Nominal + Deviations. The deviation limits are displayed next to the 

dimension value string. 
 

 

Nominal + Tolerance. The tolerance notation will be displayed next to 

the dimension value string.   
 

All parameters. In this case, both the tolerance notation and the 

deviation limits are displayed.   
 

Limits (ANSI standart). The dimension value string is composed of the 

two main values, each being the sum of the dimension value and the 

corresponding deviation limit.   

Deviations can be defined manually or calculated automatically based on the specified tolerance zone. 

Automatic deviations calculation is used by default. The change from the manual setting to the 

automatic is done by toggling the Deviations flag (when the flag is off, the deviations are calculated 

automatically, when it is on – those are defined manually). 

When using the automatic mode of calculating tolerances, you just need to specify the tolerance zone. 

Please note that the values of the calculated deviations depend on the measurement units defined in the 
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ST: Set Document Parameters command menu. Automatic calculation of deviations works only for the 

millimeters or inches settings. 

When the dimension value is modified, the deviations populated from tolerances will be adjusted 

automatically. 

A variable can be entered in place of a deviation value just like in any other numerical field. 

Various standards set the different requirements to the font size used to display value deviation limits in 

the drawing. Two choices are provided: reduced height, which is half the font size, and full-height. To 

choose the desired one, use the “Font” parameter.  

Fit parameters are defined similar to tolerance parameters. 

«Style» section 
Sign. For a linear dimension, this parameter defines a special symbol to be displayed before the 

dimension value. This is necessary to create, for example, a radius, diameter or thread dimension.  

                                          

This parameter is not available for the circular arc length dimension. 
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Type. This parameter is required if you need to have a linear dimension without extension (witness) lines 

(this is often used when creating dimensions from a centerline). This parameter can also be used to 

create one-sided dimensions (used for dimensioning on cut views or for dimensions on large-size parts). 

Strings offset. This parameter defines the distance by which the dimension value string and the string 

beneath the dimension will be separated from the dimension line or from the leader jog (by default = 0). 
 

Lines offset. This parameter defines the offset of extension (witness) lines of a dimension from the 

object when creating dimensions per the ANSI and AR_ANSI standards. Whenever this parameter 

is not defined, the offset amount will depend on the size of the dimension line arrows. 

The diagrams at the right correspond to the values 

of this parameter equal to “0” and “5”. 

72

   

72

 

Box. You can choose one of the following options from the drop-down list.  

No. The dimension text will be displayed without box. 

Square. The dimension text is outlined by square box. 

Rounded. The dimension text is outlined by rounded box. 

You can outline only selected part of the dimension text using %%R. 

 

Outside Arrows. When this flag is set, the dimension arrows are always drawn outside of the 

extension (witness) lines. When the flag is disabled (the default), the arrows position is determined 

automatically depending on the distance between the extension lines of the dimension. If arrows 

don't fit inside, then those will be automatically switched to outside. 

Show when zero value. When this parameter is enabled, dimension will be displayed on the 

drawing even when its value is zero. 

The “Clear Background” group provides controls for the dimension display mode in which drawing 

portions are erased around the dimension strokes: 

Under Arrows. Turning on this item erases the drawing portions under and around the leader 

lines and leader arrows (at the distance equal to the thickness of the main continuous line). 

Under Lines. Turning on this item erases the drawing portions under and around the witness lines 

(at the distance equal to the thickness of the main continuous line). In the case of the radial 

dimensions, the background is also erased under the cross marking the circle center. 
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«Arrows» section 

In this section you define the type and size of arrows on either end of a 

dimension line. The value in square brackets means the arrow size will 

be per the value defined on the Lines > Arrow (End) Size tab of the 

ST: Set Document Parameters command dialog. 

Button  toggles start and end arrow head parameters.  

«Units» section 
Standard. This parameter allows selecting the dimension display standard: 

ANSI, AR_ANSI, ISO or Default. When the “Default” value is used, the 

dimension standard is copied from the parameter value in Dimensions > 

Standard of the ST: Set Document Parameters command.  

 
 

     

Minimum Digits. This parameter determines the minimum number of decimal digits displayed in a 

dimension. For example, if the value “3” is specified, then the dimension 28.5 will be displayed as 

28.500. If the “Default” is set, then the value is taken from the Dimensions tab of the ST: Set 

Document Parameters command. 

Units. This defines the units in which the dimension value is displayed. 

Mostly, this item is important for inch dimensions. When the “Default” 

value is used, the dimension is displayed in the units defined in the ST: Set 

Document Parameters command. 
 

Precision. Sets the rounding accuracy of dimension values. The accuracy "0.01" means the dimension 

values will be rounded to the second decimal digit. For example, if there is a dimension 28.4482, and 

the accuracy is 0.01, then the value 28.45 will be displayed in the drawing. If this item is set to 

Default, then its setting is defined on the Dimensions tab of the ST: Set Document Parameters 

command dialog. 
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«Alternative dimension» section 
Show. This parameter determines the presence or absence of an 

alternative dimension in the drawing. When the parameter is 

set to Default, then its setting is defined on the Alternative 

dimensions tab of the ST: Set Document Parameters 

command dialog. 

Separator. This parameter sets the appearance of separators 

that are used in the drawing to separate the alternative and 

the main dimension values: 

Default. In this case, the separator assumes the type defined in 

the command ST: Set Document Parameters. 

None. The alternative dimension text will not be separated. 

[Brackets]. The alternative dimension text will appear in 

brackets. 

{Braces}. The alternative dimension text will appear in braces. 

(Parentheses). The alternative dimension text will appear in 

braces. 

 

Position. This parameter defines the mode of displaying the alternative dimension value in the 

drawing at a relative location of the main dimension  

value. According to the choice made, the alternative dimension value will appear in 

the drawing “After”, “Before”, “Under” or “Above” the main dimension value string. If 

the parameter is defined as Default, then its value is assumed from the Alternative 

dimensions > Location setting of the command ST: Set Document Parameters. 
 

 

Scale. this parameter defines the scale factor of an alternative dimension (which is fully analogous 

to the scale factor of the main dimension value). 

Why are Alternative scale and Scale factor, respectively? Suppose, dimension values need to be 

created in two measurement systems at the same time, inches and metric. For this purpose, a 

special expression is introduced in the system - #DIM#. If this expression is used in any of the 

dimension lines (strings), then a dimension value will appear instead of it in the drawing, which 

will be multiplied by the alternative scale factor. 

To follow the example on the right, set the Alternative scale 

to Millimeters/Inches and enter the following text in the Text 

> After field: [#DIM#%%119]. 
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Correction. Parameter defines correction of the alternative dimension value compared to the calculated 

value. Correction is calculated similarly to the nominal value: displayed value = calculated value*scale 

factor + correction. 

The Text group of parameters allows defining the text that will be displayed before or after the 

dimension value of an alternative dimension. Such strings can be entered manually or 

substituted by numerical or text variables. You can familiarize yourself with this capability in 

detail by reading the description of the counterpart parameter in the String section. If no 

parameter values are set in this group, then those are taken from the Alternative dimensions 

tab of the ST: Set Document Parameters command. 

The Tolerance group of parameters allows defining tolerance zones (ranges) and value deviation limits of 

alternative dimensions: 

Text. This parameter defines the included members of the dimension value string of an alternative 

dimension (the dimension value only, the dimension value with tolerance, etc.). A value can be 

selected from the list. The Default setting means the appearance of an alternative dimension will 

be determined by the Text parameter setting in the Tolerance section. 

The tolerance zone is defined by the same-name parameter. The value deviation limits can be 

either defined manually (in the respective input fields) or calculated automatically. The method of 

defining deviations is controlled by the Set Tolerance parameter: 

Auto-Scale. The deviation limit values are calculated by the tolerance zone of 

the main dimension (while accounting for the measurement units of the 

alternative dimension – millimeters or inches). The definition of the 

tolerance zone value of an alternative dimension does not affect the 

calculation of its value deviation limits. 
 

Auto-ANSI. Deviations are calculated by the defined tolerance zone of an alternative dimension 

per the ANSI standard. 

Auto-ISO. Deviations are calculated by the defined tolerance zone of an alternative dimension 

per the ISO standard. 

Manually. The deviation values are defined by the user. Variables can be used instead of 

deviation values. 

When using the automatic modes of calculating deviations (Auto-Scale, Auto-ANSI or Auto-ISO), 

you just need to define the tolerance zone. The deviations will be calculated automatically. 

Accuracy. Defines the rounding precision of the dimension values of the alternative linear 

dimensions. For example, the accuracy 0.01 means the dimension values will be rounded to the 

second decimal digit. Accuracy 0 means no rounding. If set to “Default”, the accuracy assumes the 

settings from the Alternative dimensions tab of the ST: Set Document Parameters command. 
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Units. Defines the way of displaying the dimension values of alternative linear 

dimensions. This item is primarily used when working in inches. 

Just as in the previous case, the Default setting means the dimension will be 

displayed in the units defined on the Alternative dimensions tab of the ST: Set 

Document Parameters command. 
 

Minimum Digits. This parameter determines the minimum number of decimal digits that is 

displayed for the alternative dimension value (similar to the “Minimum Digits” parameter of the 

main dimension value). If “Default” is set, then the value is taken from the Alternative dimensions 

tab of the ST: Set Document Parameters command. 

«Options» section 

The section contains only one auxiliary parameter– Show Dialog for each 

Created Dimension. If this parameter is enabled, then the dimension 

parameters dialog will automatically appear after defining the dimension 

position in the dimension creation command (the option ). 
 

This mode allows working in the same way as in previous versions of T-FLEX CAD – by specifying the 

dimension position in the drawing first, and then defining its parameters. 

Automatic alignment. If the option is enabled, the system automatically places the dimension number 

and the arrows outside when the dimension size is reduced to certain values. 

 

Show toolbar with options. If the option is enabled, additional markers and options for will appear near 

dimension when you put cursor on it. 
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Special about Defining Angular Dimension Parameters 
Linear and angular dimension parameters are mainly same. Described below are the existing differencies. 

The set of tolerance parameters for angular dimensions is different 

from the respective parameters of other dimensions. Since angular 

dimension tolerance calculation depends on the length, the 

parameter Length is provided for angular dimensions. When 

calculating deviations automatically, the following formula of defining 

the tolerance zone is used: +AT8, AT8 or -AТ8, where 8 is the 

tolerance grade, while a signed AT defines the tolerance type.  

+AT

  

-AT

  

AT

 

The deviations are calculated in degrees, minutes and seconds, respectively. The 

angular dimensions use special units for displaying the dimension value. 

For angular dimensions you cannot specify an alternative scale, nor any other 

parameters related to an alternative dimension.  

When you create angular dimensions, the Text along the line option appears. If the option is enabled, 

the text on the angular dimension will not be drawn along the arc, but along the tangent to it. 

Special about Defining Parameters for Dimensions on Circles 
In the Style section you can enable the display of a small cross at the center of the circle on which the 

dimension is created (the Cross in Center parameter). This is required by some standards. Otherwise, the 

parameters for circles correspond with the parameters for linear dimensions. 

When you create dimension on the circle the Arc Symblol option appears.  

 

Special about Defining Parameters of Ordinate Dimensions 
Ordinate dimension parameters are mainly same as those of linear dimensions. Described below are the 

existing differencies. 

The ordinate dimensions do not have the parameters to define tolerances and deviation limits. 

In the Style section there are only the parameters, whose status is relevant to an ordinate dimension. 

Besides, there are the following additional parameters: 

Leader Line. Controls the leader extension creation between the dimension and the attachment 

node. 
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Show “plus”. Controls the display of the “+” sign in dimensions with positive offset from the base 

dimension. 

Just as for angular dimensions, there is no alternative scale for ordinate dimensions, nor any other 

parameters related to an alternative dimension. 

Working with the dimension parameters dialog 
You can also define dimension parameters in the parameters dialog called by the automenu option: 

 <P> Set Dimension Parameters 

The parameters located on the tabs of this dialog duplicate the parameters in the properties window. 

Besides that, the parameters dialog has a number of additional settings. First of all, that's the system-wise 

parameters: level, layer, priority and color. The parameters dialog also has an additional tab that contains 

the font settings. This tab is standard for various system elements (dimensions, annotation leaders, 

roughness symbols, GD&T formlimits). It allows defining all necessary font settings used to display the 

dimension value string. If the value of some of the parameters on the tab is set as “Default”, then it will 

be taken from the Font tab of the ST: Set Document Parameters command dialog. 

Parameters for New Dimensions (Default Parameters) 
The default parameters that will be applied to all newly created dimensions can be defined in a number 

of ways. 

First of all, those can be defined within the parameters dialog (the option ). To do this, call the dialog 

before creating a dimension. The parameters defined for the new dimensions will be copied to the 

parameters set of each created dimension. 

You can also save the parameters defined when creating (or editing) a dimension, as the default 

parameters, by clicking the button  in the command's properties window. 

Note, that the tab Dimensions of the command ST: Set Document Parameters defines only those of the 

described parameters, that have the default option. As a rule, all dimensions should appear consistently.  

Therefore, a good strategy is defining their appearance in the command ST: Set Document Parameters, 

while using the default settings for the parameters of a particular dimension. This allows instantly 

changing appearance of all dimensions, if necessary. 

Besides the described parameters, the command ST: Set Document Parameters defines two more 

parameters. Tolerance Grade defines the threshold precision, up to which the dimension values 

are displayed on the drawing. This means, for dimensions, whose tolerance grade is less or equal 

to the specified, only the nominal values will be displayed. 

The Symbols in the ST: Set Document Parameters command dialog provides for defining codes of the 

selected special font, corresponding to the symbols diameter, degree, and “±” sign. This can be helpful 

when exporting files, and when using fonts that use different codes for these symbols. 
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Copying Parameters from Existing Dimensions 
Parameters of the dimension being created can be quickly copied from an already existing dimension. To 

do this, use the option: 

 <Alt+P> Copy Properties from Existing Element 
 

This option is available in the command automenu prior to creating the dimension or during the 

creation process (before selecting the dimension placement on the drawing). 

After calling the option, simply pick the dimension whose parameters are to be transferred on the new 

dimension. The parameters will be copied that are common for both the selected dimension and the 

dimension being created. 

To make the copied parameter values assigned to all newly created dimensions, before selecting the 

source dimension activate an additional option: 

 <S> Set Properties as Default 

With the option active, the copied parameters will be saved as default parameters. 

This option simplifies creation of dimensions with identical parameters. However, it does not allow 

to copy specific parameters or parameters from an object of a different type. In such cases, more 

convenient could be using the general mechanism of editing element parameters in the property 

window. 

Setting link of dimension with another dimension 

For any type of dimension you create, it is possible to link it with the other already existing dimension by 

means of the following automenu option: 

 

<Shift+D> Select linked dimension   
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After calling this option, you must specify the 

dimension which parameters will be used for 

the dimension being created. 

When setting such link, parameters of 

"linked" dimension, for example, the nominal 

value, other display options, will be taken 

from the original dimension. List of "linked" 

parameters can be controlled in the 

properties dialog by selecting corresponding 

values for the nominal mode - “Auto”, 

“Manually”, “Manually+Corrections”, “From 

selected dimension”. If you do not want to 

display the content of "Before", "After" and 

"Under" strings of the linked dimension, it is 

necessary to remove the flag to "Project 

string ...". The flag appears when you put the 

mouse cursor over a field of the 

corresponding parameter. 
 

To break the link between the dimensions you can use option: 

 

<Shift+K> Break link with dimension 

Option is available only for the linked dimensions. 

This functionality can be used, for example, to display dimensions on a simplified view with the same 

nominal values and other parameters as on the original accurate view. 

 

Dimensions Alignment 

The options group Dimensions Alignment is available in the context menu when you select several 

dimensions. The options allow associating the selected dimensions to move them together on the 

drawing. 

      

The Group option creates group of dimensions. When you move one of the dimensions, the rest 

dimensions also move, maintaining its position, retaining their original position relative to each other. 
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The Delete Alignment option appears for grouped dimensions. The option cancels the alignment of all 

dimensions in the group. 

The In Line option aligns all dimensions in one line. The option allows you to quickly build a chain of 

dimensions. 

 

The Adjust with offset option allows you to align the dimensions vertically in accordance with the 

specified spacing. 

 

The spacing between dimensions is specified in the ST: Set Document Parameters on the Dimensions 

tab using Alignment spacing parameter. The parameter specifies the spacing for newly created groups 

of dimensions and does not affect spaces of the already created groups. 

When you create a new dimension above or under another dimension, a snap in accordance with 

a predetermined alignment spacing is active.  

The following options are available in the context menu for each of the dimensions in the group: 

 

The same options are in the automenu of the Edit command for the dimension. 
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 Move with others. The selected dimension is moved with the other dimensions in the group. The 

option is enabled by default. 

 Move relative to others. After activation of this option, the selected dimension can be moved 

relative to other dimensions in the group. After that, the dimension will move with other dimensions 

again, but the new position will be preserved. 

 Exclude from alignment. The selected dimension is excluded from the alignment. 

 Change Direction. Changes the position of the dimensions relative to the selected dimension. If the 

remaining dimensions in the group are located above the selected dimension, then they will be located 

below after activation of the option and vice versa. 

 

Editing Dimensions 

Dimension editing is done via the command ED: Edit Dimension: 

Keyboard Textual Menu Icon 

<ED> Edit > Draw > Dimension  

Upon calling the command, the following options become available: 

 <Enter> Select dimension 

 <*> Select All Elements 

 <Esc> Exit command 

Select a dimension for editing by pointing and clicking the mouse . That highlights the dimension. This 

dimension parameters will be displayed in the properties window. Meanwhile, the automenu offers the 

following options: 

 <P> Set selected Element(s) parameters 

 <Alt+P> Copy Properties from Existing Element 

 <O> Create Name for Selected Element 

 <Shift+D> Select Linked Dimension 
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 <Shift+K> Break Link with Dimension 

 <Z> Change leader line jog orientation 

 <Z> 
Change Dimension orientation (for angular 

dimension) 

 
<Spacebar

> 
Place Dimension in the absolute coordinates 

 <J> Center Dimension Text 

 <D> Change Dimension Symbol 

 <T> Tie Dimension to Node 

 <Ctrl+T> Link String to Node 

 <N> Select insertion Node  

 <W> Move dimension 

, 

/  
<M> Change Dimension type 

/  <H> Change dimension symbol 

 <K> Break relations 

 <D> Change dimension type 

 <I> Select Other Element 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 
 

Availability of some of the above options in the automenu depends on the ways of creation and 

the type of the selected dimension. 

The selected dimension can be moved, tied to other drawing 

elements or have its parameters modified, with respect to the 

original settings. To do this, select the appropriate option in 

the automenu. 

The option  allows you to modify orientation of the 

leader extension of the dimension text. 
   

The option  changes orientation of angular dimension (i.e., the quarter of an angle on which the 

dimension is drawn). 
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The option  sets the mode of centering the dimension text. When pushed, the dimension text will be 

automatically centered between the witness lines. 

The option  helps quickly changing the dimension value prefix (“R”, “”, “M”,“”, “”), without calling 

the dimension parameters dialog box. The option  serves for changing the reference elements (lines, 

nodes) of the dimension being edited. The fixing position of the dimension created using the option , 

can be changed by selecting two nodes. 

Sometimes, it is necessary to change the witness line 

attachment point. To do this, select the dimension at the 

point of the intended origin node of the witness line, 

and pick the option .         
 

If a wrong dimension was selected, alter the selection 

using the option . 

The option  or / , depending on dimension 

type, allows changing its type without altering its 

references. 

 

R4
5

     

R4
5

 

R4
5

 

Note that if the dimension was tied to a node using the option , then to modify its fixing condition, 

first use the option . 

Option  is used to assign a name to the selected dimension. The name is unique and allows you to 

uniquely identify this dimension. 

A selected dimension can be deleted using the option . Deleting chain dimensions or dimensions 

from one base can be done separately for each dimension. Deleting the parent dimension (which is the 

dimension between the first two lines) causes deletion of the whole dimension group. The same rule is 

used for ordinate dimensions, created on one base: any dimension in the series, except the base one, is 

deleted as a separate entity; when deleting the base dimension, all dependent dimensions are also 

deleted. 

As in the case of other elements, multiple selection is done by the option , or using box selection or 

clicking  while holding down the <Shift> key (for adding to the list of selected) or <Ctrl> (for excluding 

from the list of selected). 

For editing parameters of a group of selected dimensions, use the option: 

  <P> Set selected Element(s) parameters 

First, select the set of parameters to be modified, in the dialog box that comes up on the screen. The 

standard dimension parameter dialog box will follow, allowing to define new parameter values. To define 
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color, later, level and priority, one can also use the system toolbar. The option  helps copying 

parameters from another existing dimension. 

Remember, that a number of dimension settings are defined by default, which can be changed in the 

command ST: Set Document Paremeters. 

One can also enter the dimension editing command directly from the command D: Create dimension, 

using the option: 

 <F4>  Edit 

The third way of selecting a dimension for editing is available, when the system is in the command-

waiting mode. Move the pointer over the dimension to be modified, and click . As a result, editing of 

the selected dimension begins. Besides, one can select the dimension and right click . The coming up 

context menu provides the commands for editing, deleting and modifying properties of the selected 

dimension. 

Working with dimensions in the 3D window 

When using the 3D version of the system, you can create dimensions, just as well as leader notes and 

roughness symbols, in the 3D window, on the faces of the 3D model. This allows you to create fully 

functional three-dimensional drawings. 

 

The parameters of such dimensions are automatically passed to the dimensions created in the 2D 

window on the respective lines of a 2D projection of a given model.  

 

3D dimensions can serve as driving (“control”) dimensions for 3D operations or construction elements. 

That means, when a dimension's nominal value is modified, the respective parameters of the operation 

or 3D construction element adjust to the change automatically. 
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You can also use the dimensions corresponding to the driving ones that are created on 2D projections, in 

order to modify the values of operation parameters. The system will match such pairs of dimensions 

automatically. 

The detailed description of creating 3D dimensions and dimensions on projections is provided in 

the chapters “3D Annotations” and “2D Projections. Creating Drawings from 3D Models”. 
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TEXT 

By learning various text handling techniques presented in this chapter, you will gain the command of a 

wide range of tools for handling text in T-FLEX CAD environment. At the time of decorating a drawing, 

you can insert standalone notes consisting of one or more lines of text. These lines are positioned on the 

drawing according to the attachment point and are controlled by a number of parameters that define the 

font, size, rotation angle, etc. (the section String Text). It is also possible to insert large amounts of text, 

including several paragraphs with different formatting (the sections Paragraph Text and Multiline Text). 

Table creation is also supported (the section Table). Any text may include variables created in the 

drawing and text excerpts from the dictionary (the section Working with dictionary). If necessary, a text 

can be imported or exported.  

Creating Text 

To create a text, the command is used TE: Create Text: 

Icon Ribbon 

 

Draw → Title Block → Text 

Keyboard Textual Menu 

<TE> Construct > Text 

Upon calling the command, the following options are available in the automenu: 

 <M> Create Multiline Text 

 <R> Create paragraph text 

 <B> Create Table 

 <D> Create string text 

 <P> Set Text Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <A> Set absolute coordinates 

 <N> Set relation with Node  

 <L> 
Set relation with Line (available for The string text 

only) 

 <C> 
Place Text around Circle (available for The string text 

only) 

 <F4> Execute Edit Text command 
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 <Esc> Exit command 

The first four options serve for selecting the type of the text to be created (multiline, paragraph, string 

text and table). The creation and handling techniques will be reviewed in details for each type in the 

respective sections of this chapter. 

Note that on subsequent calls to the command the type option will be turned on that was used in 

the previous command session. The default type is . 

The text being created can be positioned either in absolute coordinates (the option ), or attached to 

an existing node (the option ) to have its position adjust together with the position of the specified 

nodes. A string text can also be positioned at the specified vertical and horizontal offsets with respect to 

the attachment node. 

Besides that, the following additional options will be available in the automenu for a string text in order 

to relate it to construction entities (lines  and circles ). Those allow defining the rotation angle and 

the shape of the text according to the position and shape of the construction entities. 

Text of any type can also be bound to the joint points between graphic lines belonging to 2D fragments 

or 2D projections (a 2D node is automatically created when selecting such a point). 

Before you begin creating a text, you can set default parameters for all newly created text by using the 

option . Upon calling this option, the text parameters dialog box appears. 

Default Text Parameters 

“Style” Tab 
The first group of parameters – “Justification” - defines the element position with respect to its 

attachment point, as well is justification modes of the element contents with respect to its boundaries. 

The effect of these parameters is different for different types of text (see the respective sections for 

details). 

Justification - Horizontal. This parameter can take five values: Left, Center, Right, Left&Center, 

Right&Center.  

Generally, this parameter defines the way of positioning the text with respect to the attachment 

point, as well as the horizontal justification mode of the text contents. The combination values of 

the parameter, such as “Left&Center”, simultaneously define the text contents justification (the 

first value, along the left margin), and the attachment mode (centered  with  respect  to the 

attachment element). 
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The simple parameter value entries, such as “Left”, simultaneously set the justification of the text 

contents and the same attachment mode. 

When working with a paragraph text, the attachment mode is ignored, since this element is attached by 

two points. In the case of “Table”-type text, the text contents justification mode defined in this dialog box 

is ignored. 

Justification - Vertical. In the case of the paragraph text, this parameter defines the vertical justification 

of the text contents. In all other cases, it defines the way of positioning the text with respect to the 

attachment point. However, this parameter affects various types of text in the ways specific to each type. 

This parameter can have five values:  

Lower Limit - The string text is positioned above the attachment point at the distance 

defined by the font size; multiline text and table are attached at their lower boundary; in the 

case of the paragraph text, this defines the vertical justification of the text contents along the 

bottom margin; 

Lower Base - The string text will be positioned immediately above the attachment point; for 

the rest of text types this parameter is equivalent to the previous one; 

Center - The string, multiline text and table are centered with respect to the attachment 

point; the contents of the paragraph text are vertically centered; 
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Upper Base - The string text is positioned immediately under the attachment point; multiline 

text and table are attached at the upper boundary; the contents of the paragraph text are 

top-aligned vertically; 

Upper Limit - The string text is positioned under the attachment point at the distance defined by the 

font size; for the rest of text types this parameter is equivalent to the previous one. 

Rotation angle. Defines the Rotation angle of the text with respect to the horizontal coordinate axis in 

degrees. Positive rotation is counterclockwise. 

Symmetric. This parameter defines “mirror” text mode. 

General system parameters Color, Level, Layer, Priority. 

Force Parameter dialog box for each new text created. This parameter makes sense only for the 

string text. If it is set, then the contents of the string text being created can be defined on the 

additional tab “Contents” of the parameters dialog box. Otherwise, the special text editor is 

invoked. 

“Font” Tab 
Name. This parameter defines the font name and 

type. T-FLEX CAD supports use of the two types of 

fonts: the TrueType ( ) fonts that are the Windows 

standard, and the vector font format .SHX ( ). The 

fonts of the TrueType and SHX formats are 

distinguished in the font menu by the respective 

icons before the font name.  

Size. Defines the vertical size of capital letters (for 

example, the height of the character “A”). 

Oblique Angle. Defines the oblique angle of the font. The 

normal (vertical) font has the slant angle equal to 90°. The 

slant angle of 75° makes the font Italic. This parameter is 

of higher priority than the parameter “Style”. 

Line Spacing. Defines the spacing between the 

neighboring lines of a multiline text. Line interval is 

defined in relative units. To calculate the absolute 

value 

 

of the line spacing, multiply this parameter by the font height. 

Character Spacing. Defines additional spacing between the two neighboring characters in a line. The 

value of this parameter is also relative. To calculate the absolute value of the character spacing, multiply 

this parameter by the font height. 

Clear background. This parameter is used for padding the text outline box with the drawing 

background color. Clearing background may be convenient when displaying text over hatches, 

fills, etc. 



T-FLEX CAD Brief Introductory Course 

488 

Stretch. Defines the scale factor for the width of the font symbol. Any stretch value can be specified 

except 0. 

Style. This is a standard parameter for fonts TrueType (it does not affect SHX-fonts). It is selected 

from the list (normal, bold, italic, bold italic). 

The following two options affect only SHX-fonts: 

Line Width. Defines the width of the text contour lines for the fonts of the formats *.SHX. 

Fill. Note that not all fonts can be filled. A font can be filled, if a file is present in the T-FLEX 

system folder with the extension CHD and the same name as the respective SHX font name. 

The file can be empty. In this case, every font character will be filled. 

Once the font type and its parameters are defined, the result is displayed in the preview pane. 

Any parameter value can be defined by a variable. A textual variable can be used for the font 

name in this case. 

Creating String Text 

To create a string text, call the command TE: Create Text, and then select the option  in the 

automenu. The necessary text parameters can be defined before creating the text (the option ). These 

parameters will be applied to all types of the newly created text by default. 

Upon calling the option , the graphic pointer will be displayed as a box 

and a crossing. The box height corresponds with the height of the text font.  

The position of the crossing indicates the position of the text attachment point. The position of the box 

with respect to the crossing indicates the scheme of the text justification and positioning with respect to 

the attachment point, defined in the text parameters dialog box. The height of the box corresponds to 

the size of the text font. 

You can define the text position by clicking , and then invoke the text editor for inputting its contents. 

Besides, the text can be attached to a node, line or circle in order to have its position adjust together 

with the drawing parameter modifications. 

If attached to a node, the offsets of the text attachment point with respect 

to the node are maintained constant. If you want to impose such a relation, 

use the key <N> to select the desired node before clicking  for 

positioning the text.  

If you want to specify the exact horizontal or vertical offset of the text from 

a node, use the option <A> for entering the offset values. The same option 

used without selecting a node will allow you entering the exact text 

position with respect to the coordinates of the drawing.  
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An attachment line defines the Rotation angle of the text. The text can be 

positioned parallel to the line or at some angle (the angle being defined 

among the text parameters). Type <L> for tying the text to a line. 
 

 

Attaching a text to a node and to a line can be combined by using the 

options <L> and <N> subsequently. This allows, for example, attaching the 

text in such a way that it will adequately adjust as the image rotates. The 

example of the right hand side shows the result of selecting a construction 

line and a node. The option <A> was used for selecting the node with the 

offset values “0,0”.  

If you want to wrap the text on a circle, select a circle using the option <C>. 

You can flip such text (rotate by 180) by using the justification parameters 

for defining the position of the attachment point. 

 

 

 

The diagram on the right hand side shows a text wrapped on a circle. The 

following justification parameters were used for creating this text: 

horizontal – left, vertical – upper limit. By selecting this text for editing one 

can see a small square displayed in the upper left corner of this text, 

indicating the position of the text attachment point. 

Modifying the justification parameters of this text as follows: horizontal – 

left, vertical – lower limit - flips the text by 180. 

 

 

With the snapping turned on, the construction elements suitable for the text attachment 

references are pre-highlighted as the pointer approaches. To attach the text to those, you can 

simply click . Construction line intersections can also be selected as the attachment node, the 

actual node being created automatically in this case. 

Upon defining the text position, a window will be displayed for inputting the text contents. The text may 

contain variables, subscripts and superscripts, as well as special symbols. If the flag “Force Parameter 

dialog box for each new text created” is set among the text parameters, then the parameters dialog box 

appears with an additional tab “Contents”, where the desired text can be input. 
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Otherwise, a special text editor will be displayed for inputting 

the text contents. Text Editor is provided for inputting and 

editing the contents of string text. The text editor supports all 

functions of a common Windows text editor, including 

importing/exporting text files. 

The following commands are provided in the context menu 

of both the text editor and the parameters dialog of the 

string text: Insert Symbol (by selecting it from the symbol 

table); Repeat Symbol inserted before; Insert Variable; Insert 

text from Dictionary (see below); call Measure command. 

 

Subscript and Superscript Text. Use of Variables in Text 

The string text allows insertion of textual and numerical variables, subscripts and superscripts, as well as 

special symbols. These symbols are displayed using the same font as the main text. You can use the 

context menu commands for inserting, while the pointer is within the text editor or the text contents 

input pane in the parameters dialog. 

For example, to insert a variable in a text, you can use the context menu item “Insert Variable…” or use 

the function key <F8>. The standard dialog box “Insert Variable” will appear on the screen. Upon 
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selecting a variable, the reference to the variable will be inserted in the text contents in the following 

format: {<variable name>}. In the drawing, the reference to the variable will be replaced by its value. 

The string text also allows “manual” insertion of variables and various symbols in the text. To insert 

variable values in a text, use the following syntax: 

{<variable name>} or {<format>,<variable name>} 

Example of using variables: 

Create the text with the following contents: 

Diameter of cylinder is {D} millimeters 
 

Assigning the variable “D” the value “10” will make the text appear on the drawing as shown on the 

diagram. 

The following is an example of using formatted representation of variables: 

Today is {“%lg”,DAY}, {“%s”,$MONTH}, {YEAR} 

The format structure used by T-FLEX variables corresponds to the syntax of the input/output formats of 

the “C” programming language. Use of formats helps you control the appearance of the variable as 

displayed on the screen (for example, the number of decimal digits, or justification of the output value).  

To insert a subscript or superscript at any position in a line of text, surround the 

intended block in double brackets: 

Text_1 [[String_1^String_2]] Text_2 
 

Using the symbol “~” instead of “^”, divides the String_1 and String_2 by a 

horizontal line: 

Text_1 [[String_1~String_2]] Text_2 
 

Using angular brackets instead of square ones makes String_1 and String_2 

displayed in a two times smaller font than the rest of the text: 

Text_1 <<String_1^String_2>> Text_2 
 

String text can be framed by prefixing it with the symbol “~”. This feature affects 

the whole text.  
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Special symbols and underlining can be used in text. 

 

 

Text supports symbols in the Unicode format. Those are entered as “\U+FFFF”, where “FFFF” – is a four-

position hexadecimal describing the symbol code. For example, use of the symbol “\U+03A9” in 

combination with the “Arial” font is displayed as the Greek character “Ω”. 

To insert such symbols, one can use the standard Windows symbol table (Character Map). In it, 

you can find out the symbol code and insert it in the string text editor. 

Editing String Text 

To edit a text, start the command ET: Edit Text: 

Keyboard Textual Menu Icon 

<ET> Edit > Draw > Text  

Upon calling the command, the following options become available in the automenu: 

 <*> Select All Elements 

 <R> Select element from list (for named elements only) 

 <Esc> Exit command 

Selection, editing the position and attachment, and modifying text parameters are similar to editing 

other system elements. 

Selection of several text, as well as multiple selection of other system elements, can be done by box or by 

using the options  (selection of all text) and  (selection from the list of the named elements). 

Besides that, the string text allow subsequent selection of elements by using  with the <Shift> key 

depressed. Use of  in combination with the depressed key <Ctrl> excludes the text from the list of 

selected for editing. 

If the selected text is attached to some construction element, this element will be highlighted. 
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After selecting several text, the following options become available: 

 <P> Set selected Element(s) parameters 

 <Alt+P> Copy Properties from Existing Element 

 <N> Set relation with Node 

 <K> Break (kill) relations 

 <J> Merge Text 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

Upon selecting a specific element, the following options are available: 

 <E> Edit selected Text 

 <P> Set selected Element(s) parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Y> Create Name for selected Element 

 <N> Set relation with Node 

 <L> Set relation with Line 

 <C> Place Text around Circle 

 <K> Break (kill) relations 

 <I> Select Other Element 

 <X> Explode Text 

 <D> Duplicate Text 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

The option  is used for editing the selected text contents. When the option is called, the text editor 

window appears on the screen. 
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To attach the selected text to a node, line or circle, 

the same options , ,  are used as when 

creating a text. To break and attachment, use the 

option . 

The option  allows breaking a text containing 

several lines into a number of separate elements. In 

this case, each line of the original text will be 

converted into a separate “String Text” element. 
 

 

The option  allows creating a copy of the selected 

text. 

Modification of text parameters is bound to the option 

. The parameters dialog box appears in the screen. 

Besides accessing the text parameters and its contents, 

you can define the text position in the absolute 

coordinates or by an offset from the attachment node, if 

the text was attached to a node. 

When calling the option while several elements are 

selected, you will have to first specify the parameters to 

be modified in the dialog box “Change Parameters”. By 

default, all parameters of the selected elements are 

subject to editing. Upon specifying the parameters to 

edit, this standard text parameters dialog box appears. 

 

Creating Paragraph Text 

Paragraph Text is a text located in a specified rectangular area. The lines of such text are wrapped 

automatically upon reaching the area boundary. Various formatting functionalities can be used for 

paragraph text creation that are applicable to any text fragment. 

 

To create a paragraph text, use the command TE: Create Text.  

 

When creating a text, the parameters are automatically used that were set as the default parameters (the 

option ). Originally, these parameters use the settings “from document”. The text parameters will be 

applied to the whole content of the given text. 
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When editing the contents of the text being created, you can assign specific parameters to its separate 

elements, for example, to an isolated word or sentence. This capability is described in the topic Standard 

formatting options. 

Defining Text Position and Size 
In the automenu, select the option: 

 <R> Create paragraph text 

To create a paragraph text, first define the position and boundaries of the rectangular area that will hold 

the text (you can subsequently define several such areas with their boundaries). To do this, subsequently 

select the two bounding points for attachment. This can be freely done by clicking  or specified by 

selecting existing nodes. Upon defining the first attachment point, a rectangle starts rubberbanding 

following the pointer, indicating the size and position of the text being created.  

One can subsequently input the boundaries of several such rectangles. This, however, creates only one 

element of the type “paragraph text”. This means, as the text being input fully occupies the first 

rectangle, the input automatically continues in the second rectangular area, etc. in the order of 

rectangles creation. 

Next, click  inside the defined area or the icon  (<End>) to proceed with entering the text contents. 

At this moment, the rectangle will appear as follows, depending on the way of attaching the text: 

If the paragraph text is attached to nodes 

In this case, the rectangle can be modified or moved using 

the construction lines to which the paragraph text is 

attached. 

 

If the paragraph text is not constrained 

In this case, the rectangle can be moved, rotated or resized 

by using the provided handles while in the text editing mode. 

Move the rectangle using the handle located in the upper left 

corner of the rectangular area. Move the pointer to the 

handle (the pointer appearance will change), depress  and 

drag the mouse to the desired position. The rectangular area 

of the text will follow the pointer.  

Meanwhile, the coordinates of the upper left corner of the rectangular area will be displayed in the 

auxiliary fields of the status bar: . To locate the text, move the 

pointer to the handle located in the up or right corner. The pointer appearance will change accordingly. 

Hold down the left mouse button and rotate the text rectangle in the desired direction. Rotation will be 



T-FLEX CAD Brief Introductory Course 

496 

about the text centerpoint with snapping at each 15. Rotation without snapping is done by depressing 

the <Ctrl> key. Rotation angle will also be displayed in the auxiliary field of the status bar. 

To resize the rectangle, move the pointer over one of the small squares located at midpoints of each side 

and at each corner of the rectangle. The pointer will assume the shape corresponding to the vertical, 

horizontal or diagonal resizing. Hold the  down and move the pointer in the desired direction. 

Inputting Text Contents 

When inputting the contents of a paragraph text, the user is provided with various tools for formatting 

the text being input. To call the necessary options, you can use the system toolbar, the context menu 

or the command automenu. 

Selection of a text fragment (as for its formatting) is done by dragging the 

mouse with the  depressed. To select the whole contents of the paragraph 

text, one can use the key combination <Ctrl><A> or the context menu 

command Select All. 

The command Copy allows copying a highlighted text fragment or table into 

the clipboard for further pasting into another “Text” element or into another 

application. 

The command Paste is used for pasting a text or table from the clipboard. For 

example, you can copy a table from Microsoft Word and paste it in T-FLEX 

CAD. 

When working with variables, as well as with various objects inserted in the 

text, additional commands are provided in the context menu for defining and 

modifying the object parameters (see below). 

 

System toolbar options for handling text 

As you enter the mode of creating (editing) text contents, the system toolbar appearance changes. 

Various text-handling options become available. Those work on all elements of the paragraph text. 

 

 Bold font <Ctrl+B>. 

 Italic font <Ctrl+I>. 

 Underline <Ctrl+U>. 

 Left Text Alignment <Ctrl+L>. 

 Center Text Alignment <Ctrl+T>. 

 Right Text Alignment <Ctrl+H>. 

 Text Justification <Ctrl+J>.  
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 Text numbering <Ctrl+M>. Turns on and off automatic numbering of 

parameters.  

Once turned on, the paragraph numbering begins from number 1. The 

subsequent paragraphs are numbered automatically until the command is 

turned off. 

To access additional settings of text numbering, lunch the command 

Format Paragraph (see the description below). 

 

  Box. With this option turned on, the selected text will be framed by a box. 

 Show Unprintable characters <Ctrl+F2>. Toggles the display of the formatting marks. When 

viewing or editing a document, various formatting marks can be displayed, such as tabulation 

characters, spaces and paragraph marks that do not appear in printouts. For example, tabs are 

marked by arrows, spaces - by dots. This allows identifying, for instance, extra spaces between 

the words, spaces used instead of tabulation, etc. 

 Show Variable names <Ctrl+F3>. Defines whether the values or names of the variables are 

displayed on the drawing.  

Besides the above, the system toolbar allows defining the color, type and size of the text being created 

or selected portion of an existing text. Initially, these parameters are set “By default”, that is, their values 

are taken from the text properties defined before the text creation.  

To set a color different from the default color, turn off the button  and select the color from the list 

(the button  turns off automatically as you select a color from the list). To use the color set “By 

default”, push the button . 

Automenu options for handling text 

When inputting a text, the following automenu options are available to the user: 

Standard Windows options: 

 Cut selected text. <Ctrl><X> 

 Copy selected text to Clipboard. <Ctrl><C> 

 Paste selected text from Clipboard. <Ctrl><V> 

When pasting a text from the Clipboard, the system checks the type of the clipboard contents 

against the current variable, preventing, for instance, insertion of a character string into a 

numerical variable. 
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Insertion options: 

A black triangle in the lower right corner of an icon indicates the presence of several enclosed options 

behind this icon. Holding the button  depressed a bit longer over such an icon opens up a menu with 

additional options. 

         

Any of the enclosed options can be displayed by the automenu. Usually, it is the icon of the 

option used last in this command. 

 Insert text from Dictionary <F6>. Opens the dictionary (see the section “Working with 

dictionary” below). 

 Insert Variable <F8>. If variables exist in the 

drawing at the time of the text creation, those can 

be inserted in the text using this option. Upon 

calling the command, the “Insert Variable” dialog 

box appears on the screen. 

This dialog displays the list of variables created in 

the current drawing. This list can be sorted by the 

attributes of the variables when displayed: 

Marked only – the variables that were 

checkmarked in the variable editor (external); Real 

– the variables with numerical value; Text – the 

textual string variables. 

 

Next, select a variable from the list to be inserted. The variable name will then be automatically entered 

in the Expression input box. You can create a new variable by entering its name manually. 

Besides a variable name, you can insert an expression – in this case, the result of its evaluation will be 

displayed on the drawing. To make a variable available for editing directly in the text, set the flag 

Editable as field. 
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To edit an expression inserted in a text, call the “Insert variable” dialog box again. To do this, while 

editing the text, point the mouse to the expression/variable and right click , and then select the 

Parameters… item in the context menu. 

You can control the displayed number of decimal digits of real variables inserted in the text by 

the parameter Precision. 

If the variable has a list of predefined values, then you can specify the position of the list access 

button that will be displayed in the variable editing mode:  

Right of text – the button will be located on the right hand side 

and immediately after the variable.  
 

Left of text border – the button will be located at the end of the 

line within the rectangular text area.  

Right of text border – next to the end of the line outside the 

rectangular text area.  

None – the list access button is not displayed. 

If a variable with a predefined list is followed in the text by another element (text or variable), then 

the option Right of text will be used for the list access button of this variable. 

The editable variables can be highlighted among the given paragraph text for easy selection 

while in the editing mode (see the section “ Editing paragraph text”). You can define their 

highlighting color. To do this, check the flag Highlight when edited and select the highlighting 

color from the list. 

To modify an expression inserted in a text, call the Insert 

variable dialog box again. To do this, while in the text editing 

mode, point the mouse to the area occupied by the expression 

and right click , and then select the item Parameters… in the 

context menu.  

 Insert position numbers <Alt+F10>. This command allows us to insert the BOM position number 

into the text. When invoking this command the “BOM record selection” window appears, in which it is 

required to specify the desired BOM object. When the position number of the selected object in the BOM 

is changed, it will also be updated in the text. 

 Insert document’s technical requirements <Alt+F11>.  This option allows us to insert into the 

text the technical requirements of the document that are specified in the Format > Technical 

Requirements > Document’s Tech Requirements… command. 

 Insert Index <Ctrl+F11> and  Insert Index…. These options allow inserting subscripts and 

superscripts in a text. 
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Upon selecting the option , two input boxes appear by the 

cursor position – the subscript and the superscript one. Use the 

arrow keys or the mouse for navigation. When selecting the option 

 the dialog box appears on the screen in which the user can 

specify the font scale for the inserted indexes. After closing the 

dialog box, the fields for entering indexes appear at the cursor’s 

position. 

 

 Insert Fraction <Ctrl+F12> and  Insert Fraction….. Are similar to the options Insert Index 

(  and ). The subscript and superscript fields are divided by a horizontal line in this case. 

The options Insert Index and Insert Fraction allow unlimited 

nesting, which means that any subscript/superscript or fraction can 

contain an unlimited number of its own subscripts/superscripts or 

fractions. 

True Type Font

True Type Font

True Type Font
True Type Font

Justification - Left

Justification - Center

Justification - Right

Justification - Justify

 

 Insert Roughness <Ctrl+F8>. Allows inserting the roughness symbol in the text. Upon calling 

the command, the standard “Roughness Symbol Parameters” dialog box appears. The same 

options are available in this case as when inserting the roughness symbol directly in the 

drawing. 

 Insert GDT Formlimit<Ctrl+F9>. This command is similar to the previous one. Upon calling the 

command, the standard “GD&T Symbol Parameters” dialog box appears. 

 Insert Fragment <Ctrl+F10>. Sometimes, you may need to 

insert, let's say, a symbol, that is not present in any table. In this 

case, first you can create its 2D drawing, and then insert it in 

the text as a 2D fragment. When inserting a fragment in a text, 

the standard “Insert Fragment” dialog box appears. 

The images of the roughness or tolerance symbol or a 

fragment can be scaled in two ways. The scaling can be with 

respect to the font height or with respect to the object itself. 

True Type Font

True Type Font

True Type Font
True Type Font

Justification - Left

Justification - Center

Justification - Right

Justification - Justify
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To alter the way of scaling of the inserted object (the 

roughness, tolerance or a fragment), while in the text editing 

(creation) mode, right click over the element , and then 

select the “Size and Position…” item in the context menu. 

In the coming up “Object Parameters” dialog box, specify the 

scale value and the way of scale (with respect to “Object size” 

or “Font size”).  

The element properties can be modified by selecting the 

“Parameters…” item. 
 

 Insert Diameter <Alt+F2>,  Insert Degree <Alt+F3>,  Insert “Plus Minus” <Alt+F4> - 

the shortcuts are provided for inserting these frequently used symbols. 

 Insert Special <Alt+F9>. Inserts a symbol from the table of special symbols. 

 Non-Breaking Space <Shift+Ctrl+Spacebar> and  Non-Breaking Hyphen <Shift+Ctrl+"-

">. Allows creating a phrase without wrapping to the new line. 

 Line Break <Shift+Enter>. Continues the text on the new line without creating a new 

paragraph. 

 Open Character Map <Alt+F5>. This command brings up the standard Windows character 

map table, allowing to pick a symbol or a set of symbols into the clipboard. 

Standard formatting options 

 Format Font <F9>. This option allows setting the 

special parameters for a text contents fragment, such as 

a separate word or sentence. Calling the option brings 

up the “Font” dialog box. The following parameters can 

be defined in this dialog: 

Name and Size. Modify the font appearance and 

size of the selected text element. If set to “Default”, 

the font name and size assume the overall text 

parameters. 

Style and Italic by Default. When the flag Italic by 

Default is set, the overall text italic style setting is 

used. When the flag is cleared, the edited text 

fragment is assigned the style, specified by the 

parameter Style (Regular, Bold, Italic and Bold 

Italic).  
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Underline. This parameter allows defining the way of underlining a text: “None” – without 

underlining, “Single” – with underlining (This is the underlined text). 

Character spacing. Defines spacing between neighboring characters in a line. 

Color. This parameter sets the font color. If the “Default” flag is turned on, the text color is used 

from the general settings of the overall text. 

 

Vertical offset. Defines the vertical text offset with respect to the bottom edge of the line. For 

positive offsets, the shift is upwards, for negative – downwards. 

 

Box. With this flag turned on, the text will appear in a box.    
 

Strikeout. Setting this flag will apply the Strikeout style on the text     
 

 Format Paragraph <F10>. By calling this command, 

you can set the parameters of the current or the 

selected paragraphs in the dialog box: 

Justification - Horizontal. This option controls the text 

horizontal justification. Four modes are supported: Left, 

Right, Center, Justify. 

Fit to one line. Select this option when you need to fit 

the whole paragraph in one line. In this case, the font 

characters are first scaled by the width to the minimum 

extension (width) factor. If that's not enough, then the 

font height is reduced. 

Reduce extension (width) to. Defines the minimum 

width factor. 

Tab size. Defines the distance at which the 

cursor moves after pressing the <Tab> key. 

 

Tab list. You can enter several numbers in the list, separated by commas, that will define the tab 

sizes. The numbers are automatically sorted in the ascending order. These numbers are the 

distances from the text left margin to the text position. For example, if you enter the set of 

numbers 20,40,50, then after pressing the <Tab> key first time the cursor will move by 20 

measurement units from the left margin; on pressing the second time – by 40, on the third 

time – by 50. Thereafter, the tabulation is done according to the specified size (the default is 

12.7). 

Offset. Defines the distance from the boundary of the rectangular area to the text – left, right, 

new line indent. 

Interval. Defines the spacing between the lines. Before – sets the height of the first line in the 

paragraph, After – sets the spacing between the last line of the current paragraph in the first 
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line of the next one. Between – sets the spacing between the lines in a paragraph. With the 

Auto setting, the spacing is set automatically, depending on the maximum font height (by the 

printed characters). Minimum - sets the numerical value of the minimum line spacing. If a 

printed character doesn’t fit in the line by height, the spacing is increased automatically. 

Exactly - defines a strictly fixed numerical value of the line spacing. Factor – defines the line 

spacing as the product of the font height (by the printed characters) and the input factor. 

Numbering. This option allows turning on the automatic numbering of the paragraphs. You can 

specify a number to start a new numbering or to continue an existing numbering with.  

Additionally, you can define the format of the font for the digits of the current numbering. 

A new paragraph is automatically created by pressing the <Enter> key. However, you can wrap a textual 

string to the new line without creating a new paragraph. To do this, press <Shift>+<Enter> (the 

icon ). 

Options to control text input and text editing 

 Parameters of changing Paragraph size <Ctrl+F5>. This option is provided for the paragraph 

text only. It calls the dialog box for defining the coordinates of the window and the system 

actions. 

The Width tab defines the system action in the case when the text doesn't fit into the box by 

width: 

Ignore. The text part that doesn't fit in the box will be saved but not displayed on the screen. 

Enlarge width of rectangle – in the 

specified direction by the specified amount 

(the respective numerical value is displayed 

in the dialog which automatically appears 

in the process of text input). 

Ask. This sets automatic display of the 

query dialog in the case when the text does 

not fit in the box. If this parameter is not 

set, then the previously specified action will 

be executed without displaying the dialog. 

This parameter is On by default. 

 

 

The Height tab defines the system actions in 

the case when the text doesn't fit in the box 

by height. It contains the same options as 

the Width tab, and, additionally: 

Create new rectangle on current/new/next 
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page. This option allows to create a new 

box with the specified coordinates on the 

respective page of the drawing. If 

necessary, the new page will be created 

automatically. 

The Deletion tab serves to define the system 

actions in the case when the text shrinks so 

much that the last created box becomes 

empty. One can select one of the following 

options: 

 

The Deletion tab serves to define the system actions in the case when the text shrinks so 

much that the last created box becomes empty. One can select one of the following options: 

Ask. This parameter is similar to the same-

name parameters on other types of this 

dialog. It sets the automatic display of the 

query dialog when the text shrinks. If this 

parameter is not set, then the previously 

specified action will be executed without 

displaying the dialog. 

Leave. The paragraph text is left as is, with 

boxes remaining empty. 

Delete only Rectangles. This means an 

emptied rectangle area (box) will be 

automatically deleted. Meanwhile, the 

document page, on which it was located, 

will still exist.  

Delete Pages. An emptied rectangular area (box) of the paragraph text is automatically deleted. 

In addition, the document page, on which it was located, will also be deleted (provided that this 

text area was the only object on the page). 

If the “Ask” option is set on any of the tabs of this dialog's window, and one of the above-

described situations takes place, then an abridged dialog window will be automatically 

displayed. The contents of such dialog will be similar to the contents of the respective tab of the 

“Fit Settings” dialog. In addition, the dialog will have another parameter: 

Don’t ask this question again: (“For this text”, “For this session”). If set, then the action 

defined in this dialog box will be performed in the future without displaying the dialog box. It 

is defined separately for the width and the height of the rectangle. 
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 Edit in separate window <F11>. Allows editing the text in the text editor (see the section “Edit 

paragraph text”). 

 Check Spelling <F7>. This option invokes the command for checking the spelling of the 

contents of the current text. 

Editing Paragraph Text 

To edit a paragraph text, use the command ET: Edit Text: 

Keyboard Textual Menu Icon 

<ET> Edit > Draw > Text  

Selection of several paragraph text, just like multiple selection of other system elements, can be done by 

box or using the options  (selects all text) and  (selection from the list of the named elements). 

When selected, all rectangular areas of the specified paragraph text are highlighted. 

Upon multiple text selection, the following options become available: 

 

 <P> Set selected Element(s) parameters 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

Upon selecting a single element, the following options are available: 

 

 <E> Edit selected Text 

 <P> Set selected Element(s) parameters 

 <D> Add Rectangle 

 <Y> Create Name for selected Element 

 <N> Set relation with Node 

 <I> Select Other Element 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

Text contents editing mode 

To begin editing, click  inside the rectangular area or select the option . 

 



T-FLEX CAD Brief Introductory Course 

506 

There is yet another way to select a text for editing. When the system is in the command waiting mode, 

point the mouse to the text to be edited and right click . In the coming up context menu, select the 

item Edit text.  

 

Besides that, if the parameter “Transparent" Text editing is set among the drawing settings (the 

command Customize > Set document parameters, the tab “Preferences”), then you can start the text 

editing mode by clicking the text  (the pointer in this case turns into a textual cursor). 

Modifying parameters of selected elements 

To modify parameters of selected text, use the option . 

If the whole paragraph text was selected, then after calling the option a dialog box appears with general 

parameters of the paragraph text: 

Level, layer, priority, color – the standard parameters for all T-

FLEX CAD elements. 

Symmetric. This parameter defines “mirror” text mode. 

Account for italic font while formatting. Enabling this 

parameter allows us to take into consideration the text 

in italic when placing the elements of fractions, indices 

and also when formatting the paragraph in the “fit into 

one line” mode. 

By default this parameter is disabled for texts created in 

T-FLEX CAD of versions 11 and lower, and enabled for 

the newly created texts. 

The Font tab contains several standard parameters. 

If a rectangular area is selected (see the topic “Editing 

rectangle” for selection tips), then the option call brings up the 

dialog box Rectangle parameters: 

 

 

Vertical Justification - sets the vertical text justification inside the 

selected rectangle. Three justification options are available –Top, 

Center, and Bottom. 

Rotation angle – allows rotating the rectangular area by an arbitrary 

angle, in degrees. 
 

In the case of selecting several elements, upon calling the option <P>, the dialog box appears for 

selecting the parameters to be edited. The checkmarked parameters will be available for editing in the 

general text parameters dialog box that follows. 
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Adding rectangle 

The following option adds a rectangle at the end of the list of the existing rectangles: 

 <D> Add Rectangle 

If an existing area of the paragraph text being edited was selected before calling the option, then the 

new rectangle will be inserted in the list before the selected area. 

The new rectangle (box) may be automatically created when the content of a paragraph text is edited. 

 

Editing rectangle 

To resize an arbitrary rectangular area of a paragraph text, first you need to select it. To do this, click  

on the outer side of the rectangle. Now, you can resize it by the mouse. 

Automatic deletion of rectangle 

It is possible that, as you edit a paragraph text that spans several boxes, the text shrinks so much that the 

last created box becomes empty. In this case, the system could maintain the empty box, or delete it from 

the page, or even delete it together with the page on which it is located, provided that this text box is the 

only object on that page. The specific system actions depend on the settings made in the dialog of the 

“Parameters of changing Paragraph size” option (the icon ) in the text content editing mode (see the 

topic “Entering text content”). 

Editing text in separate window 

Besides the way of editing a paragraph text directly on the drawing, there is a provision for working in 

the text editor. To start the editor in the text contents editing mode, call the option . The text editor 

window will be displayed. 

 

The text editor provides all the text handling options described above (formatting and insertion), plus the 

option: 

 Zoom. The displayed text can be zoomed for convenience. 

The text editor also allows working with various text document files. The following formats are 

supported: T-FLEX Paragraph Text (*.tft), Rich Text Format (*.rtf), Text files (*.txt), DOS Text files (*.txt). 

The following options are used for handling files: 



T-FLEX CAD Brief Introductory Course 

508 

 New Text <Ctrl+N>. Creates a new document. 

 Open <Ctrl+O>. Opens a text document.  

 Save as <Ctrl+S>. Saves changes in a file. 

These options support exchange of text with other text editors. Suppose, for example, that you need to 

import a Microsoft Word document into a T-FLEX CAD drawing. To do this, use the Save as command in 

Microsoft Word and save a copy of the document in the RTF format. Then, in the T-FLEX CAD text editor 

open the RTF document using the command Open file. Thus, you open a copy of the original Word 

document with all the formatting preserved. You can export text in a similar way. Besides, you can carry 

over a text from one editor to another by using the clipboard via the commands Put selection on 

Clipboard, Paste Clipboard contents. 

The commands for editing paragraph text can be also called from the context 

menu by right clicking  over an appropriate element: 

- “Edit” - calls the command ET: Edit Text; 

- “Delete” - deletes the selected text; 

- “Parameters” - lunches the parameters editing of the selected text; 

- “Edit text” (for multiline and paragraph text) - executes the command 

of editing the paragraph text in the text contents editing mode; 

- “Edit in Dialog” - calls the text editor for editing the contents of the 

selected text; 

- “Edit Variables” (if variables exist in the selected text) - starts variable 

editing mode. 

 

Variable editing mode 

To modify the values of the variables inserted in a paragraph text, you do not have to start variable 

editor. Modifications can be done directly in the text, which is convenient. 

This way of editing variables is applicable only to the variables inserted in the text with the flag 

“Editable as field” checked. 

To start variable editing mode, simply point the mouse to the inserted variable and click . Besides, this 

mode can be invoked from the context menu by right clicking  over a paragraph text. 

The paragraph text containing the chosen variable will be selected as if in the text contents editing mode. 

However, available for editing will be only the variables inserted in the text and flagged as “Editable as 

field”. 
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At this moment, the following icons will appear in the automenu: 

 

<Ctrl+ 

Enter> 
Finish Variable change 

 <Ctrl><X> Cut 

 <Ctrl><C> Copy 

 <Ctrl><V> Paste 

 <F6> Text… 

 <Alt+F2> Special… 

 <Ctrl><F3> Show “Select from List” buttons 

 <Ctrl><F2> Show non-printing symbols 

 <Esc> Cancel Variable change 

The options  and  allow the user to insert the text from the dictionary, indexes, fractions and 

special symbols into the expression of the edited variable. Both options contain the lists of embedded 

icons. Any of them can be shown in the automenu. Usually it is the icon of the option which was invoked 

the most recently. 

           

When using the options of insertion into the expression of the edited variable, the special symbols 

of formatting by rules adopted for the string text are automatically added (see section “Subscript 

and Superscript Text. Use of Variables in Text”). 

The options , ,  are provided for handling the selected portion of the current variable value. As 

the contents of the clipboard are being pasted, the system checks the correspondence between the 

types of the clipboard contents and the current variable. Therefore, it is impossible to insert a character 

string into a numerical variable. 

Besides, the system checks for presence of the tab character dividers in the text being inserted. If the text 

being inserted into the field of a textual variable contains the tabulation characters, it will be processed 

as follows. The portion of the text before the first tabulation character will be inserted in the current 

variable. If there are more textual variables in this paragraph text, then the next portion of the clipboard 
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text will be automatically entered in the field of the next variable, and so on until all variables or the 

clipboard contents are used up. 

The option  toggles the display of the graphic buttons for selecting from the predefined list of values. 

The option  toggles the display of the formatting marks (tab, new line, etc.) in the text being edited. 

To confirm the changes you have made, press the option  or click the mouse outside the text area. 

The option  allows quitting the mode without saving the entered changes. 

A provision is made for the variables with a predefined list of values stored 

in a file for editing or adding values to the list without entering the variable 

editor. Simply right click  and select the respective item in the coming up 

context menu.  

Creating and Editing Multiline Text 

The Multiline Text, as opposed to the paragraph text, is always located in one rectangular area, whose 

boundaries extend as the text is being input until the user presses "Enter" for wrapping the text to the 

new line. 

To create a multiline text, use the command TE: Create Text. 

When creating a text, the parameters are automatically used that were set as the default parameters (the 

option ). Originally, these parameters use the settings “from document”. The text parameters will be 

applied to the whole content of the given text. 

When editing the contents of the text being created, you can assign specific parameters to its separate 

elements, for example, to an isolated word or sentence. 

To create a multiline text, select the option: 

 <М> Create Multiline Text 

Next, you need to specify the text attachment point. This can be done in three ways: by pointing the 

mouse anywhere in the document and clicking , or by specifying the absolute coordinates using the 

option , or else by selecting a node for attaching the text. A rectangular area will appear on the 

screen with a blinking cursor. You can now start inputting the text.  

 

The options for creating a multiline text are similar to the options for the paragraph text creation. An 

exception is the additional icons for defining the ways of vertical positioning of the text with respect to 

the attachment point. 
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When creating a new text, an icon is always present in the automenu that 

indicates the default attachment. (This attachment is defined in the text 

parameters before the text creation.) Usually, this is the attachment at the upper 

left corner. The list of the enclosed icons will appear if you press and hold  for a 

short while. 

Selecting one of these icons will define the position of the text being created or 

edited with respect to the attachment point as follows. Selecting one of the top 

attachment settings positions the text below the attachment point; selecting one 

of the bottom settings positions the text above the attachment point; one of the 

center settings centers the text with respect to the attachment point. 

The selected icon will be displayed in the automenu. The icon displayed in the automenu will be applied 

by default to newly created multiline text. When editing a multiline text, the icon is displayed in the 

automenu that corresponds to the attachment type of the text being edited. An attachment type for the 

text can be set without scrolling through the list of the enclosed icons. You can simply keep pressing the 

option in the automenu. That will rotate the icons and, therefore, the attachment type of the text with 

respect to the attachment point. 

There is another difference of the multiline text from the paragraph text. Moving and rotating the 

rectangular text area can be done with respect to the text attachment point, which is marked by a cross 

when rotating. 

 

Multiline text editing is similar to editing the paragraph text, except for the options provided for editing 

the rectangular text area. 

Creating and Editing Tables 

Table creation is based on the multiline text. The command used for this purpose is TE: Create Text. 

Editing tables is none different from its creation. The table editing options are similar to the options of 

the multiline and paragraph text, except for the options for editing the rectangular text area. 

A table can be defined in two ways. One way is by inserting the table in a text (the paragraph text or 

multiline text). In this case, the table will be placed inside the text. Alternatively, you can create a stand-

alone table. In the latter case, you cannot type outside the table borders. Select the option: 

 <B> Create Table 
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Before creating the table, you can set the default parameters (the icon ) that will be applied to all 

newly created tables. The default color defines the font color for typing in the table and the table border 

color.  

Next, specify the table attachment point. This can be done in three ways. One way is to click the mouse  

at an arbitrary place within the document. The other way is to specify the absolute coordinates using the 

option . 

Yet another way is to select a node for attaching the table. An empty rectangular text area will then be 

displayed, along with a dialog box, where you can specify some parameters of the table being created. 

The buttons set “Text” will be displayed on the main toolbar (if it is not locked). 

 

In the dialog box, set the desired number of columns and rows, as well as 

the combined width of all columns (individual column width can later be 

defined among the table properties). If the parameter Column Width is not 

set, then the system will automatically set the minimal column width. Upon 

confirming the specified parameters, the table being created will be drawn 

in the rectangle. If necessary, you can resize the cells by dragging their 

borders with the mouse.  

Special handles are provided for moving and rotating the table just like the multiline text. 

To start typing in the table, place the textual cursor in one of the table cells, and then enter the text. 

The text creation options are similar to those for creating the paragraph text. The options defining the 

table attachment are similar to the attachment options for the multiline text. A table, just like a paragraph 

text or a multiline text, can be edited in a separate window. 

A table's contents can be created by copying the contents of an already populated table or a 

Word table via the text clipboard. Vice versa: a T-FLEX CAD table can be copied into MS Word. 

The following manipulations can be done with the help of the options on the main toolbar (button set 

“Text”): 

 Insert Table <F12>. Inserts a table in a text (the paragraph text or multiline text). A dialog box 

appears, in which you can define the number of columns and rows in the table (see above). This option is 

available only if the table is inserted in a text or if the parameter is turned off, "Disable text input outside 

of Table" (see table properties/the tab “Table”). 

 Split Cells. Splits the selected cells (or the cell with the cursor) into the specified number of rows and 

columns. 

 Merge Cells. Merges the selected cells into one. 
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 Split Table. Splits the table into two separate tables. The split is made above the current row, if this is 

not the first row in the table. This option is available only when the table was inserted in a text or the 

parameter “Disable text input outside of Table” was turned off when creating the standalone table (see 

table properties/the tab "Table"). 

 Insert row before current. Inserts an empty row before the current row. 

 Insert row after current. Inserts an empty row after the current row. 

 Insert rows. Inserts a specified number of empty rows before or after the current row. 

 Delete rows. Deletes the selected rows (or the row of the cursor). 

 Insert Column Before. Inserts an empty column at the left of the current column. 

 Insert Column After. Inserts an empty column at the right of the current column. 

 Insert Columns. Inserts a specified number of empty columns before or after the current column. 

 Delete Columns. Deletes the selected columns (or the current column). 

 Database. Inserts the contents of the internal database or a reference to a database into the table. 

Upon calling this option, a dialog box appears on the screen that allows selecting the name of one of the 

existing databases. Then, the list of the database fields appears in the “Columns” pane of the database. 

The data type (integer, real, text) is marked left of the field name. To enter the contents of a database 

field into a table cell, select the field name and press the graphic button [>>]. The field name will then be 

carried over into the right pane to prevent a repeated selection (except for the field keeping the ID 

number of the database record). 

The number of the selected database fields may not be greater than the number of the table columns. 

The order of the field names in the list of selected corresponds to the order of filling in the table columns 

(the first field contents is entered in the first column, and so on). To delete data from a column, select the 

respective field name and press the graphic button [<<]. To modify the order of the data in the table, use 

the graphic buttons [Up], [Down]. A sorting rule can be assigned to any particular database field, except 

for the record number (none, ascending, descending). Upon confirming the selected fields by pressing 

the [OK] graphic button, the table will be filled with the respective values from the database. 
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If the database contents were changed, the table contents can be refreshed using the option: 

 

 Refresh from Database. Refreshes the table contents according to the changes in the database. 

 

 Select Table. This option selects all cells in a table. 

 

 Table Properties. Calls the table properties dialog box. 

Table Properties 
"Table" tab 

This tab allows defining the parameters that affect the whole table. 

Align - Horizontal. Aligns the table horizontally within the text 

rectangular area. The alignment options are Left, Center, 

Right. The “left” alignment option enables the offset 

parameter that defines the distance from the left side of the 

text rectangle to the table.  

Since standalone tables are created based on the 

multiline text, the dimensions of the text rectangular 

area depend on the input data. The values of this 

group of parameters are meaningful (and displayed) 

only in the case when some text was entered outside 

the table, thus increasing the size of the text 

rectangular area as compared to the table size. (See 

the description of the parameter "Disable text input 

outside of Table".) 
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Cell interval. This parameter defines horizontal or vertical padding of the cells. 

 

             

Default Cell Fields. Sets the amount of padding between the text being input and the cell 

boundaries. This parameter affects all table cells except those whose padding was defined 

separately on the tab "Cell". 

 

Disable text input outside of Table. This parameter allows creating standalone tables. If not set, 

then the system is in the multiline text creation mode that allows inputting text outside the 

table. In this way, the table being created will be inside a multiline text. Once at least one 

character is typed outside the table, this parameter becomes inaccessible. If the table appears in 

the beginning of a text and you need to type a text before the table, place the text cursor in the 

beginning of the first table cell and press <Enter>. To return to creating a standalone table, 

delete all character typed outside the table, leaving outside just one empty line, and then set 

this parameter. (The tables that you insert in a text when creating a multiline or paragraph text, 

have this parameter turned off.) 

"Row" tab 

The Size group of parameters defines the height of the table rows: 

Height. Sets the height value of the selected rows in 

the table. If this parameter is not set then the height 

of the rows is defined automatically depending on 

the maximum font height (by the printed characters), 

also accounting for the maximum amount of 

padding across the cells in a row. 

The parameter Height is not set for the rows of a 

newly created table and for rows that were added or 

created as a result of splitting cells. 

 

Mode. This parameter controls the specified value of the row height depending on the kind of text 

being input: 

 

Minimum. Sets the minimum value of the row height. If the text doesn't fit by the height of the 

row, the row height is automatically increased. 



T-FLEX CAD Brief Introductory Course 

516 

Exact. Sets a fixed value of the row height. The text that does not fit by height is not displayed 

and will be visible only if you increase the height of the row. 

Multiple. As you input the text, the height of the row will always be a multiple of a specified 

value. 

 

Allow wrap. Allows carrying the rows of the table over from one text rectangle to the next one, 

and, consequently, from one page to the next one (in the case of creating or using an existing 

table within a paragraph text). 

 

 

 

This parameter is set by default for all rows of the newly created tables, as well as the rows 

being added or created as a result of splitting cells. A row, for which this parameter is not set, 

will be kept together with the next row. As the table rows are carried over from one text 

rectangle into the next one, these rows will be carried over together. 

"Cell" tab 

Column width. Sets the width value of the selected columns. 

The group of parameters Text Alignment and Direction defines text alignment and direction inside each 

cell: 

Vertical justification. Defines the vertical alignment of the text inside the selected cell. There are three 

alignment options – Top, Center, Bottom. 

 

Direction. Defines the text direction inside the selected cell. Four direction options are available – 

Normal (from left to right), From Bottom to Top, From Top to Bottom, From Right to Left. 

Fields. Defines the text padding (Horizontal, Vertical) inside the selected cells. If the parameter is not set, 

the padding values are used that were set for all table cells on the tab “Table”. 

Fill. Defines the fill color of the selected cells. 
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"Borders" tab 

This tab allows modifying the borders of the selected rows, columns, cells or the whole table. 

Each border has a group of attributes that toggle the border display altogether and define the color and 

the borderline width. The attributes are placed next to the respective borders or pointed at by the 

witness lines. 

The first check box toggles the display of the border. The second one sets the border color to the default 

defined among the text parameters before the table creation. To set a border color different from the 

default, uncheck the item and select the desired color from the color list (the check is cleared 

automatically when selecting a color from the list). To restore the default border color, simply check the 

box again. 
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The parameter Width defines the value of the borderline thickness. Its default value is copied from the 

drawing parameters ST:  Set docement parameters on the Lines tab Other Lines parameter. 

A preview pane is provided on the tab that reflects on the border parameter changes as the textual 

cursor is replaced from one cell into another. 

Working with Dictionary 

When creating drawings, you often need to add text elements that require multiple entries or repeat 

from a drawing to a drawing (such as, for example, technical specifications). T-FLEX CAD makes a 

provision for this case by including in the installation a standard dictionary with a set of technical 

requirements. The dictionary is based on a database complying with the Microsoft Access (*.MDB) 

format, represented by the file …T-FLEX CAD\Program\TFDict.mdb. The user can create custom 

dictionaries or modify this standard dictionary by manually adding or deleting elements from it. To 

create a new dictionary file, make a copy of the standard dictionary and save it under a different name, 

and then modify as desired.  

The text elements from the dictionary can be inserted in all types of the text (the string, multiline, 

paragraph text, table). 

The dictionary can be opened while within the text creation and editing commands. To do this, engage 

the option Insert text from Dictionary <F6> with the respective automenu icon  or select the context 
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menu item Insert/Text… accessible by right clicking . The dictionary window is always on top of other 

windows. 

The following commands are available on the toolbar in various modes: 

 Open. Opens the dictionary file. You can open the file for editing or in the “Read Only” mode. The 

mode is set in the File Open dialog box. 

 Add. Creates a folder in the structure pane or a new line of text. A folder or text can be created from 

the context menu. 

 Delete. Deletes the selected objects from the dictionary. 

 Rename. Renames the selected objects (the names of folders or lines of text). You can activate 

renaming from the context menu or by clicking  on the selected object. 

 Sort. Sorts the current list alphabetically. 

 Move Up. Moves a line of text up the list. 

 Move Down. Moves a line of text down the list. 

 Keep visible. Allows continuously inserting several elements. The dictionary window is not closed 

after inserting a text. You can work simultaneously with the text and the dictionary. 

 Always on Top. While the option is active, dictionary window will be on top of all other windows. 

 Insert into Editor. Inserts the selected text in the drawing (see the description below).  

 Copy. 

 Paste. 

 Create formatted text. Calls the text editor (see the description above), where you can specify 

formatting parameters of the existing text or input new one. The formatted text cannot be edited in the 

dictionary dialog box. Instead, use the following command: 

 Edit formatted text. Calls the text editor window where you can edit formatted text. You can start 

the text editing mode by double-clicking  in the editing pane located in the lower right corner. 

 Delete formatted text. Deletes all text formatting. Such text can be edited in the dictionary dialog 

box. 

 Add reference Database. This option allows including in the dictionary the contents of a database 

fields (*.mdb). After calling the option, a file browser appears on the screen for selecting the desired 

                                                   
 If the dictionary file is open in the “ Read Only” mode, then the editing commands are inaccessible. 
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database. Note that adding a group with the selected database is done on the current level of the 

dictionary structure. Upon the creation, the database reference group can be renamed (the default name 

is composed of the path and the database filename) or moved to another level. Unlike other dictionary 

folders, the contents of a database by reference cannot be edited or converted into the formatted text. 

The next step will be defining the database parameters (at creation, this dialog box appears 

automatically).  

 Edit database parameters. The dialog box appears as shown on the diagram. 

The left portion of the dialog 

contains the list of all fields of the 

selected table in the database (the 

table is selected from the list in the 

item “Table”). In the right hand side 

pane of the dialog the user places 

the fields to be used in the 

dictionary. To add a field, select it in 

the left pane and press the graphic 

button [>>].  

To delete a field selected in the right thing and press the graphic button [<<]. The graphic buttons [Add 

All], [Delete All] do this with all elements of the field list. The selected database fields will be placed in 

the dictionary window in the order they were in the right pane of the dialog. To modify a field position, 

select it in the right pane of the dialog and move within the list using the buttons [Up], [Down]. The SQL 

Request field is provided for specifying the selection condition for the fields and records in the database. 

Besides, you can use the commands from the main dialog menu: 

File/Add from… Allows merging the database file you've specified into the current dictionary 

database file. 

File/Save as… Allows saving the current dictionary file under a different name. 

File/Close. Closes the current dictionary file. 

File/Exit. Closes the dictionary dialog box. 

The dictionary supports “Drag & Drop” mode for copying and moving records or folders. Point the 

mouse to a record or folder, and then depress the left mouse button and hold while dragging the 

selected element to the new place. 

Inserting Text from Dictionary 
In the dictionary structure pane, select a group folder. The contents pane will then display the list of text 

elements, each one being named. The text elements are selected by their names. You can modify the 

element contents in the editing pane (the lower right pane). Next, select the desired line from the list by 

double-clicking  or press  for inserting the selected line. At this moment the text is inserted in the 

drawing, while the dictionary window closes. To keep inserting the same text, you can copy it on the 
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clipboard by pressing <Ctrl+V>. If only the name is defined for an element, while the contents are 

empty, then the element name will be inserted in the drawing text. 

 

 

If you need to work with the text without closing the dictionary window, use the option “Continuous text 

input”, or press the respective button .  

Creating New Records in the Dictionary 
In the left pane, select a header in which you want to create a new folder or text. Select, for example, the 

folder “Dictionary”. To add a subfolder to this folder, press the icon  or select the respective context 

menu item, invoked by the right mouse click (Create/folder). 
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As a result, a new subfolder will be created in the folder “Dictionary”. 

The subfolder name will be highlighted for editing, so that you can enter its desired name. 
 

 

To enter a text in the folder, first select the folder. In the context menu accessed by right clicking , select 

the item (“Create|Text”). Alternatively, upon selecting the folder, click  in the upper right pane of the 

dialog and press the icon . As a result, a new line of text will appear in the contents pane, that can 

now be named. To enter the contents in this text line, move the pointer to the lower pane and click . 

The textual cursor will appear there, allowing to enter the desired text. 
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LEADER NOTES  

Leader notes are used for decorating various drawing elements. Those mark BOM items, specification of 

BOM positions points to the locations of brand marks, part codes, etc. A leader note is composed of two 

parts: the witness line (arrow) and the jog (the leader). 

To apply a leader note, you need to specify the position of both parts. Consequently, a leader note has 

two attachment points. If necessary, it is possible to create leader notes that contain several extension-

arrows including bent ones. 

Depending on the specified parameters, you can get various detailing elements. 
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Creating Leader Notes 

Leader node creation is done in the command IN: Create Leader Note 

Icon Ribbon 

 

Draw → Title Block → Leader Note 

Keyboard Textual Menu 

<IN> Construct > Leader Note 

 

Creating Simple Leader Note 

After launching the command of the leader note creation the following set of options is available in the 

automenu:  

 <Enter> 
Set a leader note attachment point at the position of 

the pointer  

 <Alt+P> Copy Properties from Existing Element 

 <P> Set Leader Note Parameters 

 <L> Set relation with Line 

/ /

 

<U> 
Fixing to Point/Angle Fixing/Orthogonal fixing 

 

 <N> Select Node 

 <Z> Change Leader’s Orientation 

 <F4> Edit Leader Note  

 <Esc>  Exit command 

To create a leader note, you need to specify subsequently the positions of two points. The first point 

determines the position of the witness line - the leader arrow, the second - the position of the jog.  

The third point appears after the two points positions are specified. The point allows to specify a break. 

You can create several breaks for the leader note. 

 

When creating the leader note, a dynamic view is fixed to the cursor that entirely shows the future leader 

note’s view. 
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After specifying the first snapping point, additional option will appear in the automenu: 

 <F> Tie to Arrow 

The position of the second point can be defined relative to the first point of the leader note attachment 

(relative to the arrow) or in the absolute coordinates. To select the desired mode, use the option . 

With the option turned on, the position of the jog is defined relative to the leader note arrow, otherwise 

– in the absolute coordinates. Later on when translating the first point of the leader note, created with 

the enabled option , the entire leader note will be translated, and for the leader note created with the 

disabled option , the leader will remain in the initial position 

 

 
 Option disabled 

The second point don’t move 

Option enabled 

The second point moves with the first 

 

Leader note parameters are specified in the command’s properties window before completing the leader 

note creation with the help of the  option 

Note that after specifying the last point of the leader note’s arrow the 

focus is automatically shifted to the text editor. If we press <Enter> in the 

text input editor - leader note’s creation will be completed. 

Leader note’s parameters include the contents of the text lines, style of the 

leader note lines, font style parameters etc. In addition, in the properties 

window you can specify precise location of the leader note’s snapping 

points (by specifying the absolute coordinates of the points or their shifts 

with respect to the selected snapping elements). 

 

As with creation of the dimensions, leader note’s parameters can be copied from already existing leader 

note-element with the help of the  option. This option is described in more detail in the “Dimensions” 

chapter. 

Snapping Leader Note to Drawing’s Elements 
Both leader note points can reference a node or a graphic or construction entity. You can select the 

desired element with the help of  directly in the drawing’s window. To select lines and nodes it is also 
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possible to use the  and  options. When using this mechanism, keep in mind that attaching the 

second point to a construction line or node is possible only when the option  is turned off. To cancel 

of the active attachment-defining mode, press <Esc> or right click . 

To attach a leader note point to a construction entity, first select the desired entity (by clicking  or using 

the respective option). The entity will be highlighted, and a leader note will start rubberbanding along 

the entity, following the pointer. Now, specify the position of the leader note attachment point on the 

entity by clicking .  

 

When attaching a leader note to a straight line, at least one node must exist on the line. 

Attaching to a graphic entity is similar to attaching to a construction entity. In the case when the leader 

note point is beyond the limits of the graphic entity, it will be positioned on the continuation of this 

graphic entity. 

The , ,  options define the rules of changing location of leader and leader arrow when location 

of the snapping point is modified. These modes affect only the leader notes that are snapped to lines. 

When snapping to points there will be no effect if these modes are selected. 

If the leader note is created with the use of the  option, then upon translation of the leader note 

along the line it is translated “rigidly” (without changing angles). The  option allows us to keep the 

arrow perpendicular to the selected snapping line. The  option allows us to keep the angle that the 

arrow makes with respect to the selected snapping line. 
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Markers for Controlling the Snap of Leader Note’s Elements. Creation of Arrow 

with Bends 
After preliminary snapping of a leader note, location of its snapping points can be modified. It is also 

possible to change the shape of an arrow by creating on it any number of bends. To control snapping of 

leader note’s points, and also for specifying bends on its arrow, special markers are used. 

At the beginning of leader note creation, there are only two markers – they 

designate the main leader note’s snapping points and are highlighted with blue 

color. After specifying location of both points, one more marker will appear on the 

leader note’s arrow image, marked with a green color. This is a point in which an 

arrow bend can be created.  

To correct location of any snapping point of the created leader note, it is sufficient to move the cursor 

closer to the marker of the desired point (it will be highlighted with orange color) and select it with the 

help of . The point will start moving after the cursor. In this way, for example, it is possible to specify the 

shift when snapping the leader note’s point to the node. 

To create a bend, it is required to move the cursor closer to the green marker (it will also be highlighted 

with orange color) and select it with the help of . The arrow will be split into two segments, bend point 

– arrow bend point – will start moving after the cursor. Pressing  for the second time will fix the location 

of the arrow bend point. 

 

After creation of the first bend point, new green markers will appear on the two segments of the arrow. If 

necessary, it is possible to create the next bend at each of these markers. When arrow creation is 

completed, you can start creating the next arrow, or complete leader note creation with the help of the 

 option. 
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Snapping of each bend point with respect to the previous point of the arrow is controlled by the option: 

 

 <F> Tie to Arrow 

 

When this option is enabled, the bend point location is specified with respect to the previous 

characteristic point of the arrow; when this option is disabled – in absolute coordinates.  

 

To remove a bend point, it is required to select it and use the option: 

 

 <Del> Delete Node 

Markers (Manipulators) for Controlling Location of Symbol and Text on Arrow 
In the leader note’s parameters it is possible to specify the text and symbol on the arrow. Location of 

these leader note’s elements can be controlled with the help of the special markers/manipulators. 

 

 

After selection of the desired marker with the help of , the symbol or text will start dynamically move 

after the cursor. You can fix its location by pressing  for the second time. 
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Creating Additional Arrows 
After specifying location of the main arrow and the leader of the leader note, additional option appears 

in the automenu: 

 <Space> Add Arrow 

As a result of invoking this option, the image of the new arrow will appear next to the cursor.  

When creating additional arrows, the same rules will hold as for the main arrow of the leader note. It is 

possible to tie them to lines and nodes, set relation with dimensions, form bends. In the properties 

window it is possible to specify individual parameters of the arrow which are different from the ones 

specified for the main arrow of the leader note. 

The end point of an additional arrow can be tied to any characteristic point of the main leader note. To 

do so, it is sufficient to indicate one of the markers on the leader note image as a snapping point for the 

arrow’s end. 

  

You can refuse creation of the new arrow by using the option: 

 <Del> Delete Arrow 
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The list of arrows created for the leader note is displayed in the properties window.  

 

 

The  and  buttons to the left and right of the arrows list can be also be used for creation and 

removal of additional arrows of the leader note. 

 

Automatic Completion of Leader Note’s Creation 
By default, after specifying location of two main leader note’s points (locations of arrow and leader), the 

command remains in the mode of editing the created leader note. This allows us to add to the leader 

note the desired number of additional arrows, create bends on the arrows, specify and edit leader note’s 

parameters at any instant of its creation. After finalizing the leader note formation, it is required to 

explicitly complete its creation with the help of the  option or with the similar button in the 

command’s properties window. 
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It is also possible to use another work algorithm. In the command’s 

properties window, in the “Options” section you can find the Create 

automatically flag. When this flag is enabled, creation of the leader note 

will automatically be completed right after specification of the second 

snapping point of the leader note (the leader’s snapping point). 

Note that in this case it is required either to specify parameters of the 

leader note being created before snapping of the leader or additionally 

enable the Show parameters dialog for each element flag. In the latter 

case after specifying location of the leader, the leader note’s parameters 

dialog will appear on the screen. This allows us to work as with the previous 

versions of T-FLEX CAD – first specify location of an element on the 

drawing and then specify its parameters. 

 

Leader Note Parameters 

The dialog in the command's properties window contains all main parameters of a leader note. For 

working convenience, the dialog is divided into several sections. 

«Coordinates» Section 
The first section, “Coordinates” contains the fields to define the exact coordinates of leader note snap 

points. The current coordinates are dynamically tracked as the cursor moves in the drawing window. 

Depending on the method of leader note snapping, different types of coordinates may be displayed in 

this section. For example, in the case of the free snap used for both points, the absolute coordinates of 

both snap points are displayed in the properties window. When using free snapping with the jog being 

snapped to the arrow, the offsets dx and dy will be used for the second point, relative to the first point, 

etc. 
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«Leader» Section 
The “Leader” section serves to define all parameters of the leader 

note jog. Those include: 

Text. This is the text on the leader note jog. 

When defining this and other text parameters of a leader note, you 

can use variables by entering them in curly brackets (braces). Details 

on that are given for dimensions and text.  

Text Under. This is the text under the leader note jog. 

Size. It defines the length of the leader note jog in certain units. If the 

Auto value is used, it will automatically assume the length of the text 

line. 

 
 

Thickness. Defines the thickness of leader lines. If the 

parameter value is set to Default, it is calculated 

based on the Line thickness > Other lines parameter 

defined in the command ST: Set document 

parameters the tab Lines. 

Corner. Defines the type of the leader jog (see the 

figure on the right). 

  

Standard. Serves to define the leader style standard. There are two standards for leaders - ANSI 

or BS/DIN/ISO. If this parameter is set to “Default”, then leader notes will follow the standard 

specified in the command ST: Set Document Parameters (Detailing elements > Leader Notes > 

Standard). 

Clear Background. When this parameter is enabled, the drawing image behind the leader jog 

(jogs) is erased. 

Clear Background under corners. When this parameter is enabled, the drawing’s image under the 

leader note’s corner is deleted. 

Increment by 1. This parameter is available only at the time of creating a leader note. It serves to quickly 

define BOM items. A number should appear on the jog instead of text – a BOM item reference number. 

When the next leader is created, the former current number is automatically incremented by one. It 

should be noted that when using this approach, the number that appears on the leader will not be 

related to the BOM position number.   

For details about creating BOM item references, refer to the chapter “Bill of Materials”. 
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«Multiple Leader» Section 
Next section of the properties window is – “Multiple Leader” – which contains parameters of additional 

leader jogs (if any): 

Multiple Leaders. This is the field to enter the text on the 

additional leader note jogs. The jogs in the leader note will be 

displayed in the order they follow in the window of this 

parameter. 

A new jog can be created by double-clicking  on an empty 

space of this parameter window(at position of the the next 

string) or with the button . You can modify the order in 

which leader note jogs follow using the buttons  and . 

To delete a jog, use the button . 

String Height. Defines the distance between jogs in a multiline 

leader note. When the Auto setting is used, the distance 

between jogs is set according to the font size. 

 

 

Align jogs length. When this parameter is set (default), the jogs in a multiline leader note are 

drawn with the same length, otherwise – by the length of text lines of the respective jogs. 

Append Upwards. This parameter defines the way of placing additional leader jogs. If the flag is 

enabled, the jogs will be added on top; if the option is disabled, the jogs are added at the 

bottom (see figures below). 

Sections «Arrows», «Arrow», «Text on arrow», «Symbol on arrow» 
The following several sections of the properties window  – Arrows, Arrow, Text on Arrow, Symbol on 

Arrow – should be described together. They all together allow us to specify parameters for the leader 

note’s arrows (main and additional). 
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The Arrows section contains the list of all created leader note’s 

arrows. Buttons to the right of the list allow us to 

create/remove arrows. By selecting one of the arrows in the 

list with the help of , it is possible to specify parameters of 

this arrow in the following sections of the properties window. 

The Arrow section contains the following leader note arrow 

parameters: 

Drop down list for selection of the arrow type at the 

beginning of extension line. This list mostly coincides with the 

list of arrows used in the dimension and graphic line creation 

commands. 

However, for leader notes the list is appended with two special 

arrow types:  and . For these arrow types instead of the 

arrow size specification field (see below) two input fields for 

specifying the arrow’s length and height are displayed. By 

varying those parameter values, you can get leader notes with 

a rectangle- or oval-shape tip of arbitrary size and aspect 

ratio. 

 

Field for specifying arrow size at the beginning of the extension line. If the value is displayed in 

square brackets, the value can be calculated based on the specified parameter «Arrow (end) size» 

inside the command ST: Set Document’s Parameters (the Drawing tab). 

Line thickness. It defines the thickness of arrow lines. In case when the parameter’s value is 

displayed in square brackets, the value will be calculated based on the specified parameter 

Thickness of other lines inside the command ST: Set Document’s Parameters (the Drawing tab). 

Clear Background under Arrow. When this parameter is enabled, the drawing’s image under the 

leader note’s arrow is deleted. 

Clear Background under Line. This parameter allows us to delete the drawing’s image under the 

leader note’s arrow line. 

Draw Leader. This parameter controls drawing of the extension line for the leader note, from the 

snapping point to the leader note’s arrow. 

Clear Background under Leader. When this parameter is enabled, the drawing’s image under the 

leader note’s extension line is removed. 

The Arrow Text section allows us to specify parameters of the text above and under the selected arrow: 

Over Line. Text on the leader arrow. 

Under Line. Text under the leader arrow. 

The “Symbol on arrow” section contains parameters of the symbol on the selected arrow: 
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Symbol. Defines the type of the symbol (see the figure on the right), 

which will be put in the middle of the leader line. Normally it is used 

to indicate various drawnig notes. 

Clear background. With this parameter enabled, the drawing image is 

erased behind the leader  

 

Line Width. Defines the thickness of the arrow strokes. In the case when the parameter value is 

shown in square brackets, it is calculated based on the Other lines parameter defined in the 

command ST: Set Document Parameters (the tab Lines). 

 

«Options» Section 
 

The section contains following parameters  

Show Dialog for Each Element. If this parameter is enabled, then 

the leader notes parameters dialog will automatically appear after 

defining the leader notes position in the leader notes creation 

command (the option ). 

 

This mode allows working in the same way as in previous versions of T-FLEX CAD – by specifying the 

leader notes position in the drawing first, and then defining its parameters. 

Create automatically. When this parameter is set, creation of the leader note will automatically be 

completed right after specifying the snapping point for the leader (without pressing ). 

Leader Note Examples 
The figures below show leader note appearances with different parameter settings: the first figure 

represents the state of the properties window as shown above; the second figure is obtained by disabling 

the “Append Upwards” parameter; the third figure illustrates the case with the disabled option “Align 

jogs length”; in the case of the fourth figure, the “Leader Height” parameter is set to the value 5. 

 

Leader Note Parameters Dialog 
Leader note parameters can also be defined in the parameters dialog called by the automenu option: 

 <P> Set Leader Note Parameters 
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The parameters on the tabs of this dialog duplicate the parameters in the properties window. Besides 

that, the parameters dialog contains several additional parameters. First of all, those are the system-wide 

parameters: level, layer, priority and color. Also, there is an additional tab in the parameters dialog that 

contains font settings. There, you can define the necessary font parameters that will be used to display 

the leader text. 

The leader note parameters dialog can also be called in the command-waiting mode from a 

leader's context menu (accessible by ). This facilitates quick modification of a leader note's 

parameters without calling the editing command. 

Defining Default Parameters 
The default parameters that will be applied to all newly created leader notes can be defined in several 

ways. 

First of all, those can be defined using the parameters dialog (the option ). To do that, call the dialog 

before starting a leader note creation. The parameters defined in it will be copied into the parameters of 

each newly created leader note. 

Besides that, you can save parameters of any leader note being created (or edited) as the default 

parameters, if you click the  button in the command's properties window. 

User's Defined Leader Notes 

T-FLEX CAD allows a user to make his own types of notes, more precisely – types for the leaders of notes. 

User's defined leader notes are created as standard parametric fragments in the library in the folder 

“System\Leader Symbols” (library “Leader Symbols”).  

In the dialog of the leader notes properties, the files located in the given folder are added as icons to the 

list of the accessible types of  the leader. Upon creating the leader note, location of the fragment-leader 

image is determined by the fixing vector which must exist in the fragment model.  

For controlling parameters of the user's leader note, the dialog of the fragment variables or the user's 

dialog (if it was created in the fragment) will be used. To call the dialog of the fragment variables (or the 

user's dialog), use the special button  which appears in the dialog of the leader note properties or 

call the command Annotation Properties… in the context menu of the leader note that utilizes the user's 

leader type. 



Leader Notes 

537 

 

Editing Leader Notes 

Editing leader notes is done by the command EI: Edit Leader Note: 

Keyboard Textual Menu Icon 

<EI> Edit>Draw>Leader Note  

Upon calling the command, the following icons are provided in the automenu: 

 <*> Select All Elements 

 <Esc> Exit command 

You can select one of the existing leader notes by pointing it with the mouse and clicking , or you can 

do multiple selections. As in the case of other drawing elements, multiple selections are done by the 

option . Using  together with the depressed key <Shift> adds the element to the list of selected, 

while with the key <Ctrl> - removes from the list of selected. 

Upon multiple selections, you can use the options: 

 <P> Set Leader Note parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Del> Delete selected Element(s) 



T-FLEX CAD Brief Introductory Course 

538 

 <Esc> Cancel selection 

When selecting a single leader note, the selected element parameters are displayed in the properties 

window. The following icons become available in the automenu: 

 <P> Set Leader Note parameters 

 <Alt+P> Copy Properties from Existing Element 

 <O> Create Name for Selected Element 

 <W> Link To Product Structure  

/ /

 

<U> 
Fixing to Point/Angle Fixing/Orthogonal fixing 

 

 <Space> Add Arrow 

 <Z> Change leader line jog orientation 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

The general principles of the command EI: Edit Leader Note are similar to other editing commands. Keep 

in mind that a leader note has two or more (when there are bends or several arrows) attachment points. 

The positioning and attachment of each point is edited separately. 

Select a leader note using . Now you can modify the position of either point of the leader note. To do 

this, move the pointer to the desired point and again click . At this moment, the following additional 

options will appear in the automenu: 

 <T> 
Link To Node (only when selecting a point snapped 

to the node with a shift) 

 <K> 
Break (kill) relations(only when selecting a point 

snapped to the node, line) 

 <F> 
Attach to arrow (available only when selecting the 

second attachment point of the leader note) 

 <Del> Delete Node 

/ /

 

<U> 
Fixing to Point/Angle Fixing/Orthogonal fixing 

 

 <L> Set relation with Line* 

 <N> Set relation with Node* 
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 <Z> Change leader line jog orientation 

Upon selecting a point, you start rubberbanding the leader note by the selected point.  

 

Now, you can fix the new position of the leader note attachment 

point. You can also break the attachment link using the option 

<K>, or attach the leader note to a node or construction entity. 

Editing leader note parameters in the case when a single element 

is selected is similar to defining leader note parameters. 

The option  allows modifying the parameters of several 

selected leader notes. The option <P> brings up the dialog box 

Change parameters. In this dialog box, check the parameters that 

you want to edit. By default, all the parameters of the selected 

elements are subject to editing. If a parameter is not supposed to 

be changed, clear the respective check box. Upon selecting the 

parameters for editing and pressing [OK], you get the access to 

the standard leader note parameters dialog box. The parameters 

that were check marked are available for editing. 
 

Option  takes parameters from another leader note. 

The option  allows linking the leader note to a record (entry) in a BOM product structure window. 

Calling this option brings up the window Product Structure. To add the new jogs open Multiple Jogs tab 

of the properties dialog, select the desired item from the Product Structure and press <Ins> or button 

. After that, new position number will appear in Multiple Jogs and on the drawing. 

Option <Del> allows deleting a leader note jog, when there are several, while options <Alt+Up>, 

<Alt+Down> - changing the order of the leader note jogs. 

Callouts for Product Structure and Bend Notes 

The Leader Notes command is used to create callouts for records of a product structure. 

 

More details about creation callouts in the product structure can be found in the chapter "Bill of 

Materials". 
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The Leader Notes command is used to create bend notes. 

More details about bend notes creation can be found in the chapter “Sheet metal operations”.  

 

The “By default” parameters for leader notes, callouts of the product structure and bend notes are 

stored in the system separately. 
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GEOMETRIC D IMENSIONING AND TOLERANCING 

SYMBOLS .  DATUM SYMBOLS 

To apply surface geometric dimensioning and tolerancing symbols (from now on – GD&T symbols) or 

datum symbols, use the command FO: GD&T Symbols.  

A GD&T or datum symbol can be displayed with or without the leader line and contain any number of  

extension lines. 

 

The size of the GD&T symbols is dependent on the font size specified among the parameters of a 

particular element or system-wide in the command ST: Set Document Parameters, the tab Font. 

Creating Tolerancing and Datum Symbols  

Enter the command FO: GD&T Symbols: 

Icon Ribbon 

 

Draw → GD&T Formlimits 

Keyboard Textual Menu 

<FO> Draw > GD&T Formlimits 

You will be provided the following options: 

 <P> Set GD&T formlimit parameters 

 <T> Copy properties from existing element 

/  <O> 
Create leader or datum with leader/Create leader or  

GD&T Formlimit with leader 

 <M> Select Linked dimension 

 <N> Select node 
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 <L> Set relation with line 

 <D> Set relation with Dimension 

/ /

 

<U> Orthogonal Fixing/Fixing to point/Angle Fixing 

 <Del> Delete Arrow 

 <F4> Edit GD&T Formlimits 

 <Esc> Exit command 

The /   option allows us to select which type of elements will be created – tolerance or datum. The 

state of the option changes cyclically when we press on it in the automenu or by means of <O> on the 

keyboard. By doing so, the cursor view and the dialog of command’s properties window will change. 

When we start the FO: Create tolerance of surface command for the first time, the datum 

creation mode is automatically set up. The image of the datum with extension appears on 

the screen next to the cursor. The dialog in the properties window contains the parameters 

of the datum. In the automenu of the <O> option the  icon is displayed that allows us 

to switch to the tolerance creation mode. 
 

When switching to the tolerance creation mode, the image of the tolerance with extension 

line appears next to the cursor. In the command’s properties window, the set of tolerance’s 

parameters is shown instead of datum’s parameters. The icon of the <O> option changes 

to . 

It is possible to switch between work modes of the command (creation of 

tolerance/creation of datum) at any stage of command’s work. 

 

When we subsequently invoke the FO: Create tolerance of surface command (inside the same work 

session with T-FLEX CAD), the system will by default prompt us to create that type of the element  

(datum/tolerance) which was created the last in the preceding call of the command. 

Creating tolerance 

Creating tolerance with extension line 

Specifying location of tolerance 

To create tolerance with extension, the user has to specify location of the tolerance on the drawing, 

shape of the extension, and also tolerance’s parameters. 

In general case the tolerance location is determined by sequential indication of two snapping points– 

snapping point of the extension’s arrow and snapping point of the tolerance itself. Dynamic image of the 

tolerance on the screen shows which snapping point the user must specify at the current moment. 
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Location of both points can be specified in absolute coordinates and also via snapping to the elements 

of the drawing. 

 
 

Dynamic view when the first snapping point is 

specified (snapping point of extension’s arrow) 

Dynamic view when the second snapping point is 

specified (snapping point of tolerance symbol) 

The first snapping point defines location of the extension’s arrow. Snapping in absolute coordinates is 

carried out by pressing . Snapping point is created at the current location of the cursor. 

Location of the second point can be defined relative to the first snapping point of the tolerance (with 

respect to the arrow) or in absolute coordinates. To select the mode, use the option: 

 <F> Attach to arrow 

When this option is enabled, location of the leader is specified with respect to the arrow of the leader 

note, when this option is disabled – in absolute coordinates. 

To snap the tolerance to drawing’s elements it is possible to use object snapping and the following 

options of the automenu: 

 <N> Select Node 

 <L> Set relation with line 

 <D> Set relation with dimension 

Object snapping can be used for snapping the tolerance symbol to such elements as construction line  

(line), graphic line (segment), 2D node, graphic lines that belong to 2D projections or 2D fragments, to 

points of confluence of graphic lines that belong to 2D projections or 2D fragments (a 2D node is 

created when selecting a point). It is also possible to read the value of the dimension for automatic 

calculation of the tolerance. With the approach of the cursor, the elements accessible for snapping will 

be highlighted. Both the extension line and the tolerance itself can be snapped to drawing’s elements. 

To snap to a 2D node or to a point of object snapping, it is sufficient to 

indicate the desired node/point and press . Location of the specified 

snapping point will be fixed. 

By default, the snapping of a tolerance is carried out to the node itself, 

without a shift. 
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To specify a shift, it is necessary after specifying location of all snapping 

points to return to editing of the desired point. After the point is selected it 

will start to follow the cursor. While doing so, the node will be highlighted 

and the rubber-band line will extend from it to the cursor. Pressing  defines 

the tolerance shift with respect to the selected node. In the properties 

window it is possible to specify the exact values of the shifts along the X-axis 

and Y-axis. 

 

            

To return the snapping point to the selected node, i.e., to cancel the shift, use the option: 

 <F> Fix to a node 

When snapping to the construction line or graphic line, it is necessary first to indicate the snapping line 

itself with the help of . The tolerance’s image will start moving after the cursor along the selected line. 

Second click of  will fix location of the extension’s arrow or of the tolerance itself (in case of snapping 

the tolerance itself to the graphic line). 

When snapping to the graphic line, the tolerance symbol can be situated beyond the graphic line bounds 

– on its continuation 

                            

In case of snapping the tolerance’s arrow to the line, it is possible to control location of the arrow with 

respect to the snapping line. To do so, the following option of the command’s automenu can be used: 

/ /  <U> Orthogonal Fixing/Fixing to point/Angle Fixing 

The  option allows us to keep the extension line of the tolerance perpendicular to the selected 

snapping line. If the tolerance was created with the use of the  option, then while being translated 

along the line it will be translated “as a whole” (without change in angles). The  option allows us to 

retain the angle of the extension line with respect to the selected snapping line. 

By default the “Tie perpendicularly” option is activated automatically. Note that in this case after selection 

of the snapping line it is sufficient to click  only once to specify location of the arrow and of the 

tolerance itself. That is, the second click of  immediately determines location of two snapping points of 

the tolerance. 
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To cancel snap to the line or node, use the option (available upon selection of the corresponding 

snapping point of the tolerance): 

 <K> Break (kill) relations 

To snap tolerance to a dimension, it is necessary to specify the desired dimension, with the help of object 

snapping or with the  option in the automenu. After selection of the dimension with the help of , 

the tolerance is tied to the dimension line. The tolerance’s image will move after the cursor along the 

dimension line. Additional click of  will fix the image of the tolerance in the desired location. The 

tolerance’s parameters in this case are calculated automatically on the basis of parameters of the 

dimension. Figures below show examples of snapping tolerance with extension to the dimension: 

     

There is also a possibility to link the tolerance’s parameters with the dimension’s value, without fixing 

location of the tolerance to the dimension itself. In the command’s automenu the following option is 

available: 

 <M> Select linked dimension 

The tolerance tied with the dimension with the help of the  option can be positioned on the drawing 

in an arbitrary way, however, its parameters retain connection with parameters of the indicated 

dimension. When changing the dimension’s value, the tolerance’s parameters will change automatically. 

To break connection between tolerance’s parameters and the dimension’s value, use the option: 

 <Ctrl+M> Break link with dimension 

To cancel the snap of the tolerance location to dimension, the  option is used (available when 

selecting the corresponding snapping point of the tolerance). 

 Markers for controlling the snap of tolerance’s elements. Creation of extension line with 

bends. 

After initial snapping of the tolerance, location of its snapping points can be modified. Also it is possible 

to change the shape of the extension line by creating any number of bends on it. To control the snap of 

tolerance’s points, and also for specifying bends on its extension line, the special markers are used. 

At the beginning of tolerance creation, there are only two markers – they designate 

its major snapping points and are highlighted with blue color. After location of 

both points has been specified, on the image of tolerance’s arrow one more marker 

appears, highlighted with green color. This is a point in which it is possible to create 

a bend. 
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To correct location of any snapping point, it is sufficient to move the cursor closer to the marker of the 

desired point (it will be highlighted with orange color) and select it with . The point will start moving 

after the cursor. In this way, for example, it is possible to specify the shift when snapping the tolerance’s 

point to the node. 

To create a bend, it is required to move the cursor closer to the green marker (it will also be highlighted 

with orange color) and select it with the help of . The arrow will split into two sectors, flexure point – 

arrow bend point – will start moving after the cursor. The second click of  will fix location of the arrow 

bend point. 

                     

After creation of the first bend point, new green markers will appear on the 

created arrow segments. If necessary, it is possible to create next bend on any 

of these segments. When arrow creation is finished, it is possible either to start 

creation of the next arrow or complete tolerance creation with the help of the 

 option. 

 

The following option controls the snap of each bend point with respect to the preceding point of the 

arrow: 

 <F> Attach to arrow 

When this option is enabled, location of the bend is specified with respect to the previous characteristic 

point of the arrow, when this option is disabled – in absolute coordinates.  

To remove the bend point, it is required to select it and use the following option: 

 <Del> Delete Node 

Creation of additional extension lines (arrows) for tolerance 

After location of the main arrow and the tolerance’s image itself has been specified, additional option 

appears in the automenu: 

 <Space> Add arrow 

When this option is invoked, the image of the new arrow-extension appears next to the cursor. 

Location of arrow of the additional extension line can also be specified in absolute coordinates or by 

using the snap to the lines and nodes of the drawing. With the help of markers it is possible to generate 

bends on the arrow. In the properties window the user can specify individual parameters of the arrow 

that are different from the specified parameters of the main arrow of the tolerance. 

The end of the additional arrow can be snapped to any characteristic point of the tolerance’s rectangle 

. (2D nodes can be created in those points if the option Create Nodes on GD&T Symbol is active, 
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as defined in the command Customize > Options…, the tab Snap). The characteristic point nearest to the 

pointer is automatically selected when picking the GD&T symbol. 

 

                   

You can reject creation of the new arrow by using the following option: 

 <Del> Remove arrow 

The list of created arrows for the tolerance is displayed in the properties window  

 

                        

The  and  buttons to the right of the arrow list can also be used for creation and deletion of the 

tolerance’s arrows. 

 Automatic completion of tolerance creation 

By default, after specifying location of two main tolerance’s points (location of the arrow and of the 

tolerance’s rectangle) the command remains in the mode of editing the created element. This allows us 

to add to the tolerance the required number of additional arrows, create bends on the arrows, specify 

and edit parameters at any moment of tolerance creation. After creation of the tolerance is finalized, its 

creation needs to be completed explicitly with the help of the  option or analogous button in the 

command’s properties window. 
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It is also possible to use another work algorithm. In the command’s 

properties window, in the “Options” section, there is a flag Create 

automatically. When this flag is enabled, the tolerance creation will 

automatically be completed right after specifying the snapping point of the 

tolerance’s rectangle. 

Note that in this case it is required either to specify parameters of the 

element being created before the snap of the tolerance’s rectangle, or to 

additionally enable the Show parameters dialog for each element flag. 

Then after specification of the tolerance’s location the tolerance’s 

parameters dialog will appear on the screen. This approach allows us to 

work the same way as in previous versions of T-FLEX CAD – first indicate 

location of the element on the drawing, then specify its parameters. 

 

Creating tolerance without extension line 
 To create a tolerance without extension line, it is sufficient, at any moment of tolerance creation, to 

delete the extension line with the help of the option:  

 <Del> Delete arrow 

The arrow will be removed, and the dynamic cursor will appear as a rectangle of the tolerance without 

extension line. It is more convenient to remove the arrow at the beginning of tolerance right away. If it is 

done at a later stage, for example, after snapping a tolerance, then it will be required to specify again 

location of the tolerance on the drawing. 

To remove arrows-extensions, it is also possible to use the command’s properties window. To remove an 

extension line, it is sufficient to select the arrow from the list in the “Arrows” section (by default, it is 

assumed that there is only one arrow) and press the  button. 

 Location of the tolerance without extension line can be specified by the same rules as in general case. 

The only difference is that for positioning of the tolerance without extension line it is required to indicate 

location of only one snapping point – snapping point of the tolerance’s rectangle itself. 

Symbol for the tolerance without extension line can be snapped to another tolerance already existing on 

the drawing with the help of the option: 

 <T> Select tolerance’s symbol 

After this option is invoked it is required to indicate the tolerance’s symbol. The newly created GD&T 

symbol will be positioned below the selected one. If the GD&T symbol type is the same as the other one, 

then the type notation fields of both GD&T symbols are merged. As the pointer approaches 

characteristic points on the GD&T symbol box, object snapping activates, allowing creating a 2D node at 

such a point and making an attachment to it. In this way, one can attach the new GD&T symbol to a 

characteristic point of another GD&T symbol . In this case, a 2D node will be created on the 
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selected GD&T symbol. Respectively, you can select an attachment point on the GD&T symbol being 

created (see “GD&T Symbol parameters”). 

      

Note that completion of the creation of tolerance without extension line will occur automatically right 

after specifying the snapping point. Pressing  is not required in this case. 

 Tolerance’s parameters 
The dialog in the command’s properties window contains all main parameters of the tolerance. To make 

the work with this dialog more convenient the dialog is divided into several sections.. 

«Coordinates» Section 

The first section Coordinates contains the fields for accurate specification 

of the coordinates of snapping points of the tolerance. The current 

coordinates are dynamically determined when the cursor moves inside the 

drawing’s window. 

Depending on the tolerance snapping method various types of coordinates 

can be displayed in this section. For example, if snapping of both points is 

free, the absolute coordinates of both snapping points are shown in the 

properties window. When snapping the rectangle of tolerance/datum to 

the extension’s arrow, for the second point the shifts dx and dy with 

respect to the first point will be specified, etc. 
 

«Tolerance» Section» 

The Tolerance section contains the main parameters of the tolerance: 

From the drop down list select the desired type of the tolerance: 

 

Specification. This parameter determines how the value of the tolerance will be obtained. You can 

enter it manually or it can automatically be calculated depending on the dimension’s value and precision. 

Expression. Can be one of the following choices: 

 - not defined; 

R - if a circular or cylindrical GD&T symbol is defined by the radius; 
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D - if defined by the diameter; 

Sphere R - if a spherical GD&T symbol is defined by the radius; 

Sphere D - if a spherical GD&T symbol is defined by the diameter; 

T 

- if the diametrical expression is used for GD&T symbol of Symmetry, Axis 

crossing, Profile form and Surface form, as well as the positional GD&T 

symbol (in the case when the positional GD&T symbol is bounded by two 

parallel lines or planes); 

T/2 - if the radial expression is used for the same GD&T symbols as above. 

 

Dimension. Value of the dimension upon which the value of the tolerance depends. If, when setting the 

tolerance, you tied it with the dimension, then the nominal value of the dimension will automatically be 

inserted into the parameter’s field. The value of the dimension affects the tolerance’s value in automatic 

calculation.  

Precision. Takes integer values in the range from 3 to 16, inclusive. This parameter makes sense 

only when using the automatic tolerance calculation. 

Value. This is the value of the tolerance, either input manually or calculated automatically. A 

predefined list of values is supplied for the manual parameter definition. 

«Datum» Section 

Datum 1, Datum 2 and Datum 3. These are the names of datums 

that can be used in the GD&T symbol, defined as textual strings. 

Text variables can be used as datum names just like in the case of 

any other text string parameters. 

 

«Arrows», «Arrow», «Text on arrow», «Symbol on Arrow» Sections  

Next two sections of the properties window – “Arrows” and “Arrow” – should be considered together. 

Together they allow us to specify parameters of the tolerance’s extension lines. 

The Arrows section contains the list of all created arrows-extensions of the tolerance. The buttons to the 

right of the list allow us to create/remove the arrows. By selecting one of the arrows in the list with the 

help of , in the next sections of the properties window it is possible to specify parameters of the given 

arrow. 
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The Arrow section contains the following parameters of the selected arrow: 

Drop down list for selection of the arrow type at the beginning of the extension line. This list 

coincides with the list of arrow ends used in the commands for construction of dimensions, 

graphic lines and leader notes. 

Field for specifying the arrow tip size at the beginning of the extension line. If the value is 

displayed in square brackets, it will be calculated based on the given parameter Arrow (end) 

size in the command ST: Set document parameters (the Lineвs tab). 

Line thickness. Specifies thickness of arrow lines. If the value is displayed in square brackets, it will 

be evaluated based on the given parameter Other lines in the command ST: Set Document 

Parameters (the Lines tab). 

Clear under arrow. When this parameter is enabled, the drawing’s image under the tolerance’s arrow is 

removed. 

Clear under line. This parameter allows us to remove the drawing’s image under the tolerance’s 

arrow line. 

Draw extension line. This parameter controls drawing of the extension line for extension of the 

tolerance, from the snapping point up to the arrow. 

 

Clear under extension line. When this parameter is enabled, the drawing’s image under the 

extension line is removed. 

«View» section  

Text after. This parameter allows entering an arbitrary text string that you want to be displayed after the 

tolerance value. You can enter, for instance, conditions for dependencies, unevenness, etc. Use the key 

combination <Alt+F9> for this purpose. 

 

Show dimension’s value. It can take the values “No” and “Yes”. If this 

parameter has the value “Yes”, then the dimension’s value will be 

placed after the tolerance’s value. If necessary, in this line use the 

variables by embracing them into curly brackets. 

 0.01/10 

Extension line. This parameter is active only upon creation of the 

tolerance without extension line. It controls the drawing of the 

extension line from the snapping node/line up to the tolerance. 
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«Placement» section 

 Placement. Defines the box positioning with respect to the attachment node. Eight different 

positioning options are provided in the drop-down menu. 

 Rotate 90°. Can be set or unset. If set, the GD&T symbol will be rotated by 90 degrees. 

 

«Options» section 

This section contains the following tolerance’s parameters: 

Show parameters dialog for each element. If this parameter is 

enabled, then in the tolerance creation command after specifying 

location of the tolerance on the drawing, the parameters dialog 

window will automatically appear on the screen (the  option). 

 

This mode allows us to work in the same way as in the previous versions of T-FLEX CAD – first 

specify the tolerance location on the drawing, and then specify the tolerance’s parameter. 

Create automatically. When this parameter is enabled, the tolerance creation will automatically be 

completed right after specification of the snapping point of the tolerance’s rectangle (without pressing 

). This parameter is active only if the tolerance with extension line is created. 

Creating Datum 

To create a leader or a datum with a leader, use the automenu icon .The 

creation and editing techniques of these elements are similar to creating and 

editing of GD&T symbol with leaders. The datum leader has a different 

ending tip (see the diagram on the right hand side).  

Similar to the tolerance, at any moment of datum creation it is possible to specify the datum’s 

parameters in the command’s properties window. The dialog in the command’s properties window 

contains all main parameters of the datum. To make the work more convenient, the dialog is divided into 

several sections. Some of the sections – Coordinates, Arrows, Arrow, Options entirely repeat analogous 

sections of the tolerance’s parameters dialog. 
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The Datum section, used for datum creation, contains different, shorter set of 

parameters compared to the identically-named section in the tolerance’s 

parameters:  

Datum. Datum name parameter (text string). For the datum’s name it is 

possible to use the variable. 

Location. Defines location of the frame with respect to the snapping node. 

There are eight different options which are selected from the drop down list. 
 

Extension line. This parameter is active only upon creation of the datum without extension line. It 

controls the drawing of the extension line from the snapping node/line up to the datum. 

Editing GD&T/Datum’s Symbols  

To edit GD&T/ datum symbol parameters, position, attachment or to set or break the relation between a 

GD&T/ datum symbol and a drawing dimension, use the command “EFO: Edit GD&T Symbols”: 

Keyboard Textual Menu Icon 

<EFO> 
“Edit > Draw > GD&T 

Formlimits”  

Upon calling the command, the following icons are available in the automenu: 

 <*> Select All Elements 

 <Esc> Exit command 

You can select a GD&T/ datum symbol by pointing it with the mouse and clicking , or by using multiple 

selections. As in the case of other drawing elements, the multiple selections are done by the option . 

Using  together with the pressed key <Shift> adds an element to the list of selected ones, while with 

the key <Ctrl> - removes from the list of selected elements. 

For multiple selections, you can use the options: 

 <P> Set GD&T Formlimit Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Del> Remove selected Element(s) 

 <Esc> Cancel selection 

When selecting one element, the following icons become available in the automenu: 

 <P> Set GD&T Formlimit Parameters 

 <Alt+P> Copy properties from the Existing Element 

 <M> Select Linked dimension 
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 <Ctrl+M> 
Break tie with dimension (only upon selection of the 

element tied with the dimension) 

 <Space> Add arrow 

 <Del> Delete Arrow 

 <I> Select Other Element 

 <Del> Remove selected Element(s) 

 <Esc> Cancel selection 

To change location and snapping of the tolerance/datum, it is necessary, after element selection, indicate 

the marker of the desired snapping point with the help of . The selected point will start dynamically 

follow the cursor (according to the snapping method selected for the point). At the same time the 

additional options will appear in the automenu:  

 <T> Link to node  

 <K> Break (kill) relations  

 <F> 
Snap to arrow (available only upon selection of the 

second snapping point of the note) 

/ /

 

<U> Orthogonal Fixing/Fixing to point/Angle Fixing 

 <L> Set relation with Line 

 <N> Select Node 

 <D> Set relation with Dimension 

Pressing  will fix the new location of the snapping point of the tolerance. It is possible to change 

location of any bend point exactly in the same way. It is also possible to cancel snapping of the point 

with the help of the  option, snap tolerance to a node or line, specify/cancel relation with dimension. 

To remove one of the arrow-extensions of the tolerance, it is possible to use the  option. If the 

tolerance/datum being edited has only one extension, then this option is available in the automenu right 

after selection of the element being edited. In case if the tolerance/datum with several extension lines, 

the  option will become available after selection of the desired extension line. The extension line can 

be selected in the command’s properties window (the “Arrows” section) or, for example, by specifying its 

starting point in the drawing’s window. To remove the extension line, it is also possible to use the  

button next to the list of arrow-extensions of the tolerance/datum in the command’s properties window. 
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The option  allows modifying the parameters of 

the selected GD&T symbol. Modifying the 

parameters in the case of a single selected element 

is similar to original defining of the GD&T symbol 

parameters. 

In the case of multiple selections, calling the option 

<P> brings up the dialog box “GD&T Formlimit 

Parameters”., All parameters of the selected 

elements are subject to editing.  

The option <D> allows setting the relation between 

the selected GD&T symbol and the desired drawing 

dimension. To delete the selected GD&T symbol, 

press the key <Del>. To select and modify 

parameters of a group of GD&T symbols, use the 

same techniques as for other elements. 

 

 
 



T-FLEX CAD Brief Introductory Course 

556 

ROUGHNESS SYMBOLS 

Roughness notation symbols creation is similar in its nature to creating leader notes and tolerances. First, 

you define the position and attachment of the roughness, and then specify its parameters. The size of a 

roughness element is related to the font size defined either in the parameters of the specific element, or 

in the command ST: Set Document Parameters, the tab Font. 

Creating Roughness Notation 

To apply a roughness notation, you need to enter the command RO: Create Roughness Symbol: 

Icon Ribbon 

 

Draw → Title Block → Roughness Symbol 

Keyboard Textual Menu 

<RO> Draw > Roughness Symbol 

The following options will become available to you in the command: 

 <Enter> Place a roughness symbol at the pointer position. 

 <Alt+P> Copy Properties from Existing Element 

 <P> Set Roughness Symbol Parameters 

 <N> Set relation with Node 

 <L> Set relation with Line 

 <C> Set relation with Circle 

 <D> Set relation with Dimension 

 <R> Set Relation with Leader Note 

 <E> Set relation with Ellipse 

 <S> Set relation with Spline 

 <T> Link to Node 

 <Space> Change Roughness Attach type 

 <Z> 
Change leader line jog orientation (available only 

with selection of the previous option) 

 <K> 
Break (kill) relations (available upon selecting 

attachment element) 
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 <F4> Execute Edit Roughness Symbol command 

 <Esc>  Exit command 

The roughness can be instantly placed in the absolute coordinates at the pointer position by clicking . 

An exact value of coordinates can be defined in the command's properties window (the section 

“Coordinates”). 

The way of attaching the created roughness is determined by the status of the option . This option 

contains a drop down list with the following choices: 

 <Alt+N> Roughness without leader jog 

 <Alt+L> Roughness with leader jog 

 <Alt+T>  Attach to the sign point 

To attach a roughness symbol to a construction or graphic line (ellipse, spline, path or function), use the 

respective option <L> (<E>, <S>). The graphic pointer must be over the desired line when using the 

option. The intended construction entity must have at least one node on it. In this way, the roughness 

being created is attached to the entity and the nearest node on this construction entity. A leader line will 

be created by default from the node to the roughness symbol (you can cancel the leader line creation in 

the command's properties window). 

L

                 

With the object snapping engaged, to select an attachment element you just need to move the pointer 

over the desired element. As the element pre-highlights and the pointer changes its shape, indicating 

snapping to the element, click . In complicated configurations, you can use the element selection 

options for precise element selection. 

Upon selecting the construction or graphic entity (ellipse, spline, path or function), a roughness symbol 

starts rubberbanding with the pointer. To complete the creation, point the mouse to the desired position 

of the roughness symbol (the distance from the node to which the roughness being created is attached) 

and click . A precise position of the roughness on a construction or graphic line can be defined in the 

command's properties window. 

For attaching to a node, select the desired node by pressing the key <N>. 

N

              

When selecting a node, the roughness can be created in two modes: with an offset from the node and 

without an offset. By default, the mode of snapping to the node without an offset is used. This is 
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indicated by the enabled option  in the command automenu. In this case, you just need to point at a 

node and click . To set the mode of snapping to a node with an offset, disable the option . In this 

case, after selecting the snap node you will need to specify an offset relative to the node for the 

roughness. This can be done by  in the drawing window or by entering the exact offset value in the 

command's properties window. 

A roughness symbol can be attached to a circle (the option <C>). 

С

   

The dimension is selected by the key <D>. 

D

           

A roughness can also be attached to graphic lines. As the pointer approaches 

a graphic line, the entity is pre-highlighted due to the object snapping. If the 

roughness symbol is placed beyond the graphic line limits, then by default a 

leader is created along the graphic line extension up to the roughness symbol 

(the leader creation can be disabled in the roughness parameters).   

To undo element selection (line, node, circle or dimension), and, thus, to cancel the attachment relation, 

use the option .  

To cancel the last action (for example, to cancel the leader start attachment), use the <Esc> key or right 

click . 

Roughness parameters are defined in the command's properties window prior to specifying the 

roughness position on the drawing. Besides that, you can enter the exact position of the roughness snap 

point in the properties window. Option  will take parameters of roughness symbol from already 

existing roughness element. See chapter “Dimensions” for more details on this option. 
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Roughness Parameters 

The first section – “Coordinates” – provides the fields to enter the exact coordinates of the roughness 

snap point. The current coordinates are dynamically tracked as the cursor moves in the drawing window. 

The other sections of the properties window – Height Parameter, Step Parameter, Relative Basic Length 

– may contain various sets of parameters, depending on the Type field value selections in each section: 

Height Parameter. The possible parameter combinations are – Basic 

Length and: 

Ra,         Ra, max, min          Ra, min         Ra, nom 

Rz,         Rz, max, min          Rz, min         Rz, nom 

Rmax,    Rmax, max, min     Rmax, min    Rmax, nom 

Step Parameter. The possible parameter combinations are – Basic 

Length and: 

S,           S, max, min             S, min           S, nom 

Sm,        Sm, max, min          Sm, min        Sm, nom 

Relative Basic Length. The possible parameter combinations are: 

tp,          tp, max, min           tp, min           tp, nom 

Note that the set of values that you can select can be either in the metric or 

in the inch notation. This is controlled by the parameter Units in the 

command ST: Set document parameters.   

Remember that you can use variables (surrounded in braces) in any parameter field. 

Besides, each parameter combo box provides the pre-defined list of values. The user can customize this 

list, modifying and appending it as desired. To edit the list, right click  over the dialog combo box, and 

select the command Edit Value List in the context menu. For detailed information, refer to the chapter 

“Main Concepts of System Operation”, the topic “Context menu for dialog input boxes”. 

In the “Style” section there are the following roughness parameters: 

Symbol. The type of the roughness symbol notation can be selected from the set (see 

the diagram on the right). 

Direction. Is defined by a symbol of icon or special font, invoked by the key 

combination <Alt><F9>. 

Before Symbol, After Symbol. These parameters allow defining additional strings of 

text to be displayed before and after the roughness symbol, respectively. 

Instruction. This parameter defines the string that will be put above the jog. 
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Unset Roughness Symbol. Creates the notation of unset roughness 

. To define the symbol inside the parentheses, set the flag 

Symbol in parentheses. 

Leader Line. This parameter sets the mode of creating the leader line 

when attaching the roughness to a line or a graphic entity. 

Old Drawing Style. This flag is reserved for switching between old 

and new roughness notation standards when applicable. 

In the Arrow section you can define the type and size of the leader arrow. 

The parameters represented by textual strings allow use of variables (the 

variables must be surrounded in braces). 

The section “Option” contains only one auxiliary parameter– Show Dialog for 

each Created Element. If this parameter is enabled, then the roughness 

parameters dialog will automatically appear after defining the roughness 

position in the roughness creation command (the option ). 
 

This mode allows working in the same way as in previous versions of T-FLEX CAD – by specifying the 

roughness position in the drawing first, and then defining its parameters. 

Various samples of the roughness notation symbol are shown below: 

 

Roughness Parameters Dialog 
You can also define roughness parameters using the parameters dialog accessible by the automenu 

option: 

 <P> Set Roughness Symbol Parameters 

The parameters available on the tabs of that dialog duplicate the parameters in the properties window. 

Besides that, the parameters dialog contains several additional parameters. First of all, those are the 

system-wide parameters: level, layer, priority, color. There is also an additional tab in the dialog that 

contains font parameters. There you can define the required font parameters to display the roughness 

text. 

Defining Default Parameters 
The default parameters that will be applied to all newly created roughness symbols can be defined in 

various ways. 
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First of all, those can be defined using the parameters dialog (the option ). To do that, call this dialog 

before creating a roughness. The parameters defined in it will be copied over to the parameters of each 

newly created roughness symbol. 

Besides that, you can save parameters defined for any roughness being created (or edited) as the default, 

by clicking the button  in the command's properties window. 

Editing Roughness Symbol 

The command ERO: Edit Roughness Symbol allows changing the attachment, position and the 

parameter values of a roughness symbol (alternatively, use the option <F4> in the command RO: Create 

Roughness Symbol): 

Keyboard Textual Menu Icon 

<ER> 
“Edit > Draw > Roughness 

Symbol”  

Upon calling the command, the following icons are available in the automenu: 

 <*> Select All Elements 

 <Esc> Exit command 

A roughness symbol notation can be selected by pointing at with the mouse and clicking , or by 

multiple selections. As in the case of other drawing elements, multiple selections are done by the option 

. Using  together with the depressed key <Shift> adds an element to the list of selected, while with 

the key <Ctrl> - excludes from the selected list. 

For multiple selections, you can use the options: 

 <P> Set Roughness Symbol Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

When selecting a single element, the properties window displays parameters of the selected element. 

The following icons become available in the automenu: 

 <P> Set Roughness Symbol Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <K> 

Break (kill) relations (available when the selected 

roughness is attached to a node, construction or 

graphic entity) 
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 <H> 
Change leader/roughness position (available when 

selecting a roughness symbol with a leader) 

 <Z> 
Change leader line jog orientation (available only 

when selecting a roughness symbol with a leader) 

 <T> Link to Node 

 <Space> Change Roughness Attach type 

 <N> Set relation with Node* 

 <L> Set relation with Line* 

 <C> Set relation with Circle* 

 <D> Set relation with Dimension 

 <R> Set Relation with Leader Note 

 <E> Set relation with Ellipse* 

 <S> Set relation with Spline* 

 <I> Select Other Element 

 <Del> Delete selected Element(s) 

 <Esc>  Cancel selection 

* The respective attachment element selection option is available if the selected roughness symbol was 

defined in the absolute coordinates, or if the attachment of this element was canceled by the option .  

 

Once selected, the roughness symbol starts rubberbanding on the screen, following the pointer. The 

option  allows selecting which point of the roughness notation to rubberband - the arrow tip or the 

leader jog. Clicking  fixes the roughness symbol in the new position. 

To change the attachment type, first you need to cancel the original attachment by using the option  

(<K>). After that, the options will be provided in the automenu for selecting new attachment elements: 

<N>, <L>, <C>, <S>, <D>. If the position of the selected roughness symbol was defined in the absolute 

coordinates, then you do not need to use the first option <K>. 

Node, that roughnesses on lines, dimensions and circles can assume two opposite positions. 
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The option <P> allows modifying parameters of the several selected 

roughness symbols. Modifying parameters in the case of selecting a 

single element is similar to defining the roughness parameters. 

However, if you selected multiple roughnesses for editing and run 

Edit command, then you need to determine first, which parameters 

to modify, in the “Change parameters” dialog box. By default, all 

parameters of the selected elements are subject to editing. Upon 

selecting parameters for editing and pressing [OK], you will access 

the standard dialog box for defining roughness parameters. 

Option  takes parameters of roughness symbol from existing 

roughness symbol. 

To delete a roughness symbol, select it, and then press the <Del> 

key.  
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SECTION VIEW 

The section view, arrow view and local area view are necessary detailing elements of a drawing. T-FLEX 

CAD system provides full range of functionalities for satisfying this requirement. 

Creating Section View 

The command for section view creation, SE: Create Section can be called as follows: 

Icon Ribbon 

 Draw → Title Block → Section 

Keyboard Textual Menu 

<SE> Draw > Section 

Upon calling the command, you will get access to the following set of options: 

 <P> Set Section Lines Parameters 

 <Alt+P> Copy Properties from Existing Element 

 <S> Create two point Section 

 <D> Create multiple point section 

 <R> Create Arrow View 

 <V> Create View 

 <N> Select Attachment Node   

 <Z> Change View Direction 

 <F4> Execute Edit Command 

 <Esc>  Exit command 

Next, select the type of the section view to create a simple (two-point) section, a multiple-point section, 

an arrow view or a view notation. 

Two-Point Section 
Two-point section creation begins with selecting two attachment points. Those can be defined either in 

the absolute coordinates or snapped to 2D nodes. Move the pointer to the desired position and click . 

As the pointer approaches 2D nodes, the object snapping activates, highlighting the nodes. Assign the 

second attachment point similarly. The preview of the element being created updates dynamically with 

your manipulations. Next (refer to the third diagram from the left), you need to define the offset of the 
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view notation arrows from the attachment points. Do this by positioning the pointer appropriately. To fix 

the position, click . The result is shown on the right-most diagram. 

                        

 

 

Multiple-Point Section 
The multiple-point section creation is similar to creating a two-point section. The difference is in the 

number of the attachment points to select, which is unlimited in the case of a multiple-point section. To 

call the command for creating a multiple-point section, press the automenu icon  or type the key 

<D>. The sequence of actions for creating a multiple-point section is shown on the following diagrams. 

 

    

Upon entering the desired number of points, you need to press the automenu icon  or the key 

<End>. 

 

End

   

 

Instead of specifying the individual points of the section, it is possible to select an existing 2D path with 

the help of the option: 

 <T> Select 2D path 
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The created section will repeat the form of the selected path. 

 

The view direction can be flipped to the opposite at any time by pressing the automenu icon  or the 

key <Z>. 

After defining all fixing points of section, you must specify the offset of arrow regarding fixing points with 

. The offset definition may be omitted by pressing  in automenu or in the properties window. 

Section Properties 
Section parameters can be set at any time prior to the completion of element creation in the properties 

window of the command. 

The first sub-dialog Coordinates contains fields for entering precise coordinates of section fixing points. 

Current coordinates are dynamically traced on moving the cursor in the drawing window. 

"General" sub-dialog allows you to set all the basic parameters of section. These settings include: 

The group Text: 

Text. The text to be displayed next to the arrows. This entry is filled 

automatically with a subsequent letter of the alphabet, beginning with 

the letter “A”. If the number of notations exceeds the number of letters 

in the alphabet, the multiple-letter combinations are used: AA, AB, AC, 

…, AAAAAAA, etc.  

If necessary, you can manually type a text string of an arbitrary 

length in this input box. 

Additional. The input boxes of this parameter allow entering different 

text for each arrow. The specified text strings will be displayed next to 

the text defined by the previous parameter. 
 

The group Text Offset: 

From arrow. Defines the text offset from the arrow in the outward direction along the leader, in 

the model measurement units. 
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Along arrow. The text offset from the leader. 

Standard. Defines the view notation standard. You can choose from the three options: the ISO standard, 

the ANSI standard and Default. 

In the case of using the last option, the standard is defined by the Standard/Dimension parameter 

setting in the command ST: Set Document Parameters, the tab Dimensions. The ANSI standard permits 

displaying the dashed line (the parameter Show Dashed Line). 

DIN / ISO

A A

B

B

  

ANSI

A A

B

B  

Dimensions 

The group Lines: 

Length. Defines the length of the leader. 

Line Width. Defines the thickness of the leader. In the 

case of using the Default setting, this parameter 

value is calculated based on the Line thickness/Thick 

lines parameter setting in the command ST: Set 

Document Parameters (the tab Lines). 

Offset on Start. The offset of the leader from the first 

node of the view notation. 

Offset on End. The offset of the leader from the last 

node of the view notation. 

Dash Length. Sets the length of the medium dashed 

strokes (displayable only in ANSI standard). 

The group Arrows: 

Length. Sets the arrow length of the view direction 

notation. 

 

Size. Sets the size of the view direction arrow. In the case of using the Default setting, this 

parameter value is calculated based on the Arrow (end) size parameter setting in the command 

ST: Set Document Parameters (the tab “Lines”). 

Line Width. Sets the line thickness of the view direction arrow. In the case of using the Default 

setting, this parameter value is calculated based on the Thick lines parameter setting in the 

command ST: Set Document Parameters (the tab Lines). 

Type. Sets the type of the view direction arrow. 
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The parameters on this tab are defined in the measurement units set in the drawing parameters (the 

command ST: Set Document Parameters). 

Section parameters can be also set in the section Parameters dialog box, opened by option . 

In this dialog, in addition to the above section properties, you can specify system-wide settings: 

Color, Level, Priority, Layer and [Font]. They are entered the same way as in other elements. 

You should note that the size of the view designation text is associated with the font size that is 

specified in the parameters of a particular element, or in command ST: Set Document Parameters 

on the Font tab. 

Copying Parameters from Existing Notations of Section 
The values of parameters of the notation of the section being created can be quickly copied from an 

already existing notation of the section. To do so, it is necessary to use the option: 

 <Alt+P> Copy Properties from Existing Element 

This option is available in the automenu of the command before creation of the view notation or  

during the process of creation. 

After this option is invoked, it is sufficient to indicate the notation of the section whose parameters' 

values must be transferred to the element being created. 

To assign the copied values of the parameters to all new notations of the section, it is required to 

activate the additional option before selection of the original element: 

 <S> Set Properties as Default 

When the option is activated, the copied parameters will be saved as default parameters. 

This option simplifies creation of the notations of a section with identical parameters. However, it 

does not allow us to copy individual parameters or parameters from an object of another type. In 

such cases it is more convenient to use the general mechanism of editing parameters of elements 

in the properties window. 

Arrow View 
An arrow view can be attached to a node, defined by assigning the view direction 

vector by two nodes, or positioned in the absolute coordinates without 

attachment to any drawing objects. To create an arrow view, press the automenu 

icon  or the key <R>. Upon calling the command, the arrow view notation 

starts rubberbanding on the screen, and additional options appear in the 

automenu: 

 

 <B> Set First Attachment Point 

 <E> Set Second Attachment Point 

 <Z> Change View Direction 
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 <H> Change Text Placement 

For attachment in the absolute coordinates, you can simply click . The view notation will then fix at the 

current pointer position. 

For attachment to a 2D node, you need to use the option <N> (the automenu icon ) or rely on the 

object snapping. As the pointer approaches a 2D node or a line intersection, the respective entities are 

highlighted. You can then click . 

By default, the arrow is positioned horizontally and directed from left to right. The arrow direction can be 

quickly rotated by the angle multiple of 90 by pressing the automenu icon  or the key <Z>.  

For attachment to two nodes, subsequently use the automenu options: 

 <B> Set First Attachment Point 

 <E> Set Second Attachment Point 

and consequently select two 2D nodes. 

You can change the text position with respect to the arrow line at any time by using the option  or 

the key <H>.  

Coordinates. The input boxes for specifying the exact X and Y 

coordinates when positioning the view notation in the 

absolute coordinates. 

The group Text: 

Text. The text entered in this box will be displayed next to the 

arrow. By default, this entry is filled with letters in the 

alphabetical order, starting with the letter “A”. You can 

manually input a text string of arbitrary length. 

Offset. Sets the text offset from the arrow. 

Along Arrow. Sets text offset along arrow. 

The group Arrow”: 

Length. Sets the length of the view direction arrow.   

Size. Sets the size of the view direction arrow. In the case of using the Default setting, this 

parameter value is calculated based on the Arrow (end) size parameter setting in the command 

ST: Set document parameters (the tab Lines). 

Line Width. Sets the line thickness of the view direction arrow. In the case of using the Default 

setting, this parameter value is calculated based on the Thick lines parameter setting in the 

command ST: Set document parameters (the tab Lines). 

Type. Defines the type of the view direction arrow.  

Angle. Angle of arrow rotation that will define the view direction. 
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The group Placement: 

Provides the respective fields for entering X and Y coordinate values defining the element 

position. You can also specify the arrow rotation angle that will determine the view direction. 

Color, Level, Priority, Layer and [Font] are defined in the same way as in other T-FLEX elements. 

The  option allows us to copy parameters from another already existing arrow view. 

View Notation 

To create a view notation, press the automenu icon  or the key <V>.  

A view notation starts rubberbanding on the screen. Move the pointer to the desired position on the 

drawing and click  to fix the element. In this way, the view notation will be positioned in the absolute 

coordinates that can be entered exactly in the “View Properties” dialog box (see below). 

For attachment to a 2D node, you need to use the option <N> (the automenu icon ) or rely on the 

object snapping. As the pointer approaches a 2D node or a line intersection, the respective entities are 

highlighted. You can then click . 

The default text is automatically created next to the leader of the view notation. The first such created 

element is labeled “A-A”, the subsequent ones – the respective letters in the alphabetical order, as “B-B”, 

etc. 

You can copy the text from an existing section or arrow view. To do this, press the automenu icon  or 

the key <C>. Next, select by the mouse the desired arrow view notation or section. 

A A

B

B

C   

D

E F

A -A

B - B

E

C   

View D tag

Scale 1:2

 

Coordinates. The input boxes for specifying the exact X and Y coordinates when positioning the view 

notation in the absolute coordinates. 

The group Style:  

Text over line. The text string is positioned above the leader. You can manually input a string of an 

arbitrary length. 
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Offset. The distance from the leader to the text above it. 

Text under line. The text string is positioned below the 

leader. You can manually input a string of an arbitrary length. 

Not displayed by default. 

Offset. The distance from the leader to the text below it. 

Underline Text. This flag will underline text of the view 

notation. 

Line Width. Sets the width of the dividing leader line.  

The  option allows us to copy parameters with 

another already existing view notation. 

 

Editing View Notation 

The attachment, notation position and parameter values of a view can be modified by the command 

ESE: Edit Section (the option <F4> in the command SE: Create Section View ): 

Keyboard Textual Menu Icon 

<ESE> Edit > Draw > Section  

Upon calling the command, the following icons become available in the automenu: 

 <*> Select All Elements 

 <Esc> Exit command 

A view can be selected by pointing the mouse to it and clicking , or by multiple selections. As in the 

case of other drawing elements, multiple selections are done by the option . Using  while holding 

down the key <Shift> adds an element to the list of selected, while with the key <Ctrl> - excludes from 

the list of selected.   

In the case of multiple selections, you can use the options: 

 <P> 
Properties (accessible only when same-type elements 

are selected) 

 <Del> Delete selected element(s) 

When a single element is selected, the set of the available options depends on the type of this element. 
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AXES CREATION 

This command is provided for automatic creation of axes (centerlines) for graphic entities. The axes 

created in this way maintain associative relationship with their reference elements and adjust to 

modifications of those elements. 

Axes Creation 

Axes creation is done with the АХ: Create Axis command. The command can be invoked in one of the 

following ways: 

Icon Ribbon 

 

Draw → Draw → Axis 

Keyboard Textual Menu 

<АХ> Draw > Axis 

Upon calling the command, the dash-dotted line type is set automatically, as it is used for axes. You can 

modify the line type either in the system toolbar  or among the graphic 

line parameters. The line parameters dialog box is invoked with the  option. The dialog settings affect 

the type of the line used by this command in the current drawing. 

To create an axis, you need to select a graphic line using one of the following options: 

 <1> Create Axis of two Graphics lines 
 

This option allows us to create an axis line between two graphic 

lines. You can select two straight segments or two arcs of equal 

radii as the source graphic lines. The selection is done with . The 

selected elements are highlighted.          

If the object snapping is engaged in the current session, the axis being created appears as soon as you 

select the second segment or arc. It the object snapping is turned off, the axis is displayed only upon 

confirming the selection. Confirm the selection of elements for creating the axis by the  option. 

The axis is bounded by the projections of the end points of the selected graphic lines on the axis line. 

It is possible to extend the axis on one or both sides. 

To do this, you need to select additionally one or 

two graphic lines. The axis will then be extended up 

to the projection point on the axis of the selected 

graphic line end point. If two graphic lines are 
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selected as the additional lines, the axis creation is completed automatically, without the confirmation by 

the option . 

 <2> Create two Axes of Circle or Ellipse 

This option allows us to create simultaneously two axes for a circle, ellipse or an arc. To do this, just select 

the graphic entity - the circle, ellipse or arc.  

The selected elements are highlighted, and the pair of axes is 

instantly displayed (if the object snapping is turned on). The 

limits of the axes are defined by the radii of the selected 

elements. The axes are created automatically upon the 

selection, without the confirmation.        
 

 <3> Create Horizontal Axis 

 <4> Create Vertical Axis 

These options us to create, respectively, the horizontal and vertical axes for circles and circular arcs. In 

case of ellipses or elliptical arcs, the major axis is created instead of the horizontal one, and the minor – 

instead of the vertical. 

     or       

When using the following options, it is first required to specify a 2D node and then the graphic line of 

the circle, ellipse or arc: 

 <5> Axes make an angle with the node 

 <6> Radial axis through the node 

 <7> Tangent axis along the node 

 <8> Axis along a circle and radial axis 
 

The  option allows us to draw two perpendicular lines of the axis of the circle (the arc of the circle, 

ellipse), one of which goes through the given center.  

The  option allows us to create the radial (straight) axis of the circle (arc of the circle, ellipse) passing 

through the given center. 
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Axes make an angle with the node Radial axis through the node 

The  option creates the tangent axis of the circle (arc of the circle, ellipse), i.e., the straight axis 

perpendicular to the radius that goes through the given center. 

The  option allows us to draw the axis on a whole circle and the radial (straight) axis, going through 

the given center, for the circle or ellipse. 

  

Tangent axis along the node Axis along a circle and radial axis 

To create axes with the use of the , ,  and  options, it is first required to specify the center 

node and then the graphic line of the circle, ellipse or arc. After the selection, the axial lines are created 

automatically without the need to confirm. 

                  

It is important to note that after creation of the axes, the command will remain in the mode of axes 

creation with the same center node. To create one more axis (or a couple of axes), it is sufficient to select 

the next graphic line of the circle, ellipse or arc. To return to the stage of selection of the center node, it 

is sufficient to press  or use the  option in the automenu of the command.   

One more option of the automenu of the command allows us to create inclined axes through the center 

for two circles (ellipses) with an arc of the size of these circles (ellipses): 

  <9> Axis along arc and radial axis 

To create the axes with the help of this option, it is first required to select the center node. Then it is 

required to specify two graphic lines – of the circle or ellipse. When the cursor of the mouse is over the 

second graphic line, the view of the future axis along the arc will appear on the screen in a dynamic 

mode. At this moment the direction of the arc can be modified with the help of the option: 
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 <Tab> Change direction of arc 

To finish creation of axes, press  in the window of properties or in the automenu of the command. 

  

The second graphic line does not have to be specified; instead a 2D node can be selected. In this case  is 

created an inclined axis with an arc of the size of one of the circles or an inclined axis with an arc up to 

the node. 

  

Parameters of Axes 

Axes parameters are the standard graphic line parameters that can be defined at any time by calling the 

parameters dialog box with the option: 

 <P> Set Graphic line parameters 

The detailed description of graphic line parameters is provided in the “Graphic Lines” chapter. 

Editing Axes 

Since the created axes maintain associative relationship with their reference elements, their modifications 

occur together with the reference elements. Axes can be deleted, or their parameters can be changed, or 

their name can be defined, by using the context menu that appears upon right clicking  over an axis, or 

help of the EG: Edit Graphic Line command (see the “Graphic Lines” chapter).  
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CHAMFERS 

T-FLEX CAD allows creating chamfers and various fillets without any preparatory constructions. The 

existing elements of the drawing are modified, and new ones created in the process. 

Chamfer Creation 

To create a chamfer, use the command FE: Create Chamfer. The command is called in one of the 

following ways: 

Icon Ribbon 

 

Draw → Draw → Chamfer 

Keyboard Textual Menu 

<FE> Construct > Chamfer 

To create a chamfer, you need to do several subsequent steps: 

1. Select the chamfer type and set its parameters. 

2. Select the defining nodes or graphic lines. 

Upon calling the command, a dialog box is displayed on the screen for defining the necessary 

parameters and selecting the type of the chamfer being created. (By default, the dialog box is instantly 

launched by the system). 

Upon confirming the selections with the graphic button [OK], the following actions can be performed: 

 <P> Set command options 

 <N> Select Node 

 <Space> Select Graphic line 

 <Esc> Exit command 

T-FLEX CAD supports three main techniques of creating chamfers: 

Chamfer creation by selecting the node through which the hatch contour is passing. The chamfer is 

displayed in this case as a construction entity. 

Chamfer creation by selecting the node through which two graphic lines are passing. The chamfer is 

displayed in this case as a graphic entity. 

Chamfer creation by selecting graphic lines. The chamfer is displayed in this case as a graphic entity. 

Note that the corner chamfer can be created based on straight graphic lines only. 

If the selected elements are not appropriate for the selected chamfer type or were selected incorrectly, 

then a dialog box is displayed with an appropriate error message. 
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Chamfer Creation by a Node through which the Hatch Contour is Passing  
This technique is intended mainly for creating chamfers at the drafting stage when the graphic lines are 

not created yet. A chamfer created in this way is drawn as a construction entity.  Later, you will have to 

apply graphic lines over this chamfer manually. On the other hand, if the graphic lines were created 

before introducing the chamfer, then the chamfer will be displayed as a graphic entity. This technique is 

intended for constructing only isolated chamfers. Therefore, when constructing chamfers on the surfaces 

of revolution or two-sided chamfers on the edges of faceted parts, you will have to add the missing 

construction lines manually. 

Remember that this chamfer creation technique works only in the case when the parameter is set 

among the operation parameters, “Auto change Hatches”. 

After selecting the type of the chamfer being created and defining the necessary parameters, you need 

to select the node at which the chamfer will be constructed. This is done by the option . 

The selected node must belong to a hatch contour. Upon 

selecting the node, the chamfer and the construction entities 

used for its creation are constructed automatically according to 

the specified parameters.          

The direction of creating the angular chamfer is determined by the system automatically (depending on 

where the hatch contour lies). 

Chamfer creation by the node through which two graphic lines are passing  

This technique is used when the graphic lines are already applied on the drawing. A chamfer created in 

this way is drawn as a graphic entity. All construction entities necessary for the chamfer creation are 

produced automatically. 

When creating a chamfer in this way, make sure that no more than two graphic lines are passing 

through the selected node. Otherwise, we recommend using another way of chamfer creation, 

described below. 

To create an isolated chamfer, in the operation 

parameters select the desired chamfer type and set the 

necessary parameters. After that, specify the node 

through which two graphic lines are passing. 
         

The direction of creating the angular chamfer is determined by the system automatically (depending on 

where the graphic lines lie). 

For inner chamfer creation, we recommend using the special chamfer types intended for this purpose. 

The pointer should be positioned in this case on the desired side of the chamfer creation. 

                             

When creating dual chamfers, upon defining the parameters just select two nodes where two respective 

pairs of graphic lines intersect. The pointer position is of no importance in this case. 
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Chamfer Creation by Graphic Lines 
This technique, as well as the previous one, is used when the graphic lines are already applied on the 

drawing. The chamfer created in this way is displayed as a graphic entity. The existing graphic entities are 

modified, and all necessary construction entities necessary for the chamfer creation are produced 

automatically in the process. 

When creating an isolated chamfer in this way, then, upon selecting the chamfer type and defining the 

necessary parameters, you need to specify two graphic lines intersecting in one point. The graphic line 

selection is done by  or by the option: 

 <Space> Select Graphic line 
 

In this case, the chamfer distance will be counted from 

the first selected graphic line. 
1

2      
 

When creating dual chamfers, then, upon defining the 

necessary parameters, you just need to select their 

common graphic line lying in between. In this case, each 

end point of this line should be connected with exactly 

one graphic line. 

                  

In the ambiguous cases, when more than two lines pass through the end nodes, or the lines intersect 

without passing through the end nodes, then three graphic lines need to be selected for the dual 

chamfer creation, in the order starting with the common line of the to chamfers.  

1

2 3           or        

1

2 3    

When creating any type of a chamfer, error messages are displayed on the screen in the cases of 

incorrect element definition. 

Chamfer Parameters 

Since the chamfer parameter definition is the first step of its creation, the default system behavior implies 

launching the chamfer parameters dialog box immediately upon calling the command. Otherwise, the 

dialog box is called by the option: 

 <P> Set command options 



Chamfers 

579 

You can select a predefined type of a chamfer in the Type pane of the dialog from the menu of icons. 

Radius/Distance. Defines the radius of the inscribed circle 

in the case of the fillet-type chamfer, or the distance in 

the case of the corner chamfer. 

Angle. This parameter is accessible only when the corner 

chamfer is selected, and defines the angle of the 

chamfer being created. 

Symmetrical. This parameter is accessible only when 

making the corner chamfer. Setting this parameter grays 

out the parameter Angle, since only the distance is 

required for defining the symmetrical chamfer. 

Style from original With this parameter set, the chamfer-

making line strokes will have the same parameters as 

the graphic lines on which the chamfer is based. 

Otherwise, those strokes will have the parameters 

currently used by the command G: Create Graphic Line 

or SK: Create Sketch. 

 

Auto change Hatches. Setting this parameter causes automatic adjustment of the defining hatch to 

geometry of the chamfer being created. It also makes possible creating a chamfer as a 

construction element at the node through which the hatch contour is passing. 

Show this dialog when command starts. If this parameter is set, this dialog box will be 

automatically launched upon entering the command. If the parameter is cleared, you will have 

to call the dialog by the option “Set command options” (the icon ) 
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WELDING 

In T-FLEX CAD there is a group of commands intended for design of welded parts. Welding commands 

are gathered in the Tools > Welding submenu. With the help of these commands it is possible to create 

on a 2D drawing or a 3D model various types of standard welded seams, and if necessary nonstandard 

ones. For created welded seams it is possible to automatically create captions and make tables of welded 

seams. 

To invoke welding commands, the main toolbar can be used (the “Welding” set). 

This chapter describes the commands used for creation of welded seams on a 2D drawing, i.e., 2D 

welded seams. 

General Information 

T-FLEX CAD allows us to create three types of elements intended for design of welded parts: welded 

seam types, welded seams, welded seam captions. All these elements are interconnected. The structure of 

connections between them is displayed in the tree of welded seams in the system’s service window 

“Welded seams” (see below). 

 Welded seam type – a special element of T-FLEX CAD that itself stores characteristics (description, name, 

regulatory norms, geometric parameters) of the welded seam used in the current document of T-FLEX 

CAD. T-FLEX CAD document can contain several types of welded seams.  

Welded seam types created in the current document of T-FLEX CAD are common for 2D and 3D 

welded seams. 

Welded seams types required in the current document are determined by the user. To specify 

characteristics of the welded seam types it is possible to use the standard database of welded joints that 

is available in the system. If necessary, the user can specify arbitrary characteristics. 

The types of welded seams created on the basis of welded joints of T-FLEX CAD are stored in the 

current document of T-FLEX CAD. But the connection with the database is not stored. This method 

of storage of welded seam types allows us not to worry about the presence of welding database 

when transferring the document. 

Specifying only the types of welded seams is not sufficient for design of welded parts. The types 

determine which welded seams can be present in the current document of T-FLEX CAD, but they do not 

specify the welded seams themselves. Using the welded seam types specified in the document, the user 

has to create other elements of T-FLEX CAD – welded seams. 

Welded seam – element of T-FLEX CAD that defines the welded joint existing in the given drawing (or 3D 

model). In T-FLEX CAD the welded seams are divided into 2D welded seams and 3D welded seams 

depending on method of specification.  

This chapter describes only 2D welded seams, i.e., the seams that are not directly connected with 

the elements of a 3D model.  
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When creating the welded seam, the user indicates to which of the types predetermined in the given 

document the given seam refers. In doing so the basic characteristics of the created welded seam are 

defined − they will be taken from the parameters of the specified type. If needed, the user can specify a 

number of individual parameters for a welded seam that are not defined in the corresponding type. 

2D welded seam can be both free and associated with 2D drawing’s elements (graphic lines or paths). 

Free seam is determined only by its type and, if necessary, by the individual parameters. It is not 

associated with a 2D drawing, but it is present in the current document, displayed in a welded seams tree 

and taken into account when making the welded seams table. The length of such a weld is defined by the 

user. 

 

If, when creating a 2D welded seam, we specify the elements of a drawing with which the seam must be 

associated, then in the future these elements will be treated as the image of the given welded seam on 

the 2D drawing. The length of such a welded seam can be either specified by the user or automatically 

calculated by the system based on the length of 2D elements with which it is associated. 

 

When creating a welded seam, the user must determine whether the welded seam being created 

will be indicated on the drawing. If yes, then upon seam creation the user should indicate the 

drawing’s elements which will be the image of the welded seam. Otherwise, it is sufficient to 

create free, i.e., not associated with any drawing’s elements, welded seam. 

Welded seam caption – a special element of the “Label” type, which serves for designation of the welded 

seam on the drawing. To create a welded seam caption, an additional command is used. It constitutes an 

adapted version of the command for creating notes. Caption is automatically generated on the basis of 

parameters of the indicated welded seam. If necessary, the user can edit parameters of the note-caption 

of the welded seam. In the future created note-caption retains connection with the parameters of the 

welded seam. 

 

From welded seams created in the current document a table of welded seams can be created. Welded 

seam table constitutes a text report about welded seams generated in the current document. The 

contents of the welded seam table (available types of seams, number of seams of each type, the total 

length of the seams of each type) are created automatically by the system. The table can be created in 

the current document of T-FLEX CAD and also exported to the Excel document. If necessary, the user can 

specify his own ways of creation of the welded seam table by creating corresponding macros. 
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«Welded Seam» Window 

All types of the welded seams specified in the current document of T-FLEX CAD, the welded seams 

themselves and their captions are shown in the system’s special window “Welded seams”. Control of this 

window visibility is carried out with the help of the  icon found in the set of buttons “Welding” of the 

main toolbar by the command WW: Show weld project window: 

Icon Ribbon 

 

Assembly → Assembly → Weld → Weld Project Window 

Keyboard Textual Menu 

<WW> Tools > Weld > Weld Project Window 
 

In the given window the elements of welding (welded seam types, 

welded seams themselves and their captions) are sorted by the types and 

are represented in the form of a tree. The welded seam tree allows us to 

visualize intuitively all information on the welding’s elements created in 

the current document (in the drawing or 3D model of a product). 

The context menu invoked with the help of  when clicking on any point 

of the “Welded seams” window or upon selection of any element in the 

given window contains various commands for creation and editing of the 

welding’s elements. 

 

Specifying welded seam type 

Specifying the new type of the welded seam is carried out with the help of the special command Create 

welded seam type. It is possible to invoke this command with the help of the  icon found in the set 

of buttons “Welding” of the main toolbar or from the context menu in the “Welded seams” window. In 

addition, the command of creation of the new welded seam type can be invoked directly from the 

command of creation of the welded seam. 

After the command is invoked, the window of the dialog appears in which parameters for created welded 

seam type are selected. When working in this dialog, firstly the user has to indicate the regulatory norms 

for the welded seam type being created (GOST, ANSI/AWS A2.4, ISO 2553,). Depending on the selected 

norms, the number is selected according to the norms. The selected regulatory norms and number 

determine the remaining contents of the given dialog. 
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Creating Welded Seam 

To create a welded seam, the WE: Create welded seam command is used. Invoking this command is 

carried out by one of the following methods: 

Icon Ribbon 

 Assembly → Assembly → Weld → Weld 

Keyboard Textual Menu 

<WE> Tools > Weld > Weld 
 

To create a welded seam, after invoking this command it is required to select the welded seam type in 

the “Welded seam” section of the properties window. In the drop down list those types of welded seams 

which were defined in the given document will be present.  
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If the required welded seam type is not yet created, it is possible to use 

the[Add…] button. When pressing this button, the command of creation of the 

new welded seam type will be started. After completion of the type creation the 

system will return to the command of welded seam creation. Created seam type 

will automatically be selected. 

If not a single welded seam type is defined in the current document at the 

moment of launching the “WE: Create welded seam” command, the command of 

welded seam type creation will automatically be invoked.  

After selection of the type, it is possible to complete the seam creation. 2D 

welded seam not associated with the drawing’s elements will be created. Its 

length by default is equal to zero. If necessary, the length of the welded seam can 

be specified manually. To do so, it is required to enable the “Length” flag and 

specify the desired length of the welded seam in the input field that appears to 

the right. 
 

 

To link the welded seam being created with the lines of a 2D drawing, it is required to indicate the 

graphic lines or 2D paths in 2D window with the help of the options of automenu: 

 <I> Select graphic lines 

 <P> Select paths 
 

By default, both of these options are enabled.  

The elements selected in 2D window are added to the “Elements of welded seam” list. To refuse selection 

of any element, it is required to select it in the list with the help of   and press the [Remove] button. 

By default the length of welded seam associated with the drawing’s elements is determined 

automatically based on the length of selected lines or paths. If necessary, the length can also be specified 

manually by enabling the flag “Length”. 

In the sections “Main parameters”, “Processing front side” and “Processing back side” it is possible to 

specify individual parameters of the welded seam being created.  
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In the “Main parameters” section the 

following parameters can be specified: 

 Contour: 

 no contour; 

 by closed contour; 

 by open contour; 

 Field seam: yes/no; 

 Caption of controlling complex 

or of the seam’s control category. 

In the “Processing front side” and 

“Processing back side” sections, the ways 

of processing the front and back sides of 

the welded seam are specified. The 

“Processing type” parameter found in 

each of these sections allows us to select 

one of the following types of processing 

for each side of the welded seam: “No 

processing”, “Remove reinforcement”, 

“With smooth transitioning”.  

  

To specify roughness of the front or back sides of the welded seam after machining, the Roughness flag 

in the corresponding section of the properties window should be enabled. As a result the[Parameters] 

button will become available to the right of the given flag. When pressing this button, the roughness’s 

parameters dialog will open. After specifying the desired parameters and closing the dialog, the image of 

the given roughness will appear in the preview field located below. 

All individual parameters of the welded seam described above can automatically be transferred to 

the module of technological design “T-FLEX Technology”. 

Creating Welded Seam Caption 

Caption of the welded seam is created on the drawing with the help of the WN: Create Weld Symbol 

command. Invoking this command is carried out by one of the following methods: 

Icon Ribbon 

 Assembly → Assembly → Weld → Weld Symbol 

Keyboard Textual Menu 

<WN> Tools > Weld > Weld Symbol 
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After invoking the command, the automenu and properties window will become available, which are 

similar to the caption creation command by the structure of elements. In the automenu there is 

additional option that allows us to select the welded seam on the drawing: 

 <R> Select weld  

To select a seam, it is required to move the cursor closer to those lines or 2D paths of the drawing with 

which the welded seam is associated. When the seam is highlighted, it can be selected by pressing . On 

the dynamic image of the note snapped to the cursor the text caption of the selected welded seam will 

appear. Next this caption is tied to the drawing in the same way as the ordinary note. 

 

Note that only welded seams that are associated with lines of the drawing can be selected in this 

way. The welded seams that are not associated with lines of the drawing can be selected only in 

the “Welded seams” window. Moreover, such a welded seam can be selected with the help of the 

“Other” item of the context menu if the context menu is invoked in 2D window in the command 

waiting mode. 

 

For ISO and ANSI standards the welded seam captions are specified manually. To do so, in the properties 

window in the «Type» section it is required to select the ISO or ANSI standard from the list. 

 

All required parameters of the note are specified in the dialog window «Note’s properties». This dialog 

window is invoked by pressing the  icon. 
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Different dialog windows will appear for the ANSI and ISO standards. 

 

After all input values are confirmed and all necessary parameters for a welded seam are specified, the 

welded seam caption will be created on the drawing. 
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The note’s parameters can also be specified in the parameters dialog that is invoked with the following 

option of the automenu: 

 <P> Note’s parameters 

Parameters on the tabs of this dialog duplicate parameters in the properties window. 

 

 

The note’s parameters dialog can also be invoked in the command waiting mode from the context 

menu of the note (invoked with ). Owing to this capability this dialog can be used for immediate 

change of the note’s parameters without invoking the command of editing. 

T-FLEX CAD allows the user to input his own welded seam captions. User’s captions are created in the 

same way as regular parametric fragments in the library in the folder “System\Welding Symbols”.  

 

In the command’s properties window there is the “Additional parameters” section that contains the 

following parameters of the welded seam caption: 

 

Seam’s location. This parameter shows from which side of the seam the caption is positioned: 

“On Face side” (the seam’s caption will be positioned on the leader of the note) or “On back 

side” (the seam’s caption will be positioned under the leader of the note). 
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Full caption of a seam. If this flag is enabled, then the full 

caption of the welded seam is indicated on the caption. When 

this flag is disabled, the shortened caption that contains the 

seam type number and individual parameters of the given seam 

are indicated. 

By default, for each type of the welded seam the first 

extension line is created with the full caption, all 

subsequent ones for the given type of the welded 

seam – with the shortened caption. 

Show sequence number. When this flag is enabled, the 

number of the given welded seam type is shown on 

the arrow of the 

note-caption. This parameter is available only when the 

“Full caption of a seam” flag is enabled. 

  
 

Show number of seams. This parameter is available only when the “Show sequence number” flag 

is enabled. If it is enabled, before the welded seam type number, which is shown on the note’s 

arrow, the total number of welded seams of the given type in the current document is 

specified. 

Hide dimension. If the given flag is enabled, then the seam’s leg dimension is not shown in the 

full caption of the welded seam. When the flag is disabled, the full caption with indication of the 

leg’s dimension is specified. 

Creating Welded Seams Table 

Creation of welded seams table is carried out with the help of the WT: Create welded seam table 

command. The command is invoked: 

Icon Ribbon 

 Assembly → Assembly → Weld → Weld  

Keyboard Textual Menu 

<WT> Tools > Weld > Weld Table 
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After this command is invoked, the dialog 

window appears in which the user has to 

choose the method of creation of the table of 

welded seams. Initially two options are present: 

Simple table of welded seams. Welded 

seam table is created on the first 2D 

page of the current document. 

Approximate appearance of this table 

is shown on the figure below. 

 

 

Export of welded seams into Microsoft Excel. Welded seam table is exported into the document 

of Excel. 

Creation of welded seam table in both cases is carried out with the help of macros found in the folder 

“…/T-FLEX Parametric CAD 15/Program/WeldReport”. If necessary, these macros can be modified 

independently by defining inside them another type of a welded seams table. It is also possible to create 

user’s own macros for creation of welded seams table and place them into the same folder. In this case in 

the aforementioned dialog the additional options will be present that correspond to the user’s macros. 

The work with macros is described in more detail in the “Macros” chapter. 



 

 

SUPPLEMENTARY DRAWING ELEMENTS 
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DRAWING VIEWS .  DETAIL VIEWS 

This chapter describes an auxiliary element of T-FLEX CAD system – the drawing view. Additional views, 

detail views, local section views and sections – all these instances are supported by Drawing View. This 

functionality handles situations when elaboration to the images on the main views is required. This can 

be an additional view, and, in particular, a scaled view. The functionality allows collecting together on one 

page elements from different pages, inserting an image (or a portion thereof) from one page into 

another page in various scales, even create a simple assembly from parts contained in the same 

document. 

Main Concepts 

A drawing view is an element of T-FLEX CAD that allows displaying contents of one page (or a portion 

thereof) on another page, scaled to the desired factor. It is a rectangular area of specified size used for 

displaying the contents of another page.  

 
 
 

The page displayed within a drawing view can either be selected from the list of existing pages in the 

document or additionally created for the drawing view. The newly created page is assigned the type 

“Auxiliary”. A drawing view can be nested, that is placed within another drawing view. 

 

Drawing views 

Drawing view 

pages 

A drawing page with 

drawing views on it 
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Location of the drawing view box on the main page can be specified by either direct selection of the 

fixing point and the view rotation angle or with the help of the fixing vector located on the view page. 

The main purpose of a drawing view is to display on one page drawing elements of different scales. For 

example, one can create a drawing of some object on one page and then create drawing views of this 

object on other pages that will display portions of this drawing to various scales.  

Besides, drawing views can be used simply for collecting the contents from different pages. This may be 

used for adding to the main drawing some additional, local views and sections created on other 

document pages in different scales. This capability is the most common way of using drawing views in T-

FLEX CAD. Note that the images on the detail views can be copied from other pages of the current 

document when the drawing view is created (see section “Creating Detail View”), and enhanced with 

captions of the view notations (see section “Creating Detail View with Caption”). 

  
Detail View Detail View with Caption 

The image displayed on a drawing view can be created or edited either on the original page of the 

drawing view elements, or directly in the view area of the main page by activating the view. 

Limits are shown on the drawing for drawing view and detail view. The limits are not printed. If you want 

to change color of the limits use the option Limits of inactive drawing view on the Color tab in the 

SO: Set system options command. You can specify colors of the other drawing view elements on the tab. 

 

Creating Drawing Views 

Drawing views are created using the command SD: Create Drawing View: 
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Icon Ribbon 

 

Draw → Draw →  

Keyboard Textual Menu 

<SD> Draw > Drawing View 

After invoking this command, the following options will appear in the auto menu: 

 <O> New Drawing View 

 <V>  New Detailed View 

 <C> New Detailed View with Caption 

 <S> Create drawing view by contour 
 

These options define different modes of creating drawing views. 

These command operation modes can be also specified in the properties 

window (parameter Type in the group “Basic parameters”). The command's 

properties window and the auto menu work synchronously.  

Working with Draggers of Drawing View 
For defining location, rotation angle and dimensions of the drawing view, a special type of the cursor in 

the form of the dynamically movable rectangle with markers is used. Markers can be used for modifying 

location, rotation angle, the scale and the size of the view, location of the fixing vector or fixing point. 

 

The markers are used as follows: a marker is activated simply by pointing the cursor and clicking . Then 

the marker can be moved to the desired position. The second click  fixes the new position of the view. 

Alternatively, the marker can be “dragged” by moving the cursor with the mouse button  held down. In 

this latter case, the placement of the view in the new position occurs on releasing the mouse button. 

As the placement or parameters of the view are modified, the original state stays in display.  

To change the view box size, the square-shape markers are used, located in the corners and at side 

midpoints of the view box. When pointed at by the cursor, the latter changes to a two-headed arrow . 
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The  marker provides for modifying the view scale, that is the scale factor of the page display in the 

view box. The exact value of the scale can be entered in the view parameters dialog box. 

The marker  allows changing the view rotation angle about the fixing point. (In the case the view was 

based on an existing page and a fixing vector, this will be the rotation angle of the fixing vector.)  The 

exact value of the rotation angle can be entered in the view parameters dialog box. 

For moving the view image relative to the page, on which it is located, the marker  or the marker of 

the fixing point of the view (in the form of the filled square) can be used. 

Location of the fixing point of the view is shown with the marker in the form of the unfilled square. When  

creating the drawing view on the basis of the existing page with the help of the fixing vector, the location 

of the given marker coincides with the origin of the fixing vector. 

For modifying the fixing point of the view, point at the marker for fixing the view while holding the 

button <Shift>. After that, to select the fixing point, you can pick (by pressing ) one of the characteristic 

points of the view box (corners of the view box and the midpoints of its sides). You can also specify the 

fixing point of the view arbitrarily by using <Ctrl>+ . 

It is also possible to change the location of the fixing point of the view with the help of the option 

 of the auto menu for the command of creating/editing the drawing view. 

For moving the drawing view area (that is, the drawing view box relative to the page displayed in the 

view), the marker  is used. 

Originally, the boundaries of the box coincide with the boundaries of the displayed page. Shifting 

the view with respect to its page makes sense only when a portion of the page is supposed to be 

displayed on the view. In this case, the “Clip Image” flag is usually checked in the parameters 

dialog box, and the view box manually reduced to the desired size. 

Creating Drawing View 

After entering into the command “SD: Create Drawing View” the option  becomes active by default. 

This option allows the user to create a simple drawing view. The created view can display the contents of 

already existing page of the current document as well as of the new page, automatically created by the 

system for the given drawing view. 

After activating the option the cursor starts moving a box with markers for 

moving the view area, rotating and scaling the view. Meanwhile, the status 

bar displays the help message “Select Drawing View type or set new 

Drawing View placement”. The drawing view can be placed on the current 

page by specifying a point on the drawing (a 2D node or an arbitrary 

point).  
 

To fix the view at a node, one can use the following automenu option: 

 <N> Set relation with Node 
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The location of the created view (coordinates X and Y of the fixing point) can be also specified in the 

command's properties window (in the group Basic parameters). 

By default, the snap of the drawing view is carried out at the center of the view box. It is possible to 

select another fixing point of the view with the help of the option: 

  Fixing Point of View 

After specifying the view location, the user can define more accurately the location, the size and the scale 

of the view by using the markers around the view box (the use of markers is described in section “Editing 

drawing views” in more detail). 

It is possible to specify parameters of the created drawing view in the command's properties window: 

Create New Page. A new page (“Auxiliary” type) will be created along with a new drawing view. The 

parameters “Width” and “Height” define the page size. These also define the initial size of the drawing 

view box. The parameter “Scale” defines the scale factor of the view page. These settings are entered as 

the Paper size group of parameters and Scale parameter of the newly created drawing page on the tab 

Paper of the ST: Set Document Parameters command. 

The created page will not contain any constructions. The user is 

supposed to create the necessary contents on this page himself. The 

editing techniques of drawing views and their contents are described 

in the section “Editing drawing views”. 

Use Existing Page. Allows selecting any existing page in the document 

(except the current one) from the list. This parameter is inaccessible 

for one-page documents. The size of the drawing view box is 

automatically set in accordance with the size of the selected page. 

Fixing Vector. Setting this parameter allows the user to select and use 

the fixing vector existing on the selected page for snapping the 

created drawing view. The parameter is accessible only when the flag 

“Use Existing Page” is set and when a fixing vector exists on the 

current page. Note that, when using the fixing vector, it is necessary 

to specify two fixing points of the drawing view. 

 

Fixing Vector can be used for placing a drawing view, just like a 2D fragment. This also allows 

controlling the current page layers visibility as the page is displayed on a view. Use of fixing 

vectors is described in details in the chapter “Assembly Drawing”. 

The group of parameters Parameters combines auxiliary parameters of the drawing view: 

Scale. Defines the scale factor of the drawing view, which is the scale of transformation of the 

view page as it appears on the main page. 

Rotation Angle. This parameter is inaccessible when using a fixing vector. 
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Clip Image. When set, the page in the view is clipped to the extents of the actual image contained 

on the page. 

Scale Lines. When set, the thickness of the graphic lines on the drawing view will be affected by 

the “Scale” parameter. 

To complete view creation, use the option . As a result, a rectangular area of the drawing view will be 

created, with the contents of the specified page or its portion displayed within. 

Creating Detail View 

The option  allows the user to automatically create the detail views on the basis of the drawing view. 

As a result of its use, the drawing view containing automatically created copy of the selected elements of 

the drawing will be created. In addition, the image on the drawing view page will be automatically 

augmented with the view caption. 

 

When using this option, the following will be created:  

1. A new drawing view (based on a new “Auxiliary”-type page). The drawing view parameters 

are set “by default”; 

2. A translated copy (as in the command Drawing > Copy > With translation) for associative 

copying of the selected elements onto the drawing view page with specified parameters (scale 

and rotation angle); 

3. The caption for the detail view. 

As a result, a rectangular area of the drawing view is created on the main page with copies of selected 

elements displayed within. The size of the drawing view, as well as the size of its respective page, is 

defined automatically by the system based on the size of the copied entities. If necessary, the size of the 

drawing view and its page can be modified manually. 

For creating the detail view, it is necessary to do the following: 

1. Select the elements to be copied from the original drawing; 

2. Select the fixing node for the copied elements; 

3. Define location of the detail view (that is, the location of the drawing view containing the 

detail view). 
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After invoking the option  the options for selecting the copied elements will appear in the auto menu: 

 <M> Select Mode 

 <M> Deselect Mode 

 <I> Select Other Element 

When the option is turned on  all elements selected on the drawing are added to the list of the 

copied elements. For quick selection of several elements, you can use the selection with the window. 

When the option is turned off  the selected on the drawing elements will be removed from the list of 

the copied elements. For quick selection, you can use the selection with the window here as well. 

Complete the selection of the elements, which will be copied onto the detail view, by pressing . 

After selecting the copied elements, the system will prompt the user to specify the fixing point of these 

elements (it will serve as the initial point of the copy to be created). The option for selecting a 2D node 

will appear in the auto menu: 

 <N> Set relation with Node 

After choosing the fixing node, the dynamic image of the created detail view attached to the cursor will 

appear on the screen. The location of the detail view on the drawing has to be selected next. After 

snapping the view, its location and size can be adjusted with the help of the markers for editing the 

drawing view. 

To make the caption of the detail view change its location according to the modifications of the 

drawing, it is recommended to fix the drawing view to the 2D node. 

Before completing the detail view creation, the dialog for specifying parameters of the created view will 

remain available in the command's properties window. In this dialog you can specify the precise values 

for the fixing point of the view, and also the following parameters: 



Drawing Views. Detail Views 

599 

 

Copy Scale. This scale determines the scale with which the selected elements of the drawing will be 

copied. 

The group of parameters Image defines parameters of the drawing view being created (these parameters 

can be also specified directly in the drawing's window with the help of the markers on the view image): 

Scale. The drawing scale of the drawing view, that is the scale with which the drawing view page is shown 

in the view area; 

Rotation Angle. Angle of rotation of the drawing view. 

Group of parameters Text allows specifying parameters of the view caption: 

Letter (Text):. In this field the lettered caption for the created view is shown (selected by the system 

automatically). If necessary, you can choose another caption. 

Auto Increment. When this flag is set, for each new detail view the “available” letter is automatically 

selected. It is shown in the field of the parameter “Letter (Text)”. When this flag is turned off, the 

automatic selection of the lettered caption does not occur. 

First Line. The text in the first line of the view caption. This parameter supports the special format. To 

insert the lettered view caption (the value of the parameter “Letter (Text)”) into the line, the group of 

symbols “<Letter>” is used. To insert the copy scale caption (“1:1”, “1:2” ...) – the group of symbols 

“<Scale>”. By default, the string “<Letter> (<Scale>)” is set for this parameter. 

Underline. When this flag is set, the text in the first line of the view caption will be underlined. 

Second Line. This parameter defines the text of the second line of the view caption. 

Clip Image. When this parameter is set, the view image will be cropped by the drawing view borders. 

Scale Line Width. If this parameter is set, the width of the graphic lines of the detail view will be scaled 

according to the specified drawing scale of the view. 
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The last step of the detail view creation is the view outline creation. The system allows to define the 

outline after pressing . 

 

A dotted line appears around the selected area for the detail view. The line is divided into segments. A 

click into a segment enables/disables the display of the selected segment. 

 

The following options are available: 

 <S> Show all segments of detail view outline 

 <H> Hide all segments of detail view outline 

 <I> Invert visibility of detail view outline segments 

You can specify parameters for the outlines using the option . 
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To complete view creation, use the option . For the view constructed, the caption will be 

automatically created. The obtained view can be edited and augmented, if required. 

Creating Detail View with Caption 

Creating the detail view with the caption with the help of the option  is an extension of the case of 

creating just a detail view (the option ). The option  creates the detail views clipped by the 

specified contour and with automatic creation of the caption for the detail view on the given drawing. 

As a result of its use, the caption for the detail view is created on the drawing. The image of the detail 

view itself is automatically clipped by selected contour (circle, oval or rectangle) and augmented by the 

view caption. The obtained image can be edited later by using the standard tools of the T-FLEX CAD. 

 

When creating the detail view with the caption, the following will occur: 

1. Creating the new drawing view (on the basis of a new page of the type “Auxiliary”). The values of 

the parameters of the drawing view are set “by default”; 
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2. Creating a copy with translation for associated copying of the selected elements onto the 

drawing view page with the specified scale and rotation angle. Clipping the image to be copied 

by the automatically created hatch of the specified form; 

3. Creating detailing elements for the detail view (view caption, caption of the detail view). 

After invoking the option  it is necessary to do the following: 

1. Select the fixing node for the elements which will be copied; 

2. Specify the center of the selection area for the detail view; 

3. Specify the form and size of the selection area for the detail view; 

4. Specify the location of the leader line jog for the detail view caption; 

5. Specify the location of the detail view (that is, the location of the drawing view with the detail 

view). 

Note that in the described sequence of steps, there is no step for selecting the original elements to be 

copied. When creating the detail view with the caption, the collection of the copied elements is 

determined by the view selection area – all 2D elements at least partially contained in the specified area 

will be copied. 

For selecting the fixing node, in the auto menu of the command the following option will be available: 

 <N> Set relation with Node 

The fixing node will determine the initial location of the fixing point for the created view. If, upon 

specifying the fixing node, the user selects an arbitrary point on the drawing (with the help of ), then at 

this point the free node, which will be selected as the fixing node, will be automatically created. 

After specifying the fixing node, the system will ask to specify the center of the selection area. This can be 

done by picking an arbitrary point in the drawing's window (with the help of ) or by specifying exact 

coordinates in the command's properties window. 

The center of the selection area can be also defined by selecting a 2D node or offset of the center point 

from the fixing node (selected at the previous step). For selecting the 2D node the following option is 

used: 

 <N> Set relation with Node 

For specifying the offset of the center of the selection area from the fixing node, the following option is 

used: 

 <A> Set Relative Position 

After selecting the center of the selection area, the form and dimensions of the area need to be specified. 



Drawing Views. Detail Views 

603 

The form of the area is specified in the command's 

properties window: circle, rectangle, oval. 

The dimensions of the area can be specified either in 

the properties window or directly in the drawing's 

window (the dynamic image of the area's bounding 

frame will follow the cursor, pressing  will fix the 

frame location). 

    

After specifying the view selection area, the location of the leader line jog for the view caption has to be 

defined. Dynamic image of the leader line jog will follow the cursor. Pressing  in the drawing's area will 

fix the jog location. The jog location can be also specified in the command's properties window (by 

specifying the coordinates of the starting point of the jog in the group “Basic parameters” of the 

properties window). 

For changing orientation of the jog for the view caption, the following auto menu option can be used: 

 <Z> Change leader line jog orientation 

After specifying the jog location, the dynamic image of the created detail view, attached to the cursor, 

will appear on the screen. The location of the view on the drawing has to be specified next. 

To make the caption of the detail view change its location according to the modifications of the 

drawing, it is recommended to snap the copied element to the 2D node. After snapping the view, 

its location and size can be adjusted with the help of the markers for editing the drawing view. 

Complete the view creation with the help of the option . 

For the constructed view, the caption will be automatically created. The obtained image can be edited 

and augmented, if required. 

Creating Detail View with Breaks 

On any detail view the user can create breaks, if necessary. The number of breaks on a single view is not 

limited. To create breaks, use the following option: 

 

 <B> Add or edit Broken View  
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After invoking this option, the system will transfer to the mode of creating/editing breaks on the current 

view. In the command properties window an additional section Breaks appears in which all breaks 

created on the given view and their parameters will be included. 

Note that if the breaks are not yet present on the current view, then after entering into this mode the 

new break will automatically be created. If the view already has the breaks, then the new break is not 

created and the system waits for selection of one of the existing breaks for editing its parameters. In this 

case it is possible to create the new break by pressing the  button next to the list of breaks in the 

command’s properties window. To remove the break, we use the  button. 

The following options will be available in the automenu: 

 
<Ctrl+Enter

> 
Finish break editing 

 <C> Select base point 

 <A> Select line defining break orientation 

 <L> Select lines defining label’s boundaries 

 <Esc> Exit break creation/editing mode 

By default, the system prompts us to create a horizontal break. This will be shown on the view as a 

hatched rectangular domain. The hatch lines show the direction of the space compression (perpendicular 

to the break lines). 

The next figure shows an example of the view with the 

break.  

 

If several breaks are created on the view, then the current break (that is being created or edited at 

the present moment) is displayed with green color, and the remaining breaks are shown with grey 

color. 

Location of the right and left boundaries of the break can be modified simply by selecting the boundary 

line with the help of  and by moving it to the desired location. By pressing  again we fix the new 

location of the boundary. 

When moving the break’s boundary, the additional option is available in the automenu: 



Drawing Views. Detail Views 

605 

 <N> Select insertion node 

With the help of this option, the break’s boundary location can be snapped to a 2D node. 

Break’s orientation can be modified by specifying it with the construction 

line or with the angle of rotation from a horizontal line. To specify break’s 

orientation with the help of construction line, it is required to invoke the  

option and select the desired line on the view page. The domain of the 

break will be reconstructed parallel to the selected line. Orientation of the 

break with the help of an angle can be specified directly in the command’s 

properties window (the Angle parameter). 

All breaks created on the view are added to the list of breaks in the 

properties window. For each break the location of boundary lines (Start and 

End) is indicated in the list. These coordinates are determined automatically 

when the user indicates the break zone on the drawing. They can also be 

specified with precise numeric values or variables (when the mode “In units 

of a model” is enabled, see below). To do so, it is required to select the 

desired break in the list  and enter the required values for the following 

parameters: 

Start. The value that determines the location of the left boundary – 

for horizontal break, or the lower boundary – for break at an 

arbitrary angle. 
 

End.  The value that determines the location of the right boundary – for horizontal break, or the 

upper boundary – for break at an arbitrary angle. 

If the values are specified as variables, then after the numeric value the corresponding name of 

the variable is indicated in square brackets. 

Other parameters of a break specified in the properties window are common for all breaks of the same 

drawing view. 

The Measure parameter determines the way of specifying locations of the 

break lines – either with numeric values in the units of the view page (In 

units of a model) or as a percentage along the direction of a break 

(Percentage). 

Positions of breaks can be defined relative to the start, the middle, the end 

of the image, or from an arbitrary base point (by default it is selected by the 

system, the base point is marked with an arrow on the view’s image). 

We can select our own base point for specifying the break’s boundary 

location with the use of the following option: 

 

 

 

 <C> Select base point 
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Boundaries of the lines of break’s label are defined based on the marginal graphic lines, individually for 

each side of each break. When defining the boundaries, the formatting elements (dimensions, texts etc.), 

and also 2D fragments for which the special viewing mode without clipping was specified are not taken 

into account. 

If necessary, the user can make automatically defined view’s boundaries more precise. To do so, we can 

use the option: 

 <L> Select lines defining break’s label 

After invoking this option, it is necessary to indicate two lines of the drawing view.  These lines can be 

both the graphic lines and construction lines (line, spline or function).  

When creating/editing a break it is also possible to specify the following parameters in the properties 

window: 

Distance between break lines determines the distance between the parts of the broken view. 

Angle. This parameter specifies the angle of rotation of break lines with respect to a horizontal 

line. Positive direction is in the counterclockwise direction. 

Extension lines length. If this flag is absent, then only that part of the break line will appear on 

the view which directly intersects the image of the view. Otherwise, the break line will go beyond 

the view’s margins by the magnitude indicated by this parameter. 

Do not move breaks. When this flag is enabled, the view’s lines that remain after applying the 

breaks do not change their location. 

Hide break lines. With the help of this flag visibility of break lines can be controlled. When the 

flag is enabled the break lines are not displayed on the drawing view. 

The break of a projection can be bounded by the lines that have various shapes. It can be a straight line, 

wavy line or zigzag line. 

To select properties of the lines that bound the break, it is 

required to invoke additional dialog. To invoke it, press the 

[Line’s Property…] button in the properties window.  

Line’s parameters such as the type, stroke scale, 

thickness and color define the style of break lines. 

Properties of wavy or zigzag line. For a wavy or zigzag 

line it is possible to select parameters such as the 

number of periods, period length and wave height. 

Units correspond to the units of a model. For a 

zigzag line you need to select such value for the 

period that the break line has only one chip. The size 

of a chip is controlled by the amplitude. 
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For a view that contains breaks, a list of “special elements” can 

be created. It can include formatting elements and 2D 

fragments. By default the formatting elements and fragments 

are shown on the drawing view without clipping on top of the 

main view. This rule also holds for the views with breaks. If it is 

required that the formatting element or the fragment on the 

view be cut off at the boundaries of the break, it is required to 

add the element to the Special elements list in the 

command’s properties window and select the With clipping 

mode for it. 

 

To edit the list of special elements it is required to press the  button to the right of the list. To add the 

element to the list, select it on the drawing with the help of . By default for all selected “special” 

elements, the “without clipping” mode is set. To change the clipping mode, it is sufficient to select the 

required element in the list – the mode will change (cyclically) whenever we click . 

On the view the elements included into the list are marked with a frame, and furthermore, the elements 

for which the « Clipping» drawing method was selected, are marked with slanted lines. 

 

To remove an element from the “Special elements” list, it is required to select it in the list with the help of 

 and press the  button. It is also possible to indicate the required element in the drawing’s window 

by pressing <Ctrl>+ . You can remove all “special elements” with the help of the  button. 

After all parameters of the break are specified, it is required to complete its creation by pressing  



T-FLEX CAD Brief Introductory Course 

608 

Creating Detail View by Contour 
To create a drawing view by contour you should create a contour in advance. Both the construction lines 

and graphic lines can be used for the contour creation. 

 

Use the following option to create a drawing view: 

 <S> Create detail view by contour 

You should select a contour after the option activation. 

 

Then you should select a fixing point and specify the position of detail view on the drawing. 
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Then you should edit outline. 

 

To finish a detail view creation select the option . 

 

Particulars of Scaling Drawing Views 

The “Drawing view” element and based on it detail views are created using various T-FLEX CAD 

instruments (the view page, the drawing view mechanism, the copy functionality). Each of these 

instruments has its own settings, including the scale: 

1. Drawing view page scale (defined under the command ST: Set Document Parameters);  

2. Drawing view scale which is the scaling factor of the drawing view page display on the detail 

view (defined in the drawing view properties dialog box – “Image|Scale”); 

3. The Scale of the copying the view elements (available in the properties window of the drawing 

view when using the options  and ). 

All these scales are superimposed in the image of the drawing view on the host drawing page. 

When creating a drawing view using the options of the command SD: Create Drawing View, the user 

defines only two of these scales (for example, the scale of the drawing view and the page scale when 

using the option , or the scale of the view image and the copying scale when working with the 

options  and ). The missing scale is assigned to default value. The user can manually modify the 
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values of all types of scale (see next section), however in this case the user needs to clearly understand 

the mechanism of the scale array. 

For example, consider the 

drawing view of a shaft on a 

diagram in the beginning of this 

chapter. This drawing view of 

the shaft in axonometric 

projection was performed with 

the page scale equal to 1 and 

the drawing view scale equal to 

0.5 (1:2). As a result, the image 

of the view on the main drawing 

page has the cumulative scale 

equal to 0.5. By changing the 

drawing view page scale to 2 

(2:1), we will get the 

axonometric projection of the 

shaft on the main page to the 

1:1 scale. 
 

Should we change the view page scale to 4 (4:1), the cumulative scale becomes equal to 2 (2:1). 

The detail view (View A) in this example was created using the option . The copying scale and, 

therefore, the drawing view page scale is equal to 4 (4:1). Meanwhile, the drawing view scale is equal to 

1. As a result, the cumulative scale of the detail view image is equal to 4. 

Editing Drawing Views 

Editing a Drawing View 
Editing of a drawing view is done by the command SD: Edit Drawing View The command is called as: 

Keyboard Textual Menu Icon 

<ESD> Edit > Draw > Drawing View  

Upon calling the command, an option appears: 

 <R> Select element from list 

 <*> Select All Elements 

 <Esc> Exit command 
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Once all drawing views are selected by the option , they are highlighted, and additional options 

appear in the automenu: 

 <Del> Delete selected Element(s) 

 <Esc> Cancel selection 

Upon selecting a particular drawing view by clicking it , another options appears in the automenu: 

  Fixing point of view 

 <P> Set entity parameters 

 <I> Select another nearest element 

 <B> Add or edit breaks 

The option  allows the user to modify the fixing point of the drawing view being edited. 

The option  brings up the “Drawing View Parameters” dialog box: 

Page. Displays the name of the auxiliary page corresponding to the selected drawing view. The 

parameter Scale defines the scale factor of this page. 

Clip Image, Scale Lines, Drawing Scale, Rotation Angle. These parameters affect the display of the 

drawing view area on the original page. 

Layer, level, Priority. Define the values of the respective system-wide parameters. 

The selected view is highlighted as a box with markers along the perimeter. The markers control position, 

rotation angle, scale, view size and the position of the fixing vector or fixing node. 
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Working with the markers is carried out in the same way as when creating the drawing view (or the 

drawing view of the element). 

The following option completes drawing view editing: 

 <End> Finish Page View editing 

The  option enables the mode of creating/editing breaks on the view. 

The command of editing the breaks of the drawing 

view can also be invoked without the use of the view 

edit command  −  from the context menu of the page 

displayed by the given view. In this context menu it is 

possible to specify if the diagram of breaks must be 

shown on the page (Show), and also to select the 

drawing view whose breaks have to be shown and 

edited (if there are several views displaying the given 

page). 

 

Editing the Image on a Drawing View 
The image on a drawing view can be edited in two modes:  

1. On the drawing view page – as a regular drawing; 

2. On the main page, by activating the appropriate drawing view. The view can be activated 

“in place” or in a separate window. Drawing view activation is done via the context menu 

after selecting the drawing view, or via commands in the menu View > Drawing view. 

Upon selecting one of the drawing views by clicking  on the drawing page, the following commands 

become available in the context menu: 

Activate Drawing View . Upon calling the command, all elements on the current page, except for the 

elements of the drawing view, are grayed out. The boundaries of the drawing view and the drawing view 

page become highlighted. The graphics of the drawing view can then be edited in a usual way. 

Activate in new window . This mode differs from the previous in that a new window is opened for 

editing that contains the graphics of the selected drawing view. 

Drawing View Parameters . Brings on the screen the dialog box of the command ST: Set Document 

Parameters with the selected drawing view page settings. 
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When using the menu View > Drawing view first time, only the 

command Activate… is accessible. Upon calling this command, 

the drawing view selection window is displayed. The selected 

from the list view will be activated in the current page. 

To return to the mode of editing the main page graphics, the 

active drawing view must be closed by using the command Close 

Drawing View  in the context menu or the command Close in 

the View > Drawing view menu. 

When using these commands for handling nested views, that is 

the views that appear within other drawing views, activate the 

views one by one, starting with the “outmost” one. 

Meanwhile, the command name Activate Drawing View in the 

context menu is appended with the nesting level of the next 

drawing view. 

All active drawing views can also be closed by using the 

command Close All Drawing Views , available in the context 

menu. Besides, the activated nested views can be subsequently 

closed by using the command Close Drawing View  for each 

active drawing view. 

Calling the command View > Drawing view >  Activate… from 

an active nested drawing view brings up a window with a list of 

accessible drawing views that includes <Main View>. Selecting 

the latter acts in the same way as the call of the command View 

> Drawing view > Close All, closing all levels of activated nested 

drawing views. 

When editing graphics in the drawing views created via the 

options “Create New Drawing View” and  “Create  New  Drawing  

View  with Caption”, all commands for editing copy with 

translation are available in the activated drawing view mode. 

 

 

 

 

A context menu appears on right clicking  over the lines on the view created by copying (in the 

activated drawing view area on the main page or on the view page), with the following commands under 

the Move Copy group: 
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 Edit Copy - calls the editing command 

EY: Edit Copy; 

Delete copy – deletes all elements of the 

copy; 

Copy Parameters – allows defining the 

scale and rotation angle of the 

translation; 

Explode Copy - breaks association of 

the moved elements with the original 

elements. The copied elements 

become independent objects, 

regardless of their parents creation 

history; 

Explode Array - breaks association of 

the moved elements with the original 

elements; however, relations are 

preserved between the objects of the 

copy analogous to the relations 

between the original objects; 

Restore deleted elements – allows 

restoring deleted elements of the 

copy. 

 

- "Parameters" - opens dialog of transformation parameters where you can change scale and angle of 

rotation. 

Two extra options appear at this stage: 

 

Model scale correction (enabled by default). This option is available only for “move” transformations 

automatically created for the detail view. When this option is enabled, the assigned scale value is 

replaced by the calculated scale as follows: 
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The resulting scale = 
Assigned scale  

Scale of original page 

Thus, the scale of original page is considered in the movement result. This allows you to obtain correct 

image of detail view when scaling is used on the original page. 

 

Consider page scales. This flag can be used for the drawing views created with the option , when 

scale of the original page and view page differ from 1:1 and do not match. When this flag is enabled the 

resulting view scale will take into account the scale of both pages: 

 

Resulting scale = 
Assigned scale* Scale of drawing view page 

Scale of original page 

Setting this parameter allows you to achieve the correct correspondence of element sizes between the 

original drawing page and drawing view. 

Adding to and modifying the image of drawing view 

The image created by the  and  options may need modifications or additions, for example, add 

chamfers, rounds, clipping line, or place dimensions). One shall keep in mind that these options create 

graphics based on the XM: Copy with translation functionality, therefore, it is subject to all rules and 

limitations imposed on direct use of this command. Thus, only graphic lines, hatches, 2D fragments and 

projections are copied. The snapping nodes of the copied lines can’t be modified. The copied elements 

can only be deleted, hidden by the command ESO: Hide/Show Elements, or their parameters modified 

(for example, lower the level). Besides, these can be used for snapping the construction lines (see the 

chapter “Lines”) for new element creation. Therefore, if editing a view involves modifying existing graphic 

lines, two ways of handling are possible: 

 

1. Break association of the copies with the original elements using the command Explode Copy 

of the context menu. As associations are broken, free nodes are created, thus turning the 

graphics on the view into a sketch suitable for modifications. One should keep in mind that 

further modifications of the original elements of the drawing will not propagate on the 

drawing view graphics, thus breaking its parametric behavior. 

2. Create new graphic lines based on the copies. To do this, first create construction entities 

snapped to the copy entities. Then, hide the entities of the copy if necessary. Instead of the 

hidden lines, create new ones by snapping to the newly created construction entities.  
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Clipping image by an arbitrary hatch 
 

The image created by the option  can later be clipped by 

an arbitrary hatch, using the context menu command Edit 

Copy. 

In the following example, a new (detail) drawing view is 

created using the  option. Let’s clip it by a hatch and an 

additional clipping line. 

Original image of the detail view 

 

 

To edit the drawing view, let’s activate its page. Both the hatch 

for clipping the view and the clipping line shall preferably be 

defined based on the same spline. 

Let’s create an invisible hatch based on the spline, using the 

command H: Create Hatch. Then, right click  over the copied 

lines and in the popping up context menu select the item 

Move Copy for calling the editing command EY: Edit Copy. 

Spline defining clipping hatch and 

clipping line 

 
 

The coming up automenu will contain an option  - “Select Clipping Hatch”. Pick this option, and then 

select the hatch. The image of the view will be clipped by the hatch as shown on the diagram. 

Note that the hatch can’t be based on the detail view elements, as their use will create a recursive 

dependency. 

The original image is now clipped by the hatch created in the previous step 

 

The final step is creating the necessary construction lines and creation of the clipping line based on the 

spline. 

The original image is bounded by a thin line. The line ends are defined by the intersection points between 

the spline and an additionally created construction line 
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Updating detail view with label 

In the context menu of detail views created with the help of the  option (detail view with label), 

additional command Update drawing view is available. It allows us to update the structure of the 

drawing view after the original image has been edited. 

 

The selection of elements is carried out in the domain of the label’s note, with the use of the current filter 

of elements. Only those elements which were created upon creation of the view or the previous update 

of the view are removed from the displayed page. The elements added to the displayed page after 

creation of the view are retained. 

Exploding Drawing View 
The command of exploding the drawing view can be found in the context menu of the view in the 

command wait mode. 

As a result of exploding, the object “drawing view” is removed. In the same space, a group of standard 

elements of 2D drawing (nodes, graphic lines, etc.) resembling the image of the given view is created. If 

the drawing view image contains dimensions, then after exploding the view, the scale of the dimensions 

is modified in such a way that dimension’s value remains unchanged. 

When exploding the drawing view, whose contents is clipped by hatch (for example, when the drawing 

view was created as “Detailed Drawing View with Caption”), the following rules apply:  

lines clipped by hatch (for example, lines of associate copy) are replaced by standard graphic lines 

shortened according to the clippings on the view; 
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 fragments clipped by hatch are copied into the resulting set of elements together with the 

clipping hatch; 

 hatches, clipped on the original view, disappear after exploding the view. 

Upon exploding, the page with the view can be removed or retained in the document. A query about the 

necessity of removal is sent. 



Pictures 

619 

P ICTURES 

Pictures 

You can add to a T-FLEX drawing vector or bitmap images stored in files using different graphic formats 

– grb (T-FLEX CAD drawing), bmf (T-FLEX Metafile), bmp (Windows Bitmap), wmf (Windows Metafile), 

emf (Enhanced Windows Metafile), JPEG (Joint Photographic Experts Group), GIF (Graphic Interchange 

Format), DIB (Device-independent bitmap), and images in the TIFF, PCX and TGA formats. 

T-FLEX CAD Metafiles are graphic images of T-FLEX drawings, they do not require parametric 

regeneration and are quickly displayable on the screen. Those are stored on disk with the 

extension “.BMF”. Metafiles can be generated in the command EX: Export or produced by an 

animation (the command AN: Animate Model). 

Such images can be inserted using various scale, rotated various angles and fixed to nodes, which helps 

parametrically define their position on the drawing. Unlike fragments, pictures themselves are not 

parametric, do not use variables or special fixing elements. 

Transparent font color can be set for bitmap pictures. 

Connection with Source File. Links Mechanism 
Pictures, just like fragments and databases, use the links mechanism that allows managing relations of 

objects with their source files. A picture is related with an object by a “link” that indicates the source of 

external data. 

Recall that the object of a link can be external (external file) or internal (a picture copied from internal file 

and saved inside the main document, fragment document etc.). Links management is done by the 

command AL: Links to other files…. 

Links to files are used for 2D and 3D fragments and pictures. The command File > Assembly > 

Update links updates all links to files. 

By default an inserted picture uses an “external link” to the source file. By changing the link to embedded 

(in the command AL: Links to other files…), you can save the picture directly in the drawing file (without 

relation to the source file). 

Internal document-picture can be generated automatically right after inserting the picture. In this case a 

created picture will be at once connected with two links: a link to an external document (source file) and 

to an internal document. Such picture will function as an internal one, keeping the image of the source 

document in the form that the image had at the moment of insertion, but updating an internal image 

from the source file in case of need will still be possible. 

 

Pictures on the basis of files “*.grb” are always generated as internal ones with the preserved connection 

with the source file. 
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Methods of Fixing on Drawings 
The position of a picture on the drawing can be defined by the following methods: 

By two corner fixing points. The graphic image of a picture is bounded by a box. By defining two 

opposite corners of this box on the drawing, you can change the position and size of the picture’s image 

on a drawing. The original aspect ratio of the picture is not preserved in this way. The picture is fit in the 

specified box. 

 

    

The corner points of the picture can be fixed to nodes on the drawing. This will allow parametric control 

over the position and size of the picture's image. Additionally, one can specify an angle of the picture’s 

rotation about its center. 

 

By one point, rotation angle and scale. In this case, just one reference point is used for fixing. As in the 

previous method, the fixing point can be related to a node on a drawing. 
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Creating Picture 
To insert a picture in a drawing, use the command IP: Insert Picture: 

Icon Ribbon 

 

Draw → Title Block → Picture 

Keyboard Textual Menu 

<IP> Construct > Picture 

 

After calling this command, the options for creating the picture will appear in the automenu, and the 

command's properties dialog box — in the properties window. 

 

Choosing source file and fixing method 

First of all, it is necessary to choose the source file of the picture being created. This can be done with the 

help of the button  in the command's properties window or with the help of automenu option: 

 

 <М> Select File 

Files can be selected either from the T-FLEX CAD library or just from any folder on the disk. 

 

A picture name can be variable. For this, you shall use a text variable as the picture name. 

If the current document (in which the picture is generated) contains internal pictures, the symbol 

manifesting the existence of the drop down list will appear next to the icon of the option <M>. Another 

method for selection of the picture source can be picked from the drop down list: 

 
 

 <E> Select Embedded Document 

In this case the generated picture will not have the external source file.
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The name of the selected/internal document will be shown in the command's 

properties window (to the left of the button ). 

 

If the picture is inserted from a library, then the name of the library is entered 

in the corner brackets, for example, “<Schemes>Graph node”. If the library 

name in the corner brackets is omitted, the picture is taken from the same 

library as that in which the drawing is located. 

Grey (not accessible for editing) field, located a little below is informational 

and shows the absolute path to the file from which the picture is taken. 

Upon picture insertion, as a file with bitmap image, a page being inserted 

from the source document can be selected in the command's properties 

window (parameter “Displayed Page”). 

 

The fixing method for the inserted picture (by two points or by one point, angle and a scale) is selected 

in the dialog box of the properties window (parameter “Fixing Mode”). 

Fixing picture by two points 

After choosing the fixing method (parameter Fixing Mode > 

2 Points in the command's dialog box) it is necessary to 

successively indicate location of two fixing points of the 

generated picture. This can be done with the help of  in the 

drawing's window or by indicating the exact values of the 

coordinates in the command's properties window. 

Upon defining fixing points, it is possible to select nodes of the 

drawing with the help of the option: 

 

 

 <N> Set relation with Node 

When the second fix point has been defined, the creation of the picture is automatically completed. 

 

After defining location of the first fixing point, it is possible to finish creating the picture by pressing  

(in the automenu or in the properties window). In this case, location of the second fixing point will be 

determined by the system automatically (on the basis of the initial size of the inserted picture). 
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Fixing picture by point, angle and scale 

Upon inserting picture by one point, angle and scale, the fixing 

point is defined first. Note that in the command's properties 

window location of the fixing point can be selected with respect to 

the box of the picture (parameter Fixing Point). 

Location of the fixing point can be assigned directly in the 

drawing's window with the help of  or by prescribing exact values 

of the coordinates in the command's dialog box. With the help of 

the option  it is possible to fix picture to a node. 

"Fixing point" indicates which one of the characteristic points of 

the picture rectangle will be combined with the given fixing point. 

Selection of another characteristic point from the drop-down list 

of this parameter allows you to change the final location of the 

image on the drawing. The same can be done with automenu 

option: 

 
 

 

 Fixing point 

After indicating the fixing point, the picture's contour takes the position in accordance with the 

parameters (angle of rotation and a scale), prescribed in the command's parameters dialog box (be 

default, angle of rotation is set to be equal to 0, and scale is 1). At this point it is possible to finish 

creation the picture by pressing , but it is also possible to preliminarily change the scale, angle and 

even location of the picture with the help of special markers, located at the corners of the picture’s box. 

Note that upon fixing by a point, angle and scale, rendering the picture can be completed only by 

pressing . 
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Scale and angle of rotation of the picture can be also prescribed in the dialog box of the properties 

window (parameters Scale and Angle of rotation). 

 

Creating Internal Picture with Preserved Connection with Source File 
To create an internal picture, right upon its insertion it is necessary to turn on 

the flag Create Internal Document under the group Options found in the 

command's properties window.  

Setting Transparent Color 
Prescribing transparent color is possible only for bitmap pictures. Transparent 

color can be set in two ways: with the help of a special list of colors in the 

command's properties dialog box (this list becomes available only upon 

activating the flag Transparent Background) or directly in the drawing's 

window with the help of the following option of the automenu: 

 

 

 <T> Select Transparent Background Color 

This option lets a user select color directly from the screen by pointing at the desired region of the 

drawing. 

Repeated Picture Insertion 
For repeated picture rendering it is convenient to use the following options of the automenu: 

 <R> Repeat Last Picture Insertion 

 <F> Select Picture to Insert Copy 

The option  enables to repeat multiple insertion of the last picture created in the given document. By 

default, parameters of the new picture will be assigned the same values as those of the last inserted 

picture. 
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The option  enables to repeat insertion of any of the previously inserted pictures many times. After 

calling this option it is necessary to point at the source picture with the help of . 

Editing Pictures 
A picture’s position and size can be modified, or the picture deleted altogether, in the command EP: Edit 

Picture: 

Keyboard Textual Menu Icon 

<EP> Edit > Draw > Picture  

Upon calling the command, the following options become available in the automenu: 

 <R> Select element from list 

 <*> Select all elements 

 <Esc> Exit command 

To select a picture, point to its image and click . Selection of several pictures can be carried out via a 

window or with the help of the key combination left <Shift>+  (adding elements to a list of chosen 

ones) or left <Ctrl>+  (removing an element from the list). After selecting one or more pictures, the 

following icons become available: 

 <P> Set Picture Parameters 

 <Del> Delete selected element(s) 

 <I> Select other element 

 <Esc> Cancel selection 

Editing Single Picture 

If a single picture is selected, it becomes outlined. The appropriate characteristic points and markers will 

be highlighted with the outline, depending on the fixing mode. 

Editing Picture Inserted by Two Fixing Points 

If the picture was put on the drawing using two fixing points, then the points defining the picture 

position on the drawing will be highlighted. By modifying the fixing point positions, you can change the 

picture location and size. Moreover, at the upper left corner of the picture there will be a picture 

movement marker, with the help of which a movement of a whole picture can be performed. 

To modify the picture size, move the mouse to the desired fixing point and click . The picture’s outline 

will start rubberband. One of the corners of the outline will be “tied” to the pointer, while the other stay 

still. Next, move the pointer to the desired position and click . After that, the picture will redraw per its 

new sizes. If the selected fixing point was fixed to a node, this fixing will be broken after the move. 
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Upon movement of the fixing point, the following option will be available in the automenu: 

 <N> Set Relation with Node 

  

To move the picture with the help of the movement marker, it is necessary to bring the cursor to the 

pointer, press , drag the cursor to the desired location and press  again. If the fixing points were 

initially fixed to nodes, then, upon moving the picture, their relations with those nodes will be broken. 

The picture’s rotation angle can also be defined in the two-fixing-points mode in the properties window. 

Editing Picture Inserted by One Fixing Point, Angle and Scale 

In case when selected picture was put on the drawing with the help of one fixing point, angle and scale, 

the fixing point as well as the markers for setting picture's movement, scale and angle of rotation will be 

highlighted. The markers enable to change position, angle of rotation and size of the image directly on 

the drawing. 

The location of the fixing point will be determined by the value of the parameter Fixing Point in the 

command's properties window. If this parameter is modified, another fixing point will be highlighted on 

the drawing (corresponding to the selected value of the parameter). 

Detailed description of working with markers was provided in the chapter “Drawing view. Detail 

Views”. 

    

The exact numerical values of the rotation angle and picture scale can be defined in the picture’s 

parameters dialog box (the option ). The same dialog allows modifying the picture’s fixing method. 
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Editing Several Pictures 
If multiple pictures are selected, you can modify their parameters (level, layer, priority). You can also 

delete the selected pictures from the drawing. 

Updating Internal Pictures 
If upon creating a picture in the command's dialog box the flag “Create Internal Document” was turned 

on, then such picture will be connected with two links: the first link will refer to the external source file of 

the picture, the second one – to, created upon insertion, the internal (i.e. stored inside the current 

document) copy of the file. Upon recalculations, an internal copy of the source file will be used for 

updating the picture. This means that picture will preserve the form which the source document had at 

the moment of creating a picture. 

For updating the picture from the external file, it is necessary to select a desired picture in the command 

waiting mode and call the context menu with the help of . For the internal picture, which maintained 

connection with the external source file, the command Update File Data will be accessible from the 

context menu. 
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GROUPS OF ELEMENTS 

Group – is a named logical union of several elements created by arbitrary rules. Grouping allows us to 

work with heterogeneous elements as with a unique object: select, move/copy as a whole object, specify 

common properties, etc. Grouping allows us to arrange the structure of a drawing (a 3D model) and 

avoid undesired editing of its individual elements.  

Both 2D and 3D elements can form the groups.. 

General Principles of Work with Groups 

Groups of elements in the documents of T-FLEX CAD can be created in two ways:  

 Manually by the user with the help of the “EU: Edit groups of elements” command; 

 Automatically by the system when various actions are performed, for example, when 2D 

copies, 2D fragments, and drawing views are unfolded, 2D projections are broken. This 

method of creation of groups will be described in more detail in the “Automatic Creation of 

Groups” section. 

Each group in the document has a unique name. Groups created by the user by default are assigned the 

names of the type “Group_0”, “Group_1”, etc. This name can be changed to a more informative one in the 

command of editing/creation of groups. 

Any object of the drawing or of a 3D model can belong only to one group. Moreover, both 2D and 3D 

elements can be combined into a single group. The group itself can be included into another group, thus 

creating a hierarchy of groups of arbitrary complexity. 

The system will work with objects combined into a group as with a whole. If the cursor of the mouse is 

moved across the screen to an element, which belongs to some group, the entire group will be 

highlighted on the screen. When selecting an element belonging to the group, all elements of the group 

will automatically be selected.  

If necessary, any element of the group can be selected individually. To do so, use  +with pressed key 

<Alt>. For the element of the group selected in this way, it is possible to change properties and even 

geometric parameters. 

 

The structure of groups can be edited by adding new elements to them or by deleting already added 

elements. The elements removed from the structure of the group remain in the drawing or in the 3D 

model and the user can work with them as with independent objects. 

Command for Working with Groups 

For creation and deletion of groups, editing its structure, use the “EU: Edit groups of elements” 

command: 
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Icon Ribbon 

 

Draw → Additional → Groups 

Keyboard Textual Menu 

<EU> Construct > Groups 
 

The window of properties of this command contains two lists. The 

upper list – “Groups of elements” – shows the list-tree of groups 

created in the current document. In the root list of the tree, all main 

groups of the current document are located. The folders, which can be 

expanded, contain the embedded groups (groups included into other 

groups). 

The lower list (“Structure of group…”) displays the contents of the 

group selected in the upper list. A group can be selected by pressing 

  on the group's name. The elements included into the selected 

group are also highlighted on the drawing or in the 3D scene 

(depending on what sort of windows are opened in the current 

document).  

If in the current document none of the groups were created, both lists will be empty. 

In the automenu of the command, the following options for invoking various modes are available: 

 <G> Group 

 <U> Explode group 

 <Y> Set name 

 <E> Edit&Copy 

 <Esc> Exit command 

The  option allows us to create a new group. The  option – ungroup an already existing group, i.e., 

make all elements included into it independent objects. In this case the group itself will be deleted. 

The  option is used to specify a new name of the group. 

The  option allows us to modify the structure (i.e., add or delete elements) of the selected group. 

Grouping (Creation of New Group) 

After invoking the  option, the command will enter the mode of creation of a new group. In the 

window of properties of the command, in the list of groups, the new group will appear under the 

standard name “Group_№”. When entering the mode of editing, at the header of the list of elements the 

name of the new group will appear. The list of elements itself will remain empty.  
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New group  will always be created at the upper level of the structure of groups (at the root of the 

tree of groups). 

In the automenu of the command, the following options will become available: 

 

<Ctrl> 

<Enter> 
Finish selection of elements 

 <M> Mode of addition of elements 

 <M> Mode of deletion of elements 

 <Y> Specify name 

 <Esc> Cancel editing 

By default, in the automenu the  option will be active, i.e., the mode of addition of elements to the 

group being created will be enabled. The elements can be selected by pointing at them in the window of 

the drawing or of the 3D model, and also in the tree of the 3D model (for 3D elements). The selected 

elements will be displayed in the list of elements of the group in the window of the command's 

properties. 

Note that when selecting the elements, the filters in the system toolbar are active. 

To correct a wrong selection, the mode of deletion of elements can be used (the  option). The 

elements which are specified in the given mode are excluded from the list of the selected elements. Only 

the elements that are already added to the group being edited can be selected. The state of the filters of 

the selector is also taken into consideration when making a selection. 

If necessary, it is possible to change simultaneously the name of the 

group being created with the help of the  option. After invoking this 

option, the command enters the mode of editing the text of the group's 

name. The new name of the group can be typed directly in the list of 

groups. The editing of the name can be completed by pressing  outside 

the box with the edited text.  

 

The name of the group can also be modified outside the mode of creation/editing with the help 

of the analogous option in the main menu of the command. 

Creation of a group can be completed with the help of the  option (in the automenu or in the 

properties window). After pressing  the command returns to the main mode of work. 
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Ungrouping and Editing a Group 
For editing an already existing group, it is necessary to select the desired group in the list of groups and 

invoke the  option.  The work in this mode is carried out exactly in the same way as in the mode of 

creation of a group.  

Note that if in this mode all elements from the structure of the group are deleted, the group itself is not 

deleted. Later such an “empty” group can be edited again by adding to its structure the new elements. 

To remove the group, it is necessary to use the .  

Working with Groups with the Help of Context Menu 

All modes of operation of the “EU: Edit groups of elements” command are accessible directly from the 

context menu upon selection of elements outside the command. 

Commands for working with groups are combined into the “Groups” submenu. Depending on the set of 

elements for which the context menu was invoked, it can contain the following commands: 

 Group…. It launches the groups editing command in the mode of creation of a new group; 

 Ungroup. It  ungroups  (deletes) the selected group/groups; 

Edit groups… (available upon selection of only one group). It launches the groups editing command in the 

mode of editing of the structure of the selected group 

Automatic Creation of Groups 

Automatic creation of groups is offered by the system in the following cases: 

 when creating complex elements of the draft (polygons, rectangles …). Capability of 

creation of such a group is controlled with the corresponding flag in the window of 

properties of the given mode of draft creation; 

 when creating a 2D array, if a group is selected as one of the initial objects of the array. In 

this case, by default, the new group is created that includes elements-copies of the array 

obtained on the basis of elements of the initial group. If two groups were selected for 

copying, two more groups will be created, etc.; 

 when unfolding fragments, projections, drawing views, copies and arrays. In this case, the 

system generates an additional window-warning with the suggestion to combine the 

resulting elements into a group. The group will be created in case of positive answer of the 

user. 

When unfolding a 2D array, the number of created groups depends on the command being used 

– “Explode” or “Explode Keeping Relations”. In the first case, one group is created that includes all 

elements belonging to the array. In the second case, elements of each copy of the array are 

combined into an individual group. This implies that the number of resulting groups is equal to 

the number of copies in the array.  
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If elements of the array/copy that is unfolded were already combined into groups (for example, 

upon creation of an array), these groups are removed and the new groups are created. 
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MOVING AND COPYING DRAWING ELEMENTS. ARRAYS. 

USE OF CLIPBOARD 

T-FLEX CAD provides two main mechanisms for creating new 2D elements based on existing ones. 

The first mechanism relies on moving, copying and array creation commands. This group of commands 

unites all functions related to translating, scaling, using symmetry and rotating arbitrary 2D elements, as 

well as creating various types of associative and independent copies, including linear and circular arrays. 

Moving/copying of elements can be done within the current page of a T-FLEX CAD document or from 

one page to another one. 

The second mechanism uses copying via the clipboard that is a somewhat extended functionality in T-

FLEX CAD as compared with the standard Windows clipboard management. This mechanism only 

supports non-associative (independent) copies. However, it supports copying between different 

documents within the same T-FLEX CAD environment, as well as exchange with other applications. 

Any T-FLEX CAD 2D elements can be handled by either of the moving/copying mechanisms, except those 

specifically mentioned in the respective sections (for example, multi-page text and BOMs cannot be 

copied or moved). 

MOVING,  COPYING AND ARRAY CRE ATION COMMANDS  

A family of commands is provided in T-FLEX CAD for moving, copying and array creation. These 

commands are used for transforming existing drawing elements and making various types of copies, 

including multiple (arrays). All commands have similar interface and underlying mechanism that allow 

easy switching from one command to another while keeping the same set of selected objects. These 

commands also interact with object snapping described in the chapter “Sketch. Creating a Non-

parametric Drawing”. Upon calling any of the commands, the toolbar is displayed for object snapping 

management. 

The commands are divided into three large groups by their purposes: 

The commands for moving (for modifying the existing elements – translation TM: Move, rotation 

TT: Move and Rotate, scaling TA: Move and Scale, symmetry TS: Move with symmetry); , translation 

with rotation TP: Move with translation and rotation); 

The commands for creating copies (copying with translation XM: Create Copy, copying with rotation 

XT: Copy and Rotate, with scaling XA: Copy and Scale, creating copies symmetrical to the original 

elements XS: Create Symmetry); and copying with translation and rotation XE: Copy with translation 

and rotation); 

Array creation commands (linear XL: Create Linear Array and circular XR: Create Circular Array). 

Since the interface of all the commands is identical, the further description will be as general as possible, 

covering all moving, copying and array creation commands.  
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Calling the Commands 

The commands for moving elements are available under the textual menu entry Edit: 

Keyboard Textual Menu Icon 

<TM> Edit > Move > with Translation 
 

<TT> Edit > Move > with Rotation 
 

<TA> Edit > Move > with Scale 
 

<TS> Edit > Move > with Symmetry 
 

<TP> 
Edit > Move > with Translation and 

Rotation  

You can find the commands in Draw → Additional in the Ribbon. 

 

The copying and array creation commands are grouped under the menu entry Draw: 

Keyboard Textual Menu Icon 

<XM> Draw > Copy >  with Translation 
 

<XT> Draw > Copy >  with Rotation 
 

<XA> Draw > Copy >  with Scale 
 

<XS> Draw > Copy >  with Symmetry 
 

<XE> 
Draw > Copy > with Translation and 

Rotation  

You can find the commands in Draw → Additional in the Ribbon. 
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Keyboard Textual Menu Icon 

<XL> Draw > Array > Linear Array 
 

<XR> Draw > Array > Circular Array 
 

You can find the commands in Draw → Additional in the Ribbon. 

 

Upon calling any moving, copying or array creation command, the first step will always be selecting the 

objects for moving or copying. The following options will be provided in the automenu: 

 <End> Finish element selection 

 <M> Add elements  

 <M> Remove elements  

 <I> Select Other Element 

 <Esc> Exit from editing of selected Elements list 

Any T-FLEX CAD 2D elements are available for selection. Elements can be selected by box and/or using  

under the active option . Selection can be canceled in the same way with the active option . To 

speed up the process, you can use the transparent mode of switching between adding and removing 

elements: pressing the <Ctrl> inverts the current mode. This means, if the current active option was , 

pressing <Ctrl>+  will be removing the elements from the selected set, and vice versa, with the active 

option  pressing <Ctrl>+  will result in adding the picked elements to the set. To complete the 

selection, use the option . 

After selecting the objects for moving/copying, the system will switch to the main automenu of the 

specific command. 

The commands can also be called from the context menu when selecting one or several 2D drawing 

elements. In any case, the main automenu of the selected command will appear at once in this case. All 

the objects that were selected at the time of calling the context menu will be subject to the 

transformation. 
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The Common Options of the Moving, Copying and Array Creation Commands 

For working convenience, all moving, copying and array creation commands have similar sets of 

automenu options. 

Such options include the options for switching between the commands, the attachment point selection 

options and the options that define the action upon the completion of the current transformation. 

Options for switching commands  
The automenus of all moving, copying and array creation commands include the options, whose 

composition defines the current command. These options are used for quick switching between the 

commands while keeping the selected set of objects.  

The moving, copying and array creation commands differ primarily in the type of the transformation and 

its mode. The transformation mode is either moving (modification of the selected elements) or copying 

(creation of new elements based on the selected). The type of transformation defines the kind of change 

between the original position and the target position. This can be a translation, rotation, scaling, 

translation with rotation, creation of a linear or circular array. Thus, for example, the combination of the 

“Move” mode and “Translate” transformation makes the command TM: Move, while the “Copy” mode in 

combination with the same transformation makes the command XM: Create Copy with translation. Note 

that the array creating transformations always make copies. 

The kind of transformation is defined by the first automenu option  that contains the enclosed list: 

 <Ctrl+M> with Translation 

 <Ctrl+T> with Rotation 

 <Ctrl+Q> with Scale 

 <Ctrl+U> with Symmetry 

 <Ctrl+R> with Translation and Rotation 

 <Ctrl+L> Linear Array 

 <Ctrl+K> Circular Array 
 

The default automenu option corresponds to the current command. 
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The current transformation mode is defined by the following options: 

 <C> Move 

 <R> Copy 

You can turn on only one option at the time: pressing one option automatically undoes the other one as 

in a radio group. The current mode is defined by the active option. Setting the option  switches to 

one of the commands in the “Move” group, while setting the option  - activates a command in the 

group “Copy” or “Array”. 

If the “Linear Array” or “Circular Array” transformation is active, the options for selecting a 

transformation mode are not shown in the automenu. 

Defining base points of transformation  
When defining a transformation, you need to specify two special points - origin and target. These points 

define the transformation direction and parameter. Depending on the kind of transformation, either both 

or just one point is required. 

Origin point is the point that marks the original position of the objects to be transformed. This would be 

the start point of a translation, the center of a rotation, the center of scaling or the start point of a linear 

array. 

The origin point of a transformation can either be defined as an arbitrary point, or be selected as one of 

the characteristic points of the outlining rectangle. The outlining rectangle is a rectangular area that 

covers the extents of the set of objects selected for the transformation. Characteristic points of the 

outlining rectangle are its center, corners and the side midpoints.  

The way of defining the origin point of a transformation is selected from the following pull-down list 

under the option : 

 <Ctrl+0> Left Top 

 <Ctrl+1> Center Top 

 <Ctrl+2> Right Top 

 <Ctrl+3> Left Center 

 <Ctrl+4> Center 

 <Ctrl+5> Right Center 

 <Ctrl+6> Left Bottom 

 <Ctrl+7> Center Bottom 

 <Ctrl+8> Right Bottom 
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 <Ctrl+9> Free attachment mode (arbitrary point selection) 

The default setting is the free attachment mode . In this case, the origin point is defined by specifying 

the coordinates in the property window or by clicking  in the 2D window, or else by selecting an 

existing 2D node. To select a node, you can use the option: 

 <N> Select Node 

If the free attachment mode was selected, defining the origin point will be the first step of 

moving/copying.  

Target point is the point defining the target position of the objects after the transformation. This can be 

the end point of a translation, the end point of a linear array (defining its length and step), or the center 

of the circular array. The target point of the transformation is always defined by specifying its position by 

mouse clicking , in the property window, or by selecting a 2D node (the option ). 

Option for selecting action after the current transformation 
You can select a desired action upon completing the transformation from the enclosed list of the 

option : 

 <Alt+X> Exit Command automatically when finished 

 <Alt+O> Repeat Command for selected elements 

 <Alt+N> 
Repeat Command for created elements (available for 

copying only) 

 <Alt+A> 
Repeat Command for selected and created elements 

(available for copying only) 

 <Alt+S> Select new elements when finished 

The selected option defines the system action upon completing the original transformation: 

 - the system automatically exits the move/copy command. 

, ,  - upon the completion of the first transformation, the command instantly activates 

the mode of defining a new transformation. This will be indicated by a new set of objects for 

transformation, rubberbanding with the pointer, and the respective prompts displayed in the 

status bar (such as, “Set destination point for Move”). Depending on the selected option, the new 

set of objects for moving/copying will include either the original objects of the first 

transformation, or the objects created as a result of the first transformation, or else all of the 

above. 

 - upon the completion of the first transformation, the command switches to the mode of selecting 

objects (see the section “Calling the command from menu”). 
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Common Options of Moving Commands 

The moving commands include the translation TM: Move, rotation TT: Move and Rotate, scaling 

TA: Move and Scale and symmetry TS: Move with Symmetry, and translation with rotation TP: Move 

with translation and rotation. 

Options for selecting moving mode 

When executing any moving command (translation, rotation, scaling or symmetry), you can set various 

modes of executing these transformations. The mode selection is done in all cases by one of the 

automenu options in the list: 

 <O> Change dependent elements 

 <G> Change related elements 

 <F> Change selected elements 

Change dependent elements. The selected elements are moved together with their parents and 

immediate dependents only. 

                        

Change related elements. The selected elements are moved together with all objects related via 

parents or dependents. 

                        

Change selected elements. Only the selected elements are moved, separated from parents and 

dependents. 
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In complex cases, when it is impossible to break a relation between the element and its parents and/or 

dependents, the following exceptions from this rule are possible: 

If the selected object can't be separated from a parent, a copy of the parent is created, that moves 

together with the selected object. The original parent element is left unchanged; 

If the selected object cannot be separated from a dependent, then the object is moved, while its copy is 

created in the original position to which the dependent is attached; 

If the selected objects have a common parent construction entity that cannot be moved (such as a node 

or a construction line), and the parent does not have any other dependents that cannot be moved, 

then the parent is moved along. 

Dynamic model regeneration mode 
When defining various types of moving in the modes “Change dependent elements” and “Change 

related elements”, you can turn on the dynamic model regeneration mode to view the modifications of 

the elements related or attached to the selected ones (the selected elements themselves are always 

updated dynamically). To turn on this mode, use the option . 

Options for handling variables 
If the original position of the selected elements (or the elements used for defining the selected ones) was 

driven by variables, use the options  and  when moving the elements. These options cannot be 

used together. When one is engaged, the other becomes inaccessible.  

If none of these options is active, then after selecting the new 

position for the elements being transformed, a message is 

displayed on the screen, prompting the user for modifying the 

value of the respective variable. Pressing the [Ok] button 

completes the transformation with updating the variable. 

Pressing [Cancel] aborts the transformation. In the case when 

several variables are affected, the prompts   

will be displayed subsequently for each of the variables. Checking the item “For all variables” in one of 

the prompt windows confirms adjustment of all the rest of the variables without querying. 

With the option  turned on, the values of the respective variables are adjusted without querying. 

The option  replaces all the variables used for defining the coordinates of the transformed elements 

by their respective values. The variables themselves are not deleted from the model. The variables related 

to other element parameters are not affected by moving. 

Common Options of Copying and Array Creation Commands  

This section covers all the commands that allow creating copies of the selected objects. Those are the 

commands for copying with translation XM: Create Copy, copying with rotation XT: Copy and Rotate, 

copying with scaling XA: Copy and Scale and creating symmetrical objects XS: Create Symmetry, and 
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copying with translation and rotation XE: Copy with translation and rotation as well as the array creation 

commands XL: Create Linear Array and XR: Create Circular Array.  

Options for selecting copying modes 
When executing any copying command, one can use various copying modes. The mode selection is done 

in all cases by one or the automenu options in the list: 

 <F> Create Associative Copy 

 <J> Create Copy on Associated Constructions 

 <G> Explode Copy keeping relations 

 <O> Explode Copy 

Create Associative Copy. This option creates an associative copy, whose elements maintain the 

relation with the original parent elements. The copied elements will automatically adjust, as the 

original elements are modified. 

Create Copy on Associated Constructions. For selected construction elements the associated 

copies are created. Copies of the drawing elements are detached from the original parent 

elements and snapped to the copies of the construction elements. If this mode is used while 

creating rectangular or circular arrays, the drawing elements will be created only at the moment 

of array creation. Increasing the number of elements in the array does not lead to appearance of 

new graphics lines and other drawing elements. 

Explode Copy keeping relations. The created copy operation is automatically destroyed. The 

elements created by this operation become independent from the original parent elements. 

However, the internal relations are maintained between the resulting objects similar to those that 

existed between the original elements. The relations with variables are maintained if the variable 

values are not affected. Otherwise, the variables are replaced by constants. 

If a copied object has a parent that was not among the set of the objects to be copied, then upon 

destroying the copy operation, a copy of the parent element will be created that will move 

together with the selected object. To prohibit this, turn on the additional option: 

 <Alt><T> Copy only selected elements 

With this option turned on, the system tries to separate the objects being copied from their 

parents that were not included in the set of the objects to copy (similar to the mode “Change 

selected elements” in the moving commands). 

Explode Copy. The created copy is automatically broken up into the separate unattached objects. 

The copied construction elements become stand-alone objects, regardless of the ways of their 

parent element creation. All variables that were driving the parameters of the original elements 

are replaced by constants in the new elements.  
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For successful copying of the detailing elements (dimensions, leader notes, roughness symbols, 

tolerances, etc.) in the modes “Create Associative Copy” and “Explode Copy”, make sure that the 

set of the objects to be copied includes the elements and their parents as well. Otherwise, the 

copy will not be created. To avoid this, let the system automatically append the selection with the 

required parent elements by including those in the set of objects to be copied. This mode is 

turned on by the additional automenu option: 

 <K> Auto selection of required parents 

Attachment node creation option 

When creating associative copies and arrays, selecting an existing 2D node (the option ) as a base 

point of the transformation automatically establishes a relation between this base point and the selected 

node. As a result, the position of the base point will change according to modifications to the node 

position, causing repositioning of the whole copy. If the necessary nodes do not exist, those can be 

created automatically using the option: 

 <T> Create Node at point 

When the option is turned on, a 2D node is created automatically at the point of the mouse click when 

defining the base points of the transformation. The base points become attached to this node. 

Translation 

To define translation or copying with translation, specify the start point (the origin point of the 

transformation) and the end point (the target point of the transformation). If using the mode of 

automatic origin point location based on characteristic points of the outlining rectangle, you shouldn't 

define the start point. The transformation is performed by carrying the start point over the end point. 

Additionally, you can change the scale and the rotation angle of the 

translated image in the property window. Option Scale Elements Font 

controls scaling of the drawing elements added to the copy set. When the 

flag is on font size of all elements being copied will be scaled according to 

the assigned scale factor. When the flag is off, font size remains unchanged. 

The flag does not affect font size of the text being copied – it is always scaled. 

When defining the end point of the transformation, you can restrict pointer 

movements by snapping to the coordinate axes. This helps defining a vertical 

or horizontal transformation. The related options are  and . Turning on 

either option allows pointer movements along the respective axis. When 

turned off,  the  option  prohibits  movements  in the  respective  direction.  

With  both 
 

options turned off, the moving (copying with translation) can only be done among the pages without 

changing the coordinates of the object being translated. 
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                   or  

Rotation 

When defining a rotation, three points are specified in a 

general case: the center of rotation (the attachment 

point), the start point and the end point. Rotation is done 

about the specified center. The rotation angle is defined 

as the angle between the vectors constructed from the 

rotation center to the start and end points. 

The value of the rotation angle can be specified 

numerically or by a variable in the property window. 

When using the mode of the origin point automatic 

definition based on characteristic points of the outlining 

rectangle, the rotation center is defined automatically. 

 

                                              

     or      
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Scaling 

When scaling and image, you need to specify the three points, just as in the 

case of rotation: the center of scaling, the start point of scaling and the end 

point of scaling. 

The center of scaling is determined automatically in the case of using the 

mode of automatic definition of the origin point based on the characteristic 

points of the outlining rectangle. 

The scaling factor is computed as the ratio of the distances between the center 

and the end point and between the center and the start point. 

The scaling factor can also be defined numerically or by a variable in the 

property window. 

Scale elements font flag controls scaling of the drawing elements (analogous 

to the flag with the same name for Translation).  

                                        

     or       

Symmetry 

To define symmetry, specify just the symmetry axis to mirror the selected object about. The axis can be 

defined by either selecting an existing straight line or segment using the option , or by defining two 

points for the symmetry axis to pass through. Existing 2D nodes can be used as the points. 
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     or     

The options  and  help speed up definition of 

horizontal/vertical symmetry axes. Both options are active by 

default. This means, an arbitrary axis can be defined (you need 

to specify two arbitrary points or an arbitrary straight 

line/segment). Undoing one of the options turns on the mode 

of creating a horizontal/vertical axis. The remaining active 

option defines the axis being:  -horizontal,  -vertical. In 

this case, simply select one point for the symmetry axis to pass 

through. 

When mirroring text, you can check the additional flag 

“Symmetrical Text” in the property window. When the flag is 

cleared, only the text position is affected by the symmetry. 

When set, the text contents are also mirrored symmetrically. 

 

Moving with Rotation 

For creation of translations with rotation or of analogous copying it is 

required to specify: 

 initial point (this is an initial point of transformation and the first 

point of the initial direction vector); 

 initial direction vector (the end point of a vector is specified); 

 end point (this is a target point of transformation and the first 

point of the final direction vector); 

 final direction vector (the end point of a vector is specified). 

If the mode of automatic determination of the initial point on the basis of 

one of the characteristic point of the encompassing rectangle is enabled, the 

initial point is not specified.  
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Transformation is carried out by translating the initial point to the end point (target) and rotating with 

respect to the end point at an angle between the initial and final direction vectors. In the properties 

window you can specify the magnitude of angle of additional rotation (it is added to the angle specified 

by the vectors). 

In addition, in the properties window it is possible to change the scale of the image being translated. The 

Scale font size of formatting elements flag allows us to control the scaling of the formatting elements 

that are included into the set of copied objects. 

                          

     or      

Linear Array 

To create a linear array, you need to specify two points: the start (origin) and the end (target). 2D nodes 

can be used as points: the existing ones (the option ) or the ones automatically created using the 

option . When creating an associative array (the option ), it will be attached to the nodes 

automatically. The specified points define the direction vector of the array and its step, length or the 

number of copies, depending on the way of defining the array. The copies will be positioned along the 

array direction vector. 

After defining the first point, the array elements start rubberbanding on the screen. Their number 

depends on the default setting of the number of copies in the property window. To complete the array 

creation, simply select the position of the end point. 

The start point of the array is determined automatically in the case of using the mode of automatic 

definition of the origin point based on the characteristic points of the outlining rectangle. 
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The array can be two-dimensional, that is, composed of 

several rows. The rows are created in the direction orthogonal 

to the direction vector. The number of copies in the direction 

orthogonal to the specified vector (that is, the number of 

rows), and their parameters (the step or the total length) can 

be defined among the array parameters in the property 

window.  
 

The group Columns defines the parameters of the 

columns in the linear arrays (the copies positioned 

along with the direction vector): 

Mode. Sets the definition mode of the linear array: 

“Number of Copies and Step”, “Length and Step”, 

“Number of Copies and Length”.  

Depending on the selected definition mode, the 

distance between the points specified at the array 

creation can be defining, respectively: the step (the 

number of copies is always defined by a numerical 

value); the step or the length, at user’s choice; the total 

length of the array (the number of copies is again 

defined by a numerical value).   

The values of the step and the total length of the array can be defined by numerical values in the 

property window as well (the parameters Step and Length). To do this, check the flag next to the 

desired parameter. The specified points will in this case define the array direction only.  

The number of copies is always defined by a numerical value using the parameter Copies. The original 

elements are included in the count of copies. The accessibility of parameters Copies, Step and Length is 

determined by the selected mode of defining the array. 

The group of parameters “Rows” defines the respective parameters of the rows of a linear array.  

                              

Circular Array 

To create a circular array, after selecting the objects to copy you need to specify the center point of the 

array. You can specify a 2D node as the center using the option . The option  allows creating a 

node in the specified point with automatic attachment to that node (for the associative array). After 
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selecting the objects to copy and before specifying the center of the array, the array elements 

rubberband on the screen. The number of elements and the angle swept by the elements are defined by 

the default values. The array parameters can be modified in the property window. Here you can define: 

Mode. Sets the definition mode for the circular array: Number of 

copies and total angle, Total angle and Step or Number of copies 

and Step. Depending on the selected mode, some parameters may 

be inaccessible (computed automatically): 

Copies. Defines the total number of copies in the array, including the 

count of the original elements. 

Step. Defines the angle between the copies of the array.  

Total Angle. This parameter allows defining the total angle that will be 

swept by the array elements. 
 

                                                

Calling the Commands in Transparent Mode 

The command TM: Move can be called in “transparent mode” when one or several T-FLEX CAD 2D 

elements are selected. The elements can be selected by box and/or using <Shift>+ , <Ctrl>+ . After 

selecting the elements, simply point the mouse at one of the highlighted nodes or the border lines of the 

object being moved. The pointer then assumes the shape (when pointing to a line) or (when 

pointing to a node), that indicates readiness of the command TM: Move. 

Next, two ways of acting are possible: 

Click  and release without moving the pointer. Then move the pointer to the target point of copying 

and once again click  or press the <Enter> key. This way is convenient when moving objects from 

one page to another. 

Depress  and move the pointer while holding down the mouse button. Moving will be completed when 

the button is released or the <Enter> key is pressed. 

In either case, after first pressing of the  both of the automenu and the property window will appear as 

appropriate in the “TM: Move”. command. If necessary, you can switch to another moving, copying or 

array creation command, using the automenu or the property window. 
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EDITING COPY OR ARRAY  

All elements obtained by moving or non-associative copying can be edited as normal construction or 

graphic elements.  

The associative copies created using the copying commands are edited by the command EY: Edit Copy 

Operations. The command can be called by one of the following means: 

Keyboard Textual Menu Icon 

<EY> Edit > Draw > Copy  

Upon calling the command, select the copies to be edited. To select one copy, you can use . Multiple 

selection can be done by box selection or selection by <Shift>+ , <Ctrl>+  or by the automenu option: 

 <*> Select All Elements 

When the copies are selected, both the selected and the original elements are highlighted, as well is the 

transformation vector (or the attachment point in the cases of scaling, rotating or creating a circular 

array). 

Upon multiple selection of copies or arrays, the option is available in the automenu: 

 <Del> Delete selected Element(s) 

Selection of a single copy or array makes the following options available in the automenu: 

 <Enter> Finish Editing 

 <P> Set selected Element(s) Parameters 

 <O> Explode Copy 

 <G> Explode Copy keeping relations 

 <H> 
Select Clipping Hatch (available only for translated, 

rotated and scaled copies) 

 <K> 
Cancel selection of clipping Hatch (available only for 

copies clipped by a hatch) 

 <S> Edit copied elements list 

 <I> Select Other Element 

 <Del> Delete selected Element(s) 

When selecting a copy (an array), the property window displays the dialog for editing the copy 

parameters, similar to that used at the time of the copy creation. It allows modifying the copy 

parameters. You can use the parameters dialog box for this purpose as well, called using the option . 
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The two options -  and  - are provided for breaking up copies, that is, for converting those into a 

set of independent elements. The copy (array) itself as a T-FLEX CAD element is deleted at this moment. 

The result of applying these options corresponds with the respective modes of the copy (array) creation.  

Elements created as a result of breaking up a copy can automatically be combined into a group. By 

default the group is assigned the name of the broken copy. It is possible to refuse the automatic creation 

of the group. 

To delete a copy altogether, you can use the option . 

The option  is provided for editing the list of the original elements of the copy (array). In this mode, 

you can add the new elements to the list of the objects to be copied and delete some of the elements 

from the list of selected. 

The option  is accessible for copies created by the commands XM: Create Copy, XT: Copy and 

Rotate, XA: Copy and Scale, XE: Copy with Translation and Rotation. It allows clipping the image of the 

copy by a hatch. To do this, upon calling the option, select the desired hatch by clicking . 

If the clipping hatch is used for this purpose only, we recommend setting its 

flag “Invisible”. The diagram shows a copy image before and after selecting 

an invisible hatch for clipping. In addition to the described capabilities, the 

attachment points can be redefined for the selected copy (array).        

To do this, select one of the transformation vector ends or an attachment point by clicking  it (in the 

cases of scaling, rotating and the circular array). After that, specify the new attachment point(s). At this 

moment, the following options will be available in the automenu: 

 <T> Create Node at point 

 <N> Select Node 

After defining the new attachment point, the element being edited will be drawn according to the 

applied changes. 
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The commands for editing a copy or an array, or their 

elements, are also accessible via the context menu. Simply 

select one of the elements of a copy/array and right click . 

In the coming up context menu, the editing commands will 

be provided for the selected element, as well as for the 

whole copy or the array. 

You can change the properties of the selected element of a 

copy/array (the default properties are copied from the parent 

element). You can also delete the selected element of a copy/array 

(without deleting the copy itself). In this case, the copy/array itself 

maintains the information about the deleted element, so that it can 

be restored in the future.  
 

In the context menu of graphic lines obtained by copying, the Shorten/extend command is also 

available. This command allows us to modify the length of the visible part of the line. This function is 

described in more detail below. 

The editing commands for the copy/array itself are grouped in the context menu into a submenu, named 

according to the copy type (such as, “Move Copy”, as shown on the diagram). An additional command is 

provided among the copy/array editing commands, Restore deleted elements, specifically for restoring 

all deleted elements of the copy. 

Changing length of visible part of a line obtained by copying 
The Shorten/extend command, which is available in the context menu of graphic lines obtained by 

copying, allows us to modify the length of the visible part of the line. It is possible both to shorten and 

extend the line of the copy. However, the function of extension is only available for segments and arcs. 

The part of the line that is to be changed is indicated by 2D nodes. At first when you work with the 

command it is required to indicate the part of the line which must be modified, then – the node which 

defines the new end point of the line. For closed lines it is necessary to indicate two nodes and the part 

of the line which must remain. The 2D nodes, which are being used, can be located on the line itself or at 

some distance away from it. In the latter case the end point of the line is defined as a point on the line 

that is the closest to the selected node. 

          

The context menu for the line modified with the help of the Shorten/extend command contains the 

Reset command. It allows us to quickly restore the original appearance of the line-copy. 
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Removing original objects of copy/array 
When deleting an original element of the copy/array, two variants of the system's response are possible 

depending on the option selected in the dialog of the command of deletion. 

 

If the “Delete selected and dependent elements” option is chosen, the element that is being removed is 

simply excluded from the set of original elements of the copy/array. As a result, the view of the 

copy/array will change: the elements obtained by copying of the element that has been deleted will 

disappear. 

                            

When the “Delete only selected elements by changing the way of specifying the dependent elements” 

option is selected, the element that is being removed is also excluded from the original set of the 

copy/array. But, in addition, instead of copies that have been disappeared, identical externally free 

objects are created. This means that the result of copying visually does not change. 
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Copying between pages with different scales 
The dialog of parameters of the already created 2D copy (by 

translation, rotation, scaling – except symmetry) contains 

two additional flags: Correction for a scale of model and 

Compensate scales of pages. These flags are taken into 

account when copying between pages is performed. 

The Correction for a scale of model flag is available only for 

translations created automatically upon construction of 

taken out elements. 

 

Description of this flag can be found in the “Drawing views. Taken out elements” chapter. 

The Compensate scales of pages flag allows us to achieve the correct ratio between the dimensions of 

the elements on the original page and the resulting page of copying when the scales of these pages are 

different. When this flag is enabled, to obtain the scale of the copy, the scales of both pages are taken 

into consideration: 

Resulting scale of 

the copy 
= 

Given scale of the copy* Scale of target page of copying 

Scale of original page of copying 

By default, this flag is enabled. 

Particulars of handling variable arrays  
When modifying the number of copies in a linear or circular array, adding or deleting copies occurs in 

the position immediately before the last copy in the array. This feature helps, for instance, keeping the 

dimensions between the outer elements of the array throughout modifications to the number of copies 

in the array. The dimensions set on “inner” copies of the array may disappear as the total number of 

copies is reduced. The same is true for any 2D constructions: the elements attached to the outer copies 

of an array will always maintain the correct position, regardless of the changes to the array. 

                                                

             

When creating a hatch based on an array elements, hold on to the following technique: before creating 

the hatch, set the maximum necessary number of copies in the array. The hatch should be defined using 

the automatic contour search mode. In this case, the hatch will behave correctly in the future and will not 

“break” under any modifications to the number of copies in the array (within the initially defined range). 

In the three-dimensional modeling mode, a 2D array placed on a workplane can be used for creating a 

3D profile. The profile can be created based either on the graphic lines directly, or on the hatch 
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constructed by those graphic lines. When using an array with a variable number of elements, use of an 

intermediate hatch (based on the lines of the array) for the profile creation makes sense only in the case 

when you know the maximum number of copies in the array. In all other cases, the 3D profile should be 

created based on the graphic lines of the array. In the course of future construction, keep in mind that 

indexing of geometrical items within the resulting 3D element (such as edges, vertices, etc.) will be 

changing, as you modify the number of copies in the array that defines this 3D element. 

COPYING VIA CL IPB OARD  

Besides the moving, copying and array creation commands, T-FLEX CAD also supports the mechanism of 

copying via the clipboard. Its function is mostly similar to the copying command “XM: Create Copy”, yet 

has some additional capabilities. The clipboard allows copying any 2D elements, except for the drawing 

views and multipage text and BOMs. This mechanism is recommended for use in the following cases: 

For copying across several documents within the same T-FLEX CAD application; 

For exchanging data with other applications. 

Copying via the clipboard includes four commands available in the context menu and in the menu Edit 

after selecting the objects to copy: XC: Copy, XI: Copy with Insertion Point, XP: Paste, XE: Paste Special. 

The standard key combinations are used with the clipboard: <Ctrl><C>, <Ctrl><V>, <Ctrl><Ins>, 

<Shift><Ins>. 

The command XC: Copy - places the selected object on the clipboard: 

Icon Ribbon 

 Edit → Edit → Copy 

Keyboard Textual Menu 

<XC>,  

<Ctrl><C> 
Edit > Copy 

 

To use this command, simply select the elements, and then call the command. No additional actions are 

required. When later pasting the copied objects into the T-FLEX CAD document, you can use the 

characteristic points of the copied object (center, upper left corner, upper right corner, etc.). 

The command XI: Copy with Insertion Point - places the selected object on the clipboard with the 

specified attachment point: 

Icon Ribbon 

 Edit → Edit → Copy with Point 

Keyboard Textual Menu 

<XI> Edit > Copy with Point 
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Upon calling the command and selecting objects, you need to specify an arbitrary point (2D node), to 

which the objects will be attached when pasted in the T-FLEX CAD document. The following options will 

be available in the automenu in this case: 

 <N> Select Node 

 <A> Set absolute coordinates 

 <Esc> Cancel selection 

Object snapping is active when defining the point, similar to that used in sketching. Upon pasting the 

copied objects in the T-FLEX CAD document, the attachment can be defined by specifying a point or by 

the characteristic points of the copied object. 

When copying, the data are put on the T-FLEX CAD clipboard in a specific internal format. Besides that, 

to ensure interaction with external applications, the selected drawing elements are placed on the 

clipboard in the image format Enhanced Metafile (EMF). However, if a single element of the type “Text” 

was selected for copying, then additionally the textual data is placed on the clipboard in the following 

formats: 

1. T-FLEX Paragraph Text (except the string text),  

2. RTF (except the string text),  

3. Unformatted text. 

This supports data exchange both within the same T-FLEX CAD application and across several different 

applications. To insert data from the clipboard, use the commands XP: Paste, XE: Paste Special. 

These commands are available only if there is some data in the clipboard. 

The command XP: Paste: 

Icon Ribbon 

 Edit → Edit → Paste 

Keyboard Textual Menu 

<XP>,  

<Ctrl><V> 
Edit > Paste 

In this command, the format selection upon pasting the clipboard contents is done by the application 

itself. The program scans through the clipboard, searching for the appropriate format among the 

clipboard data. The data will be pasted in the first appropriate format found. The order of the format 

search is as follows: 

1. Internal T-FLEX CAD format (used only when copying within one T-FLEX CAD application) 

2. T-FLEX Paragraph Text 

3. RTF 

4. Unformatted text  

5. EMF 
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6. BMP (bitmap image) 

Upon calling the command, the elements being pasted will be rubberbanding with the pointer. The 

attachment point for the elements being pasted is defined by clicking  or by using the option . 

The following options are provided in the automenu: 

 <N> Select Node 

 <E> 
Use Variables when names are coincident (only when 

pasting in another T-FLEX CAD document) 

 <Alt><T> Copy only selected elements 

 <U>  
Move along X axis (only when pasting in the same 

T-FLEX CAD document) 

 <V> 
Move along Y axis (only when pasting in the same 

T-FLEX CAD document) 

 <Ctrl+4> (Selection of the attachment point) 

 <Alt+x> (Selection of the action after pasting) 

 <Esc> Exit command 

The options  and  are used for blocking pointer movement in the directions of the respective 

coordinate axes. To specify the exact position of the copied elements or the offset with respect to the 

original object, use the command property window. This option is available only when pasting the copied 

elements in the same T-FLEX CAD document. 

The group of options for selecting the attachment point allows specifying the point to which the pasted 

object should be attached. The characteristic points of the object are available for selection. If the objects 

were placed on the clipboard by using the command “XI: Copy with Insertion Point”, then an additional 

attachment point can be defined in the command being discussed (the option ). 

When using the clipboard copying mechanism, the system forces copying of the parent elements of the 

objects being copied (in the cases, when the former were not explicitly included in the set of the copied 

elements). This feature is similar to that used in the copying mode “Explode Copy keeping relations”. In 

the current case, you can also prohibit this system behavior by using the option . With this option 

activated, the elements, whose parents were not included in the set of elements to be copied, will be 

converted into independent objects. 

The copied elements can have relations with variables (except for the variables describing the position of 

these elements). To replace the respective parameters of the elements being copied by the variables 

defined in the target T-FLEX CAD document (the document where the elements are copied to), use the 

option . This option is only available when pasting the copied elements in another T-FLEX CAD 
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document within the same active application. If the option  is turned on, the names of the variables 

are compared in the target document versus those in the copied objects. If the names coincide, then the 

copied elements take on the relations with the respective variables of the current document. The 

variables, for which no match is found, are replaced by their values. If this option is turned off, the 

relations with all variables are broken, the variables being replaced by constants. 

 

The group of options  is used for the same purpose as in the moving, copying and array creation 

commands. Those define the action that will be automatically performed upon completion of pasting the 

clipboard contents. The following choices are provided: 

 

 - the system exits the command after pasting the clipboard contents; 

 

 - repeated pasting mode - upon pasting the first instance, the copied object starts 

rubberbanding with the pointer. The system waits for the user inputting the attachment point 

for the next copy. Upon selecting a second point, another copy is pasted, and so on. The copy 

creation can be interrupted by right clicking  or pressing ; 

 

 - the copying command XI: Copy with Insertion Point is automatically executed over the 

pasted object; 

 - is similar to the previous choice; however, before calling the copying command, the 

system turns on the mode of editing the list of selected elements. 

 

When pasting data from different applications, either a textual or a graphic format is used. If a textual 

format is used, then a “ Paragraph text” element is automatically created, and then its editing command 

is launched, ET: Edit Text. When inserting images, the command is launched for the “Picture” element 

creation, IP: Insert Picture. 

 

The dialog box will appear when pasting clipboard data with AutoCAD objects into a T-FLEX CAD 

document (see more details in “Exporting and Importing Documents” chapter). This dialog is used for 

specifying the general import parameters of an AutoCAD document. Then XP: Paste command will start 

for setting location parameters of the elements being inserted  position, angle of rotation, scale factor. 
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The command XE: Paste Special: 

Icon Ribbon 

 Edit → Edit → Paste Special… 

Keyboard Textual Menu 

<XE> Edit > Paste Special… 

This command allows the user to manually select a format 

for the clipboard contents to be pasted. The command 

dialog displays the list of formats present in the clipboard at 

the time of calling the command. Depending on what 

format the user selects, the system goes into the T-FLEX 

CAD object pasting mode, or pasting pictures in the EMF or 

BMP format, plain text or formatted text (RTF).  
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ELEMENT REPLACEMENT 

Let us reiterate that parametric properties of T-FLEX CAD models are managed by applying drawing 

elements over the construction entities. Meanwhile, all construction elements are defined using various 

geometrical relations with several base elements. This array of references from one element to another 

makes the model parametric. The command “RL: Replace Element” allows replacing a construction 

element by an element of the same type, that is, replacing all references to the original element in the 

model by references to another construction element. If necessary, the original element can be 

automatically deleted from the model upon the replacement. 

The command “RL: Replace Element” can be called by one of the following means: 

Icon Ribbon 

 

Edit→ Edit → Replace 

Keyboard Textual Menu 

<RL>, 

<Ctrl>+<H> 
Edit > Replace 

 

Upon calling the command, the following options become available in the automenu: 

 <L> Select Line 

 <C> Select Circle 

 <E> Select Ellipse 

 <S> Select Spline 

 <N> Select Node 

 <I> Select Other Element 

 <Del> Delete Source Element After Replacement 

 <Esc> Exit command 
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Let's review the use of the command on a simple example. A hatch is 

created in the drawing, whose contour was defined by a circle. We need to 

modify the model so that a different circle, “Circle 2”, is used in the future 

instead of “Circle 1”.  That's use the command "RL: Replace Element" for this 

purpose. 

 

When using this command, the first step is selecting the source element. 

 
 

In the example, it is a circle. It can be selected using the option . The 

selected element will be highlighted in the drawing. 

When working with drawings crowded with elements of the same type, one 

can miss the selection. The option  helps selecting a neighboring 

element in such a case. It cancels the last element selection and highlights 

the element of the same type nearest to the previous. 

 

Next, you need to select the target element of the same type for 

replacement. 

 

 

When selecting such element, only the elements of the same type as the 

source element will be pre-highlighted in the drawing. The only option 

available in the automenu will be the option for selecting elements of the 

respective type. 

In this example, select the “Circle 2”. 

Upon selecting the source and the target construction element, confirm the 

element replacement using the option: 

  
 

 <End> Replace Element 
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In the course of the replacement, all the elements constructed relative to the 

source element are rearranged with respect to the target one. In this 

example, it was the hatch.  

If necessary, the source construction element can be deleted from the model 

upon the replacement. The mode of deleting the source element is turned 

on by the icon . 

In the following example, the construction began with creating a vertical line 

– “Line 1”. All later constructions were done relative to this line. The “Line 2” 

was constructed as parallel to the first one, and the “Line 3” - orthogonal, 

through the “Node 1”. A tangency circle and the “Line 4” were later 

constructed relative to the two latter lines. 

 

Let's replace the base line “Line 1” by a new line “Line 5”.  

  
  

Upon the replacement, all construction elements that were defined relative to the “Line 1” are rebuilt 

relative to the “Line 5”. 

 When using the command RL: Replace Element, the target element should not be a child of the source 

one. Otherwise, a message is output about the encountered recursion. 

In the next example, the “Line 2” is constructed relative to the base line, “Line 1”. In turn, the lines “Line 3” 

and “Line 4” are constructed relative to the “Line 2”. A circle is created with the center at the intersection 

between the “Line 2” and the horizontal line in such a way, that it intersects the “Line 3” and not the “Line 

4”. 

 An attempt to replace the “Line 1” by the “Line 2” in this model causes the message about recursion. 
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The command may also fail when some drawing element position cannot be defined relative to the 

target element. 

 

For example, when creating the drawing of the above example, one of the nodes was defined as the 

node at the intersection between the circle and the “Line 3”. An attempt to replace the “Line 3” by the 

“Line 4” will cause an error message, since the system will not be able to define the position of this node 

after the replacement. 
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DRAWING MODIFICATION VIA DIMENSIONS 

T-FLEX CAD has the capability of modifying the model (3D model or 2D drawing) by using the 

dimensions. The user specifies the new dimension nominal value, and the system automatically rebuilds 

the 3D model or drawing based on parametric dependencies. Such editing is supported for both 2D 

dimensions (that is, dimensions in a drawing) and for 3D dimensions (dimensions in a 3D model), as well 

as their corresponding dimensions on 2D projections. 

Decides that, there is a provision for automatically calculation of all dimensions to the middle of the 

tolerance range. 

D IMENSION VALUE MODIF I CATION COMMAND  

In T-FLEX CAD it is possible to edit both the drawing and the 3D model by modifying the nominal values 

of dimensions created therein. The command PE: Set Dimension Values is used for this purpose. The 

command can be used either in the “transparent mode” or explicitly called by one of the following 

means: 

Icon Ribbon 

 

Parameters → Tools → Set Value 

Keyboard Textual Menu 

<PE> Parameters > Dimensions > Set Value 

 

Besides that, this command is available in the context menu when selecting a dimension (whether a 2D 

dimension or a 3D dimension). 

To enable the command in the transparent mode, you need to set the 

flag Dimension edit is transparent in the command SO: Set System 

Options, the tab 2D. After that, selecting any dimension value string by 

 launches the command PE: Set Dimension Values. The selected 

dimension value is highlighted, ready for editing. 
 

If the transparent mode is not set for this command, dimension values can be selected for editing only 

after the explicit command call. 

When a dimension value is modified, the system tries to find one construction element, whose 

modification affects the dimension value. If such element is found, it will be modified according to the 

requested dimension value. Otherwise, the drawing will stay unchanged. If several such construction 

elements are found, then the system will select the one of them, whose modification will affect as few 

other dimensions as possible. When the position of a construction element is modified, other 2D 

elements will be adjusted as well (including construction lines and/or graphic lines, dimensions, leader 
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notes, etc.), that are related with it. If the position of the elements being adjusted was driven by variables, 

then the system will query you for the automatic adjustment of their values. 

Upon calling the command, the following icons appear in the automenu: 

 <Enter>  Finish Value input 

 <Esc>  Exit command 

Select the dimension and enter the new nominal value: 

             

Then confirm the input by pressing the <Enter> key or . As was already mentioned, the drawing 

changes only when it is possible.  

 

The command will not work correctly in the following cases: 

The flag “Manually” is set in the dimension parameters, or the parameter “Dimension text” is assigned the 

value “No parameters”. 

The referenced construction elements definition does not allow their position modifications. For example, 

you cannot change the value of a circle radius if the circle is tangent to three entities. 

Changes in the construction entity positions caused by the dimension modification make the system 

unable to define the position of some element with respect to other affected entities. 

In all of these cases, the dimension reverts to the original value, with no changes done to the drawing. 
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"RE CALCUL ATE D IMENSIONS TO MIDDLE OF TOLERAN CE FIELD"  

COMMAND  

Besides the command that allows arbitrary modifications to dimension values, there is also a command in 

T-FLEX CAD to automatically recalculate dimensions to the middle of the tolerance range. This command 

performs a correction of nominal values for all selected dimensions in such a way as to make their values 

balanced about the median of their own tolerance range. The new tolerance range (also referred to as 

“tolerance field”, or “zone”) becomes symmetrical. This functionality can be used when adapting a 3D 

model to the toolpath calculation in the CNC module. 

         

Warning: this action is not reversible. That means, after recalculating all dimensions in the model 

to the middle of their tolerance range, the reverse model recalculation is impossible. To save the 

original state of the drawing, you can use the command UN: Undo changes right after 

recalculating the dimensions to the middle of the tolerance range, or save the original and the 

recalculated models in different files. 

The command can be called by one of the following means: 

Icon Ribbon 

 

Parameters → Tools → Recalculate to Middle of Tolerance 

Keyboard Textual Menu 

<PN> 
Parameters > Dimensions > Recalculate to Middle of 

Tolerance 

 

The following options become available in the command automenu: 

 <End>  Recalculate 

 <F5> Preview Operation Result 

 <Esc>  Exit 

Dimensions are recalculated upon clicking the icon . Before that, you can review the expected result 

ofthe recalculation with the option . 
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In the command properties window there are flags that control the recalculation process. When all flags 

are disabled, then only the dimension on the current 2D page will be recalculated (except for the 

dimensions on 2D projections, if such exist on that drawing page). The flags in the properties window 

serve to make the following adjustments: 

Recalculate 3D Dimensions. If this flag is set, then 3D dimensions will be recalculated along with 

2D dimensions (and, therefore, with the 3D model). 

Recalculate Projections. By having this flag set you allow recalculating 

the dimensions on 2D projections. If this flag is cleared, then the 

dimensions created on 2D projections are not recalculated. The 

projections themselves are not updated either (even if the 3D model 

changed as a result of recalculating 3D dimensions). 

Please note that projections recalculation is also affected by the state 

of the flag Recalculate Dimensions on All Pages. If this flag is set, the 

dimensions are calculated on all 2D projections of the  given model. If 

the flag is cleared, then recalculated are the dimensions of 2D 

projections located on the current 2D page only. 

 

Recalculate Dimensions on All Pages. This flag allows performing recalculation of 2D dimensions 

on all pages of the given document. 

As a result of recalculation, dimension tolerances become symmetrical. The manual method of defining 

tolerances will be set in the parameters of recalculated dimensions. The tolerance values can be assigned 

either symmetrical values resulting from the recalculation or zero values. The choice is made by 

setting/clearing the flag “Delete Symmetrical Tolerances”. When the flag is cleared, the parameters of 

recalculated dimensions are assigned symmetrical tolerances, whereas when the flag is set – zero 

tolerances. 

When previewing the recalculation result (the option ), the system highlights with different colors the 

dimensions that it successfully recalculated to the middle of the tolerance range, along with those that 

couldn't be recalculated, or those recalculated incorrectly. By default, the correctly recalculated 

dimensions are marked blue, the incorrectly recalculated ones – red. If necessary, you can specify your 

own highlight colors in the properties window. 
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RELATIONS 

To quickly track geometrical dependencies in drawings and manage them, T-FLEX CAD has a special type 

of 2D elements – Relations. Relations serve to visually render on the drawing screen the types and 

parameters of geometrical dependencies between construction elements. Using the relations one can 

modify parameters of those dependencies without calling the editing commands of the respective 

construction elements.  

Relations are auxiliary objects that are displayed in the drawing field in the way of special marks. Those 

are not printed and are not exported. The information about the type of the geometrical dependency 

and the numerical parameter of the object, to which a relation pertains, is displayed on the relation mark.  

If a parameter is related with an expression or with a variable, then the relation mark displays both the 

expression and its current value.  

Relations can be created automatically by the system (“temporary Relations”) or manually by the user.  

The automatic creation is done in the command for editing construction lines and graphic lines created 

based on construction lines. The system creates relations and displays them on the screen: if a 

construction line is edited – then for that line itself, if a graphic line is edited – then for the construction 

line, on whose base the graphic line is created. When exiting the editing command, such Relations are 

deleted automatically. Temporary Relations can be used to modify construction line parameters in the 

transparent mode. 

Manual creation of Relations is done by the user in the command “REL: Element Relations”. In this case, 

it is possible to create Relations either for individual construction elements or for all construction 

elements in a given drawing. Relations that are explicitly created by the user exist in the drawing up until 

the user deletes them by the same command. By default, those are permanently displayed in the 

drawing. Using those you can analyze parametric relations in the model, as well as modify construction 

line parameters. If necessary, all or specific existing Relations can be hidden from the current 2D window 

or completely over the entire document (such hidden Relations will not be displayed in any 2D windows 

opened for this document). 

USING REL ATIONS WHEN W ORKING WITH D RAWI NGS  

Relations serve the two main purposes: 

- Visualizing geometrical relations in the model; 

- Modifying geometrical parameters of the model in the 

transparent mode. 

The first goal is achieved by creating Relations, when the user can 

visually examine geometrical relations without using the 

command “Help|Information…”.  
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To modify an existing geometrical parameter using Relations, point the mouse at the parameter value in 

the Relation mark and click . The mark will turn to an edit box displaying the parameter value it 

controls. 

Just like in other system fields for editing values, the user can create here the list of frequently used 

parameter values and use it with the help of a special button for selecting the value from the list. This list 

is created with the commands of the context menu called by  in the editing mode of selected Relation. 

“Font” command can modify font that will be used for displaying the Relation marks. 

Font parameters are common for all “marks”: Relation marks, dimension marks used for editing 

dimension values in transparent mode, dragger marks in 3D operations. 

                      

The new parameter value can be fixed by clicking the  

button on the mark itself or in the automenu. 

 

If the parameter described by a Relation is bound to an 

expression or a variable, then the Relation mark displays both 

the expression and its current value. The user can edit the 

expression itself in the same way as its value. 
 

 

Sometimes, a Relation mark may obstruct working with the 

model by overlapping a portion of the drawing. To fix the 

situation, you can delete or hide from display such Relation 

(how to do it will be described a bit later), or simply move the 

Relation mark aside. 

To move a Relation mark, point the mouse at the Relation icon. 

Once the cursor changes to , depress  and, while holding 

the mouse button, drag the mark image to the desired 

position. The moved mark will be connected with the Relation 

image by a leader line. 
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You can move not only the relation mark, but also the Relation 

image that appears as an arrow connecting the 2D element, for 

which this relation is created, and its parent element. To do 

this, simply move the cursor to the Relation arrow and click . 

After that, the Relation image will rubberband along with the 

cursor. Move it to the new position and fix by clicking  again. 

 

CREATING REL ATIONS WITH THE COMMAND “REL :  E L E M E N T  RE L A T I O N S ”  

A special command “REL: Element Relations” serves to create, as well as hide/show and delete existing, 

Relations: 

Icon Ribbon 

 

Parameters → Tools → Relations 

Keyboard Textual Menu 

<REL> Parameters > Relations 

The following options are available in the command automenu: 

 <*> Create Relations for All Elements 

 <Del> Delete All Relations 

 <C> Create Relations for selected Elements 

 <P> Create Relations for parent Elements chain 

 <D> Delete Relations mode 

 <Esc>  Exit command 

There are three ways to create Relations: 

1. Automatic creation of Relations for all construction elements in the current drawing. For this, 

you just need to push the  option after starting the command; 

2. Manual creation of Relations for individual construction elements with the option . After 

calling the option, select the construction elements in the 2D window, for which you need to 

create relations. 

3. Manual creation of Relations for chains of dependent elements with the option . After 

calling the option, select the element in the 2D window, which will be the last in the chain. 

Relations will be created for the specified element through the entire chain of parent elements 

up to the base ones (those that are independent of other construction elements). 
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The created Relations will be always shown on the drawing, whether in the command waiting mode or 

inside any 2D command. Some of the existing Relations can be hidden from display, if you specify in the 

command properties window, which Relations shall be visible. This is done with the help of flags defining 

the visibility/invisibility of each Relation type (all flags are enabled by default): 

Relations for construction lines: 

Parametric Relations – Relations for construction 

elements that use geometrical parameters, which can 

be defined by variables. Such geometrical parameters 

include, for example, an offset line parallel to another 

line, an angle of a line inclined with respect to another 

line or to the horizontal, a circle radius etc. The 

exception is vertical and horizontal lines, for which 

Relations visibility is controlled by a special flag (see 

below).  

Symmetry – Relations for lines constructed as the 

symmetry axis for two other lines. 

Tangency – Relations for elements constructed with the 

tangency condition.  

Horizontal/Vertical – Relations for vertical and horizontal lines. 

 

Orthogonal – Relations for the lines constructed as perpendicular to other lines. 

Relations for nodes: 

 

Free Nodes – Relations for the free nodes, meaning those defined by two coordinates - X, Y. 

Relative Nodes – Relations for nodes defined by an offset relative to another node. 

 

Parametric Nodes – Relations for nodes having one numerical parameter. Such nodes include 

the nodes on construction lines (circles, splines, functions etc.), as well as a node relative to 

another node on a line. 
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The flags in an additional Variables section serve to control the 

visibility of Relations depending on whether variables were used 

to define geometrical parameters of those elements (by default, 

those flags are disabled): 

Only Related to Variables. When this flag is enabled, the 

2D window will display the Relations only for those 

construction elements, which were defined using 

variables. 

The list below shows all numerical variables in the current 

document. An additional flag Show Hidden Variables 

serves to display in this list also the hidden numerical 

parameters of the current document. Using the list, you 

can specify the variables that shall be considered when 

determining which Relations to show. To select a variable, 

you need to set the flag beside its name (using ). 

 

All variables in the list can be quickly marked with the button . Checks can be cleared off all 

variables in the list by the button . 

After exiting the command, the Relations hidden by the above-described flags will stay hidden from the 

drawing. Nevertheless, they exist in the model. To make them visible, you need to call the REL: Element 

Relations command again and set the respective flags in its property window. You do not need to create 

Relations anymore in this case. 

Hide on Current View. When enabling this flag, all created Relations become invisible in the 

current 2D window. However, those will be visible in other 2D Windows of the same drawing (if 

any are open). Just like in the case of using the previously described flags, to alter the relations 

visibility/invisibility once out of the command, you would have to call it again and change the 

status of the given flag in the property window. 

Relations are deleted with the options  and . When clicking , all previously created Relations 

will be automatically deleted. The option  is used to delete individually selected Relations. After 

calling this option you need to sequentially select any Relations to be deleted. 
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MANAGING REL ATIONS V IS IB IL IT Y OUTSIDE “REL :  E L E M E N T  RE L A T I O N S ”  

COMMAND  

You can manage the visibility of created Relations even without calling the command REL: Element 

Relations. The “View” toolbar provides the  icon to call the special command Show/Hide Relations. 

The effect of this command is same as setting/clearing the “Hide on Current View” flag in the property 

window of the command REL: Element Relations. 

D ISPL AYING REL ATIONS IN THE “ I N F O ”  COMMAND  W INDOW  

When the “Info” dialog is activated for selected or all model elements, the relation objects are displayed 

in this dialog in a special way. An existing relation icon is displayed beside the element, to which it 

pertains. 

 

 



 

 

VARIABLES AND RELATED 
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VARIABLES 

This chapter describes the uses of variables in T-FLEX CAD, the ways of defining parametric relations 

between the drawing elements and the idea of parameterization without programming. The variables 

allow extending the concept of parameterization on a deeper level. This chapter describes how to 

perform complex mathematical calculations within a drawing, how to define relations between 

construction entities, and other very useful capabilities of the system. 

MAIN CONCE PTS  

The T-FLEX CAD variables – are auxiliary elements of the system which enable to specify different types 

of non-geometrical interconnections between the elements of a drawing.  

For example, the variables can serve as parameters of construction lines. In this case, the value of the 

construction line parameter will be determined by the value of the variable. If the value of the variable 

changes, then the value of the construction line parameter connected to it will be automatically modified 

(for example, radius of a circle or line location). With the help of variables, it is possible to assign color or 

visibility of the elements of a drawing, parameters of hatches, the text content, various parameters, etc. 

The variables can be also used upon creating a 3D model.  

By assigning interconnections between the values of the variables, which determine parameters of the 

drawing's construction elements and drawing's image elements, it is possible to achieve automatic 

modification of the entire drawing when changes in the values of one or several basic variables are made. 

Creating Variables 

T-FLEX CAD system provides various ways of creating variables: 

 using variable editor; 

 while creating and editing construction line parameters and also other elements of the drawing 

or 3D model; 

 using text editor; 

 while defining textual strings for parameters of certain elements; 

 while defining practically any of the numerical parameters of the system elements levels 

priorities, etc. 

The main tool for handling variables is the variable editor. It allows a user to perform any manipulations 

over the variables. Thus, we will commence describing the work with the variables exactly with the 

description of the variables editor. All other methods for creating variables will be described later, in the 

section “Using variables in the T-FLEX CAD”. 
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Variables Characteristics 

Before getting to description of the variables editor itself and how to work in it, let's consider the main 

characteristics of any variable of the T-FLEX CAD. 

Upon creating any variable of the T-FLEX CAD, it is necessary to indicate: 

 a unique name of the given variable which enables to uniquely identify it in the document 

and also  determine the type of the given variable (text or real); 

 expression, based on which the system will calculate the current value of the variable.  

 

Moreover, there is also a number of additional characteristics of variables, which can be specified in case 

of need. Several of them enable to impart additional properties to the variables (for example, the 

indication of external variable). Others are used exclusively for simplifying the work with a large number 

of variables in the document (comment of variable, group of variable). 

 

Rules for assigning variables' names 
The name of any T-FLEX CAD variable must represent itself a string of characters. The letters, numbers 

and the character “_” (underlining) can be used in the name. There is no limitation on the length of the 

variable's name. 

 

The variable's name determines the type of the variable: real or text. The type of the variable shows what 

sort of values the given variable may take. The type is determined by the first character in the name of 

the variable. The name of the real variable must start with the letter, text variable – with the symbol $. 

Examples of correct variable names: 

 

VAR1; VVVVVVVVVV; VAR_1; $TEXT; WIDTH; width; 

Note that the two last variable names are considered different, as the names are case-sensitive. Local 

language extensions of US ASCII are supported for the names. Local language users shall keep in mind 

that some language characters (particularly, Cyrillic and Greek) resemble the standard US ASCII, while 

their system codes may be different. Therefore, care should be taken in entering names, as the system 

will not recognize a name with the same appearance yet actually composed of different characters. 

 

Examples of inappropriate variable names: 

1_VAR (the first character is not a letter); 

!_VAR! (inadmissible “!” character is used); 

V A R (the name may not contain “space” characters). 
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Expression for variable 
An expression is specified for each variable so that the system could calculate the value of the variable at 

any moment of time. An expression – is a mathematical formula, containing standard algebraic 

operations, logical operations, conditional operations, calls to mathematical functions and the T-FLEX 

CAD functions, various constants (real or character, depending on the type of variable), the values of 

other variables. As a result of the expression calculation, the value of the variable is obtained. 

The rules for composing expressions for the T-FLEX CAD variables and description of the functions 

that can be used inside the expressions are described in the Attachment I of this chapter. 

Upon specifying the expression for the variable, the type of the variables should be taken into account. 

Real variables can take only numeric values (12; 125; -234; 781.234; 3.834e+6), text variables – only 

character values (“Text”; “String”; “Name”). 

An expression can represent itself just a constant (numeric or character depending on the type of 

variable). 

Variables-functions 
Besides various mathematical and special functions, predetermined in the system, upon compose the 

expressions for the variables, it is possible to define and use user's own functions. For example, if, upon 

defining the variables, many similar, bulky expressions, differing only in separate arguments, are used in 

the expression, it is possible to define user's own function, a call to which can replace the expressions. 

User's functions are defined with the help of variables of a special kind – variables-functions. 

Variable-function represents itself the definition of the user's function. The expression for the variable-

function is composed according to the same rules as those for the standard variable. The entry of the 

arguments of the function into the expression is denoted in the following way (the number of the 

arguments is not limited): 

#1 – the first argument, 

#2 – and second argument and so on. 

The function defined in such way can be used in the variables editor upon specifying the values of other 

variables. Upon calling this function, the names of the variables and numeric expressions serve as the 

arguments. The number of actual arguments must be equal or more than the number of formal 

arguments. 

For example, if the variable-function was defined in the following way: 

 

FUNC=(#1+#2)*10, 

the call FUNC (L, 20, 30) will not be a mistake. 

 

In the list of the variables of the current document, the empty brackets “()” are automatically 

added to the name of the variable-function. 
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The list of variable's values 

For any T-FLEX CAD variable it is possible to define a list of values. To be more precise – a list of 

expressions since the list for the variable can include any values, not necessarily the constants. The list of 

various expressions can be defined even for a variable-function. After that, the value of any variable, 

more precisely, of any expression, determining this value, can be selected from the created list. 

The list is created as a set of lines, containing required constants or expressions. Moreover, the list can be 

created on the basis of already existing file, internal database, the list of materials in the 3D version or 

the calendar two last items are available only for text variables. 

The list defined for the variable will appear in all places in which the value of the given variables is 

specified (in the variables editor, in the command М: Edit model parameters, upon assigning the 

variables of a fragment). The field for the entry of the values of such variable will include the graphic 

button  which enables to call the list of values. To access the list of values, it is enough to point at this 

button with the cursor of the mouse and press . As a result, the list will pop up on the screen, and the 

new value (expression) can be selected from the list. 

 

Comment of variable 
If necessary, for any variable the comment can be specified. It represents itself an arbitrary text string. The 

comment enables to “attach” certain clarifications to the variable. For example, the comment may clarify 

the variable's designation (the width of the part, the radius of the circle, etc.) or the range in which the 

value of the variable is changed. 

 

The comment of the variable, if it is specified, will appear in the dialog for inserting a variable (this dialog 

can be called, for example, from the context menu of all fields of the system dialogs), and also from the 

list of the values of the fragment upon its insertion into a drawing or 3D model. 
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Group of variables 
If necessary, for any variable the group can be identified. When the variables are broken down into the 

groups, it becomes easier to control the large list of variables of the complicated drawing. 

The Group, as well as the comment, is an additional characteristic of the variable specified for simplifying 

the work with a large number of variables. The fact that the variable belongs to a certain group does not 

affect in any way the use of this variable. 

External Variables 
Any variable, the value of which is specified by a constant (numeric or character), can be given an 

attribute “external”. External variables are used for organizing parametric connection between the 

assembly document and the fragments. The values of the external variables, defined in the fragment, can 

be modified from the assembly document. 

The variables, marked as external, can be exported to the external text file with the possibility of reading 

from this file afterwards. This enables to use external variables for organizing connection between the T-

FLEX CAD and other systems and application programs.  

Hidden Variables 
For regulating the work with a large number of variables, the mechanism of hidden variables can also be 

used. 

Any variable, created in the T-FLEX CAD document, can be marked as hidden. By default, such variables 

are not displayed in the window of the variables editor or in the windows of other T-FLEX CAD dialogs 

dealing with the variables. Thus, it is possible to hide various auxiliary variables. 

All standard templates of the T-FLEX CAD documents already contain a list of hidden variables providing 

automatic cross-reference between the fields of the drawing format (the title block) and the BOM data. In 

other words, the textual strings of these variables are substituted in both the appropriate title block fields 

and the respective entries of the BOM data. 

Used and used variables 
In order that the value of the variable could affect the structure of the drawing (or 3D model) of the 

given document, it is not sufficient just to create this variable in the T-FLEX CAD document. The given 

variable has to specify a characteristic of the elements of the drawing or 3D model: location of a line or a 

node, the radius of a circle, the level of visibility of the image line or 3D bodies, etc. 

The variables the values of which take part in specifying characteristics of other elements will be further 

called used. Also, the variable is considered to be used, when its value is used for evaluating the value of 

another variable. 

Consequently, the variables the values of which are not used anywhere on the drawing or in the 3D 

model and also upon calculation of the values of other variables are considered to be unused. Such 

variables, being equal variables of the T-FLEX CAD document, do not have any influence on its content. 
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WORK IN VARI ABLES  EDITOR  

Window of Variables Editor 

The work with the editor can be carried out in two ways. The first way – the work in the main window of 

the variables editor, called with the help of the command “V: Edit variables”. The dialog box of the given 

window enables to use the entire functionality of the variables editor and possesses a convenient 

interface. However, all changes made in the given window will be applied to the model only after closing 

the window of the dialog box. 

The second way – is to use a special service window of the system – the window “Variables”. This window 

enables to work with the variables in the transparent mode. 

In this chapter the description of work with the variables editor will be further presented by taking the 

standard window of the variables editor as an example. However, the same operations can be performed 

in the window “Variables”. The work with the window “Variables” will be discussed in the section 

“Working with variables editor in transparent mode” in a more detailed manner. 

To call the main window of the variables editor, the command V: Edit variables is used: 

Icon Ribbon 

 

Title Block → Additional → Variables 

Keyboard Textual Menu 

<V> Parameters > Variables 

 

The window of the variables editor contains the list of all variables of the current T-FLEX CAD document 

no matter in what way they were created (recall that the new variables can be created not only in the 

variables editor). Upon calling this command, the window of the variables editor will be empty if no 

single variable has been created in the document. 

In the editor window, the variables list is displayed as a table, the form of which can be freely edited by a 

user. It is possible to modify the number and content of the displayed columns, the parameters for 

grouping and sorting the rows of the table, parameters of the grid of the table.  

The variables editor has its own textual menu and the toolbar containing the main commands for 

working with the variables. 
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Creating Variable 

In the variables editor the new variable can be created by using the command New Variable: 

Keyboard Textual menu Icon 

<Ctrl><N> Variable > New  
 

After calling this command, the window for specifying properties of 

the variable being created appears. For creating a variable it is 

necessary to indicate the name, type of the variable (real or text), and 

also specify an expression, which will determine the value of the given 

variable. 

The field “Name” and the toggle “Real/Text” work in a synchronized 

manner. For example, if the specified name of the variable starts with 

the symbol “$”, then the type toggle is automatically switched to the 

value “Text”. And vice versa – upon changing the type of the variable, 

the symbol “$” is automatically added/removed to/from the name of 

the variable. 

 

Parameters Comment and Group do not have to be specified. 

By default, the parameter “Group” takes the same value as the variable selected in the table of  

variables upon calling the command New Variable. 

The flag External is turned on if the variable being created has to be external. 

In the table of variables the names of the external variables are marked with bold font. 

The flag Hidden is turned on if the variable being created has to be hidden. 
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The flag Function is set on only in case it is necessary to create a variable-function. In this case the 

expression has to be made up with the use of the notation for the arguments of function (#1, #2, #3…). 

If the current document is going to be used as a fragment, then for its external variables, the assembly 

variable name and/or the list “connector values”. can be also indicated in the dialog “Variable's 

Properties”. What that means will be discussed in detail in the chapter “Creating assembly drawing”. The 

name of the assembly variable is defined in the field of a single-named parameter, and the list of 

connector values – in the dialog box “Connector values” emerging upon pressing the button [Connector 

values…]. 

The list “Connector Values…” is filled up for external variable of a document, used as a fragment 

with fixing by connector. Upon inserting such fragment into an assembly, the system has to 

automatically change the value of the fragment's external variable in accordance with the given 

(“values”) of the indicated connector. The system selects the name of the required value of the 

connector in the list “Connector values” for the external variable. Upon fixing the fragment to the 

connector, the system will be first looking for the first name from the list, among the named 

connector values, and if it is not found – the second name and so on. 

The list of connector values may contain arbitrary number of 

elements. 

For creating a new element of this list, the button  is used 

in this window, for removing already existing element – the 

button . The buttons  and  enable to move 

elements up and down along the list (the order of the 

elements in the list is set by a priority of elements in the list 

upon searching for the coincidences with the connector 

values). 

 

The group of parameters Value List enables to create and edit the list of values for a variable. If a given 

variable does not have the list, then the value No will be specified in the drop-down menu of the given 

group. For creating the list it is necessary to select from the menu the required creation method: Text, 

Database, File, Data, Materials. More detailed description of various methods of creating the list of 

variable’s values is presented below in the section “Creating List of Variable’s Values”. 

After pressing [OK] the created variable appears in the list of variables. 

It is recommended to use uncomplicated names for the variables in order not to write lengthy 

expressions. It is a good thing to write a comment for each variable. 
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The command “New Variable” can be also called from the context menu at any place of the list of 

variables. 

 

Besides the use of the aforementioned method, it is possible to create a new variable by other means. It 

is enough to put the name of yet non-existing variable into the expression of some variable. After 

recalculation of the given expression the system will find that such variable (for example, the variable “С”) 

has not been defined, and a message will pop up on the screen: “Create variable “C”?”. If the 

question is answered positively, the new variable will automatically appear in the list of variables, and the 

focus of input will be moved to its field “Expression” – for specifying the expression for this variable. In 

case of a negative answer, the new variable is not created and the error message is generated. 

Creating List of Variable's Values 

The list of variable’s values is created with the help of the parameter “Value List” in the variable’s 

properties window. The method by which the variable’s list is created is chosen from the pull down menu 

of this parameter: Text, Database, File, Data, Materials. 

After selecting the list creation method on the basis of text, the window of the text editor will appear, in 

which the necessary list of values can be formed. Each value has to be located in a separate line. Upon 

creating the list, all options of the text editor become available. 

When the list is created on the basis of database, already existing 

internal database is used. For example, let's suppose there is 

database shown on the picture. After calling the command for 

creating the list on the basis of database, the dialog window will 

appear. The parameters for forming the list have to be indicated in 

this window. 

One has to choose: 

- the name of the database from the list of databases for the 

current document; 
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- the column in the database from which the values 

will be selected. The first line of the list – “Record 

number” can be also chosen. In this case, the 

selected record number will be a value being 

returned; 

- columns which will appear upon creating the list. 

The field “Filter” enables to specify conditions for the values 

selected from the database (upon creating the list of values). 

These conditions are specified with the help of logic 

expressions, which are made up by the same rules as those 

for the expressions for the variables (see Attachment I to this 

chapter). 

For example, the use of the expression, shown on the picture 

above, will lead to the result shown on the picture below (for 

comparison, the list obtained in the same example without 

specifying the condition in the field “Filter” is shown as well).  
 

 
 

List on the basis of database obtained with the use of 

filter 

List on the basis of database obtained without using the 

filter 
 

When the list is created on the basis of file, the dialog 

window for selecting already existing or creating the new 

file appears. The data in the file must be stored in the form 

of sections with the lists of values. Upon creating the list, 

the required section is indicated. Also, it is possible to 

create the new section or remove already existing section 

from the file with the help of buttons  and  (buttons 

in the left pane of the dialog). 
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The list of values for the selected section is shown in the field on the right. The buttons , ,  and 

 in this pane of the window enable to edit the list of values of the selected section. 

The created file can be used while working with other T-FLEX CAD documents. 

When the list is created on the basis of date, the dialog window pops up, in which the date 

representation format can be specified, for example, “DD.MM.YY”. The variable, for which this list is 

specified, has to be a text variable. After that, upon making a selection from the list, the window in the 

form of a calendar will emerge, in which any required date can be chosen. 

 
 

Also, it is possible to form the list on the basis of materials list (only in 3D version of the system). Such 

list can be formed only for the text variable. Upon creating the list, the window of the text editor appears, 

in which all materials, used in the 3D model of the current document, are included by default. If 

necessary, the list can be edited manually. 

 

In order to edit the created list, it is necessary to use the button [Edit…] of the group “Value List”. For 

each type of the list, the corresponding edit method will be called. 

 

For removing any list of values, it is enough to put again the value “No” in the drop-down list of the 

group “List”. If the list is created on the basis of database, then only connection with the database will be 

broken, the database itself will be preserved. 

 

Window “Assistant” 

To specify the values of the variables, the user can use a special auxiliary window “Assistant”: 

Keyboard Textual menu Icon 

<Ctrl><H> View > Assistant  
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Assistant is used for quick insertion of functions’ names, records from the databases, variables already 

existing in the document, frequently used constant, etc. into the expressions of variables 

For convenience the contents of the Assistant is divided into 

several categories. The list of available categories is displayed in 

the upper part of the Assistant window in the field Category:. The 

contents of the category selected in the field “Category” is 

displayed in the lower part of the window. For example, on the 

picture to the right the list of standard mathematical function of 

the T-FLEX CAD is shown in the Assistant window. For each 

function there is a short description. 

To insert a function (a link to a field in the database, an operation, a 

variable, etc.), the user needs to select a desired category in the 

Assistant window, then select a required line in the category 

contents list and finally press  or button [Insert]. The item is 

inserted in the main window of the variables’ editor into the space 

corresponding to the position of the cursor before activating the 

Assistant window. 
 

When working with the variables’ editor, the window “Assistant” can be placed on the screen 

permanently. 

Properties of Variable 

For changing the name, expression or other characteristics of variables, the variable's properties dialog 

box, called with the command Properties, is used: 

Keyboard Textual menu Icon 

 Variable > Properties …  

The command Properties can be also called from the context menu, activated with the  upon choosing 

the variable in the list of variables. Or it can be called just by pointing with the cursor at the variable's 

name in the list of variables and pressing . 

After calling this command, the window of the dialog Variable's Properties will appear. Inside this 

window it is possible to modify the name of the variable, its expression, comment and group, by using 

corresponding fields of the dialog. It is possible to mark this variable as external or hidden (flags External 

and Hidden). 

The command Properties can be also accessible when several variables are selected simultaneously. In 

this case, when this command is called, the window emerges in which for selected variables the only 

parameter: group can be specified. Selection of several variables is carried out with the help of <Ctrl>+ , 

<Shift>+ . 
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Removing Variable 

It is possible to delete the variable with the help of the following command of the variables editor: 

Keyboard Textual menu Icon 

 Edit > Delete  

The command Delete can be also called from the context menu upon choosing the variable in the list of 

variables. 

After calling this command, the variable, for which this command was called, will be removed. Note that, 

only unused variables can be removed (in the column “Not used” a symbol “?” will be standing next to 

such variable). The command Delete is not available for used variables. In case if the variable is currently 

used, the user has an option of either deleing the chain of dependent elements or replacing the selected 

variable with a constant value. 

Diagnostics of Errors 

Upon creating the new variables and also the further work with the variables, various errors can arise. 

Usually these are the syntax errors in the expression of the variable. In this case, for the problem variable 

the sign  will be shown in the column “State”. Upon bringing the cursor to this sign, a tooltip about the 

type of the error will appear. At the same time, the color of the field Value will be changed to red 

manifesting the existence of the error. In addition, for the given variable a detailed description of the 

arisen error will appear in the column Message (by default this column is turned off). 

In spite of the existence of errors, it is possible to finish the work in the variables editor, and get back to 

their correction later. The existence of errors in the variables editor does not affect the recalculation of 

the 2D/3D model elements of which depend on the incorrect variables. 

 

 

If necessary, you can track the use of any variable in the model with the help of the “The use of a 

variable” command found in the context menu of the variable. 
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Canceling Operations in Variables Editor 

Any actions in the variables editor can be canceled/repeated with the help of step-by-step commands: 

 

Keyboard Textual menu Icon 

<Ctrl><Z> «Edit > Undo  

<Ctrl><Y> «Edit > Redo»  

The number of cancellation steps is limited only by general setting of the system (parameter “Undo/Redo 

Buffers” in the dialog of the command Customize > Options…, the tab “Preferences”). 

 

Show/Hide Hidden Variables  

Command «Show/Hide hidden variables»  shows or hides hidden document variables in one click. 

State is maintained in user settings. 
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Customizing Window of Variables Editor 

The appearance of the table of variables in the window of the variables editor can be customized with 

the help of command: 

Keyboard Textual menu Icon 

 View > Options…  

Moreover, this command can be also called from the context menu at any place of the variables editor. 
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After calling this command the window Options opens up. At the left pane of the window, the list of all 

possible columns from the table of variables will be displayed. 

The majority of the columns correspond to some 

characteristic of the variable (name, type, usability, 

expression, current value, and so on). The columns State 

and Message are used for output of system messages 

about errors upon evaluation of the value of variable. 

The columns displayed at the current moment are marked 

with a tick before the name. To add the column into the 

table, it is enough to select it in the list and with the help 

of  put a tick before its name. For removing a column 

from the table, it is sufficient to take off a tick next to its 

name. 

In the right pane of the window “Options” there are other 

various parameters of the table of variables: 
 

The group Number Format sets the format for the real numbers in the column Value: Precision 

and Trim Trailing Zeros. 

The group “Grid Lines” defines the appearance of the grid of the table of variables: 

Vertical. The appearance of vertical lines of the grid of the table: No, Small dots, Large dots, 

Dashed, Solid. 

Horizontal. The appearance of horizontal lines of the grid of the table: No, Small dots, Large 

dots, Dashed, Solid. 

Color. The color of grid lines of the table of variables. 

Show Hidden Variables. This flag controls the view of hidden variables in the table of the 

variables editor. 

Show Grouping Area. This parameter controls the view of the grouping area over the table of 

variables (see below). 

The button [Font…] enables to set the font used upon displaying the table of variables in the 

window of the variables editor. 

The visibility of single columns of the table can be customized without calling the command Options. To 

do that, it is enough to call the context menu from any place on the header of the table of variables. 

Submenu Columns enables to quickly turn off/turn on the display of the columns. 
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The order in which the columns are displayed in the table of variables can be easily changed just by 

pulling over the columns into the required places. To do that, it is enough just to bring the cursor to the 

column, hit  and without releasing the mouse button, drag the header of the column to the required 

place. Red arrows on the screen suggest where the column will be inserted. 

     

Grouping Area. Grouping of Variables 

By default, in the variables editor all variables are grouped by the characteristic “group” (if this 

characteristic is specified for variables of the current document). However, it is possible to use other 

parameters of variables for grouping, including several parameters at the same time. 

For customizing the grouping parameters it is convenient to use the grouping area. It is turned on via 

the dialog of the command View > Options… or via the context menu in the header area of the table of 

variables. The grouping area is situated over the table of variables. By default, the label “Group” is 

displayed in the grouping area. This means that the variables are grouped by the characteristic “group”. 
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In order to turn off the grouping, it is enough to point with the cursor at the label in the grouping area, 

press  and without releasing the mouse button, drag the label to any other place outside the grouping 

area. If the label is moved to the headers' bar of the table of variables, the column with the same name 

will be added to the table. If the label is moved while holding the key <Ctrl>, the label will be copied – it 

will remain in the grouping area, and at the same time the corresponding column will appear in the table. 

When the mode of grouping is turned off, the message Drag Column Header here to group by Desired 

Parameter is displayed in the grouping area.  
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To activate the mode of grouping by some characteristic, it is enough to point at the header of the 

corresponding column of the table of variables, press  and without releasing the mouse button, drag 

the header of the column to the grouping area. After that, the label of the chosen characteristic will 

appear in the grouping area, and the variables in the table will grouped by this characteristic. If the 

headers of two columns of the table are moved to the grouping area, the grouping will be carried out by 

two characteristics simultaneously. Location of the labels in the grouping area shows the order of 

grouping. 

 

Note that upon moving the header of the column into the grouping area, the column is removed from 

the table. In order to keep this column in the table, it is necessary to hold the key <Ctrl> while moving 

the header.  

It is also possible to control grouping with the help of the context menu. It is sufficient to point the 

cursor at the column header of the table of variables and call the context menu with the help of . The 

flag Group by this Column will be accessible in the context menu. In order to activate grouping by this 

column, this flag should be set on. To cancel grouping by selected column, it is enough to take this flag 

off. 
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Sorting Variables 

In addition to grouping, for the list of variables it is possible to specify sorting by any column. By default, 

the sorting is turned off. To turn it on, it is enough to bring the cursor to the header of that column of 

the table of variables by which the variables are to be sorted. The tooltip Sorting by: … with the name of 

the selected column will appear on the screen. If one hits  pointing at the header of the column, then 

the rows of the table of variables will be sorted by the selected characteristic. In the header of the 

column, by which the sorting is carried out, an additional symbol in the form of a triangle will appear, 

showing the direction of the sorting:  – for sorting in ascending order,  – for sorting in descending 

order.  

      

By default the mode of sorting in an ascending order is turned on initially. Pressing  on the header of a 

column repeatedly turns on the sorting in a descending order. For sorting by another characteristic, it is 

enough to press  on the header of the corresponding column. 

Sorting can be canceled with the help of the command “Cancel Sorting” in the context menu called from 

the headers' bar of the table of variables (i.e. in the area of the header of any column of the table). This 

command is available only when the mode of sorting is turned on. Also, in the context menu the 
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commands Sort Column Ascending and Sort Column Descending are available. They activate sorting by 

the column for which, in the column header, the context menu was called. 

 

Sort parameters are saved in the file of the document and restored upon reentry into the variable editor. 

When sorting capability is turned off the user can also utilize <Ctrl>+<ArrowUp>, 

<Ctrl>+<ArrowDown> to change the order of the lines in the variable editor. To change the order of 

rows in a table the buttons can also be used: 

 - Move downwards.The current row will be moved to the row below. 

 - Move upwards.The current row will be moved to the row above. 

These commands are also accessible via the text menu of the variables’ editor: 

 

The changes in the sequence of the lines are saved in the document’s file separately for the main window 

of the variable editor and for the auxiliary window “Variables” (see section “Working with variable editor 

in transparent mode”). 
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Finding Variables 

Upon working with a large list of variables, it is sometimes convenient to use the command of searching 

for variable by name: 

Keyboard Textual menu Icon 

 Edit > Find  
 

 

After calling this command the dialog window pops up, in which the search parameters are required to 

be specified After specifying the parameters, the button [Find Next] has to be pressed. If the search 

process was completed successfully, the cursor is moved to the column Expression for the found 

variable. If the variable was not found, the cursor stays at the same place, and in the message line of the 

editor the message appears: Cannot find specified string. 

Upon specifying parameters it is important to pay attention to the state of the flag Match Case. By 

default, this flag is activated. In this case the system looks for the variable, the name of which coincides 

exactly with the specified string in the field “Find what”. When this flag is off, the system searches for the 

variable for which the text, specified in the field “Find what”, enters the variable's name as a substring. 

In all columns. The option allows finding of the specified string in all columns. 

Copying Variables 

The T-FLEX CAD makes it possible to copy variables from one document to another with the help of the 

clipboard. 

For copying one variable to the clipboard it is necessary to select it in the table of variables with the help 

of , and after that call the command Copy: 

Keyboard Textual menu Icon 

<Ctrl><C> Edit > Copy  

For inserting the already copied variable, the command Paste is used: 

Keyboard Textual menu Icon 

<Ctrl><V> Edit > Paste  
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If the document, in which the insertion is performed, already contains the variable with the same name as 

that of the variable being inserted, the message Some Variables have equal Names pop up. 

 

 

The commands of copying/insertion can be also called from the context menu for the variable: 

 

For copying several variables simultaneously, a multiple selection with the help of <Shift>+  and 

<Ctrl>+  is used. For selecting all variables of the given document at once, the following command is 

used: 

Keyboard Textual menu Icon 

<Ctrl><A> Edit > Select All  

Writing Variables to External File 

The values of variables can be written into the file of parameters by using the command Export 

Parameters: 

Keyboard Textual menu Icon 

 «File > Export» 
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Upon calling this command the dialog window appears. One 

needs to specify the name of the file, into which the 

information will be written. By default, the filename 

coincides with the name of the current drawing, file 

extension is – “par”. It is possible to specify an arbitrary 

filename. 

Each variable is written in a separate line. The format of the 

record is the following: 

<name of variable> = <value> [/*<comment >*/] 

The name and the value of the variable are always written 

down. 

 

The comment is written on condition that one of the following parameters has been set on: With 

Expressions or With Comments. 

If in the export dialog box the flag Marked Only is activated, then only external variables of the given 

document will be written into the resulting file. When the flag is taken off, all visible variables are 

exported.  

Hidden variables are not exported by default. In order to write them into the external file as well, it is 

necessary to set on the flag Export Hidden Variables. 

For example, suppose there is the following list of variables in the editor: 

 

Upon writing the file, the following parameters have been activated: output all variables except hidden 

ones, with expressions and comments. This has to result in the file with the following content: 

 

If you select Export connector values, the output file will have values added from the corresponding 

column. 

If you select Export only selected variables, the output file will have only selected rows. 

The values of external variables can be read from the file of parameters by using the command Import 

Parameters: 

Keyboard Textual menu Icon 

<Ctrl><R> File > Import  
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After calling this command the dialog window pops up. 

If the variable present in the file of parameters is absent in 

the current drawing, it will not be read. Also, the variables 

that are not defining in the drawing as external will not be 

read. 

How can files of parameters be used?  

Files of parameters can be used when you need to save several versions of the same drawing. In this case 

you save several files of parameters with the values of external variables and, if necessary, read the values 

from a specific file. As a result, a finished drawing with the required parameters is obtained. 

It is convenient to use the files of parameters for connection of the T-FLEX CAD with other computational 

software. In the system you can create a parametric drawing with certain set of parameters. Your 

computational procedure receives the values of these parameters through the file. You calculate the 

remaining parameters of the drawing in your software and create either a new file of parameters or 

update the old one. From the T-FLEX CAD you read the file and obtain a modified drawing on the basis 

of the parameters calculated by you. Thus, the file of parameters serves as an intermediate link for 

connection between the T-FLEX CAD and your software.  

Printing List of Variables 

For printing the content of the variables editor the command Print can be used: 

Keyboard Textual menu Icon 

<Ctrl><P> File > Print…  

After calling this command the standard printing options dialog appears. As a result, all content of the 

variables editor will be sent to printer in the same form as it was displayed on the screen. 

Before calling this command, separate lines from the table of variables can be picked out in the window 

of variables editor with the help of , <Ctrl>+ , <Shift>+ . Then by setting on the flag Print range > 

Selection in the printing options dialog, it is possible to print out only selected lines and not the entire 

content of the editor. 

WORKING WIT H VARIABLES  EDITOR IN TRANSPARENT MODE  

To work with the variables editor in the transparent mode (while working simultaneously in the drawing 

or 3D model window), the service window of the system “Variables” can be used. Similar to other service 

windows of the system, the window “Variables” can operate in floating and popup mode. Also it can be 

placed along one of the sides of the main window of the system. 

By functionality the window “Variables” duplicates the main window of the variables editor, called with 

the command V: Edit variables. But the textual menu and the toolbar are absent in the window 

“Variables”. All operations with the variables in the window “Variables” can be carried out only with the 

help of the context menu and hot buttons. Such simplification of the interface is completely 
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compensated for by the transparent operation with the variables. With the help of the window 

“Variables”, it is possible to edit variables while being in any command. Upon changing the expression of 

the variable in the window “Variables”, automatic recalculation of the drawing (or 3D model) is carried 

out. All changes are immediately displayed in the window of the system. 

 

EDITING EXTERN AL VARIABLES  

External variables are usually widely used in the T-FLEX CAD documents for organizing parametric 

connection between assembly document and fragments, and also for organizing connection of the 

T-FLEX CAD with other systems and applications. 

For editing variables, marked as external, besides the variables editor, the command M: Model 

Parameters can be used: 

 

Icon Ribbon 

 

Parameters → GUI Control → Model 

Keyboard Textual Menu 

<M> Parameters > Model 
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In contrast to the variables editor, only those variables of the current document which are marked as 

external are displayed in this command. This command does not allow a user to create new variables. 

Thus, if there are no external variables in the drawing, the message No external variables is produced 

and the command is not called. 

The kind of the dialog box used in this command depends on the attribute setting External variable 

editor in the command ST: Set Document Parameters (the tab External variables ). This attribute can 

assume one of the following settings: 

Internal Editor. Upon calling the command М: Model Parameters, the Variable Editor dialog box comes 

up for editing external variables, that looks similar to the normal variable editor window; 

External Program. In this case, the appearance of the dialog box is defined by the external custom 

application; 

Control. The user might have created a custom dialog box using interface elements (see the chapter 

“Control Elements. Creating User Defined Dialog Boxes”). In such a case, calling the command 

М: Model Parameters brings up this dialog box.  

The command M: Model Parameters can be used for modeling the process of editing external variables 

of the fragment in an assembly. One more possible way of using this command – when too many 

expressions are specified in the current drawing. In this case it is possible to mark the variables on which 

the remaining variables depend as external ones, and, if necessary, modify their values in the external 

variables editor. 

Upon changing the values of the external variables with the help of the command М: Model parameters, 

only constants can be used as admissible values of variables. 

After completing the command, all variables are recalculated per the changes to the external variables, 

and the drawing is regenerated with the new parameters. 

USE OF VARIABLES  IN T-FLEX  CAD   

The variables and expressions created within the variable editor do not affect the drawing in any way per 

se. The variable editor in itself is merely a powerful calculator. However, the variables can be used in T-

FLEX CAD system in many various ways. 

Variables and Construction Lines  

The main application for numerical variables is their use as construction line parameters. 

A variable can be assigned as a parameter to a construction line in the following two ways: 

When creating construction lines in the commands L: Construct Line, C: Construct Circle and EL: 

Construct Ellipse. This can be done in the dialog of the properties window for the given 

commands or in the dialog of the construction line parameters, called with the help of the 

option <P>. 

When editing construction lines in the command EC: Edit Construction. To do that, it is necessary 

to choose a line in the edit command. After that, it is possible to specify the variable as a line 
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parameter in the dialog of the properties window or in the dialog of the line parameters, called 

with the help of the option <P>. 

Your actions for defining a construction line parameter via a variable 

are the same in both cases. Therefore, consider only the example of 

editing construction lines.  

In this example, the left and bottom lines are constructed as vertical 

and horizontal respectively. The right and top lines are constructed as 

parallel, accordingly.  
 

Save this drawing with a certain name, say, TEST, as it will be further used for describing variable 

uses. 

Call the command EC: Edit Construction. Select the right vertical line In the dialog of the properties 

window place the cursor into the field of the parameter “Distance”. 

The distance from the reference line is a parameter of a parallel line, and, by default, this distance was 

specified as constant. Replace the value by the expression “-A”.  

     

Hit  at any place of the drawing. Two outcomes are then possible: 

- if the variable A exists, then the construction line will adjust to the variable value. 

- if the variable does not exist, then the dialog box will appear on the screen for defining the value of the 

new variable. You can then also mark the variable as external. After pressing [OK] the construction line 

will be adjusted in accordance with the value of variable. 

By doing the same with the top horizontal line and defining its parameter by a variable B, you establish 

relation between the variables and the construction lines. From now on, the construction line positions 

will be driven by modifications in the variables A and B. 
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Note that construction line parameters can be defined by variables only when the option  or 

<P> is available. (Refer to the commands L: Construct Line, C: Construct Circle, EL: Construct 

Ellipse). 

To clearly witness the relation between the construction lines and the variables, let’s complete the 

drawing. 

Draw the graphic lines using the command G: Create Graphic Line 

and apply the dimensions between the vertical and the horizontal 

lines using the command D: Create Dimension. 

After that, in the window “Variables” or in the main window of the 

variables editor (called with the command V: Edit Variables), 

change the value of variables A and B.  

 

Note that modifications in variables and expressions driving the construction lines, also affect the 

dimension display and dimension values. 

The dimensions themselves can be also used for modifying position of the construction lines, with 

which these dimensions are connected, and as a consequence, values of the variables determining 

parameters of these lines. To do that, it is necessary to point the cursor at the dimension value 

and hit . Chosen dimension value is selected for editing. Upon modifying the dimension value, 

the system automatically changes position and parameters of construction lines, on which the 

given dimension is based. If position of the given line was determined  by a variable, the value of 

this variable will be also changed. 

When using variables as construction line parameters, try not to use complicated expressions. The 

recommended approach is defining construction line parameters via a standalone variable or a simple 

expression. All complicated mathematical relations can then be defined within the variable editor. This 
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helps keeping definitions in one place, without need of visiting all possible commands and searching 

through all elements for handling. 

Variables and Visibility Levels 
 

It is often convenient to define visibility level values by variables. 

This helps covering a wider variety of configurations by a single 

parametric model. Consider, for example, the parametric drawing 

on the diagram. 

The two views are interdependent. The slanted line was 

constructed as passing through a node, at a specified angle to 

the horizontal. A variable AL is introduced as the parameter of the 

line. The configuration on the diagram corresponds to the value 

of AL = 130. Let’s modify the variable value to AL = 60. 
 

 

The upper dashed graphic line on the side view stays after 

modifications, which is wrong. This graphic line was originally 

created on top of a construction line parallel to the horizontal line 

and tangent to the circle. This flaw can be fixed by using the 

variable LEVEL as the value of the visibility level of the dashed 

graphic line. 

The value of this variable can be defined by the following 

expression:  

LEVEL = AL > 90 ? 0 : -1 
 

The visibility interval for graphic lines is set from 0 to 127 (inclusive). In our case, if the variable AL is 

greater than 90, then LEVEL equals 0, which is within the visibility interval. Therefore, the graphic line will 

be drawn. If AL is less than 90, then LEVEL = -1, which is outside the visibility interval, and the graphic line 

will not be drawn. This drawing sample can be found in the directory “Documentation samples/2D 

Design\Variables\ Variables and visibility on levels.GRB”. 

This approach allows creation of models representing a family of product modifications. An example 

could be a drawing of a bolt with various head styles. 

VARIABLE DEPENDENCY  

Variable interdependencies with other elements can be examined with the help of the command 

SR: Show Variable links. The command is called as follows, 

Icon Ribbon 

 

Parameters → GUI Control → Links… 

Keyboard Textual Menu 

<SR> Parameters > Links… 
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As a result of calling the command, the dialog box appears, listing all the variables of the drawing and 

their values in a tree layout. By default, only the visible variables are in the list. To view all variables of the 

given document (including hidden), set the flag Show Hidden Variables. 

The “+” glyph in a box before a variable indicates a collapsed branch. Such a branch contains a list of one 

or more drawing elements that rely on the variable. To expand the list, point and click the left mouse 

button over the box. The list contains element types and Ids. 

The listed elements, in turn, may be constructed based on other elements. In such a case, their branches 

will also be preceded by the box with the plus inside. The base (independent) elements in construction 

hierarchy are on plain branches, not prefixed with the box. The pane on the right-hand side of the dialog 

box displays information about the selected element. Besides that, the selected element is highlighted in 

the drawing or in the 3D window. 

 

Besides viewing relations of variables with drawing elements, you can additionally perform certain 

manipulations with 2D or 3D elements selected in the list, using the following buttons: 

[Parents] Upon clicking this button, the dialog window displays the tree of parent elements for the 

element selected in the list, instead of the list of all variables. This button is unavailable for the 

elements without parents. 

[Children] Works similar to the previous button, but instead of the parent element tree displays the 

children's tree for the selected element. 

[Delete] Closes the command window and calls the command to delete the selected element. 

[Edit] Closes the command window and calls the command to edit the selected element. 
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[Show] Closes the command window. The current drawing (model) working window is adjusted so 

as to fully display the selected element on the screen. 

[Select] Closes the command window. The selected elements stay selected for further 

manipulations. 

[Measure…]. Calls the command PM: Measure Element or relation between two Elements for the 

selected element. 

Properties…] Calls the parameters dialog for the selected element. After finishing working with the 

dialog, the SR: Show Variable links command window is resumed. 

[Close]. Exits the command. 

[<<] [>>] Open and close an additional console in the Information dialog window, containing the 

following fields: 

Information. This field displays a brief information about the selected object. 

Attributes. This field displays information about the attributes assigned to the selected element. 

AT TACHMENT I .  RULES FOR WRITING EXPRESSIONS .  FUNCTIONS 

FOR WORKING WITH VARIABLES  

Expression 

Expressions determining the values of the variables can contain operands (real constants and variables, 

text constants and variables) and operations (a set of actions upon these variables). Expressions can also 

include functions. 

Members of Expressions 

Numerical constants. 

Numerical variables. 

String variables. 

Numerical constants may not contain spaces. 

Examples of correctly defined constants: 

2; 3.344; -2.34; 1.234e+5; 1.2344E-32; 0.0034; 

Examples of incorrectly defined constants: 

2,34 – the comma is not allowed as the decimal symbol. 

1.234 e+5 – inadmissible “space” symbol is used in a constant. 

Note for local language users: in the exponential number representation, use only the US ASCII “E” or “e”. 

String constants. 

A string constant is an arbitrary string entered in quotes: 

“This is a string constant!” 
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Should a string constant include the quote symbol (“), it must be preceded by the backslash symbol (\). 

“This is another \”string\” constant!” 

The above is the way to enter a string constant, whose value is to read,  

This is another ”string” constant! 

To have the backslash symbol a part of a string constant, it must be duplicated. 

Example: 

“This \\is\\ t\w\o\!” 

The value reads, 

This \is\ two! 

Note that a single backslash is ignored throughout. 

Instructions (Operations) Used in Expressions 

The string members can only be subject to the operation 

concatenate, or, simply, addition of two strings ( + ) 

“T-FLEX”+” CAD” = T-FLEX CAD 

The numerical members are subject to common arithmetic operations, as  

addition ( + ) 

subtraction ( - ) 

multiplication ( * ) 

division ( / ) 

unary negation (minus). 

Examples of correctly defined expressions (followed by the result after the “=” sign): 

2 + 3 = 5 

5 - 9 = -4 

Do not divide by zero. This will result in an error. 

Use of “unary negation” operation is illustrated by the following example. Suppose, VAR_1 is equal to 5, 

then the following expression yields:  

- VAR_1 = -5 

An arbitrary number of spaces are allowed in expressions, for example,  

5   *   3    +    2 = 17 

Spaces make expressions more readable. 

An important issue is the order of operations (precedence). 

Thus, the resulting value of the following expression,  

2 + 3 * 4 
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will be 14, rather than 20, because multiplication operation has higher precedence than addition. To 

change the order of operations, use parentheses. The previous expression can be modified in the 

following way in order to yield 20: 

( 2 + 3 ) * 4 

Proper use of parentheses helps avoiding unexpected results. 

Power of ( ** or ^ ) 

Example: 

2 ** 3  = 8 

-3 ** 3 = -27 

The following examples demonstrate specifics of this operation: 

0 ** 17 = 0 (zero to any power is zero). 

23 ** 0 = 1 (any value to the power of zero is one). 

Errors may occur on evaluating this operation. The following message is output in such a case: 

“illegal power function in line 1”. 

Errors occur in the following cases: 

-2 ** 3.4 (an attempt to raise a negative value to a fractional power). 

23 ** 234344 (overflow error due to too large resulting value). 

Modulo division ( % ) 

Example: 

23 % 5 = 3 

23.7 % 5.5 = 1.7 

-23 % -5 = -3 

23 % -5 = 3 

-23 % 5 = -3 

The result of the operation member1 % member2 is the remainder of dividing member1 by member2. 

The value of member2 may not be zero. In the case member2 = 0, the error occurs, “Zero divide in 

line 1”. 

Besides the above-mentioned algebraic operations, logical (comparison) operations can be used in 

expressions. The result of a logical operation is the numerical value 1, if the relation defined by the 

operation is true, and 0 otherwise.  

Logical Operations  

Greater than ( > ) 

Less than ( < ) 

Greater than or equal ( >= ) 
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Less than or equal ( <= ) 

Inequality ( != ) 

Equality ( == ) 

Logical AND ( && ) 

Logical OR (  >  >  ) 

Logical NOT ( ! ) 

Examples: 

23 > 45 && 56 < 34  

This example expresses the question: Is the number 23 greater than the number 45 and the number 56 

less than the number 34? Obviously, the answer will be - no, therefore the value of this expression is 

zero. 

The expression !VAR_1 is the same as VAR_1 == 0 

Logical operations are usually used for comparing the value of a variable against a constant or a value of 

another variable. A shortcoming here is that only two values are possible as the result of evaluating a 

logical expression - 0 or 1.  

Another form of using logical operations is a conditional statement. 

A conditional statement has the following structure: 

condition ? value1 : value2 

Example: 

VAR_1 > 100 ? 1 : -1 

If the value of VAR_1 is greater than 100, then the statement will yield 1, otherwise it yields -1. 

One can use arbitrary expressions for the condition, value1 and value2. 

VAR_1 ? 1 : -1 

or, just the same thing, 

VAR_1 != 0 ? 1 : -1 

(VAR_1 != 0 && VAR_2 == 0) ? (VAR_3 + 1) : (VAR_4 -1) 

Standard Mathematical Functions 
 

ABS  Return absolute value of  abs ( -20 ) = 20 

ACOS Calculate arccosine acos ( 0.5 ) = 60 

ASIN Calculate arcsine asin ( 0.5 ) = 30 

ATAN Calculate arctangent atan ( 1 ) = 45 

CEIL Find integer ceiling ceil ( 3.98 ) = 4 
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COS Calculate cosine cos ( 60 ) = 0.5 

FLOOR Find largest integer less than or 

equal to argument 

floor ( 3.13 ) = 3 

HYPOT Calculate hypotenuse of right 

triangle 

hypot ( 3, 4 ) = 5 

INT Round to nearest integer  int ( 3.13 ) = 3 

LOG Calculate natural logarithm log ( 1 ) = 0 

LOG10 Calculate base-10 logarithm log10 ( 10 ) = 1 

RACOS Calculate arccosine, in radians racos ( 0.5 ) = 1.0472 

RASIN Calculate arcsine, in radians rasin ( 1 ) = 1.5708 

RATAN Calculate arctangent, in radians ratan ( 2 ) = 1.10715 

RCOS Calculate cosine, angle input in 

radians 

rcos ( 1 ) = 0.540302 

ROUND(

ARG1, 

ARG2 ) 

Round the value ARG1 with 

accuracy ARG2. 

Round ( 2.357, 0.25 ) = 2.25 

Round ( 2.357, 0.1 ) = 2.4 

RSIN Calculate sine, angle input in 

radians 

rsin ( 1 ) = 0.841741 

RTAN Calculate tangent, angle input in 

radians 

rtan ( 1 ) = 1.55741 

SIN Calculate sine sin ( 30 ) = 0.5 

SQRT Find square root sqrt ( 16 ) = 4 

TAN Calculate tangent tan ( 45 ) = 1 

 

All functions except hypot and ROUND have one numerical argument. Function arguments can be 

substituted by any expression, including other function calls that result in real numbers. 

SIN ( 10 + 10 + 10 ) = 0.5 

SIN ( SQRT ( 900 ) ) = 0.5 

The functions hypot and ROUND have two numerical arguments separated by a comma: 

 

HYPOT ( 1 + 1 + 1, 1 + 1 + 1 + 1 ) = 5 
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The angle arguments of trigonometric functions are input in degrees, except for the functions whose 

names begin with “R”. 

T-FLEX CAD Functions 
 

ATOF(“10.5”) Convert the string “10.5” to the real number 10.5 

ATOT(1.50.0110)LTOT(1.50.0110) 

SATOT(1.5) SLTOT(1.5) 
Convert the real number 1.5 to a string per the format specified by 

the rest three arguments  

FTOT(“variable name”) The function of conversion a numeric value to text. It converts a 

numeric variable or expression to the text using a comma instead 

of a dot. 

CHECK(“file name”, type) Find a file in the specified folders. 

DISTANCE (“NAME1”, “NAME2”) Get the distance between the entities specified by their names or 

Ids. 

ERROR(“STRING”) Display a user-defined message “STRING” on the screen 

FTOA(10.5)  Convert the real number 10.5 to the string “10.5”. 

FIXNODENAME(n) Get the name of the fragment’s node used for inserting the current 

document as a fragment by fixing points.  

This function is helpful for creating the libraries of logical and 

algorithmic schemes. It helps to orient direction of connecting 

arrow between elements. 

Input parameter: the number of the fragment’s fixing point. 

GET(“STR”,“P”) Get the real value of the parameter P of the system element 

named STR. Instead of element’s name it is possible to specify its 

identifier (ID). 

The entire list of parameters whose values can be obtained with 

the help of the function get, can be found in the Attachment II of 

this chapter. 

GETG/TGETG("NAME”,N) Get the value of a numerical/string global variable named NAME. 
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GETV(“NAME”,N) or  

GETV(“NAME_Page”,N) 

Get the value of the service parameter of the document named 

NAME. N – is a value that will be returned by the function if it does 

not find the indicated parameter. 

Certain parameters are defined separately for each 2D page of the 

document. In this case, the ending “_Page” is added to the name 

of the parameter, where “Page” – is a name of desired page of the 

current document. If the page name is not specified, the 

parameter value will be returned for the first page. 

The entire list of parameters whose values can be obtained with 

the help of the function getv can be found in the Attachment II of 

this chapter. 

GRAPH(“Graph_name”,X) Get the value of the function F(x), corresponding to the X 

argument value, for the graph named “Graph_name”. 

ISFRAGMENT() Find the assembly hierarchy level of a fragment. For the current 

drawing, returns zero 

MAX(N1,...,NN) Find the maximum value among the input set.  

MEASURE(“NAME1”, “NAME2”, 

“RELATION”) 
Get the value of requested relation RELATION between specified 

elements NAME1 and NAME2 (elements’ names or IDs can be used 

as input values). 

MIN(N1,...,NN) Find the minimum value among the input set. 

SETG/TSETG("NAME”,N) Set the value N of a numerical/string global variable named NAME. 

SETV(“NAME_Page”,N) or  

SETV(“NAME”,N) 

Set the value N of the global parameter named NAME for the 

page named “Page” of the current document. If the page name is 

not specified, the parameter value will be set for the first page of 

the document. 

STRLEN(“STR”) Find the number of characters in the string STR 

TFIND("string1", "string2") Searches for the substring "string2" in the string "string1". Returns 

an integer value equal to the position number of the first substring 

occurrence, counted from 1. In the case of an error (the substring 

is not found) returns 0. 
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TGET() This function allows the user to obtain textual properties of the 

elements: the name of the material of 3D operations, the values of 

text variables of the fragment. 

$text = tget(“0xD000001”,“$textvar”) – returns the string value 

from variable $textvar. 

$mater = tget(“Extrusion_0”,”Material”)  – defines material for the 

operation “Extrusion _0”. 

TGETV (“system variable”) Get the string value of a system variable or characteristics of the 

current drawing. 

The entire list of parameters whose values can be obtained with 

the help of the function tgetv, is given in the Attachment II of this 

chapter. 

TMGETV (“system variable”) Get the string value of a system variable of the assembly if the 

current drawing is inserted there as a fragment. 

This function works similar to the function TGETV. 

TPART(“string”,N,N) Get a substring. 

TREPLACE("string1", "string2", 

"string3") 
Replaces the substring "string2" by the substring "string3" in the 

string "string1". Returns a character string, which is the input string 

with the entry replaced. 

TWORD(“string”, N) Get a word from a string. 

$NAME=TWORD(“William Henry Gates”, 2) – results in assigning 

the value Henry to the variable $NAME. 

WARN(“STRING”)or  

WARN(“STRING”,”element name”) 

Display a user-defined message “STRING” in the diagnostics 

window. Include the element name in the message. 

Database Management Functions 
 

DBF(arg1, arg2, arg3) A dBASE database query. 

arg1 – database name. The database name can be defined by a 

string constant, variable or expression. 

arg2 – the name of the field to copy from. The field name can be 

defined by a string constant, variable or expression. 

arg3 – the condition for copying. The condition can be defined by a 

string constant, variable or expression. 
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DBFWIN(arg1, arg2, arg3) A dBASE database query. Also converts text from DOS to WINDOWS 

format. Is used for correct handling of local language text. 

The parameters are analogous to those of the function dbf. 

FIND(database_field, condition_1, 

condition_2, ...) 
Get a value from the internal database  

The function returns the value of the specified field database_field 

of a record satisfying the conditions condition_1, condition_2. If no 

suitable record exists, the function outputs the error message 

“Wrong record number”. 

MDB(arg1, arg2, arg3, arg4) An Access database request. 

arg1 - database name. The database name can be defined by a 

string constant, variable or expression. 

arg2 -the table name in the database. Can be defined by a string 

constant, variable or expression. 

arg3 - the name of the field to copy from. The field name can be 

defined by a string constant, variable or expression. 

arg4 - the condition for copying. The condition can be defined by a 

string constant, variable or expression. 

For example: 

mdb ( "c:\\T-FLEX_USER.mdb", "USER", "FULLNAME", "Code 

={kod}" ) 

This means: select the value from the table “USER” of the database 

“T-FLEX_USER” from the field “FULLNAME” under condition that the 

value of the field “Code” is equal to the value of the variable kod.  

It is worth noting that the last operand of the function, specifying 

condition for record selection, can be written in the form of SQL 

query and then it must correspond to the WHERE clause of the 

SELECT command. 

If, upon writing the condition, the text variables are used, the 

expression will take the following form:  

mdb ( "c:\\T-FLEX_USER.mdb", "USER", "FULLNAME", "Post=\"{$Dol}\"" ). 

REC(condition) Get the Id of a record in the internal database. 

condition – a logical expression, taking values True or False. The 

expression may contain members – queries to the fields of the 

database. 



Variables 

715 

FREC(arg1, arg2, arg3, arg4) Get the Id of a record in the internal database or in the database by 

reference, where the value in the specified column matches most 

closely the specified value. 

arg1 – a database column, in which the search is performed. Must 

be of real or integer type; 

arg2 –sought value;  

arg3 –search option. Possible values: 

 0 –find nearest value; 

 -1 –find nearest lesser value; 

 1 –find nearest greater value. 

arg4 –defines the column type to perform the search (the order in 

which the values occur in this column): 

 0 -the values are not in order; the search is performed over 

all database records; 

1 –the values in the column are ordered ascending or 

descending.  

Once the difference between the value sought and the value in the 

current column of the database is greater than in the previous one, 

the search completes. 

The parameters arg3 and arg4 are optional. If these are skipped, the 

default values are used: 

arg3 = 0; search for nearest value;  

arg4 = 0; column not ordered; 

FTOT Executes the transformation of a real variable or expression into the 

text with the use of comma instead of a period. 

VAL(record_number, 

database_field) 
Get the value from the internal database by the record Id. 

record_number -an arbitrary arithmetical expression, that yields an 

integer.  

database_field -a field query. 

#.<name> Get the number of records in the specified internal database  

The detailed description of T-FLEX CAD functions follows below. The database managing functions 

description are also available in the chapter “Databases”. 

Examples of function uses: 

sin ( 30 ) = 0.5 

min ( 5, 67, 34, 28, 0.67 ) = 0.67 
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SQrt ( 16 ) = 4 

As evident in the last example, the function naming is case-insensitive. 

AT TACHMENT I I .  EXAMPLES OF USING SOME FUN CTIONS  

Using Functions ATOT (), LTOT (), SATOT (), SLTOT () 

These four functions are intended for converting numerical values to character strings in a specified 

format. The conversion format is similar to that used for converting the nominal dimension values. 

 

The function SATOT () converts a real number of an angular value into a string of text. The conversion 

parameters are defined by the settings of the ST: Set Document Parameters command on the 

Dimensions tab. 

The function SATOT () specifically uses the definitions from the Angular Dimensions group. Suppose, the 

following parameters are defined in the ST: Set Document Parameters command. 

In this case, calling SATOT (120.34567) leads to the following result: 

12%%d30’ 

  

The character combination %%d stands for the degree symbol (). 

 

In order to realize this character combination as the degree symbol, the variable must be used as a 

parameter of some detailing element, such as a text (string text only), dimension, leader note, etc. 

Let’s clarify the above on the following example. Suppose, the following value is assigned to the variable 

$str by the function call: 

 

$str = SATOT ( 120.34567 ) = 120%%30’ 

We will then create a dimension with the “Before” string containing the variable in braces instead of the 

default. The following result will then be displayed: 
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The variables that are assigned return values of such functions can also be entered (in braces) in string 

text. Such text will then be correctly displayed as well. 

Modifying the Units parameter in the command ST: Set Document Parameters as shown leads to the 

following result: 

SATOT ( 120.34567 ) returns    120.5%%d 

 

The “Accuracy” parameter allows controlling the accuracy of the returned result: 

SATOT ( 120.34567 ) returns    120%%d21 

 

The “Minimum digits” parameter is used only for decimal representation: 

SATOT ( 120.34567 ) returns    120.500%%d 

  

The function SLTOT () differs from the previous one only in that the value to be converted is considered a 

linear value. Therefore, the conversion formats change accordingly. There are four standard formats for 

this function: 

1 – decimal format. Example: 1.123; 

2 – in inches; 
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3 – in inches and fractions; 

4 – in feet, inches and fractions. 

The following settings showing in the pictures result in: 

SLTOT ( 120.34567 ) returns    120.35 

  

The functions ATOT () and LTOT () are, respectively, the variations of the functions SATOT () and SLTOT (), 

with the conversion parameters defined explicitly. 

The calling sequence of the function LTOT is as follows, 

LTOT (value, accuracy, standard, digits), where 

value – a real number to be converted; 

accuracy – the accuracy to be used in the conversion; 

standard – the measurement system; takes one of the following values: 

 1 – decimal format. Example: 1.123; 

 2 – in inches; 

 3 – in inches and fractions; 

 4 – in feet, inches and fractions; 

digits – the number of significant decimal digits in the decimal representation. 

The calling sequence of the function ATOT is as follows, 

ATOT (value, accuracy, standard, digits), where 

value – a real number to be converted; 

accuracy – the accuracy to be used in the conversion; 

standard – the angular units; takes one of the following values: 

 1 – decimal format. Example: 1.123; 

 2 – degrees, minutes and seconds. Example: 12’30”. 

digits – the number of significant decimal digits in the decimal representation. 

Example: 

LTOT ( 120.34567, 0.001, 1, 5 ) returns    120.34600 

Using Function GET () 

This function returns the value of the requested property of a 2D or 3D element, as well as the current 

drawing page. Sets of accessible properties vary depending on the queried element. 
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The function will be automatically substituted as expression for a variable if such variable is 

created when measuring properties of 2D or 3D element in PM: Measure Element or relation 

between two Elements command. 

The calling sequence: 

GET  ( “string1”,  “string2” ), where  

string1 – the queried element name or Id, 

string2 – the parameter name. 

All 3D elements and operations are assigned Ids (unique identification numbers). They are also assigned 

a "Name" parameter that is automatically initialized by a system default. The name can be changed by 

the user if necessary. The 2D elements by default only get an Id. Names can be assigned to some 2D 

elements, particularly, to 2D nodes and graphic lines. The names are assigned in the editing commands, 

such as “EN: Edit Node” or “EG: Edit Graphic Line”, using the  option. 

The elements whose parameters can be got by the described function, are: 

- the drawing's 2D pages; 

- construction lines; 

- nodes; 

- graphic lines; 

- text; 

- fragments; 

- hatches; 

- 3D elements; 

- 3D operations; 

- faces, edges, loops. 

The following reserved names are used for the available parameters: 

for 2D pages of a drawing: 

“ZONES_STEP_X”  the size of one zone along X-axis (the step size along X-axis); 

“ZONES_STEP_Y”  the size of one zone along X-axis (the step size along Y-axis_; 

“ZONES_OFFSET_X”  the offset of the area being divided into the zones from the point (0,0) - 

along X-axis; 

“ZONES_OFFSET_Y”  the offset of the area being divided into the zones from the point (0,0) - 

along Y-axis; 

“ZONES_COUNT_X”  the number of zones along X-axis; 

“ZONES_COUNT_Y”  the number of zones along Y-axis. 

The parameters of dividing a drawing page into zones are defined in the command ST: Set 

Document Parameters, on the tab Paper > Zones. 
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for nodes: 

“X” – X-coordinate of the node; 

“Y” – Y-coordinate of the node; 

for construction lines: 

lines: 

“X”, “Y” – the coordinates of the first node the straight construction line is passing through; 

“P1”, “P2” – the coordinates of the second node the straight construction line is passing 

through; 

circles and ellipses: 

“LENGTH” – the length of the circumferential; 

“P1” – the radius of the circle (this parameter is specific to circles); 

“X”, “Y” – the coordinates of the center of the circle; 

splines, 2D paths, functions and offsets: 

“LENGTH” – the entity length; 

for graphic lines: 

segments: 

“LENGTH” – the segment length; 

“START_X”, “START_Y” – the coordinates of the start point of the segment; 

“END_X”, “END_Y” – the coordinates of the end point of the segment; 

based on circles:  

“LENGTH” – the length of the circle arc; 

“CENTER_X”, “CENTER_Y” – the coordinates of the circle center; 

“ANGLE” – the angular arc length of the graphic line; 

“RADIUS” – the radius of the circle; 

based on ellipses, splines, 2D paths, offsets and functions: 

“LENGTH” – the entity length; 

for graphic lines constructed as a circular or elliptical arc, portion of spline, 2D path, offset or 

function, there are following additional parameters: 

“START_X”, “START_Y” – coordinates of the arc start point; 

“END_X”, “END_Y” – coordinates of the arc end point; 

for hatches: 

“AREA” – the hatch area; 

“PERIMETER” – the hatch contour perimeter; 

“XMASS” – X-coordinate of the center of gravity; 
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“YMASS” – Y-coordinate of the center of gravity;  

“XAREAMOMENT” – 1x component of inertia moment; 

“YAREAMOMENT” – 1y component of inertia moment; 

“PRODUCTAREAMOMENT” – Centrifugal inertia moment of area; 

“XINERTIARADIUSVALUE” – Radius of inertia X; 

“YINERTIARADIUSVALUE” - Radius of inertia Y; 

“XAREAMOMENTMAINVALUE” – 1x component of principal moment of inertia relative to mass 

center; 

“YAREAMOMENTMAINVALUE” – 1y component of principal moment of inertia relative to mass 

center; 

“MAINAXESROTATIONVALUE” – Rotation angle of principal axes. 

for text: 

“WIDTH” – the text width; 

“HEIGHT” – the text height; 

“X”, “Y” – X and Y coordinates of text fixing point; 

“TEXT” – text content; 

 

for fragments: “string1” represents the fragment name or Id, “string2” – the name of the fragment 

variable. The function returns the value of the variable. 

In addition, the following parameters are available for 2D fragments: 

“BoundBoxLeft” – left coordinate of bound box (X-coordinate); 

“BoundBoxRight” – right coordinate of bound box (X-coordinate); 

“BoundBoxTop” – top coordinate of bound box (Y-coordinate); 

“BoundBoxBottom” – bottom coordinate of bound box (Y-coordinate); 

“BoundBoxCenterX” –X-coordinate of bound box center; 

“BoundBoxCenterY” –Y-coordinate of bound box center. 

In the three-dimensional version of the system, the following 3D element parameters are accessible: 

for operations: 

“Area” – the surface area; 

“Mass” – the mass of the body (material density accounted); 

“Xmass”, “Ymass”, “Zmass” – X, Y, Z-coordinates of the center of gravity; 

“IX”, “IY”, “IZ” – the moments of inertia about the axes X, Y, Z respectively; 

“IXY”, “IYZ”, “IZX” – the products of inertia with respect to the planes XY, YZ, ZX; 

“Volume” – volume; 
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for Apply Material operation the following additional parameter is used: 

“MaterialArea” – total area of faces with the attached material; 

for all 3D Arrays (except arrays of faces) the following additional parameter is used: 

“CopyCount” – actual number of copies in the array (with account of limitations and 

exclusions); 

for 3D nodes: 

“POINTX”, “POINTY”, “POINTZ” – X, Y, Z-coordinates of the 3D node; 

for a 3D profile: 

“Area” – the area of the surface surrounded by the 3D profile; 

“Perimeter” – perimeter of a closed 3D profile or length of an open one; 

for a 3D path: 

“Perimeter” – the length of the 3D path; 

for a face: 

“Area” – the area of the face surface; 

“Perimeter” – the perimeter of the face border; 

special for a flat face: 

“LocationX”, “LocationY”, “LocationZ” – X, Y, Z-coordinates of the face’s underlying plane 

origin; 

“NormalX”, “NormalY”, “NormalZ” – X, Y, Z-coordinates of the normal to the face’s underlying 

plane; 

“RefDirectionX”, “RefDirectionY”, “RefDirectionZ” – X, Y, Z-coordinates of the reference vector 

on the plane (the plane vector defines the direction of the X-axis of a flat plane); 

special for a cylindrical face: 

“Radius” – the radius of the cylinder; 

“Diameter” – cylinder diameter; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinates of the center; 

“AXISX”, “AXISY”, “AXISZ” – X, Y, Z-coordinates of the axis; 

for a toroidal face the following additional parameters are used: 

“MaxRadius”, “MinRadius” -  major and minor torus radii; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinates of the torus center; 

“AxisX”, “AxisY”, “AxisZ” – X, Y, Z-coordinates of the torus axis; 

for a spherical face additional characteristics are used: 

“Radius” – sphere radius; 

“Diameter” – sphere diameter; 
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“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinates of sphere center; 

for an edge: 

“Perimeter” – the edge length; 

“StartX”, “StartY”, “StartZ” – X, Y, Z-coordinates of the start point; 

“EndX”, “EndY”, “EndZ” – X, Y, Z-coordinates of the end point; 

special for a straight edge: 

“VECTORX”, “VECTORY”, “VECTORZ” – X, Y, Z-coordinates of the edge direction; 

for a circular edge or along circular arc: 

“Radius” – circle radius; 

“Diameter” – circle diameter; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinate of the circle center; 

“AxisX”, “AxisY”, “AxisZ” – X, Y, Z-coordinates of the circle plane normal; 

“StartAngle” – arc start angle; 

“EndAngle” – arc end angle; 

special for a elliptical edge: 

“MajorRadius” – ellipse major radius; 

“MinorRadius” – ellipse minor radius; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinate of the ellipse center; 

“AxisX”, “AxisY”, “AxisZ” – X, Y, Z-coordinates of the normal to the ellipse plane; 

“MaxDirectionX”, “MaxDirectionY”, “MaxDirectionZ” – X, Y, Z-coordinates of the ellipse major 

axis; 

“MinDirectionX”, “MinDirectionY”, “MinDirectionZ” – X, Y, Z-coordinates of the ellipse minor 

axis; 

“StartAngle” – the start angle; 

“EndAngle” – the end angle; 

for loop: 

“Perimeter” – loop perimeter. 

The parameter names are case-insensitive. If an incorrect element name or parameter name is input, then 

the function returns 0. 

Examples: 

Get the X-coordinate of a node named NODE_1 by calling the function GET () as follows, 

get ( “NODE_1”, “X” ) 

Get the length of a graphic line named IMAGE_1 as follows, 

get ( “IMAGE_1”, “length” ) 
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Get the perimeter of the contour of the hatch Id 0x9000001 as follows, 

get ("0x9000001”, "PERIMETER”) 

Get the volume of the 3D body of a 3D fragment named 3D fragment_11 as follows, 

get ("3D fragment_11”, "volume”) 

To compute the total length of a chain of connected graphic lines, one could call the function GET() for 

each line and sum up the results. However, a more efficient way is to construct a 2D path that follows 

along the chain of the graphic lines, and create a single graphic line from this path. In this case, the 2D 

path is considered a spline. Then it is easy to get the length of this single graphic line. 

Using Functions DISTANCE() and MEASURE() 

Function distance() returns the value of distance between two 2D or 3D elements. 

The function will be automatically substituted as expression for a variable if such variable is 

created when measuring distance between two 2D or 3D elements in “PM: Measure Element or 

relation between two Elements” command. 

The calling sequence: 

distance ( “name1”,  “name2” ), where 

name1 - name or ID of the first element, 

name2 - name or ID of the second element. 

Distance can be calculated for the following pairs of 2D or 3D objects: 

2D elements – is the distance between a 2D node and another 2D node, construction line, 

graphic line or hatch (the order of selecting the measurable entities is not significant); 

3D objects – is the distance between two arbitrary 3D objects that are 3D construction entities 

(except for LCS), operations or such topological objects as an edge, loop, face, vertex. 

Function distance() also measures distances for such geometrical 3D objects as vertices, edges, loops, 

faces. This is possible only for already named objects. Naming (e.g. “Vertex_1 or “Edge_2”) occurs 

automatically in “PM: Measure Element or relation between two Elements» or in commands where such 

objects were specified as source data. These names should be used as input parameters. 

Function measure() calculates various relations between two 2D or 3D objects. 

The function will be automatically substituted as expression for a variable if such variable is 

created when measuring any relation (except distance) between two 2D or 3D elements in “PM: 

Measure Element or relation between two Elements” command. 

The calling sequence: 

Measure ( “name1”, “name2”, “relation”), where 

name1 – name or ID of the first element, 

name2 – name or ID of the second element. 

relation – type of  relation. 
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Function calculates the following types of relations: 

for 2D elements: 

“Angle” – is the angle between two lines, segments or a line and a segment. 

for 3D objects: 

“Angle” – is the angle between directional vectors of two 3D objects. Listed below are 3D 

objects, for which a direction can be defined (and, therefore, this relation can be calculated). 

Additionally specified is what will be selected as the direction vector for each object: 

for a 3D path or open 3D profile lying on a straight line – the line direction; 

for a 3D path or open 3D profile lying on an ellipse (circle) – the vector directed from the 

center of the ellipse (circle) normal to the plane of the ellipse (circle); 

for a flat 3D profile; workplane; an operation body consisting of one face lying in a plane – 

the normal to the plane; 

for a cylindrical work surface; 3D profile lying on a cylinder; an operation body consisting of 

one face lying on a cylinder – the axis of the cylinder; 

for a 3D profile, lying on a cone; an operation body consisting of one face lying on a cone – 

the axis of the cone; 

for a toroidal work surface; 3D profile or face lying on a torus; an operation body consisting 

of one face lying on a torus – the axis of the torus. 

“AxisDistance” – is the distance between the axis of two 3D objects. The same 3D objects can be 

selected as the objects of the measurement as in the previous case (when identifying “Angle”), 

except for workplanes. In the latter case, the axes of the selected objects coincide with the 

directional vectors of the planes; 

“DX” – Shift of two 3D nodes or 3D points with respect to each other along the X-axis; 

“DY” – Shift of two 3D nodes or 3D points with respect to each other along the Y-axis; 

“DY” – Shift of two 3D nodes or 3D points with respect to each other along the Z-axis. 

 

Analogous to distance(),  measure() can calculate relations between various topological 3D objects - 

vertices, edges, loops, and faces,  that were already named earlier in “PM: Measure Element or relation 

between two Elements” or other commands. 

One more additional relation can be measured for vertices, edges and faces, as well as for a pair 

“geometrical object – 3D node”: 

“GeomDistance” – is the distance between 3D points, 3D curves or surfaces corresponding to 

two respective 3D objects of the types: 3D node, vertex, edge, face. 

Input parameters for distance() and measure() functions can be specified using either small or capital 

letters analogous to get() function. If an incorrect element name or relation name is input, then the 

function returns 0. 
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Examples: 

Distance between two 3D nodes “3D Node_0” and “3D Node_1” can be measured with the following call 

of distance() function: 

distance ( “3D Node_0”, “3D Node_1” ) 

Distance between image line with ID 0x3000014 and 2D node named as “Node 1” will be returned by the 

following call: 

distance ( “0x3000014”, “Node 1” ) 

Axial distance between cylinder axis resulted from extrusion operation named “Extrusion_1” and torus 

axis from “Rotation_2” operation can be calculated with the following call to measure() function: 

measure ("Extrusion_1", "Rotation_2", "AxisDistance") 

“PM: Measure Element or relation between two Elements” command is recommended for using 

distance() and measure() functions. Read more details in chapter “Measure Elements and Relations 

between Them”. 

Using Function CHECK () 

This function searches files by name in certain directories. Specifically, the files are searched in the 

current directory, and in the directories specified in the command SO: Set System Options on the 

Folders tab. 

CHECK (“FILE NAME”, TYPE)  

The file name must be specified with the extension. The file type is defined as follows,  

0 – undefined; 

1 – T-FLEX CAD document; 

2 – font; 

3 – database; 

4 – pattern; 

5 – BOM. 

Using Functions SETV () and GETV () 

Functions setv() and getv() allow the user to obtain and specify the values of real service characteristics of 

the T-FLEX CAD documents, such as the number of pages in the document, scale and font size, assigned 

for each page, coordinates of corners of the title block, volume of all bodies in the 3D scene (if the 

document contains a 3D model), etc. The values of these characteristics can be used, for example, for 

transferring data between the assembly drawing and the fragments. 

Syntax of Functions 
setv("NAME",N) 

This function sets the numeric value N for the parameter of the current document NAME. 
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getv ("NAME",Err) 

This function returns the value of the parameter NAME of the current drawing.  Err – the value which will 

be returned by this function if the indicated parameter is not found. 

 

In multipage document certain characteristics (scale, font size, etc.) are set independently for each page 

of the document. By default, the functions get() and set() deal with the characteristics of the first page of 

the document. 

 

To address characteristics of other pages it is required to add “_Page” to the end of the parameter’s 

name, where “Page” – the name of the desired page. 

List of Characteristics of the T-FLEX CAD Document Processed by Function GETV() 
Characteristics of 2D pages of Document: 

PAGES – total number of pages in current document; 

DPAGE – the number of the current drawing’s page; 

DPAGES – total number of drawings’ pages in the document;; 

SCALE – scale of current drawing; 

XL – coordinate X of the left border of the drawing;  

XH – coordinate X of the right border of the drawing; 

YL – coordinate Y of the lower border of the drawing; 

YH – coordinate Y of the upper border of the drawing; 

FSIZE – font size of the drawing. 

LTHICK – thickness of main lines in the drawing. 

TLTHICK - thickness of thin lines in the document. 

Characteristics of 3D scene of Document: 

MASS – mass of all bodies in the 3D scene of the current document; 

VOLUME – volume of all bodies in 3D scene of the current document; 

AREA – surface area of all bodies in 3D scene of the current document; 

EXPLODE – state of exploded view mode for the fragments of 3D model of the current 

document (0 – exploded view mode is turned off, 1 – turned on). 

XSIZE, YSIZE, ZSIZE – measure overall 3D model sizes by X, Y and Z axes of the global coordinate 

system. 

Characteristics of fragments calculated from assembly: 

_XL – coordinate X of the left border of the assembly drawing when using the current document 

as a fragment; 
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_XH – coordinate X of the right border of the assembly drawing when using the current drawing 

as a fragment;  

_YL – coordinate Y of the lower border of the assembly drawing when using the current drawing 

as a fragment;  

_YH – coordinate Y of the upper border of the assembly drawing when using the current 

drawing as a fragment; 

 APAGES - returns the total number of pages in the document containing a given fragment; 

APAGE - returns the number of the page which contains a given fragment; 

BOMPAGES – returns the total number of pages in the BOM of the document containing a given 

fragment; 

BOMPAGE – returns the number of the page of the BOM which contains a given fragment. 

The values of these characteristics are calculated for the document-fragment inside the assembly. 

For example, if in the document of the fragment the user created the variable the value of which is 

specified by the expression (“apage”, -1), then inside the document of the fragment the value of 

this variable will be equal to -1, and inside аn assembly document – to the number of the page of 

the document which contains a given fragment.   

List of Characteristics of T-FLEX CAD Document Processed by Function SETV() 
Characteristics of 2D pages of document: 

SCALE – scale of current drawing; 

XL – coordinate X of left border of drawing;  

XH – coordinate X of right border of drawing; 

YL – coordinate Y of lower border of drawing; 

YH – coordinate Y of upper border of drawing; 

FSIZE – font size of the drawing. 

LTHICK – thickness of main lines in the drawing. 

TLTHICK – thickness of main lines in the drawing. 

Characteristics of 3D scene of document: 

EXPLODE – state of exploded view mode for the fragments of 3D model of the current 

document (0 – exploded view mode is turned off, 1 – turned on). 

Examples of Using Functions 
getv("SCALE",0) – returns the value of the scale specified for the first page of the current 

document; 

getv("SCALE_Page 2",-1) – returns the value of the scale specified for the page of the current 

document with the name “Page 2”. If this page is absent in the document, the function returns 

the value “-1”; 
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getv("mass",0) – returns the value of mass of all bodies in the 3D scene of the current document. 

If the 3D scene is empty, the function returns the value “0”; 

setv("SCALE_Front_0",2) – this functions sets the value of the scale equal to 2 for the page 

“Front_0” (page of workplane “Front view”); 

setv("explode",1) – this function activates the exploded view mode for the 3D model in the 

current document. 

 

 

Using Function TGETV () 

Function tgetv() allows the user to obtain the values of  system’s text characteristics of the current T-

FLEX CAD document. 

Syntax of functions: 

tgetv ("NAME"), where NAME – the name of text parameter of the system or the current 

document. 

Any of the following characteristics can be used as parameter of this function: 

USERNAME – Name of current user of the system; 

YEAR – Current year; 

MONTH – Current month (number); 

DAYOFWEEK – Current day of week (number); 

DAY – Current day of month (number); 

HOUR – Current hour; 

MINUTE – Current minute; 

SECOND – Current second; 

DATE – Current date (the name) in accordance with system’s current settings; 

TIME – Current time in accordance with system’s current settings; 

REGNAME – User name on whom the system is registered; 

REGCOMPANY – Name of company on which the system is registered; 

TITLE – Title of current drawing; 

SUBJECT – Subject of current drawing; 

AUTHOR – Name of author of current drawing; 

KEYWORDS – Keywords of current drawing; 

COMMENTS – Comment of current drawing; 

TEMPLATE – Template of OLE document; 

LASTAUTHOR – Name of author who last saved the drawing by; 
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REVNUM – Number of revision of current drawing; 

EDITTIME – Total editing time of current drawing; 

PRINTDATE – Date of the last print of current drawing; 

CREATEDATE – Date of creation of current drawing; 

SAVEDATE – Date of last save of current drawing; 

FILENAME – Name of current file (the returned line contains full path to current document and 

the file name with extension); 

SHORTFILENAME – Name of current file (the returned line contains the file name only); 

FORMAT – Title block of current drawing; 

_FORMAT - Format name for the drawing of the page on which the current fragment is inserted; 

FORMAT_BOM – Returns format of first “BOM” type page. If there is no such a page, it returns 

first page format.  

SCALE – Scale of current drawing; 

_SCALE - Scale for the drawing of the page on which the current fragment is inserted;  

SCALEVALUE – Scale of the current drawing (the returned string contains the value of the scale 

without the letter М); 

_SCALEVALUE – Scale of the drawing’s page onto which the current fragment is inserted (the 

returned string contains the value of the scale without the letter М). 

PAGENAME – Name of the page on which the current fragment is inserted; 

PAGETYPE – Type of the page on which the current fragment is inserted. 

 

Example of using the function tgetv: 

$TIME = tgetv ("TIME") 
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MEASURE ELEMENTS AND RELATIONS BETWEEN THEM 

The command PM: Measure Element or relation between two Elements serves for measuring various 

geometrical characteristics (coordinates, length, perimeter, area, volume, etc.) of a 2D or 3D object, as 

well as relations (distance, angle, etc.) between two objects. A new variable can be automatically created 

based on a measured parameter, or the value of an existing variable can be modified. 

CONDUCTING ME ASUREMENTS  

The command PM: Measure Element or relation between two Elements can be called as follows: 

Icon Ribbon 

 Measure → Measure → Measure 

Keyboard Textual Menu 

<РМ> Parameters > Measure 

 

After calling the command, the following actions become available: 

 

<Ctrl+ 

Enter> 
Finish input 

 <Esc> Exit command 

 <1> Measure one element parameter 

 <2> Measure relation between two elements 

 <3> Measure Multiple Elements 

 <4> Select LCS 

 <C> Reset target LCS 

 <5> Body measurement mode 

 

At the first step of the command you need to select what will be measured:  

 - a single object parameters  

 - a relation between two objects (the option )  

 - the sum of parameters of several objects.  
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After activating the selected mode, pick the object or objects to be measured in the 2D or 3D window. 

The state of element selection filters in the system toolbar affects the selection. The set of filters depends 

on which type of window is currently active in the system (2D or 3D). 

Measuring Parameters of Single Element 

Upon activating this mode and picking the object to be measured, the name of the selected object will 

be displayed in the Measure section of the properties window within the Element field, along with its 

available set of parameters (the table Property). 

Upon selecting the desired parameter in this list, you can view the following in the additional fields below 

the parameters list: 

- description of the given parameter (for example, “Element length” or “Circle radius”); 

- its value in the model units (model units are defined in the command ST: Set Document 

Parameters on the tab 3D); 

- an expression that is used to evaluate the given parameter (for example, 

get(“0x3000011”,“LENGTH”)). 

To create a variable based on the selected parameter, you need: 

Select the desired parameter in the list; 

In the “Variable” section of the properties window set the radio 

switch “Create/Replace” in the “Create” state (the default setting); 

Enter the name of the variable being created; 

Enter a comment for the variable being created in the field 

“Comment” comment (optional); 

Click the button [Apply]. 

After that, you can complete the command or create another 

variable by selecting its respective parameter in the list. 

In the case when, instead of creating a new variable, a new 

expression needs to be defined for an already existing variable, 

the order of steps is similar to the described, with one exception: 

the “Create/Replace” switch shall be set in the “Replace” state. 

The name of the variable being edited is selected from the 

combo box at the right of the radio switch. The list displace all 

variables present in the given document (except the hidden 

ones). Upon clicking the [Apply] button, the old expression of the 

specified variable will be replaced by the new expression 

corresponding to the selected parameter.  

All created and edited variables can be viewed in the variable editor (the command “V: Edit 

Variables”). 
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Filter of the measured values allows to display values that satisfy selected filter in the properties window. 

 

Measuring Relations between Two Elements 

To measure relations between two 2D or 3D 

objects, activate the mode  and subsequently 

select two measured objects. The selected objects 

will be highlighted and entered in the fields First 

element and Second element of the properties 

window. The relations that can be measured on the 

selected elements appear in the Relation table. 

In the rest, working in this mode is analogous to 

the steps when measuring parameters of a single 

element. 
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Measure Multiple Elements 

To get a summary value of the identically-named 

characteristics of several elements, it is necessary to 

select the  option.  

After this mode is enabled, it is required to select 

the required objects. In the command’s properties 

window, in the Element field the names of the 

selected objects will be shown. In the Property 

table those summary characteristics which can be 

calculated for the selected set (for example, total 

length or mass) will be listed. 

In this way it is possible to measure only the 

following parameters: 

 Mass (total mass of the elements); 

 Perimeter (total perimeter of the 

elements); 

 Area (total area of the elements); 

 Length (total length of the elements). 

 

ADDITIONAL METHODS OF CALLING COMMAND  

Calling Command from Context Menu 
 

This method is convenient when you need to measure 

parameters of a single object. For this, select an object in the 

2D or 3D window, whose parameters are to be measured, and 

right-click . In the coming up context menu select the item 

Measure…. This will result in launching the command 

Parameters > Measure in the mode of measuring parameters 

of a single object. The 2D or 3D object over which the context 

menu was accessed gets automatically selected for conducting 

measurements. Further steps within the command are fully 

identical with the described above. 
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Calling Command in Transparent Mode when Defining Parameters of 2D or 3D 

Elements 
 

When defining numerical parameters of any 

T-FLEX CAD element (construction or graphic 

line, 3D node or operation, etc.) one could 

need to relate one of the parameters with a 

certain geometric characteristics of the given 

model. This could be, for example, the 

distance between two of the model elements 

or the length (angle, perimeter, area etc.) of 

another element. 

To define such relation, simply set the course 

are in the input field of the respective 

parameter in the properties window or the 

parameters dialog and press <F12>. 

Alternatively, you can access the context 

menu at this moment (by right clicking ) and 

select the Measure item in it. The properties 

window (or parameters dialog) of the element 

being edited temporarily disappears, while the 

command PM: Measure Element or relation 

between two  Elements is launched. 
 

 

Next, you need to select the command mode (measuring one or two objects), the object or objects to 

measure and the desired measurement parameter. 

 

Using the Expression, Value, Variable drop-down list, specify in what form the value of the selected 

parameter will be returned: as an expression (using the function get(), distance() etc.), variable or a 

constant. Clicking  completes the command. After that, the original parameters dialog reappears on 

the screen, that launched the command. It will already have the geometrical parameter value or 

expression that was used to evaluate it, in the parameter input field. 
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ADDITIONAL FE ATURES OF THE MEAS URE COMMAN D  

If you call the command when designing a 3D model additional options become available. 

 <N> Select objects with rectangle 

Body Measurement Mode 

Body measurement mode  allows to consider possible changes in the once measured body. 

It is available for single body measurement mode . You need to select  option and select a body in 

the scene. 

 <5> Body measurement mode 
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For example, you measure the area of a body and assign variable for it. Then you apply Boolean 

operation to the body and the area changes. In this case the corresponding variable will change as well. 

Material Properties 

The Measure command is available for materials of 3D models. For measurement of material properties, 

it is necessary to activate the command and to choose material in the 3D model tree. 

 

The measured values of materials physical properties can be saved as variables. You can use them in 

calculations so that there is no need to enter them manually. 
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Measurements Relative to LCS 

You can measure bodies according to the selected LCS using option: 

 <4> Select LCS 

If a single body was selected, the body will be measured relative to the selected LCS. 

 

For example, we have an exported body. If you want to receive overall dimensions of the body, you need 

to create an LCS and measure dimensions relative to the LCS. 

 

 

If several bodies are selected, you can measure distance between them relative to the “X” axis of the 

coordinate system. 

For example, you need to measure distance between body vertexes relative to the “X” axis.  

First, you need to create a LCS. The measurement will be performed with respect to its X-axis. 

After that select Measure relations between two elements option  and vertexes of the body. 

Then activate Select LCS  option and select the already created LCS. 

The selected elements are projected on the X-axis of the specified local coordinate system, and then the 

distance between them is measured. 

 

In the current example, when measuring the distance between two vertices (Vertex_5 and Vertex _6), 

these vertices are projected on the X-axis of the specified coordinate system (LCS_2). 

 

This possibility is helpful, For example, when you want to measure objects of irregular shape. 
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You can specify variable for the measured value. 

To reset target LCS use option: 

 <C> Reset target LCS 

MEASURABLE PARAMETE RS AND REL ATI ONS  

Measurable Parameters 

The set of parameters that can be measured by the command PM: Measure Element or relation 

between two Elements depends on the selected object of measurement. Follows below is the list of 

parameters for all 2D and 3D objects. 

The command uses the function get() for measuring parameters. Syntax description and examples 

of standalone use of this function are provided in the chapter “Variables”. 

2D elements 
2D nodes: 

“X” – X-coordinate of the node; 

“Y” – Y-coordinate of the node; 

Construction entities: 

Straight lines: 
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“X”, “Y” - coordinates of the first point through which the construction line passes; 

“P1”, “P2” - coordinates of the second point through which the construction line passes; 

Circles and ellipses: 

“LENGTH” – length of the circle or ellipse; 

“P1” – circle radius (this parameter is specific to circles); 

“X”, “Y” – coordinates of the circle or ellipse center; 

Splines, 2D paths, functions and offsets: 

“LENGTH” – element length; 

Graphic entities: 

Straight segments: 

“LENGTH” - segment length; 

“START_X”, “START_Y” – coordinates of the segment start point; 

“END_X”, “END_Y” – coordinates of the segment end point; 

Circles: 

“LENGTH” - arc length; 

“CENTER_X”, “CENTER_Y” – circle center coordinates; 

“ANGLE” - angular length of a graphic entity; 

“RADIUS” – arc or circle radius; 

Ellipses; splines; curves constructed by 2D path, offsets and functions: 

“LENGTH” – element length; 

for graphic lines constructed as a circular or elliptical arc, portion of spline, 2D path, offset or 

function, there are following additional parameters: 

“START_X”, “START_Y” – coordinates of the arc start point; 

“END_X”, “END_Y” – coordinates of the arc end point; 

Hatches: 

“AREA” – hatch area; 

“PERIMETER” - hatch perimeter; 

“XMASS” - X-coordinate of center of mass; 

“YMASS” – Y-coordinate of center of mass;  

“XAREAMOMENT” – Ix component of inertia moment; 

“YAREAMOMENT” - Iy component of inertia moment; 

“PRODUCTAREAMOMENT” -Centrifugal inertia moment of area; 

“XINERTIARADIUSVALUE” - Radius of inertia X; 

“YINERTIARADIUSVALUE” - Radius of inertia Y; 
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“XAREAMOMENTMAINVALUE” - Ix component of principal moment of inertia relative to mass 

center; 

“YAREAMOMENTMAINVALUE” - Iy component of principal moment of inertia relative to mass 

center; 

“MAINAXESROTATIONVALUE” - Rotation angle of principal axes. 

Text: 

“HEIGHT” – text height; 

“WIDTH” – text width; 

“X”, “Y” – X and Y coordinates of text fixing point; 

“TEXT” – contents of the text; 

2D fragments: fragment parameters are defined by the values of the fragment’s real (numerical) 

variables. In addition, the following parameters are available for 2D fragments: 

“BoundBoxLeft” – left coordinate of bound box (X-coordinate); 

“BoundBoxRight” – right coordinate of bound box (X-coordinate); 

“BoundBoxTop” – top coordinate of bound box (Y-coordinate); 

“BoundBoxBottom” – bottom coordinate of bound box (Y-coordinate); 

“BoundBoxCenterX” –X-coordinate of bound box center; 

“BoundBoxCenterY” –Y-coordinate of bound box center. 

Dimensions: 

“FIT” – fitting dimension; 

“LOWER_DEVIATION” – lower value of tolerance; 

“UPPER_DEVIATION” – upper value of tolerance; 

“TEXT_BEFORE” – text before (the dimension’s value); 

“TEXT_AFTER” – text after (the dimension’s value); 

“TEXT_UNDER” – text under (the dimension’s value); 

“TOLERANCE” – dimension’s tolerance; 

“VALUE” – dimension’s value; 

Leader Notes: 

“INSCR_TEXT” – leader note text; 

“INSCR_TEXT_UNDER” – text under leader of the leader note; 

“TEXT_ON_LEADER” – text on the arrow; 

“TEXT_UNDER_LEADER” – text under the arrow; 

“INSCR_ZONE” – place; 
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2D connectors – connector’s values are returned as connector’s characteristics. 

3D objects 
Operations: 

“Area” – surface area; 

“Mass” – body mass (according to the material density); 

“Xmass”, “Ymass”, “Zmass” - X,Y,Z-coordinates of the center of mass; 

“IX”, “IY”, “IZ” – Moments of inertia with respect to the axes X, Y, Z; 

“IXY”, “IYZ”, “IZX” – Inertia value with respect to the planes XY, YZ, ZX; 

“Volume” – volume; 

for “Apply Material” operation the following additional parameter is used: 

“MaterialArea” – total area of faces with the attached material; 

for all 3D Arrays (except arrays of faces) the following additional parameter is used: 

“CopyCount” – actual number of copies in the array (with account of limitations and 

exclusions); 

3D nodes: 

“POINTX”, “POINTY”, “POINTZ” - X, Y, Z-coordinates of a 3D node; 

3D profiles: 

“Area” - surface area of a 3D profile; 

“Perimeter” - perimeter of a closed 3D profile or length of an open one; 

3D paths: 

“Perimeter” – length of a 3D path; 

Faces: 

“Area” - surface area; 

“Perimeter” - face perimeter; 

for a flat face the following additional parameters are used: 

“LocationX”, “LocationY”, “LocationZ” – X, Y, Z-coordinates of the plane origin; 

“NormalX”, “NormalY”, “NormalZ” – X, Y, Z-coordinates of a flat face normal; 

“RefDirectionX”, “RefDirectionY”, “RefDirectionZ” – X, Y, Z-coordinates of a plane vector (the 

plane vector defines the direction of the X-axis of a flat plane); 

for a cylindrical face the following additional parameters are used: 

“Radius” – cylinder radius; 

“Diameter” – cylinder diameter; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinates of the center; 

“AXISX”, “AXISY”, “AXISZ” – X, Y, Z-coordinates of the cylinder axis; 
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for a toroidal face the following additional parameters are used: 

“MaxRadius”, “MinRadius” –  major and minor torus radii; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinates of the torus center; 

“AxisX”, “AxisY”, “AxisZ” – X, Y, Z-coordinates of the torus axis; 

for a spherical face additional characteristics are used: 

“Radius” – sphere radius; 

“Diameter” – sphere diameter; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinates of sphere center; 

 

Edges: 

“Perimeter” – edge length; 

“StartX”, “StartY”, “StartZ” – X, Y, Z-coordinates of the start point; 

“EndX”, “EndY”, “EndZ” – X, Y, Z-coordinates of the end point; 

for a straight edge the following additional parameters are used: 

“VECTORX”, “VECTORY”, “VECTORZ” – X, Y, Z-coordinates of the segment direction; 

for a circular edge or along circular arc: 

“Radius” – circle radius; 

“Diameter” – circle diameter; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinate of the circle center; 

“AxisX”, “AxisY”, “AxisZ” – X, Y, Z-coordinates of the circle plane normal; 

“StartAngle” – arc start angle; 

“EndAngle” – arc end angle; 

additional parameters for the elliptical edge are: 

“MajorRadius” – ellipse major radius; 

“MinorRadius” – ellipse minor radius; 

“CenterX”, “CenterY”, “CenterZ” – X, Y, Z-coordinate of the ellipse center; 

“AxisX”, “AxisY”, “AxisZ” – X, Y, Z-coordinates of the normal to the ellipse plane; 

“MaxDirectionX”, “MaxDirectionY”, “MaxDirectionZ” – X, Y, Z-coordinates of the ellipse major 

axis; 

“MinDirectionX”, “MinDirectionY”, “MinDirectionZ” – X, Y, Z-coordinates of the ellipse minor axis; 

“StartAngle” – start angle of the elliptical arc; 

“EndAngle” – end angle of the elliptical arc; 

Loops: 

“Perimeter” – loop perimeter. 
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3D connectors – connector’s values are returned as connector’s characteristics. 

Measured Relations 

The list of relations that can be measured by the command PM: Measure Element or relation between 

two Elements depends also on the selected objects of the measurement. Follows below is the list of 

relations, with specified pairs of 2D and 3D objects, for which such relations can be defined. 

The functions distance() and measure() are used in this command for measuring parameters. The 

syntax of these functions is described in the chapter “Variables”. 

2D elements 
“Distance” – is the distance between a 2D node and another 2D node, construction line, graphic 

line or hatch (the order of selecting the measurable entities is not significant); 

“Angle” – is the angle between two lines, segments or a line and a segment. 

“DX” – Offset on X; 

“DY” – Offset on Y; 

3D objects 
“Distance” – is the distance between two arbitrary 3D objects that are 3D construction entities (except for 

LCS), operations or such topological objects as an edge, loop, face, vertex. 

“GeomDistance” – is the distance between 3D points, 3D curves or surfaces corresponding to two 

respective 3D objects of the types: 3D node, vertex, edge, face. 

“Angle” – is the angle between directional vectors of two 3D objects. Listed below are 3D objects, for 

which a direction can be defined (and, therefore, this relation can be calculated). Additionally specified is 

what will be selected as the direction vector for each object: 

for a 3D path, edge or open 3D profile lying on a straight line – the line direction; 

for a 3D path, edge or open 3D profile lying on an ellipse (circle) – the vector directed from the 

center of the ellipse (circle) normal to the plane of the ellipse (circle); 

for a flat 3D profile; workplane; flat face; an operation body consisting of one face lying in a 

plane – the normal to the plane; 

for a cylindrical work surface; cylindrical face; 3D profile lying on a cylinder; an operation body 

consisting of one face lying on a cylinder – the axis of the cylinder; 

for a 3D profile or face, lying on a cone; an operation body consisting of one face lying on a 

cone – the axis of the cone; 

for a toroidal work surface; 3D profile or face lying on a torus; an operation body consisting of 

one face lying on a torus – the axis of the torus. 

“AxisDistance” – is the distance between the axis of two 3D objects. The same 3D objects can be 

selected as the objects of the measurement as in the previous case (when identifying “Angle”), 
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except for workplanes. In the latter case, the axes of the selected objects coincide with the 

directional vectors of the planes. 

“DX” – Offset on X; 

“DY” – Offset on Y; 

“DY” – Offset on Z. 

“MaxDistance” – Maximum distance between two 3D objects (between two points the most distant from 

each other). 

“MaxGeomDistance” – Maximum distance between two geometric elements (3D points, 3D curves or 

surfaces). 
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GLOBAL VARIABLES 

A global variable is a named value of one of the two types: text (string) or real. Global variables are 

accessible for editing in the variable editor or via the special functions across all currently open 

documents. The list of global variables and their values are saved automatically upon exiting the 

application (in the registry) and are restored upon launching the application. 

Global variables are created by the command SG: Create/Edit Global Variables. The command is called 

by one of the following means: 

Icon Ribbon 

 

Parameters → GUI Control → Global Variables 

Keyboard Textual Menu 

<SG> Parameters > Global Variables 
 

Upon calling the command, the dialog box is displayed on the 

screen where you can create new global variables or delete and 

edit the existing ones. To create a new variable, press the graphic 

button [New]. In the coming up dialog box defining the name, 

value and type of the variable being created. 

 
 

Upon the confirmation, the entered data will be displayed in the 

command dialog box. 

Created global variables will be stored until you delete those or update 

your system installation (the global variables are stored in the system 

registry). A global variable can be accessed from any document managed 

by one user. 

 
 

You can retrieve the value of a global variable in any dialog 

that allows use of variables, by the following special 

functions: 

getg (“Name”,N) – gets the value of a real global 

variable; 

tgetg (“Name”,N) – gets the value of a text global 

variable. 
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The first argument defines the name of the created global variable. The expression after the comma 

defines the value to be used in the case if the global variable is not found. 

Exercise: create a new variable of a certain type (real or text) in the variable editor within a drawing, and 

then make a function call for accessing a global variable of this type. If the global variable with the 

specified name (“L”) exists in your user registry, then its value will be displayed in the “Value” column. If 

the specified global variable  is  not found then the second function argument will be displayed in the 

“Value” column. 

Besides that, a global variable can be created, or its value modified, in the common variable editor or in 

any dialog that allows use of variables. The following functions are provided for this purpose: 

setg (“Name”,N) – sets the value of a real global variable;  

tsetg (“Name”,N) – sets the value of a text global variable. 

In this case, the first argument is the name of the global variable, and the expression in the second 

argument defines the global variable value.  

Exercise: create a new variable (“var_2”) in the variable editor, and 

assign it to the function setting the value of a global variable. 

If a global variable with the specified name already exists, then its 

value will be modified. If the variable with the specified name 

does not exist, then it will be created and displayed in the main 

pane of the Global Variables dialog box.  If a global variable is 

defined in the drawing by one of the functions, setg or tsetg, 

then opening this drawing in a different user account (on a 

different computer) creates the global variable on that 

account/computer automatically. 

 

 

Note that global variables can be used, for example, for automatic 

creation of drawing documentation. Suppose, the user creates a 

global variable - the developer's name. The value of this variable 

can be entered in the title block of the drawing by using the 

described functions. Thus, a portion of the title block template will 

be filled in automatically as you insert the title block.  
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DATABASES 

T-FLEX CAD has a capability of creating databases. The usage of databases in T-FLEX CAD allows us to 

realize the whole catalogs of products in one single drawing. It is possible to create elements of 

structures by specifying their parameters from the databases. 

The database of parameters of the bushing can serve as a good example. In T-FLEX CAD there is no need 

to create several separate drawings for bushings of different diameter. It is sufficient to construct 

parametric model of the bushing and obtain different modifications of the bushing by specifying the 

corresponding values from the database for the parameters of construction elements. The process of 

creation of the database with bushing’s parameters is described below. 

 

GOST 12215-66 
 

Bushing GOST 

code 12215-66 

d H D 

 

D1 

 

l R = c Weight, kg 

per GOST 12215-66 

7030-0172 4 6 8 8 1,2 0,2 0,002 

7030-0173 6 8 10 10 1,5 0,6 0,003 

7030-0174 8 10 12 12 1,5 0,6 0,005 

In T-FLEX there are two ways of storing the data. The first method – store data in the external file of one 

of the standard formats (for example, MDB format). Such files can be created with the help of T-FLEX 

CAD system as well as any other programs designed for this purpose. The second method – store data 

inside a specific drawing. Databases that are stored together with the drawing are called internal 

databases, all other databases are called external databases. 

There are several variations of how to work with external databases. The way of working with the 

external database upon which, on the basis of external data file, the database-copy is created in T-FLEX 

CAD document, which retains connection with the external source-file, is called database by reference. 

The contents of the database by reference can be updated from the source-file, automatically or upon 

user’s request. In addition, if the external file is absent the parametric model continues to work using the 

copy of the database inside the document. When the source-file again becomes available, connection 

14 
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with it is automatically updated. The given way of working with external data files allows different 

parametric models to refer to the same database. 

Another way of working with the external databases is possible upon which the database is not directly 

downloaded into the T-FLEX CAD document. In this case to get an access to the database content the 

functions are used.  

GENERAL INFORMATION  

For creation and editing internal databases and databases by reference we use the command ID: Edit 

database: 

Icon Ribbon 

 Parameters → Tools → Database 

Keyboard Textual Menu 

<ID> Parameters > Database 

 

The command offers the following capabilities: 

 create new internal database; 

 create database by reference to external file; 

 edit the contents and the header of the existing database; 

 save the internal database into the external file of the format dBase or Access; 

 transform the database by reference to the internal database; 

 delete the database. 

When invoking the Parameters > Database command, additional window of the current 

document is created in which the database editor is displayed. The window contains a table of 

the database (if the document does not have a database, the table will be empty) and the list of 

databases of the current document with the help of which it is possible to switch from one 

database to another.  
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Owing to the fact that the database editor dialog opens in a separate window, it is possible to 

simultaneously work in the main window of T-FLEX CAD document and in the editor’s window, and also 

simultaneously edit several databases of a single document. 

 

All main commands for working with the database are included into a special group of the main toolbar 

– Database (it becomes available when working with the database editor): 
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 Create new database 

 
 Remove current database 

 
 Save database into a file 

 
 

Update contents of database (only for databases by 

reference) 

 
 Copy to buffer 

 
 Copy database to buffer 

 
 Insert from buffer  

 
 Insert a row before 

 
 Insert a row after 

 
 Insert rows 

 
 Remove rows 

 
 Insert a column to the left 

 
 Insert a column to the right 

 
 Insert columns 

 
 Remove columns 

 
 Move downwards  

 
 Move upwards  

 
 Sorting 

 
 Select table 

 
 Table’s properties 

If the current drawing does not have other databases, then only the “Create new database” 

command is available. With the help of this command, it is possible to create new internal 

database or a database by reference. 
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CREATING INTERNAL DATAB ASE  

Creating New Database 

To create a new database, invoke the option on the main 

toolbar. In the “Database properties” window that appears, 

specify the database properties and comments (if necessary).  

Each database has its own unique name. The name of a 

database – a string of symbols (no more than 10). It is 

important to pay attention to the fact that the upper-case and 

lower-case letters when entering the name lead to creation of 

different names. The name BASE_1 and base_1 – different 

names. The same is true for the names of columns of the 

database. 

It is also possible to specify the background color for the cells 

of database’s table with the help of the parameter 

“Background“. When creating new database the background 

color is selected in a special field located in the upper part of 

the “Database properties” window.  
 

 

Different databases can have different background color. When 

opening another database, the color of the background will 

change. 

After pressing [ОК] the “Database properties” window will close. 

The system automatically transfers to the database table creation 

mode. The dialog window for specifying parameters of the first 

column of the created database will appear on the screen: 

 

Name. Defines the name, by which the access to the values of a database will be carried out. A field is 

identified by its name. The length of the field name should not be greater than 10 characters. The field 

name can be an arbitrary string of letters, numbers and the underline sign ( _ ). The string should begin 

with a letter. All field names within one database should be unique. 

Comments. Explanatory text for the column of length of no more than 80 symbols. 

Type. Defines the information representation format for the given column. Columns can be of one 

of the following types: 

Integer. In this column you can input only integers. The range is from −32768 to 32767 (16-

digit sign integer); 
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Long integer. Integers in the range between −2147483648 and 2147483647 (32-digit sign 

integer); 

Float. In this column you can input only real numbers. Admissible range is from −3.4 ×1038 to 

+3.4 ×1038 (7 digits); 

Double float. Real number in the range from  ±5.0 ×10−324 to ±1.7 ×10308 (15−16 digits); 

Text. In this column it is possible input any text information. 

Length. Defines the maximum admissible number of symbols when entering and editing the 

value in a column of the textual type. 

Alignment. This parameter defines the way of displaying the values in a column: with alignment 

by the left margin of the column, right margin or the center. 

Order number. Shows order number of chosen column in database. 

If the Create next column flag is selected, after entering the values and pressing [ОК], the column’s 

properties dialog will appear again which will allow us to specify parameters of the next column, etc. If 

the flag is disabled, after closing the dialog window the system will transfer to the mode of filling in the 

database.  

Filling in and Editing the Database 

After specifying parameters of the database and its columns, on the screen will appear an empty table of 

the database that contains one line and those columns which were specified by the user. 

 

Note that in the database table there is always an additional, service column with the name “№”. 

This column contains line numbers of the table. 

To create additional lines, it is possible to use the options of the main toolbar: 

 
 Insert a line before 

  Insert a line after 
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  Insert lines 

Also, you can create an empty line if you press <Enter>, when the cursor is located at the last line of the 

table. 

To remove the lines, use the option: 

 
 Delete lines 

All options are repeated in the context menu that can be invoked with  for any string of the table (out 

of the mode of editing the contents of a specific cell of the table). 

 

You can add and remove the columns to/from the database table by using the following options of the 

main toolbar: 

 
 Insert column to the left 

 
 Insert column to the right 

 
 Insert columns 

 
 Remove columns 
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The same options are accessible from the context menu in the area of columns’ headers of the database 

table: 

 

In addition, in the context menu the following commands for a column are available: 

 Sort in the ascending order. As a result of applying this command, the lines of the table are 

displaced in such a way that the contents of the cells of the current column are sorted in the 

ascending order; 

 Sort in the descending order. As a result of applying this command, the lines of the table 

are displaced in such a way that the contents of the cells of the current column are sorted in 

the descending order; 

 Select width. Selects the width of the current column according to the contents of the 

column’s cells; 

 Column’s properties. Invokes the dialog of column’s parameters (the same as used upon 

creation of a database). In the dialog you can change the name and the type of already 

existing and completed column. It should be taken into account that upon changing the 

column type its contents can be lost. In addition, the change in the column’s name to which 

the links were already created in the variables’ editor, will lead to the errors in the variables, 

which can be corrected only by the user. 

The column’s parameters dialog can also be invoked without using the context menu, i.e., simply by 

clicking  on the column’s header. 

Moving across the lines when editing the contents of the database is carried out in the following ways: 

 With the help of pointing at the required string with the cursor and pressing ; 

 With the help of pressing the keys <Up> or <Down>. In this case, the cursor moves one 

line up or down, respectively; 
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 With the help of the key <Enter> in any line, except the last one. As a result, the cursor 

moves to the next line; 

 With the help of pressing the keys <PageUp> or <PageDown>. In this case, the cursor 

moves one page up or down, respectively, i.e., to the first/last string in the current window; 

 With the help of pressing the keys <End>/<Home>. In this case, transition to the first/last 

lines of the database table is carried out. 

The user can move rows and the data contained in them inside the database table with the help of the 

following options: 

 
 Move upwards 

  Move downwards 

The same actions can be performed by pressing the key combination: 

 <Ctrl>+<Down> - to move the row downwards 

 <Ctrl>+<Up> - to move the row upwards 

To specify the contents of cells of the data’s table, it is required to enter into the mode of editing the 

required cell with the help of . The selected cell is highlighted with an inverted rectangle (the 

background color becomes the text’s color and vice versa) and the blinking cursor appears in the cell. 

 

To speed up the work of filling in the database table, it is possible to use the options of 

copying/insertion. It is possible to copy both the contents of individual cells and the entire strings of the 

database table. It is allowed to copy both inside a single database and from one database to another, 

even if the second database is inside another document of T-FLEX CAD.  

 

To copy the contents of a specific cell, it is required first to select the contents and choose the required 

command from the context menu. Insertion of the copied data into another cell is carried out in a similar 

way. The commands of insertion of symbols, variables, fractions, etc. are also available in the context 

menu for the cell’s contents of the data’s table. A detailed description of these commands is given in the 

“Texts” chapter of this user’s manual. 
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Copying the entire string or several strings simultaneously is carried out in a similar way. To select a 

string, it is possible to use two options. The first option – indicate the desired string with the help of , 

which right away also invokes the context menu with the commands of copying/insertion of strings. The 

second option – select a string with the help of , by indicating the very first, service column of the 

database table, with the name “№”. To select several strings, you can use the selection with the help of 

<Ctrl> and <Shift>, as is done elsewhere in the system. 

 

For insertion of the copied string/strings, it is sufficient to choose the desired place (string) in the table 

and invoke the “Insert from clipboard” command from the context menu. Insertion will be carried out 

after the line at which the cursor was at the moment of invoking the insertion command. 
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To copy/insert the entire strings, it is also possible to use the commands of the main toolbar   and 

. It is important to note that these commands work only with the entire strings.  

The entire contents of the table can be selected for copying with the help of the  command found on 

the main toolbar (the “Database” group). 

For the contents of the cells of the database’s table there is a capability of simultaneous sorting by 

several columns. Such sorting can be used in order to group the data with equal values in one single 

column, and then carry out sorting of another column in these groups with equal values. 

To sort by several columns there is an option on the main toolbar: 

 
 Sorting 

After calling this option the dialog window Sorting will appear in which it will be possible to indicate the 

sorting options for several columns.  

For example, suppose there is a database of parameters of flange couplings. 
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It is required to group the data that has equal values in the column isp, then execute sorting of the 

column d in these groups with equal values. 

To do so, on the main toolbar invoke the  option. In the Sorting window that appears in the fields of 

the columns 1 and 2 specify conditions for sorting the values of parameters isp and d, respectively. 

 

After pressing [ОК], the data of the table will be grouped according to the specified conditions. 

 

Example of Internal Database Creation 

The database creation process will be explained on the example of a bushing. First, let us create 

parametric drawing of the bushing with the number of variables equal to the number of columns in the 

table that is shown on the first page of this chapter. After that it is required to create a database and 

select the desired values from it. 
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To create a new database, invoke the  option on the main 

toolbar. In the “Database properties” window that appears, 

specify the database name.  

After pressing [ОК] the “Database properties” window will 

close. The system will automatically transfer to the mode of 

creation of a database table. The dialog window for specifying 

parameters of the first column of the database being created 

will appear on the screen. Specify for it the name “BUSH_ID” 

and the type “textual”. 

 

 

The type of a column is selected based on its expected 

contents. For example, it is clear that the column «Bushing ID» 

must contain information of the textual type, the column 

«length» − integer type, and the column «Mass» − float type. 

 

Since the Create next column flag is enabled in the dialog by default, after the input of data and 

pressing [ОК] this window will appear again. Specify parameters of the next column in it and so on. 

When specifying parameters of the last column, the “Create next column” flag can be disabled. In this 

case the system will automatically transfer to the mode of filling in the database. If the flag was not 

disabled, then it is possible just to refuse creation of the new column by pressing [Cancel] in the 

column’s parameters window that will appear again. 

Now we need to fill in the cells. After filling in the first string according to the GOST data we need to 

press the <Enter> key – the new empty string will be created and the same actions can be repeated up 

to the end of the table. If the data coincides for several fields then it will be more efficient not to retype 

the data each time from the beginning but instead carry out the operation of copying of rows. Then the 

contents can be edited 

As a result of your work, the following table should be obtained 
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Thus we created the database inside the drawing which is an analog of the table from the database. Now 

in the variables’ editor it is possible to carry out selection of the required values from this table 

depending on the controlling parameter in our case, internal diameter for recalculation of the model 

and obtain a drawing of the bushing of the desired size 

FUNCTIONS FOR GET TING VALUES FROM INTERN AL DATAB ASES  

The syntax of referencing a database field is as follows: 

<database name>.<field name> 

An entry BASE.WEIGHT refers to the field WEIGHT in the database BASE. 

There are four functions for accessing values in the internal databases: 

REC - gets the number of the record satisfying the given condition; 

FREC – gets the number of the record whose contents matches best the specified value; 

VAL - gets the value of the field from the record with the specified number; 

FIND - gets the value of the field from the record satisfying the given condition. 

Function REC 

rec ( condition ), where 

condition is a Boolean expression assuming the values true or false. The expression can contain members 

that are themselves calls to the fields of the database. 

Example: 

rec ( BASE.DD == 4 ) 

This call means: find the record number in the internal database BASE, satisfying the following condition: 

the value of the field DD in this record should be equal to 4. 
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Function FREC 

frec ( argument_1, argument_2, argument_3, argument_4 ), where 

argument_1 – is the column in the database that is subject to the search. Must have Real or Integer type; 

argument_2 – the sought value;  

argument_3 – the search option. Possible options are: 

 0 – find the nearest value; 

 -1 – find the nearest floor value; 

 1 – find the nearest ceiling value. 

argument_4 – the parameter indicating the structure of the column subject to the search. It indicates how 

the values are ordered in the column. The value 0 means the entries are not ordered, forcing the search 

over all records in the database. The value 1 means the column is ordered ascending or descending. The 

search completes once the difference between the sought value and the value in the current column of 

the database is greater than in the previous one. 

The parameters argument_3 and argument_4 are optional. If those are not specified, the default values 

are used: 

argument_3 = 0; search for the nearest value;  

argument_4 = 0; the column is not ordered; 

Function VAL 

val ( record_number, database_field ), where 

record_number - is an arbitrary numerical expression yielding an integer.  

database_field - the reference to the field. 

Example: 

val ( 4, BASE.H ) 

This call means: get the value from the record number 4 of the field H in the database BASE. 

Function FIND 

find ( database_field, condition_1, condition_2, ... ) 

This function combines the previous two. 

The function returns the value of the specified field database_field from the record satisfying the 

conditions condition_1, condition_2.  

If such record is not found, the function signals the error “Incorrect record number”.To get the parameter 

values for the drawing of the bushing from the internal DB, use the function FIND (). To do this, enter the 

variable editor by using the command V: Edit Variables and define the expressions for the variables as 

shown on the right hand side diagram. 
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Thus, we have created a parametric drawing of a bushing. The values of the drawing elements will be 

selected from the internal database BASE depending on the value of the inner bushing diameter d. In this 

way, you create a whole family of bushings for latches and mounting rods per GOST 12215-66 by 

creating a parametric drawing of the bushing and connecting it to the DB. 

 

By using this example we have reviewed the main steps of creating databases in T-FLEX CAD. Now, let's 

review the full set of the database editor commands 

PARAMETE RIZATION  OF DATABASES  

The values of cells in databases can be specified as variables and expressions with the help of the 

Support parameterization parameter. This parameter can be enabled when creating the database.  
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The value of such a cell is recalculated when recalculating parametric model. When being displayed 

the value of the cell in the table, specified either as a variable or expression, is highlighted with 

bold font. 

 

When clicking the cell the expression appears instead of the value and it can be edited. 

 

Along with the functions for working  with databases, the value in a cell can depend on other cells. 

In the given example the 6th row contains the sum of all five previous rows: 
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Recursive specification of values is not allowed in this case. In case of appearance of the recursion the cell 

will be highlighted with red color. In this example this event can occur if the range of rows 1, 5 is 

removed: 

 

The message about recursion is also sent to the diagnostics window.Cross-like specification of cell’s 

values from one table to another is also possible, but also without recursion. 

FUNCTIONS FOR WORKING WIT H RANGES OF CEL LS  IN DATAB ASES  

The functions for working with the ranges of cells should be applied when upon working with databases 

we need the functionality similar to the work functionality of electronic cells, for example, in Excel. 

In the variables’ editor there are the following functions for working with the ranges of cells of databases: 

db_sum – evaluation of sum of the cells in an interval  

db_mid – evaluation of the average value in an interval  

db_max – evaluation of the maximum value in an interval  

db_min – evaluation of the minimum value  in an interval  

Interval can be specified in the following way: 

1. Specifying the name of a column in DB. In this example we evaluate the sum and the average 

value by the column. 
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2. Specifying the column and initial row number. In this example we evaluate the sum and the 

average value for the column аа starting from the second row. 

 

3. Specifying initial and final rows. In this example we evaluate the sum and average value from 

the 1st to 4th rows. 
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DATABASES BY REFE RENCE  

As with internal database creation, to create a database by 

reference you need to invoke the command . In the 

Database properties window that appears it is required to 

specify the name of the future database, comments (if 

necessary), data source file and mode of updating the 

database.  

For specifying the source file it is required preliminary to 

enable the By reference (file) flag. After that the File name 

field becomes accessible. To select a file, use the  

button The standard window of the file selection dialog 

will open, in which selection of the required file format and 

its location is carried out. 

 

To create a database by reference, it is possible to select the files of the following formats: 

 Microsoft Access Files (*.mdb); 

 Files of the format dBase (*.dbf); 

 Microsoft Excel Files (*.xls); 

 FoxPro Files (*.dbf); 

 Paradox Files (*.db); 



T-FLEX CAD Brief Introductory Course 

768 

 Text Files (*.txt, *.csv). 

When creating the database on the basis of the file of “*.xls” format, it is required to specify additionally 

that part of the information from the Excel book which will be used as the database’s contents. Selection 

is carried out with the help of the drop down list of the Table’s Name parameter. By default, the system 

prompts the user to select one of the pages of the Excel document. In this case, as the contents of the 

created database, the entire page of the Excel book will be used. The columns’ headers will be created on 

the basis of the first string of the selected page. 

When it is required to use only a part of the page’s contents, it is possible to preliminary create the 

named data domain in the Excel document (select the desired cells in Excel and perform 

“Insert\Name\Assign”). In this case, when creating the database by reference, this name will also appear 

in the list of the Table Name parameter. The first line of the selected information will also be treated by 

the system as the string with the columns’ headers of the database table. 

When creating the database on the basis of the file of “*.mdb” format, it is required, in addition to the file’s 

name, specify the table’s name from this file. The contents of the selected table will be transferred to the 

database being created. The list of all tables in the selected file will automatically be placed in the drop 

down list of the Table Name parameter. 

When creating the database on the basis of the file of “*.dbf” and “*.db” formats, you need to specify only 

the file’s name (the Table Name parameter is not available). In addition, the DOS Coding flag is available. 

When this flag is disabled (default state), the system assumes that the format of the external file is 

Dbase-Windows. When this flag is enabled, the external file is opened only as a file of the format Dbase-

DOS. This allows us to correctly open the databases that contain Russian names for the columns and the 

contents of the text cells. 

When creating the database by reference on the basis of the file of textual format, this file must have the 

following structure: 

 the first line must contain the column’s names that are delimited by a symbol. The symbol 

of delimitation is specified in register in JET parameters (HKEY_LOCAL_MACHINE\ 

SOFTWARE\Wow6432Node\ Microsoft\Jet \х.х\ Engines\ Text \Format - for W7, 

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Jet\х.х\Engines\Text\Format – for 

Windows XP, HKEY_LOCAL_MACHINE\ SOFTWARE\ Wow6432Node\ Microsoft \Jet 

\х.х\Engines\Text\Format\Delimited(,) - for Windows 8 the symbol of delimitation is 

specified in parentheses of Delimited parameter); 

 the following lines contain the records of the database. The contents of the fields in each 

record are also separated by this symbol. 
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In the case when the T-FLEX DOCs system is installed on your computer, one more option of 

creation of the database by reference is available – the database by reference to the T-FLEX DOCs 

dataset.  This is described in more detail in the T-FLEX DOCs user’s manual. 

The mode of updating the created database can be selected from the drop down list of the Mode of 

update parameter: 

Automatically. Updating the data is carried out when opening the file of the model. 

During total recalculation. Updating the data is carried out when performing the total 

recalculation of the model with the update of references. 

Manually. Updating the data is carried out only manually by using the special option Update 

contents of database. 

By pressing [Ok] you complete creation of a database by reference. The “Database properties” dialog is 

closed, and the table of the new database appears on the screen. It can be viewed but editing the 

contents is not allowed The access to the data from a database by reference is carried out similar to the 

access to internal databases, i.e., by using the name of the database by reference similar to the name of 

the internal database In this case the syntax of functions remains the same 

ADDITIONAL COMMANDS OF DATAB ASE ’S EDITOR  

Let us review still not mentioned commands of the main toolbar that are designed for working with 

databases. 

The Delete current database command  allows us to delete the internal database or the database by 

reference 

The Save database into file command  allows us to copy the internal database into the external file 

of the format “*.mdb” or “*.dbf”. The database itself does not change, and it remains internal. This option 

can also be used for the database by reference, in this case the current, internal version of the database 

will be copied into the external file. 

The Update database’s contents command  is used for databases by reference and allows us to 

compellingly update (from the file) the contents of the database. 

The Table’s properties command  allows us to edit the database’s attributes. For internal databases 

you can edit the name and the comments. It is also possible to transform it to the database by reference 

by enabling the corresponding flag and indicating the name of the external source file. The contents of 

the database that already exists will be lost in this case. For a database by reference by invoking the 

command  it is possible to change the name, comments and path (including the file’s name) and the 

table’s name. 
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FUNCTIONS FOR WORKING WIT H EXTERN AL DATABASES  

In T-FLEX CAD it is also possible to use the option of working with external databases, when the database 

is not downloaded directly to the T-FLEX CAD document. In this case to get an access to the database’s 

contents other functions are used. 

Functions for Getting Values from External Databases: DBF () and DBFWIN () 

The functions DBF() and DBFWIN()are provided for getting data from external databases in DBF format. 

The difference between the two functions is in the way of handling the ASCII extension fonts. The user 

decides what function to use depending on the textual data encoding. In the following description, 

anything said about the function DBF() is also true for the function DBFWIN(). 

Function syntax: 
dbf (arg1, arg2, arg3), where 

arg1 - the name of the database. The name of the database can be defined by a string constant, a 

variable or an expression. 

arg2 - the name of the field to get data from. The name of the data field can be defined by a string 

constant, a variable or an expression. 

arg3 - the access condition. You can use string constants, variables and expressions for defining the 

condition. 

Example: 

dbf(DBF_NAME, COL1, COL2 = 30) 

The above means: get the value of the field COL1 in the database DBF_NAME under the condition that 

the value of the field COL2 is equal to 30. 

If we were to use an external DB for defining the bushing parameters, then we would have to define the 

following expressions: 
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Function for Getting Values from External Databases: MDB() 

The function MDB() is provided for getting data from the external databases in XLS (Access) format. 

Function syntax: 
mdb (arg1, arg2, arg3, arg4), where 

arg1 - the name of the database. The name of the database can be defined by a string constant, a 

variable or an expression. 

arg2 - the name of the table in the database. Can be defined by a string constant, a variable or an 

expression. 

arg3 - the name of the field to get data from. The name of the data field can be defined by a string 

constant, a variable or an expression. 

arg4 - the access condition. You can use string constants, variables and expressions for defining the 

condition. 

Example: 

mdb ( "c:\\T-FLEX_USER.mdb", "USER", "NAME", "Code={code}" ) 

The above means: get the value of the field NAME from the table USER in the T-FLEX_USER database 

under the condition that the value of the field Code is equal to the value of the variable "code" (equal to 

15 in this case). 

It should be noted that the last argument of the function that specifies record selection criterion can be 

written in the form of SQL query and must correspond to the statement “WHERE” of the “SELECT” 

command. If text variables are used when writing the condition, then the expression will look like the 

following:  mdb ("c:\\T-FLEX_USER.mdb", "USER", "NAME", "Job title=\"{$Job}\"").   

Because of the slower process of receiving information from the external database the DBF () and 

MDB () functions should be used only in cases where it is impossible to use the database by 

reference on the basis of formats“*.xls” and “*.txt”. 
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CONTROL ELEMENTS. CREATING USER DEFINED 

DIALOG BOXES 

When working with parametric models and while building an assembly, the user often needs to edit the 

values of external variables of the models being designed or fragments being a part of an assembly. The 

T-FLEX CAD general variable editor can be used for handling external variables. However, it is much 

easier and simpler to work with specially created custom dialogs containing Windows-native tools (input 

boxes, drop-down lists, “Yes/No” switches, etc.).  

A custom user-defined dialog provides a quite convenient and easy way of editing variables in a 

parametric model. It is developed by the user when creating a model or fragment. Special T-FLEX CAD 

system elements, namely, control elements, are used for creating a custom dialog. When creating a 

dialog, the developer can make it clear and easy to use by adding necessary explanations and comments 

in the dialog and by structuring the input of the model parameters in a most comprehensible way. 

In the future, a custom dialog will be called instead of the general variable editor whenever necessary to 

edit external variables of a given model or fragment. A custom dialog will be coming up upon calling the 

command for modifying external variables, Parameters > Model, in the current document and in the 

parameters window when inserting the current document as a fragment. 

GENERAL INFORMATION  

Types of control elements 

T-FLEX CAD system supports the following types of control elements for use in the custom dialogs: 
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The control elements “Static text”, “Frame” and “Group Box” are not related to any variables and are used 

for making a clear dialog layout and providing hints. 

Static Text is a text string positioned in the specified area of the dialog box. 

Frame is a rectangular frame or rectangular area of the specified color. By default, this is a black 

frame or a rectangle of the background color. 

Group Box is a frame with a text aligned with the top border of the box. 

The two last elements are used for enhancing and structuring the visual appearance of control elements 

in the dialog box. Other visual means can also be used for this purpose. 

Other elements – “Edit Box”, “Button”, “Combo Box”, “Check Box”, “Radio Button”, “Preview” - are related 

to variables or the model pages and is intended for manipulating those in certain ways. 

Edit Box is a rectangular field for editing the value of the variables associated with this box. Edit 

box is used for variables without lists of predefined values. It is possible to work in a mode when 

the displayed value cannot be edited (in this case, in the Edit Box field the value of the connected 

to this field variable will be shown but this value will not be possible to modify). 

Button. A button defines the sequence of actions performed upon pressing it. Such actions can be: 

- Activate Page (show contents of the specified page in the current dialog box); 

- Open Dialog Box (displays the dialog box contained on the specified page, in a new window); 

- Set Variable Value (assigns the specified value to the selected variable); 

- Regenerate 3D Model; 

- Run Macro (a macro is a program written in some programming language using T-FLEX CAD 

API functions. See the “Macros” chapter for details or creating and working with macros). 

Combo Box is a rectangular field with a pulldown list button  on the right. A combo box is used 

for modifying a variable value when there is a predefined list of values. The element parameters 

define whether it is possible to edit the input value. 

Check Box switches between the two values of the selected variable. The particular value depends 

on the check box state. 

Radio Button switches between the variable values defined in the radio group parameters. Radio 

buttons can be conveniently used for variables with several fixed choices of values. (In the case of 

just two choices, “Check Box” can be used instead.) In this case, a radio group of switches is 

created for the variable, each representing one of its values. 

The custom dialogs allow creation of Preview controls. Such an element 

allows displaying a preview pane for a page per the specified fixing factor 

in the dialog box for editing the fragment external variables. Preview is 

not available in the dialogs called by the command Parameters > Model.  

When creating a dialog box, besides the control elements proper, you can use any drawing elements: 

nodes, construction lines, images, pictures, etc. Construction lines and nodes are not displayed as part of 
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the dialog box window, however, those can be used for precise positioning of control elements when 

creating complicated dialogs. 

Graphic elements and pictures can be used as additional detailing elements in the dialog box along with 

the standard control elements, such as “Frame”, “Group Box”, “Static Text”. Those elements can be used, 

for example, for creating a simplified parametric drawing on the page of the dialog box. In this way, the 

user can evaluate the changes made to the model parameters by this drawing. 

Dialog pages 

All control elements of a dialog should be located on one page. Dialog elements can be placed on a 

drawing page or on an additional manually created page. However, we recommend placing control 

elements on a separate page of “Controls” type, created automatically. Such page is assigned “Custom” 

format with the paper height and width recommended for dialog boxes, as well as optimum font size and 

grid step for dialogs. 

The dialog box size is defined by the value of the parameter "Paper size" in the command ST: Set 

Document Parameters (the tab Paper), defined for the dialog page. The size of the dialog box can be 

modified via the parameters of the mentioned command or by using the command Customize > Page 

Size. 

For automatically created “Controls”-type pages, grid display is turned on for easy positioning of control 

elements. To turn off the grid or to change its step, use the command Customize > Grid. If necessary, 

you can turn on snapping to existing 2D nodes or use the absolute coordinates. 

The dialog box can be used in the future for editing the model external variables. Therefore, the 

automatically created dialog page is added for convenience to the list of pages on the tab External 

Variables of the command command ST: Set Document Parameters . You need to switch the parameter 

External variable editor to the option Control, and check mark the created dialog page in the list of 

pages. 

The page name will be used as the dialog box title. The page name can be modified using the command 

Customize > Pages… or with the help of the command Rename found in the context menu for the tab of 

the given page. 

Multipage dialogs 

A T-FLEX CAD document may contain an arbitrary number of dialog pages. You can build separate 

dialogs for various groups of parameters and specify different scenarios of the dialogs interaction. The 

two main scenarios of the dialogs interaction are as follows: 

Complex multi-tab dialog box. Separate dialog boxes are joined into a complex one with tabs, each tab 

corresponding to a particular contributing dialog box; 

Main-subordinate dialog scheme. In this scheme, one of the dialogs is rendered main and appears upon 

calling the command Parameters > Model, while the rest of the dialog boxes are called, if necessary, via 

the controls of the main dialog.  

The combination of the two schemes is also possible. 
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When creating a dialog box with tabs, keep in mind that the pages of the dialogs being joined must have 

same size. Otherwise, all pages and their respective elements will be forced to scaling to the size of the 

first one. 

The second scheme that relies on using several dialog boxes allows different page sizes. 

General principles of creating control elements 

To create a dialog box use the command Create Control. It can be called by one of the following means: 

Icon Ribbon 

 

Parameters → GUI Control → Control 

Keyboard Textual Menu 

<TR> Draw > Control 

Upon calling the command, the following options become available in the automenu: 

 <S> Create Dialog Page 

 <F  Frame 

 <T> Static Text 

 <E> Edit Box 

 <G> Group Box 

 <B> Button 

 <C> Check Box 

 <R> Radio Button 

 <O> Combo Box 

 <V> Preview 

 <P> Edit Control Parameters 

 <A> Set absolute coordinates 

 <N> Set relation with Node 

 <F4> Edit Control 

 <Esc> Exit command 

Creation of All control elements can be fit in the following scheme: 

1. Defining the size and position of the element being created. This is done by specifying two 

diagonal points of the box defining the element extents on the dialog page.  
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2. Defining the element parameters in the “Control Parameters” dialog box. This dialog is 

launched automatically.  

3. Defining additional parameters of the variable bound to the control, or of the sequence of 

actions performed upon activating the control.  

Depending on the type of the control, some of the steps in this scheme can be skipped. For example, 

when creating the “Frame” and “Preview” controls, all you need to specify is the position. Other 

parameters of these controls are defined by default. To modify those, you can use the control editing 

command described in the section “Modifying control elements”. Additional parameters need to be 

defined only for the elements “Edit Box”, “Combo Box” and “Button”. 

Parameters of control elements 

Control elements, just like any other T-FLEX CAD elements, have a set of parameters. Some of the control 

element parameters belong to general system parameters: “Level”, “Layer”, as well as font parameters. 

The default value of the “Level” parameter is “0”, the parameter “Layer” – “Main”, the font parameters – 

“By default”.  

The general parameter “Priority” is assigned automatically in the process of control element creation, 

reflecting the order of creation: the first control is assigned priority “0”, next – “1”, etc.  

Besides the general system parameters, control elements have a set of additional parameters: 

Caption (the text displayed on the control); 

Color of characters (in the cases of “Frame” and “Preview” – the color of the frame strokes or the 

box background); 

Background Color of the control element (for the element “Group Box” – the background color 

under the group name); 

Horizontal Alignment;  

Vertical Alignment. 

The two latter parameters define the caption text position with respect to the control element 

boundaries. 

Some of the above-mentioned parameters are omitted in certain control elements. For example, the 

“Button” control omits the parameter “Background Color”, while the “Group Box” does not require the 

parameter “Vertical Alignment”, since the group name is always positioned along the top boundary. Note 

that, when defining parameters of a particular control element, only its relevant parameters will be 

accessible in the “Control Parameters” dialog box.  

Some control elements also have their own specific parameters: 
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Frame: 

Frame Type: frame or rectangle.  

Edit Box: 

Multiline EditBox – used for text variables only. 

Permits entering multiple lines. 

Show Expression. This parameter affects custom 

dialogs when using variables. Usually, names of 

the variables are not displayed in the dialog 

boxes, when such variables or expressions are 

used as parameters of the fragments being 

inserted into assemblies. This option outputs 

name of a variable in edit fields of the dialog 

boxes. At the same time variable’s value or 

expression is displayed nearby. 

Read Only. When this flag is turned on, the 

editor will work in a regime “read only”, i.e., in 

the Edit Box field the value of the connected to 

this field variable will be shown but this value 

will not be possible to modify. 

 

Combo Box: 

Editable – allows direct input of variable values without selecting from the list. 

Value Selection. Option is used for binding external variables  between each other. For example 

to select the thread pitch from list, according to the thread diameter, automatically. If the option 

is not activated, the thread pitch will not change according to diameter. 

 

Check Box: 

On – defines the value assigned to the variable when the box is checked; 

Off – the value assigned to the variable when the box is cleared.  

Radio Button: 

On - defines the value to assign to the variable when switched on. 

In the further description of the controls, only the elements will be mentioned that are specific to this 

control element. 
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D IALOG BOX CRE ATION  

Let’s review the process of creating a dialog box using 

the example from the chapter “Brief Introductory 

Course” (section “Creating Parametric Drawing”). 

The files for the examples described in the present 

chapter are located in the library “Examples” in the 

folder “\T-FLEX Parametric CAD 15 

\Libraries\Examples\Parametrization\Control”. The 

drawing being considered is stored in the file “Sample 

plate drawing.GRB”. 

To modify parameters of the drawing, let’s introduce a 

set of variables: 

The variables height, width and width_1 are 

used as parameters of the lines defining the 

part dimensions; 

Plate drawing example
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The variables r_min and r_max define the radii of the conic-shape hole; flag_1 defines the visibility 

level of the axes; 

 

flag_3, size and $text define, respectively, the visibility level, the font size and the drawing title 

text; 
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flag_21 and flag_22 define, respectively, the visibility level of the linear dimensions and the circle-

referencing dimensions. Their values are driven by the variable dim_mode that controls the type 

of the displayed dimensions (none, linear only, circle dimensions only or all dimensions). 

All variables, except flag_21 and flag_22, are external. Predefined 

lists of values are created for the variables height, width and 

width_1, and dim_mode. Note that the variable dim_mode uses a 

list of a special type: each numerical symbol is separated by “;” 

from the string bound to this numerical value. How to use such a 

list is described below. The introduced variables allow getting 

different versions of the original drawing: modifying the part size 

and the size of the hole, displaying axes and various dimensions. 

You can also modify the font size of the title, or hide it altogether.  

Let's consider various choices of the dialogs for this example. Let's begin with creating a simple dialog for 

this model, as shown on the diagram. The respective library file is “Sample single dialog.GRB”. 

The dialog being created allows modifying the part size and the size of the conic hole and 

showing/hiding dimension and axes display. 

Call the command TR: Create Control. Let’s create the dialog page: 

 <S> Create Dialog Page 
 

By default, the newly created page is assigned the type 

“Controls”, with the recommended sizes set 

appropriately. This page is also automatically added and 

check marked in the list of pages displayed by the 

command ST: Set Document Parameters (the tab 

External variables), while the parameter External 

variable editor is switched into the mode Controls 

Name the new page “Part parameters”. 

 

Grid snapping is turned on this page by default. You can 

also turn on snapping by the absolute coordinates: 

 
 

 <A> Set absolute coordinates 

When using construction lines and nodes, you can use snapping to 2D nodes: 

 <N> Set relation with Node 
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If necessary, you can define default parameters for all newly created control elements: 

 <P> Edit Control Parameters 

Calling the option <P> brings up the “Control Parameters” dialog box. The latter provides the full set of 

parameters for a control element. Thus, in our example, the parameter “Editable” can be turned off for 

“Combo Box”-type controls. 

The variables of the model, whose values will be controlled by the dialog being created, can be divided 

into several groups: 

Variables that drive the part sizes (height, length, width); 

Variables that drive the size of the hole (minimum and maximum radii); 

Variables that control axis and dimension display. 

Let's divide the dialog box accordingly into several theme areas. In the first area, let's put the control 

elements for modifying the “Part Sizes”. The second area will hold the controls for defining the “Conic 

Hole Sizes”. The third area will contain the control elements for axis and dimension display “Preferences”. 

Finally, the fourth group can unite auxiliary elements: the preview pane (for selecting the active page 

when inserting the drawing as a fragment) and the picture of the drawing (to display when modifying the 

model parameters in the command Parameters > Model). 

The “Group Box” control element will be used for enhanced visual representation/grouping of the control 

elements in the dialog box being built: 

 <G> Group Box 
 

Create the first group on the dialog page. Set the size and 

position of the element as shown on the diagram.  

In the “Control Parameters” dialog box, enter the group 

name as: “Part Sizes”. 

Thereafter, create the rest of the groups in the same way. 

Position the groups as shown on the diagram. Note that the 

group reserved for the preview pane is left unnamed. To 

have it this way, leave the “Caption” entry blank in the 

“Control Parameters” dialog. The element “Frame” can be 

used for similar purpose. 
 

Thus, we have created group boxes for various model parameters. Now, we need to create control 

elements within each group, that will allow modifying the values of the respective variables. 

Let's create explanation notes. To do this, select the automenu option: 

 <T> Static Text 

To create a string of text, specify two bounding points of the text. 



Control Elements. Creating User Defined Dialog Boxes 

781 

In the coming up “Control Parameters”, enter the string 

“Height:” in the “Caption” parameter input box. 

Similarly, create the captions “Length:”, “Width:” and 

“Minimum:”, “Maximum:”, placing those as shown on the 

diagram. 

Next, we need to create control elements for editing certain 

model parameters. The control elements “Edit Box” and 

“Combo Box” can be used for this purpose.  

Since the lists of predefined values exist in this example for 

the variables height, width and width_1, responsible for the 

height, length and width of the part, respectively, let's use 

the “Combo Box”-type controls for these variables. 

 

Since the parameter Editable is turned off in the default settings, the direct input of the variable values is 

disallowed for all created “Combo Box” controls in this example. The variables can only be defined by 

selecting values from the list. 

First, let's create the control element for defining the part height. Call the respective automenu option: 

 <O> Combo Box 
 

Position the control to the right of the “Height” caption, as shown on the 

diagram. 

Next, in the coming up “Insert Variable” dialog box, select the variable to bind to 

the control being created (the variable “height” in the case of the part height). 

 

If necessary, you can specify the name of any non-existent variable by manually entering it in the 

“Expression” field. This brings up the standard “Variable value” dialog box, described in the 

chapter “Brief introductory course”. The variable being created is automatically marked as external. 

 

Create yourself the “Combo Box”-type controls for the variables “width” and “width_1”. 
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The next step is creation of control elements for modifying the variables r_min and r_max that drive the 

size of the conic hole. Since these variables do not have predefined lists of values, you can use “Edit Box” 

controls for them: 

 <E> Edit Box 
 

Let's create the “Edit Box” of the variable r_min. Activate the 

option and define the control position according to the diagram. 

In the “Insert Variable”, select the variable to bind the control to 

– r_min. 

Similarly, create “Edit Box” for the variable r_max. 

 

To make the selector for axis display, in this example one can use the “Check Box” control, placing it in 

the “Preferences” group. 

Select the automenu option: 

 <C> Check Box 

As in the case of any control elements, the first step of creating the switch is selecting two points for 

defining the switch position. Next, the “Insert Variable” dialog box appears. Select the variable flag_1 

from the list. The “Control Parameters” dialog box then comes up automatically. 

In it, you need to define the respective variable values for On and Off states. 

Since the variable flag_1 in our example defines the visibility level of the axes, 

the “On” state corresponds with “0”, while “Off” – with “-1”. In the Caption 

input box enter the string “Show Axis Lines”. We will use another “Combo Box” 

control for managing the dimension display options, bound to the variable 

dim_mode. 

 

 

Place this control in the “Preferences” group box. Note that, with the flag 

“Editable” turned off, the described combo box displays in its value field and 

the pulldown list the textual string portions defined in the values list of the 

variable dim_mode, rather than the numerical values. Put the explanation text 

“Dimensions:” before the “Combo Box” control, using the “Static Text” element. 

The remaining empty space on the dialog page can be used for placing a 

picture or preview pane. 
 

Let's insert a picture in the dialog, illustrating our model. Save your model as a picture, using the 

command EX: Export. After that, add the created image to the dialog page, using the command IP: Insert 

Picture, and place it in the empty group box. Use File > Assembly > Links command for breaking link 

between a picture and the corresponding file. Set “Embedded” flag for the respective item. 

The “Preview” element can be placed on top of the picture. To create it, select the option: 

 <V> Preview 
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Specify two points defining the size and position of the 

preview pane.  

In this example, align the preview pane boundaries with 

those of the group box hosting the picture. The 

“Preview” element should fully cover the picture.  

From now on, when inserting this drawing as a 

fragment, there will be a preview pane in the dialog box. 

In this way, both the picture and its hosting group will 

be screened by the preview. However, when calling the 

dialog by the command "Parameters| Model", the 

preview pane will not appear, exposing the underlying 

picture. 

 

Now, all dialog controls are created. To insure that the transition from one to another control in the 

dialog follows the desired order (as, for instance, when using the <Tab> key), we need to define the 

activation sequence of the control elements while working with the dialog. This can be done using the 

control element editing command EO: Edit Control described in the section “Modifying Control 

Elements”. 

Thus, the dialog creation is complete. In the course of creation, you learned how to create a dialog page 

and control elements for decorating the dialog box and modifying the values of the external variables. 

USE OF T HE D IALOG  

As was mentioned above, the created dialog box can be used for defining the model parameters and 

when using the model as a 2D or 3D fragment.  

In the first case, the command Parameters > Model 

is used for launching the dialog box. Upon calling 

the command, the newly created dialog appears on 

the screen, allowing to modify the values of the 

model variables. Modifying a parameter in the dialog 

box instantly reflects on the part drawing. However, 

the image on the picture does not change since it is 

not parametric to our model. 

Try changing the dimension display mode: set the 

parameter “Dimensions:” to the value “Linear”. The 

drawing will adjust to this setting as shown on the 

diagram. 

To finish working with the dialog box, you need to 

press [Ok]. 
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When inserting the model as a fragment, the created dialog box becomes part of the fragment 

parameters dialog box. To verify that, save the resulting model using the command File > Save. Then 

open a new document using the command File > New 2D Model. Call the fragment creation command 

Draw > Fragment and select the automenu option . In the coming up window find the file of your 

example. The fragment parameters dialog box will then display the created dialog. By default, the user-

defined dialog of fragment parameters will be a part of the general dialog of parameters of fragment 

insertion command. By pressing  at the upper right corner of the parameters dialog, the dialog can be 

shown in a mode of viewing in a separate window. 

 

Note that the preview pane now appears in the dialog box, screening out the picture. All changes done 

to the model parameters using the dialog controls will be reflected in the preview pane. The preview 

pane also displays the selected drawing page and the fragment fixing vectors present in the model. 

The control elements that make up the dialog can be used for modifying the model external variables 

directly in the 2D window, without calling the command Parameters > Model or Draw > Fragment. In 

this way, working with the dialog page is similar to working with the actual dialog box when the latter 

comes up on the screen. 
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Thus, upon clicking  on the “Button” control, all functions defined for this control elements are activated 

from the dialog page. Upon clicking on the elements “Edit Box” and “Combo Box”, one can manually 

define or select from the list a new variable value. Clicking  changes the states of the “Radio Button” 

and “Check Box” control elements. 

To finish inputting changes, you can press , <Enter> or  over 

any empty area on the dialog page. The entered changes can be 

canceled by pressing , <Esc> or . In this case, a confirmation 

window will appear, double-checking about the cancellation. 

A “Combo Box” control allows an additional manipulation. If it is 

bound to a variable whose predefined list is based on a file, then you 

can modify this list directly in the dialog page by turning on the 

“Editable” parameter. To do this, point the mouse to the input box of 

this control and access the context menu.  

Commands will be provided in the context menu for modifying the 

list of predefined values of the variable. Upon selecting the 

command Add to list, the value entered in the input box is added to 

the list of values for this variable. Selecting the command Edit List 

brings up the “Value List of Variable” dialog box, that allows editing 

the existing list. 

 

PARAMET RICIT Y OF CUSTOM D IALOGS  

In the course of reviewing this example, it was mentioned that control elements, just like other T-FLEX 

CAD elements, possess general system parameters “Level”, “Layer”, etc. This allows creating parametric 

dialogs, whose appearance changes depending on the kind of a model.  

As an illustration to this statement, let's continue with the current example. Let's create a modification of 

the dialog. The respective file in the library of samples is “Sample parametric dialog.GRB”. 

Delete the elements “Preview” and “Picture” from the dialog page. Then select the group box of the 

deleted elements and double-click . In the coming up “Control Parameters” dialog box, modify the 

group box title by assigning the parameters “Caption” the string “Drawing Title”. 
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Let’s place in this group box the control elements for handling the drawing title. The variable “flag_3”, 

“size” and $text will define, respectively, the visibility, size and text string of the title. To control the title 

visibility, the variable flag_3 needs just two values (“0” when the title is displayed, “-1” – title hidden). 

Therefore, let's create a “Check Box” control element for this variable. 

Position the control as shown on the diagram. In the window “Insert Variable”, select the variable flag_3. 

In the “Control Parameters” dialog box, assign the “Caption” parameter the string “Display Title”. Enter 

the value “0” for the parameter “On”, “-1” - for “Off”. 

Next, let's create control elements for defining the title font size. Since the variable "size" does not have a 

list of values, one can use an “Edit Box” control. In the window “Insert Variable”, select the variable "size". 

Put the explanation text “Font size:” before the control, using the “Static Text” element. 

The next step is creation of control elements for modifying the title text. 

The variable $text can be conveniently controlled by an “Edit Box” element as well. To provide support 

for defining a multiline title, turn on the flag “Multiline EditBox”, using the option . Then specify the 

element position and select the variable $text in the “Insert Variable” window. 

To go to the new line in the multiline editor, use the key combination <Shift><Enter>. The control 

sequence “\n” can be used for separating lines as well. 

Put the explanation text “Text:” before the “Edit Box” 

control, using, as before, the “Static Text” element. 

Thus, we have created the interface for controlling the 

title text in our dialog. However, it is not yet parametric. 

Let's modify it in such a way that the control elements for 

modifying the font size and the title text string were 

displayed in the dialog only when the flag “Display Title” 

is turned on. To get this, let's relate the “Level” parameter 

of the relevant elements to the variable flag_3. 

Select by box the font size and the title string control 

elements and click . 
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In the context menu, select the item Parameters…. The 

dialog for editing properties of the selected elements will 

appear in the properties window. In this dialog, clear the 

marks against all parameters except the “Level” 

parameter, and assign the latter a new value: flag_3 == 0? 

0:-1. Click . The entered expression means: if the 

variable flag_3 is equal to 0, then the parameter “Level” 

will be assigned the value 0, otherwise - (-1). 

Thus, the dialog is created, and we can call it by the 

command Parameters > Model. Calling the command 

brings up this dialog box on the screen.  
 

When the flag “Display Title” is turned on, the parameters 

“Font size:” and “Text:” are present in the dialog. If the 

“Display Title” flag is off, the controls for defining the font 

size and the title text string are omitted in the dialog. 

Therefore, the created dialog box sample has parametric 

properties. One can create various parametric dialogs of 

more complex structure, using the same principle. 

  

 

WORKING WIT H MULTIPLE  D IALOGS  

As was mentioned above, multiple dialogs can be created within one model. Let's get back to the dialog 

instance with a preview pane and a picture. In addition to the existing dialog, let's create a dialog with 

controls for the title of the drawing. The file of this instance is “Sample dialog with tabs.GRB”. 

Call again the command TR: Create Control. Using the option , create a page for the second dialog. 

Rename it with the help of the command Pages, setting the name “Drawing title”. 

As it was mentioned, the variables “flag_3”, “size” and $text control the visibility, size and the contents of 

the drawing title text string, respectively. For each variable's control element, let's create the three 

respective “Group Box” elements, as shown on the diagram. 
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As before, create a “Check Box”  for switching the 

values of the variable flag_3.  

Place this control inside the first group, as shown on 

the diagram. In the window “Insert Variable”, select the 

variable flag_3. In the “Control Parameters” dialog box, 

assign the parameter “Caption” the string value “Display 

Drawing Title”. Set the parameter “On” to “0”, “Off” – “-

1”.  
 

We will use the “Edit Box” control for modifying the title 

text, with the flag “Multiline EditBox” turned on. 
 

We need to put the explanation text “Title Text:” before the “Edit Box”. To do this, use a “Static Text” 

element. 

Finally, let's create the control elements for defining the title font size. Those will be placed in the group 

box “Font size”. 

We will pre-define three choices: small font (size=6), medium (size=8) and large (size=10). For controlling 

the value of the variable “size”, we will use three “Radio Button” elements: one per each value of the 

“size” variable. 

Call the option: 

 <R> Radio Button 

Specify the position and the size of the switch. In the “Insert Variable” window, select the variable “size”. 

In the parameters dialog box set the “On” parameter value equal to “6” and the parameter “Caption” as 

“Small”. Similarly, create another two “Radio Button” controls, positioning those exactly beneath the first 

one.  

Their related variable should also be ‘size”. The “On” 

parameter settings for these elements should be “8” 

and “10”, respectively. 

The name of the second switch is – “Medium”, the 

name of the third one – “Large”. 

One can put “Static Text”-type control elements next 

to the switches to provide explanation, mentioning the 

respective font size of the text (6,8 and 10) in the 

“Control Parameters” dialog box on the tab “Font”. 

Once all the control elements are created, make sure 

to check their activation order.  
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Thus, a second dialog is created in the model – the one for controlling the title of the drawing. 

Next, we need to decide, how the two dialogs will interact. Since the option  was used for their 

creation, both pages were automatically added and check marked in the page list of the command 

ST: Set Document Parameters (the tab External variables). Meanwhile, the parameter External variable 

editor switched to the mode Control. 

 

In this case, the dialog pages will be automatically joined into one dialog box with tabs. The tab names 

will be the same as the names of the pages. The first tab will correspond to the first page, the second tab 

– to the second page, respectively. 

      

However, there is another way of using multiple dialogs. 

Consider one dialog as main. Then this dialog will be launched by the command Parameters > Model or 

when inserting the fragment. Other dialogs can be called, if necessary, using the “Button”-type control 

elements of the main dialog. 
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Let's consider this possibility in our example. Select the “Part parameters” dialog box as main. To do this, 

in the command ST: Set Document Parameters (the tab External variables) clear the checkmark on the 

page “Drawing title”. Now, upon calling the command Parameters > Model or while inserting the 

fragment, only the dialog “Part parameters” will be displayed. 

The second dialog will be called by one of the controls 

of the “Part parameters” dialog box. Let's create a button 

as such a control. Place this button in the “Preferences” 

group box. 

Note that the dialog page is already fully occupied by 

the existing control elements. To fit the button, let's 

reduce the size of the “Check Box” element for the 

variable flag_1. Change the “Caption” property of this 

element from “Show Axis Lines” to “Show Axes”. 

To create the button, again call the command TR: Create 

Control. 

 

Select the automenu option: 

 <B> Button 
 

As was mentioned, this option allows creating a button 

control on a dialog page and define a sequence of actions 

performed upon pressing the button. 

The first step of button creation is defining its size and 

position in the dialog box. Next, in the “Control Parameters” 

dialog box, define the button parameters. Then, the “Actions” 

window appears. Here we need to specify the action (or a 

sequence of actions) to be performed upon pressing this 

button. 

 
 

Adding actions to the list is done as follows. In the pulldown list of 

actions select the desired one and press [Add…] button. Then, 

depending on the selected choice, an appropriate dialog box will 

appear for selecting a page or variable and the value to be assigned 

to it. After that, the action is added to the list of actions of the 

button being created.  
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To make changes in the specified list of actions in the 

“Actions” window, use the following graphic buttons: 

To delete an action - select the desired line in the list of 

actions and press the button [Delete]; 

 

To modify an action - select the desired line in the list of actions and press the button 

[Properties…]. A dialog box will appear for selecting the page or variable and for specifying its 

value; 

To change the order of actions (which is the same as their order in the list) - select the necessary 

line in the list of actions and move it, using the buttons [Up] or [Down]. 

When pressing the button, the actions of performed in the order in which they were defined. 

Therefore, the order of actions is defined according to the purpose of the button creation. In 

addition, keep in mind that if the action sequence involves calling a dialog box, the remaining 

actions will be performed only after closing this dialog box by pressing the [OK] button. If the 

dialog call ended in pressing the button [Cancel], the remaining actions are ignored. 

For the current example, define the position of the button on the dialog page as shown on the diagram. 

In the “Actions” window, define the following sequence of actions:  

1. Assign the variable: $text=“Drawing Title”; 

2. Show the “Drawing title” dialog. 

After creating the button, call the command Parameters > Model. The “Part parameters” dialog box will 

appear. Press the graphic button [Text…]. The “Drawing title” dialog window opens. The title text changes 

to “Drawing Title”. To return to the main dialog, just press the [OK] button. 
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In this way of dialog interaction, the dialog box sizes can be different. Let's reduce the “Drawing title” 

page size using the command PZ: Set Paper Size. 

 

The two latter examples are represented in the library of samples by the files “Sample compound dialog 

with constant size of pages.GRB” and “Sample compound dialog with variable size of pages.GRB”. 

CONTROL ELE MENTS MODIFICATION  

To modify control elements, the control editing command is provided, “EO: Edit Control”: 

 Keyboard Textual Menu Icon 

<EO> Edit > Draw > Control  

The control editing command can also be called from the context menu. 

Upon calling the command, the following options become available in the automenu: 

 <*> Select All Elements 

 <R> Select element from list 

 <T> Change Controls Tab Order 

 
<S> Set Recommended Page Parameters 

 <Esc> Exit command 

The option  is used for assigning default parameters of a dialog page to the current page (those set 

ar creation by the option ). The page being modified is assigned the type “Controls”. This page is 

automatically check marked in the list of pages under the External Variable Editor parameter in the 

command ST: Set Document Parameters. The parameter itself switches to the “Page” setting. The option 
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is used on the pages created or modified by using the commands Customize > Pages…, Customize > 

Page Size or Customize > Grid. 

The option  allows changing the order of control element activation.  

Control elements have a certain order that defines transition to the next element upon pressing the keys 

<Tab> and <Shift><Tab>, and priority, that defines the order of overlapping of the control element 

images. By default, both properties are assigned according to the order of element creation. That means, 

the transition will occur from the first created element to the next one, while the priority of each element 

is higher than that of the previous, and lower than that of the next one.  

Upon calling the option , the order number is 

displayed next to each control element.  

If you need to change the order of elements, select 

them in the desired order. To confirm the changes, 

press the icon  or <Enter>. If you made a mistake 

when defining the order of elements, press  or 

<Esc>, and then select the option  again.  

To modify a control element (or a group of elements), select it by clicking  (you can also use box 

selection, <Shift>+  for multiple selections, selection by name from the list using the option , or 

selection of all elements on the page by the option ). 

If selecting a single element, you can modify its size. To do this, simply point the mouse to the border of 

the element rectangular area. The pointer shape changes to . Dragging the mouse with  depressed 

changes the size of the selected element. 

To move the selected element (group of elements), simply point the mouse inside the element 

rectangular area. The pointer shape changes to . Dragging the mouse with  depressed changes the 

position of the selected element. 

Upon selecting an element, you can use the following options (the full set of accessible options depends 

on the element type): 

 <P> Edit Control Parameters 

 <V> Change Control Variable 

 <Y> Create Name for selected Element 

 <A> Edit Actions List 

 <I> Select Other Element 

 <Del> Delete selected Element(s) 
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 <Esc> Cancel selection 

The option  is only accessible for the control elements that are bound to variables. This option allows 

reassigning the variable, whose value is controlled by the selected element (all steps in this case are the 

same as when creating the control element).  

The option  is only accessible for the “Button”-type control elements. It allows adding/deleting the 

actions to perform when pressing the selected button.  

The option  calls the property window of the selected 

control element. For “Frame”, “Group Box”, “Static Text” 

and “Preview” elements, this window can be called by 

double-clicking . 

In the case of multiple selections, the option  first 

brings up the “Change parameters” dialog box. In this 

dialog box, you need to mark the parameters to be 

edited. By default, all parameters of the selected 

elements are subject to editing. If a parameter should 

not change, clear the check mark before its name. Upon 

specifying the set of parameters to be edited and 

pressing [OK], the standard dialog box appears for 

defining the parameters of the selected elements. The 

parameters that cannot be modified are made 

inaccessible. Note that some general parameters 

(“Layer”, “Level”, etc.) can be edited using the system 

toolbar.  
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OPTIMIZATION 

T-FLEX CAD provides a capability for computing parameters of a 2D drawing or a 3D model by solving an 

optimization problem under certain constraints on the model variables. The solution to this problem 

yields a set of values for the existing variables that satisfy the imposed conditions best.  

MAIN CONCE PTS  

Optimization of the model is done by using the command PO: Optimize Model: 

Icon Ribbon 

 

Parameters → Tools → Optimize 

Keyboard Textual Menu 

<PO> Parameters > Optimize 

 

The command is accessible only when numerical variables are present in the document. 

Calling the command brings up the dialog box "Optimization Task", that contains the list of the defined 

optimization problems. The column Name displays the name of the variable, whose value is optimized by 

the current task. The column Comment contains textual strings entered by the user.  

A T-FLEX CAD document may contain any number of optimization tasks. 

The graphical buttons at the bottom of the dialog box allow the following actions: 

Add. Entering a new optimization task. 

Delete. Deleting the task of the current list item. 

Properties. Displays "Optimization Parameters" dialog box of the current list item task. 

Run. Starts the optimization computations. The system seeks for the solution according to the 

specified optimization parameters and regenerates the drawing or the 3D model with the found 

variable values. 

Close. Exits the command. 

OPTIMIZATION TASK DE FINITION  

Upon pressing the [Add] button, the "Optimization Parameters" dialog box is displayed that contains the 

following fields: 

Goal. Keeps the textual string that is the comment of this optimization task. Next are the combo 

box for selecting the target function (Make Equal, Minimize, Maximize), the variable Name combo 

box and the Tolerance input box. The variable is selected from the list containing all numerical 
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variables present in the document. If the selected function type is “Make Equal”, then the input 

box becomes accessible for entering the target value of the variable. 

The tolerance value defines the admissible range of the 

values of the target variable within which the 

optimization task is considered solved. 

Limitations. Defines the list of restrictions on the 

model variables when performing the optimization. 

New limitations are entered upon pressing the [Add] 

button. 

In the “Variable” box, set the name of the desired 

variable (one variable can be subject to multiple 

restrictions). In the “Condition” combo box, select one 

of the comparison types (<, >, <=, >=) for comparing 

the variable against the target value (the “Value” input 

box). To modify the entered limitations, use the button 

[Properties] that allows editing all fields of the current 

line in the limitations list. Pressing the [Delete] button 

deletes the current line of the limitations list. 

 
 

Variables. This is the list of variables whose values will be the subject to 

the optimization process. The range of admissible values is to be defined 

for each variable. To be formulated correctly, the optimization task 

requires defining the range of admissible values for at least one variable. 

The graphic buttons [Add], [Properties] and [Delete] work similar to 

those described in the previous section. To define a new record, you 

need to fill in the following entries: Set the variable name by selecting 

from the list in the “Variable” combo box (each variable can have only 

one the range of admissible values). 

 

 

The entries “Minimum” and “Maximum” define the bounding values of 

the variable's range of admissible values. When solving the optimization 

task, the values of the variables are tried that satisfy the set of the 

limitations and fall in the range of admissible values. 

Once a limitation is defined for a variable, its name is no longer available 

for defining the range of values, and vice versa. The variable whose value 

is the target of the optimization is not included in the lists of variables 

when defining limitations and the value ranges.    
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Run. This parameter takes one of the following values: 

User. The optimization task will run only upon user pressing the 

bottom [Run] in the "Optimization Task" dialog box.  

Optimizing may take long time on complicated drawings or 3D models. The described setting allows 

skipping optimization when regenerating the model. 

On optimal Model Regeneration. The optimization task will run upon partial (optimal) model 

regeneration (when only modified elements are regenerated).  

On full Model Regeneration. The optimization task will run upon full model regeneration. 

To select an optimization algorithm and to define its parameters, use the graphic button [Algorithm…]. 

Pressing this button brings up the dialog box for defining the algorithm parameters. 

The pane in the left side of the 

dialog box displays the list of 

available optimization methods: 

Fast Search. This method is 

suitable for functions with one 

or two extremes. 

Dichotomy. This method is 

suitable for functions of one 

variable. Not recommended for 

handling restrictions Iterative 

Search. This method is suitable 

for functions with complicated 

behavior and multiple extremes. 

 

The right side of the dialog box contains the set of parameters for the selected optimization 

method.  

The button [Ok] closes the dialog box, saving the entered changes. The button [Cancel] allows 

quitting the dialog box without saving changes. 

Show current result. If this flag is set, the “Finding Solution” window dynamically displays the 

variable values as the solution progresses.   

Recalculate 3D model. Setting this flag forces the 3D model regeneration at each step of the 

optimization algorithm. If the target function of the optimization (the variable) is related to 3D 

elements, then this flag is required for proper optimization process. 

EXAMPLES OF USING OPTIMIZATI ON  

Idler Roller Positioning Task 

As an optimization example for a 2D model, let's consider the task of finding an idler roller position for 

fitting the belt of a specified length.  
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This example can be found in the library “Examples\Additional resources\Optimization\ Belt.GRB ”. 

The example presents a kinematic system of a 

generic belt drive. Let's assume one of the 

requirements for the design of the system being 

the fixed belt length (1000 mm), adjusted by the 

position of an idler. The idler position depends on 

the angle of turning its mounting bracket. 

The turning angle of the idler mounting bracket is 

defined on the drawing by the parameter of the 

respective construction line created as "through 

node, at an angle to horizontal". This parameter of 

turning the construction line was defined by a 

variable named “alpha”. The length of the belt is 

defined by the variable “Length”. 

Belt length: 1000 mm

Alpha: 125.348°

In this example tension

roller ensure belt length

1000 mm. Optimization

work automatically after

transform construction line.

 

 

Let's define the optimization task for this model by 

calling the command PO: Optimize Model.  

The target condition will be the equality: the 

variable “Length” is equal to 1000 mm with the 

tolerance 0.0001. 

Let's set to the variable “alpha” to be the target of 

the optimization, with the values ranging from 
045  

to 
0225 .  

There are no additional conditions on the variable 

in this model, therefore, no restrictions are applied. 

Let's set the optimization run condition “On 

optimal Model Regeneration”. In this way, any 

model modifications will trigger the optimization, 

making it work in “transparent” mode. Let's set the 

dichotomy method as the optimization algorithm. 

 

Upon defining all optimization parameters, any change in the drawing will trigger the optimization. For 

example, moving any of the rollers or changing any radius requires running the optimization to define 

the position of the idler. Meanwhile, the belt length is maintained equal or nearly equal to 1000 mm. 
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Belt length: 1000 mm

Alpha: 142.204°

 

Belt length: 1000 mm

Alpha: 75.6876°

 

Bottle Volume Optimization Task  

This example clarifies use of optimization for 3D models. The file for the example is located in the 

library “Examples\Additional resources\Optimization \ Bottle.GRB”.  

The example presents the solution to the bottle volume problem. 

In this example, the variable “Volume” is created, equal to the 

bottle capacity, that is, the volume of its contents. The variable “H” 

defines the height of the bottle, while “HW” – the level of the liquid 

in it. 

The optimization task is to maintain the constant bottle capacity 

(0.5 liter = 500000 mm3) while varying the bottle height and the 

level of the liquid in it. To achieve this goal, we need to find the 

value of the variable “D” driving the median diameter of the bottle 

(the widest portion diameter). 

The optimization task “Volume” was defined in the command 

PO: Optimize Model as follows. 

The target function equates the variable “Volume” to 500000 with 

the tolerance equal 1. 

The modifiable variable is “D”, in the range from 70 to 90. 
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No additional conditions are imposed on the model variables; 

therefore, no restrictions are defined. To visualize the 

optimization process, the flags are turned on, “Show current 

result” and “Recalculate 3D model”. 

The dichotomy method is selected for the optimization 

algorithm, with the maximum number of iterations equal to 

100. 

The parameter “Run” is set to the option “User”, so that the 

optimization is run only upon the user request. 

 

After specifying the optimization task, let's modify the model. For example, let's reduce the bottle height 

and, respectively, the level of the liquid in it, by changing the values of the variables “H” and “HW”. This 

reduces the capacity of the bottle. 

To adjust the bottle diameter, simply call the 

command PO: Optimize Model, select the task 

“Volume” in the coming up dialog box and press 

the graphic button [Run]. The shape of the model 

will be changing on the screen according to the 

current values of the variable being optimized as 

the solution progresses. 

 

By accepting the found solution by pressing the button [Ok], we get the bottle 220 mm high and 0.5 liter 

in capacity. 
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BASIC FUNDAMENTALS AND CONCEPTS OF WORKING 

WITH ASSEMBLIES 

INTRODUCTION  

Any drawing can be inserted in other drawings in T-FLEX system. For example, you can insert the drawing 

of the title block template into a part drawing, or, say, a drawing of a bolt into an assembly.  

A T-FLEX CAD drawing is called fragment when inserted into another document. The drawing obtained 

by using fragments will be referred to as assembly drawing. The assembly drawing keeps only a reference 

to the original fragment file. Modifications in the fragment file propagate on the respective component 

in the assembly drawing. 

Creation of drawings using fragments brings significant benefits in various cases. Firstly, this simplifies 

the process of creating complicated drawings, since you can create portions of such drawing first, and 

then join those. The design workflow of separate fragments can be completely independent, or, 

alternatively, be conducted in the assembly context, using the associative relations between the 

fragments and the assembly. Separating the assembly drawing into fragments corresponding to separate 

parts makes the assembly drawing fully represent the actual assembled mechanism. This approach also 

provides maximum automation to creating bills of materials of the assembly drawing, and delivers the 

complete set of detail drawings. Secondly, the use of assembly drawing supports reverse propagation of 

parametric modifications to any of the assembly parameters from the assembly to its contributing parts. 

This feature instantly yields a full set of part drawings satisfying those modified parameters. Thirdly, 

fragments can serve for representing frequently used drawing elements. Standard library elements can 

also be handy as fragments. For example, the title block template drawing can be added to a part 

drawing. You could also create special detailing elements to add to drawings. 

Effective use of fragments in T-FLEX assembly drawings relies on the following fragment characteristics: 

As any T-FLEX CAD elements, fragments can be attached to 

various elements of the assembly drawing, including other 

fragments. This allows coordinating fragment position 

modifications with other drawing elements relocations.  
 

Since fragments are parametric drawings, they dimensions upon 

assembling are calculated according to the desired parameters of 

the assembly drawing. Note that the same fragment file can be used 

in the assembly document multiple times with different parameter 

values. This feature is especially beneficial when using libraries of 

standard elements. 
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Once assembled, fragments often overlap each other and 

the image of the assembly itself. T-FLEX CAD allows setting 

up automatic hidden line removal upon fragment 

overlapping. 
 

 

You can do selective insertion of only necessary 

elements from the fragment drawing into the 

assembly drawing. This capability allows using fully 

furnished part drawings in assemblies. 

Fragments can be variable, meaning that one or 

another fragment would be inserted in the 

assembly drawing, depending on certain 

conditions. This capability allows creating assembly  

drawings  and  modeling  products  in 

   

various configurations, when different parts are put in the same assembly, depending on the 

configuration. 

Assembly drawings do not directly incorporate all fragment data. They only keep the necessary images 

and references to fragment drawings. This helps achieving most compact representation of the drawings 

in the memory and on the hard disk. Besides, if the same drawing file is inserted in different assemblies, 

then its modifications will propagate on all documents that use it. 

SPECIFICS  OF HANDLING ASSEMBLY DRAWINGS  

This section describes main capabilities and design techniques of fragments and assembly drawings. 

Detailed description of fragment-handling steps is provided in further chapters of this book. 

Assembly Drawing Creation Techniques 

Before starting with creation of an assembly drawing, think through its structure. Try to define 

requirements to its parametric layout: what specifically will be subject to modifications in the future, what 

parts will make up the drawing, what is the expected hierarchy of fragments. The conclusions made at 

this preliminary analysis stage will define the preferable technique of the assembly model and fragment 

creation. Assembly design techniques differ in the ways of creating fragment files: 

 “Bottom-up” development. This technique implies creating part drawings first, to be inserted in the 

assembly, in a conventional way in separate T-FLEX CAD documents. Assembly drawing creation in 

this case implies subsequent assembling of the necessary fragments. In the course of development, 

one has to accomplish the task of attaching part images within the assembly drawing. 

“Top-down” development. This technique implies that the part drawings originate from the assembly 

drawing. This means, the fragments are created in the assembly context. In this case, development 

start from creating the assembly drawing. Already created parts of the assembly drawing, including 

graphic lines and nodes belonging to fragments, can be used for creating new fragments. This 
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approach simplifies creation of associative relations between the assembly fragments and the process 

of their attachment. The created fragments are saved into separate documents for further refinement 

and/or use in other assemblies. 

The described techniques can be combined. For example, a fragment created and inserted in an 

assembly according to the “Bottom-up” approach, can later be edited in the assembly context. Vice versa, 

a fragment created in the assembly context, can later be used for creating other assemblies within the 

“Bottom-up” framework. 

Ways of Attaching the Fragment Image to the Assembly Drawing 

For placing the fragment image at a desired place in the assembly drawing, in the system T-FLEX CAD 

there are several different methods utilizing various tools depending on the problem being solved: 

1. Inserting the fragment with the help of fixing vector. The fixing vector represents itself a 

special construction entity which serves as a two-dimensional coordinate system. When 

inserting the fragment into the assembly drawing, a user specifies location of the fixing vector, 

and the fragment image, connected to the fixing vector, is transferred along with that. The 

fixing vector is defined in advance in the fragment document (for more detailed description see 

the chapter “Bottom-Up Design”). 

   

2. Inserting the fragment by fixing points. The fixing point represents itself an intersection of the 

horizontal and vertical construction lines the coordinates of which are specified by a pair of 

variables with special names x1…x9 and y1…y9. Accordingly, the number of fixing points can 

vary from 1 to 9. The entire parametric drawing of the fragment is constructed on the basis of 

the base construction lines determining the fixing points. When inserting such fragment, a user 

indicates a new location, and the parametric drawing of the fragment gets reconstructed 

depending on the new location of the base construction lines. This method is used when the 

fragment image (linear dimensions, shape, topology, etc.) has to be modified depending on the 

placement in the assembly drawing when position of the base fixing points is changed. For 

more detailed description see the chapter “Bottom-Up» Design”. 
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3. Associative/Non-associative fixing to elements of the assembly drawing. While designing by 

«Top-down» approach, upon creating a fragment in the assembly context drawing, a user can 

perform associative and non-associative fixing of the elements of the fragment to the elements 

of the assembly drawing (for more detailed description see the chapter “Top-Down” Design”). 

            

Without fixing (inserting «as it is», in absolute coordinates). When the fixing vector and the fixing 

points are absent while working with the «Bottom-Up» approach, and also, when all snaps are turned off 

while working with the «Top-Down» approach, the system puts the image of the drawing on the page of 

the assembly drawing without any changes. Each line or node of the fragment gets the same coordinates 

in the assembly drawing as the coordinates it had in the fragment document. 

Use of special functions of variables. In some cases when inserting the fragment in absolute 

coordinates, the functions of the T-FLEX CAD variables can be used. For example, it is used for making 

the title block. In the parametric drawing of the title block the special functions that read the coordinates 

of the page borders of the assembly drawing are utilized. Then the coordinates are passed via the 

variables to the corresponding construction lines. Thus, the title block automatically takes the desired 

size in accordance with the specified page size of the assembly drawing. 

   

Use of Fragment Variables 

When inserting a fragment, one can define the values of the variables that define the fragment drawing. 

For this, the desired variables must be marked as external when creating the drawing of the future 

fragment. For example, to be able to define a circle radius of a fragment when inserting it in other 

drawings, assign an external variable (say, “R”) to the circle radius when creating the respective 

construction circle. After that, any time when inserting this fragment into other drawings, the system will 

ask for the value of the variable “R”, and then adjust the fragment image according to the input value. 
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The external fragment variables play an important role by relating the fragment parameters with those of 

the assembly drawing. For example, consider a drawing representing a shaft, whose diameter is assigned 

the variable “Diameter”. 

 

Suppose, we need to mount a ball bearing on the shaft. A variable “d” was created in the ball bearing 

drawing that is responsible for the value of the ball bearing inner diameter. The variable “d” is marked as 

external. All the rest of the ball bearing parameters are interrelated in such a way that they are driven by 

the value “d”. 

 

Now, as the bearing is inserted in the shaft drawing, the two variables can be related. 

After the above steps, modifications to the shaft diameter, that is, to the variable “Diameter” of the 

assembly drawing, will be automatically propagate as changes to the variable “d” in the fragment, 

leading to the desired adjustment of its image. 

 

An assembly variable name can be set the same as an external variable name of the fragment. When 

inserting a fragment in the current assembly drawing, if a same-name variable is found in the fragment 

as an assembly variable, the latter will be automatically assigned the respective external fragment 

variable. 
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For automatic specification of connections between the values of the fragment variables and the 

variables of other fragments in the assembly, the mechanism of connectors can be used (see 

below for details). 

When working with a large number of external variables of a fragment, it is convenient to use 

configurations.  

Configuration – is a named, stored in the document, collection of values of external variables for 

the fragments of the document and 3D geometry corresponding to these values. In the 2D 

document, only the values of external variables are stored in the configuration. The work with 

configurations will be described in more detail in the chapter “Auxiliary Tools for 3D Assemblies 

Modeling” of the book “T-FLEX Parametric CAD. Three-dimensional Modeling”. 
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If in the document of a 2D fragment, configurations are created, then, when inserting and editing the 

fragment, the user can select one of the fragment’s configurations. The values stored in the selected 

configuration will be automatically assigned to all external variables of the fragment. 

The name of the used configuration can be specified as a variable. If the value of this variable changes, 

the system will select the corresponding configuration of the model and automatically modify the values 

of the fragment’s variables. 

Visibility Management of Fragment Drawing Elements 

A part drawing may contain an image that should not be included in the assembly drawing. Alternatively, 

we may need to use one or another portion of the same part drawing, depending on circumstances. (For 

instance, in one case we need to show the top view, while in the other – the front view.) Visibility of the 

fragment drawing elements inserted in the assembly can be controlled using layers or visibility levels. 

Two approaches are possible when using layers.  

The first one is using a layer's own attributes (“Hidden when model is used as a Fragment”, “Visible only 

when model is used as a Fragment”). This way does not allow defining several configurations of the 

fragment image based on the same drawing. Nevertheless, it allows hiding/showing the elements of the 

fragment part drawing that are definitely necessary in the part drawing, yet must be hidden in the 

assembly (or vice versa). This can be, for example, the part dimensions, the title block, etc.  

The second approach is more flexible, and can be used when positioning the fragment by a fixing vector. 

The fixing vector parameters can relate the vector with selected layers (see chapter ”Bottom-Up Design”). 

Thus, a number of part configurations (such as part views) can be obtained from the same drawing by 

creating several fixing vectors with different types of relation with the layers in the drawing. 

Control over the visibility of the fragment drawing elements is done by using visibility levels in a way 

common across all drawing elements. This approach may require use of external fragment variables. Such 

external variables can be created in the fragment drawing, and then carried over to the assembly, in 

order to control the visibility levels of the fragment drawing. The visibility levels of the fragment drawing 

elements will obey the external variable settings both while editing in the assembly context and in 

detailing (in the exported assembly fragment instance). 

Hidden Line Removal in Assembly Drawing 

One of the important advantages of T-FLEX fragments is the hidden line 

removal mechanism when building an assembly from fragments. This 

allows, on one hand, creating a complete drawing of the desired part, 

while, on the other hand, “hide” the drawing lines that fall behind the 

image of other parts of the assembly drawing. 
        

 



Basic Fundamentals and Concepts of Working with Assemblies 

809 

The area in the drawing subject to hidden line removal is defined using a 

hatch. To remove hidden lines, you can use an existing hatch or create an 

additional invisible one (using the fill method Invisible). In the hatch 

parameters, set the flag Use for hidden line removal. In this case, the invisible 

hatch will be hiding behind the objects with lower priority. 

Control over the visibility of a covered up element is done by setting an 

appropriate priority in its properties. If a fragment is supposed to cover 

assembly lines, then the fragment priority should be set higher than that of 

the assembly elements, which the fragment should cover. Vise versa, if the 

assembly lines should cover the fragment lines, then one would have to create 

a hatch in the assembly drawing itself, and then set its priority higher than the 

priority of the respective fragment.  
 

 

Let's review hidden line removal on the example of a shaft drawing 

and a ball bearing fragment. 

We need to create a hatch in the shaft drawing for hidden line 

removal. Upon inserting the fragment in the assembly, the ball 

bearing fragment image will be overlapping the shaft image. For the 

shaft image to cover the lines of the ball bearing, we need to set the 

priority of the ball bearing fragment lower than the priority of the 

hatch contour on the shaft. This can be done by the immediately at 

the time of inserting the fragment, or later, when editing it. 

           

 

Upon modifying the fragment priority, refresh the image by 

calling the command RD: Update Model Windows (by pressing 

<F7>). As a result, the image will appear as shown on the lower 

right diagram. 

  

Snapping the Fragment Elements 

Even though the lines and other elements of a fragment are not part of the assembly drawing that 

includes it, those can be used as references for creating various elements of the assembly drawing. 

Ordinary lines of the fragment image (arcs and circles) can be used at the time when the object snapping 

is turned on. In this way, one can create new construction lines on top of the fragment graphic lines or 

dimension those, or attach any other detailing elements. 

Besides the graphic lines, one can use the fragment nodes as references. To engage use of fragment 

nodes, you need to activate certain settings. The flag Fragment Nodes must be set in the command 

SO: Set System Options on the tab Snap > Priority. This setting allows creating assembly drawing 

elements that rely on the named fragment nodes or end points of graphic lines. In this way, the new 

nodes based on fragment nodes are created in the transparent mode. 
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If the image of the fragment is crowded with various elements, working in transparent mode may 

become somewhat difficult. In this case, you can turn off the discussed setting and work in the mode of 

forcing creation of necessary nodes based on a fragment:  

1. The command N: Construct Node allows creating only the nodes that will later be actually 

used in the assembly constructions (a detailed description is provided in the respective 

chapter). 

2. Named fragment nodes can be created automatically when inserting the fragment, 

provided that the flag Create Named Nodes Automatically is set in the system settings 

(the command SO: Set System Options, the tab Fragments). 

Assembly BOM Creation 

Creation of bill of materials is one of the important steps in handling assembly models. Detailed 

description of handling BOMs is provided in chapter Product Structure, Reports, Bills of Materials. 

For automatic filling of BOM records, you need to make sure, that the parts (fragments) of the assembly 

document contain sets of the relevant data. BOM data can be defined in the fragment part document in 

“Product structure” window at any stage of creation. You can specify the way of using the inserted 

elements (other fragments) and their data contribution in the product structure of assembly. This allows 

including in the product structure the data about inserted fragments or append data from product 

structure belonging to a fragment document. Defining an appropriate mode simplifies building bills of 

materials of multi-layer assemblies.   

To obtain the BOM of the assembly document, you need to do the following steps: 

1. Enter the BOM data in the product structure window in the fragment document. 

2. In the assembly document, define the way of including the fragment in product structure, 

either in the fragment parameters or in the command BI: Include in Product Structure 

(Tools > Report/Bill of Materials > Elements). 

3. Using the command BC: Create Report/Bill of Materials, generate the assembly BOM. 

Modifications of the assembly drawing are automatically reflected in the BOM. If necessary, an arbitrary 

number of BOMs can be attributed to an assembly drawing.  

Detailing Drawings Based on Fragments 

When building an assembly, the fragment drawings may be modified according to the assembly 

parameters via modifications of the fragment external parameters or the whole drawing when using 

associative attachments. In this case, the fragment drawing files are not changed. However, if necessary, 

one can automatically create separate documents with the drawings of the fragment parts adjusted to 

the assembly parameters. We will refer to such drawings as detail drawings. One can create detail 

drawings for the whole set of parts making up the assembly drawing. Once created, a detail drawing 

does not maintain any relation with the source assembly drawing. 
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To get a detail drawing, use the option  in the commands FR: Create Fragment and EFR: Edit 

Fragment or the command Open Part in the fragment context menu. 

Upon calling the command, a new document window will be opened, with a copy 

of the fragment drawing loaded in it, with the external parameter values and 

associative relations inherited from the assembly. The new drawing will be named 

“Part” with a subsequent number, for example, “Part 1”. This drawing will be 

treated by the system is a new document, with the system asking to define the 

name to save the drawing as upon an attempt to close the window.  

Usually, detail drawings are used for printing out hard copies of the detail drawings that can be different 

from the original fragment drawing due to, for instance, modifications of the assembly variables. In such 

case, you don't even have to save a copy of the detail drawing into a file. This is convenient in the case 

when a parametric fragment used in the assembly has a corresponding fully furnished drawing. In such a 

case, upon creating the detail, the user instantly gets a complete set of new documentation for the 

desired part. 

Exploding Fragments 

An inserted fragment can be exploded. By this operation, the fragment is removed, while instead the 

copies of all fragment elements are created in the assembly drawing that were deemed visible at the 

time of assembling.  

The system can explode selected fragments in two ways, creating 

drawing elements with or without construction entities. In the 

first case, all parametric relations are preserved between the 

former fragment elements by carrying over all necessary 

construction lines for maintaining parametric relations of the 

former fragment drawing. In the second case, the fragment is 

transformed to a set of graphic lines attached to free nodes.  
 

A fragment that contains nested fragments is exploded into the graphic elements and fragments that it 

contains. After using the exploding option, the obtained elements can be treated as usual, according to 

the type. 

If some elements in the assembly drawing were attached to fragment elements (dimensions, construction 

lines, etc.), then, upon exploding, those will be re-attached to the elements created by the fragment 

explosion (nodes, construction and graphic lines).  

Use of Connectors 

When creating assembly documents, it is often necessary to relate parameters (variables) of the inserted 

elements with the parameters of the elements to which the attachment is made. Examples are: setting a 

ball bearing on a shaft, attaching a cap to a ball bearing, a shaft key to its slot, a nut to a bolt, insertion of 

a screw or being into a hole, etc. When inserting such elements, the user is required not only to define 

the main dimension parameters (diameter, length, etc.), but also precisely position the elements being 
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inserted with respect to the target element (selection of the attachment point and direction). One of the 

ways of solving this task is using “Measuring” mechanism. This mechanism, however, often requires large 

amount of auxiliary preparations. Connector mechanism helps significantly simplify the procedure of 

assembling elements and minimize the number of actions required from the user. 

This mechanism is based on the concept of a “connector” 

which is a construction element serving as a reference for 

attaching other elements. In fact, a connector is a 

counterpart of a fixing vector or a target LCS for attaching 

3D fragments. Its main difference from a fixing vector is that 

a connector serves for providing attachment reference to 

other model elements. Consider, for instance, use of a fixing 

vector for inserting a bearing image into an assembly 

drawing. Suppose, the image of the bearing should be 

attached to an axle. In this case, the connector should be 

attached to the axle image (fragment).  

Besides the geometrical positioning (the origin position and 

the axes directions), a connector may keep additional 

information necessary for “snapping” to it other elements. 

 

This information is kept in the connector in the form of named values that can be constants or variables. 

The names of these values are used for specifying the values of the respective external variables of the 

fragments being snapped to the connector. For example, a connector placed on the axis of a hole, can 

have such parameters as the hole depth and the diameter. When inserting a pin in this hole, its diameter 

can be automatically defined by the value D kept in the connector. To achieve this, the external variable 

defining the in diameter should also be named “D”. 

There are a number of considerations when using a connector for snapping a fragment: 

 A connector is a construction entity and may not be displayed in the main drawing, while it 

has to be selected when snapping a fragment to it.  

 A connector may be located outside the viewable area of the drawing. 

 Sometimes, it is convenient to use a connector for placing an element elsewhere. For 

example, when attaching a cap to a ball bearing, it is convenient to select the outer lines of 

the ball bearing. Meanwhile, the intended connector is lying on the ball bearing axis. 

A concept of “associated elements” is introduced for dealing with such questions and for overall 

convenience. The list of such elements is stored in the connector. Associated elements are necessary for 

in-depth utilization of the object snapping mechanism when snapping to a connector. As the pointer 

approaches one of the image lines associated with the connector, the connector is automatically 

activated (highlighted in the screen), and the external variables of the fragment receive the values from 

the connector. The 2D fragment is automatically calculated with the new variable values and is snapped 

to the attachment point with the appropriate orientation. 
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All libraries of the standard T-FLEX CAD elements are already equipped with connectors and ready 

for their use. The required named values for linking with the connectors have been set in advance 

for the driving external variables. 

COMPOSITION DOCUMENT.  EMBEDDED FRAGMEN TS  

T-FLEX CAD provides a mechanism for managing references to other documents (fragments, pictures, 

external databases, etc.). A T-FLEX CAD document may contain references to external files ("external 

link") or have the external file data embedded directly within the file of the composition (assembly) 

document in T-FLEX CAD (“internal link”). This mechanism also helps quickly port an assembly model to 

another location in the file system, zipping the assembly in one file with the capability of quickly 

unzipping it later. 

The File > Assembly… group of commands is often used in the system to manage references. Working 

with commands of this group is described in the chapter Links. Managing Composite Documents. 

Keyboard Textual Menu Icon 

<UL> File > Assembly > Update Links  

<UA> File > Assembly > Update Assembly  

<AL> File > Assembly > Links…  

<AM> File > Assembly > Move Assembly…  

The command UL: Update Links redownloads data from the external files of the first level which are 

included into the composition document. The command UA: Update Assembly re-downloads data from 

the external files and embedded documents as well. 

The command AL: Links is provided for managing the assembly document links to other documents. 

Each of the links can be assigned a type defining the position of the external file.  

The command AM: Move Assembly is provided for moving an assembly document to another location in 

the file system or for zipping the assembly into one file. When moving the file, the moving options can 

be specified (embedding, substitution), as well as the name and the path to the target document of 

moving the assembly. 
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L IST OF COMMANDS USED IN ASSEMBLY DESIGN  

The commands for inserting and editing fragments: 

Keyboard Textual Menu Icon Brief Description 

<FR> Draw > Fragment  

The main command for inserting fragments 

and creating new fragments in assembly 

context  

<EFR> Edit > Draw > Fragment  

The command for editing fragments. Is used 

for modifying attachment parameters, defining 

properties, editing fragment variables, etc. 

The commands for “Top-down” design: 

Keyboard Textual Menu Icon Brief Description 

<FM> File > Fragment > Create  

The command for creating new fragment in 

assembly context. 

<FX> 
File > Fragment > Extract 

Fragment Drawing  

The command for creating new fragment from 

assembly drawing elements. Moves selected 

elements to fragment file. 

<FF> File > Fragment > Apply  

The command for finishing fragment editing in 

assembly context with saving fragment. 

<FQ> File > Fragment > Cancel  

The command for finishing fragment editing in 

assembly context with or without saving 

fragment. 

<FG> 
File > Fragment > Update 

Files  

The command for updating fragment created 

by “Top-down” approach, per changes in the 

assembly. 

The command for handling the assembly structure: 

Keyboard Textual Menu Icon Brief Description 

<SS> 
Tools > Special Data > 

Structure…  

The command for managing the assembly 

model structure. Displays all fragments 

contributing to the document as a tree in a 

special window, or in a text file (embedded 

fragments are included).  
 

The current document settings are done by the command ST: Set Document Parameters, the tab 2D 

Fragment. These settings will be applied to the assembly drawing when using the current document as a 

fragment.  
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On the tab Fragments, the mode Dynamic Fragment Editing used upon creating and editing a fragment 

can be turned on. When this mode is turned on, the variables editing or the fragment attachment results 

in redrawing the elements connected to the fragment. While doing it, preliminary image of the fragment 

being inserted is displayed with the same quality as the final image. Dynamic modes enhances the clarity 

of the editing process. It can be useful for editing schemes, plans, etc. 

The system settings for handling fragments are accessed by the command Customize > Options, the tab 

Fragments: 

 

The command for starting the application «Document converter»: 

Icon Ribbon 

 

 → Document Converter 

Keyboard Textual Menu 

<AC> File > Document Converter 

This command allows carrying out automatic or forced, complete recalculation, diagnostics or saving of 

the entire assembly together with the files of the fragments included into the assembly. Documents 

created under the previous versions of the T-FLEX CAD are adjusted in accordance with the format of the 

current, newer version of the software. When the work is finished, the report is generated which can be 

used for diagnostics and error search in the structure of the assembly model. Also, the converter is used 
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for transferring the documents to the T-FLEX DOCs system. Details on working with this application can 

be found in the chapter “Converting Documents Created in Earlier Versions of T-FLEX CAD”. 
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«BOTTOM-UP» DESIGN 

When using the “Bottom-up” approach, the assembly model design starts from creation of separate 

assembly elements – fragments. A fragment drawing is originally created as a standalone T-FLEX CAD 

document. In the process of creation, it is necessary to follow the certain rules that will allow in future to 

“snap” the fragment to the elements of the assembly drawing. 

A special mechanism is provided in T-FLEX CAD for correct positioning of the fragment drawings in the 

assembly  Fixing points or vectors. Such elements should be created in a fragment drawing in advance, 

before inserting it into an assembly drawing.  

When inserting a fragment, you need to specify the position of the reference elements in the assembly 

drawing, which will define the fragment position, orientation and size. The fragment image will be built 

according to the specified fixing points or vectors. If no attachment elements are created in the fragment 

drawing, such fragment will be attached to the coordinate system of the assembly drawing page 

according to its initial coordinates in this page. The position of such fragment can be modified only by 

editing. To get associated relations between the fragments and the assembly drawing, attached 

fragments to the nodes of the assembly drawing (including the nodes of other fragments). 

WAYS OF  AT TACHING FRAGMENTS  

When designing assemblies by «Top-down» approach, two ways of positioning the fragment on the 

drawing are primarily used in the T-FLEX CAD system: 

Defining fixing vector. In this way, first create the drawing, and then define the necessary number of 

fixing vectors. Each fixing vector defines the origin and the positive direction of the X-axis of one 

local coordinate system in the drawing. An arbitrary number of fixing vectors can be defined within a 

fragment drawing. The fixing vector defines the fragment position and orientation one the assembly 

drawing and controls elements visibility. 

Defining fixing points using variables. In this way, the drawing is created first, following certain rules. The 

base vertical and horizontal lines are assigned the parameters with the reserved variable names. 

Upon assembling, the system will identify the intersection point of such lines as a fragment fixing 

point. Multiple fixing points are allowed. All the rest of fragment constructions are done with respect 

to the base lines defining the fixing points. The fixing points can define the position, orientation and 

size of the fragment within the assembly drawing. 

The main difference between the fixing vector and fixing point approaches is in the sequence of creation 

steps of the fragment drawing. When using fixing vectors, you need to create the drawing first, and then 

specify the fixing vectors. When using the fixing points, one has to create fixing points first, and then 

build the drawing of the part based on the fixing points. 

There are also differences in the uses of fixing vectors and points. Fragments with fixing vectors are 

created as follows: first, the image of the fragment is formed, taking into account the visibility layers. 
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Next, the complete image is moved to the specified point and rotated by the specified angle without 

distortions. Fragments with fixing points are created differently: upon specifying the fixing points, all 

construction elements dependent on those points are rebuilt first, and then the image of the fragment is 

obtained. 

This difference in forming the fragment image on the 

assembly drawing leads to differences that can be 

illustrated by the following example. Let's create identical 

fragments with different fixing provisions. Insert these 

fragments into a drawing, rotated by the same angle. 

The fragment that uses a fixing vector, exposes a change in 

the hatch angle, nonstandard dimension placement (with 

the automatic dimension text orienting functionality 

disabled), and a changed angle of a text. The fragment that 

uses fixing points shows the hatch angle preserved, the 

dimension “10” rotated per the standard, and the text angle 

maintained as well. 

Fixing Vector Fixing Points

            

The mentioned differences shall not be considered shortcomings; rather, those are features that can be 

exploited in certain design situations. 

Fixing Vectors. Connectors 

A fixing vector and a connector are auxiliary elements of the model which are used when attaching the 

fragments. These construction elements are constantly displayed on the screen and can be hidden 

together with other construction elements by the command “Hide Construction”. Context menu is 

available for those elements, providing the deletion, editing and property modification commands. 

To use a fully furnished drawing as a fragment, one needs to create a fixing vector. To prepare the 

environment for fast “snapping” of other fragments, one needs to create a connector. The connector 

does not have to be created in the fragment drawing. It can be created in an assembly drawing.  

Fixing vectors and connectors have different purpose, however, are created in the same command 

FV: Construct Fixing Vector: 

Icon Ribbon 

 

Draw → Insert → Fixing Vector 

Keyboard Textual Menu 

<FV> Construct > Fixing Vector 

Upon calling the command, the following options appear in the automenu: 

 <F> Create Fixing Vector 

 <C> Create Connector 
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 <A> Set Snap Elements 

 <N> Select Node 

 
<F4> Execute Edit Fixing Vector Command 

 <Esc> Exit command 

Fixing vector properties 
There are two types of fixing vectors: a fixing vector defined by two points, and a fixing vector defined by 

one point. Fixing by one point is used for fast attachment of parts whose image does not change under 

rotations or parts not requiring rotation. 

When creating a fixing vector, in its parameters specify the layers of the drawing to be displayed in the 

assembly. This allows, for example, inserting different views of the same part in an assembly. 

If the 3D model exists in the document, then the fixing vector can be bound to a specific workplane. This 

allows using 2D fragments in three-dimensional assemblies for defining the position of a three-

dimensional fragment in the space with respect to the final position of the fixing vector and the selected 

workplane. This assembly creation technique is called “Layout”. Detailed information on this technique 

can be found in the three-dimensional modeling manual, the chapter “3D Assemblies Creation”. This kind 

of relation allows inserting a 3D fragment automatically when the respective 2D fragment is assembled. 

To enable this feature, set the flag Auto create 3D Fragment in the command FR: Create Fragment. 

Fixing Vector defined by two points 
When inserting a fragment with such fixing vector, the position of 

the first point (the vector start) will be defining the fragment 

placement position within the assembly drawing, while the second 

point position (the vector end) - rotation of the fragment in the 

assembly. 

To create such vector, subsequently select two nodes by clicking 

. Once the second node is selected, a dialog box appears in the 

screen. You can enter a comment for the fixing vector in this 

dialog. The comment will help selecting the fixing vector when 

inserting the fragment into an assembly drawing. 

The attribute Use as default Fixing Vector for Fragment insertion 

defines what fixing vector will be offered by default when 

inserting the fragment into an assembly drawing. Although 

multiple fixing vectors are allowed in a fragment drawing, only 

one fixing vector can be defined as the default. 
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The group Link to Layers serves for managing display of the drawing layers upon assembling. The 

parameters in the group affect only the display of 2D fragment elements. They do not affect visibility of 

3D fragments placed on the respective layers. 

 

Layer list. This pane contains the list of all layers 

existing in the drawing. Here you can mark those 

that will be displayed when assembling the 

document as a fragment using this particular fixing 

vector.  

On the diagram below, highlighted are the fixing vector and the drawing elements to be carried over to 

the assembly drawing. Those elements are assigned a new layer. Exactly this layer must be check marked 

in the fixing vector parameters. 

 

After that, when assembling these drawing as a fragment, only the check marked layer will be displayed 

in the assembly drawing, and, therefore, only the elements that lie in this layer will be displayed. 

 

               

If a fixing vector has linked layers, its context menu will provide the command “Apply Layer 

visibility”. Calling this command shows or hides the layers in the way in which they will be 

displayed when assembling the document as a fragment, using this fixing vector. 

 

Link to Workplane. This parameter has a meaning only in the 3D version of the system. It servers for 

defining the workplane to which the given fixing vector will be bound. This functionality is used when 

creating layouts (see the chapter “3D Assemblies Creation” in the volume “Three-dimensional modeling”).  
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View orientation. View orientation is used when creating 

layouts (2D fragment on a workplane by 3D fragment). It 

allows us to select condition for which the schematic view 

will be added to the assembly’s plane. Only three options 

are possible: 

Parallel to workplane − after addition of the model to the 

assembly, the model’s schematic image will be created only 

under condition that the workplane of the assembly is 

parallel to the workplane in the file of the fragment with 

which the vector is linked. 

 
 

 

Axial symmetry − it is used for models of body of 

revolution type. After addition of the model to the 

assembly, the model’s schematic image can be created on 

any plane of the assembly which is parallel to a line on 

which the fixing vector is lying. 

Arbitrary orientation − it is used for bodies with central 

symmetry or having identical pseudo-graphical display of 

several views. After addition of the model to the assembly, 

the model’s schematic image can be created on any plane. 

Fixing Vector defined by one point 
To create such fixing vector, select a node in the drawing by 

clicking  and press <End> or  in the automenu. The same 

dialog box will appear in the screen as the one described for the 

other type of the fixing vector. In this dialog box, check the flag 

Use only first point. 
 

When inserting a fragment, only one point will be asked. It won't be possible to define rotation for such 

fragment. If the flag Use only first point is not set, then a two-point fixing vector will be created. The 

direction of such fixing point will coincide with the X-axis of the fragment drawing. 

Connector 
To create a connector, upon calling the command FV: Construct Fixing Vector, activate the automenu 

option: 

 <C> Create Connector 

The system will then go into the mode of defining nodes. A connector can be defined by one or two 

nodes. If only one node needs to be specified, you can use the icon  after selecting the first node. 
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If a connector is defined by one node, then its drawing image will be a point. This leaves the only 

possibility of geometrical attachment to it of the fragments with the fixing vector defined by one point 

(only the origin, no direction). For easier fixing by such a connector, we recommend establishing the 

references between such connector and several drawing elements (see below).  

If a connector is defined by two nodes, then, upon snapping to it a fragment with a two-point fixing 

vector, the fragment will be automatically positioned by bringing together the two vectors. 

Upon specifying the nodes, the connector parameters dialog box automatically appears for defining the 

variables and the common properties of the connector. The connector variables are defined on a 

separate tab of the dialog box.  

           

Initially, a new connector does not contain any variables. At the time of creation, the user normally 

already knows the purpose of creating this connector and, in particular, what parameters of the 

connector fragments to control with it. If, for example, we create a connector on the axis of a shaft, we 

will be connecting to it the fragments of parts to be mounted on the shaft. Therefore, we need to pass 

the shaft diameter value to the fragment being connected (say, a ball bearing). 

To create a new variable in the connector , press the button [Add]. In the coming up window, define the 

name of the connector variable and its expression. The name of the connector value is used subsequently 

upon attaching another fragment to the given connector. The name of the external variable of the 

fragment may not coincide with the value of the connector. At the moment of attaching the system uses 

a special parameter of the fragment external variable called «Connector values» (see the chapter 

«Variables» for details). If in the list of values of the external variable connector the name coinciding with 

the value stored in the connector, to which the fragment is being attached, will be found, then the value 

for the external variable will be automatically read from the connector. Link with the connector will be 

retained. Also, when attaching to the connector there is a possibility to manually link any fragment 

external variable directly with one of the connector values (see below “Specifying values of fragment 

external variables”). 

The number (or the text in quotation marks for a text variable), expression or the name of the current 

document variable can be put into the field “Expression”. In our example, the value of the diameter, 

which is driven by a certain variable (for example, ‘D’) in the shaft model, has to be passed to other 



«Bottom-Up» Design 

823 

fragments. When creating the named value for the connector, it is possible to assign the name 

‘Diameter’, and put the variable ‘D’ into the expression field. When creating the ball bearing model, in the 

properties for the variable driving the mounting diameter, it is necessary to specify the new value of the 

connector with the name ‘Diameter’. 

The tab “Common” allows defining basic properties of a connector as an auxiliary drawing object – name, 

level, layer and color. Besides, a special box in this tab tracks information about the number of 

connections to this connector (if the dialog of the connector properties is open directly in the assembly 

drawing). 

Defining associated elements for connector 
To define associations of graphic lines with a connector, use the option in the automenu: 

 <A> Set Snap Elements 

Upon selecting the option, the system enters the mode of selecting lines in the drawing that will activate 

the connector once pointed at by the mouse. To add elements to the connector, select those by the 

mouse in the drawing window. The selected elements are included into the list of associated elements in 

the properties window. 

  

Insertion rules 
So-called «insertion rules» can be additionally defined for a connector. These are additional 

transformations of translation and rotation with respect to the coordinate axes of the connector which 

the system will prompt a user to carry out when attaching a fragment to a given connector. For example, 

when attaching a nut to the bolt connector, in practice it is always required to specify additional 

translation of the nut along the axis of the bolt. That is why when designing the bolt model, in the 

insertion rules for the bolt connector the necessity of translational motion along the X-axis of the 

connector has to be specified. 

Fixing Points 

A fixing point is created as an intersection of a vertical and horizontal lines, whose parameters are 

defined by variables with reserved names. 

The variables reserved for the vertical lines are: x1, x2, x3, x4, x5, x6, x7, x8, x9.   

Those for the horizontal lines are:  y1, y2, y3, y4, y5, y6, y7, y8, y9.   
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The numeric postfix of X and Y corresponds to the number of the fixing point and must match between 

the vertical and horizontal lines that define one fixing point. Up to nine fixing points are supported in a 

drawing. 

 
An example of fragment with three fixing points (a transistor) 

When using the fragment fixing method based on fixing points, one has to determine the necessary 

fixing points before creating the drawing. All the rest of the drawing elements must be created relative to 

the lines defining those points. For example, if we want to use a circle as a fragment, that we could the 

later place in various locations in the drawings, we should first create a horizontal and the vertical line, 

and only after that the circle at their intersection point. 

Fixing point creation 

Fixing points can be created automatically, using the option  of the 

command L: Construct Line. Upon calling the option, move the pointer to the 

desired position and press <Ctrl+1> (<Ctrl+2>, <Ctrl+3>, ...) or use the 

automenu icon . When creating a point by option , a number will be 

attached to the pointer, indicating the order number of the fixing point being 

created. 
 

As a result, two intersecting construction lines will appear in the screen. Besides, a pair of external 

variables will be created, x1 (x2, x3, ...) and y1 (y2, y3, ...). The parameters of the horizontal and the vertical 

construction lines will be given by these variables. Thus, a fixing point is produced in the drawing. When 

inserting this fragment in an assembly drawing, the system will ask you to specify the fixing point.  

If necessary, a fixing point can be defined manually. To do this, just create manually two intersecting 

lines, a vertical and a horizontal one, and assign the reserved variable names to their parameters, x1 (x2, 

x3, ...) and y1 (y2, y3, ...), respectively. The variables must be marked as external in this case. 

Throughout the following description, the expression Create first (second, …) fixing point will imply 

performing all steps of a fixing point creation described above. 

Let's review most common techniques of creating fixing points of fragments and local coordinate 

systems in a drawing. 

Fragment with one fixing point without rotation provision 
Create a fixing point. After that, create all construction lines relative to the vertical and horizontal 

construction lines that define the fixing point. In the course of the drawing creation, do not use the lines 

of types “vertical” and “horizontal”; rather, use the types “parallel” and “under angle”. If you follow those 
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rules, you'll get a drawing whose local coordinate system originates in the fixing point, and axes collinear 

with the X-axis and Y-axis of a drawing in which the current fragment is being inserted.  

Fragment with one fixing point with rotation provision 
Create a fixing point. Then, create a construction line passing through the 

node of the fixing point, at an angle to the horizontal line. Assign the slant 

angle of the line the variable “al”. When creating the variable, mark it as 

external and enter value other than 0 (entering “0” will make the lines coincide 

with the horizontal line on the drawing, complicating further constructions). 

The variable “al” will be an external variable of the drawing. Upon inserting the 

drawing as a fragment, the system will be asking for the value of the variable 

“al”. 

The construction line passing through the node at an angle to the horizontal 

line defines the X-axis of the new local coordinate system in this drawing. To 

create the Y-axis, make a construction line passing through the node and 

orthogonal to the slanted construction line that is passing at the specified 

angle to the horizontal line. 

The slanted line and the line perpendicular to it define a new local coordinate 

system in the drawing. All further constructions must be based on these lines. 

As a result,  a parametric  fragment  will be  built  with one fixing  point and 

the 

 
 

 

variable “al”, that will be defining the slant angle of the fragment coordinate system with respect to the 

coordinates of the assembly drawing. 

To make further constructions with respect to the new coordinate system easy, we recommend doing the 

following steps. Set the level value equal to “-1” for the vertical and horizontal lines passing through the 

fixing point. The lines will disappear from display as the construction lines visibility levels are defined by 

the range from 0 to 127 in the command SH: Set Levels, while these lines are assigned the level -1 and 

do not belong in the range. After that, call the command ST: Set Document Parameters, switch to the 

tab View and select the value Visible only in the parameter Element selection. By doing so, you set the 

drawing into the mode in which the elements will not be selectable that are not shown on the drawing. 

Fragment with two fixing points with rotation provision 
The described fragment can be created into different ways. In the first way, the second fixing point 

defines the fragment rotation and changes the size of the fragment. In the second the way, the second 

fixing point defines the fragment rotation only, not changing its size. 
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First approach: 

Create two fixing points of the would-be fragment. 

After that, you need to create construction line 1 passing through two nodes 

- the fixing points. This line will be defining the X-axis of the new local 

coordinate system in this drawing. To create the Y-axis of the local coordinate 

system, you need to make construction line 2 passing through the node and 

orthogonal to the line 1. The line passing through the two nodes and the line 

orthogonal to it define the new local coordinate system in the drawing. 

 

 

All further constructions must be performed relative to the lines 

defining the new coordinate system in the drawing. Create line 3 

parallel to line 2 and passing through the node defining the second 

fixing point. Next, create lines 4 and 5 parallel to line 1. After that, 

one can create the necessary graphic lines. 

 

 

 
 

As a result, a parametric drawing with two fixing points is achieved, 

with the point positions defining the position of the fragment 

coordinate system with respect to the coordinate system of the 

assembly drawing. Besides, the second fixing point will be also 

determining the size of the rectangle.  
 

Second approach: 

All constructions within the second approach repeat those in the 

first approach, except that line 3 does not snap to the node of the 

second fixing point, however staying parallel to line 2. 

 
 

When inserting such a fragment into an assembly, its size will be 

constant, with the second fixing point defining only the rotation 

angle of the fragment. 

 

Since T-FLEX system always treats variables x1, y1, x2, y2, etc. as defining fixing points, these 

names may not be used for defining other drawing parameters.  
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INSERTING FRAGMENTS INTO A DRAWING  

There are several ways of inserting a fragment into an assembly drawing: 

1. By using the command FR: Create Fragment.  

2. Within the Library Explorer or library window. 

3. By creating a fragment directly in the assembly context. 

The following description relates to the first two techniques of inserting a fragment into a drawing. The 

third technique is described in the dedicated section Top-Down Design”. 

Enter the command FR:Create Fragment for inserting a fragment into an assembly drawing: 

Icon Ribbon 

 

Draw → Insert → Fixing Vector 

Keyboard Textual Menu 

<FR> Draw > Fragment  

The following options will appear in the automenu: 

 
<O> Select File 

 
<C> Create new Fragment in Assembly Context 

 
<G> Extract Fragment Drawing 

 
<P> Set Fragment parameters 

 
<R> 

Repeat previous Fragment (accessible upon a 

repeated call to the command) 

 
<F> Select Fragment to create its copy 

 
<F4> Execute Edit Fragment command 

 
<Esc> Exit command 

The controls for customizing parameters of the fragment will appear in the properties window. They are 

put into several sections, their number and structure depend on the fragment creation approach. The 

sections of the properties window allow selecting the file of the fragment being inserted, a way of 

attaching the fragment, specifying external variables of the fragment, etc. 

Before selecting the fragment file the dialog in the properties window contains only three 

sections: Basic parameters, Fragment parameters, Options. The values of the parameters, defined 

in the properties window before file selection, are automatically stored as default values for all 

subsequently inserted fragments. 



T-FLEX CAD Brief Introductory Course 

828 

The first step when inserting the fragment is the selection of the file of a fragment. The dialog window 

for selecting a file can be called with the help of the option  or by pressing the button  in the 

section Basic parameters of the command's properties window. In the window for file selection it is 

necessary to indicate the document file of the fragment. After selecting the file, a dynamic image of the 

inserted fragment attached to the cursor will appear in the drawing window. The contents of the 

automenu will be changed. The new state of the automenu will depend on the fragment attachment 

approach specified in the properties window: by fixing points or by fixing vector. 

The fragment attachment approach is specified in the section Insert Fragment, with the help of the 

parameter Fixing. In case the fragment is attached by the fixing vector, the required fixing vector can be 

chosen from the drop down list of this parameter. The required page of the fragment document can be 

selected here as well (in case of multi-page document). 

In the section Fragment parameters of the command dialog it is possible to specify various settings for 

fragment insertion. A detailed description of these parameters is presented in the section “Fragment 

parameters”. 

The values of the fragment external variables are specified in the section Variables of the properties 

window. This section is present in the dialog of the command's properties window if the fragment being 

inserted has external variables. 

In the section Preview of the command dialog the inserted fragment is dynamically displayed in 

accordance with the specified values of the external variables, fixing elements (fixing points and fixing 

vectors) are indicated.  

When defining fragment insertion parameters, you need to specify the placement points of the fixing 

vector or fixing point in the drawing area (see the section Defining Fragment Placement in the 

Assembly Drawing). The coordinates of the specified points are shown in the section Coordinates of the 

command's properties window. 

After attaching the fragment on the current drawing, it is necessary to finish creating the fragment by 

pressing  in the automenu or in the command's properties window. Before that a series of additional 

operations can be performed with the help of the options appearing in the automenu of the command at 

this stage of the fragment insertion: 

 
<K> Input Fragment insertion points 

 
<P> Set Fragment Parameters 

 
<Y> Create Name for selected Element 

 
<Ctrl+O> Open Part 

 
<O> Open Fragment in Context of Assembly  

 
<D> Automatic Explode 
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<S> Explode with Construction 

 
<F4> Open Fragment file for editing 

 
<C> Select Clipping Hatch 

 
<I> Select Other Element 

 
<Esc> Deselect all elements 

The option  starts the mode of respecifying the fixing point of the fragment. 

The option  allows assigning the name for the inserted fragment. The fragment name can be used, 

for example, for search, for automatic creation of nodes of the fragment in the assembly, for obtaining 

the values of the fragment variables in the assembly drawing with the help of the function get: 

get («Fragment name»,« Variable name»), 

where «Fragment name» – the name that was specified for the fragment, and «Variable name»  the 

name of the variable from the fragment drawing the value of which has to be obtained in the assembly 

drawing. 

To explode the fragment automatically the options  and  are used (see the section Exploding 

Fragments in the chapter “Basic Fundamentals and Concepts of Working with Assemblies”). The options 

 and  allow opening the file of the inserted fragment straightway for editing, after its creation has 

been finished automatically. 

If necessary, for example, for fast insertion of several fragments in a row, it is possible, by setting on the 

flag Auto Create in the section Options of the command's properties window, to turn on the mode of 

finishing fragment insertion automatically after specifying its fixing points. In this case, the fragment 

insertion will be finished automatically right away after specifying all fragment fixing points or its fixing 

vector. 

Detailed description of all steps of inserting a fragment (selecting the fragment file, defining 

external variable values and placement, attachment of the fragment to the assembly drawing) can 

be found in the respective topics of this section. 

If you need to insert another instance of one of already inserted fragments, you can conveniently use the 

options  and  (described below, in the topic “Repetitive fragment insertion”). 

Selecting Fragment File 

For specifying the fragment file the standard window for file selection is used. It appears after using the 

option: 

 
<O> Select File 
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Both your directory structure and the installed T-FLEX CAD libraries can be the source for this selection.  

Switching between these two sources is carried out with the help of drop down list found at the upper 

left corner of the file selection window. 

When you are in the fragment insertion command, it is also possible to indicate the library element in the 

service window “Library Explorer”. 

Selecting Fragment from Library 

If a library element is used as a fragment, it can be assembled directly in the “Library Explorer” window or 

in the auxiliary library window (see the chapter Libraries), bypassing a direct call to the command 

FR: Create Fragment. In this approach, you can use the context menu commands or the Drag&Drop 

mechanism. To use the latter, select a fragment in the “Library Explorer” or library window by pressing  

on the fragment and drag it into the drawing area, while holding the left mouse button down. This will 

automatically activate the command FR: Create Fragment. You can get the same result by right-clicking 

 over a fragment in the “Library Explorer” or library window, and then selecting the context menu item 

Insert. 

Defining Fragment External Variables 

If external variables exist in a drawing, you will be asked to define the values when inserting this drawing 

as a fragment into assemblies. When attaching to the connector, necessary values can be specified 

automatically. 

Let's review defining fragment external variables in the example of a ball bearing drawing that we will be 

inserting into a shaft drawing. An external variable “d” is created in the ball bearing drawing that drives 

its inner diameter. 

After choosing the name of the fragment-bearing, in the command's properties window the tab 

“Variables” will appear which allows specifying the values for the fragment external variables. The 

standard list of variables or user-defined dialog with the control elements can be used for specifying the 

values (see the chapter “Control Elements. Creating User Defined Dialog Boxes”). 

If the fragment drawing has text fields with an external variable inserted into them (for example, 

title block), then the values of such variables can be changed directly on the assembly drawing. 

Let's consider first defining the fragment external variables using the list of variables. In this way, 

variables may be assigned data of three types:  

1) Constant (a number in the case of a real variable, or a string in the case of a text variable); 

2) An assembly variable; 

3) None (the variable entry left blank). 

Type 1: Assigning constant value 
Let’s set a particular value of the ball bearing diameter, for 

example, “30”.  
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In this case, as the shaft diameter varies, the inner diameter 

of the ball bearing will not change. To modify the value of 

the ball bearing external variable, you will have to edit the 

fragment. 
  

Fragment external variables can be pre-defined with default values when offered for defining. The 

default values are copied from the respective variables in the original fragment drawing file, if the 

flag Substitute Variable values is set in the command SO: Set System Options on the tab 

Fragments. 

Type 2: Assigning assembly variable 
Instead of a fixed value of the ball bearing external variable, let's type in the name Diameter of an 

existing assembly variable. If a user puts in the name of a non-existing variable, the system will prompt a 

user to create a new variable. 

 

Suppose, at the insertion time, the variable Diameter equals 20. Let's modify the variable Diameter to 

“40”. In this case, the ball bearing image will adjust automatically. 

An assembly variable can be selected from the list of existing variables by pressing the key <F8> (see the 

chapter “Main Concepts of System Operation”, the topic “Context menu for dialog input boxes”). 

       

If a fragment external variable was named after an assembly variable, and such assembly variable 

actually exists in the current assembly drawing, the latter value will be automatically assigned to 

the fragment variable (see the chapter Variables). 

Type 3: Undefined value 
You can skip defining the external variable altogether, 

leaving the entry blank.   

In this case the value read from the fragment file will be put into. To change now the ball bearing 

diameter, it is necessary to download its file as a separate drawing, specify the desired diameter value in 

that file, and after saving the file return to the assembly drawing. This scheme is used in practice rarely, 

when it is required to modify the assembly drawing by changing the values of the variables in the 

fragment file. 
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For filling in unspecified values of the variables 

automatically, in the System options a special 

parameter Substitute variable values is turned on 

by default. In this case, upon inserting the 

fragment, all variables automatically get constant 

value read from the fragment. 
 

Working with user-defined dialog 
User-defined dialog with control elements represents itself a more visual tool for working with external 

variables of the fragment. The set of different control elements allows specifying the values for the 

variables with the help of various toggles, buttons and also by entering the values from the keyboard or 

working with the list of values. There are two regimes in which the dialog fields for the value entry can 

operate. Either the value of the variables or the expressions themselves can be displayed in the fields of 

the dialog. In the latter case, the values of the expressions are shown to the right of the entry field. The 

second regime works in case the parameter Show expressions has been set on in the properties of the 

entry field. Details of creating user-defined dialogs are described in the chapter Control Elements. 

Creating User Defined Dialog Boxes. 

In any case, a user can write both values and expressions into the entry fields. After finishing the data 

entry (when the focus of input is shifted to another field), the fragment external variable which is related 

to the given entry field will be set equal to the expression. 

To define a relation between a fragment external variable and an assembly variable, you can use the 

context menu commands. 

You can call the context menu command “Insert Variable” or, 

instead, simply press <F8>. The standard “Insert Variable” dialog 

box will be displayed in the screen. Upon selecting an assembly 

variable, its value will be assigned to the fragment external 

variable. A checkmark before the respective command of the 

context menu will be indicating that the current fragment variable 

has a relation with an assembly variable. Direct editing of the 

dialog entries will be modifying the respective assembly variable 

values. 

To cancel such a relation, call the same context menu command 

again. When the connection with the variable is established, it is 

possible to continue working with the drop-down lists of the 

values. While doing it, the assembly variable connected to the 

given fragment variable will be assigned the new value from the 

drop down list.  
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If necessary, it is possible to switch to the mode of working with the list of variables instead of working 

with the user-defined dialog. For switching to another regime, use the flag List of Variables found at the 

bottom of the dialog. 

 

For loading one of the saved configurations (predefined set of values for the fragment external variables), 

use the drop-down list Configuration: at the bottom of the user-defined dialog. 

 

The command for working with the configuration can be invoked by the following means: 

Icon Ribbon 

 

Parameters → Tools → Configurations and variations 

Keyboard Textual Menu 

<FCE> Parameters > Model Configurations and variations 

Details of the work with the command Model Configurations and variations can be found in the chapter 

“Auxiliary Tools for 3D Assemblies Modeling” of the book “Three-Dimensional Modeling”. 

Working with the connector 
Upon attaching the fragment (for example, a nut) to the connector of another fragment (for example, a 

bolt) the values of the variables can be obtained automatically. For successful automatic connection of 

the variables with the connector, the following conditions must be met: 

1. In the connector the named values have to be specified. These named values will subsequently 

serve as a link between the variables of the fragment having a connector (bolt) and the 

variables of another fragment (nut) which will be attached to the given connector in the 

assembly. 
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2. For corresponding variable of the fragment the list of names for the values or at least one name 

of such sort must be specified for linking with the connector. The name of the value for the 

variable has to be specified in advance in the variables editor in the fragment file by modifying 

the properties of the variable. The name of the connector value specified for the variable must 

coincide with the name of the value specified in the connector. Only in this case the automatic 

connection is possible. 

  

3. Upon inserting the fragment, the connector must be chosen. The variables of the new fragment  

automatically take the values straightway after the connector selection. The image of the 

fragment takes the form in accordance with the values of the variables. 

The connection between the fragment variables and connector values can be determined manually. To 

do it, resort to the list of the fragment variables in the command of creating and editing the fragment. If 

the user-defined dialog is used for controlling the variables, switch to the list of the variables. The manual 

setup of the connection between the variable and the connector value is needed in case the fragment is 

attached to the connector but for its variable the connector value name is not designed or that name 

does not coincide with the value in the connector. In this case, clicking in the field Connector Values… 

will show the list of the connector values and upon selecting one of the values, the connection will be 

established. The field will be marked by a special symbol. 
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Using configuration 
For specifying the values of the fragment’s external variables, it is also 

possible to use configurations created in the document of the fragment.   

When configurations exist in the fragment’s document, the parameter 

“Configuration” is available in the fragment’s parameters dialog. Its drop-

down list contains the names of the configurations created in the 

fragment’s document. When selecting a configuration, all fragment’s 

external variables are automatically assigned the values stored in the 

selected configuration.  

In addition to the names of fragment’s configurations, the list of the 

parameter “Configuration” contains additional items: 

No configurations – this option is used to prevent the use of 

configuration; 

Variable… – allows specifying the name of the used configuration with 

help of the variable. After selecting this item in the list, the window for 

specifying the variable’s name will pop up on the screen. The variable’s 

name can be specified either manually (in curly brackets) or with the help 

of the context menu command “Insert Variable… F8”. 

 

 

 



T-FLEX CAD Brief Introductory Course 

836 

Defining Fragment Placement in the Assembly Drawing 

When specifying location of the fixing vector or fixing points, the 

nodes of the assembly drawing can be picked for carrying out 

fragment attachment to the elements of the assembly drawing. 

When changing location of the specified nodes of the assembly 

drawing, the fragment placement will be modified as well.   

If necessary, the fragment can be inserted by specifying the absolute coordinates for the fixing vector 

and points. This becomes possible upon clicking at the desired place of the drawing in the absence of 

object snap. The object snap can be turned off via the toolbar View or by pressing the key <Ctrl> at the 

time of the click. In this case, with the help of the section Coordinates in the fragment properties window 

the adjustment of the coordinates of the fragment insertion can be performed. 

Fragment placement using fixing vectors 
When inserting a fragment by the fixing vector the system asks to define the vector fixing points. 

If the fixing vector was defined in the fragment drawing by a single point, then 

you need to specify only one point in the assembly drawing to place the 

fragment. Once that is done, the image of the fragment will be placed in this 

point. The fragment image cannot be rotated in this case. 

If the fixing vector was defined by two points in the fragment drawing, then the 

fragment can be placed in several ways. 

The first way implies specifying two points, the first defining the location of the 

fragment image, and the second - rotation of the fragment image about the first 

point. 

 

The option for handling this way appears upon specifying the first point: 

 <M> Fixing using two points 

When proceeding in this way and fixing the vector start to one node and the vector end to another, 

modifying the position of the first node will change the location of the fragment image, while the second 

one - the orientation. 

   

The second approach differs from the first one as follows. The first point still defines the location of the 

fragment image, while the second point, instead of maintaining the rotation, sets just once the rotation 



«Bottom-Up» Design 

837 

angle of the fragment image with respect to the X-axis of the assembly drawing. The angle of rotation for 

the fixing vector can be specified as a variable. 

This way is handled by the option that appears upon defining the first point: 

 <M> Fixing using one point and angle 

With this type of placement, modifications in the position of the first placement node will cause change 

in the fragment location only, not affecting the rotation angle of the fragment image. 

  

Before confirming the fragment insertion or in the fragment editing 

command, already inserted points of the fixing vector can be easily 

changed. For modifying location of the desired point, bring a cursor to 

this point. The cursor will take the form corresponding to the point 

number (1 or 2). Next by pressing  select the point, and the system will 

be ready for modifying the point location. Choose the new position and 

press . 

 

 

 

The fragment being inserted can have several fixing vectors. For 

selecting the desired vector, the section Insert Fragment in the 

properties window should be used. In the drop down list «Page» it is 

possible to select the desired page of the fragment document (if the 

fragment contains several pages), and then for the selected page the 

fixing vector is picked in the drop down list “Fixing”. 

The section “Preview” of the properties window can be also used for 

changing the fixing vector. Here, on the preliminary image of the 

fragment, the active fixing vector is highlighted with a red color, the rest 

are blue. The fixing vector can be selected by clicking in the preview 

window. 
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Attaching to connector 
When inserting a fragment with a fixing vector, turn on the mode of snapping to connectors. This mode 

is activated by the automenu option: 

 <С> Mode of snapping to Connectors 

The option appears in the automenu immediately after selecting a fragment file, if the system determines 

that the current fragment is placed using a fixing vector. In this mode, as the pointer approaches a 

connector or a graphic line referenced by the connector, the variables of the fragment being inserted 

automatically assume the values from the same-name connector variables. This reflects on the changing 

shape of the fragment. At the same time, the updated fragment automatically snaps to the connector. 

 

When attaching to the connector the system may require specifying additional transformations 

(see below). 

If you need to define the values of other variables, this can be done in a conventional way. 
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Additional transformations 
When attaching the fragment with the help of the fixing vector, sometimes 

it is required to make the fragment location more precise – move or turn 

the fragment with respect to the axes of the fixing vector, i.e. define 

additional transformations. Transition to specifying additional 

transformation can be carried out straightway after specifying the points of 

the fixing vector. While doing it, a special dragger in the form of the 

coordinate system will appear on the fragment image. If the cursor is 

brought to the elements of the dragger (the coordinate axes and the arc 

between the axes), it will be taking the form in accordance with the offered 

transformation – ,  rotation or ,  translation along one of the 

axes. When specifying the rotation, one of the dragger axes is also selected 

(namely the nearest one) for possibility of defining exact direction to the 

selected point on the drawing. 

 

 

If at this moment  is pressed, the fragment will start moving following the 

cursor. For fixing the current transformation, it is necessary to select the 

object on the drawing or specify the numeric value of the transformation. 

Selection of the object of the drawing will create its associative link with the 

transformation. This means that upon changing the object location, the 

transformation will be automatically adjusted as well. The numeric value for 

the transformation is specified in the properties window or by clicking  at 

the free space of the drawing without selecting the object. 

 

It is possible to define an unlimited number of transformations successively. All specified transformations 

are put into the properties window. The transformations of similar type (for example, several translations 

along the same axis) are automatically summed up. 

When attaching the fragment to the connectors, the requirement of defining additional transformations 

can be brought into the fragment file already at the connector creation stage. In this case right away 

after the connector selection (when attaching another fragment) and reading the values of the variables, 

the system will automatically turn to specifying the required additional transformation. This approach is 

frequently used in the libraries of the standard elements since it is not always possible to automatically 

determine the location of the future fragment. For example, when putting a nut on a bolt, it is almost 

always necessary to place this nut on the surface being fastened, the attachment to which is specified by 

a user while defining additional transformations.  

Fragment placement using fixing points 
If the fragment drawing contains external variables “x1”, “y1”, “x2”, “y2”, etc., then upon inserting the 

fragment into the assembly drawing you will have to specify as many placement points as you have pairs 

“x” and “y” with the respective numbers in the fragment drawing. 
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For example, suppose we want to locate the image of 

the transistor, the drawing of which has three fixing 

points. Each point specifies location of one transistor 

contact. When inserting the fragment on the assembly 

drawing, the system will successively prompt a user to 

specify location of each point. 

When specifying the fragment fixing points, the current 

fixing point number will be drawn next to the cursor. 

The dynamic image following the cursor helps to 

evaluate the appearance of the future fragment. If 

necessary (in case of complicated for dynamic imaging 

fragments) the dynamic image can be switched off with 

the help of the option . 

There are two possibilities for specifying locations of 

the fixing points: attach the fixing point in absolute  

 

           

coordinates (independent of the assembly drawing) or snap to the node on the assembly drawing. 

Attachment in absolute coordinates is carried out by pressing  while the object snaps are turned off or 

by pressing simultaneously the key <Ctrl>. Snapping to a node is done via  with simultaneous node 

selection or with the help of the option <N>. 

 

Repetitive Fragment Insertion 
Several options are provided in the fragment creation command FR: Create Fragment for repetitive 

insertion or duplicating fragments. Use of these options speeds up insertion of identical fragments.  

Multiple insertions of the last created fragment are supported by the option: 

 <R> Repeat previous Fragment 

Selection of a fragment to duplicate in the drawing is done by the option: 

 <F> Select Fragment to create its copy 

Upon calling one of those options, the system asks you to specify just the placement of the fragment in 

the drawing. In this case, the external variables will have the same values as the fragment being 

duplicated. 

Adding Projections and Schematic Drawings of Models to Assembly Drawing  
This option allows us to add projections or schematic drawings of models onto a plane. 

 <W> Project 3D fragments onto a workplane  

After the command is activated, the automenu appears. 



«Bottom-Up» Design 

841 

 <W> Select workplane for specifying projection direction  

 <F> Select 3D fragment 

 <A> Select all 3D fragments in scene 

 <Esc> Exit from the command 

Using the command: 

1. Select a plane onto which the model will be projected . The selected plane will be displayed 

in the operation’s properties in the «Workplane» column; 

2. Select one or several models for projection  or ; 

3. Select projection type or schematic view. 

The source for the 2D fragment being created can be selected in the list in the «Fixing» field:  

            

 Vector projection – projection of the selected model is created on the basis of the lines of the 

model’ image; 

 Raster projection – projection of the selected model is created as a 2D fragment; 

 Fixing vector – schematic image created earlier is added to the plane. Only those vectors are 

added to the list which satisfy the workplanes compatibility condition. 

The use of this command is described in more detail in the «3D Assemblies – Creation of assembly 3D 

models» subsection of the «Using 2D-fragment as «projection» for 3D fragment» section.  

Using 2D-fragment as «projection» for 3D fragment 

This method allows us to create, on the drawing, instead of projection of a 3D fragment, a 2D image 

prepared in advance in the fragment’s file (the term “the schematic view” is used below). 

This can be a simplified image or a drawing of the workpiece. In most cases the assembly’s drawing 

created in this way will be recalculated faster than the drawing obtained by projection of the assembly. 
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This method can be conveniently used when creating layouts of industrial shops, creating electric circuits 

and in other cases that require schematic display of 3D elements on the drawings. Furthermore, 

schematic view can contain conditional graphical views which can not be foreseen on projections (for 

example, direction of door opening). 

Preparing simplified image in fragment’s file  

It is important that the overall dimensions of the drawing and 3D model be the same. If the model is 

parametric, the image being created must also be reconstructed when changing parameters. For 

example, if the length of the pipe on the drawing will be smaller than that in a 3D fragment then the 

fragment will not be connected with other elements of the pipeline upon the assembly. 

                 

Graphic lines of each drawing must be located on different layers for them to be added independently of 

each other upon creation of the assembly’s drawing even if they are located on the same workplane. 

With the help of the command  

Icon Ribbon 

 

Edit → Document → Layers 

Keyboard Textual Menu 

<QL> Customize > Layers 

 

 

First we open or create a 3D model of the fragment. In this example we 

consider an element of a pipeline. 

On the «Top view» workplane we create schematic view of the given 

element.  

It is possible to create several different drawings of the workpiece 

on the same or different workplanes and then select any drawing 

among them upon creation of the assembly’s drawing. 

Let us create one more drawing. Its construction lines must be built 

independently of the graphic lines of the previous drawing in order 

to translate drawings independently of each other. Let us call the 

resulting drawings as «Scheme» and «Top view».  
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We create two new layers. For convenience, we will call these layers «Scheme» and «Top view». 

 

  

Next we select the graphic lines of each drawing and choose one of the created earlier layers in the 

properties windows. Now selected graphic lines will be associated only with that layer. 

At the next step we create the fixing vector with the help of the command: 

Icon Ribbon 

 

Draw → Insert → Fixing Vector 

Keyboard Textual Menu 

<FV> Construct > Fixing Vector 

Now we indicate the start and end point of the vector on the drawing. The fixing vector is used for 

creating connection between the 3D model and the drawing.  

 

In the «Fixing vector parameters» window that appears we specify the 

name of the vector «Vector for “Scheme”». In the «Connection with 

layers» field we select the «Draw only marked items» option, so that 

upon rendering only the drawing located on the selected layer is 

displayed as a fragment. From the list of layers we select the 

«Scheme» layer.  

In the «Connection with workplane» field we select the plane with 

which the fixing vector will be linked. In the «View orientation» field 

we select the option of axial symmetry. The same sequence of actions 

should be repeated for the second drawing, by indicating another 

layer. 

Creation of fixing vectors is described in more detail in the «Ways of 

attaching fragments» section of the «2D–fragments – Bottom-Up 

Design» chapter. 

As a result we have two schemes for insertion into the assembly’s drawing. Projective connection must 

exist between the model and the scheme, i.e. schematic image must be located at the same place where 
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the projection of the model would be located. In our example the schemes are created on the same 

page, that’s why before adding the model to the assembly the schemes must be combined (place the 

«Top view» drawing above the «Scheme» drawing). 

 

Save the file of the fragment. 

Creating schematic image of 3D fragment in the assembly 

Open the assembly’s file. It contains two connected elements of the pipeline. The elements of the 

schematic view were created for them in advance. 

 

Go to the page of the «Top view» workplane. 

For the pages of the workplanes to be displayed in 2D window, the command must be invoked 

Icon Ribbon 

 

Edit → Document → Pages 

Keyboard Textual Menu 

<PG> Customize > Pages 
 

This command can be invoked only when 2D window is active. In the 

window that appears enable the «Workplane» flag. Now at the bottom of 

2D window the tabs of the workplanes will be displayed.   



«Bottom-Up» Design 

845 

Invoke the command 

Icon Ribbon 

 

Assembly → Assembly → 3D Fragment 

Keyboard Textual Menu 

<3F> Operation > Insert 3D Fragment 

After the 3D fragment has been inserted into the assembly we invoke the command  

Icon Ribbon 

 

Draw → Insert → Fixing Vector 

Keyboard Textual Menu 

<FR> Draw > Fragment  

Now we activate the automenu option  

 <W> Project 3D fragments onto a workplane 

We select the plane on which will be created the image and the body, for which this image will be 

created. There is a capability of selecting simultaneously several bodies manually or all bodies in the 

scene with the help of the option  

 <A> Select all 3D fragments in the scene 

For a current 3D fragment, the source for the 2D fragment being created can be selected from the list of 

the «Fixing» field: 

 Vector projection – projection of the selected model based on its graphic lines is created; 

 Raster projection – projection of the selected model as a 2D fragment is created; 

 Fixing vector – schematic view created earlier is added to the plane. Only those vectors that 

satisfy the workplanes compatibility condition are added to the list. 

 

We select «Vector for “Scheme”» and press «Finish input». On the «Top view» plane the new schematic 

image has been created. 
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3D fragment and schematic image will be synchronically moving in space. For example, when translating 

a 2D-fragment, the 3D fragment will also change its location. At the same time some degrees of freedom 

of a dragger can be automatically suppressed upon this translation (become grey), in order to prevent 

the break-up of connection with the schematic views on the other planes. 

 

Fragment Parameters 

The section Basic Parameters contains data about the fragment file. The button  can be used to open 

a window for selection of the fragment file. In the field available for editing, the text with the reference to 

the fragment file is written down. The reference can be full or relative. The second line shows the full path 

on the hard disk through which the written reference is functioning. The relative reference can be written 

manually or automatically in the following form: 

 ..\..\folder\file_name.grb – in this case, the record is made relative to the file of 

the assembly drawing. The symbol ..\ denotes going along the folders by one level up with 

respect the assembly file. 

 <library>file_name.grb – in this case, the reference uses the drawings library 

connected to T-FLEX CAD. 

It is recommended to use the relative references which operate in a more flexible way and are not tied to 

a specific place on the hard disk. It allows a user, for example, to move the assembly with all documents 

contained in it from one place to another without any losses. 
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The section Insert Fragment allows a user to select the desired page of the document being inserted as a 

fragment (parameter Page). This parameter is not available if there is only one page in the fragment. 

Also, in the drop down list Fixing found in this section, the attachment approach is specified: either by 

fixing points or by fixing vector. 

The section Fragment Parameters contains different parameters of the fragment insertion: 

Scale. Defines the scale of the fragment being inserted. This is used only when inserting fragments 

by fixing vectors. 

Rotation Angle. Defines the angle of the fragment rotation. This is used only when inserting 

fragments by fixing vectors. 

Scale line thickness. This parameter specifies whether to apply the assigned scale to the fragment 

lines thickness. This is used only when inserting fragments by fixing vectors. 

Symmetry About Fixing Vector. When set, the fragment image will be mirrored about the fixing vector. 

This is used only when inserting fragments by fixing vectors. 

Always regenerate 3D model. With this flag set, the 3D model of the fragment will be automatically 

regenerated upon changes to the 2D fragment parameters. 
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Constant Fragment (Symbol). Setting this parameter makes the inserted fragment saved in the 

assembly document as a picture. This allows speeding up the work with the assembly since now there is 

no necessity to resort to external files. The fragment file is not read when opening the assembly. Owing 

to that, the fragment can be displayed in the assembly even in case its source file is absent. However, 

since this is a picture, other elements of the drawing cannot be fixed to it. Also, it is not possible to 

modify variables of such fragment from the variables editor of the assembly drawing (when the 

connection between the assembly variable and the fragment variable exists). Modifying variables is 

possible only upon editing such fragment on condition that the source file exists on the hard disk at the 

indicated reference. 

Use Status of. As any T-FLEX drawing, the fragment has its own drawing settings defined in the 

commands ST: Set Document Parameters and SH: Set Levels. Those include the line thickness, the font 

size, levels, etc. One of the two status settings can be selected for the fragment being inserted into the 

current drawing: 

Fragment. In this case, the fragment will be inserted with the settings defined in the fragment 

drawing. 

Current Document. The inserted fragment will adjust to the settings of the current document. 

This choice is used when the assembly drawing is required to maintain a uniform style. Besides, 

by changing the ranges of visibility levels you can “turn on” or “turn off” certain portions of the 

fragment drawing when it is used in an assembly. For instance, one can remove “extra” 

drawings or dimension symbols. 

Include in Product Structures. This parameter manages incorporation of fragment data into the bill of 

materials of the current drawing. It can take the following values: 

Don’t Include - the fragment is not entered in the BOM table.  

Without Embedded Elements - the fragment is entered in the BOM table. If the fragment is an 

assembly itself, then only the fragment proprietary data is entered into the BOM. The information 

about the nested elements (lower-level fragments) is not included. 

With Embedded Elements - the fragment is entered into the BOM together with the nested 

elements. 

Embedded Elements Only - only the nested elements are entered into the BOM. 

 

Additionally, a graphic button [Include in new Product Structures] will be provided for displaying the 

window with the list of BOMs existing in the current document, and the settings of the fragment 

contribution to each of them. 
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By activating the Specify workpiece’s structure name option, one of the structures of the workpiece 

which are present in the fragment’s file can be selected. This option works only when the with 

embedded elements  and only embedded elements parameters are enabled. 

 

The way of including the given fragment into the assembly’s structure can also be specified with the help 

of the command: 

Icon Ribbon 

 

Bill of materials → Product structure → Included fragments 

Keyboard Textual Menu 

<BI> Tools > Report/Bill of materials > Included fragments 
 

The section “Variables” allows a user to specify the values for the 

fragment external variables.  

This section is present in the command's properties window only if the 

fragment being inserted has external variables. 

Both the list of variables and the user-defined dialog of the fragment 

parameters (if it has been created in the document of the fragment being 

inserted) can be used for specifying external fragment variables. The 

choice of the desired way to work with the variables is made with the help 

of the flag “List of variables”.  

To make the work with user-defined dialogs more convenient, the section «Variables» in the command's 

properties window can be brought out as a separate window by pressing the button . For bringing the 

dialog for specifying the external variables inside the general dialog of properties window, it is enough to 

close it (with the button ). 
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The section “Coordinates” can be used for specifying precise 

coordinate values for the points of the fixing vector or the fragment 

fixing points if these points are not being fixed to the elements of 

the drawing. The work with the fields in this section is similar to that 

described in the chapter “Sketch. Creating a Non-parametric 

Drawing. Automatic parameterization mode” of this manual. The 

structure of the controls in the section “Coordinates” changes 

depending on the situation: 
 

 

Section “Preview”. In this section of the properties 

window the diminished image of the fragment on the 

selected page is shown. The fixing vectors are also 

shown in this window if they exist. The desired fixing 

vector can be selected in this window by pointing at it. 

The selected fixing vector is shown with red color. The 

rest of the vectors are blue. 

Section “Options” contains the following parameters: 

Auto create 3D fragment. (Available only for 3D version). 

In case this flag is set on, right away after inserting the 

new 2D fragment the corresponding 3D fragment is 

automatically created with attachment by default 

(without using the coordinate system). 

 

Auto create. When turning on this flag, the process of inserting the fragment will be finished 

automatically straightway after specifying the fixing points or the points of the fixing vector of 

the fragment. 

Create internal fragment. This parameter allows a user to create an internal fragment, the 

contents of which are stored in the assembly drawing, but not in the external file. 

In the dialog of the fragment parameters (option ) the following parameters can be specified 

additionally: 

Priority. Defines the priority of the fragment in the assembly drawing. This is used for changing 

the order of drawing fragments within the current document and for the fragment hidden line 

removal. Priority is represented by an integer, positive or negative. Fragments with lower 

priority will be drawn in the screen prior to the fragments with higher priority. The priority of 

the current (assembly) drawing is equal to “0” by default. 
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Level. Sets the fragment level. 

Layer. Sets the fragment layer. 

The button Options. Provides a shortcut to defining the system parameters for handling 

fragments. The parameters in this dialog are the same as those on the tab Fragments of the 

command SO: Set System Options.  

See the chapter “Customizing System”. 
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“TOP-DOWN” DESIGN 

When using the “Top-down” design approach, separate parts-fragments are created directly within the 

assembly drawing window while working with the assembly. There are two approaches to creating a 

fragment when using the “Top-down” method - fragment extraction and working in the assembly 

context. In the first case, a fragment can be created by extracting into a separate file the necessary 

elements of the assembly drawing. The second case allows creating a new part drawing with the 

provision for referencing existing elements of the assembly drawing.  

The fragments created in this way can be attached to the elements of the assembly itself or other existing 

fragments. This helps excluding or significantly reducing use of external variables and simplifies handling 

of an assembly. Meanwhile, some values of the original model parameters can be obtained directly from 

the assembly context. This approach significantly simplifies relating elements with each other and 

provides parametric relation between those. If dimensions or position of one of the parts is modified, 

then all related model elements will adjust automatically. 

Working in the assembly context simplifies in certain cases the design process of the assembly module. 

This also facilitates development of the complete documentation suite of such a module, including detail 

drawings of all contributing fragment parts. Upon modifications to any assembly document, either the 

assembly drawing itself or one of its fragments, the changes propagate to all documents of the assembly 

(automatically or by the user request). As a result, modifications to one part cause update of the full suite 

of new documentation for the assembly, including the assembly drawing itself and detail drawings of all 

contributing part fragments. 

The “Top-down” design approach may not be suitable in all cases of designing assemblies. The method 

has certain shortcomings that limit its use: 

More complicated organization, compared with the approach “from part to assembly”; 

Lesser robustness to topology changes. For example, once an assembly line is referenced by an 

introduced fragment, it can no longer be deleted, otherwise the fragment associative 

reference will be lost; 

This approach is less convenient in terms of reusing fragments in other assemblies, since 

modifying a fragment may be complicated without the availability of references to the original 

assembly; 

Upon an attempt to extract a fragment, if it is impossible to “detach” an element from the 

assembly drawing, additional copies of the necessary elements are created in order to 

preserve parametric relations in the assembly drawing; 

Somewhat higher computational resources are required. 

The icons for handling the “Top-down” approach can be found: 

In the textual Menu File > Fragment > ...; 

In the automenu of the command FR: Create Fragment: 
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 <C> Create Fragment in Assembly 

 <G> Extract Fragment Drawing 

Managing Fragments in Assembly Context 

When using the option , the first step will be specifying the name of the fragment being created, 

using the “Save As” dialog box. After that, all construction elements of the assembly will be hidden in the 

drawing window, and the graphic elements drawn in halftone. While in this mode, all newly created 

construction and graphic elements will belong to the new fragment. As you create drawing elements, you 

can use one of the following modes of snapping to assembly elements: 

Associative snapping (the icon  must be in the pushed state). In this case, the fragment elements can 

be snapped to the graphic lines and nodes of the assembly. By assembly nodes, we mean the joint 

points of the graphic lines and the attachment points of the detailing elements. This ensures two-way 

relation between the assembly and the fragment file. In other words, changes in the assembly 

drawing can be propagated, upon the user request, into the fragment file, and, vice versa, 

modifications in the fragment file cause the assembly document update. As the pointer approaches 

assembly nodes in this mode, those are highlighted and marked by the tooltip “Assembly Node”, 

while the graphic elements – “Assembly Image”. 

Non-associative snapping (the check box  pushed). In this mode, snapping to assembly drawing 

elements is also available. However, in this case, snapping is done to the current "snapshot" of the 

assembly. The future modifications of the assembly lines won't affect the fragment image. 

No snapping (both of the above modes should be undone). This mode is none different from 

conventional drafting. The assembly drawing displayed on the screen does not interact with the 

fragment elements in any ways. 

The icons of the snapping modes can be found in the context menu and also in the textual menu 

“Customize|Snap|...”. 

The following diagrams show fragment creation in the assembly context, using associative snapping. In 

this mode, the assembly construction elements are hidden, while its graphic lines are shown in the 

halftone. When creating fragment construction lines, snapping to assembly elements is engaged. The 

graphic elements of the fragment drawing are created last. 
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Upon finishing working with the fragment, the system returns to the 

normal mode of working with the assembly drawing. If the created 

fragment was saved, its image will appear in the assembly. 

To finish working with a fragment, use the options in the context 

menu:   
 

 <FF> Save Fragment and Return to Assembly 

 <FQ> Close Fragment  

The option  completes working with the fragment either with saving the results or without saving, at 

user's choice 

Extracting Fragment from Assembly Drawing 

The option  serves for creating a new fragment by moving or copying into a separate file already 

existing elements of the assembly drawing. Upon the call, the following options appear in the automenu:  

 <End> Finish Fragment Creation 

 <M> Select Mode 

 <M> Deselect Mode 

 <F> Assign Fixing Vector 

 <V> Select Variables for copying into Fragment 

 <D> 
Delete or hide selected elements after creating 

Fragment 

 <Esc> Exit command  

Fragment extraction is the action opposite to that of the option “Explode Fragment”. To create a 

fragment, the user just needs to select a set of graphic elements (lines, dimensions, hatches, etc.) of the 

assembly drawing to be carried over into the separate fragment. When creating a fragment, besides the 

graphic elements picked in the assembly drawing, their respective construction elements are also 

created. 

The option  allows picking the assembly drawing elements, adding those to the contents of the 

fragment. (The selected elements are highlighted.)  

The option  excludes elements from the selected set. 

The option  toggles between the modes: 

 If the icon is in the pushed state, then, after creating the fragment, the elements included in 

the fragment are deleted from the assembly drawing. Exception is the parent elements of 
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other elements. In this case, the system will not delete the element. Instead, it will make it 

hidden (invisible) by assigning a special attribute;  

 If the icon is not pushed, then the fragment contents are formed by the copies of the 

selected elements. 

Creation of a fixing vector (the option ) is optional. However, if you need to make a provision for 

modifying the attachment of the fragment being created or placing its duplicate at other locations, then 

you should perform this step. A fixing vector can be created in one of the ways described above. 

The option  brings up the dialog box for 

selecting variables existing in the assembly 

drawing, to be copied to the fragment. 

The list in the left-hand side pane contains all 

plain variables. Variables defined by an 

expression cannot be copied into a fragment. 

The variables can be carried from the left to the 

right pane and back using the graphic buttons 

[>], [<]. The buttons [>>], and [<<] allow 

carrying over the whole list. All fragment 

variables that originated from the assembly 

drawing are automatically deemed “external”. 

 

The fragment creation can be completed using the icons:  

 <End> Finish Fragment Creation 

 <Esc> 
Exit command (without 

saving the fragment) 

 

Calling the option  brings up the dialog box for defining the fragment 

filename. If variables to be copied to the fragment were not defined in the 

course of the fragment creation (as they would have been by the option ), 

the dialog for selecting variables will appear prior to the filename defining 

dialog. 

The diagrams on the right hand side show the fragment extraction. 

The first step is selecting the elements to include in the new fragment. 
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After that, a fixing vector is created. 

Next, the necessary variables are selected, and the filename is defined. As a 

result, the selected lines are placed in the assembly drawing by the 2D fragment 

possessing the set of the specified parameters. 

Whenever possible, we recommend creating all elements directly in the new 

fragment, rather than carrying those over from the assembly drawing. This 

approach enhances productivity.  
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EDITING FRAGMENTS 

GENERAL INFORMATION ABOUT FRAGMENT EDITI NG  

Fragment editing can be performed in order to modify its parameters (references to file, image settings, 

the way it is included into the bill of materials, etc.), fixing, variables. In some cases in order to make 

changes, it is enough to turn to the dialog of the element parameters. Sometimes it is convenient to use 

the fragment-editing command EFR: Edit Fragment. It can be called as follows: 

Keyboard Textual Menu Icon 

<EFR> “Edit > Draw > Fragment”  

As for any other T-FLEX element, the common selection and editing rules apply to a fragment. That 

means, selection of the necessary fragment for editing is done by clicking , while the option <P> or  

is used for changing its parameters, etc.  

To select multiple fragments, one can use the key combination <Shift>+  (for adding elements to the 

selected list), <Ctrl>+  (excluding an element from the list) or the box selection. 

To select a fragment by name, use the option: 

 <S> Select Fragment from list 
 

This option can be helpful when the fragment with the 

known name is hard to find in the drawing. Besides, the 

option may be very helpful for editing the reference paths of 

several similar fragments simultaneously. 

A dialog box will appear in the screen, where you can select 

the desired fragment. 

By default, the fragments appear in the list in the order of 

their insertion into the assembly drawing. The flag Sort by 

Name alters the order of fragments in the list. The graphic 

buttons [Change] allows changing the filename, the 
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reference paths or both, of the selected element (or a group 

of elements) in the list. 

The fragments which because of some reasons lost 

connection with the external file are marked with the 

question sign. 

Selecting the option Change Name allows modifying the 

filename only, without changing the path. Selecting the 

option Change Path modifies the path to the fragment 

without changing its name. 

 

Selecting the option Change Name and Path modifies both the Name and the path of the fragment file. 

We recommend using relative paths to the assembly or library rather than full paths, when 

inserting fragments. Using relative paths simplifies porting assembly drawings to different file 

systems. 

In some cases, the system may automatically record the relative path to a reference with respect to the 

assembly file. Depending on the relative location of the fragment and the assembly file, the relative path 

to the reference may appear differently. The following table shows examples of relative path formats for 

fragment references: 

Assembly location Fragment location Fragment reference path 

C:\Assembly.grb C:\Drawings\Parts\Part3.grb Drawings\Parts\Part3.grb 

C:\Drawings\Assembly_1\Assembly.grb C:\Part2.grb ..\..\Part2.grb 

C:\Drawings\Assembly_1\Assembly.grb C:\Drawings\Assembly_1\Part1.grb Part1.grb 

Any Library “Bolts”, file  “Bolt_1.grb” <Bolts>Bolt_1.grb 

Follows are the rules that are accepted for the fragment reference relative path formats: 

1. If the assembly is located at a higher level in the file tree, than the fragment, then the 

reference will be always relative to the assembly file. In this way, the portion of the full path 

to the reference, identical with that of the assembly file path, is removed, resulting in the 

relative path to the reference. 

2. If the assembly is located deeper in the file tree, then the fragment, yet in the same tree 

branch of the file system, then T-FLEX CAD system will be able to create the relative path for 

the reference. In this way, to step up one level in the file tree, the system will use the 

notation “..\” in the beginning of the reference path. However, if the reference requires 

switching to another branch of the file tree, the user will have to specify the reference path 

manually, as the system won't be able to do this automatically. 

3. If the assembly file and the fragment file are in the same folder, then the reference name 

will consist of just the fragment file name. 

4. If the fragment file was inserted from an opened library, then the reference relative path will 

contain the library name, in brackets, and the fragment file name. 
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All fragments at once can be selected by the option: 

 <*> Select All Elements 

Upon selecting multiple fragments, the following options are available: 

 <P> Set Fragment Parameters 

 <Del> Delete selected Element(s) 

 <X> Explode Fragment 

 <Ctrl+X> Explode with Constructions 

 <R> Select Fragment from list 

 <I> Select Other Element 

 <U> Update Fragment model 

 <Esc> Cancel selection 

The options  and  explode the selected fragments, turning those into sets of drawing elements, 

with or without the original constructions. 

The option call  loads the changes from the fragment file. 

The available editing options for a single selected fragment are: 

 <K> Input Fragment insertion points 

 <P> Set Fragment parameters 

 <Y> Create Name for selected Element 

 <Del> Delete selected Element(s) 

 <Ctrl+O> Open Part 

 <O> Open Fragment in Context of Assembly 

 <H> Update Fragment File  

 <X> Automatic Explode 

 <Ctrl+X> Explode with Constructions 

 <T> Open Fragment file for editing 

 <U> Update Fragment model 

 <C> Select Clipping Hatch 
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 <V> Inner Fragment Variables 

 <Z> Change Fixing Vector 

 <R> Select Fragment from List 

 <I> Select Other Element 

 <Esc> Cancel selection 

Upon selecting a fragment, it will be marked by an outlining rectangle. All fixing points or the fixing 

vector of the fragment will be highlighted. 

The option  allows defining the fragment name. The fragment name can be used, for example, for 

search, automatic creation of the named nodes of the fragment in the assembly, for accessing the values 

of the fragment variables in the assembly drawing by the function get: 

get (“Fragment name”,”Variable name”),  

where “Fragment name” – the specified name of the fragment, and “Variable name”  the variable name 

in the fragment drawing, whose value is being accessed in the assembly drawing. 

The selected fragment document can be opened for editing in a separate window, using the option . 

In this case, the parameters of the opened drawing will be those defined at its creation. The option  

starts fragment editing in the assembly context.  

Option  allows switching between fixing vectors defined in the fragment being inserted. 

Option  allows editing external variables of embedded fragments without opening of source 

fragment. After activation, you need to choose one of embedded fragments.  

A detail drawing of the fragment can be obtained by the option . In this case, a new window is 

opened, with a copy of the fragment drawing loaded in it with the parameters corresponding to the 

assembly. The thus created drawing can be edited and saved under a new name, if necessary. 

WAYS TO EDIT FRAGMENTS  

Modifying Fragment Attachment  

If a fragment has several fixing points, to change all their positions (or those of the fixing vector), use the 

option . After that, just as when inserting the fragment, subsequently define the position of each 

fixing point. 

Modifying a particular fixing point (or a placement point of the fixing vector) can be done right after 

selecting the fragment. The order of steps in this case is described below. 
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The case of fragment attachment by fixing points 
To modify a placement point, move the pointer to it and click . The fragment will start changing 

dynamically together with the cursor until the new location of the point is specified by clicking  or by 

one of the automenu options: 

 <U> Dynamic Preview 

 <I> Select next Fragment insertion point 

 <N> Select Node 

 <Z> Change Fixing Vector 

 <Esc> Cancel 

To speed up handling of large fragments, the fragment rubberbanding can be turned off by the option 

. 

The case of fragment attachment by fixing vector 
To modify placement of a fixing vector point, move the pointer over it and click . The respective end of 

the fixing vector will start rubberbanding with the pointer. Set its new position by clicking  or by one of 

the automenu options: 

 <W> Dynamic Preview 

 <M> Fixing using two points 

 <M> Fixing using one point and angle 

 <C> Mode of snapping to Connectors 

 <Z> Change Fixing Vector 

 <N> Select Node 

 <I> Select next Fragment insertion point 

 <Esc> Cancel selection 

Clipping Fragment by Hatch 

The option  is provided for selecting a hatch, whose contour will be used for clipping the fragment 

image. Upon selecting a hatch, only the portion of the fragment will be displayed that is within the 

contour of the selected hatch. If the image of the clipping hatch is not needed on the drawing, the hatch 

should have the parameter “hidden” set on. 

Clipping by the hatch can be used if you need to use a hatch pattern not included in the standard set. 

Perform the following steps: 



T-FLEX CAD Brief Introductory Course 

862 

 create a new document with a set of graphic lines representing a “hatch” pattern; 

 in the document in which it is required to draw a nonstandard contour, create an invisible 

hatch the contour of which corresponds to the required one; 

 insert the document with the hatch pattern created at the step one, as a fragment; 

 call the fragment editing command and select the hatch fragment. Then, with the option 

 select the contour of the invisible clipping hatch. 

The option  ceases hatch clipping (this option appears only when editing a fragment clipped with a 

hatch).  

Editing External Variables Using Draggers 

For additional convenience, the system allows varying the fragment external variables dynamically by the 

mouse, using specially provided draggers. Draggers appear as thickened images of construction lines 

that are driven by external variables. This mode is on by default. Switching it On/Off is done within the 

document customizations on the tab “Preferences”, the graphic button “Fragments”. 

 

Variables Editing for Several Fragments 

The system allows the simultaneous modification of the variables with the same name for several 

fragments at once. For modifying the fragment variables it is necessary to perform the following actions: 

 select fragments on the drawing; 

 invoke the context menu by pressing the right mouse button and choose the command 

Variables; 

 introduce modifications in the dialog which appears. 

Upon calling the command of the context menu Variables, the dialog with the list of variables of the 

selected fragments appears. This list may include either all variables of all fragments or only common 

variables (i.e., the variables with coinciding names). Control is carried out with a toggle Show variables at 

the bottom of the dialog. 
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The common variables in different fragments can have different values. In this case, for such variables 

opposite their value there will be a special control element – a flag which when being switched on will let 

a user change the value. Modification of the value for the common variable will be applied to all selected 

fragments. 

Using Clipboard for Fragment Variables 

When selecting a specific fragment with , the commands for 

copying variables from one fragment to another will be found 

in the context menu. The command “Copy variables to 

clipboard” copies values and expressions for the variables into 

the internal clipboard. The command “Insert variables from 

clipboard” replaces the values of the variables having the same 

name for the selected fragment with the values from the 

clipboard. 
 

Editing Fragment in Assembly Context 

The option for editing in the assembly context  is available in the context menu of the selected 

fragment and in the automenu of the command EFR: Edit Fragment. 

Upon calling the option, all elements of the assembly drawing other than those belonging to the 

fragment are drawn in halftone, and the fragment elements become editable. As in the assembly-context 

fragment creation, the user can create and/or edit the fragment drawing. With the associative or non-

associative snapping to assembly elements turned on, you can use nodes and lines of the assembly 
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drawing as references. The commands for modifying the snap types and exiting the mode of work in the 

assembly context can be found in the context menu. 

                              

Updating Fragments Files 

The options Refresh Fragment File and Refresh All Fragments Files (the icon ) are provided for 

updating the fragment document per the changes in the assembly when working by “Top – down” 

approach or in the assembly context. To update a single fragment, you can use the respective option in 

the automenu of the command EFR: Edit Fragment or the command Update, accessible in the context 

menu. To update all fragments per the changes in the assembly drawing, use the option “Refresh All 

Fragments Files” in the textual menu item File > Fragment > Refresh Files. 
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PRODUCT STRUCTURE, REPORTS, BILLS OF MATERIALS 

T-FLEX CAD provides convenient set of tool for creating standard and custom BOMs and reports.  

Report is a flexible mechanism for creating technical documentation in customized formats. This 

mechanism can be used for a standard BOM creation as well as for your own reports based on the 

product structure. Thereby program technical documentation tools can be adapted for various specific 

industries. 

BOM in program is a table containing data about fragments (parts, subassemblies) inserted into the main 

assembly. If necessary, one drawing document may contain several BOMs.  

 

BOM data is automatically copied from fragment files or added manually by user. In addition to 

fragments, the data from other sources can be included in the product structure – from 3D objects or 

drawing elements. 

BOMs and reports can be created on the base of prototypes or report templates. 

The BOM prototype is a program document that contains empty BOM table with preset properties. The 

BOM prototype describes structure of columns and sections for the created table. Prototype-based 

BOMs is a legacy mechanism and is not recommended for usage in the new documents. 

The report template is a more flexible mechanism with extra options comparing to BOM prototypes. 

When you work with the product structure, the templates usage is preferable because of various 

advantages. 
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The report template is a program document file. BOM format and its data structure are described in this 

file according to certain rules. Tables and data description are inserted as text entities that are created in 

the template. 

The template may contain macros (special microprograms) for additional template data processing, for 

example, empty rows adding. 

Each macro has some number of attributes. Their values can be set for inputting when you create a 

report. Report is filled according to the product structure and the report template. 

Report and BOM data is displayed in Product structure window. 

The Product structure is used to collect technical documentation data. The data about the structure and 

the hierarchy of a product can be added to product structure manually or automatically. You can specify 

sorting, grouping and displaying rules for data in the table. There are commands for callouts creation, 

export to Excel, report generation, etc. 

 

New product structures are created on the base of product structure types either included in the 

program installation or custom. Each type specifies various properties and column composition. 

Several product structures can be created for one product. Each of them will display appropriate data for 

further generation of reports and BOMs. 
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PROD UCT ST RUCT URE  

Product Structure Window 

Product structure window is used for managing the product structure. 

 

To open this window use option: 

Icon Ribbon 

 

Bill of materials → Product structure → Product structure 

Keyboard Textual Menu 

<Alt+9> Tools > Report/Bill of materials > Product structure 

BOM data, collected from fragments and other objects or inserted manually, is displayed in Product 

structure window. Also there are additional tools for assigning data. When you fill in the title block, all its 

data is automatically included in the document product structure, because title block and product 

structure fields are associated by variables. 
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Product structure for assembly documents is automatically compiled on the base of product structure 

data of parts. 

Data from various assembly sources can be added to the product structure. It can be fragments, 

bodies, 2D elements, etc. By default fields of the product structure records are set as automatically 

filled to use data from the source elements. 

Icons indicate the field filling method. Automatic fields are indicated with  icon.  Manually assigned 

fields have  icon. The third field type  appears for specific fields that are also assigned automatically 

– titles, zones, page format, etc. 

If you need to edit the content of a field manually, click appropriate icon. Thus «Field is filled by 

user» mode activates and icon will change to . 

 

By default the new product structure has “General BOM” type.  

Any product can be presented as the hierarchical structure (tree) in the Product structure window. The 

product itself is a root and its constituent components are presented as hierarchical records. 

The product structure record is presented as a row in table with columns. It contains information about 

parts, quantities, materials, documents, etc. All data is inserted into data cells corresponding to the 

columns. 

 

Product structure window has control toolbar that is located in the upper part of the window. It is used 

for various operations with the product structure. 

 

 
 

Under the toolbar you may see the main product structure window that contains list of records, which 

are included into the current product structure. The following columns are displayed by default: 

“Description”, “Part No”, “Quantity”, “Position” and two columns for specifying inclusion of the records 

into reports and assemblies. If necessary, you can add/remove columns to be displayed in window 

manually. 
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Every product structure may have various “representations”. Representations allow to display the same 

product structure data according to the preset rules. For example, similar parts of assembly can be 

merged and their quantity can be displayed in the corresponding column. Or some data may be filtered 

out. To use representations press  Apply product structure representation button on the toolbar. 

Necessary representation can be then selected from the drop-down list. 

 

Each representation has its own properties set: displayed columns, sorting and grouping rules, filters, etc. 

More information about representations can be found in “Representations tab” section.  

  

Without representation With representation “With Records Merge” 

On the right side of the Product structure window you may open Parameters window via toolbar option 

 Show record parameters window. All product structure columns and their content for the selected 

record are displayed here. Here you have access to all fields of the product structure record even those 

that are not displayed in the main window. 
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Toolbar  

Product structure window toolbar provides options for: 

 creating and deleting the product structures; 

 editing the product structure properties; 

 data adding, grouping and sorting; 

 setting relations between product structure records and objects in the current document; 

 reports generation and updating; 

 callouts creation; 

 export to Excel. 

 
Product structure name is displayed in the field: 
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Every new document already 

contains the product structure 

called “General BOM” created 

on the base of “General BOM” 

product structure type.  

If you want to create another 

product structure you need to 

select “New product structure” 

item. 

After that in New product 

structure dialog box you can 

specify Product structure 

name and other parameters of 

the product structure. 

 
 

Product structure type. The drop-down list contains all available 

product structure types. 
 

Copy document template records when creating a new product structure. Product structure records 

will be copied from the selected template to the new product structure. User can select any document as 

a prototype if he select User-defined item in the drop-down list. 

Product structure type is a set of properties for product structures used as a template for new 

product structure creation. Properties include columns composition, grouping rules, sorting and 

records filtering. Each product structure type is stored in the separate file. 

New product structure types can be created with BY: Product structure types command. 

You can set the following parameters in New Product Structure dialog box: 

 

Export product structure to T-FLEX DOCs. If the flag is set, the current product structure will be 

saved when the file is exported to T-FLEX DOCs application. If there are several product structures, 

but no one was set for export, then the first one structure from the list is exported. 

 

Getting location zones from fragments. If the flag is set, zones values are defined by the fragment 

location. If the flag is not set, the zone is defined by the callout location. 

 

Zones are used for simplifying search of parts in big assemblies. You need to open Paper > Zones 

tab in the ST: Set Document Parameters command. Set the corresponding flags. 
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Exclude hidden objects. When the flag is set, only visible objects will be included in the product 

structure. Object no visible on the drawing/model, for example, hidden using levels mechanism or 

suppressed, will not be included.  

 

Create hierarchy by tree of fragments. When the flag is set, the hierarchy, that exists in the fragment 

file, will be added to the assembly product structure. When the flag is not set, all items from the 

fragment file will be added to the same level in the assembly product structure. 

 

When you create a new product structure based on the selected type, all properties will be copied and 

saved in the current file.  

More information about the properties can be found in “Properties Tab” section. 

 Add record option creates a new empty record (item) in the Product structure window.  

 

All new records are added to the zero hierarchical level. By default only records from first and 

upper levels are displayed in  Apply product structure representation mode. That is why the 

new records will not be displayed in this mode.  

If there are several sections in the product structure, the new record will be created in the section that 

has input focus. Data is entered manually. Each data cell can be associated with a variable by setting the 

flag in the field. 

 

  

To manage all existing data cells of the current record use   Show record parameters window option. 
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List of columns (cells) can be sorted using  Categorized and  Alphabetical options in the top of 

the window.  

 

 Add child record. Option is used to form the hierarchical structure of a product. It creates an 

embedded record relative to the current. The new record is indicated with  icon. 

 

 Add record to section option is used to add a new record to the section.  

  

If there are any records existing in the required section, you can point the cursor on one of them and add 

a new record with  option. 
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Also you can specify the record section in the parameters window , by pressing on the corresponding 

field in the drop-down list. 

 

 Delete record option deletes the current record from the product structure. 

 

  Move records up/down. This options allow to move selected records in the product structure. 

Moving is allowed only inside one section and with inactive sorting. 

 

 Link selected objects with product structure record option allows to set links between product 

structure records and document objects (3D operations, 3D construction elements, 2D drawing 

elements). 

 

The option is available only for manually created records. Such link cannot be set for records from 

fragments or any other data sources. 

To set the link, perform the following actions: 

 

1. Select record in the Product structure window. The string will be marked. 

2. Select object in the scene with mouse click (it will be highlighted). 

3. Press  icon. 
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When the record is selected in the Product structure window, the linked objects are highlighted in the 

scene and in 3D Model window. 

  

It is possible to link one record with several objects. 
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You can delete the link using  Delete link of product structure record with objects option. 

Use BL: Create BOM Callout command to create callouts. For quick access to the command use icon .  

More information about the command can be found in section “Callout Creation”. 

 Show variable names. When option is active, the variables names are showed in cells that have link 

with those variables. When the option is inactive, the variables values are shown. 

 

Use BI: Include in product structure command to manage parameters of the fragments inclusion into 

the product structure. You can use icon  on the toolbar to activate the command.  

More information about fragments inclusion can be found in section “Include in product 

structure”. 

 Apply product structure representation mode shows list of records according to the grouping and 

sorting rules set in the representation. When the mode is active, group names are displayed in the list 

and representations selection becomes available. 

The  mode allows to display data according to the preset rules of representations. 

 
Product structure without representation 
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Product structure with representation that corresponds to standard BOM table. In this case, the group names are 

the names of the BOM sections 

Fields are indicated with color if their values are summed. 

Representation field. If there are several representations in the product structure properties, then you 

can select one of them in the Apply product structure representation field.  

  

More information about representations creation can be found in section “Product structure 

types”. 

 

 

Update. The command updates current product structure after changes in the 

assembly document or fragments. 

Update all. The command is updating all existing product structures. First, existing 

positions are updated, then – linked records. 

 Product structure properties option opens dialog of the current product structure properties. 

Modifications are saved in the current assembly file.  
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You can change name of the current product structure in appropriate field. With a special flag you can 

mark product structure for be used when exporting assembly to T-FLEX DOCs. 

Button Save properties as type will save the current product structure properties as a product structure 

type in *.xml format.  

When a new product structure is created, it uses one of the product structure types that defines its 

properties and behavior. The original product structure type may change later due to various system 

improvements or customization. If this file with product structure type changes, system reflects this case 

with a warning message “Properties of product structure differ from properties of type used for its 

creation. You may update properties from the modified type or ignore this warning”. 

You may either ignore this message and leave the original behavior of the product structure or update 

product structure properties from the modified type using Update properties button. 

If necessary, you may also reassign product structure properties by reading them from any arbitrary 

product structure type by using Read properties from type button. 

 

The information about product structure properties can be found in “Product structure types” 

section. 
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Use option  Export product structure to Excel to 

export the current product structure to Excel format.  

 

You can specify exporting of only columns visible in 

the product structure window by setting appropriate 

flag in the dialog that appears. If the flag is inactive, all 

product structure columns will be exported. 

Export hierarchy allows to export hierarchy of product 

structure record into Excel. 

You can set decimal separator for the exported values. 
 

If export is used in  Apply product structure representation mode, the Show titles of sections 

flag will appear. These titles will be added to the additional column of the resulting excel table. 

 

After that you can specify file name, folder  and necessary Excel format - XLSX or XLS. 

From a product structure you may generate various reports, like for example BOM tables on the drawing 

page. 

To show all reports and BOMs created in the current document use BM: Report/Bills of material 

command. Icon  is used to obtain quick access to the command. 

 Delete product structure. The option allows to delete the current product structure. 

 

The search bar is located in the right part of the toolbar. It simplifies data search inside the product 

structure. 

 

Input search string or a substring in the field or select from one of the previously used search strings. 

The corresponding record will be selected after pressing <Enter> or  button. Repeated pressing on 

<Enter> or  button gives next search result. 

 

The data will be searched in both visible and invisible columns. When found, the corresponding record 

will be marked. 

Reports 

To create a report use option  Create report based on Product Structure. Window with the list of 

reports available for the current product structure will appear. This contents of this list is unique for each 

product structure and originally is taken from the product structure type used for product structure 

creation.  
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Preview is located to the left from the list. It can be hidden using button . 

 

Properties of the product structure reports are displayed in the lower part of the window. You can 

change them for each created report if necessary. Lists of reports and their properties are stored in the 

product structure properties. 

 

  

 

Report creation: 

1. Select template for the report with preset rules for filling its fields; 

2. Set properties of the selected template (optional); 

3. Press [Run] button. 

Use option  Update product structure reports, located on the toolbar, to update the already existing 

reports. 
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More information about report creation can be found in “Create Report/BOM” section.  

More information about report generator properties can be found in “Reports Tab” section. 

Commands of the Product Structure Window Header Context Menu 

You can find some commands for managing  product structure in context menu of header. The context 

menu is called by right mouse click in the title of the product structure table. It includes the following 

commands: 

Columns. The drop-down list of this command allows you to select columns to be displayed in the 

Product structure window. 

A column is displayed in Product structure window when the flag is set near the column’s name. 

 

Show all. When option is active all columns existing in the product structure will be shown.  

 

Show Only Predefined. When option is active only columns with the preset flag  Show column in 

Product Structure window will be shown. The option can be set on Columns tab in Product structure 

properties window. 

 

Show Linked object. The option adds “Linked object” column to the table. The column shows names and 

icons of the data sources (for example, data of fragments). 

Main Data. Includes main and manually created columns. 

You can create a new category for columns. All manually created columns can be added to any 

category, except “Parameters of include”. 

More information about columns can be found in the “Columns tab” section 
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Inclusion Data. Presents the following columns: Position, Include in report/BOM of current document, 

include in assembly. 

 

Include in report/BOM of current document and Include in assembly columns displays flags that allow 

to include records into the current document reports and product structure of the upper level assembly. 

Sort by. The drop-down list contains the most commonly used columns for sorting records. 

 

 

 

Sort Ascending, Sort Descending. Sets sorting order for the current column of the product structure. 

Cancel Sorting. Cancels sorting rules. 

Show Grouping Tool Window. Activates special tool area in the upper part of the window to simplify 

grouping. To set grouping by column you need to drag its header to this area. 

 

 

 

Group by This Column. When this mode is enabled, all records in the product structure will be 

organized as groups with the same value in the current column. Sequence of grouping is displayed in the 

upper part of the window. Marker near the header allows to change sorting sequence. 
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Group by Representation Rules. The grouping mode is set from the product structure properties. Each 

representation can have its own grouping rules set. Data is not grouped, when the flag is disabled. 

The option is available only in  Apply product structure representation mode. 

Cancel Grouping cancels usage of all groupings rules set in the context menu or in the representation. 

Borders. Allows to manage display of table borders in the Product structure window. 

 

 

Alignment specifies text or icons alignment in the fields of the product structure for the column. 

 

 

Hide Column. The selected column will be hided in the main window of the product structure. 

 

Adjust Width. The option is adjusting width of columns to show their full names in the Product structure 

window. In case of insufficient space the priority goes to the column which header was used for 

command activation. 
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The Product structure item provides quick access to several commands that also exist in the toolbar. 

 

 

Summation results command allows to assign sums of values in columns to variables. Summation of 

values is specified on the Sum tab in the product structure properties.  

 

More information about the summation can be found in section “Sum tab”. 

Context Menu of Product Structure Records 

Context menu of a product structure record includes options for the product structure and the record 

itself. 

  

You can create a child record for the selected 

record using option Add child record.  

To restore the original position of a record in the 

Product structure window, you need to select 

item Restore location of record in product 

structure. 

Option Expand All/Collapse All allows to 

show/hide grouped records. 

Create BOM Callout. Activates command for 

creating callout in the current document. After 

callout creation, you can select another record 

and continue working with the command. 

Restore location of record in product structure. You can restore locations of child records. 

 

You need to select Restore location of record in product structure option to restore the source position 

of a record. The record appears on the source position after the product structure update. 
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Copy/paste options: 

 

 You can copy the selected records using the clipboard; 

 All records pasted from the clipboard will be added as “created manually”; 

 If there were hierarchical relations between records before copying, they are retained after 

pasting. 

 Links between records and variables persist while copying within one document. When you 

paste records into another document or text, only values will be copied; 

 Hotkeys <Ctrl+C>/<Ctrl+V> are available for coping; 

 When you paste records in the 2D window, they are inserted as text. Only columns visible in 

Product structure window are copied as text. 

 

Product structure item in the context menu is similar to the same item from the headers context menu. 

3D Fragment item appears in the context menu of each fragment. Its drop-down list contains all 

standard options for working with a fragment. 

 

Reports item allows you to select report template from the drop-down list. The report will be generated 

after  selection. Its properties are preset in the product structure properties. 
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PROD UCT ST RUCT URE TYPES  

The product structure type is a file that contains the product structure properties. The product structure 

type is a prototype for creating new product structures in documents. 

Product structure type command is used to create new product structures types and edit the existing 

ones. 

To call the command: 

Icon Ribbon 

 

Bill of materials → Options→ Product structure type 

Keyboard Textual Menu 

<BY> Tools > Report/Bill of materials > Product structure type 

You can also open the same window for the current product structure using  option on the toolbar. 

The list of existing product structure types is located in the left part of the window. Tabs with their 

properties are located on the right side. 

 

 

Each product structure type is stored in XML file. Settings from such type will be copied to the current 

document when type is used for creating a new product structure or for an update of product structure. 

Path folder with the product structure types is set in SO: Set system options command on the Bill of 

Materials tab in Product Structure Types field.  
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New documents already contain “General BOM” product structure created on the base of "Default 

product structure.xml" file. 

 

The following icons are located at the top of the Product Structure Types window: 

 

 Open type from file loads description of the product structure type from the *.XML file. 

 Save type as saves description of the product structure type into the XML file. 

 New type creates a new type based on the “empty type”. Properties of such a type are not set. 

 

 Delete type deletes the current record from the list of product structure types. 

 Copy type copies properties of the current product structure type. 

 Paste type creates a new product structure type based on 

the copied properties – columns, groupings, sorting, 

representations, etc.  
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To rename the product structure type, click   on its name and fill in text. 

 
Note that if you create a BOM table based not on the product structure report template but on the 

legacy mechanism based on the BOM prototype file, the prototype properties will be used along with the 

product structure properties. The prototype properties can differ from the product structure properties. 

In this case, the created BOM may differ from what you see in the Product structure window, because 

the prototype properties like grouping and sorting will be applied to it after the product structure 

properties. 

Properties Tab 

The following properties of the product structure type can be specified on Properties tab: 
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Define zone by. When you work with large assemblies, they are divided into zones to simplify fragments 

searching. If the Fragments location flag is set, the zone value is determined by position of the 

fragment’s bounding box that encloses elements belonging to the fragment. 

When the Callout flag is set, the zone is defined according to the callout location. 

Don’t include invisible objects. If the flag is set, only visible fragments will be included in the product 

structure. Fragments that are invisible on the drawings or 3D models, i.e. hidden using various 

mechanisms, will be ignored. 

Create hierarchy by tree of fragments. When the flag is set, the hierarchy that exists in the product 

structure of fragment will be retained in the assembly product structure. If the flag is not set, all the 

records from the fragment’s product structure will be placed on the single level in the assembly product 

structure. 

This option does not affect records that were automatically generated based on fragments or 

other sources and then manually moved inside the assembly product structure. 

Example: 

Product structure “Subassembly 1” contains two item-records for two fragments – Bolt and Screw. 

 

The flag set in the  column means that records will be included when the Subassembly 1 is inserted 

into the upper level assembly. 

Next, the assembly “Assembly example” with its own product structure was created using With 

embedded elements mode in option . 

The “Assembly example” has the following product structure: 

 

After inserting “Subassembly 1” into file “Assembly example” as a fragment and updating the product 

structure you will receive the following results. 

If the Create hierarchy by tree of fragments flag is set in the current product structure, then all the 

records from the fragment becomes “child” for the assembly record of the product structure. Both the 

hierarchy of assembly example and the hierarchy of Subassembly 1 are taken into account.  
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If the flag is not set, all the records from the fragment file will be placed on the same level of the product 

structure. 

 

Update product structure considering changes entered manually in the embedded product structures. 

If the flag is not set, records added manually inside items constituting the product structure, will not be 

included in the current product structure. 

Report Options Group 

 

Merge Records. When the flag is set, all records with the same content will be merged. Flag Ignore 

parameter when comparing records to merge for particular columns will be also taken into account. 

More information about the parameter can be found in “Columns tab” section. 

For example, records with the same descriptions and different quantities can be merged. 

Merging is performed in the following way: 

A record in the product structure is compared with the following record in the list. If their columns’ 

content is the same, they are merged and comparison with the following record in the list is performed. 

For correct merging list of records should be first sorted prior to merging. Sorting is performed by 

specifying sorting rules. 

More information about the sorting rules can be found in “Representations Tab” section. 
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Option disabled: 

 

Option enabled: 

 

 

Reverse order. When the flag is set, records in the Product structure window will be organized in reverse 

order, starting with the highest position number. 

 

Sort by positions. If there are manually set values for positions in the product structure, they will be 

organized by order after setting this flag. 

  
Without sorting by order With sorting by order 

Number positions in the group after maximum value in the previous group.  

The option is used to correctly support reservation of strings and positions when some positions are 

omitted for possible further usage. If there are manually created positions in the sections and their value 

is higher than position values in the following group, automatic numeration in the following group will 

begin according to the highest value of manually created positions. 

 

If the flag is not set, the “missed” positions values from the precious section will be used. 
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Inactive option Active option 

All options are used only when  Apply product structure representation mode is active. 

 

New Product Structure group. 

Name of new product structure on creation sets name to be used when creating new product structures 

of the current type. 

Copy document template records when creating a new product structure. You can enter filenames of 

prototypes from “Program/Template” folder in the fields. Records from the templates will be added to 

the new product structure created using the current type. 

Use column for positions assignment on the drawing. You can select a column from the drop-down list. 

The column will be used upon callouts creation instead of the “Position” column. 

Columns Tab 

You can add new columns for the product structure type and modify properties for already existing 

columns on Columns tab. 
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There is a the set of standard BOM columns and their properties in the product structure by default. 

Buttons  

Add , Properties , Delete , Up  and Down  are located on the right side. 

The columns on the right side present flags from the column properties. 

  

When you create a new column the Column properties window appears: 
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Properties group 

  

Name. Sets the column name. 

 

Synonym name is used to simplify the entry of the element in the report template. It is recommended 

to specify a synonym without spaces. For example, instead of the {param name = "Part No."/} element, 

you can write the {PartNo/} element. 

 

Category. Columns can be grouped into 

categories. Categories are displayed in the 

product structure parameters window and in the 

header’s context menu. 

The “Inclusion parameters” category is reserved 

for the system columns “Include in Report/BOM 

of current document”, “Include in assembly” and 

“Position”.  

 

 

 

If the column has no category, it will be placed to the “Main 

Data” category. You can select any other category from the 

drop-down list. When you enter a new category name, it is 

added to the list. 

Type. Parameter sets type of data in the column. 

String. The column contains text string. 

Real. The column contains real values. 

Integer. The column contains integer numbers. When the 

real number is entered into the column, its fractional part will 

be omitted. 

Boolean. The value is used as a toggle. If the column field is 

linked with a variable, then the “0” variable value switches the 

field off (value “False”), other values switch the field on (value 

“True”)  
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You can specify accuracy of real values for the Real type. 

 

Column width. Parameter sets column width in pixels in the Product structure window by default for 

the new product structures.  

 

Show column in Product Structure window. When the flag is set, the column is shown in the 

Product structure window. This flag is taken into account only in Product structure window. 

Group by column. When flag is set, all records with the same value in this column will be merged 

into groups. This flag is taken into account only in Product structure window. 

Sum values when merging. When this flag is set, the values in this column will be summed for the 

merged records, for example the values in “Quantity” column will be summed, if there are similar 

parts in the assembly.  

The flag is taken into account when the column is selected on the Sum tab. 

Several algorithms for the summation are available:  

 

Summation – the result is the arithmetic sum. 

Concatenate strings – the result is the sequential 

combining of values with separator if necessary. 

Concatenate unique strings – the result is the same as 

above but without duplicated values. 

In the last two cases, the result presents one combined 

string. 

In the right field, you can specify any symbol for values 

separation. E.g. you may generate single string 

enumerating positions of merged items.  
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Concatenate strings and Concatenate unique strings options only for text strings. 

Ignore on comparison. When the flag is set, the content of the column will be not taken into account 

when the product structure records are compared. I.e. if there are several records, which parameters 

differ only in this column, these records can be merged - the column will not affect merging. 

Value group 

 

Default value. The entered value will be automatically set in the column data cell for each new 

manually created record. 

List of values. Allows to create preset list of values for a column. When you enter text into the string it 

will be added to the list after pressing <Enter>. After that you may enter another string to the list. If list 

exists for a column it will be available for selection in the Product structure window. 

 

Data Assignment group 

Data can be entered in the column cell manually or automatically. You can select data source from the 

drop-down list of the Data Assignment group. 

 

Data from fragment field, variable of current document or variable – data assignment method set by 

default. 
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Zone. Format. The column is automatically set with zone or format values for fragment-based records. 

Zone is taken from the assembly drawing and depends on Getting location zones from fragment 

flag. 

Format. The drawing format is used for the parts. For subassemblies, BOM format used in 

subassemblies is assigned. 

 

Fragment Name. Name and folder of the fragment file of the product structure item. 

Variation Name.  Name of the fragment variation that is used in assembly. You can specify the 

variation name in FCE: Edit model Configurations and Variations command. 

Fragment Variable. Fragment variable value will be used as value. You need to specify the fragment 

variable name. If there is no such a variable in the fragment file, the field will stay empty. 

 

Compound Column. Allows you to compose the value using values of other columns. Data can be 

taken from any other columns. Mathematical and logical operators can be applied to the columns. 
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Compound Column Creation 

Option  adds a new element to the compound column sequence. 

The new element will be added after the selected element. The element 

type can be selected from the drop-down list. 

Column. Element-column  will be added to the string. You can select 

the column name from its drop-down list. 

 

Text. Text constant element will be added to the string. 

 
 

 

Parentheses. Parentheses allow to set sequence of mathematical and 

logical operations. 

 

  
 

Mathematical operations: «+» - addition, «-» - subtraction, «x» - 

multiplication, «/» - division, «%» - division remainder.  

Operations allow to apply mathematical formulas/relations for the 

neighboring elements of the string. 

 

Concatenation «Concat»/ conditional concatenation «CondConcat» - 

merge element/ merge conditional (the operation is performed if both 

elements are not empty). The result of CondConcat operation for the 

“Compound column” is shown below. 
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Conditional operator «->» - if A, then B. The B will be included in the column if A is not empty, not equal 

“0”, is “True”.  In particular it is useful to use this operator to control separation symbols, e.g. usage of 

separation symbol “-“ in various situations. 

      

We may create condition to not display separations symbol when the column “Part No” is empty. 

  

Logical operators: «&&» - "And"; «||» - "Or"; «!» - "Not". These operators allow to perform logical 

operations on the neighboring elements.  

For example, with logical operation «&&» you can output the separation symbol only when both 

“Description” and “Material” columns are not empty. 

 

Operators of string comparison. «StrEq», «StrNotEq» - A equal B, A is not equal B. This operators 

perform comparison of text values. The result is “True” or “False”.  

For example, you can set the condition: display value of “Quantity” if the field “Parameter 1” is equal to 

“Parameter 2”. 

 

If the condition is satisfied, the composite column contains data. If not - it will be empty. 

 

Operators of string comparison. «StrSubstr», «StrSubstr», «StrStartWith», «StrEndsWith» work in the 

same way. The only difference is that the selected column is compared to some text constant. 

Example: If the “Company Standard Parts” section is set for the record, the “Quantity” column data is 

displayed in the column. 
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Operators of numerical comparison. «==» - А is equal В; «!=» - А is not equal В; «>» - А is greater than 

В;  

«<» – А is less than В. The operators perform comparison of number values. The result is “True” or 

“False”. 

Round. Rounds decimal number the nearest integer. 

Floor. Largest integer that is not greater than the argument.  

Ceil. Smallest integer that is greater than or equel to the argument. 

Format. Converts real number to string. Allows to output values with the specified number of decimal 

places. 

Sources Tab 

Along with fragments you can use any objects of drawings or 3D models as items-records of the product 

structure. You can specify types of objects, included in the product structure, and set their selection 

conditions in Product structure properties window. The selected objects can be used as data sources. 

For example, all created pipe operations can be automatically included into the product structure. 

 

Source tab is used for this purpose. Here you can set sources and data, which must be set for various 

columns. 
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<Product structure from fragment> source exists in the product structure by default. It provides 

receiving data from files of fragments inserted into the current document. All data that is included in the 

product structure of fragment will be included in the product structure of assembly as well. 

To create a new data source use option . The Data source properties window will appear. (This 

window is called with option  for existing strings). 
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Name. Sets the data source name. 

Object type. The drop-down list contains available types of source object. 

Filters. Filters are used to set conditions for selecting objects of the specified type. Filter may consist of 

unlimited number of conditions combined with logical operations "And" and "Or", which will be used in 

combination. One of the two logical operations may be assigned when you add the second and other 

next condition to the list. 

Filters section options: 

 Add condition option creates a new condition in the properties list. Objects included in the product 

structure will be selected according to these rules.  

There are three columns: Parameter, Operation, and Value. 

  

 Parameter. The parameter can be set as:  

- measured characteristic of object;  

- value of variable (only for fragments);  

- attribute – internal object property, usually assigned by add-on applications;  

- object property. 
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Next to parameter type there is parameter name field. 

For Measure parameter you need to set the name of one of the object’s measured properties. 

Name of the property must coincide with the name in PM: Measure command. 

To specify Variable parameter, you need to enter name of variable that exists in the fragment 

document. 

 

Attribute name is set for Attribute parameter. The object attribute can be found using 

Information command in its context menu. 

 

For Property you to specify the property name from the Properties window. 

You can use only common properties of objects for filter. They are displayed in the Properties 

window when several objects of the same type are selected. 

 Operation. You need to select an operation from the drop-down list. It 

will be performed for the Parameter and Value values. 

Some notes on them: 

Contains no data, Contains any data are used for numeric parameters. 

Empty, Not empty are used for string parameters. 

To set additional conditions for adding objects to the product structure is 

possible to use the mechanism of Masks. Mask - is a specialized pattern 

that when used in filter is applied to the string values of objects parameters. 

It allows to include or vice versa do not include objects into the product 

structure depending on the string content. To set a mask it is necessary first 

to choose one of the Operation option Matches mask or Doesn’t match 

mask, and in the Value data field set the mask itself by a combination of 

symbols. 
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The following mask symbols are allowed: 

Symbol Description Example 

% Any string with zero or more 

symbols 

«А%» - returns all values that starts with А 

_ 

 

Any single symbol «А_» - returns all values that has two symbols 

length and starts with (А1, А2, Аа and so on) 

[ ] Any single symbol within the 

specified range ([a-f]) or set 

([abcdef]) 

«[12][0-9]» - returns all values from 10 to 29 

[^ ] Any single symbol not within the 

specified range ([a-f]) or set 

([abcdef
) 

«[^0-9]%» - returns all values that do not start 

with a number. 

You can manage order of logical operations in filters using brackets. 

 Value. In this field, you can enter value that will be compared with the selected parameter. 

 

 Delete condition. Option deletes the current condition from the list. 

 

 

To create a group of conditions you must select several filters in the list using <Shift> or <Ctrl> 

and press button  Group conditions. Grouped conditions will be considered as a single 

operand in the list. 

 

To cancel grouping, you need to select its header and press  Ungroup conditions. 

 

 Copy and  Paste options use the clipboard for conditions creation. 

 

 Up and  Down options allow to change order of the created conditions. 

 

 

Data Source Assignment  
You can set data that will be set to column data cells of product structure for each data source. 

Assignment of data sources to columns section is used for this purpose. 
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A full list of columns is available in the section. You can specify assignment condition for each of them. 

There are two strings available. You can use them to set the conditions. The data receiving method is 

specified in the upper string. It is similar to the Parameter field from sources filters.  

 

The data can be: 

- result of object measuring; 

- variable value; 

- attribute; 

- object property; 

- constant.  

You can specify the name in the second string. 

To specify Measure parameter you need to set the name of one of the object measured properties 

(name of the property must coincide with the name in PM: Measure command). 

To specify Variable parameter, you need to enter the name of variable that exists in the fragment 

document. 

Attribute name is set for Attribute parameter. Object attribute can be found using Information 

command of its context menu. 

To specify Property parameter, you need to set property name from the Properties dialog box of 

corresponding object. 
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Constant parameter defines a constant value that will be used for all records in the selected 

column. 

Filters Tab 

Filters specify data arranging conditions for representations. You can specify various filters that can be 

used in different representations. For example, from the whole set of product structure records you can 

select only records about materials to receive the corresponding report. 

You can read about representations in “Representations tab” section. 

 

 

When creating a new filter you can select one of two types: By Condition or 

By level of hierarchy. You can change filter name by pressing   on its 

name.  

- By level of hierarchy. This filter helps to define level in assembly hierarchy for which to gather 

product structure data.  

You can specify Comparison type and Level for this filter. The levels values begin from “0” (the 

product is on a zero level). For example, filter “<= 1” will gather data in the assembly file and 

the fragment files of the first level. 
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- By Condition. This type allows to specify conditions using content of product structure columns. 

Filter creation is similar to the previously described data source filter creation. The only difference is that 

the Parameter drop-down list contains columns of the product structure. 

You need to select a column and specify condition for the values selection. 

 

Representations Tab 

Representation is a set of rules (for example, grouping and sorting) for displaying Product structure data 

in various forms and further usage in generating report tables. One product structure may have several 

representations that correspond to different report tables. 

All the conditions specified on Representations tab work only in  Apply product structure 

representation mode. 



Product Structure, Reports, Bills of Materials 

909 

  

All existing representations are displayed in the corresponding field. 

 

Properties of each representation are managed on Grouping rules and Representation properties tabs. 

The Grouping rules are managed on Properties of grouping rule and Sort tabs. 

The following flags are located near representations names: Use for positions assignment , Consider 

records hierarchy while grouping , Use position column . 

Representation Properties 
You can specify common representation properties on Representation Properties tab. 
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Consider records hierarchy while grouping. If the flag is set, the grouping will be performed separately 

on each level of hierarchy. It allows to assign positions and receive reports for different “branches” of the 

product structure tree if necessary. The flag is not available when Use for variant reports flag is active. 

Important! It is required the topmost record of the product structure tree to be included into 

reports of the current document for correct data processing in this mode. 

 

For example, you want to create BOM table only for the “1.1” subassembly. For this purpose, you need to 

select it in the product structure and create report with Only selected elements and Only first level 

parameters. 

 

More information about reports creation can be found in “Reports Tab” section. 

Ignore option “Include in product structure”. If the flag is set the representation will show records with 

disabled Include in product structure option. 
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Filter. Specifies the filter  set on the Filters tab that will be used for the current representation. The drop-

down list contains filters from Filters tab. 

Synonym name. You can specify a synonym name for the representation. The synonym name may be 

helpful if you plan to output summation results in Summation results window or link them with variable. 

More information about the window can be found in “Summation result” section. 

Use for positions assignment. If the flag is set, positions for representation are assigned automatically. 

Otherwise, positions will not be assigned for this representation Note, that this flag will be used in 

combination with analogous flags for automatic position assignment set for each grouping rule if any 

exists. 

 

Use “Position” column. If the flag is set, the specified position is entered into “Position” column. If the 

flag is not set, the position is entered in the column specified in Column for position field.  

Positions will not be displayed in the product structure if the flag is not set and the column name is not 

specified. 

 

If flag Assign positions automatically is not set, this flag will be ignored.  

Use for variant reports. When the flag is set, the representation data is processed in a specific way to 

generate a variant report. Report type can be selected from the drop-down list of Type of variant report 

field. 

More information about variant reports can be found in “Variant report creation” chapter. 

 

Grouping Rules 
Rules for grouping records in the product structure window are specified on Grouping rules tab. 

You can set name for a grouping rule. For each grouping rule there is also possible a set of positioning 

options: create positions for group, positions increment, number of skipped positions at the beginning 

and number of skipped positions at the end of the group. 

 

Every grouping rule has its type. According to the grouping rule type, you may set additional options on 

Properties of grouping rule tab. 

 

The following types are available: 

By condition. You may specify one or several conditions for the rule.  Conditions are similar to the filters 

from the Filters tab. 
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By parameter. When you create this type of grouping rule, you can select column from the drop-down 

list. Records will be grouped according to the values in this column.  

  

Values from the column will be used as groups names if the flag Consider records hierarchy while 

grouping is not set. 

By BOM sections. Product structure records will be grouped by BOM sections. Each section is included 

into a separate group. BOM sections are defined in BG: Edit BOM sections command. 

By default. This type merges all records into one group. 

If there are several grouping rules in one representation, they are applied sequentially. Initially the 

first rule that distributes records to the groups is applied. Some of the records may be not 

included in any group after that. The second rule is used for these records. The following rule is 

used for the remaining “Free” records and so on. 

Sorting 
Sorting can be specified for each grouping rule (group) on the Sorting tab.  
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To create a new sorting rule at first you need to select a grouping rule. Then, you need to create a sorting 

rule using icon  add. You can select column name in the Column field from the drop-down list. The 

data will be sorted by this column. After that, you need to select limits of comparison region for the 

columns. 

From – defines the beginning of the comparison region. 

 

You can select one of the following values from the drop-down list: 

character № - the character serial number.  For example, three will mean that 

comparison region will begin from the third character of the selected column 

string. 

substring – the serial number of the selected character sequence occurrence, for 

example, from the first substring “Part” occurrence. 

character № from end – the character serial number from the end of the string, 

for example, the third char from the end. 

substring from end – the serial number of the selected character sequence 

occurrence from the end of the string, for example, the first appearance of “ISO” 

substring from the end. 

№ - the serial number of the string or substring. 

 

“ ” – the sequence of substring characters here. 
 

To – defines limits of comparison region. 
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character №  - the character serial number. 

substring - The serial number of the selected character sequence occurrence, for 

example, to the first appearance of the “-” substring. 

end of string –all characters to the end of string will be compared. 

Compare. The field specifies comparison type. 

 

Character –content of two data cells of the table will be compared as two character strings. 

Numeric – content of two data cells of the table will be compared as two numeric values. If 

string contains non-numeric characters they will be omitted on comparison. 

Mixed – The strings will divided into substrings that contain character and numeric values. After 

that, same-type substrings will be compared. 

 

If sorting rules for the group are not set, the records of the product structure will be placed in an 

arbitrary order. 

 

Important! The order of applying sorting rules depends on their order in the list. 

 

Position priorities 

- If both numbers and characters are located on the same position in the data cells, the priority 

goes to numbers; 

- If there are character sets “AA” and “AAA” on the same position, priority goes to the shortest 

record. 

 

Example of sorting creation 

Sorting will be set for the “Part No.” column for all records in the “Grouping rule_1” section. 
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Each data cell of “Part No.” column will be searched for the first “Part” substring from the beginning. 

Searching is performed to the end of string. Type of comparison is set to Mixed, i.e. all characters and 

numbers after the specified substring will be taken into account. 

The data was inserted into the table after specifying the sorting conditions. They are sorted by order of 

creation. 

  

After activation of  Apply product structure representation mode, the sorting rules were applied to 

the records of the “Part No.” column. 

  

The characters and numbers before Part substring were not taken into account. 

Initially the comparison was made by the first position after the Part substring.  

Numbers on the first position were selected from each cell (1). They were combined into substrings with 

nearby numbers (11, 12). After that, they were compared. 

Then all chars on the first position were selected (A, B). They were combined into substrings with nearby 

characters, if available (AA). They were compared. 
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Then symbols on the second position were compared and so on until the end of the string. 

Sum Tab 

You can specify rules for summation in the product structure columns on Sum tab. 

 

Summation rule will be displayed in Summation of product structure records list after creation. 

There is the following set of specified properties for each summation rule in Properties group: 

Name. Specifies name for the summation rule. 

 

Synonym name. You can specify synonym name in the field. The synonym name is displayed in 

Summation results window. The window is described above. 

 

Column. You need to select column from the drop-down list. Its data will be summed. 

 

If Sum values when merging parameter is specified for the selected column it will be taken into 

account. 

Filter. You can select a filter from the drop-down list. The filter is created on the Filters tab. The filter will 

be applied for the values summation. I.e. only records that satisfy conditions of the filter will be summed. 
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Display results in product structure window. When the flag is set, the summation result is displayed in 

the bottom part of Product structure window when  Apply product structure representation mode 

is on. 

 

 

Summation results 
You can assign value of summation result to a variable. You need to perform the following sequence of 

actions to do that: 

First, you need to select the Summation results item in the context menu of the product structure. 

 

Summation results window will appear.  

The product structure name is displayed in Product structure name field. 
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You need to activate Create variable flag and enter the variable Name. You can also enter a Comment to 

the variable. 

The expression for getting variable value is displayed in Expression field. 

You need to select necessary item from the list of summation rules. Each item name is a combination of 

representation and summation rule. 

Press [OK] button to create the variable. 

Summation results are created separately for each representation. 

Example: There are four representations in the product structure. Five records will appear in Name of 

summation rule field if you create one summation rule for the product structure. 

Four of them refer to representations. They calculate sum in the specified column for records included in 

the representation. 

The fifth record displays total amount in the column, but the representations are not taken into account. 

I.e. all the existing records data is summed. 

Selected Filter is used for each of the five records. 

The Summation rule name consists of two parts. The first part is the name/synonym name of the 

representation (Bill_of_Materials), the second – the name/synonym name of the summation rule (Weight). 

If synonym names are specified for representations or summation rules, they will be displayed in 

the field. Otherwise, the names will be displayed. 

Information about the selected summation rule is displayed in Value and Description fields when you 

select any record in Name of summation rule list. 
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Reports Tab 

Parameters of reports and appropriate template files can be set on Reports tab. The reports list is located 

on top of the window. Preview window is located to the right. You can change scale in the preview 

window using mouse wheel. You can hide the preview with  button. 

Buttons for creating, deleting and changing report properties are located on the right side. You can 

change reports order in the list using icons  . 

You can change properties of reports and their generators using Report properties and Generator 

properties tabs. 

 

 

Add New Report 

After pressing  Add button you can select one of the available generator types. The generator 

processes existing data according to certain rules and forms reports. 
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The selected generator name is shown in 

Generator comment field. 

 

After selecting generator, a new report will 

appear in the list. You can change default name 

by pressing   on its name string. 

 

 

Report Properties 
Report properties assigned for particular reports generator define values that will appear automatically in 

the corresponding data fields when a new report is created. This data can be then modified. 

You can specify the following properties for the report: 

   

Representation. Specifies representation which data and rules will be used in the report. If representation 

is not selected, the field contains value “By default” and the first representation will be used. 

Report contents specifies mode of data inclusion in the report. If All records of product structure item is 

set, all its data will be included into the report. If Only selected records item is set, only selected product 

structure “branch” data will be included. It allows creating reports for subassemblies embedded in the 

main assembly file. 

Hierarchy specifies levels of the product structure tree that will be included into the report. The “root” 

record of the tree is considered the zero level. There are several options:  

 

Template file. Specifies name of a report template file. Button  is used for the file selection.  

Template file creation is described in section “Report template”. 



Product Structure, Reports, Bills of Materials 

921 

Report file specifies name of the file in which report, if created in a separate document, will be stored. 

The report file will be saved in the same folder that contains the product structure file. 

Overwrite existing reports. If the flag is set, a new report created with the sane generator will replace the 

existing one. If the flag is not set, a new report will be created as a new table. 

Open report document after creation. The flag is taken into account when you create report in a 

separate document. If the flag is set, report file will be opened after creation. Otherwise, the current 

document will stay active. 

 

Location: 

- In new document. After selection, a new document will be created. Its name is specified on the 

Report tab. The system creates a new document with the specified name and opens a new 

window with the report. 

- On new page. A new drawing page with the report table is created in the current document. The 

table matches the selected template. 

- On existing page.  

 

Automatic snap flag activates mode of automatic snap of the report table to the two 

predefined nodes named “BOM1”, “BOM2” that define table position (upper left and bottom 

right points). 

Names can be assigned to nodes in EN: Edit node command. 
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The snap requires that both named nodes exist on the 

same page. Standard title blocks already contain these 

nodes by default. 

 

If the nodes are not found on the current page, system 

displays warning message and allows you to specify the 

table placement manually.  

You need to specify placement of the top left corner of 

the table. 

Name format for new pages. 

In general case name format for new pages looks like: “BOM name” {#o} Page {#p} 

For each page: 

{#o} – will be replaced by the sequence number of the BOM of the current type.  

{#p} – will be replaced by the sequence number of the BOM page. 

Generator Attributes 

Generator attributes is the list of options that additionally control the result of report generation. These 

attribute are linked with macro program that is contained in the report template file, and that you can 

manage. The set of attributes may differ for various generators. Examples of such attributes: 

 

- EmptyRows_CountBefore and EmptyRows_CountAfter – value sets number of empty strings 

before/after each record of the table. 

- EmptyRows_SkipFirst and EmptyRows_SkipLast – when“0” value is set, empty strings that were set 

by attribute EmptyRows_CountBefore/EmptyRows_CountAfter will be displayed for all records. When 

another value is set, the empty strings will not be created for the first/last record in the section. 

 

CREATE REPORT /  BOM 

You can create a report/BOM via command: 

Icon Ribbon 

 

Bill of materials → Bill of materials → New… 

Keyboard Textual Menu 

<BC> Tools > Report/Bill of materials > New… 

 

The command is used to create report or a BOM for the current assembly drawing. There are two 

tabs in the dialog box of this command: Report/BOM List and BOM by Template. The latter 

corresponds to the legacy mechanism and is not recommended for usage. 
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Report Creation 

You can create report or BOM table using template mechanism on Report/BOM List tab. 

 

1. Select product structure for the report; 

2. Select report generator from the list. 

3. Set report parameters.  

Parameters description can be found in “Product structure types” section. 

4. Confirm creation using [Create] button. 

You can also initiate new report creation with the toolbar in the Product structure window using option 

 Create report based on product structure or from the context menu of the selected record. In the 

second case, you can’t change the report properties before its creation. They are just copied from the 

product structure properties. 

 

BOM Creation 

You can also create a BOM using obsolete prototypes mechanism on the BOM by template tab. 
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1. Select location type: 

 In new document 

 On new page 

 On existing page 

Automatic snap flag is available only for On existing page type. 

2. Select product structure for the BOM; 

3. Select Prototype that will be used for BOM (The preview of the document will be shown in 

the preview window); 

4. Confirm creation using [Create] button. 

When you select the <new prototype> prototype, the BOM is created based on the 

“BOMStructure.mdb” database that contains only standard fields. I.e. you need to create all 

other parameters (column width, sorting rules, etc.) manually. It differs from the new prototype 

creation only in the fact that the specified parameters and properties of the BOM will be used only in 

the current document.  

If you want to use this prototype for any other BOMs, you need to save it in the 

“…\Program\Template\BOM” folder. 
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Variants of BOM location are described in “Product Structure Types” section. 

If there are BOMs created in previous versions of the BOM creator, the Convert old specification 

flag will appear. When it is set, the old BOM data will be converted according to the selected type. 

If parameter Include in product structure was enabled for fragments in assembly drawing file and any 

data was set for the fragment drawings, the created BOM will contain an appropriate records number. If 

the conditions were not met, the BOM will be empty. 

After the BOM creation, the editing mode is automatically activated (except for BOM on existing page). If 

BOM is empty, the following window appears: 

 

Using this window, you can manually enter a new record to any section. You can decline it by pressing 

[Cancel] button. 

It is recommended to set “Transparent” text editing parameter on Preferences tab in ST: Set 

document parameters command. It allows to enter edit mode after pressing on any record. 

VARIANT REPORT /  BOM  CRE ATION  

To create a variant report/BOM you need to perform the following sequence of actions: 

1.  You need to create variations in the assembly file using  option in FCE: Edit model 

configurations and variations command.  

More information about the command can be found in “Auxiliary Tools for 3D Assemblies 

Modeling” chapter. 

 

You need to choose  Name and "Variant BOM" Product Structure Type for the new 

variation in the following window: 
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After saving the variation, the same product structure will be automatically created in the 

document. 

Note that variations creation is not available until the current document is not saved. 

Optionally, you can specify subtitles of variations directly in the variations list. 

2. Select base variation of variant BOM by setting the flag in the list of variations. If base 

variant is not specified, it will be set to the first variation in the list. 

 

3.  Select the variation in the Product structure window. 

 

Its content can be edited if necessary. 

4. Activate Create report based on Product structure command. 

 

Report template corresponding to the selected variation will appear. 

5. You can select the report location on Generator properties tab. The report will be created 

after [Run] button pressing. 
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CREATION OF CALLOUTS ON T HE DRAWING  

You can create callouts using command: 

Icon Ribbon 

 

Bill of materials → Positions→ Callouts 

Keyboard Textual Menu 

<BL> Tools > Report/Bill of materials > Callouts 

 

There are three options in the automenu: 

 <W> Show product structure window 

 <A> Create All Callouts 

 <Esc> Exit command 

If  Show product structure window option is active, Product structure window will appear. 
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There are two ways to create callouts after calling the command: 

1. You need to select a record in the Product structure window. A callout cursor for the record will 

appear. Callout is a specific type of leader note element. The corresponding fragment will be 

highlighted in 2D and in 3D windows. Then you need to specify fixing points of the callout in one 

of the existing windows. 

Position number will be assigned to Text field of inscription/callout Properties window 

automatically in “{{Position}}” format. 

More information about leader notes creation can be found in “Leader Notes” chapter. 

The “By default” parameters for leader notes, callouts of the product structure and bend notes are 

stored in the system separately. 
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2. You need to select an object on the drawing. A callout for the record, which corresponds to the 

object, will appear. You need to specify its location on the drawing. The Product structure 

window is not necessary in this case. 

 

Create BOM callout command provides links between records of product structures and callouts. If there 

were any changes which lead to the position number change, callouts will update. 

 

You can update positions using the following commands: 

 BRP: Update callouts. This option is used when you change sorting or perform any other action that 

means positions change in the product structure. The callouts will be updated according to the current 

values after the option activation. 

 

 BRA: Update all. This option updates product structures and callouts. It is used when content of 

product structure changes, e.g. when new fragments are included into assembly.  

 

Automatic Callouts Creation 

Create All Callouts  command is used for multiple callouts creation.  

 

The following options are available in the automenu of the command: 

 <G> Group Alignment of Callouts 

 <N> Callout without Leader 

 <*> Select All Elements 

 <C> Cancel Elements Selection 

 

The Group Alignment of Callouts  option allows to align all callouts after their creation. 

If the option Callout without Leader  is enabled, the callouts will be created without leaders. 

Numbers of positions will be snapped to the center of objects that linked with the record in the product 

structure. 
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You can select all records in the product structure and create callouts for them using the option Select 

All Elements .  

If there are several projections (2D views) created for a product structure item, callouts are created 

for each of them. 

Use the Cancel Elements Selection  to cancel selection of all records. 

After all options are specified, you should press . 

Callouts without leaders are created immediately. 

If the option Group Alignment of Callouts  is activated, the callouts will automatically follow the 

cursor. The following options will appear in automenu: 

 

 <Tab> Horizontal 

 <Tab> Vertical 

 <Z> Change leader line jog orientation 

 <D> Change placement of additional jogs 

 

Options  and  allow to change direction of the created callouts row – horizontal or vertical. 

 

The  option changes jog orientation for all created callouts.  
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When the callouts are assigned automatically, placement of leader note arrows is defined as the 

middle of the bounding rectangular for each 2D fragment or the middle of the selected 

projections lines of 3D fragments. 

You need to press  to finally set the callouts location. 

 

The callouts use standard parameters of leader notes except for arrow ending type (the point is used) 

and priority (127 is used). If there are several positions corresponding to one fragment, the callout with 

several jogs is used.  

 

You can change additional jogs placement using  option. Created callouts can be edited. 

Arbitrary data cell of product structure selection 

 

You can output content of an arbitrary product structure cell to the callout. Use the Specify column for 

linking with callout option for this purpose. 

  

System waits until you select the product structure column after the option activation. The selected 

column will be highlighted and Use specified column for linking with callout  mode will be 

activated. 

The next step is to select string of the product structure. Its content will be set to the callout string.  
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The selected column is stored. You can disable option  (the column will not be highlighted) and 

continue callouts creation in an ordinary way. You can enable link with the selected column again, if 

necessary. The next callout will be linked with the selected cell of the column. 

 

Additional Jogs 

Use option  to create several jogs. After the option activation, you need to select all records of the 

product structure that should be added to the callout. 

 

You can use existing callouts to show additional positions on the drawing. Therefore, several records may 

be associated with one callout. For this purpose, point the callout using the mouse cursor, press  and 

select Edit item from the appeared automenu.  

You need to select the record of the product structure and create a new jog using  button on the 

Multiple jogs tab in the Properties window. 
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Use  and  buttons to change the order of jogs. To delete jogs use  button.  

To change position on the existing jog, select it and specify any other record in the Product structure 

window. 

Multiple jogs list contains the main leader note jog. Do not delete it. 

The symbols “{{ }}” means that the callout is linked to the product structure and is updated in accordance 

with it. If you remove these symbols, then the link will be broken. 

 

Transparent Call of Create BOM Callout Command 

Create BOM callout command is available in the context menu of the selected record. 

 

 

The command also activates automatically when you drag a record into the scene using Drag’n’Drop 

mechanism. For this purpose select a record in the product structure, move it and release in the 2D or 3D 

window. The command of callout creation will be activated. 

 

INCLUDE IN PROD UCT ST RUCTURE  

The command: 

Icon Ribbon 

 

Bill of materials → Product structure → Included fragments 

Keyboard Textual Menu 

<BI> Tools > Report/Bill of materials > Included fragments 

Is used for managing inclusion of document fragments in a product structure.  

After activation of the command the window that contains lists of fragments and product structures 

appears. 
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The product structure parameter specifies the name of product structure for which the specified 

fragments inclusion modes will be used: don’t include, without embedded elements, with embedded 

elements, embedded elements only. 

When you select <New Product Structures> from the drop-down list, the specified inclusion parameters 

will be used for new product structures. 

 

When you select fragment its inclusion mode is specified in the lower part of the window. 

Using Assign product structure name parameter you can select a product structure from the fragment 

file, which data will be included in an assembly product structure. 

 

Multiselect. . You can select several elements from the fragments list using tapped button <Shift>. 

Tapped <Ctrl> button allows you to add/remove fragments from the selected list. 

 

Button  Select all allows to select all fragments. Button  Deselect all allows to deselect all 

fragments. When you select fragments, each of them is highlighted in 2D and 3D windows. If there are 

more than one fragment in the list, selected parameters are applied to all of them. 
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EDITING BOM  SE CTIONS  

BOM sections are stored in a special database. The system installation includes the database with the 

standard set of BOM sections (…\Program\ BOM Groups.mdb). The standard set of sections can be 

changed by the command BG: Edit BOM Sections: 

Icon Ribbon 

 Bill of materials → Options → Sections… 

Keyboard Textual Menu 

<BG> Tools > Report/Bill of materials > Sections… 

 

Upon calling the command, the Sections dialog 

box appears. 

The data box in the upper portion of the dialog 

box displays the path to the currently used 

database. The current database can be set in the 

command SO: Set system options on the tab Bill 

of Materials. 

The BOM sections are displayed as a tree, with 

each group being assigned its unique Id number 

(Code). To add a new group, select the parent 

group to add the desired one as a subgroup, and 

press the graphic button [Add…]. As a result, the 

Add Group dialog box will appear. 

It allows defining the name for the group being 

created, and its ID number. The ID provides the 

relation between the group database and the 

BOM data. The default IDs are assigned 

subsequently, beginning with 10000.  

 

 

You can manually assign an ID number. If the number you try 

to assign is already reserved, the system will prompt you 

about this. Upon the confirmation, the newly created move 

will be entered in the active database and will be displayed in 

the tree of sections, thus being incorporated in the BOM 

definition. To delete a group, select it in the list and press the 

graphic button [Delete]. 
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Deleting listed sections is not recommended, since the relations may be lost between the sections 

and the earlier created BOMs. 

To reorder the sections in a BOM, use the BOM properties dialog box and its tab Sections. To save the 

database under a different name, use the button [Save As…]. 

REPORT /  BOM  TEMPL ATE  

The report/BOM template is a specially prepared GRB file that contains data and options for generating 

reports. The report format and data composition are described in this file according to certain rules.  

This file contains table created using command TE: Text and various structured data in its cells. System 

installation has various predefined report templates. Path to the report templates folder is specified on 

the Bill of Materials tab in SO: Set system options command. 

Report template structure 

The report structure is similar to the XML language. The structure represents tree of elements. One or 

two tags specify an element. The element has embedded attributes and contents.  

Allowed elements names (without register): 

1.group is used only for table framing. 

2.container is used for variant reports (more information can be found in a report generator description). 

3.list – The list of elements. It is used for table framing. 

4.param – The parameter is used only in the table. Content is ignored. An element is replaced by the 

value from the product structure column. Should not be embedded into each other.  

5.group_macro – The macro for group processing. Should be used as embedded element for element 

group. 

6.summary – The result. Used only for table framing. 

7.outcome – The resulting value. Used in summary element. 

8.frag – insertion into the fragment cell. 

9.sum_res - The result of the summation described on the “Sum” tab in the product structure properties. 

Used only in the summary table. 

10.variable – The value of the variable. The variable should exist in the file on the basis of which the 

report is created. 

11.table_hider – The element to hide the table. Used with the filter. 

Only group and list can be the top-level elements. 

Allowed attributes values: 

1) name is used only for param element.  

2) filter is used in all elements.  
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3) recursive is used only for group and list elements. If there is hierarchy in the input data, it will influence 

the result of product structure records sampling.  

4) recursive_template The attribute shows that the element is a template for all groups. 

5) str_process is used in param and outcome elements for post-processing or text value retrieving from 

the record. This attribute is used if insignificant processing of text value is necessary. For example, to 

specify the formatting and adjust the number of decimal places. 

6) str_proc_macro is used in param and outcome elements for post-processing or a text value received 

from the record. This attribute uses the specified macro for text processing. 

7) hide_table is used in table framing elements. Specifies the rule according to which the table doesn’t 

displayed. 

8) source is used with frag element. 

9) sorce_macro is used with frag element. 

10) from_item is used with frag element. 

11) regenerate 3d is used with frag. 

12) index is used with table_hider. 

The elements have two forms of recording: 

1) {list}element content{/list} - 2 tags and the content. 

2) {param name=”Description ”/} – 1 tag and no content. 

When the report is generated the group and list elements copy the content (table) for each 

group/ product structure record to the report  

Element group  
Param elements are filled in the table of group element as follows: you take the first record from the 

group and its values are substituted.  

All embedded list elements will operate merged data (those data that will be shown in Product structure 

window in  Apply product structure representation mode). 

Element list  
If list element is not embedded into group element, it is operating all records of the product structure (as 

they look like in Product structure window in  Apply product structure representation mode).  

If the input data has the hierarchy: 

 By default, recursive attribute is disabled, i.e. only the structure records of the top level will 

be displayed. 

 If you set recursive as true, all records will be displayed. 

It is allowed to create an embedded list element in the existing list element. In this case, the table from 

the embedded list element will be created and filled in for each product structure record with child 

records. 
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Element param  
Element param is replaced with the corresponding value of the product structure record cell. 

Full element record: {param name=”Description”/}. A full element record should be used if the column 

name contains spaces. 

The element has a simplified record:  

1){param Description/} – the name is an attribute by default, thus its specifying is not necessary; 

2){Description/} – a param is an element by default, , thus its specifying is not necessary. 

For example,  record {Part No./}  is not recognized as correct. For names of two or more words, you need 

to use a full record. 

Names Pos, Position are allowed to display positions. 

Element summary  
The element frames the table. It can be used as a top-level element. The table is just copied to report in 

this case. 

When you use the element in group and list elements, information obtained by processing group/list 

records can be output into the table. The information is output using outcome element. 

Optional element before=”true” outputs table before group/list records. 

 

 

Example of top-level summary element: 

{summary} 

Header  EmptyGlobalHeader   

{/summary} 

 

Example with embedded group and list elements: 

{summary} 

Header  EmptyGlobalHeader   

{/summary} 

{group} 

  {Section str_process="str = .SpecGroup(str)"/}   

{list recursive="true"} 

{summary before="true"} 

EachGroupHeader: At all: {outcome name="Quantity" out_operation="numeric_sum" 
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argument="F4"/} 

{/summary} 

{summary} 

EachGroupFooter: At all: {outcome name="Quantity" out_operation="numeric_sum" 

argument="F4"/} 

{/summary} 

       {/list} 

       {summary before="true"} 

AllGroupsHeader: At all: {outcome name=" Quantity " out_operation="numeric_sum"/} 

       {/summary} 

       {summary} 

AllGroupsFooter: At all: {outcome name=" Quantity " out_operation="numeric_sum"/} 

      {/summary} 

       {summary} 

AllGroupsFooter: All names: {outcome name="Description" out_operation="str_concat" argument="-;"/} 

      {/summary} 

      {summary} 

AllGroupsFooter: Unique names: {outcome name="Description" out_operation="unique_strs" 

argument=";"/} 

      {/summary} 

{/group} 

{summary} 

Header  EmptyGlobalFooter   

{/summary} 

Element outcome  
The element is used to output resulting information inside framed table {summary}. 

Main attributes: 

1.name – a name of parameter which is used to gather resulting information.  

2.out_operation – values processing type: 

 numeric_sum – numerical sum of all values; 



T-FLEX CAD Brief Introductory Course 

940 

 str_concat – strings sum; 

 unique_strs – list of unique values. 

3.argument – additional string parameter conveyed to out_operation. 

 numeric_sum – string output format; 

 str_concat – delimiter between summed strings for values enumeration; 

 unique_strs – delimiter between summed strings for unique values enumeration. 

You can also specify attribute for sorting records that will be used in calculation using source_filter 

attribute (works similar to filter parameter). You can use str_process for the string post-processing. 

Examples: 

{outcome name="Description " out_operation="unique_strs" argument=";"/} 

At all: {outcome name="Quantity" out_operation="numeric_sum" argument="F4"/} 

Element sum_res 
The sum_res element is used for summation result output. The summation is set on the “Sum” tab in the 

product structure properties. 

Main attributes: 

name – a summation name. The name can be found in the product structure window. To do so call 

Product structure > Summation results from the context menu. 

The name can be omitted. Then it will be selected automatically (Representation name + Name of the 

first summation). 

You can use filter attribute. 

You can use str_process for string postprocessing. 

Examples: 

{sum_res/} 

{sum_res name="Mass"/} 

Total: {sum_res Mass/}  

Element variable 
The variable element is used to output document variables into report. It can be displayed in the 

summary header table or in group and list tables.  

Main attributes: 

name – a variable name. 

If there is no variable in the document, an empty string will be outputted. 

You can use filter attribute.  

You can use str_process for a string postprocessing. 

Examples: 

{variable name=”nCount”/}  

{variable name=”$Number”/} 
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Formatted output of valid values (1 decimal place): 

{variable name="nCount" str_process="str = str.AsDouble().Format(1)"/} 

Element group_macro  
The Group_macro element is a group processing macro. This element should be used as an embedded 

element of group element. Can use attribute filter – the macro will be applied only for the groups, 

which satisfy the condition. 

Name of the element must be specified. The name specifies macro that should be started before the 

table filling. The macro prototype: void func(MacroCallContext context, GroupItemInfo group); 

The first parameter contains context for the macro call. 

Example: 

{group} 

       {group_macro name="Gen.Gen.GroupMacro" filter="Section = Company standard parts"/} 

… 

{/group} 

 

The macro example: 

using System; 

using System.Linq; 

using TFlex.Model; 

using System.Collections.Generic; 

using TFlex.Model.Model2D; 

  

using TFlex.CadReportGenerator; 

  

namespace Gen 

{ 

    public class Gen 

   { 

        public static bool GroupMacro(MacroCallContext context, GroupItemInfo group) 

       { 

              var generAttrs = context.Properties.Attributes;// The report attributes check. 

                if(!generAttrs.HasAttribute(“attrName”)  

                        || generAttrs[“attrName”].ValueAsBool == false) 

                        return true; 

                //%%TODO: fill in 

                return true; 

       } 

    } 

} 

You need to add link to TFPSCadReportGenerator for the macro compilation. 
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Element frag  
The element is used only in tables, one element per cell. Fragment is inserted instead of it.  

One of the four ways can specify the path to the fragment: 

1. The filename is taken from the product structure column: {frag name=”Remarks”/}; 

2. The filename is specified explicitly: {frag source=”<3D Assemblies>Cam.grb”/}; 

3. The name matches the current element name (the fragment from which the data was raised will be 

inserted): {frag from_item=”true”/}; 

4. The name is received from the macro (look through source_macro):  

{frag source_macro=”Gen.Gen3.SourceMacro”/}. 

You can specify page name in the fragment document, its image will be inserted into the cell: 

{Frag Source="<Fitting_v2>Sketch.grb" page="sketch_p"/} 

You can also use filter attribute (filter=”…”) similar to param and outcome elements. 

The auto_width attribute allows you to automatically select the width of the fragment so that it fits into 

the cell. 

Element table hider 
You can add several tables between tags that specify an element. Element table hider allows to specify 

logic for hiding tables.  

Main attributes: 

Index – an index of the table, which is embedded into the parents tag (indexing from 0).  

filter – a filter for hiding tables. 

Attributes 

In the general case the attributes are recorded like attrName=”attrValue” in the tag that opens element. 

Attribute filter  
Example of a filter record: 

{group filter="section = 'Company standard parts'"} 

First lexical unit – product structure column name 

Second lexical unit – operator 

Third lexical unit – value 

The filter operator (in this example - ‘=’) is recorded with the space in opposite to the attributes 

that have no space. A string value is recorded in single quotes. 

You can specify logical relation between expressions: AND / OR. 

{group filter="Section = ‘Company standard parts' OR Section = ‘Unknown’"} 

 

You can use parentheses in the filter ( ).  
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{group filter="(Section = ‘A' AND Quantity = 1) OR (Section = ‘B' AND Quantity = 2)"} 

Special symbols in the column name processing 

If the column name contains spaces or symbols, you need to change them  

 ampersand "&" replace with "&amp;"  

 less "<" replace with "&lt;" 

 more ">" replace with "&gt;" 

 quotes """ replace with "&quot;"  

 apostrophe "'" replace with "&apos;"  

 space " " replace with a "&#032;"  

For example: 

{param name="Total Quantity" filter="Total&#032;Quantity != 0"/} 

When the condition formed &#032 is replaced by the space. 

Attribute hide_table 
The attribute is similar to the attribute filter. It specifies the condition for the current element. According 

to the condition, the table will not be displayed. It can be used for the elements that are framing the 

table. 

Example: 

{group hide_table="Section = 'No' OR Section = '' "} 

… 

{/group} 

For the groups without the section or it is “No” the heading table will not be created.  

List of valid operators: 

 =  

 != 

 > 

 >= 

 < 

 <=  

 IsOneOf – included in the list 

 IsNotOneOf – not included in the 

list 

 IsNull  - does not contain data 

 IsNotNull – contains any data 

 

 ContainsSubstring - contains 

 NotContainSubstring – does not contain 

 StartsWithSubstring – starts with 

 EndsWithSubstring – ends on 

 IsEmptyString - does not contain text 

 IsNotEmptyString – contain text 

 MatchMask – merges mask 

 NotMatchMask – does not merge mask 
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Attribute str_process 
The attribute is used in param and out_come elements for the post-processing of text value that is 

received from the element. 

Example: The value of the attribute is recorded using C#. The resulting variable is “str”. 

str_process="str = str.Replace('R', 'V')" 

There are pre-determined methods allowed in “P” class: 

 P.SpecGroup – processes full BOM section name and lefts only subsection name after 

last ‘\’. 

str_process="str = P.SpecGroup(str)". 

 P.AsDouble – converts string to real number: 

str = (str.AsDouble() * 1.2).ToString() 

 P.AsInt – converts string to integer number:  

str = (str.AsInt() * 2).ToString() 

 P.Format – converts number to string with formatting (by default there are two 

characters decimal places): 

str = (str.AsDouble() * 1.2).Format(1) -one character decimal places. 

str = (str.AsDouble() * 1.2).Format() - two characters decimal places. 

Example of composite processing: 

{Section str_process="str = P.SpecGroup(str).Replace('R', 'V').ToLowerInvariant()"/} 

 

 

Attribute str_proc_macro 
The attribute is used in param and outcome elements for the post-processing of a textual value, 

retrieved from product structure record. The attribute value should specify the post-processing macro 

name. 

The attribute example: 

{param name="Title_1" str_proc_macro="Gen.Str.ConstVarReplacer"/} 

 

The macro example: 

using System; 

using TFlex.Model; 

using TFlex.Model.Model2D; 

using TFlex.Model.Model3D; 

 

using TFlex.CadReportGenerator; 

 

namespace Gen 

{ 

 public class Str 

 { 
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         public static string ConstVarReplacer(MacroCallContext context, String originalValue) 

         { 

                 if(String.IsNullOrWhiteSpace(originalValue)) 

                         return originalValue; 

                 else if(originalValue == "ConstPart") 

                         return "Variations constant data:"; 

                 else if(originalValue == "VarPart") 

                         return " Variations variable data:"; 

                 else 

                         return originalValue; 

         } 

 } 

} 

 

Attribute from_item 
The Boolean attribute used with frag element. It means that the path to the fragment is formed from 

the current element (a fragment from which the data was raised will be inserted). 

Example: 

{frag from_item="true"/} 

 

Attribute source 
Used with frag element. Specifies a path to the fragment file that should be inserted:  

Example: 

{Frag Source="<Fitting_v2>Sketch.grb"/} 

 

Attribute source_macro 
Used with frag element. Specifies a path to a fragment file that should be inserted using macro:  

Example: 

{frag source_macro="Gen.Gen3.FragSourceMacro"/} 

  

Macro example: 

using System; 

using System.Linq; 

using TFlex.Model; 

using System.Collections.Generic; 

using TFlex.Model.Model2D; 

  

using TFlex.CadReportGenerator; 
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namespace Gen 

{ 

 public class Gen3 

 { 

         public static string FragSourceMacro(MacroCallContext context, ItemInfo item) 

         { 

                 string val = item["Annotation"]; 

                 return String.IsNullOrWhiteSpace(val) ? "<Fitting_v2>Sketch.grb" : val; 

         } 

 } 

} 

Attribute page 
Used with frag element. Specifies name of inserted fragment page: 

Example: 

{Frag Source="<Fitting_v2>Sketch.grb" page=”Page_2”/} 

 

Attribute regenerate 3d 
Used with frag element. Activates flag of the inserted 2D fragment. 

 

Example: 

{Frag Source="<Fitting_v2>Sketch.grb" page=”Page_2” regenerate_3d=”true”/} 

Attribute recursive_template 
The attribute is used in group elements. 

The attribute is important for representations, which consider hierarchy when grouping. 

Example: 
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recursive_template=”true” 

Template example 

 

Variant Report/BOM Generator (TFPSCadVersionReportGenerator) 

The generator is a specialized version of standard (TFPSCadVersionReportGenerator) generator 

described above. It is used to generate reports for variant product structures. 

The main differences are: 

 Container element is used instead of group element; 

 Param element has special syntax. 
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EXAMPLE OF REPORT TEMPL ATE CRE ATION  

Report template is a GRB file, which describes report format and data in file according to the certain 

rules. You need to create a table in the report template file using TE: Create Text format. Structure of the 

report is described in its cells. 

Creation of report template: 

1. Create a new document based on “ISO Drawing” template and save it into the folder with templates. 

Path to report templates is set in SO: Set System Options command on the Folders tab.  

2. Set A4 format and portrait orientation on the Paper tab in the ST: Set Document Parameters 

command. 

3. If the template will be used for creation of reports on a separate page or in another document, 

insert the 2D fragment of a title block, which contains a table header and lines. 

If the template will be used for creation of reports on the current page, you can skip this step. 

4. Create a paragraph text using command TE: Create Text. Attach it to the nodes of the title block 

fragment or in absolute coordinates. 
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Press  after selection of attaching points. After that, you need to specify coordinates for new text 

rectangles using Change paragraph size parameters  option from automenu. Records, which don’t fit 

on the first page, will be moved to new rectangles. 

 

If the template is for the current page, select “Create rectangle on current page”. Note that its position 

should not coincide with the coordinates of the existing rectangle. 

 

 

If the template is for a new page select “Create New Page with Rectangle”. Its coordinates should 

coincide with the nodes on the following BOM or report pages. 

You should set rectangle coordinates manually in the Rectangle Coordinates section. 

Press [OK] button. 

 

5. Add a table header into the created paragraph text. 

If the template is for a separate page, you can skip this step. 

Header should be between {summary} and {/summary} tags. You should create a table with column 

names there. The table is filled in manually. 
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6. Add tags {group} and {/group} for group of records output. 

 

7. Create a table for a group header. Name of the BOM section is a header of the group in standard 

BOM. 

Note! Total width of all tables should match with the first table. 

 

Add {Section/} tag to a column. It will display name of the section, which is used for grouping records in 

the report. 

 

8. If a group header has no text (for example, if it is a group of records without section), the table will 

be empty and should not be displayed in the report. You need to add a condition. First, you need to 

find name of the corresponding group in the product structure. Its name is “No group”. 
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You need to add the filter {group hide_table="Group_name = 'No group'"} which will replace the opening 

tag of the group. 

 

9. Add table for new BOM records. Add {list} and {/list} tags. 
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10. In the third table, you should specify names of product structure columns. Data from the columns 

will be added to the report. 

If there are no spaces in the column name, you should type {column_name/}. You can use a synonym 

name instead of the name of the column. 

 

If there is a space in the column name, use the following record: 

{param name="Column name"/} 

Example of filling of the third table cells, which do not have additional filters: 
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You can manage value output using filter. For example, the following filter allows you to display only the 

non-null field values in the column: 

{Quantity filter="Quantity != 0"/} 

 

Creation of the simplest report template is finished. Finish paragraph text edition using  and save your 

document. 

Note! Text of report template should fit paragraph text rectangle. It should not go beyond it by 

height or width. 
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Report template should be used for a report generator.  

Report generator properties are described in “Reports” section of “Product structure types” 

chapter. 

If a new report generator is created for a product structure type, not for a product structure in the 

document, it can be used in all documents where the product structure type is used. 

 

It will be necessary to update product structure properties for the existing documents according 

to the properties of the updated product structure type. 

Additional Features 

 Add a summation result to the report. 

For example, if you need to display total weight use {outcome name="Weight" 

out_operation="numeric_sum"/} record in a separate table between {summary} and {/summary} tags. 

 

 Formatting of the value in the column may be performed using argument parameter. 

For example, the following record will display the summation result with accuracy of two decimal places:  
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{outcome name="Weight" out_operation="numeric_sum" argument="F2"/} 

 You can display variable value in a report using variable name element.  

For example, {variable name="$Date"/}. 

The variable should exist in the file based on which the report is created. 

 You can display records of all levels for the representation using recursive attribute. 

{list recursive="true"} 

You can find description of elements and attributes for report template in “Report/BOM template” 

section. 

 You can add macros. Additional data processing can be performed using a macro, which may be 

added to the report template file. You can add and edit a macro in the Macro editor. 

 

A macro can process product structure records or data, which is displayed in a table cell. 

In the first case a macro is called using {group_macro name="Name "/}. Name is a name of the macro, 

which should be run before the table is filled in.  

You can use filter attribute, when you call a macro. The macro will be applied only for groups that 

correspond the condition.  

Example: {group_macro name="Gen.Gen.GroupMacro" filter="Section = 'Industry Standard Parts '"/} 

The macro for processing of textual value in the table cell is used in param and outcome elements. The 

macro is called using {param name="Column name" str_proc_macro="Name"/}. Name is a name of the 

macro for string processing. 

Example: {param name="Quantity$$00" str_proc_macro="Gen.Gen.XAmount"/} 
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WORKING WIT H BOM  ON PROTOT YPES  
 

Mechanism of BOM creation used in the earlier program versions will be described below. Unlike BOM 

on templates mechanism, BOM on prototypes mechanism is left inside the program for compatibility 

reasons only and is not recommended for usage for the new projects due to its limitations.  

This mechanism also provides tools for automating bill of materials (BOM) composition in the formats 

recommended by various standards and in customized user-defined formats. 

To work with this mechanism you need to use the set of commands from Tools > Reports / BOMs text 

menu or options from BOM main toolbar. 

You can use standard BOM prototypes or custom prototypes when creating BOM. 

The prototype is a BOM with empty records. It defines table contents and the rules for its formatting. The 

prototype also defines text type for the BOM. The text can be of two types: 

- Multiline text (text is not translated to another line cause of growing strings number); 

- Paragraph text ( text can be translated to a new page or a new area on the existing page cause of 

growing strings number) 

User defines columns number and their data in BOM properties. You need to select standard fields for 

the BOM table from the list and to create additional BOM table fields. Information for the table is taken 

from fragment files or is inserted manually. 

For automatic filling of the BOM table, it is necessary that: 

 BOM data is defined in the Product structure window of the fragment documents 

(otherwise the string of the table that corresponds the fragment without data will be 

empty); 

 The parameter Include in product structure in the fragment properties is set to one of 

the options: 

- Without Embedded Elements – the fragment data is included into the product 

structure. The elements that are embedded in the fragment drawing are not 

included; 

- With Embedded Elements - the fragment data and the embedded elements data 

are included into the product structure; 

- Embedded Elements Only – only embedded elements are included into the 

product structure. 

Each assembly fragment corresponds to the table record when you create a BOM. Additional strings are 

added manually when the table is edited. For manual editing you need to unselect  automatic field 

option for a cell/column/string in which you need to enter a new data. 

Text formatting parameters, strings height and columns width are specified in the table properties.  

The table header is a fragment, which contains text with the header table. That is why you need to make 

corresponding changes in the headers table if table columns content or columns width were changed. 
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BOM sections structure is stored in the database file. The name and the path to the file can be specified 

in SO: Set System Options on the tab Bill of Materials (“BOM groups.mdb” file is specified by default). 

 

One can view the list of existing BOMs in a document by using the command BM: Reports/Bills of 

Materials: 

Icon Ribbon 

 Bill of materials → Bill of materials → List 

Keyboard Textual Menu 

<BM> Tools > Report/Bill of materials > Reports/Boms List 

 

Upon calling this, the dialog box appears on the screen with the list of all reports and BOMs existing in 

the document. This dialog box allows creating a new BOM, deleting an existing one (by selecting from 

the list) or viewing its properties. 

It also allows renaming a BOM file if it was created as a separate document. If such BOM was selected, 

the graphic button [Save As…] becomes enabled, allowing the name and folder change. 

 

 

 

Note! It is required the separate document file and the current document file to be saved. 

To create a new BOM, use the command BC: Create Bill of Materials. The command can be called by one 

of the following means: 

Icon Ribbon 

 

Bill of materials → Bill of materials → New… 

Keyboard Textual Menu 

<BC> Tools > Report/Bill of materials > New… 
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Upon calling the command, the dialog box “Create report/Bill of Materials” will come up on the screen. 

Use this dialog to create the BOM table either in a new document or as a new page in the current 

document. This command also allows creating a new prototype based on an existing one. 

The delete BOM from the current document, use the command BX: Delete Bill of Materials: 

Icon Ribbon 

 

Bill of materials → Edit → Delete 

Keyboard Textual Menu 

<BX> Tools > Report/Bill of materials > Delete 

Should multiple BOMs exist in the current document, a dialog box comes up for selecting the BOM to be 

deleted. 

Another command is BI: Include in Bill of Materials: 

Icon Ribbon 

 

Bill of materials → Product structure → Included fragments 

Keyboard Textual Menu 

<BI> Tools > Report/Bill of materials > Included fragments 

The command is intended for maintaining a binding between BOM and respective fragments. Call to this 

command results with the dialog box that comes up on the screen and contains the list of all existing 

fragments in the document. The controls provided by this dialog let you set or modify the method of 

inserting any fragment into the BOM. 

The BOM table and callouts can be updated following the assembly modifications by the command BRA: 

Update Bills of Materials and Callouts: 

Icon Ribbon 

 Bill of materials → Edit → Update All 

Keyboard Textual Menu 

<BRA> Tools > Report/Bill of materials > Update All 
 

Keyboard Textual Menu Icon 

<BRA> 
Tools > Report/Bill of Materials >  

Update All  

Should the callouts position numbers change in BOM (as, for instance, a result of changing the rules of 

sorting records), the command BRP: Update BOM Callouts lets updating the callouts in the assembly: 

Keyboard Textual Menu Icon 

<BRP> 
Tools > Report/Bill of Materials > 

Update Callouts  
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To set callouts in assembly, use the command BL: Create BOM Callout: 

Keyboard Textual Menu Icon 

<BL> 
Tools > Report/Bill of Materials > 

Callouts  

For editing an existing BOM, use the command BE: Edit Bill of Materials:  

Keyboard Textual Menu Icon 

<BE> 
Tools > Report/Bill of Materials > 

Edit  

The command allows modifying the contents and parameters of the BOM table (see the section “Editing 

BOMs”). If several BOMs exist, the dialog for BOM selection appears first. 

Next is the command BT: Toggle: Assembly/BOM Pages: 

Keyboard Textual Menu Icon 

<BT> 
Tools > Report/Bill of Materials > 

View Assembly/BOM  

The command allows switching between the assembly and the BOM, if the BOM is located on another 

page or in a separate document. If several BOMs exist, the dialog appears first for selecting the BOM to 

switch to. 

The command BG: Edit BOM Sections: 

Keyboard Textual Menu Icon 

<BG> 
Tool > Report/ > Bill of Materials > 

Sections…  

This command allows modifying a database file containing information about BOM sections (the default 

file is "BOM Group.mdb"). The name and the path to the database sections can be defined/modified by 

the command SO: Set System Options > Bill of Materials (see the section “Editing BOM sections”). 

Command BS: Export BOM: 

Keyboard Textual Menu Icon 

<BS> 
Tools > Report/Bill of Materials > 

Export…  

This command allows you to export the BOM data or the BOM itself to the Excel file (xls). The export is 

carried out by a special macro located in the folder “…/Program/BOMExport”. 

BOM  COMPOSITION  

Any BOM is composed of the following elements: 

 BOM prototype table is a textual table with a certain number and type of columns. The 

table properties define formatting of the BOM columns. The table is created based on the 
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“Text” element type (“Paragraph text” or “Multiline text”). The text parameters define the 

behavior of the BOM as it is being filled with information: the direction of the BOM 

“growth”, the capability of continuation on the new page. Thus, for instance, a prototype 

based on a “Multiline text” template element does not support multipage BOMs. 

 A fragment with the title block image or just the BOM header (depending on the BOM 

type). 

 

Interaction between BOM prototype table, title block and BOM table header depend on the type of the 

BOM. If the BOM is located on the drawing page, then the table fragment is used that describes the 

image of the table header with the column titles only. Such fragment is described in the BOM properties 

as the table header or footer. Since the table height is unlimited in this case and depends on the number 

of records in the BOM, the table grid lines are defined in the template properties as the table boundaries. 

Besides, automatic continuation to the new page is not supported for BOMs created on the drawing 

page. 

If the BOM is located on a separate page or in a separate document, the table size and appearance are 

predefined and do not depend on the actual number of records in the BOM. In this case, the fragment is 

inserted in the BOM page that contains the full image of the BOM title block, including the header, the 

main text and the table grid. The table boundaries are not specified in the template in this case. What is 

required in this case is that the distance between the horizontal lines of the table grid in the fragment 
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was equal to the height of the template cells. In this case, the template (the textual table) is applied 

“over” the fragment and is tied to its nodes. 

Such BOM is allowed to occupy several pages. Once the table is filled up on one page, the BOMs 

continuation is automatically created on the new page. The BOM title block fragment inserted in the new 

page is defined in the BOM prototype under the command ST: Set Document Parameters, the 

Fragments tab. 

When creating a BOM, the template and the title block are created automatically according to the 

selected BOM prototype. The BOM prototype is a document containing the empty BOM only. It has the 

BOM prototype table (empty paragraph text with a table of certain type and formatting), BOM properties 

and the title block fragment. The drawing settings define which title block fragment to insert when 

continuing on the new page (for automatic creation of additional BOM pages). All these data are 

obtained from the mentioned prototype when creating a BOM. In future, when working with the created 

BOM, the user can manually change the BOM template, its properties and the title block.  

Creating BOM  

To create a BOM based on prototype, use the command BC: Create Report/Bill of Materials: 

Keyboard Textual Menu Icon 

<BC> 
Tools > Report/Bill of Materials > 

New…  

Upon calling the command, the dialog box “Create Bill of Materials” will be displayed. Use the controls 

provided by the dialog box and create BOM table either in a new document or on a new page of the 

current document, or else on the current drawing page. 
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When creating a BOM, one can select a BOM prototype describing the structure of the columns and 

sections of the table being created. The list of prototypes is provided in the Prototype pane. 

To create an individual BOM tables and new BOM prototypes, use the “<Empty Template>” template.  

System offers BOM templates in various standards that are based on the paragraph text functionality. 

The “Preview” pane allows previewing the image of the selected prototype. 

When creating a BOM on menu or the current page, it is assigned a unique name “Bill of materials 1”, 

“Bill of materials 2”, etc. The name of a BOM created as separate document includes the name of the 

respective assembly. For example, if the assembly is named “Assembly 1”, then its BOM created in a new 

document will be named “Assembly 1 (Bill of materials 1)”. The latter name can be modified in the 

command BM: Bills of Materials. 

When creating a BOM, we recommend setting the parameter ‘Transparent’ Text editing (ST: Set 

Document Parameters command, View tab), that allows entering BOM editing mode by simply 

clicking  one of the records. 

Creating BOM on New Drawing Page or New Document 

Call the command BC: Create Report/Bill of Materials. In the coming up dialog box set parameter On 

New Page and select a prototype (for example, “ISO_BOM.grb”). Press [OK]. As a result, a new page will 

be created in the document, displaying the BOM being created in editing mode (subsequent BOM pages 

are also created automatically).  
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If any data was specified for inserted fragments and they were included in the assembly product 

structure, this data will be added to the product structure after its updating. The data will be 

automatically added to the BOM. 

In the cases, when the data was not defined or 

relation with fragments was not established, an 

empty BOM is displayed on the screen. In this case, 

the dialog box Add record to section will be 

displayed. 

This dialog box appears any time when editing an 

empty BOM. By using this dialog, you can add the 

desired records to any of the sections. If the 

specified group does not exist in the BOM, it will be 

created automatically. You can abort BOM creation 

by pressing the button [Cancel]. 

  

 

An edit mode is activated after BOM creation. 

Display options and sorting rules of the BOM table will be taken from the prototype.  

More information about BOM editing can be found in section “Editing BOM”. 

BOM creation is confirmed by option: 

 <F5> Finish input 

Alternatively, you can right click , with the pointer being outside the BOM table area. 
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Creating BOM on Existing Drawing Page 

Call the command BC: Create Report/Bill of Materials. In the coming up dialog box set parameter 

On Existing Page and select the desired prototype. To automatically position the BOM prototype on the 

drawing, check the optional parameter “Automatic snap” (recommended). Usually, such BOMs are 

created on the drawings with their title blocks already in place. 

If using the automatic snap, the system will automatically search 

for snapping nodes when creating the BOM. The standard title 

block fragment has the default nodes defined, with the reserved 

names “bom1” and “bom2”. In this case, the BOM will be 

positioned above the title block. If such nodes do not exist on 

the title block, the system will search for them among other 

drawing elements. You can create such nodes manually. What is 

important is that the nodes are not aligned vertically nor 

horizontally, with the horizontal distance between them 

sufficient for fitting the BOM prototype in between. 
 

For a BOM prototype based on a multiline text, just one node, “bom1”, is sufficient. If the nodes not 

found, the system displays the respective message and switches to the mode of manual snapping point 

input.  

In the case of manual BOM positioning, a box rubber bands on the screen defining the BOM boundaries. 

Position the box as desired and click . Note that in this case the BOM table is Lower Limit-justified and 

will grow upwards as records are added. 

 

 

 

For confirming the BOM creation use the option: 

 <F5> Finish input 
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Creating BOM from Empty Prototype 

By selecting the prototype named <Empty Template>, you will be independently creating a BOM based 

on an empty drawing. This is different from creating a new prototype (see the section “BOM prototype”) 

in that the parameters and BOM properties being defined will be used in the current document only. An 

empty prototype-based BOM can be used as a prototype for creating other BOMs only by saving the 

current document in the folder “…\Program\Template\BOM”. 

Switching Between the Assembly and BOM Document 

The command BT: Toggle: Assembly/BOM Pages allows opening a BOM from the current assembly that 

is located on a different page or in a different document: 

Keyboard Textual menu Icon 

<BT> 
Tools > Report/Bill of Materials 

> View Assembly/BOM  

If the document contains several BOMs the dialog box Select Bill of Materials appears. 

 

Select the BOM to open and press [OK]. The selected BOM document will open. The returned to the 

assembly, called the command BT: Toggle: Assembly/BOM Pages again. 

 

 

 

When creating a BOM in a separate document, there is yet another way of switching to the assembly 

drawing. You can select the item Assembly in the BOM context menu. 
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If several BOMs exist in the document, one of which is placed on the first page of the assembly 

drawing, then any other BOM created on a separate page or in a separate document will have to 

be opened manually. 

Filling in BOM Title Block  

A BOM title block can be filled in by two ways: 

1. Since the BOM table title block is a fragment, the title block can be filled using this fragment variables. 

To do this, call the command EFR: Edit Fragment. 

Then select the BOM table fragment with the mouse. A dialog box will come up on the screen 

representing the title block of the BOM page that you selected. Alternatively, this dialog box can be 

called as follows. While the system is in the command-waiting mode, move the pointer over the BOM 

table fragment and right click . In the coming up menu, select the item “Variables”. 

 

Fill in all required entries of this dialog box. Upon confirming by pressing the graphic button [OK], the 

records from this dialog box will be entered in the title block of the BOM page you have selected. 

2. Another way of filling in the title block is by direct input in the drawing, without calling the fragment 

variables. To do so, set the textual pointer inside the title block box to be filled, and click . Start typing 

the text as soon as you see the blinking cursor in the specified box. The button with an arrow appears to 

the right of the box allowing selecting values from the list. In usually, the list is empty (except for the 

entries in the “Date” column). If it is necessary to fill in the list for selecting values from the list in future, 

fill the box with the desired text, and then in the context menu called by right clicking , select the item 

“Add Value to List”. 



Product Structure, Reports, Bills of Materials 

967 

BOM  PROPE RTIES  

While in the BOM editing mode, the properties dialog box of the BOM being edited can be called using 

the option: 

  BOM properties 

This option is located on the main toolbar (button set “BOM”). 

The BOM properties dialog box can also be called by different means. For example, it can be accessed 

from the dialog box of the command BM: Reports/Bills of Materials. Alternatively, in the command – 

waiting mode, move the pointer over one of the current BOM records and right click , and then in the 

coming up context menu select the item BOM Properties. If this item is not available in the context 

menu, then first select the element BOM by using item Other.  

 “BOM” Tab 

Reverse Order. With this flag set, the records in the BOM table will be coming in the reverse order 

that is starting with the row with the highest ID number. The order of records in the table is 

defined by the sorting rules (see below). 
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Merge Records. Allows merging BOM rows with identical records.  

Example: suppose, the same fragment is inserted into assembly several times. In this case, the 

data are compared, and since there is no difference, the records of these fragments are merged in 

one row, as directed by the flag. 

Don’t Include Invisible Elements. When this flag is on, BOM will contain only visible fragments. 

Fragments invisible on the drawing (e.g. hidden with levels) will not be added to BOM. 

Sort by Position. If BOM contains explicitly defined positions, when this flag is set, records in BOM 

tables will be sorted according to those positions along with the usual sorting rules. 

Update product structure by BOM. When the flag is enabled, the BOM data is included in the 

product structure. 

Begin position number in section after maximum value in previous section. Setting this flag will 

bring the following behavior: if any BOM section contains explicit positions with numbers greater 

than assigned automatically, numbering in the next group will begin from the values following 

the maximum explicitly specified number. 

 

Zones. This parameter defines the zones when using the automatic zone definition mode (see the section 

“Preparing data for BOM table”). Takes the following values: 

By Fragment Location. The zones will be defined by the fragment location.  

By Leader Note Text Location. The zones will be defined by the location of the leader note 

callout that marks the fragment position.  

 

The following two parameters define the name of the document containing the table header image, used 

in the prototype file: 

Page Header Fragment. This parameter entry specifies the path to the file containing the BOM 

table header. (The case of using the header). 

Page Footer Fragment. (The case of using the footer). 

Link with external database for update. This parameter is used for connecting with a BOM based on an 

external database. Data exchange between the BOM and the database occurs only upon updating the 

BOM.  

The parameters “Assembly Document” and “Bill of Materials Document” specify the path to the file or 

files containing the assembly and the BOM documents.  

“Sections” Tab 

A box in the upper portion of this tab displays the path to the active sections database.  

This tab contains a table with the list of sections displayed as a tree, in its first column, and the rest of the 

columns displaying the parameters of the respective sections. The set of sections can be modified in the 

command BG: Edit BOM Sections. The order, in which the sections are listed in this table, will be 
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maintained as the sections are inserted in a BOM. For example, in the case represented by the above 

table, the group “Military standard parts” upon inserting in a BOM will be located after the sections 

“Company standard parts”, and before the group “Industry standard parts”. 

 

The existing group order can be changed using the graphic buttons [Up] and [Down]. 

To modify group parameters, select this group in the list. The parameters of the active group will appear 

in the entries in the lower portion of the tab. You can input the desired values of the following 

parameters:  

Empty Rows: Before and After. Define the number of empty lines before and after the group 

header. These lines serve as separators, not allowing entering records.  

Positions: Controls the group positions appearance. With this parameter set, positions will be set. If 

the parameter unset, this group will be ignored when setting the positions.  

Step. Defines the step of setting the positions in the group.  

Skip. Specifies the number of positions to skip for the beginning of the group. The number of 

the first position in the group will be equal to the number of the last position in the previous 

group plus the amount defined by this parameter.  

Header. This parameter defines, whether the group header title is displayed in the BOM. The 

graphic button [Font] is used to call the dialog box for defining the font parameters of the 

group header title. The button [Paragraph] calls the respective dialog box for defining various 

parameters for group title formatting (see the chapter “Text”). 
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“Columns” Tab 
 

This tab contains the list of columns and their respective parameters. The columns are inserted in the 

BOM table that are checkmarked in the box before the column name. The top-down order of columns in 

the list defines the column position in the BOM (left to right). A column position can be modified using 

the buttons [Up (to the Left)] and [Down (to the Right)]. Remember, however, that changing a column 

position will not affect the position of the respective column in the BOM table template, nor change its 

width. 

 

The correspondence between the fragment data and the standard BOM table columns is defined by the 

type of the column, rather than its name. 

The following are the only parameters of the current column allowed for modifications: Accumulate 

Values for Merged Rows, Ignore When Comparing Records, Show Group Header. 

When inserting the same fragment several times into the assembly, its data are compared, and, since 

identical, entered into the BOM as one record (in the case when the parameter Merge Records is set on 

the tab BOM). In this case, it is necessary that the records be summed up in the column “Quantity”. This 

behavior is supported by the following two parameters. 

Accumulate Values for Merged Rows. With this parameter set, the numerical figures will be 

summed up when merging the positions. 

Ignore When Comparing Records. With this parameter set, the columns will be excluded from 

comparison (that is considered equal). If the parameter Accumulate Values for Merged Rows is 

set, then this parameter is also set automatically. 

Show Group Header. The column with this parameter defined will display the group header. 
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In text of the united records with flags Accumulate Values for Merged Rows and Ignore When 

Comparing Records it is not possible to use variables that change their values depending on the 

assembly parameters. Such variables will be replaced with constants on uniting. 

The list of columns can be modified using the graphic buttons [Add…] and [Delete…].  

The graphic button [Add…] is used for creating a new column. It brings up a dialog box for defining all 

necessary parameters for the column being created. 

Column Name. This entry is for specifying the column name. 

Column Type. Defines what fragment data will be entered in the column being created. 

Standard. Presents the standard BOM data. The 

entries are copied from the respective section of the 

fragment BOM data. The data entry name for the 

BOM is selected from the combo box on the right 

hand side. 

By default, the column name coincides with the 

name of the selected entry. If necessary, the user 

can define an arbitrary column name. The BOM 

table can include two columns with the same 

standard BOM entry (for example, one can have a 

column presenting the weight of one part, and 

another column presenting the combined weight of 

several parts). If the list of columns contains records 

with coinciding entry names, the system of box a 

warning message. 
 

Variable. Such a column will be displaying the value of the fragment variable. The variable name 

is entered in the box on the right hand side. The default column name will be the string 

“Variable ‘variable_name'”, however, if necessary, the user can specify an arbitrary column name. 

Only those boxes in the column will be filled in, that correspond to the fragments with the 

namesake variables defined. If the variable data type mismatches the data type of the BOM 

column being defined, the system automatically converts the data types. 

Custom. Selecting this parameter provides access to the list of names for additional BOM 

entries. The list displays only the names of the entries that are added to the installation package 

(the file “…\Program\BOM Custom Data.txt”).  

 

If necessary, the file containing the list of additional BOM entries can be manually edited, with 

one's own data included in it. The thus defined entries will be displayed in the list of additional 

entries of the above-described parameter. 
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When you select the name from the list, the fragment data that was input in a respective cell of 

the Product structure window will be entered in the column. 

When entering an arbitrary column name, there are two possibilities: 

- If the data was defined under the same name in the fragment documents, then the created 

column will contain the respective data from the fragments; 

- If the user creates a column with a unique name, then its data has to be entered manually. 

To use this feature, select the column while in the BOM editing mode and clear the default 

option “Automatic Field”. 

The Data Type combo box offers one of the following values: 

Integer. Integer numbers only. 

Real. Real numbers only. 

Text. Arbitrary textual information. 

The delete a column, select it in the list and press the graphic button [Delete]. 

“Sort” Tab 

This tab is used for defining and editing the sorting rules for the BOM Records. 

By default, this tab reflects the sorting rules specified in the BOM prototype that was used for the BOM 

creation. 

 

The sorting rules are defined for each BOM section separately. Those appear as a set of conditions for 

comparing the contents of the selected BOM columns. 
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The pane Document Sections defines the BOM section, for which the sorting rule is being defined or 

modified. 

The sorting defined for the section “Sections”, affects the records that do not belong to any BOM section. 

The rule itself is displayed in the entry Sort Order in Selected Section in the form of a table, in which all 

the conditions are collected, that will be used for comparing lines in the section concerned. The order of 

applying the sorting conditions corresponds with their order in the table. If sorting rules are not defined 

for a section, then the records in the table will be placed in the order of the entering in the database. 

The diagram shows that in the example the row comparison in the “Sections” group will be done by two 

columns: “Part Number” and “Part Description”. First, the lines will be compared in the column “Part 

Number”, since this column appears first in the table. If several lines in this column will be identical, then 

their further comparison will be performed based on the records in the column “Description”. The order 

of comparing the BOM lines by columns can be changed by altering the record positions in this table. 

This is done using the graphic buttons [Up], [Down]. 

To create or modify existing rules for sorting a section, do the following steps: 

1 Select the desired section from the BOM section tree in the Document Sections pane. The list 

of columns with the currently defined set of sorting conditions will then be displayed in the 

Sort Order in Selected Section table. 

2 Select the column whose sorting conditions are to be modified. The specified sorting condition 

settings will appear in the parameter fields on the right from the sections list.  

3 Defines the required settings of the sorting parameters: 

Columns List. Defines names of columns.  

Compare Zone. Defines the excerpt of the table entry content to be used in comparison. 

From. Defines the start of the excerpt to be compared. 

Char # - the number of the character position (example: from the third character in the entry). 

Substring – the number of a subsequent string occurrence in the entry (example: from the first 

occurrence of the string “ISO”). 

Char # from end – the number of the character position, counted from the end of line. 

Substring from end - the number of the subsequent string occurrence in the entry, counted 

from the end of line (example: from the first occurrence of the string “ISO” from the end of 

line). 

To. Defines the end of the excerpt to be compared. 

Number of chars - defines the position number of the last character in the excerpt (example: 

until the character number 10 in the entry). 

Substring - the number of the subsequent string occurrence in the entry (example: until the 

first occurrence of the string “-”). 

End of line – to the End of line.  

Compare Type. 
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Character. Realizes comparison by ASCII characters (the contents of the two table entries are 

compared as two strings of characters). If the first character in the record entry is a number, 

the record is considered empty and is moved to the start or end of the group as prescribed by 

the parameter “Placement”. If the several such records, their relative positioning will be 

random. 

Numeric. Compares numbers (the contents of the two table entries are compared as two 

numbers). If the first character in the record entry is a letter, the entry is considered empty. 

Mixed. If a non-numerical character appears on the first position of the first entry in the 

comparison, then the system identifies the substring of characters starting from the first 

position and compares it with the respective substring found in the second entry. If the second 

entry does not begin with a non-numerical character, then the first entry sub string is 

compared against the empty string. Next, the numerical substrings are identified, and the 

respective numerical values of the two entries are compared, starting from the first position 

after the last character string used in the previous step of the comparison. Thus, the contents 

of both entries are analyzed until reaching the end of the first entry. If a digit is found in the 

first position, the contents of the entry are considered an empty string of characters. 

Placement. Defines the order of records placement. Case-sensitive.  

Ascending. Begin with the first letter in the alphabet and the smallest number. 

Descending. Last letters in the alphabet and largest numbers come first. 

Empty Record. If empty lines exist in the group, intended for inputting records, this parameter will 

define whether these lines will be moved To Start or To End of the group. 

To add a sorting condition in the table, first, unselect the existing records in the table. Next, set the 

necessary parameter values on the right of the list of sections, and press the [Add] graphic button. 

Alternatively, select one of the existing conditions in the table, then add it to the same table by the [Add] 

button and edit its settings. 

The graphic button [Copy] allows copying one of several lines of the table with the sorting parameters 

defined to the clipboard, and then pasting them in another group. To select all lines, hold down the 

<Shift> key, several rows with the <Ctrl> key. 

To delete one of the sorting conditions from the table, select this condition and press the graphic button 

[Delete]. 

With the “Automatic Update”  mode set, the new records added the BOM table are instantly placed in 

the position defined by the specified sorting conditions (except the manually edit records). 

“Sum” Tab 
 

This tab is intended for defining the rules of summing up the data in BOM columns for evaluating the 

bottom line. A specified rule is not recorded in a database; rather, it becomes an attribute of the text and 

can be used in future for evaluating the bottom line of a BOM column. 
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As an example, select the text used for creating some BOM table, and right click . From the coming up 

menu select the command “Measure…”. The element with the name of the summing rule will be present 

in the list of the text attributes. 

If necessary, you can create a variable with the value equal to the sum, calculated based on the specified 

rule. 

To define a new rule for summing up a column, specify the following parameters: 

Sum. Specify the target column of this summing rule. 

Section. Specify the BOM section to apply this rule to. The “<None>” setting means the rule will be 

applied to all records in the table. 

Condition. Defines limitations on the BOM table records to be included in the bottom line 

evaluation. Select a column, a comparison condition and a value to compare the entry against. 

Selecting “<None>” means the condition is applied to all records in the table. 

To input the defined settings, press the graphic button [Add]. The new rule will appear among the list of 

rules, named by default “New condition”, with the summing parameters defined. The graphic button 

[Delete] deletes the current record from the list of summing rules. To modify a whole name, point at the 

entry “Name” of the desired column and double-click  . The rule name will then be focused on, so that 

you can edit it.  

BOM  EXPORT  

For exporting BOM data or the BOM itself to the Excel file (xls), the command “BS: Export BOM” is used: 

Keyboard Textual Menu Icon 

<BS> 
Tools > Report/Bill of Materials > 

Export…  
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After calling this command, the dialog window with the list of export options appears on the screen. 

From the list the user can select Export BOM data to Excel and Export BOM table to Excel. 

When exporting the BOM table, only the contents of the BOM 

table is transferred to the Excel document. The sequence and 

the composition of columns in the table, the row sequence, etc. 

are retained. 

When exporting the BOM data to the Excel document, all 

internal data, on the basis of which the BOM was created, is 

transferred. All sorting rules and rules for combining the records, 

used in the BOM, are ignored. The result of the export operation 

will be different from the initial BOM appearance in the program 

document. 
 

 

If the original program document contains several BOM, the result of the export operation will be the 

multipage Excel document. Each BOM is exported to a separate page (sheet). 

The export is carried out by macro located in the folder “…/Program/BOMExport”. If necessary, for 

exporting BOM to different formats, the user can add his own macro to this folder. 

EDITING BOM 

When creating a new BOM, the BOM editing mode activates automatically. To activate this mode for an 

existing BOM, simply move the pointer to the BOM area and click  (this will work in the case when the 

transparent text editing setting is activated for the page, by the command ST: Set Document Parameters 

on the View tab). Alternatively, you can call the command BE: Edit Bill of Materials: 

Keyboard Textual Menu Icon 

<BE> Tools > Report/Bill of Materials > Edit  

Besides, you can enter BOM editing from the context menu. To do so, move the pointer over the BOM 

text and right click . In the coming up menu, select the item Edit Contents. Any of these efforts lead to 

entering the BOM editing mode. 

On the main toolbar of the program (if its state is not locked), the button set “BOM” which has options 

for editing Bill of Materials will appear. 

The automenu options are intended for inserting various elements and formatting the text of the BOM. 

The text can also be formatted by using the system toolbar. Details of these options and the system 

toolbar were provided in the description of the command TE: Text, the sections “Paragraph Text” and 

“Multipage Text”. If after the text formatting it is necessary to restore the formatting defined in the BOM 

table default template, simply highlight this text and press the option: 

  Default Format 
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To edit the BOM table template, use the option: 

  Edit Template 

For the system will enter the table creation command. On the main toolbar the button set “Table” will 

appear with the help of which editing the template (see the chapter “Text”). 

If the following option is turned on the main toolbar (in the button set “BOM”): 

  Automatic Update 

Then, the BOM will be updated automatically (updating the table accounts for the specified sorting 

conditions). This mode is recommended; this is why the icon is turned on by default. If the automatic 

updating hinders the operation, this icon should be turned off. In this case, the BOM records can be 

updated manually, using the icon: 

  Update 

Remember, that the sorting conditions are not applied automatically when saving the BOM.  

To update the BOM outside the editing mode (as, for instance, after assembling fragments), one can use 

the context menu. To do this, position the pointer over one of the BOM records and right click . In the 

coming up menu, select the item “Update BOM”. 

The Automatic Field option is turned on for all records into the BOM automatically from the inserted 

fragment data, as indicated by the pushed icon: 

  Automatic Field 

This means, the manual input is disallowed in the fields of this record. If such a necessity exists, this 

option can be turned off. Remember however that the later modifications to the assembly do not affect 

the records created manually. 

To manually input a record in the BOM table, first insert an empty row. To add a row to the current 

section, simply position the pointer at the row, before or after which the record should inserted, and 

press one of the following icons: 

  Add Record Before 

  Add Record After 

As a result, an empty row will be inserted in the current section, allowing for entering a record manually. 

The position will be defined for the added record. Remember, that upon updating (the automatic update 

does not work in this case), the added rows will be moved according to the defined sorting parameters 

(see “BOM Properties”). 

To add a record to an arbitrary BOM section, use the command: 

  Add Record into Section or Create Section 
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In the coming up dialog box select the section to which the 

record should be added, and enter the number of rows in 

the parameter “Number of records”. 

Upon confirming, empty rows will be created in the section. 

This records are also accounted for, when setting the 

positions. Empty rows appear in the beginning or in the end 

of the section depending on the sorting rules. 

If the specified section does not exist in the BOM, then the 

specified section header will appear in the BOM upon 

confirmation. This capability can be used when searching 

for a section in the case of multipage BOMs. 

 

The delete a record, place the pointer over the record entry to be deleted and press the icon: 

  Delete Record 

If all records are deleted in the section, then the section header will also be deleted. 

The deleted records still exists in the BOM, they are just not displayed. Those can be viewed using the 

option: 

  Show Hidden Records 

Upon turning on this option, all deleted records will be displayed in the BOM. The record entry is will be 

color-marked (the color can be modified in the command Customize > Options, the tab BOM, the 

parameter Hidden Records Background Color). To restore a deleted records, simply select it with the 

mouse and press the icon: 

  Restore Hidden Records 

To hide deleted records again, turn off the icon Show Hidden Records. 

The hidden records that were entered manually are kept until the BOM is updated. 

A record can be moved up and down by the options: 

  Move Up 

  Move Down 

These options are only accessible when the sorting is turned off (see “BOM Properties”), and only for the 

records that can be a moved without violating the sorting conditions (such as identical records). 

If the records should be moved in such a way, that one record always follow the other specific one, it 

should be tied to the previous using the option: 

  Snap to Previous Record 
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To have a BOM row ignored when setting the positions, one should set the option for it: 

  Skip Position 

To insure that a record has the same position under any assembly or BOM modifications, set the option 

for this record: 

  Lock Position 

The options: 

  Insert Empty Row Before Current Record 

  Insert Empty Row After Current Record 

Low editing rows, serving as record separators, before or after the record pointed by the mouse. Such 

rows are assigned the parameter “Automatic Field”. No text can be entered in such rows. 

The accessed by the following option BOM properties dialog box allows defining the order of setting 

positions, decoration of the BOM section headers, column properties and sorting conditions (see the 

section “BOM Properties”): 

  BOM Properties 

BOM editing is completed using the automenu option: 

 <F5> Finish input 

DELETING BOM 

Deleting Whole BOM 

To delete a BOM, use the command BX: Delete Bill of Materials: 

Keyboard Textual Menu Icon 

<BX> 
Tools > Report/Bill of Materials > 

Delete…  

If several BOMs exist in the document, the system offers selecting the BOM to delete from the list. 

When deleting a BOM, only the textual table of the BOM is actually deleted. The fragment title block 

stays in the drawing and needs to be deleted separately. 

CREATING AND EDITING BOM  PROTOT YPE  

A BOM prototype is a program document, containing only an empty BOM with specific defined 

properties. Since a prototype is not an assembly, its BOM does not have any records. The text formatting 

parameters and the tables defined in the prototype will drive the graphic shape of the BOM based on 

this prototype. 
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Should a BOM prototype need modifications, it can be opened as a common program document and be 

edited. One can also create one's own custom BOM prototypes and use them in future. 

The files used as prototypes are stored in the folder whose name and path are defined by the command 

SO: Set system parameters, the tab Bill of Materials, the parameter Template Folder. The default folder 

setting is “…\Program\Template\BOM”. The standard BOM table prototypes are stored there upon the 

system installation.  

To create a custom BOM prototype, use the command BC: Create Report/Bill of Materials. In the coming 

up dialog box, select one of the prototypes in the BOM list. If the new BOM has just insignificant 

difference from a standard BOM, then the most closely matching prototype should be selected. To create 

a BOM, whose table differs in a relevant manner from the tables of the standard BOMs, use the “Empty 

Template”. 

Upon selecting a BOM prototype, press the graphic button [Create New Template]. 

Creating BOM Prototype Based on Existing Prototype 

The first step will be defining the name of the new prototype (a new prototype is always created in a new 

document). By default, the document is created in the folder defined in the command SO: Set System 

Options, the tab Bill of Materials (by default, “…\Program\Template\BOM”). This insures the presence of 

the created document in the list of prototypes when creating a new BOM. After that, a window opens 

with the new document created based on the selected one. 

To make modifications to the table header, open the title block or the BOM title fragment and modify 

the names of columns, then number and with as desired. Save the title block under a new name. 

Returned to the document of the prototype being created. If the prototype being created is intended for 

creating a BOM, that will occupy a separate page or separate document, specify the name of the edited 

title block in the properties of the title block fragment. In the case of a BOM prototype for positioning on 

the drawing page, modify the fragment name in the BOM properties. If the prototype provides for 

automatic continuation of the BOM to the new page, make the respective changes to the subsequent 

pages of the title block fragment, as specified in the parameter Insert Fragment on new Page creation in 

the command ST: Set Document Parameters, the Fragments tab. 

Upon modifying the title block or the BOM header fragment, modify the properties of the BOM template 

as well. In the BOM context menu select the command “BOM Properties…” and enter the necessary 

changes (see the section “BOM Properties”). The BOM template will be automatically edited according to 

the introduced changes. The same can be done by calling the command Tools > Report/Bill of Materials 

> Reports/Bills of Materials… and pressing the button “Properties”. 

The size of the table cells and their contents formatting parameters is done by using the option “Edit 

Template”, called in the BOM editing mode. 

Creating BOM Prototype Based on “Empty Template” 

When selecting the “Empty Template” as the prototype, BOM creation stars “from scratch”, based on an 

empty drawing. In this case, the BOM table has to be created manually. 
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First, in a separate document create either the complete BOM title block with a header and the 

ruled BOM table, or just the table header, depending on the purpose of the prototype being 

created. Upon saving the created title block, one can proceed with creation of the BOM prototype 

itself. 

Call the command BC: Create Bill of Materials. Select the “Empty Template” as the base prototype. Upon 

pressing the graphic button [Create New Template] a window appears for selecting a new document 

prototype. 

 

 

Next, define the name of the prototype being created and its directory. The system will then open a new 

window with the created document, and the automenu will display the options for creating the BOM 

template text: 

 <M> Create Multiline Text 

 <R> Create paragraph text 

 <P> Set Text parameters 

 <N> Set relation with Node 

 <Esc> Exit command 

Creating BOM title block  
A prototype for a BOM on a separate page requires creation of a complete BOM title block 

including the title block text, header and grid lines of the BOM table being created. The table itself 

will be created with indivisible borders in this case. 

Fixing of the title block as a fragment in the BOM prototype document will be done in absolute 

coordinates. Therefore, it is not necessary to create fixing points or a fixing vector. All you need is just to 

position the title block drawing correctly with respect to the page borders. 

The title block text entries are created based on “Text” elements, driven by the external variables in 

the document. To simplify entering the title block text, one can create custom dialog boxes. 

To create a BOM prototype to be placed on an existing drawing page, all you need is to create just the 

table header. The grid lines will be defined by the borders of the table text, that should be made visible 

in this case. 
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A fixing vector needs to be created in the table header file, using two points. The fixing vector should 

pass along one of the horizontal borders of the created table. The fixing vector direction determines the 

position of the header as the BOM grows.  

The fixing vector should be the directed from left to right in the case the left justification is set for the 

BOM table template, and the right to left if the right justification is set to for the template. When creating 

the BOM, the system will fix the header at upper or lower nodes of the text, reserving the necessary 

space for the header.  

 

If the prototype is intended for creating multipage BOMs (usually, those are BOMs located on a separate 

page), one needs to create an additional title block for the second and the subsequent pages (also in 

separate document). 

As an example, one can review the standard BOM title blocks located in the library “Standard”, the 

folder “Titleblk”. 

Creating prototype for BOM located on separate page 
As an example, let's create a BOM prototype, whose table will have the following columns:  “Item No”, 

“Part Quantity”, “Part Description”, “Part Number”, “Part Material”, “Part Price”. 

Let's begin the prototype creation with creating 

BOM title blocks for the first and subsequent 

pages in separate program documents.  

After that, one can proceed with creating the BOM 

prototype itself. Call the command BC: Create 

Report/Bill of Materials. In the coming up dialog box 

select “<Empty Template>“ and press the graphic button 

[Create New Template]. After selecting the new 

document prototype and entering the name for the 

prototype being created, the system activates the text 

creation command. 

The BOM table is created based on the paragraph text or 

multiline text. If you want the system to support 

automatic continuation of the BOM table onto the new 

pages as records are added (with automatic new page 

creation) or into a different area on the current page, 

then select the paragraph text. If you select the multiline 

text, then your BOM table will grow high without the 

capability of transferring it onto another page.  



Product Structure, Reports, Bills of Materials 

983 

Select, for example, the option  Create paragraph text. You should set vertical justification among 

the text parameters of the table being created. This should better be done before entering the text. 

 

Call the text parameters dialog box using the  

option. 

If you want your BOM to grow from bottom up as 

records are added, then set Lower Limit justification, 

to grow from top down use Upper Limit justification 

(Upper Limit justification is set by default). When 

creating a BOM prototype on separate page, the 

vertical justification is usually required to be the 

Upper Limit one. 

 

If you use the paragraph text, the rest of parameters 

can be left unchanged. When using the multiline 

text, additionally set the right horizontal justification. 

When using the paragraph text, the vertical 

justification can later be changed by calling the 

properties dialog box for the rectangular text area 

(see the chapter “Text”). 

After that, we need to define the boundaries of the 

box where the created BOM table will be placed. To 

do this, specify two arbitrary points in the case of the 

paragraph text, or just one in the case of the 

multiline text. 

 

 

To continue with the BOM creation, click   inside the paragraph text or press . The BOM property 

window will appear on the screen (see the section  “BOM Properties”). In the case of using the multiline 

text, the BOM property window will appear right after selecting the fixing node. 

Default BOM properties (names and types of the columns, the sorting rules and the sections) are 

copied from the file …\Program\BomStructure.mdb. 
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The number of columns, their 

position and structure can be defined 

on the tab “Columns”. 

The columns that are checkmarked in 

the table on this tab are the ones that 

will be included in the created BOM 

table. 

In the example shown on the 

diagram, the BOM table will have the 

six check marked columns, their 

positioning left to right being 

determined by the relative positions 

of the checkmarked entries on this 

tab in the top down direction. 

 

Note that the number, names and order of the columns should correspond with the BOM title 

block. 

The Sort and Sum tabs allow defining (or modifying default) sorting rules of the BOM records and 

summing up rules for its cells. 

Upon confirming the specified properties, the system will activate the BOM table editing mode. The 

dialog box Add Record into Section or Create Section will appear on the screen. The BOM prototype 

should not contain any records; therefore, close the dialog window by pressing the graphic button 

[Cancel]. 

To format the columns of the created table, enter the template editing mode. This can be done using the 

option: 

 Edit Template 

This option is located on the main toolbar (in the button set “BOM”). Upon calling the option, the system 

activates the table editing mode. On the main toolbar (if it is not locked), the button set “Text” will be 

shown. The options of this set allow changing the height, width and formatting of the columns. Besides, 

the following options become available in the automenu: 

 <F9> Format Font 

 <F10> Format Paragraph 

 <Ctrl><F5> Parameters of changing Paragraph size 

 <F11> Edit in separate window 

Let’s format the created table. The columns width was set automatically when inputting the text based on 

the size of the input paragraph text. (When using the multiline text, the width is set by default). The width 

of each column must be changed according to the width of the columns in the BOM title block. The 
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height of the template rows must be equal or (for multiline records) a multiple of the distance between 

the horizontal grid lines in the title block. 

Select the whole table by clicking   or with the following option on the main toolbar (button set “Text”): 

  Select Table 
 

Then, using the option , call the paragraph 

parameters dialog box. The parameter “Between 

(interval)” should be assigned the value “Exactly” 

and the numerical value equal to the height of the 

rows in the title block table (in this example - 8). 

Press the [Ok] button to close the dialog box. 

The height of the table rows should be changed 

accordingly, and the border display should be 

turned off. To do this, keep the table highlighted 

and call the option on the main toolbar (button set 

“Text”): 

 
 

  Table Properties 
 

On the “Row” tab, set the following row parameters: the 

row height, as well as the line spacing interval, is set 

equal to the distance between the horizontal grid lines in 

the title block. The parameter “Mode” should be 

assigned the value Multiple. This allows increasing the 

height of the rows with long entries in the table so that 

they exactly match the rows of the title block. 

Additionally, one can set the parameter “Allow wrap”. 

This will allow prolonging the BOM table on the next 

page. 

 

Since the BOM table grid is defined by the title bar, the display of the template table border lines should 

be turned off. To do this, on the tab Borders of the same dialog box clear the respective flags. Upon 

confirming the entered changes, the system returns to the BOM editing mode. 

Keep calling the same dialog box for each separate cell in the template table, setting the desired width of 

each cell in the Cell tab, along with text offsets from the beginning and the end of the cell, if necessary. 

Besides, one can set horizontal justification mode for various table cells, and force no-line-break for the 

text, using the automenu option . 

Table creation and editing capabilities are described in details in the chapter “Text”. 
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To complete BOM template editing, one can use the option: 

 <F5> Finish input 
 

The system will then return to the BOM editing mode. 

To complete working with this functionality, one can also use 

the option . After that, the system returns to the text 

creation command. To continue working with the system, with 

this command. 

Next, let's insert the predefined title block fragment in the 

drawing. To do this, use the command FR: Create Fragment. 

Then call the command “Edit” from the BOM context menu 

and snap the created text to the fragment nodes (“Node 1” 

and “Node 2” on the diagram) for the exact match between 

the BOM template and the title block lines. 

 
 

The final step will be insuring the correct BOM continuation 

onto the subsequent pages. For this purpose, call the 

command ST: Set Document Parameters and on the 

Fragments tab specify the title block fragment names for 

the second and other subsequent pages of the BOM. 

You will have to enter the template editing mode again and 

call the option . In the coming up dialog box on the tab 

“Height” set the action upon the text outgrowing the 

rectangle bounds as “Create new rectangle on next page”.  

The new rectangle coordinates are set according to the 

coordinates of the outer nodes of the table (similar to the 

nodes on the previous diagram) on the title block drawing 

for the subsequent BOM pages. 

 

Note that the described order of steps in defining the BOM template parameters is not 

mandatory. All these steps can be performed in an arbitrary order. 

Creating prototype for BOM located on existing drawing page 
The sequence of steps for creating such a prototype is mostly the same as in the previously described 

situation. As in the case of creating a prototype for a BOM on the separate page, the prototype creation 

should begin with creating the BOM header in a separate file. 

In the following example, let's create the table header consisting of the same four columns as in the 

previous case. Let's position the fixing vector along the top border of the header directed from right to 
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left. The vector direction choice is based on the requirement, that the BOM table template located on the 

existing page has right justification. 

 

Save this file. Then call the command BC: Create Bill of Materials. In the coming up dialog box select 

“<Empty Template>“ and press the graphic button [Create New Template]. After selecting the new 

document prototype and defining the name of the prototype being created, the system activates the text 

creation command. 

In the text parameters dialog box, called by the option , set the Lower Limit vertical justification (a 

BOM located on the drawing page should grow from bottom up). In the case of the multiline text, 

additionally define the right horizontal justification. 

After that, define the boundaries of the rectangular area for fitting the BOM table being created. Upon 

defining the text boundaries, the BOM property window will appear. In it, select the required BOM 

columns, sorting and summing rules, etc.  

Additionally, specify the table header 

(footer) fragment on the tab BOM of 

the same window. 

If the header is used in the table, 

specify the path to the header 

fragment. Otherwise, if the footer is 

used in the table, enter the path to the 

footer. The path can be defined using 

the button . 

Upon confirming the specified BOM 

properties, the  system  will  switch  to 

the 

 

BOM table editing mode. The dialog box “Add Record into Section or Create Section” will again appear 

on the screen. On the main toolbar (if it is not locked), the button set “BOM” will appear. The BOM 

prototype should not contain any records; therefore, close the dialog box by pressing the button 

[Cancel]. 

To format the columns of the created table, enter the template editing mode using the option . in the 

Paragraph parameters dialog box (the automenu option ) specify the line spacing for the table cells, 

as well as the text horizontal justification modes and the requirement of keeping the text as one line. 

In the Table properties dialog box, called by the option  on the main toolbar (set “Text”), change the 

width of each column according to the width of the columns in the header fragment. The height of the 
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table rows does not have to be set in this case. Also, turn on the table border display (is on by default). 

On the Table tab, the right horizontal justification should be set for the table. This will allow 

automatically keep the BOM being created toward the right hand side of the drawing above the title 

block text.  

Note that the justification defined in the table parameters must correspond with the fixing vector 

direction of the BOM header. 

The template editing, as well as the whole BOM editing, can be completed using the option . 

Exit the text creation command and save the resulting prototype. 
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PRINTING DOCUMENTS 

T-FLEX CAD documents are printed out using the command File > Print… (PT: Print Model), which is 

similar to printing commands of most Windows applications. This command allows outputting a single 

(current) T-FLEX CAD document to a printer or other hardcopy-making device. 

 

However, one may often need to print a whole batch of drawings, arranging those economically on one 

or several sheets of paper of the specified format. In this case, one can use an additional command “Print 

documents”. This is an external T-FLEX CAD application, which allows composing the required batch of 

drawings and optimize their placement for printing on sheets of the specified size. The composed batch 

is created in the current T-FLEX CAD document. The drawings included in the set will be represented in 

the resulting joint document as internal 2D pictures with the preserved connection with the source files. 

The resulting document is then printed out just like an ordinary T-FLEX CAD document. 

 

Follow below are the descriptions of both methods for printing T-FLEX CAD documents. 

PRINTING A S INGLE DOCUMENT  

2D drawings can be printed as well as 3D models. It is important, which window was active at the time of 

calling the print command. Printed are all elements that are visible on the screen, except those on the 

layer assigned the «Screen only» attribute. Please also keep in mind that construction elements are not 

printed by default. 

 

To print out a drawing, call the command PT: Print Model: 

 

Icon Ribbon 

  

Keyboard Textual Menu 

<PT>, 

<Ctrl><P> 
File > Print 

 

Upon calling the command, the Print dialog box appears. 

Copies. Sets the number of document copies to print. 
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Printer. Specifies the printer from the list. The list displays all installed printers.  

The button Printer settings calls the Windows dialog for setting up properties of the selected printer; it 

allows specifying print quality, page parameters etc. 

 

Current Page. Upon setting this parameter, the printout will contain the image displayed in the current 

window, including portions of the image outside the format frame. 
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Current window. Upon setting this parameter, the printout will contain only the contents that fit inside 

the format frame. 

Whole document. All document pages of “Normal”, “Text” and “Bill of materials” type will be printed. If a 

3D view was active upon calling print command, it will be also printed. 

 

Selected pages. When printing a multi-page drawing, you can specify which pages to print. A list with 

available pages appears. You need to set the flag near required pages or use one of the options. 

 

 Select all. All pages available in the list will be selected. 

 Deselect all. Cancels pages selection. 

 Invert selections. Invert pages selection. 

 Only print odd pages. Only odd pages will be selected from the list. 

 Filter. Allows to select pages types that will be displayed in the list. 

 

You can also select 3D view for printing, if it is available in the current window. Upon 3D view printing, 

dynamic selection of the printed bitmap resolution depending on the printer DPI and scale is performed. 
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Orientation from page allows to specify each page orientation individually. 

Portrait orientation. Sets portrait orientation for all printed pages. 

Landscape orientation. Sets landscape orientation for all printed pages. 

 

From document. Paper size is controlled by settings of the current document. 

From printer’s settings. Size of the paper that will be printed out will be determined by settings of the 

printer. This mode is enabled by default. 

You can also select paper size from the list manually. 

 

Center (Scale: 100%). Makes the image automatically centered on the sheet at 100%. 

Center. Makes the image automatically centered on the sheet. You can set its scale manually. 

 

Fit to page. Setting this parameter scales the drawing so as to fully fit on one page. 
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Custom. Allows you to specify image position on the drawing and its scale manually. 

 

Left and Top. These parameters define the left and top margins of the paper sheet, respectively. 

Width and Height. Set the width and height of the printed image. 

Scale. Sets the image scale. 

 

If one of the three latter parameters is manually modified, the other two are adjusted automatically to 

maintain the drawing’s aspect ratio. 

  

 

Don’t split into pages. A drawing will be printed on one page. 

Split into pages. Use this option when a drawing needs to be printed at a strictly defined scale while the 

full image does not fit on one page. The option will let you automatically distribute the drawing over 

multiple pages. The result can be preliminarily evaluated in the preview pane. 

 

Upon selecting the option Custom parameter for image location is activated. 

Activate Split lines option to print split lines. The option appears only in Split into pages mode. 

You can select skipped pages using option . 
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Overlap. This option sets the amount of overlapping between the neighboring sheets when using the 

Split into pages option. The overlap can be used for gluing separate printed sheets together. 

 

 

Without constructions. Construction elements will not be printed. 

Print Constructions. Setting this parameter makes construction elements printed as well. 

Selected elements only. Enabling this flag allows us to print out only selected elements of the drawing. 

The parameters managed in Print dialog are retained and displayed upon subsequent opening of the 

print dialog. 
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Printing Settings dialog. 

Hidden Line Removal. You can specify the method of removing hidden lines from the drawing: Raster or 

Vector removal. This option is important when outputting a drawing to pen plotters that require vector 

hidden lines removal. 

 

Monochrome. This option makes the drawing printed all in one color. 

Keep Line Width. Setting this parameter helps avoid variations in line thickness when printing a 

document at a scale other than 100%. 

Preview window is located in the right pane of the dialog. 

 

Its scale can be specified in the right bottom corner. 
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To zoom in and zoom out use options  and . Option  allows to fit page. 

 

Options  and  allows to select pages in preview window. 

 

Several pages can be shown in preview window when you zoom out. If their display takes a long time, 

their content is not displayed and  button appears in the bottom of the dialog. 

 

Selected page is highlighted with orange frame. 

Option  allows to select position and scale of the printed area manually. You can move printed area 

with pressed left mouse button. Mouse wheel rotation allows to change scale of the printed area when 

the option is active. The drop-down list switches to the corresponding location parameter according to 

the changes. 
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Printers’ fields are showed with grey in preview window. There are no fields for virtual printer. 

After all parameters setting press Print button in the top left corner. 

 

Dialog from the previous versions of T-FLEX CAD is also available. 

If you want to use legacy version of printing dialog box, you need to set option Legacy printing on 

Additional Options tab in Options command. 

  

 

PRINTING SEVERAL DOCUMENTS  

The “Document printing utility” application can be called by the following T-FLEX CAD command: 

Icon Ribbon 

 

 

Keyboard Textual Menu 

 
File > Print Documents  

 
 

To work with the application, make sure that it is running. By default, it is always started. If, however, the 

application is shut down for some reason (this can be instantly determined by the absence of the 

command in the textual menu), it can be loaded by the command AP: External Applications. When the 

application is running, the list of T-FLEX CAD toolbars contains an additional “Print Control” bar. 

The batch of documents will be composed on the basis of the document opened in the active window of 

the T-FLEX CAD upon invoking the print module. The pages of the base document correspond to the 
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print paper sheets. The images of the documents which need to be printed out are placed on these 

paper sheets. When carrying out the batch layout for printing, new pages can be automatically added to 

the base document, and also the settings of already existing pages can be modified. Thus, before calling 

the print module, it is recommended to create a new blank drafting which will become the basis for 

compiling the batch of documents. 

In the print module, only the pages of the base document having the type “Normal” are displayed and 

used. 

The documents selected as components of the batch are put into the base document as internal pictures 

with the preserved connection with the source files. 

Formation of the batch of documents is carried out in a separate window “Print documents”. This window 

is split vertically into two panes: the structure of the composed batch of documents is shown on the left, 

the window with the preview of the composed document is shown on the right. 

Formation of the batch for printing is usually performed in the following way: with the help of the 

commands of the textual menu and toolbar the documents which have to be included into the batch are 

indicated. A user can select the T-FLEX CAD documents and the documents of all graphics formats 

available for insertion in the command “IP: Create picture”. For the T-FLEX CAD documents added to the 

batch and multi-page pictures, it is possible to specify the pages which will be printed. 

The images of all documents included into the batch for printing, by default are placed on the current 

page of the base document. Afterwards, during the batch layout, the images are distributed in a rational 

way over pages of the base document. 
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The batch layout (creating new pages, modifying parameters of already existing pages, placing the 

images over different pages) can be carried out both manually or automatically with the help of the 

special command. 

The compiled batch of documents can be sent to a printer straightway or can be saved as the 

T-FLEX CAD file. 

Forming the Structure of Documents Batch 

For adding the document to a list, the following commands of the print module are used: 

Keyboard Textual menu Icon 

 File > Add Image from File… 
 

 File > Add Images from DOCs 
 

 
File > Add Image from Open 

Document…  

The command “File|Add Image from File…” allows a user to add arbitrary T-FLEX CAD documents to the 

batch, and also raster and vector images. When this command is invoked, the file selection window 

appears. 

When among the selected documents there is at least one multi-page document, the dialog window 

“Add Image” is opened additionally. The list of the selected documents together with the specified pages 

of the given documents as well as the area for the preview of the pages contents are displayed in this 

window. 

By default, in the dialog all pages of the selected documents are marked with the tick (next to the page 

name). If everything is left unchanged, after pressing [OK], the images of all pages of the selected 

documents will appear in the preview window of the print module. If for some page the tick is taken off, 

the image of that page is not put into the compiled batch of documents. To take off the tick, it is enough 

to point at the desired tick with the cursor and press . 
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Now the added documents will appear in the batch structure (in the left pane of the print module 

window). Note that if dimensions of the added image are larger than the dimensions of the current page 

of the base document, the system can automatically change the scale of the image so that it could fit on 

the page (the system actions will depend on the settings of the print module). 

The command File|Add Images from DOCs allows to add images from DOCs to the batch. The command 

is available only when an integration with DOCs is configured. For this purpose you need to run 

Customize >> Options >> T-FLEX DOCs and select any installed DOCs system from the drop-down list. 

The command “File|Add Image from Open Document…” allows a user to add to the composed batch the 

T-FLEX CAD documents opened at the present moment. After invoking this command, the window “Add 

Image” (analogous to the described above) with the list of the currently open documents and their pages 

will appear. 

Before closing the dialog “Add Image” the system checks if any changes were made in the open T-FLEX 

CAD documents (since the last save). 

If the unsaved modifications were found in any of these documents, the system displays the message 

with the prompt to save the given document. If the user denies saving, the given document can not be 

added (it will not be shown in the list of the documents in the window “Add Image”). 

After compiling the list of the documents of the batch (with the help of any command described above), 

additional customization of the batch can be carried out by taking off/setting on flags for any image in 

the batch structure. The images for which the ticks are taken off remain in the batch structure but will no 

longer be displayed in the preview window of the print module (and as a result will not be printed out). 

The tick controlling page visibility in the batch can be taken off/set on with the help of  or by using 

commands «Image|Show» and «Image|Hide»: 

Keyboard Textual menu Icon 

 «Image|Hide»  

 «Image|Show»  

When forming the structure of the documents batch, the following commands of the print module can 

be also used: 

Keyboard Textual menu Icon 

 Image > Dublicate…  

This command allows a user to “duplicate” selected images (from the list of the documents already 

added to the batch being formed). The images can be selected in the batch structure (in the left pane of 

the print module window) or directly in the preview window of the print module. The dialog in which the 

number of the copies being created will have to be specified appears on the screen. Thus, several copies 

of any image can be printed out. 

Keyboard Textual menu Icon 

 Image > Rotate  
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After invoking this command, the images of the documents selected in the list or in the preview window  

turn by 90 counterclockwise. 

Keyboard Textual menu Icon 

 Image > Delete  

This command removes selected images from the list of images of the composed batch. 

All commands for dealing with the images of the batch can be also invoked from the context menu of 

the image. 

 
Keyboard Textual menu Icon 

 File > Delete Document  
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This command allows a user to remove the selected document entirely from the structure of the 

composed batch. This command can be also called from the context menu for the document. 

 
Keyboard Textual menu Icon 

 File > Update Images  

This command allows a user to synchronize the contents of the base document in the main T-FLEX CAD 

window and in the print module. 

The document print module works in parallel with the main T-FLEX CAD window. This allows a  user to 

make changes in the base document concurrently in the print module and in the main T-FLEX CAD 

window. For example, simultaneously with the print module functioning, via the T-FLEX CAD window of 

the base document a user can modify the page settings, picture parameters or modify the documents on 

the basis of which the images have been created in the print module. As a result, the situation may arise 

when the print module lags behind in tracking down these changes. The command Update Images of 

Document is intended to resolve these situations. It removes all data on created images and used 

documents from the print module, and then restores this data according to the contents of the base 

document from the T-FLEX CAD window. 

Print Module Options 

Options of the print module are specified in the command Set Editor Options: 

Keyboard Textual menu Icon 

 View > Options…  
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This command invokes the dialog “Options”: 

The parameters group “Editor” defines general settings for 

dealing with the print module: 

Show Images. This parameter controls the display of the 

images in the preview area of the print module. When the 

flag is turned off, only the image bound box is displayed 

in the preview area. By default, this flag is turned on. 

Offset Step. This parameter defines the offset step for 

moving the images selected in the preview area with the 

help of the keyboard keys (<>, <>, <>, <>). The 

step size is specified in page units. 

Snap Distance (Pixels):. This parameter defines the 

maximum distance in pixels at which the sides of the 

selected images will be snapped to the sides of other 

images on page (horizontally and/or vertically). This 

parameter is taken into account when moving the image 

with the help of the mouse (recall that the images can be 

also moved with the help of the keyboard keys (<>, 

<>, <>, <>). 

 

Prompt to automatic Image adjustment if it does not fit on Page. This parameter defines the 

system response in cases when the image does not fit on the page of the base document (for 

example, when adding a large image). When this parameter is turned off, the system 

automatically moves and scales the images in such a way that they will fit on the page. When 

the parameter is on, the prompt about the necessity of image translation/scaling will be 

shown. 

The parameters group “Auto Layout” defines layout parameters: 

Use Image Rotation. Allows a user to apply rotation to the image by 90 degrees when selecting 

ways of the image placement. 

Distance between Images. This parameter sets the minimum allowable distance between the 

images after the layout. The distance magnitude is specified in the units of the corresponding 

page of the source document. 

Show Free Areas. If this parameter is turned on, the areas of the base document pages not 

occupied with the images are marked with green color after performing the layout. 

Delete Empty Pages. This parameter affects the work of the mode of layout of all pages in the 

print module. When this flag is enabled, pages, which after performing the automatic layout, 

ended up being empty (i.e., not containing any images) are automatically removed. When this 

flag is turned off, such pages remain in the structure of the print batch (they can be deleted 

manually afterwards). 
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Auto Layout of the Documents Batch 

For automatic layout of the images within the scope of one page, the following command is used: 

Keyboard Textual menu Icon 

 Layout > Layout Current Page  

This command distributes images placed on the current page within the scope of this page in such a way 

that they will not overlap with each other and occupy the least area. In case when the system is not able 

to place all images on one page, the message Layout errors appears with the list of “problem” images. 

For automatic layout of all images of the documents batch, the following command is used: 

Keyboard Textual menu Icon 

 Layout > Layout All Pages  

This command distributes the images of the batch over different pages of the base document. When 

carrying out the layout, the required number of the base document pages is automatically added. The 

size of the added pages will be the same as that of the last existing page of the base document. If after 

successful completion of the layout, the blank pages will still remain in the base document, they can be 

removed automatically (this operation is performed by setting on the flag “Delete empty pages” in the 

dialog of the print module options). 

The pages are not considered empty if they contain hidden images (images which were added to the 

batch for printing but for which the flags were taken off later in the batch structure). Such pages can be 

deleted only after removing hidden images. 

If the size of some image exceeds the size of both existing and 

automatically created pages of the base document, the dialog 

window “Error optimizing page Layout” will appear on the 

screen with the list of problem images. The flag “Change Image 

Size and Run Optimization Again” found at the bottom of the 

given dialog allows a user to choose further actions of the 

system. 
 

 

If this flag is disabled, after pressing [OK] the layout will be completed. The 

images which could not be placed automatically will have to be placed 

manually. 

When this flag is on, after pressing[OK], the dialog for page format 

selection, similar to that invoked by the command Page > Page Size…, will 

appear. By default, the smallest by area format which accommodates any 

visible images counting gaps is set in this dialog (see chapter “Print Module 

Options”). After selecting the format and pressing [OK], the dialog “Page 

parameters” is closed, parameters of all pages of the base document are 

automatically modified and the repeated layout is carried out.  
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“Manual” Layout of Documents Batch 

Print module allows a user to enter “manual” corrections into results of automatic layout: change location 

and size (scale) of images, their distribution over the pages of the batch, etc. 

 

To make the work with the created batch more convenient, the frames of all images in the preview area 

are marked with a certain color. Nonactive images (i.e., not selected for modification of position and size) 

are marked with a frame of dark-green (if they fit on the current page) or dark-red (if they do not fit on 

the current page) color. If the placement of the nonactive image could not be adjusted upon automatic 

layout, the color of its frame will be dark-red. 

 

Selected (active) image is marked by default with sky-blue color (the color is specified in the command 

SO: Set System Options, tab Colors, parameter 2D Elements Highlighting/Additional Color). In addition, 

at the corners of the frame of the selected image, square-markers are displayed. 

 

A user can select the image in the list or directly in the preview window with the help of . 
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When bringing the cursor to the borders of the frame of the selected image or to the markers at the 

corners, the cursor takes the form of a two-directional arrow ( ,  or ). If at this moment a user presses 

 and without releasing the pressed mouse button, moves the cursor, the image boundaries will move 

along with the cursor. After releasing the mouse button, the size of the image bound box will be 

modified (thus, the scale of the image view will be modified). The same result can be achieved if after the 

first click on , a user releases the mouse button straightway, moves the cursor to the desired place 

(corresponding to the desired location of the image bound box) and presses the  again. 

When moving the cursor, the scale magnitude is rounded off up to the second digit after the comma. A 

user can refuse to round off the scale by keeping the key <Ctrl> pressed while moving the borders of the 

image bound box. 
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In order to move the image over the page, after the image selection put the cursor in any place inside 

the image bound box. The cursor will take the following form: . Press  and without releasing the 

mouse button, move the cursor to the required place on the page. Also, another way of working with the 

dragger can be used here – if after pressing , the mouse button is released, the image bound box will 

start to follow the cursor motion. Second click on  will fix the image in a new place. 

When moving the image with the help of the mouse, the snapping of the selected image to the sides of 

other images on the current page of the document is performed (taking into account the value of the 

parameter “Editor/Snap Distance (Pixels)” in the options dialog of the document print module). 
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It is also possible to move the image with the help of the keyboard keys <>, <>, <>, <>. 

Selected image can be also moved to another page of the base document. To do it, point with the 

mouse inside the image bound box, press  and without releasing the pressed mouse bring the cursor to 

the tab of the desired page. The selected page will be automatically opened in the preview area. After 

that, it will remain only to place the image on that page and release the mouse button. If after the image 

selection,  a user presses  and immediately releases the mouse button, the translation will be completed 

after the second click of the  (already on the selected page of the batch). 

The scale, the placement page and the location of the selected image within that page can be also 

modified with the help of the command Edit Image Properties… 

Keyboard Textual menu Icon 

 Image > Properties…  
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Upon invoking this command, the dialog window “Image properties” with the parameters of the selected 

image is opened: 

 

Picture. This field carries picture ID in the base document of the 

batch. 

Source File. Path of the source file with the given image 

Displayed Page. This parameter indicates the page in the 

source document used for creating the given image. 

Page. This parameters shows the page of the base 

document on which the current image will be placed. 

The drop down list allows a user to select another page 

of the base document for placing the image. 

Location. Parameters of this group define the image 

location within the page of the base document. 

Size. This is the parameters group showing the real 

dimensions of the given image (taking into account the 

specified scale). 

 

Scale. Scale of the view of the current image on page of the base document. 

Rotate. When this flag is enabled, the image is turned by 90 (with respect to the initial position). 

This parameter is enabled automatically if the image was rotated upon the auto layout. 

For modifying scale and position of several images on one page at once, multiple selection can be used. 

For example, you can use selection with window (in the preview area) or successive selection with the 

help of <Shift>+  (<Ctrl>+  cancels your selection of the image). Note that multiple selection can be 

used only for images placed on one page of the base document. 

Selected images are marked with common frame. Modification of size 

(scale) and location of a group of images is carried out the same as 

when dealing with one selected image. 

In this dialog, the scale field will be left empty if selected images have 

different scales. If the scale magnitude is specified, then after pressing 

[OK] and closing the dialog, the specified value will be set for all 

selected images. If the field is left empty, the scale of the elements will 

not be changed. 
 

Invoking the command Edit Image Properties… when selecting several images at once makes the dialog 

window “Image properties” appear. In the title of this window it is shown to how many images the 

settings of this dialog will be applied. 
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Change of Parameters for Pages of Base Document. Adding/Deleting Pages 

To modify parameters of any page of the base document, the command Change Page Properties found 

in the print module is used: 

Keyboard Textual menu Icon 

 Page > Page Size…  
 

Upon invoking this command, the dialog “Page Properties” is opened. With 

the help of this dialog, you can modify the format (by selecting it from the 

list of the standard formats or by specifying desired width and height) or 

orientation of the current page of the base document. The flag “Apply to 

all pages” allows a user to apply specified settings of the given dialog to all 

pages of the base document at once. 

If needed, a user can add a page to the base document manually. To do it, 

the command Add new Page is used: 

 
 

Keyboard Textual menu Icon 

 Page > Add  

A user can delete the current page of the base document (under condition that it does not contain any 

images), with the help of the command Delete Current Page: 

Keyboard Textual menu Icon 

 Page > Delete Current Page  

Note that if on the apparently empty page there are hidden images (i.e., the images for which the flag 

next to the name has been taken off in the batch structure), then the removal of such image will be 

impossible. In this case the command Delete All Hidden Images can be used: 

Keyboard Textual menu Icon 

 Page > Delete Hidden Images  

This command removes from the document structure unused images located on the current page of the 

base document. After executing this command, the current page can be deleted. 

Printing Composed Batch of Documents 

A user can print out the composed batch of documents directly from the print module with the help of 

the following command: 

Keyboard Textual menu Icon 

 File > Print…  
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This command in turn invokes the command PT: Print Model. 

The composed batch of documents can be also sent to a printer from the main T-FLEX CAD window by 

calling the command PT: Print Model for the base batch of documents. 

PRINT 3D 

The Print 3D command activates STL export command: 

Keyboard Textual menu Icon 

<3PD> File > 3D Print..  

When exporting to the “Stereo Lithography” format, the geometrical shape of the 3D model surfaces is 

translated by faceting surfaces into a set of triangular elements. The accuracy of the surface 

representation depends on the three-dimensional mesh parameters. 

More information about export to STL can be found in “Exporting and importing documents” 

chapter. 

 



 

 

SERVICE COMMANDS AND TOOLS 
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ANIMATION 

Animation is an effective mechanism that helps designing products. Animation helps analyze the 

behavior of kinematic mechanisms and mutual situation of parts in assemblies. Animation creation is a 

logical continuation of developing a parametric model. It allows visually inspect the impact of parameter 

modifications on the shape and position of the objects in the 3D scene, model operation of kinematic 

mechanisms, record and analyze the process of exploding the parts of an assembly. This system 

capability is yet another advantage of using parameterization when creating separate parts as well as 

assemblies. Analyzing a parametric model by means of animation allows mitigating errors at an early 

stage of designing a product. Use of a movable camera in animation allows creating realistic clips 

supporting the effects of zooming in and out, and spinning the object being viewed. 

In animation, the system renders the state of the model under continuous modifications of its 

parameters. A requirement for creating an animation is presence of variables controlling the model 

parameters. For example, to have a part spinning with respect to a fixing point in animation, a variable is 

introduced whose value is equal to the rotation angle. In other words, the user must define variable 

parameters when building that model (geometrical shape or element positions) and assign the driving 

variables to these parameters. 

T-FLEX CAD has two means for creating an animation. The first and simple one is using the command 

AN: Animate Model. When animating using this command, one can vary the value of one variable from 

its starting to the ending value with a specified step. A more powerful means for creating animations is a 

stand-alone application Animation Screenplay. This application provides control over an unlimited 

number of variables in the model and drive variable variations by complicated diagrams. A T-FLEX CAD 

document can have any number of animation scenarios included within, representing various model 

modification schemes. 

ANIMATING MODEL BY COMMAND "ANIMATE MODEL"  
 

Drawing animation is implemented by a step-by-step modification to 

some parameter defined by a variable. The drawing is simultaneously 

redrawn at each step. 

Suppose, we have created a drawing of a kinematic mechanism. The 

drawing is assembled from fragments, each of which is a link in the 

mechanism. Now, we would like to view the behavior of the mechanism 

as the position of the driving link is varied.  
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The driving link position is defined by 

the parameter of a construction line 

defined as a line passing through a 

node at an angle to the horizontal. 

This parameter is the angle of 

rotation. 

One can assign a variable to drive this 

parameter. Let's call it “alpha”.  

To “animate” the mechanism, use the command AN: Animate Model: 

Icon Ribbon 

 

Tools → Animation → Animate 

Keyboard Textual Menu 

<AN> Parameters > Animate  
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When entering the command from the 

2D window, a dialog box with the 

command parameters is displayed on 

the screen. 

The parameters are as follows: 

Variable name. You can specify the 

name of the variable whose value will 

change. The variable’s name can be 

specified manually or selected from 

the suggested list. All real variables of 

the drawing are included in this list. 

The variable cannot be a text 

variable. 

Starting value. This is the starting 

value of the variable to vary.  

Ending value. The target value of the 

variable at the completion of the 

command. 

 

Step. The increment value added to the variable at each step of the animation. 

Clear screen. With this option set, the screen will be redrawn at each step. Otherwise, the images 

will be overlapping to show the progress of the movement and drawing modifications at each 

step. 

Change color. With this option set, the image at each step will be displayed in its own color. This 

option is useful when you want to compare results when varying the values of different drawing 

parameters. 

Pause. With this option set, the system will require confirmation at each step, before drawing 

another frame. 

Generate Metafile. With this option set, the animation clip will be saved in a T-FLEX CAD metafile. 

This metafile can later be output to a printer or plotter, included in a T-FLEX drawing using the 

command “IP: Insert Picture” or exported into another format. Note, that with the “Clear screen” 

mode turned on, a metafile will not be output. 
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Save Report. With this option set, the result of animation at each step will be output in a log file 

(the filename must be specified in the operation parameters). This parameter is available only 

when the model has at least one report template, defined in the command REP: Create Report. 

Generate multimedia file. Setting this option allows creating an *.avi file and defining its 

parameters:  

File name. 

Number of frames per second. The recommended frequency is 24 frames per second. 

The graphic button [Compression…] for the *.avi format invokes the dialog box for customizing 

multimedia file compression parameters: 

Compressor. Selects a compressing application. 

Compression Quality. Defines the quality grade for 

multimedia file compression. 

Key Frame. Defines the number of frames between the 

key frames. 

Data Rate. Defines the data transfer rate (kilobytes per 

second).  

The graphic button [Configure…] brings up the dialog box for entering the required settings of 

the selected compressing application. 

Video quality parameter is available for the *.wmv format. 

 

You can specify sizes for the video in the Size group. 

Use current view size. With the flag turned on, the whole contents of the current 3D view window is 

recorded. With the flag off, the user can define one's own width and height parameters of the image 

being saved. 

 

is specified the video size will be equal to the T-FLEX CAD window size. 

 

To interrupt a running animation, press <Esc>. 
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Returning to the above example, let's define the first four 

parameters. 

The specified values realize the variation of the “alpha” 

variable from the value “0” to “360” with the step equal to 

“10”. The drawing will be displayed at each step.   
 

Press [OK], and the result shown on the right hand side 

diagram will soon be displayed on the screen. 

By performing these steps on your computer, you will see 

the drawing “animate”.  

Consider a few more examples. In those, several variables 

are made dependent on the driving variable, which results 

in an interesting behavior.   

An animation of the drawing of a cutting tool appears as if “machining” of a cog wheel: 

 

 

Next is the example of a drawing that creates a function diagram by using animation. 

              

What was entered in the variable editor is as follows: the variable “h” is equal to “10”, and the variable 

“l” is defined by the expression “^1.2/Cos(h)”. 

Note, that when calling the command AN: Animate Model while in the 3D window, the animation 

parameters dialog box has a slightly different appearance. In this case, to create a multimedia file, one 

needs to define the following groups of parameters: 

You can select one of three variants in the Photorealistic view generation section. 

Non-photorealistic rendering – the exploded view scenario is recorded according to the current view 

in 3D scene. 

The following variants are used for photorealistic view creation. Each frame of the video is processed 

using selected photorealistic view mechanism. 
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Photorealistic rendering using OptiX – the video is created using NVIDIA OptiX mechanism. 

Photorealistic rendering using Embree – the video is created using Embree mechanism. 

You can set Image quality and Number of Ray Tracing iterations for the previous two variants. 

 

Photorealistic rendering using POV-Ray – the video is created using the POV-Ray mechanism. 

You can find more information about photorealism in “Photorealistic view” chapter. 
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View point. Defines the position and direction of the animation recording camera. 

Use current view point. The view point is defined by the system camera present in any 3D window by 

default. 

Use camera. The other possibility is specifying a user-defined camera. 

"ANIMATION SCREENPL AY"  APPLICATION  

This application is intended for making animations of 2D drawings and 3D models. Creation of the 

animation screenplay implies defining a dependency of several variable values in time. Such 

dependencies are introduced in the form of diagrams. Each diagram is represented in the time and 

variable value coordinates. 

The animation functionality allows controlling parameter values and viewing or recording in a file the 

dynamically changing state of the model. The application is activated via the command “AP: External 

Applications”. If the application is running, then it can be called similar to other system commands: 

Icon Ribbon 

 

Tools → Animation → Animation editor 

Keyboard Textual Menu 

 
Parameters > Animation editor  

Let's review the general scheme of using the application when creating an animation screenplay: 

1. Forming diagrams of each variable’s time dependency (defining the minimum and 

maximum values of the respective variable; setting points on the diagrams defining the 

variable values at specific moments in time).  
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2. Setting animation options and creating a multimedia file (*.avi). 

3. Starting the animation and viewing the results. When forming an animation, the system 

defines the number of animation steps per the specified animation time range and 

increment. Then, the variable values are subsequently read from the created diagrams at 

each step, and the model is regenerated with the current set of parameters. The results of 

the animation can be recorded (if necessary) in a multimedia file (*.avi).  

Note that the animation screenplay functionality is 

accessible only when the document has at least 

one variable that is not a textual (string) variable. A 

T-FLEX CAD document may contain several 

animation screenplays, defining the different ways 

of modifying variables. Upon calling the 

application, the dialog box is displayed on the 

screen for entering the name for a new screenplay 

([New]) or selecting an existing one. If an existing 

screenplay is selected then the provided graphic 

buttons allow running, recording or reviewing the 

animation defined by this screenplay, or proceed 

with editing ([Open]) or deleting ([Delete]) the 

data. 
 

Editing of an animation screenplay is done in the dialog box “T-FLEX CAD Editor of Animation Frames”.  

The dialog box is invoked by pressing the graphic button [Open]. The variations of each variable are 

defined as separate diagrams. The left pane of the dialog box keeps the list of the model variables, their 

values and comments. Driven variables (defined by a function or an expression) are displayed on a 

different background (particulars of handling those will be described below).  
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Creating New Diagram 

Click the desired line in the variable list with the mouse, and then select the following option in the 

context menu or under the “Diagram” menu entry: 

 <Ins> Add Window With Diagram For Selected Variable 

A dialog box will appear next for defining the diagram parameters. The default range of the variable 

values is set from ½ to 1½ of its current value.  

In future, the specified values can be modified using the option: 

 <C> 
Set Diagram And Its Window Properties For Selected 

Variable 
 

The “Load from file” flag allows reading in an existing 

diagram saved in a file (*.tfg). The “Color” and “Background” 

define the color of the diagram and its background window. 

Upon confirming the diagram parameters, it's pane opens. 

The ruler on the left side of the diagram pane represents the 

scale for the variable values, while the one on the top side 

of the diagram pane reflects the time scale. Both scales 

reflect the defined range is of the values (the default time 

interval is from 0 to 60 seconds). At the beginning, the 

variable diagram is a constant equal to the current variable 

value. The user can now add an arbitrary number of points, 

defining the variation of the variable values along the 

specified time interval. 

If the screenplay already has another variable diagram in the 

window, then upon selecting a variable, the following option 

becomes available: 

 

 

 <G> 
Add Diagram For Selected Variable To Active 

Window 

The current window is outlined by a frame, whose color is defined by the parameter “Active window 

color” per the option: 

  Change Current Screenplay Name 
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To select the current window, point the mouse to the desired diagram and click . The option of adding 

a variable to the current window allows overlapping several diagrams in one coordinate space. If several 

diagrams are present in one window, the last modified diagram is considered selected. Its line is thicker, 

and the respective entry is highlighted in the list of a variables. A diagram sharing the window with other 

diagrams can be moved to a separate window using the option: 

  Move Active Diagram Into New Window 

Adding/Modifying Diagram Points 

As the pointer moves inside the diagram window, its current coordinates are displayed in the lower right 

corner. Upon clicking , a new node is created under the pointer position, and is connected by straight 

segments with the neighboring points in the diagram. To create a new node dividing an existing 

segment of the diagram in the two, point the mouse to the diagram line and select the item “Add Node” 

from the context menu. 

     
 

To modify the node position, point the mouse to it 

(the mouse pointer will change its appearance). Then, 

dragging the mouse with the  depressed, place this 

node of the diagram in a different position. To 

specify the exact node coordinates, right click , 

select in the coming up automenu the item 

“Properties” and enter the values for the Т- and Y-

coordinate. 

In the case of multiple selection of the nodes in the 

diagram, the selected group of points can be 

translated: 

 

 

 

 <M> Transfer Selected Nodes 

Upon selecting this option, a dialog box appears for inputting the shift values along the Т- and Y-axes. As 

a result, the selected group of points will change its position per the specified values. 

Adding points to a diagram can also be done using the option: 

  
Cut Selected Nodes Of Active Diagram And Put Them 

Into Clipboard Or File 
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Copy Selected Nodes Of Active Diagram Into 

Clipboard Or File 

  
Paste Nodes With Positioning Into Active Diagram 

From Clipboard Or File 
 

Use of these options implies existence of least one diagram 

with two nodes. Select several nodes (those will be 

highlighted) and pick one of the options, “Cut” or “Copy”, in 

the control toolbar. Then select the fixing node for inserting 

the selected fragment of the diagram and pick the option 

“Paste”. Thereafter, the “Insertion” dialog box appears. 

Besides the Clipboard, a source for insertion can be a diagram 

saved in a file (*.tfg). The insertion particulars are defined by 

the fixing node of the diagram fragment being inserted (“Left 

Node”, “Right Node”) and by the number of insertions. If the 

flag “Symmetrical, horizontal” is set, then the insertion 

fragment will be a copy of the original mirrored about the 

vertical line passing through the fixing node. 

 

     

The leftmost picture shows the highlighted points of the diagram fragment being copied to the 

Clipboard. The second picture shows the insertion with the option Left Node, the third one - that 

with additional use of the flag Symmetrical, horizontal. 

In the case when the time span of the diagram fragment being inserted is greater than the time interval 

of the remaining portion of the diagram to the right of the fixing node (when using left node fixing), or 

to the left of the fixing node (for right node fixing), the system aborts the insertion operation. This is 

done to prevent violation of the time segments order. 

To add nodes to the selected diagrams at the point of the intersection with the main ruler, that defines 

the current time instant (highlighted in blue), use the option: 

  
Add Nodes To Selected Diagrams By Time Axis Of 

The Main Ruler 

Upon calling the option, a window appears containing the list of variables for each of the existing 

diagrams.  
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The column Value contains the variable values at the current time 

instant. Check the variables in the list, whose diagrams are to be 

added nodes. Upon pressing the [OK] button, new points will be 

created in the respective diagrams at the point of the intersection 

with the time main ruler marker. 

Setting the flag Use values of variables from model positions the 

new nodes along the time main ruler, using the variable values 

defined for the model. In this case, the new node is connected by 

straight segments to the neighboring points in the diagram. 

 

This capability allows defining diagrams by modifying variables in the model and then adding nodes with 

their values at the certain time instant. 

Selecting Diagram Nodes 

Point the mouse at the desired node and click  – the point on the diagram will be outlined by a box. 

Multiple selection is done by one of the following means: 

- With the <Shift> key held down, a sequence of nodes is selected between the two specified 

ones; 

- With the <Ctrl> key held down, the directly picked nodes are selected. 

Selection of all nodes in the diagram is done by the option: 

 <Ctrl><A> Select All 

The option is called from the context menu over the diagram area. 

Box selection of a group of nodes is done with the option turned on: 

 <S> Select Group Of Diagram Nodes 

Deleting Diagram Nodes 

The following option is provided for deleting selected nodes: 

 <D> Delete Selected Node Or Group Of Nodes 

The option is available under the menu entry Edit or from the context menu. Once a node(s) is deleted, 

the neighboring points in the diagram are connected by straight segment. 

Smoothing Diagram 

Upon adding new nodes, the diagram is formed as a polyline. If necessary, you can obtain a smooth 

curve by replacing the polyline segments by curved segments. To do this, point the mouse to the desired 
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segment in the diagram and right click , and then select the item Bezier Curve. Two nodes will appear 

on the selected segments dividing it in equal parts. 

      

The segment can be transformed into a curve by modifying the position of each node.  

      

The reversed transformation of a curve segment into a straight segment is done by the command 

“Straighten”, available in the context menu upon its selection. 

Grid 

To apply vertical and/or horizontal ruler lines in the diagram pane for easy orientation in the coordinate 

space when constructing diagram points, use the option: 

  Construct Grid Of Rulers In Active Window 

The respective flags in the Grid dialog box control the presence of vertical and horizontal rulers. For each 

type of ruler, the following parameters are defined: 
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Start Time, T. Defines the position of the first ruler; 

Number of rulers. Defines the number of rulers; 

Step by time, T. Defines the distance between rulers. 

To define a ruler crossing at a point with specific coordinates, use the option: 

 <R> 
Define Ruler Crossing For Diagrams In Active 

Window 

The option is provided under the menu Edit. To add an individual vertical of horizontal ruler, set the 

mouse pointer at the image of the scale (time or variable), and click . In the coming up menu select the 

item Ruler and specify the point on the scale, for the ruler being created to pass through. 

Driven Diagrams 

If the model has variables defined by functions or actions, then it is possible to obtain a special type of a 

diagram – “driven”. Since the values of such variables are dependent values, the system creates their 

diagrams automatically. The lines corresponding to the dependent variables in the list of the animation 

screenplay dialog box are grayed out. A “driven” diagram cannot be edited; it merely illustrates the 

variation of the variable during an animation. Note that a driven diagram is regenerated upon starting an 

animation. This type of a diagram can be used for analyzing mutual positions of various model elements. 

A variable can be created for this purpose, whose value would be the function of the distance measured 

between two bodies, vertices, etc. When modifying the model parameters, the diagram of such a variable 

will reflect changes in the distance concerned. 
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General Animation Parameters 

Besides the described above, a number of options are available in the toolbar and under the “Edit” menu 

entry. 

 <T> Set Limits For Time Scale 

This option sets the limits of the Time axis portion visible in the diagram pane. 

  Change Current Screenplay Name 

This option allows saving the current screenplay under a different name and/or change the color of the 

outlining frame highlighting the active diagram window (the parameter Active window color). 

  Save Active Diagram To Text File 

This option allows saving the current diagram or the selected nodes in a text file (*.tfg). In future, the file 

contents can be inserted into another diagram or another screenplay. 

 <F7> Update List Of Variables For The Current Model 

This option reloads the changes in the model variable list.  

 <Alt>+<P> Set Parameters For.avi File 

This option allows defining the parameters for recording an .avi file. The parameters are the same as the 

respective ones in the command AN: Animate Model. 

 <Alt>+<A> Set Limits, Step And Delay For Playing Animation 

This option defines the values of the following parameters: 

Start time, Т. Defines the time instant from which the animation should begin. 

End time, Т. Defines the time instant at which animation ends. 

In real time. With this flag set, the 

animation is performed in real time.  

The latter option means the following. 

At the beginning, the model is 

regenerated with the variable values 

defined for the starting instant of the 

animation. The next set of values 

corresponds to the instant when the 

first model regeneration completes. 

Therefore, in this case, the animation 

step is actually the duration required 

for the model regeneration. 
 

Animation step, Т. Defines the time step for sampling the variable values. 
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Delay, sec. Defines delay after each step of the animation. 

  
Do Not Use Variable Values From Diagram In 

Animation 

This option allows excluding a variable variation diagram when forming an animation (in this case, the 

above icon appears before the variable name in the variable list). A repeated call to the option removes 

the variable diagram block. 

Zooming Diagram Window 

When working with the diagram, it is often necessary to change the scale of the diagram image. The 

listed below options allow manipulating the drawing image in various ways. 

 <Ctrl>+<T> Zoom In By Time Scale 

Two points specified by clicking , define the boundaries of the new interval on the Time scale. 

 <Alt>+<T> Zoom Out Active Window By Time 

This option results in doubling the current interval on the Time scale. 

 <Ctrl>+<Y> Zoom In By Values Scale 

Two points specified by clicking  define the boundaries of the new interval on the Value scale. 

 <Alt>+<Y> Zoom Out Active Window By Values Scale 

This option results in doubling the current interval on the Value scale.  

 <Z> Zoom Window 

Two points specified by clicking , define the box diagonal. The vertical and horizontal size of the box 

area in the window defines the displayed intervals on the Time and Value scales. 

 <Ctrl>+<PgUp> Zoom In Active Window 

Doubles the current intervals along the Т and Y-axes.  

  <Ctrl>+<PgDn> Zoom Out Active Window 

Halves the current intervals along the Т and Y-axes. 

 <Ctrl>+<G> Zoom All Diagram Nodes For Active Window 

This option pans/zooms the current window in such a way to fit all the existing diagrams in this window.  
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Manipulating Animation 

The following graphical buttons are located in the bottom portion of the animation screenplay dialog 

box (alternatively, those are accessible under the “Diagram” menu entry or from the context menu, 

invoked over the list of variables): 

 <Del> Delete Diagram For Selected Variable 

This option is available for variables with existing diagrams. It deletes the diagram of the current variable. 

 <Ins> Add Window With Diagram For Selected Variable 

This option is available for variables without diagrams. It creates the variable diagram in a new window. 

 <P> Apply Current Variable Values For Animation 

This option regenerates the T-FLEX CAD model with the variable values per the diagram readings at the 

current time instant. The current time instant is set using the time ruler (highlighted in blue on the Time 

scale). As the Time ruler is moved, the variable values are automatically updated in the list. 

 <A> 
Animation In T-FLEX CAD On The Current Values Of 

Variables 
 

This option starts executing the animation. A sequence of the 3D 

model (drawing) modifications is displayed, reflecting the model 

regeneration per the variable values defined in the screenplay. The 

animation execution is controlled by the buttons [Pause/Continue] 

and [Stop] in the “Animation” window.  
 

 <F> Save Animation To File(*.avi) 
 

This option is for recording an AVI-file. Upon starting the 

recording, the system offers to select a compressing application of 

the video image. The “Video compression” dialog box allows 

selecting one of the installed applications on your computer and 

setting its parameters. 

 
 

 <V> Play Video (*.avi) File For The Current Screenplay 

This option plays back the recorded AVI-file. 

Animation helps visually illustrate the influence of parameter modifications on the shape and/or spatial 

situation of the objects, model the function of kinematic mechanisms and check permissible ranges of 

the variable values. 
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EXAMPLE :  CLOCK T ICKING ANIMATION  
 
 

A simple and instructive example of using animation for 

simulating a mechanism motion can be a model of a 

clock. This model is provided with the library 

“Examples”, the folder “Additional 

resources\Animation\Watch”. The model contains 

an animation screenplay, modeling a working clock: 

moving arms and changing date. 

To animate the model, the variables “a” and “Date” are 

introduced. The variable “a” defines the current time in 

seconds (it will drive the position of the clock arms), 

while the “Date” variable – the figure displayed in the 

date dial of the clock. 

The clock arms and the date dial are 3D fragments. Since 

the arms are supposed to rotate in the animation, each 

arm fragment has an angle parameter defining the angle 

of rotation with respect to the Z axis via an expression 

dependent on the variable “a”: for the seconds arm it is “-

6*a”, for the minutes one - “-a/10”, and for the hours – “-

a/120”. 

The date dial fragment must update the displayed figures 

during the animation. For this purpose, an external 

variable “Date” is created in the fragment, defining the 

numeric figures in the fragment. Upon assembling the 

fragment, this variable is commanded by its namesake in 

the assembly. 

The  animation is supposed  to simulate the time from 

23: 55 to 0:01. During the animation, besides the arms 

motion, the date shall change on the date dial (at the 

midnight). 

Therefore, two independent variables, “a” and “Date”, 

shall vary their values. The model is “animated” by the 

Animation Screenplay application, taking into the 

account this mentioned feature. 

 

 

 

 

The “Clock” animation screenplay uses the variation diagrams for the variables “a” and “Date”. The 

animation time interval T is assumed from 0 (5 minutes before midnight) to 360(1 minute of the 
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midnight). The time T=300 corresponds to the midnight, that is the moment of changing date. The 

variable diagrams are created according to the following tabulated values: 

T 0 300 360 

a, 0 -300 0 60 
 

T 0 300 360 

Date 31 31/1 1 
 

 

 

The animation parameters define the necessary interval and step of the time variation. The step T=1 

corresponds to the clock arms motion with the beat rate of one second. 
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Now, start running the animation using the option , and you will see a 

“live” model of the clock on the screen: the arms moving and the date 

changing from the 31st to the 1st at “midnight”. The pictures on the right hand 

side show some snapshots of the animation corresponding to the time instants 

reflected on the diagrams. 

For viewing the animation “in the real time”, check the respective flag among 

the animation parameters. The animation step will then be the time of the 

model regeneration. The arms movement in this case may not correspond to 

the normal clock arms movement. 
 

 

When creating a video clip, the image playback speed depends on two 

parameters: the animation step and the frame frequency. In this particular 

example, the natural clock ticking can be obtained by specifying the 

animation step equal to T1/N, where T1 is a portion of the animation 

corresponding to the seconds arm advancing by one notch, and the N is the 

number of frames per second defined in the parameters of the video clip 

recording. 

 

EXAMPLE :  D ISASSEMBLING A PY RAMID  

Another example of animation is the animation of taking apart a toy pyramid.  

The 3D model of the pyramid is located in the library “Examples”, the folder “Additional 

resources\Animation\Pyramid”. 

 

The model of the pyramid is made of a base with a pole, stacked up four rings, and a topping. When 

disassembling, the base stays still, while the rings and the topping are “undone” one by one from the 

base and put around. 
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To achieve this, the shifts from the axes for the respective 3D operations are defined by variable-based 

parameters. The variables Z_1, Z_2, Z_3, Z_4, Z_5 will define the shifts along the Z-axis, corresponding to 

the vertical movement of the rings (along the axis of the pole). The variables XY_1, XY_2, XY_3, XY_4 and 

XY_5 describe the movement of the rings and the topping in the horizontal plane along the X- and Y-

axes (removal of the rings off the base). 

 

Such a large number of varied variables require use of the Animation Screenplay application. 

 

Let's define the diagrams for the model variables varying with time in the animation screenplay. Two 

diagrams correspond to each body being moved (for the topping, those are the diagrams of the 

variables Z_5 and XY_5, for the blue ring – the diagrams Z_4 and XY_4, etc.). One of those defines the 

object moving in the vertical plane, the other one - in the horizontal. The diagrams are designed in such 

a way, that each ring first moves up along the pole (the values of the respective variable Z in the diagram 

increase). At reaching the top of the pole (the flat portion of the Z variable diagram), a ring starts moving 

in the horizontal plane at some distance from the base (the growing portion of the respective variable XY 

diagram), and then goes down (the descending portion of the Z variable diagram). The rings start 

moving sequentially with the time delay interval of T=2. 
 
 

Once all diagrams are created, let's define the animation parameters: the interval T from 0 to 25 (the last 

ring finishes its movement at the time instant T=23), and the step equal to 0.25. 
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Upon starting the animation, the process of taking the pyramid apart will be simulated on the screen. The 

pictures below show certain animation stages corresponding to the time instants shown on the diagrams. 
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T = 7.25 
 

 

T = 11 
 

 

T = 15 
 

 

T = 24 
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PREVIEW/SLIDE 

Preview is a vector graphic (T-FLEX CAD Metafile) or bitmap (Windows BMP) image of an arbitrary size 

saved together with the drawing file. It serves for quick previewing of the document contents in the 

preview window, when opening the document or inserting it as a fragment, a picture or a 3D picture. 

You can find out whether the preview is available within the given drawing file, when the 

document appears in the window “Library Explorer”, by picking the item “Properties” from the 

context menu invoked by the . 

Document icon – small, raster picture of fixed size (16x16, 32x32, 48x48 or 64x64 pixels). It is displayed on 

the tab of the open document, in the list of documents found in the Library Explorer. 

The mode of automatic preview and icon creation can be set in the command ST: Set Document 

Parameters on the tab Save. 

CREATING PREVIE W  

The command PV: Save Preview is provided for creating a preview. The command is called by one of the 

following means: 

Icon Ribbon 

 

Tools → Special Data → Preview 

Keyboard Textual Menu 

<PV> Tools > Special Data > Preview 

 

Upon calling the command, a dialog box appears on the screen. 

This dialog box serves for creating a preview (in the BMF or 

BMP format), importing a preview from an external file and 

exporting a preview into an external file. 

A preview (bitmap) stored in an external file can be edited using 

a graphic editor, such as “Paint”. 

Creating preview in the T-FLEX CAD Metafile (BMF) format is 

possible only upon invoking the command from 2D window. 

Such preview is created on the basis of the image of the active 

2D page of the current document. The area of the page, the 

image of which will copied into the preview, can be determined 

by the system automatically or specified by the user. 

 

For automatic determination of the area of the drawing for which preview is created, the flag Save 

Automatically should be enabled. The state of the toggle below the flag determines how the 

system will select the area: 

By Window Size. The preview image is created by the image of the current 2D window; 
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Maximize Image (By image size). The preview image is generated by the whole image of the 

current page of the drawing; 

By Paper Size. The preview image is created by the image of the drawing found itself within the 

drawing border  of the given page. 

After turning on the flag “Save automatically” and setting up the desired toggle state, it is enough 

to press [OK] and the preview will be created in the current document. 

To manually specify the area of the drawing, the flag Save Automatically should be turned off. In 

this case, after pressing[OK] and closing the dialog window “Preview”, in the 2D window it is 

necessary to  specify the rectangular domain of arbitrary size. To do it, bring the cursor to one of 

the corners of the intended rectangle and press , then bring the cursor to another corner and 

press  again. After that, the preview creation will be completed. 

Preview in the raster Windows Bitmap (BMP) format can be created when invoking the command 

both from the 2D or 3D window. As in the previous case, the preview is created on the basis of 

the whole image or part of the image of the active 2D page. The used area of the page can be 

determined by the system automatically or specified by the user. 

The size of the created raster picture (in pixels) is specified via the group of parameters Bitmap 

Size. The same parameters determine the dimensions of the rectangular box which is used for 

specifying manually the area of the drawing for creating the preview. 

Creating preview with automatic determination of the area of the drawing is carried out in the 

same way as for the BMF format: it is necessary to set on the flag Save Automatically, select the 

desired approach for determination of the area of the drawing and press[OK].  

For manual specification of the area of the drawing, the flag Save Automatically should be turned 

off. After pressing [OK] and closing the dialog window of the command, a rectangular box 

attached to the cursor will appear on the screen (its size will coincide with the size of the picture 

being created). To create preview, bring the box to the desired area of the 2D window and press 

. 

The settings of the command ST: Set Document Parameters can be disabled in favor of the 

described command settings. This will happen if you use the value “None” or “Auto” in the Save 

combo box on the tab Save of the command ST: Set Document Parameters. Upon confirming the 

parameter settings, a message would be displayed that the preview would be created manually. 

The preview created in the current document can be exported to the external file of the BMF or BMP 

format (according to in which format the preview of the current document was created). And vice versa, 

any picture from the external file of the BMF or BMP format can be imported to the current document. 

To do it, after invoking the command, select in the list the required operation (PV: Save preview), and 

then in the appeared standard window for saving/opening files specify the name of the external file. 

The preview saved in the external file of the BMP format can be edited by using tools of any graphics 

editor. 
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CREATING ICONS  

To create the document icons, there is a command IC: Create/Edit Document Icon: 

Icon Ribbon 

 

Tools → Special Data → Icon 

Keyboard Textual Menu 

<IC> Tools > Special Data > Icon 

 

After invoking this command, the dialog window Document Icon is opened. In the field Icons of this 

dialog, there is a list of icons created in the current document. After selecting the icon in the list (with the 

help of  ), in the preview area (to the right of the list) the image of the selected icon appears. If there 

are no icons in the current document, the list will be empty. 

 

Recall that icons can be created automatically. The regime of automatic icon creation is set in the 

command “ST: Set Document Parameters (tab Save). 

To create an icon in the current document, the buttons [Add] (“manual” 

creation of icon image) or [From Drawing…] (automatic creation of icon 

image) can be used. When pressing any of these two buttons, the dialog 

appears in which a user will be prompted to select the size of the created 

icon: one of the standard values (16x16, 32x32, 48x48, 64x64 pixels) or 

arbitrarily specified size.  

Large icons (of size 32x32, 48x48, 64x64 pixels) can be used in the 

windows of the T-FLEX CAD libraries. 

After selection of the icon size with the use of the button [Add], the 

window of the icon editor (see below) is opened. 
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When the button [From Drawing...] is used, the command response after selection of the icon size 

depends on which way the command IC: Create/Edit icon was invoked. In case it was invoked while the 

2D window was active, the window of the command gets closed temporarily, and the rectangular box 

snapped to the cursor appears on the screen. The box allows a user to select the area in the 2D drawing 

on the basis of which the icon image will be created. If the command was invoked from the 3D window 

of the system, then the icon image will be created on the basis of the contents of the entire 3D window 

of the current document. 

There is one more button in the command dialog which allows a user to create icons – button [Auto 

Create…]. This button creates all four icons at once (of size 16x16, 32x32, 48x48, 64x64 pixels). The icon 

image is specified in the same way as when using the button [From Drawing…]. 

In addition to creating icons, in the command 

IC: Create/Edit Document Icon it is possible to edit and 

remove already existing icons. To edit the icon, select it 

in the list (with the help of ) and press the button 

[Edit]. As a result, the window of the icon editor will be 

opened in which the current icon image can be 

modified. 

To remove already existing icon, it is enough to select it 

in the list and press the button [Delete]. 

The button [Export…] allows a user to save all created in 

the current document icons in one external file of the 

“*.ico” format. With the help of the button [Import…], it 

is possible to load the icons from the external file.  
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EXPORTING AND IMPORTING DOCUMENTS 

T-FLEX CAD allows exporting its 2D drawings and 3D models into other graphical system formats.  

Exporting from T-FLEX CAD is supported for the following formats: 

Only for 2D drawings: 

 Windows Metafiles (*.wmf); 

 Enhanced Windows Metafiles (*.emf); 

 AutoCAD files (*.dwg); 

 AutoCAD DXF files (*.dxf); 

 AutoCAD DXB files (*.dxb); 

 T-FLEX CAD Metafiles (*.bmf); 

 T-FLEX CAD Metafiles without hidden lines (*.bmf). 

For 2D drawing and 3D models: 

 Raster Image (*.bmp, *.jpg, *.gif, *.tif, *.tiff, *.png); 

 Files in PDF format (*.pdf) 

Only for 3D models: 

3D documents 

 Parasolid files (*.xmt_txt); 

 Parasolid Binary files (*.xmt_txt); 

 STEP (*.stp, *.step); 

 IGES ЗD (*.igs, *.iges); 

 JT (*.jt) 

 ACIS (*.sat, *.sab) 

 PRC (*prc); 

Mesh geometry 

 AutoCAD DXF 3D files (*.dxf); 

 Stereo Lithography (*.stl); 

 PLY files(*.ply); 

 OBJ files(*.obj); 

 VRML 2.0 files (*.wrl); 

 U3D files(*.u3d); 

 X3D files (*.x3d); 

 POV-Ray (*.pov); 
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 Open Inventor files (*.iv); 

 Rhino Model (*.3dm); 

 IFC (*.ifc); 

 3MF (*.3mf); 

 T-FLEX Scene files (*tf3d). 

Importing in T-FLEX CAD is supported from the following formats: 

Only for 2D drawings: 

 AutoCAD files (*.dwg); 

 AutoCAD DXF files (*.dxf); 

 AutoCAD DXB files (*.dxb). 

Only for 3D models: 

 Parasolid (*.xmt_txt, *.x_t, *.x_b, *.xmt_bin); 

 AutoCAD DXF 3D/DWG 3D (*.dxf, *.dwg); 

 STEP (*.stp, *.step); 

 IGES ЗD (*.igs, *.iges); 

 ACIS (*.sat, *.sab); 

 SolidWorks (*.sldprt, *.sldasm, *.sldlfp, *.asm); 

 Autodesk Inventor (*.ipt, *.iam); 

 Siemens NX (Unigraphics) (*.prt); 

 Creo (ProE) (*.prt, (*.prt.*, *.neu, *.neu.*, *.asm, *.asm.*, *.xas, *.xpr); 

 Catia V5 (*.CATPart, *.CATProduct, *.CATShape); 

 Catia V4 (*.model, *.dlv, *.exp, *.session); 

 Solid Edge (*.asm, *.par, *.psm, *.pwd); 

 Rhino (*.3dm); 

 I-Deas (*.arc, *.unv, *.mf1, *.prt, *.pkg); 

 VDA-FS (*.vda); 

 JT (*.jt); 

 PRC (*.prc); 

 3dxml (*.3dxml); 

 CGR (*.cgr); 

 U3D (*.u3d); 

 IFC (*.ifc). 

3D Images 

 TF3D (*.tf3d); 
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 Open Inventor (*.iv); 

 AutoCAD (*.dwg, *dxf, *.dxb), 

 VRML 2.0 (*.wrl); 

 X3D (*.x3d); 

 3DS (*.3ds); 

 PLY (*.ply);  

 OBJ (*.obj); 

 STL (*.stl). 

When porting models from T-FLEX CAD to other systems and from other systems to T-FLEX CAD, 

you are strongly advised to prefer the STEP to the IGES format whenever possible as the more 

advanced one. 

 

An additional license is required to import in the Creo/ProE, Catia V5, Catia V4, I-DEAS formats. 
 

Besides the above-listed formats, the 3D configuration of the system supports import of *.x3d, 

*.ply, *.obj, *.3ds, *.dxf, *.tf3d, *.stl files, VRML 2.0 (*.wrl), AutoCAD (*.dwg, *dxf, *.dxb) and Open 

Inventor (*.iv) files by the command 3I: Insert 3D Picture. This capability is described in details in 

the chapter “3D Pictures” of the Three-dimensional Modeling User Manual. 

 

Documents of raster images in formats *.bmf, *.bmp, *.jpg, *.jpeg, *.gif, *.dib, *.pcx, *.tga, *.tif, *.tiff, 

*.png, .grb drawings, Windows metafiles (*.wmf and *.emf)  may be inserted into a 2D drawing 

with the help of IP: Picture command. 

EXPORTING DOCUMENTS  

Exporting T-FLEX CAD documents into other system formats is done by the command EX: Export 

Drawing Or Model: 

Icon Ribbon 

 
 → Export 

Keyboard Textual Menu 

<EX>  or 

<Ctrl><W> 
File > Export 

After calling the command, the dialog with formats available for export appears. You should select one 

and press [Export] button on the top of the screen. 
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Next, depending on the selected export format, either the file will be saved at once (as in the formats: 

Windows Metafiles, Enhanced Windows Metafiles, T-FLEX CAD Metafiles, Metafiles without invisible 

lines), or additional parameters, described below, must be specified (for all other formats). 

AutoCAD System Formats: DXF, DXB, DWG 
 

When exporting 2D drawing into one of the 

AutoCAD system format (DXF, DXB or DWG) 

specify the following parameters: 

AutoCAD version; 

Convert Lines to, Convert hatches to. 

These parameters determine into what 

AutoCAD system elements the T-FLEX 

CAD lines and hatches will be converted; 

Convert dimensions to. For T-FLEX CAD 

dimensions, one can select one of the 

following export options: 
 

Dimensions. In this way of converting dimensions, T-FLEX CAD dimension parameters are translated 

into AutoCAD dimension parameters. This may suffer some loss of dimension text data that is not 
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supported by AutoCAD (for example, tolerances containing letters in their notation). Converting 

some dimensions not supported by AutoCAD could also create additional strokes, notations and 

text unrelated to the AutoCAD dimension, used for accurate representation of the respective T-FLEX 

CAD dimension. For example, this is possible when exporting certain dimensions with the text put on 

a bent leader or on a leader extension. 

Dimensions and Text. Selecting this option also makes AutoCAD dimensions (sometimes, with 

additional lines). However, the textual fields of the resulting dimensions get hidden by AutoCAD. 

Instead, those get objects of the type “Text” inserted that appear as T-FLEX CAD dimensions yet are 

not related to the AutoCAD dimension. 

Lines and Text. In this case, AutoCAD dimensions are not created in the conversion. The T-FLEX CAD 

dimension images are translated as lines and text. 

Text Conversion. This is the group of parameters defining the method of exporting text: 

Convert Text. This parameter defines the method of converting elements of the type “String text”: to 

text or to line strokes in AutoCAD; 

Convert Multitext. This parameter defines the method of converting “Multiline text”, “Paragraph 

text” and “Table” text types. Three options are available in the combo box:  

To Multitext. T-FLEX CAD text of the specified types is converted to AutoCAD multi-text (mtext). 

Subscripts, superscripts, GD&T symbols which are part of T-FLEX CAD text content, are not 

translated to AutoCAD. The contents of T-FLEX CAD tables is written in one column. The fractions 

contained in T-FLEX CAD text are converted correctly only upon the condition that those do not use 

nested fractions; 

To Text and Lines. T-FLEX CAD text is exported to ordinary AutoCAD text and lines; 

Select. During the conversion, T-FLEX CAD text is checked for presence of tables, fractions, 

subscripts, superscript, GD&T symbols, roughnesses, etc. If any of those entities is found, then the 

text is exported into ordinary AutoCAD text and lines. Otherwise, the text is converted to AutoCAD 

multi-text. 

Code Page. This parameter allows selecting the desired text encoding. The default encoding 

corresponds to the language used in T-FLEX CAD. When exporting a file that contains characters of a 

language other than that used in T-FLEX CAD, you may need to change encoding.  

Convert splines into. Parameter that controls the transfer of graphic lines-splines from GRB file to 

the AutoCad file: 

Polylines. Spline is created as a polyline with division into segments. 

Polylines with interpolation by arcs. Segments of the spline are replaced by arcs where it is 

possible. 

Tolerance. This parameter specifies allowable offset of the location of polyline points from the 

original spline. 
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The “Export” group allows us to find out which pages of the original T-FLEX 

CAD drawing must be exported into AutoCAD document. The drop down 

list of export modes offers the following options: 

All pages;  

Current page;  

Selected objects. In this case only the objects which were selected on the drawing are exported; 

Selected pages. Only the pages selected in the list below will be exported. Page selection is 

carried out in the same way as upon printing out a document. 

Export only to the space of the model. When this parameter is enabled, the export is carried out to the 

tab “Model”, but the pages are not created in the file (layouts). 

If the drawing being exported uses SHX fonts missing in AutoCAD, you can add those to AutoCAD 

by copying those fonts into its working directory. 

The earlier versions of T-FLEX CAD (8.0 and prior), a different export/import mechanism was used for 

exchanging data with the AutoCAD formats. The old mechanism did not support AutoCAD 2004/2005 

files format and the binary *.DXB format. When exporting a T-FLEX CAD drawing into AutoCAD, one 

could not select specific pages of a drawing that needed to be exported. Besides, the conversion method 

of T-FLEX CAD elements into AutoCAD elements that was used in the old mechanism might not always 

deliver correct translation of all drawing elements. Nevertheless, the old data exchange mechanism had 

its own advantages. For example, it supported selection of the operating system for exporting (for data 

exchange with old AutoCAD versions), as well as a text conversion method.  

To use the old mechanism of data exchange with AutoCAD format for exporting, you would need to 

check an additional flag Use Version 8 Algorithm. This mechanism can be used only in the 32-bit version 

of T-FLEX CAD. Activating the flag enables the parameters of the old mechanism and blocks the 

parameters inherent solely to the new mechanism T-FLEX CAD. Described below are the parameters 

pertaining solely to the old export mechanism: 

Convert Dimensions to. T-FLEX CAD dimensions conversion into AutoCAD elements in the 

old mechanism occurs differently. The following options are available: 

Dimensions. When exporting a dimension, an AutoCAD block is created in which all strokes and 

text are added that were related to the dimension. This block “links” to the AutoCAD dimension. 

A shortcoming of such approach is the fact that the dimension appearance may change 

significantly when regenerating in AutoCAD. 
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Lines and Text. In this method, no AutoCAD dimensions are created; instead, all T-FLEX CAD 

dimension data translates into lines and text. 

Text Conversion\Convert Text. This parameter determines into what AutoCAD system elements 

the T-FLEX CAD text will be converted: 

To Text. The original drawing text will be translated into AutoCAD text. The Code Page 

parameter allows selecting the desired text encoding; 

To Lines. The original T-FLEX CAD text are converted into a set of line strokes. 

Operating System. This parameter allows selecting the type of an operating system: DOS or 

Windows. Default is Windows; however, if the file is being exported into an older AutoCAD 

version running DOS, you should change the radio group setting. 

When using the old data exchange mechanism, you cannot select an AutoCAD version higher than 

2000. 

Raster Image (*.bmp, *.jpg, *.gif, *.tif, *.tiff, *.png) 

The following parameters are defined in the raster image export dialog: 

“File” group of parameters displays and allows to edit the name and format of the output file 

defined in the previous step. 

“Export” group of parameters defines the export image: 

Current View. This setting means exporting the current window image; 

Current Page. This setting means the current 2D page image will be exported; 

Rectangular Area. This setting serves to manually define a rectangular area of the 2D page, 

whose content will be recorded in the resulting file. There are two ways to specify the area: 

1. By defining the lower-left and upper-right corner coordinates of the area (Left Bottom and 

Right Top). The coordinates are entered in the respective fields; 
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2. By selecting a rectangular area in the 2D window. To select an area, click the button 

[Select…]. The dialog window will temporarily disappear from the screen, and you will be 

able to specify the desired area with the cursor. To return to the dialog, click  in the 

automenu. 

An additional Hide Constructions flag (set by default) has an effect on exporting 2D and 3D 

construction elements. When this flag is set, the construction elements are not exported. 

Please note that the Area to Export parameter, as well as the fields to define a rectangular area, 

are available only when calling the export command from a 2D window. If calling the command 

from a 3D window, then the Current View setting is forced. Besides that, when called from a 3D 

window, the command dialog gains another flag – Hide Annotation Elements. When this flag is 

set, the 3D annotation elements are not exported. 

The Hide screen layers flag is also available only when exporting from a 2D window. This 

parameter determines whether the drawing elements from the layers for which the "Screen" 

option is set will be exported. 
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Image group of parameters serves to define parameters of the file being created: the image 

dimensions, resolution and background color: 

Width, Height. These are the width and height of the image in the resulting file. If these 

parameters are set, the system will force saving the image aspect ratio. 

Units. This parameter defines the units in which the height and width of the image are specified: 

Pixels, Millimeters, Centimeters, Inches. 

Resolution. This parameter defines the resolution of the file being created. You can additionally 

select the resolution units: Pixels per Inch or Pixels per Centimeter. 

An info parameter “Size in Pixels” serves to assess the size of the resulting file. 

Background Color. This parameter defines the background color of the picture being created: 

Auto (same as the active window background), White, Black, Other (any color from the drop-

down list at the right). 

If you export a 3D scene, the option Transparent is available for PNG format. The option allows 

you to set a transparent background for the image. 

Quality. This parameter is available only when exporting the “*.jpg” format. It defines the rate of 

compression for the file. The higher the compression quality setting, the less image loss and the 

larger the file size will be. 

PDF Format 

You should select a path for saving the exported file after calling the command for exporting to PDF. A 

dialog window appears after that. Here user can specify export parameters. 

In the Pages field user should select pages for export. 

Buttons to the right of the field allows to control the selection of pages for export. 

Buttons Up and Down allows to position the 3D view at the beginning of the PDF document or at the 

end. 

The Settings button is available for the 3D view. The button calls the 3D PDF export dialog. 
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Convert to raster image. All pages will be converted to raster images. You can specify image resolution 

in the field to the right. 

Create layers. If the flag is set, layers will be created in the PDF document. The layers will be similar to the 

layers in the T-FLEX CAD document. 

Monochtome. Allows to specify single color for the drawings on all pages. By default the color is black. 

Open file. If the flag is set, the PDF document will be opened when the export is complete. 

Parasolid (*.xmt_txt, *.xmt_bin) Formats 

When exporting into the Parasolid format, you need to specify the Parasolid Version. 

By default, the Parasolid version number is set to the one that T-FLEX CAD system is running (the 

maximum number). 

Data organization. Specifies export type: Assembly or Set of Bodies. 

Assembly. The model is exported with assembly hierarchy, if it exists. 

Set of Bodies. The model is exported without assembly hierarchy. 

In the Entity Types to Export group, you can specify which objects will be exported: 

 Solids; 
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 Sheets; 

 Wires. 

Color. Allows to select one of the following color sources: Material or Shading. In the first case the 

scattering color of material (is specified in the material parameters in T-FLEX CAD) is exported. Otherwise, 

shading is exported. 

  

Simplify geometry. The option, if possible, removes the redundant topology of the exported model 

bodies. As a result the size of the output file is reduced. The option does not change the quality of the 

model. 

For example, it can be "extra" ribs, breaking a cylindrical surface into segments. With this option, the 

export time and memory consumption are increased. 

Export welds. Manages export of welded seams. 

Export 3D paths. Manages export of 3D paths, routes. 

Export profiles. Manages export of profiles. 

Copy geometry of arrays. If the flag is set, copies of all of the elements of the array will be created. File 

size in this case increases. 
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Rhino Model (*.3dm) 

Export options for this format specify types of T-FLEX CAD elements for exporting to Rhino model: 

 

Solids and Surfaces. When this flag is set, all visible solid and sheet bodies will be exported. 

3D Profiles. This flag enables 3D profiles for exporting as Rhino curves. If flag Closed 3D Profiles as 

Sheet Bodies is set, Rhino surfaces will be generated instead of curves-bounds for the closed 3D Profiles. 

3D Paths. When this flag is set, 3D Paths will be exported as Rhino curves. 

Visible only. This option controls 3D Profiles and 3D Paths to be exported. When this flag is active only 

visible objects will be exported. Solid and sheet bodies are not affected. 

STEP (*.stp, *.step) Format 

If STEP export format was selected, the STEP translator parameters dialog appears after entering the file 

name. Here you can specify the process options. 

 

Protocol provides compatibility of STEP files with older versions of CAD systems. New protocol is 

enabled by default. Older protocol version AP203 doesn’t support colors, so the Color option is 

unavailable for it. 

Compatibility with CAD systems option provides possibility to read STEP file in other CAD systems. 
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Export multiple Solid Model as group: 

Sets the mode of exporting a multiple-solid model: 

Assembly. The model being exported is converted as an assembly with its hierarchy. 

Set of Bodies. Geometry contained in the file being converted is exported as a plain set of bodies 

without creating an assembly structure. Each body contained in the model is exported separately. 

Representation specifies type of bodies export: boundary representation based on geometry (Solids and 

surfaces) or mesh polygonal representation (Faceted). 

Export 3D Images option is available for Faceted representation. If it is disabled, objects of 3D image 

type will not be exported into STEP file. 

Color option specifies source of bodies color: basic material color or shading color. 

Quality of curves and surfaces. Setting this option forces conversion of all non-analytical surfaces into 

B-spline surfaces. Accuracy of current geometry conversion into representation spline can be set using 

the drop-down list. The geometry is converted only if it is necessary. This might improve the resulting 
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export in some systems, as, for example, in CATIA and SolidWorks, but increases the size of the resulting 

file. It is recommended to use standard quality by default. 

 

Split periodic faces defines the method of converting periodic geometry present in the model. 

By periodic geometry, we mean cylindrical, toroidal, spherical surfaces and their counterpart spline 

surfaces. When converting a model into the STEP format, such surfaces and curves can be broken into 

pieces for better export results.  

 

Simplify geometry option removes excess topology from the model and reduces file size. It is disabled 

by default, as export time and memory consumption grow when it is used. 

 

Export welds. When the option is enabled, welds are exported. Welds are transformed into bodies. 

Export curves. When this parameter is set on, in addition to bodies of the model, the wire geometry will 

be exported as well.  

Export profiles. When the flag is set, profiles are exported. 

Curves and profiles are transformed into paths. 

Convertation process is performed after pressing [Ok] button. The progress bar follows on the overall 

conversion process.  

 

 

 

JT, ACIS, PRC Formats 

Similar dialogs are used for JT, ACIS and PRC formats. 

For JT Format you can additionally specify JT Version. 

Data organization. Specifyes the export type: 

Assembly. The model is exported with assembly hierarchy, if it exists. 

Set of Bodies. The model is exported without assembly hierarchy. 
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In the Entity Types to Export group you can specify objects to export: Solids, Sheets, Wires, 3D Images, 

Welds, Profiles. 

Option Annotations is available only for JT format. It allows to export dimensions and another 

annotations. 

Wires and Curves export is available only for PRC format. 

Color. Allows to select one of the following color sources: Material or Shading. In the first case the 

scattering color of material (is specified in the material parameters in T-FLEX CAD) is exported. Otherwise, 

shading is exported. 

Simplify geometry. The option, if possible, removes the redundant topology of the exported model 

bodies. As a result the size of the output file is reduced. The option does not change the quality of the 

model. 

For example, it can be "extra" ribs, breaking a cylindrical surface into segments. With this option the 

export time and memory consumption are increased. 

IGES (*.igs, *.iges) Formats 

The IGES export dialog is similar to the dialog for JT, ACIS and PRC formats, but two additional 

parameters are available for the IGES format. 

Using NURBS. Setting this flag allows use of rational splines (NURBS) when converting a model. If the 

flag is cleared, all exported geometry is described solely by polynomial splines. 

Save Bodies as Sets of Faces. Instead of preserving a solid body, a set of its faces will be preserved, each 

face as a separate surface. 
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3D Mesh Formats Export Parameters 

When models are exported to 3D mesh formats, their geometrical shape is converted into a set of 

triangular elements. You may control the accuracy of representation which determines the number of 

triangular elements and thus the export file size. 

The same Export Parameters window is used for specifying export parameters for various 3D mesh 

formats. Depending on the format, the set of parameters may differ. 
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X3D, IV, VRML 2.0, TF3D Formats 
You may define various export parameters for x3d, iv, vrml 2.0, tf3d formats (These parameters are also 

used in most of the formats described in the following sections): 

   

Pack to archive - reduces the size of resulting file and stores all relevant data in one compressed file. For 

example, you can store main scene file and textures. 

Object caching. If there are several identical elements in the document, and the flag is active, the 

elements will be saved in a single instance. Transformations are used to create all elements based on this 

instance. If the flag is disabled, a separate instance is created for each of the elements and the file size 

will be larger. 

Export light sources - adds light sources of active view. 

Export edges – adds model edges as separate graphical items. 



T-FLEX CAD Brief Introductory Course 

1058 

 

T-FLEX CAD 3D PDF 

Export materials – when the flag is set, the materials will be exported. Otherwise, model colors will be 

exported.  

Export 3D Annotations. Allows to export 3D annotations, such as dimensions and GD&T symbols. 

 

 

T-FLEX CAD 3D PDF 

 

Texture usage:  

without texture - file is saved without data on textures;  
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embedded texture – texture is stored inside the file. 

external texture – adds only links to the texture files;  

 

Mesh quality specifies image quality for the exported model. Higher quality produces bigger files. 

 

Accuracy Result 
Size of STL file (ASCII 

format) 

Default 

 

3,27 МB 

 

Increased 

accuracy 

 

13,1 МB 
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Decreased 

accuracy 

 

21,7 KB 

 

To define mesh quality settings manually use option .  

More information about mesh quality settings can be found in “3D tab” section of “Drawing 

setup” chapter  

 

Output coordinate system. Allows you to select the LCS that determines the initial orientation of the 

model when you open the exported file. 

Exploded view scenario. Allows to select an exploded view scenario, which will be added to the exported 

file. 

3D PDF, U3D Formats 
These formats have the same options as described in the section "X3D, IV, VRML 2.0, TF3D Formats” and 

several additional options. 

Create Layers. When it is enabled, all layers from T-FLEX CAD document will be created in the file. 

Export attributes. Attributes may be set for 3D model objects. These attributes will be saved in the 

resulted file on export. 
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Threads can be exported into the 3D PDF format. Textures export should be enabled for this purpose. 

Open file. Allows to open file in the program, associated with the format. 

POV format 
The Export Parameters window for the *.pov format has the same set of parameters plus button 

[Additional settings]. 

 

  

After pressing the button the Pov-ray export window appears.  

 

More information about the window can be found in chapter “Photorealistic view”. 
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PLY, OBJ Formats 
The following Export Parameters window has fewer parameters: 

 

All options were already described above. 

STL (Stereolitography) Format 
There are some extra parameters in Export Parameters window specific to STL format: 

 

Separate file for each body. Separate files will be created for each body in the assembly. 

STL color model. You can select color from one of two standard formats: VisCAM and SolidView format 

or Materialise Magics format or select Without color. 

File type:  

Binary (with color support) - binary format with color support. Bodies are stored as a single large 

mesh. 

ASCII (multibody) - text format without color support. The bodies are divided into individual meshes. 

Open file. Allows to open file in the program associated with the format. 
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DXF 3D format 
The only difference of Export Parameters window for DXF 3D format is a Layers assignment field. You 

can select one of the following variants: 

One layer – all bodies will be placed on the same layer. 

Layer for each body – bodies will be placed on different layers. 

T-FLEX CAD layers – layers specified in T-FLEX will be used. 

 

3MF Format 
3MF is an XML-based mesh format created for use in additive production and 3D printing. The format 

includes additional information (for example, about the material and color of the model). 

The export parameters dialog for the 3MF format is similar to the dialog described in the chapter "JT, 

ACIS, PRC Formats". The only difference is that the result of the export is a mesh geometry. 
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IFC Format 
IFC is a file format that includes data of the construction industry. 

Export to this format is started without selecting additional parameters. 

The result of the export is a mesh geometry. 

IMPORTING DOCUMENTS  

Importing documents in T-FLEX CAD from other systems is done by the command IM: Import Drawing 

Or Model: 

Icon Ribbon 

 
 → Import 

Keyboard Textual Menu 

<IM> or 

<Ctrl><R> 
File > Import 

After calling the command, the standard File Open dialog appears on the screen. In this dialog specify 

the name of the file to import and its format. Then the dialog window for specifying additional import 

parameters appears (see below). 
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You can also import the file by moving it to the 3D scene of the opened file using drag'n'drop. 

To import files of various formats into the 3D version of the system, you can also use the 

command 3MO: Insert External Model. More details on this are provided in the chapter “External 

Model” of the “Three-Dimensional Modeling User Manual”. 

In addition, you can open the imported model using the command O: Open Model or by dragging the 

model to the panel from Windows Explorer using drag'n'drop. 

When you open a file using the command O: Open Model, you can select the Open or Open with 

parameters option. 

 

If you select Open with parameters, a dialog similar to the import dialog for the specified format opens. 

In this way, you can open the model with the specified parameters. 

T-FLEX CAD can be set as the default program for formats that can be opened with the O: Open 

Model command. 
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AutoCAD Formats 

When importing AutoCAD documents into T-FLEX CAD, you need to specify the following parameters: 

Create new Document. This option directs where the result of the import shall be placed: in the 

current T-FLEX CAD or in a new document. 

Convert Text to Windows coding. Setting this option converts all imported text to Windows 

encoding. This flag shall be used when importing an AutoCAD document of one of its earlier 

versions running under DOS. 

Convert Blocks into Fragments. This option defines method of processing AutoCAD “block” 

entities. When the flag is on, blocks will be converted into T-FLEX CAD fragments. If this flag is 

cleared, blocks are converted directly into T-FLEX CAD entities.  

Converting blocks to T-FLEX CAD fragments may significantly slow down conversion if there are 

too many blocks and/or they have multilevel hierarchy. 

 

Scale lines thickness on layouts. This parameter scales thickness of lines for drawings views and is 

helpful after importing from AutoCAD. 

 

Import line thickness instead of line weight. The parameter defines the method of assigning thickness 

for imported lines.  

 

Split polylines into lines. Imported polylines are divided, if possible, in several lines with simple geometry 

(segments, splines, arcs). On these lines you can create dimensions.  

Points in spline. Specifies number of segments for imported splines representations. May be helpful in 

case of large number of imported splines. In this case reducing the number is recommended.  
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The next two groups of options (Convert Dimensions to and Convert Hatches to) define the method of 

converting AutoCAD elements (dimensions and hatches) into T-FLEX CAD elements. An additional flag 

for hatches Automatic area search enables the automatic hatch tracking (by the coordinates of points 

specified in AutoCAD at hatch creation - Pick points). Its use is recommended in the cases when hatch 

import fails in the normal mode (when the flag is cleared). 

During the import, the points of the source AutoCAD drawing are converted (wherever possible) to free 

2D nodes within T-FLEX CAD. A large number of such introduced nodes might interfere with further 

manipulations over the imported drawings. This can be avoided by setting the flag: 

Optimize Construction. Upon setting this option, the nodes that are closer to each other than the 

specified Join Distance, will be merged in one node.  

If the flag is cleared, then nodes coincidence is not tested. This helps speed up the import process, while 

could significantly clutter the drawing. 

Note that since the drawings in the DXF and DWG formats are not parametric, those remain non-

parametric in T-FLEX. 

3D Geometry. This parameter is used when the source AutoCAD file contains 3D solid geometry: 
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Ignore. When selecting this parameter, 3D geometry is ignored at conversion; 

 

Ignore 3D as 2D. In this case, at conversion 3D bodies from the source AutoCAD model are 

projected onto 2D drawing, 3D geometry is absent in the resulting T-FLEX CAD file; 

 

Import only 3D. 3D geometry of the source file is transformed into 3D geometry of the T-FLEX 

CAD. 

 Solids and Surfaces – exact solid and surface geometry will be imported. 

 3D Lines to 3D Paths –3D AutoCAD lines will be imported as 3D paths. 

 3D Points to 3D Nodes - 3D AutoCAD points will be imported as 3D nodes. 

 3D Meshes to 3D Pictures – AutoCAD mesh models will be imported as 3D Pictures. 

 

Just like when exporting, the old data exchange mechanism can be used when importing T-FLEX CAD 

version 8.0 and earlier data. For this, set the Use Version 8 Algorithm flag. The flag is available only for 

32-bit version of CAD. Once this flag is set, the option “Automatic area search” becomes inaccessible, 

while the group of options activates that pertains to the old mechanism: 

Create nodes: Free, On Construction Lines. This group of options allows selecting the method of 

creating nodes in an imported drawing: as free nodes or as intersection points of additionally 

created horizontal and vertical lines. 

Parasolid Format 

When importing Parasolid 3D models you should define the import mode: Assembly or Set of Bodies or 

One body. 

This mode is important only when importing multibody models or assemblies. If original file is 

presented as one solid, the result will be the same in all modes. 
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When importing in Assembly mode the model will be imported into multiple files retaining assembly 

structure. Parts and subassemblies will be stored in the newly created documents. The root assembly file 

will be opened after import completion. 

When importing in the mode Set of Bodies, the model will be imported as a set of independent external 

models corresponding to separate parts of the assembly. The imported model is added to the current 

T-FLEX CAD document. 

One body mode will insert the resulting single body in the current document. The result is similar to the 

result of using the 3MO: External Model command. 

In the Entity Types to Import group you can select the objects to be imported into the document: Solids, 

Sheets and Wires. 

Update Product Structure. Option manages the creation of product structure based on data from file: 

Description (Product name) and Part No (Product ID). It should be used only if records for the product 

structure exist in the imported file. 

Add BOM items for bodies. If the option is active, records about bodies will be added to the product 

structure. 

Heal Geometry. If there are problems with imported geometry the system will try to fix them. 
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Check Solids. If the option is active, the import will check the correctness of the imported geometry. If 

errors are detected, messages will be displayed in the diagnostics window. 

In Destination folder field you can specify folder for the created parts and assembly documents. 

IGES, STEP, Solid Edge, SolidWorks, Rhino, Autodesk Inventor, ACIS, Siemens NX 

(Unigraphics), Creo/ProE, Catia V5, Catia V4, I-Deas, JT, PRC, 3DXML, CGR, U3D, 

VDA-FS Formats 

Similar import parameters dialog is used for all of the formats. 

In the Assembly mode, the model will be imported with the creation of the assembly structure. New 

documents are created on the disk for storing of the fragments and the assembly. After the import is 

completed, the created assembly file will be opened in the T-FLEX CAD window. 

 

Set of Bodies. The model will be imported as a set of independent external models corresponding to the 

individual parts of the assembly. The imported model is added to the current T-FLEX CAD document. 

If you select One Body the result of the import is single body. The result is similar to the result of using 

the 3MO: External Model command. 

In the Entity Types to Import group you can select the objects to be imported into the document: Solids, 

Sheets, Wires, Mesh geometry, Annotations, Hidden bodies, bodies From active layer only. 

If Point clouds option is active, all points from the file are imported into T-FLEX CAD as 3D Nodes. 

Geometry Healing. You can select one of the three variants: Auto, Yes, No. 
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If you select Yes, the system tries to correct the erroneous geometry in the imported model and receive a 

correct body. Potential errors may take place due to the presence of self-intersections or non- sewed 

surfaces in the original model. The resulting body after healing may differ from the original one. 

The Geometry Healing option does not guarantee obtaining absolutely correct data. 

If you select Auto, the system decides whether it should try to heal it or not. 

If you select No, the model is not healed, which accelerates the import process. 

Sewing Accuracy. If the surfaces can form a solid body with a given accuracy, they will be sewn into a 

solid body. Otherwise, the surfaces will remain surfaces  

Create Precise Edges. You can select: Yes, No, Auto. Enabling the option is recommended only for 

attempting to correct the geometry if errors occur in the model. 

Check after import. If the option is active, the imported geometry will be checked and all found errors 

will be listed in the diagnostics window and all objects with errors will be marked in the model tree. 

Special warning will also be displayed at the top of the screen. 

To get a more detailed description of the problem, you can use the QM: Check model command. 

 

By default for options Geometry healing, Create precise edges and Check solids the optimal 

variants are set in terms of performance and result. It is recommended to change them only if 

there are problems in the imported model.  

 

Update Product Structure. Option manages the creation of product structure based on data from file: 

Description (Product name) and Part No (Product ID). It should be used only if records for the product 

structure exist in the imported file. 

Add BOM items for bodies. If the option is active, records about bodies will be added to the product 

structure. 

Check Solids. If the option is active, the import will check the correctness of the imported geometry. If 

errors are detected, messages will be displayed in the diagnostics window. 

In Destination folder field you can specify folder for the created parts and assembly documents. 

IFC format 

The geometry from the file of IFC format can be imported as: Solids and T-FLEX CAD Operations. When 

you select T-FLEX CAD Operations the system tries to create T-FLEX CAD operations and the import will 

be slower. 

Wireframe. Wireframe data will be imported. 

Import model structure. Hierarchy of the source IFC file will be shown in the 3D Model tree. 
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Default units. Allows to specify units of the imported geometry in case that they were not specified in 

the source file. 
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ANNOTATIONS CREATION 

Annotation is a set of notes, which overlaid T-FLEX CAD drawing. Annotation is saved in separate GRN 

file which content is displayed in annotated drawing. The original drawing itself is not changed. Creation 

and edition of annotations is performed using annotations editor.  

 

Annotating allows the head of department, verifier or any other employee to add comments to the 

document without editing the original document. This functionality may be helpful for team 

development, especially when working with document management system. 

 

There can be several annotations in one document. The annotations can be created by different people. 

A list of all document annotations is stored in GRI file. The file name is the same as for document. 

You should use AT: Annotations command to manage annotations. It shows a list of annotations for the 

current document, allows to show/hide annotations and to activate annotations editor. 

 

ANNOTATIONS COMMAND  

You should use AT: Annotations command to manage annotations. The command is called via: 

 

Icon Ribbon 

 

Tools → Tools → Annotations 

Keyboard Textual Menu 

<AT> Tools > Annotation 

 

The command brings up a dialog that contains a list of annotations created for the current document. 
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Annotations with active flag are displayed in the drawing window. If you want to hide an annotation, you 

can disable the flag. 

Priority of annotations on the drawing is determined by their order in the list. Use buttons [Up] and 

[Down] to change annotations order in the list. For example, you can display the text and dimensions 

from one annotation above the fill from another using the buttons. 

Information about annotations is displayed in “User name”, “Version” and “Comment” columns. The 

information can be edited. 

To create a new annotation use [New…] button. The dialog window for the filename (By default 

“Annotation №.grn”) and directory selection appears. Annotation files are stored in GRB file directory by 

default. 

You can open the selected annotation for editing using [Open] button. 

You can delete the selected annotation using [Delete] button. 

ANNOTATIONS EDITING  

When you open an annotation, system activates annotation edit mode. There are fewer elements 

available for creation/edition in the edit mode. Nodes, graphic lines, sketches, dimensions, text, hatch, 

leader notes and some other options are available for annotations. 
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All created elements are colored red by default. 

Special tab with available commands appears after annotation opening. 

 

Commands for system and drawing setup, toolbars and windows management are available. 

Annotation creation is similar to creation of T-FLEX CAD fragment in the assembly mode. You can snap 

elements to nodes and graphic lines of the original document. If the drawing will be changed cause of 

model parameters changes, the snapped elements will also be changed. 

After annotation creation it is necessary to save its file using SA: Save Model or SL: Save All Modified 

Models command. 
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LINKS. MANAGING COMPOSITE DOCUMENTS 

A T-FLEX CAD document can have links to other files: T-FLEX CAD documents (fragments), graphics files 

(pictures), database files, etc. Working with such composite document, one can face some difficulties, for 

example, when moving it to another computer. 

To ease working with composite documents, T-FLEX CAD provides a mechanism of links management. A 

link is a T-FLEX CAD object containing the path to an external file (the target of the link). Links are used 

when creating fragments, pictures and other T-FLEX CAD elements for specifying the source of external 

data. The same link can be used by different elements; for example, several fragments based on one file 

will refer to one link. 

The links management mechanism allows managing the way of storing the link targets. T-FLEX CAD 

allows storing the link targets either outside a T-FLEX CAD document as a conventional external file 

(“external link”), or directly within the file of the composite document (“internal link”). The internal 

storage of the link increases the size of the composite T-FLEX CAD document, but allows dealing with it 

as with one file. Links are managed by the commands located in the submenu File > Assembly. 

The links management mechanism solves the problem of moving large assembly documents. By using it, 

you do not have to search for all fragments files that may be located in different folders, on different 

disks, in libraries, etc. All you need to do is to “zip” the assembly model into one file with a provision of 

future unzipping, and move it to another place in the file system or into a storage of a document 

management system (for example, T-FLEX DOCs). 

L INKS MANAGEMENT  

Links window serves for managing links in a composite document. To call the window use Customize > 

Tool Windows > External Links command. 

More information about links management can be found in “Main operation principles” chapter. 

  

The command UL: Update all reference documents (Fragments) allows to reload the data from all 

external files contributing to the composite document:  

 

Icon Ribbon 

 

Assembly → Component Links→ Update Links 

Keyboard Textual Menu 

<UL> File > Assembly > Update Links 
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MOVING ASSEMBLIES  

The command AM: Move Assembly serves for moving a composite document to another location in the 

filesystem or for zipping the assembly into one file. 

 

Icon Ribbon 

 

Assembly → Component Links→ Move Assembly 

Keyboard Textual Menu 

<AM> File > Assembly > Move Assembly 

After calling the command, the “Move Assembly” dialog box will be displayed. In it, you need to specify 

the new location and name of the moved document and the moving method: 

 

Embedding. In the embedded moving, all linked files are stored within the assembly file. This 

method is convenient when you need to move a composite file to another computer, since it 

resolves in one common file. 

Substitution. When moving by substitution, all linked files are gathered into one folder named 

after the file of the main document and located in the same folder. 



T-FLEX CAD Brief Introductory Course 

1078 

In the lower pane of the Include Library Elements dialog, specify the list of libraries whose elements are 

used in the current document. The flags before the names of each library allowed specifying whether to 

move the library elements, to which there are links in the current document. 

UPDATE ASSEMBLY  

The command UA: Update Assembly starts converter that converts and saves all the fragment files that 

are included in the assembly. 

 

Icon Ribbon 

 

Assembly → Component Links→ Update Assembly 

Keyboard Textual Menu 

<UA> File > Assembly > Update Assembly 

 



Creating Custom Lines and Hatches 

1079 

CREATING CUSTOM LINES AND HATCHES 

T-FLEX CAD supports creation and use of user-defined custom graphic lines and hatches along with 

standard types. This chapter describes methods of creating and using those entities. 

T-FLEX CAD standard distribution includes several examples of custom lines and hatches that can be 

used as a sample for creating your own ones. 

GRAPHIC  L INES  

To add your custom line type to standard types of graphic lines, all you need is to place the descriptor 

file of the new line type in the folder …\Program\LinePatterns.  

The descriptor file of a custom line type – the line pattern  is a T-FLEX CAD drawing created to satisfy 

certain required rules. The file name coincides with the name of the line type. Upon restarting T-FLEX 

CAD, the new line type automatically appears at the end of the list of graphic line types. 

Creating Line Pattern 

Image of a line is created in general case from several elements described in the line pattern according to 

the special rules.  

Description of a line element constitutes a drawing of the corresponding segment of a line executed with 

the use of construction lines, nodes, graphic lines, text and hatches. Description of each element of the 

line must be located on a separate page of the pattern. The sequence order of pages in the pattern’s 

document is not important.  

In general case the image of the line is created from the following elements: Symbol, Space, Line, Start 

and End. 

Element “Symbol” – “main” element of the line. It can be repeated several times on the line. The number 

of repetitions is specified in the pattern of the line with the help of the variable CenterMaxCount. If this 

variable is not created in the pattern, the “Symbol” element is drawn only once on the line. The number 

of repetitions of the “Symbol” element can be decreased by the system if the number indicated in the 

pattern can not be fitted to the specified line length. The “Symbol” element is not drawn at all if the 

variable CenterMaxCount was assigned the value of “0” or if the line length is too small. 

“Start” and “End” are the elements that determine the line endings. They are placed at the beginning and 

the end of the line being created without changes. If in the line pattern the “Start” or “End” elements are 

absent, it will be possible to specify standard endings for a line on a 2D drawing upon using the given 

type of a line. 

“Space” and “Line” – auxiliary elements of the line that are repeated many times along its length, if 

required. When creating a line the system draws the “Start” and  “End” elements at the line ends, then 

uniformly places along the line the required number of the elements “Symbol” (as many times as it can 

be fitted along the line length but no more than it is specified by the CenterMaxCount variable). The 
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remaining intervals between “Symbols” are filled with the “Space” and “Line” elements. Filling in is carried 

out in the following way: into each interval the maximum possible number of the “Space” elements is 

inserted. The spaces remaining between them “are covered” automatically by the “Line” elements scaled 

to the required proportion in such a way that the “Space” and “Line” elements alternate. 

Any elements can be absent in the line pattern except the “Space” element. 

The required attribute of description of each element of the line is a pair of nodes named in a special 

way. The nodes determine the points of joining the given element of the line with the neighboring 

elements (characteristic points). The nodes names are precisely defined for each element of the line: 

 The “Symbol” element – specified by nodes CenterStart, CenterEnd; 

 The “Space” element – specified by nodes Start, End; 

 The “Line” element – specified by nodes LineStart, LineEnd; 

 The “Line start” element – specified by nodes TailStart, TailEnd; 

 The “Line end” element – specified by nodes HeadStart, HeadEnd. 

Start and end are connected to the main part of the line by TailEnd and HeadEnd nodes, 

respectively. 

When creating a pattern, one can use graphic elements of different color and different width. However, 

the color and width of a graphic line created from a custom type can be modified only if the whole 

pattern uses the same color and line width. 

The line elements may be of a quite complex shape. When a hatch is created based on graphic lines of a 

custom type, the hatch contour will not follow the line shape by default; instead, it will be composed of 

line segments passing through the characteristic points of the line elements. To make the hatch contour 

exactly follow the line or assume other arbitrary shape, you would need to specify additional 2D paths 

with special names in the line pattern drawing defining the hatch contour route. 

The paths are created separately for each line element. Each path must lie on the same page as the 

respective line element. The path must start and end at characteristic nodes of its element and be named 

as one of the following: “Polyline” – the path of the periodical part, “TailPolyline” – the start path, 

“HeadPolyline” – the end path, and “CenterPolyline” – the path of the center part. 

Working with Custom-type Line 

To start using a created line type, simply place the line pattern file in the folder …\Program\LinePatterns. 

Upon restarting T-FLEX CAD, the line types found in this folder will be automatically added to the lists of 

line types in 2D commands. To delete a custom line type, simply delete the pattern drawing file from 

…\Program\LinePatterns and restart T-FLEX CAD.  

When using a custom line type in a document, the line pattern is saved with that document. Relation with 

the source file is lost at this point. Therefore, when porting a document file to a computer without the 

given line type, the image does not get lost. 

When porting a document containing custom line types to a computer with existing line type pattern 

under the same name, the line image stays unchanged in the form of the image saved in the document. 
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To update a line image, you would need to redefine its type over again. To make an update, all you need 

is to bring up the parameters dialog box for one of the lines and confirm the existing value. New graphic 

lines of the same type that will be created in this document will take on the current pattern. 

Example of Creating Custom Line 

Let’s review custom line creation on a simple example. We will create the line pattern shown on the 

figure. First of all, let’s decide on the elements to be included in this line. The figure features: the 

periodical part – interlaced crosses and segments; center part entered just once  – the text “Test”; start 

and end as special symbols. 

 

To create the pattern, let’s open a new 2D drawing (the command FN: Create New Model). 

Description of each line element shall be placed on a separate page of the document. We will create four 

pages in the pattern document. For working convenience, each page can be renamed according to its 

purpose.  

To create or rename document pages, use the command PG: Pages. 

When creating descriptor drawings of line types, one can use either use simple sketched lines, or graphic 

lines snapped to construction lines. For simplicity, we will use free-hand sketching. 

We will begin creation of a line pattern from the main element – the periodic part. The descriptor of the 

periodic part will be the drawing depicting the cross with two strokes, on either side. The points at which 

this part connects to its neighboring line pieces are marked by the named nodes, “Start” and “End”, as 

shown on the diagram. 

A node name is defined by the command EN: Edit Node, the path name – by the command 

EC: Edit Construction. 

The lines constituting the periodical part can be of various 

types, color and width, depending on the desired appearance 

of the custom line. In this example, the crosses on the line 

ought to be blue. Therefore, we will make the cross strokes 

blue, while the lateral strokes - black. 

Next, we need to decide whether to prescribe the path for 

hatches. Suppose, this line may be used in the future for 

creating hatches, so that the hatch or fill lines are not allowed 

to overlap the cross strokes. For this purpose, we will create a 

named path, “Polyline”, starting and ending in the named 

nodes “Start” and “End” and passing as shown on the figure. 
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After describing the periodical part, let’s proceed to 

creating the next line element – the center part. To 

create it, we need to switch to another page of the 

pattern template. 

The pattern’s center part will include the text “Test” 

with two strokes on either side. The text can be 

created by any text entity type (the command 

TE: Create Text). The start and end of the center 

part are defined by the named nodes “CenterStart” 

and “CenterEnd”. Additionally, we will create a 

named path “CenterPolyline” for hatches based on 

this line, as shown on the figure. 
 

 

Similarly, we will create description of the tail and 

head of the line on separate pages, as shown on 

the figure. We will have to use a hatch to create the 

filling. 

No additional paths for hatches will be created. In 

this case, the contour of a hatch bounded by this 

line type will follow the lines connecting the border 

nodes of these line elements. 
 

 

What is left to do before using the created 

template is to save it in the folder …\Program\ 

LinePatterns under the name “Custom line 

sample.grb” and restart T-FLEX CAD. After 

restarting, the new line with this name will appear 

in the list of line types. It can be used just like a 

standard line type. 
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HATCHES  

T-FLEX CAD allows creating custom hatch types along with custom graphic line types. To add a custom 

hatch type to the system, place the file with a hatch pattern in the folder …\Program\HatchPatterns. Upon 

restarting T-FLEX CAD, the new type will appear in the list of hatches “by pattern”. To remove a custom 

hatch type, simply delete its pattern file from …\Program\HatchPatterns and restart T-FLEX CAD. 

Creating Hatch Template 

A pattern file is a T-FLEX CAD drawing complying with certain rules. It must contain the image of the 

hatch pattern composed of nodes, graphic lines, text and hatches, as well as construction elements. The 

start point of the hatch is defined by a special node named “Center”. This node is mandatory in the hatch 

pattern.  

To make a given pattern repeat multiple times when filling the hatch contour, additional named nodes 

must be defined in the pattern that would define the direction and step of the pattern repetition. The 

node defining the first hatch direction must be named «StepX»; the node defining the second direction – 

«StepY». The direction-defining nodes are optional. In the case either of them is not defined, the pattern 

will be drawn just once in the respective direction. 

Working with Custom Hatches 

When using a custom hatch type in a document, the hatch pattern is saved with that document. Relation 

with the source file is lost at this point. Therefore, when porting a document file to a computer without 

the given hatch type, the image does not get lost. 

When porting a document containing custom hatch types to a computer with existing hatch type pattern 

under the same name, the hatch image stays unchanged in the form of the image saved in the 

document. To update a hatch image, you would need to redefine its type over again. To make an update, 

all you need is to bring up the parameters dialog box for one of the hatches and confirm the existing 

value. New hatches of the same type that will be created in this document will take on the current 

pattern. 

Examples of Creating Simple Hatches 

To create a custom hatch pattern, let’s open a new document (the command FN: Create New Model).  

In the opened document, create the image of a hatch pattern as shown on the figure. Make sure to put 

an additional node on the drawing, named “Center”, which must be present on a hatch pattern. 

The drawing created in this way can already be identified by the system as a custom hatch template. All 

that needs to be done is saving the file in the folder …\Program\HatchPatterns (for example, under the 

name “Custom hatch sample.grb”) and restart T-FLEX CAD.  

However, since no direction nodes are defined in the pattern, an actual hatch created from this pattern 

will contain just a single instance of the hatch. 
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To make the sample defined in the hatch pattern repeat in one direction, you would need to create the 

respective named node in the pattern, as, for example, “StepX”. The position and step of the node will 

define the step and repetition direction of the pattern sample. 

   

Two named nodes – “StepX” and “StepY”  would allow defining repetition of the pattern sample in both 

directions. By varying the position of the direction nodes with respect to the “Center” node, one can 

obtain various hatch appearances all based on the same pattern. 
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Example of Creating «Woody» Hatch  

The custom hatch creation mechanism allows creating even more complex hatches, for example, a 

“woody” hatch. To create this type of a hatch, a pattern was created as shown on the figure. An 

appropriately arranged placement of direction nodes yields a hatch imitating wood texture. 
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CREATING LIBRARIES OF PARAMETRIC ELEMENTS 

T-FLEX CAD offers a rich library of standard elements included in the application installation package. 

The libraries of standard elements speed up the design process and allow the designer to concentrate on 

the actual development, rather than on drawing bolts and nuts alike. 

Besides, T-FLEX system provides tools for the user to define one's own standard elements, that support 

wide range of productivity improvements. Designers often use families of elements whose members are 

mostly identical, often with the only difference in the dimension values, having to spend time just to 

draw such an element. This issue can be resolved by creating a standard parametric element in T-FLEX 

CAD system. 

A big advantage of T-FLEX CAD compared to other systems is the provision for the user to create own 

standard parametric elements. This does not require knowledge of any programming language. The user 

can create any objects, from drawings and 3D models to dialog boxes for fragment insertion. T-FLEX CAD 

provides special commands for this purpose. Another positive feature is that any library element is an 

ordinary T-FLEX parametric drawing. 

CREATING PARAMETRI C L IBRARY  ELEMENTS  
 

Parametric library element creation can be 

divided into several steps:  

Creating databases (if necessary). 

Creating variables, including those relying on 

databases. 

Creating a parametric drawing and/or 3D 

model. 

Creating fixing vectors and fixing LCS; 

Creating 2D and/or 3D connectors; 

Creating a dialog box of fragment’s 

parameters. 

Adding the element to the library. 
 

Some of these steps can be skipped. For example, you may not need a set of values from a database, or 

you're not creating a 3D model, 2D or 3D connectors. 

Let’s review each step by an example. Consider a bolt GOST 7795-70. 
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The file for this example can be found in the library “Examples” in the 

folder “T-FLEX Parametric CAD 15 

\Libraries\Examples\Parametrization\Library of parametric parts 

creation\ Bolt GOST 7795-70”. 

The parameters of this bolt should update from the database 

depending on the input diameter and length. The bolt has several 

implementations. Both the drawing (the three views: front, left and 

top) and the 3D model should adjust to each implementation. The 

bolt will be used as a fragment in other drawings. 

 

Creating a Database 

At the step, you need to create an internal database to pick the values from. 

First, you need to decide, which will be the driving parameter. In our case, the candidate parameter is the 

bolt thread diameter. Therefore, the bolt diameter is entered in the first column, followed by all the rest 

of the parameters (except the length). The names of the database columns (and the database itself) 

should be made descriptive, so that later, when creating variables, you could easily remember which 

column relates to which parameter. However, too long column names are not recommended either. A 

good strategy is to name the columns according to engineering standard notations adopted in your 

industry. In our example, the thread diameter is named d, the bolt head size - S, etc. 
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In our example, the input bolt length must be rounded to the nearest 

standard length. We should also account for the fact that the set of 

standard lengths is different for each diameter. For example, the bolt 

diameter of 6 mm corresponds with the length of 30 mm, while the bolts 

12 mm in diameter have minimum length of 45 mm. Besides, depending 

on the selected bolt length, two additional parameters are defined: l1 and 

l0. We recommend creating separate databases of lengths for each 

diameter. The suggested database names are l6, l8, etc. The letter l, as in 

“length”, refers to the databases of lengths, while the number stands for 

the respective diameter. 

Once the databases are created, proceed to the next step. 

 

Creating Variables Relying on Databases  

At this step, we need to create variables that would be used for building the parametric drawing and the 

3D model. We recommend using descriptive names for the variables. 
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First, define the driving variables for the rest of dimensions, whose values need to be defined when 

assembling the part. In this example, those are the diameter, the length and the implementation (see 

below). If a variable has a set of standard values, it is helpful to create the predefined list of values for 

convenient and quick input. The list of values can be created based on an existing field in the database. 

Upon creating a variable, it is a good practice to put a description in the comment field, so that another 

person can easily decide on what data to input, when working with this document. 

Next, we need to create variables that keep track of the database record number from which the values 

are taken. Such variable value can be read by calling the function rec or frec. For the functions 

description, refer to the chapter “Databases”. In this example, we need two such variables: one (the 

variable n) for accessing the values dependent on the bolt diameter from the respective database, and 

the other (the variable nl) for maintaining the value of the length. The challenge here is that the second 

variable should be assigned an appropriate record number across different databases (depending on the 

diameter). Besides, one should keep in mind, that the input length might not be always correct, as the 

designer of the part could enter a nonstandard bolt length. Therefore, the value of the variable nl can be 

described by the expression: d==6 ? frec(6.l,l) : (d==8 ? frec(l8.l,l) : d==… ), that means, if the variable d 

(diameter) is equal to 6, then do the search for the record number in the database number 6, otherwise, 

if the variable d is equal to 8 - then do the search for the record number in the database named l8, and 

so on over all databases.  

Next, create the rest of the variables. Their values are accessed by calling the function val based on the 

value of the variable that keeps the record number of the database (those are - n and nl). The value of 

the bolt length (ll) will be defined by the expression: d==6 ? val(nl,l6) : (d==8 ? val(l8.l,l) :d==… ). The 

meaning of this expression is similar to that of the variable nl described above. 

The bolt has several implementations. The drawing should adjust, depending on the implementation. 

This can be fulfilled by setting, when necessary, the level of certain drawing elements below the 

displayable threshold. We need to create special variables for this purpose (separate for each 

implementation). By default, the displayable elements have level from 0 to 127. If the level of an element 

is below zero, it is not displayed. Consider, for example, the variable imp25 that defines the level of the 

elements visible only in the implementations number two and five. It is equal to 0 when the 

implementation (defined by the string variable $imp) is equal to “2 - with pin hole” or “5 - with pin hole 

and groove”, and is equal to -10 in all other cases: $imp=="2 - with pin hole"||$imp=="5 - with pin hole 

and groove"?0:-10. 

Special functions (WARN and ERROR) are provided in T-FLEX CAD for prompting the user about errors 

when variables take certain inadmissible values, and request inputting different value. For example, if a 

non-specified bolt length is encountered, you can force the message: “The input bolt length is not 

standard”. This is done by calling the function: WARN(“The input bolt length is not standard”). 

Once the necessary variables are created, you can proceed with creating the drawing and the 3D model. 

Creating Parametric Drawing and 3D Model 

When using a library element is a fragment, it is often necessary to insert just a portion of the drawing. 

Anticipating that, you can predefine several new layers. Use descriptive layer names to make it easy to 
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understand which portion of the drawing belongs to which layer. In our example, we need to create three 

new layers. Let's name the layers according to their purpose: front view, left view and top view. During 

creation, all elements can be placed on any layer, for example, on the layer “Main”. Once the drawing is 

ready, simply select the desired portions by box and modify the layer of those elements as desired. 

Some elements of the bolt (for example, the pin 

hole) may or may not be displayed, depending on 

the implementation. At the previous step, we 

created special variables for this purpose. The 

variable imp25 is equal to 0 whenever the 

implementation is equal to “2 - with pin hole” or “5 

- with pin hole and groove”. In any other 

implementation, the variable is equal to -10. If an 

element is to be displayed only in the 

implementation 2 or 5, its level must be defined by 

the variable imp25. 

 
 

 

To make sure that in the assembly drawing the bolt 

is properly displayed in the bolted joints, to each 

view of the drawing let us add hidden hatches with 

the activated option of suppressing the hidden 

lines. 

Upon completing the 2D drawing, proceed with 

the 3D model. Suppose, your 3D model is required 

to undergo changes depending on some 

parameter. It is not solely the model dimensions 

that could change. Some features may appear or 

disappear in the model. 

 
 

 

In our example, such a feature is the pin hole. The easiest way to achieve this is by suppressing a certain 

operation. This can be done using the same variables as when defining the level of the respective 

features on the drawing. What exactly can be done in this case? The pin hole is created as follows. First, a 

rotation was made, creating a cylinder. Next, a Boolean subtraction was done of the cylinder from the 

bolt stem. The rotation operation can be suppressed as follows. Among the “Rotation” operation 

properties, assign the parameter “Suppress” to the variable imp25. The rotation operation will be 

suppressed when the variable is not equal zero (that is, when the implementation is not equal 2. To avoid 

a system error when creating a Boolean with an empty member, set the flag “Allow missing operand” 

among the Boolean parameters. 
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On the resulting body of the bolt the user should put a thread. To achieve this, let us use the command 

“3AT: Create thread”. 

The drawing and the 3D model of the future library element are completed. Next, let us create fixing 

vectors and the special coordinate system for fixing the created document in the assembly drawing. They 

will be used for inserting the given document as a fragment into the assembly. 

Creating Fixing Vectors and Coordinate System for Fixing Fragment in Assembly 

In our case, the fixing vector will be used when the library element is inserted as a 2D fragment into the 

assembly drawing. To use it as a 3D fragment, it is necessary to create a special local coordinate system 

(3D analog of the fixing vector) which will be used for fixing the fragment in the 3D assembly model.  

For our drawing of the bolt let us create several fixing vectors, each for inserting a certain layer. Among 

the created vector properties, the flag is checked “Draw only marked”, and the layer is marked that 

should be displayed upon the insertion. The same vector names as the layer names are used for clarity.  

 

On the 3D model of the bolt, let us create LCS for fixing a 3D fragment. 

The position of the fixing vectors and the coordinate system is determined by the main surface (the 

contact surface between the bolt and other parts). This is the surface of the bolt head base. 
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When inserting a fragment, the contents of the fragment folder are displayed in the left portion of the 

coming up dialog box. If the flag is set “Show icons”, then the drawing slides (icons) are displayed next to 

the file names. We recommend creating slides for the drawings, to insure easy selection for assembling. 

The slide can be created using the command Tools > Special Data > Preview. Upon entering the 

command, select the item “Create Raster Preview as Windows Bitmap (BMP)”, press the graphic button 

[OK] and select the portion of the drawing that you want to put on the slide. 

After this, proceed to the next step. 

Creating Connectors 

In the assembly drawings, other fragments, for example, a fragment-nut, will be attached to our library 

bolt element. Let us create conditions for a quick “connection” of other fragments: let us add connectors 

to created drawing and 3D model, and also assign connector’s values to external bolt variables (for a 

quick specification of the values of the fragment’s variables upon inserting a fragment into the assembly). 

 

For the drawing, let us create four 2D connectors – for two front views (standard and simplified) and for 

two top views. For creating a connector, the command FV: Construct Fixing Vector can be used. 
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Let us specify the named value “DiameterOuterMetricThread” for all 2D connectors. This named value will 

pass the magnitude of the bolt’s diameter to the fragment (nut) being attached. As an expression for the 

named values of all connectors, indicate the variable “d”. 

 

Note that for the successful use of the connectors, upon creating the fragment of the nut it is 

required to indicate the connector’s named value “Diameter-OuterMetricThread” in the properties 

of the variable controlling the nut’s diameter. 

For created connectors, let us indicate graphic lines, as associated elements, on the corresponding views 

of the bolt – this will simplify fixing to the given connector. 

 

Also, for 2D connectors it is required to specify «insertion rules». When fixing a nut to the bolt’s 

connector, it is usually required to specify additional translation along the X-axis of the connector. 
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By the same principle, let us create 3D connector on the 3D model. For the 3D connector let us create 

two named values: “DiameterOuterMetricThread” (bolt diameter) and “ThreadPitchMetric” (pitch of the 

bolt’s thread).  

 

Having created connectors, we prepared a basis for convenient fixing of other fragments of the assembly 

to our fragment. Next, let us return to the variables editor of our model and specify the following value 

of the connector: “DiameterInnerMetric” for the variable “d”. The same named value was specified for the 

connectors entering the library of openings. As a result, when the fragment of the bolt is inserted into 

the assembly by means of fixing to an opening’s connector, the actual bolt diameter will be defined 

automatically. 
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Creating Dialog Box 

At this step, we will compose the dialog box that will be used for inserting the current drawing as a 

fragment. Each time when assembling a drawing (model), the user will be getting a dialog box containing 

standard Windows elements (input boxes, pull-down lists, etc.), helping easily and quickly defining the 

parameters of the fragment being assembled. 

 

Creating such a dialog box is relatively simple. First, create a new page to hold the control elements. To 

do this, lunch the command Draw > Control and select the automenu option  “Create Dialog Page”. 

Some of the controls (“Static Text”, “Group Box”) do not depend on variables. When creating such 

elements, you define their position and then enter their name. Such elements help creating a clear dialog 

structure with necessary descriptions. 

Other elements depend on variables. At creation, besides defining their position, you need to specify the 

variable related to such element. To input the parameters directly, you can use the items “Edit Box” and 

“Combo Box”. The “Combo Box” is used when the variable has a predefined list of values. In our example, 

all variables that we input have lists of values; therefore, “Combo Box” should be used for them. 
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Some variable can have only two determined values. To work with these variables, it is convenient to use 

a “Yes/No” switch element. When creating such an element, you define the variable values for the cases 

when the switch is on and off. 

When specifying the text displayed on controls, it is possible to use variables. This will allow for changes 

in the text contents of the dialog according to selected bolt’s parameters. For example, in the dialog of 

our bolt, the text for one of the controls of the type “Static text” is set in the following way: “Bolt 

{$ispsp}М{dd}{$polesp}%%042{ll}{$klprsp}{$mmat}{$Pocrnom} GOST 7795-70”. 

 

Next, change the page size (this can be conveniently done by the command Customize > Page size) to 

make its size equal to the size of the dialog box. After that, start the editing mode of the control 

elements and define the order of the control elements. 

 

The order of the control elements determines their appearance in the dialog box and their activation 

order when using the <Tab> key. It is recommended to place static text first, followed by the control 

elements bound to the variables, in the order that provides easy switching between them. 
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ADDING AN ELEMENT TO L IBRARY  

The last step to be made is adding the element you've created to the library, and, if necessary, creating a 

new library. 

To add an element to an existing library, copy the created element to the folder on your hard disk, where 

other library bolts are stored. In this case, the element will automatically appear in the library after 

restarting the application. You can also create a new library. When doing this, carefully check every step, 

as in the following example. Suppose, you need to move a library to another file system, where the root 

folder name is D: rather than C:. If the full path was specified when adding the element to the library 

(“C:\…”), the application will not find the file, and therefore, you will not be able to insert the fragment 

using the library.  

To avoid this, use the relative rather than the full path when 

adding an element to a library. In this way, the path will be 

defined with respect to the configuration file that determines 

library contents. Besides, your created element should be 

placed “deeper” then the configuration file. 

Suppose, we are to create a new library for our newly created 

bolt. The folder of this drawing will be “C:\Program Files\T-FLEX 

Parametric CAD 15 \Libraries\My libraries\New”, while the 

configuration file will be located in the folder “C:\Program 

Files\T-FLEX Parametric CAD 15 \Libraries”. When creating the 

library, specify the relative path with respect to the 

configuration file rather than the full path: “New”. 
 

Now, we need to fit the drawing with the data necessary for supporting the BOM creation mechanism in 

T-FLEX. In Product structure window, select the group to include the part into. Define the name, 

material, weight and other parameters. Since the bolt name is supposed to change depending on its 

parameters, let's use variables for defining the name. The bolt name will be: Bolt{imp}М{d}*{ll} GOST 

7795-70. In the formatted BOM, the actual values will replace the variable notations {imp}, {d} and {ll}. The 

weight and material can be defined in the same way. 

Finally, we would like to mention that the described procedure is just a recommended technique, rather 

than a strictly determined sequence of actions. 



T-FLEX CAD Brief Introductory Course 

1098 

DOCUMENT PROTECTION IN T-FLEX CAD 

This command serves for setting limitations on working with T-FLEX CAD documents. The developer of a 

document or a set of documents (library) can set a protection on those by using this command, and 

modify parameters of this protection in the future as necessary.   

Working with protected documents requires the user to possess HASP protection key (the “plug”). The 

command has the capability of setting multiple protections on one document. Each protection requires 

selection of one of the protection types. The developer of the document can set different access rights 

to this document for different users. For this purpose, each protection has a set of access types (for 

editing, for opening, etc.). A protected document can have an unlimited number of protections, any of 

which can have its own set of access types, which allows using this document by different users with 

different access rights. For example, one protection would provide only the capability of opening and 

viewing the document, being set for all users, while another protection would provide the capability of 

full access, being set only for a particular HASP protection key ID. 

All information about the document protection is stored within the document.  

 

PROTE CTION PARAMETE RS  

Protection Types 

The following types of document protection can be set: 

 

Not using HASP Plug. This type of protection is set for any user. This type of protection allows, for 

example, setting the access only for “Preview” and “Edit variables”. Then, any user working with this 

will be able to open it view-only, without being capable of other actions, such as editing or copying 

the information. This is convenient if a developer intends to pass the document to the user solely for 

getting acquainted with the contents. In this case, the user is not required to possess HASP 

protection key, since previewing a document can be performed by the T-FLEX Viewer application that 

does not require a HASP protection key.  

Specific T-FLEX CAD HASP Plug or list of HASP Plugs. This type of protection is used in the cases when 

the developer knows in advance the IDs of protection keys for T-FLEX CAD users who will be working 

with the protected documents. Enter the IDs of the T-FLEX CAD protection keys in the document 

protection parameters. The access to the protected document will be granted on any computer with 

this particular T-FLEX CAD protection key installed. If using the network key, then the access can be 

gained on any computer on the network. 

Password with T-FLEX CAD HASP Plug. This type of protection is convenient if the developer does not 

know in advance the IDs of T-FLEX CAD protection keys of the users who will be working with the 
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protected document. This type of protection is generally used when distributing a document or 

library (a set of documents). By setting this type of protection on the document once, you do not 

have to change the document protection for each new user. After that, the user shall send his (her) T-

FLEX CAD protection key ID to the developer of the document. The developer uses the currently 

described command to generate a password based on the protection key ID, and passes it to the 

user. When accessing a protected document, the user must enter this password for gaining the 

access to the document.   

Another specific HASP Plug or list of HASP Plugs. A document protection can be set not only by T-FLEX 

CAD HASP protection key, but also by any other HASP protection key. This type of protection is 

similar to the type “Specific T-FLEX CAD HASP Plug or list of HASP Plugs”; however, in this case the 

developer needs to specify, among the parameters, a special password for the protection key in use, 

which shall be obtained from the manufacturer of this protection key. 

Password with another HASP Plug. This protection type is similar to the type “Password with T-FLEX 

CAD HASP Plug”, except that it can be set on any HASP protection key, provided that the specific 

password is known for accessing this protection key, as supplied by the key manufacturer. 

 

Access Types 

For each protection, its specific document access types can be set. The command supports the following 

Access types: 

Change access. This access type is set for the user who will be allowed to modify or delete protection 

types and access types of this protected document. Normally, this access type is set by the document 

developer for himself. 

Edit. The user with this access type can open, edit and save a given document. Editing access means full 

access except the ability to “Change access”. 

Preview. This access type implies permission for opening, previewing and printing a protected document. 

When opening such document in T-FLEX CAD, all commands that can modify it are blocked. 

View as fragment. A document permitted to this access type can be opened from an assembly 

document if it is used in this assembly as a fragment, a picture or an OLE object. 

 Edit variables. This access type permits editing document variables and regenerating the document with 

the set values. When setting this access type, additionally, the “Preview” and “View as fragment” 

access is granted automatically. 

Insert as Fragment. The document with this type of access granted can be inserted as a fragment, the 

chair or an OLE object into another document. If a document is assigned this access type, then the 

“View as fragment” access is assigned automatically as well. 
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WORKING WIT H “DOCUMENT PROTECTION ”  COMMAND  

The document protection command can be called by one of the following means: 

Icon Ribbon 

 
 → Document Protection 

Keyboard Textual Menu 

<AF> File > Document Protection 

Upon calling the command, a dialog will be displayed on the screen in which you can select one of the 

following actions: 

 

To modify document protection, do the following steps: 

1. By using the option Set or Modify Access Rights for Documents, protect the intended 

documents by the sets of access types. 

2. In the case of “By password”-type protection, the developer shall use the option Generate 

Password for Document or Library and generate the password for a user to access a document 

by the key ID received from the user. 

The option Get Current HASP Plug ID allows the user to check the key ID currently installed on his 

machine.  

Setting Access to Documents 

Upon selecting the option Set or Modify Access Rights for Documents, the dialog will be launched for 

selecting files subject to setting or modifying the access.   

Use the buttons [Add files…] and [Add Folder…] provided in the dialog for selecting the separate files or 

specifying a folder whose files will be added to the list.  

To set protection on files, their version must be the same as the current T-FLEX CAD version. The selected 

files will be added to the list. The icon before a file indicates its current state. 

 – Indicates the file in the format corresponding to the current version of T-FLEX CAD. In this case, the 

file will be protected successfully. 
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 – Indicates the file in the format of one of the previous versions of T-FLEX CAD. In this case, the file 

needs to be resaved in the current version. This can be done by the converter of the older versions of 

files. Without that, the file protection will not be set. 

 – The file is write-protected or used by another application. In this case, either clear the file attribute 

“Read-only” or close this file in the other application, respectively. After that, retry protecting the 

document. 

 

Node that in the cases when multiple documents (a library) need to be protected by the same 

password, preferably select all files of this library at once. This is because each newly created 

protection of the type “By password” is unique and requires generation and input of a unique 

password. 

Once you selected the desired files and pressed the button [Next], the dialog for modifying document 

access will appear. 

 

This dialog allows setting a new protection by the button [Add]. The button [Edit] serves for modifying 

the type of an existing protection. Upon pressing one of these buttons, a dialog will be displayed, 

offering selecting a protection type. 
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In this dialog, select a protection type and define its name. If the protection type “Another specific HASP 

Plug or list of HASP Plugs” or “Password with another HASP Plug” is being set, then for these types enter 

a special password for access to the HASP protection key in the “Password” and “Password 2” input 

boxes. This password is issued by the manufacturer of the HASP protection key. If this is a network key, 

then fill in the entry “Net HASP program number”. This information is also distributed by the 

manufacturer of the protection keys. 

When setting up document protection by key, it is possible to enter an alternative text password. This 

password may be needed in the case when the protection key with administrator’s privileges is lost (that 

is, the protection key with the access type “Change access”). 

Once the new protection is set, its name will be displayed in the list of protections in the “Change access 

rights for T-FLEX CAD documents” window. 
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For the created protection, define access types. Using the buttons [Add] or [Add Current HASP Plug ID], 

enter the key ID, if this type of protection relies on key protection. 

Let's review in details one of the ways of setting document protection. The diagrams above illustrate two 

protections set to a document. The first protection, named “Administrator”, has the type “Specific T-FLEX 

CAD HASP Plug or list of HASP Plugs”. The key ID was entered for it, and the “Change access” access type 

set. This means that the user working with the protection key ID 72815448, can change protection 

parameters of this document. The second protection, named “Bolt library”, has the type “Password with 

T-FLEX CAD HASP Plug”, with the access types set for modifying variables and inserting fragment. For the 

user to gain access to a document with this protection, the following steps are required: 

1. The user for whom this protection was set needs to send the ID of his T-FLEX CAD protection 

key to the developer. 

2. The developer shall generate the password based on the received protection key ID, by using 

the command “Generate Password for Document or Library” (see the description below) and 

send this password back to the user.  

3. When accessing the document, the user shall enter this password in order to gain the access. 

All protection settings can be saved in a file in a special format *.tfdat, using the button [Save settings...]. 

A protection can be loaded into document from a *.tfdat file, using the button [Load settings...]. This 

functionality may be helpful when one needs to add a document to an already protected library (a set of 

documents). To do this, one can save the protection parameters from a protected document, and then 

load those settings into the new document. 

Upon pressing the [Finish] button, the protection will be set on the selected files. 

 

Generating Password for Accessing Document or Library 

As was mentioned earlier, in the case of protecting a document by password with the protection key, the 

developer shall supply the password for accessing the document to the user, that was generated by the 

user's key ID. To do this, use the option “Generate Password for Document or Library”.  
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In this dialog, select a document that is already protected. After selecting the document, in the 

appropriate field enter the key ID, for which the document access password will be generated, and press 

the button [Generate Password]. Since a document might contain multiple protections simultaneously, 

the list of protections will be built, with an individual password generated for each of them. The button 

[Copy Password to Clipboard] copies the selected password to the clipboard. 

Getting ID of the Current T-FLEX CAD Protection Key 

If this option is selected in the “Document Protection T-FLEX CAD” dialog, the information will be read 

from the current protection key. The acquired ID can be passed to the developer of the protected 

document for generating the password. 

  

Working with Protected Document 

If a document was protected by a specific HASP protection key, then, when the user works with this 

document (opening, inserting as a fragment, etc.), the current user’s HASP Plug ID will be matched 

against the ID of the key set in the document protection parameters. In the case of matching IDs, this 

user will be allowed the access corresponding to the given protection. If the IDs do not match, the access 

to the document will be banned. 

If a document was protected by password with access key, then, when the user attempts to open the 

document, one will be prompted to enter password. 
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The user shall enter the password in this dialog, that he received from the document developer. (See 

“Generating password for access in document or Library”). 

Once the password is entered, it can be automatically saved in a special file DocAccess.ini, created into 

“Program” folder. When opening documents with this protection in the future, the password will be taken 

from the file DocAccess.ini. 

If the password is not known at the time of opening the document, one can set the option “Don't ask 

password for this Library or document”. Then, when using this document in the future, the password-

querying dialog will not be displayed, and the access protection will be set to “Not using HASP Plug” (if 

this protection type was set in the document). Otherwise, if the protection type “Not using HASP Plug” 

was not assigned to the document, the access to the document will be banned. 

When working with a protected document, the access is set that is the most of the allowed accesses. For 

example, if one protection grants document editing, and the other bans it, then editing document is 

considered allowed.  

Modifying Document Protection 
 

The procedure of modifying access to protected 

documents is similar to setting access to 

documents. First, by using the option “Set or 

Modify Access Rights for Documents”, select the 

protected documents or a folder with protected 

documents. In the list of files, select a file, from 

which the protection parameters will be read. If 

no such file is selected, then the protection 

parameters will be read from the first file in the 

list. 
 

Depending on what type of  “Change access” protection was used, the possibilities are as follows: 

1. If the protection type was “Specific HASP Plug or list of HASP Plugs”, then, upon matching Key 

IDs, the access for change will be granted. 

2. If the protection type was “Password with HASP Plug”, then, upon pressing the button “Next”, 

a dialog will appear, requesting the password for this protection. Upon entering the password, 

the access for changing the protection will be also granted.  
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Otherwise, if the hardware key is missing that was used at the time of 

setting this protection, or the password for accessing this protection 

was not entered, then you can press the button “Cancel”. In this case, 

an alternative access password will be asked. Upon entering the 

alternative password, the access to changing the protection will be 

granted. 

Next, a dialog will be displayed with the protection parameters set for 

the document. You can delete or change the parameters in this dialog. 
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SAVING TEXTUAL DRAWING INFORMATION 

While working with T-FLEX CAD, you can create text documents (files) containing various information 

about a drawing or a model: 

A system of drawing variables, with the respective values and defining expressions; 

A report on variable modifications, including those used in animation; 

Information about geometrical parameters of certain drawing elements; 

Assembly structure. 

The saved information about drawing parameters can be used for preparing accompanying 

documentation or as input data to other applications. 

SAVING INFORMATION AB OUT DRAWING VARIAB LES  TO F I LE  

One way to store drawing variables in an external file is by using the command WP: Save Model 

Parameters: 

 

Keyboard Textual menu Icon 

<WP>   

This command allows saving to an external file the values, expressions and comments for all or 

specifically external drawing elements, at user’s preference. The data is written using a specific format: 

LD = 110 /* 110 ; Part length: from 60 to 100 1 hole, from 100 to 110 2 */ 

$vt1 = "Bushing" /* LD>100?"Bushing":"" ;  */ 

HD = 50 /* 50 ; Height of machined part (20-60) */ 

UGL = 10 /* 10 ; Surface slope angle (0-10) */ 

lo = 27.5 /* LD<=100?LD/3:LD/4 ; Distance to hole (do-LD/2) */ 

do = 7 /* 7 ; Diameter of hole (3-15) */ 

l01 = 97.5 /* lo<LD/2?(lo+15+LD/2):(2*lo+15) ;  */ 

l1 = 131 /* l01>LD+21||LD>100?(LD+21):l01 ;  */ 

ld = 35 /* l01>LD+21||LD>100?(LD-l1+56):LD+20 ;  */ 

$vt2 = "Bushing 2" /* LD>100?"Bushing 2":"" ;  */ 

$vint = "Screw" /* LD>100?"Screw":"" ;  */ 

The information saved in this way can be used in other T-FLEX CAD documents via the command 

RP: Load Model Parameters: 

Keyboard Textual menu Icon 

<RP>   
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Working with the commands WP: Save Model Parameters and RP: Load Model Parameters is fully 

analogous to working with export/import commands of the variable editor, which is described in details 

in the chapter “Variables”. 

If you need to save information about values of the drawing variables in an arbitrary form, it might be 

more convenient to use the report creation mechanism. A report is a text document that is saved in an 

external file. A report can include an arbitrary text containing values of the drawing variables. The 

contents of the information saved in an external file is determined by the report template defined in the 

T-FLEX CAD document. The template text usually includes document variables. At the time of saving the 

report to a file, the actual values may be written instead of variables. A report can be saved by a user 

request, or a the time of saving the entire document. Multiple report templates can be created in a T-

FLEX CAD document. 

Reports can be created while running animation within the command “AN: Animate Model”. In this case, 

the report file will be appended at each animation step with the contents of the template filled with the 

variable values corresponding to the current step of the animation. 

Creating Report 

To handle reports, use the command REP: Create Report: 

Icon Ribbon 

 

Tools → Special Data → Report 

Keyboard Textual Menu 

<REP> Tools > Special Data > Report 

 

Upon entering the command, a dialog box appears for handling report templates. If the document 

already contains templates, one of those will be opened in the dialog window. If no template exists in the 

document, the dialog window will be empty. In this case, the only accessible button will be [New], 

allowing to create a new report template. 

Upon clicking the [New] button, a window appears, in which you need to specify the name of the 

template being created. The preset default offers the name “Report” with the respective enumerator 

suffix. 

Upon clicking [OK], an empty report template will be opened in the command’s dialog window. 
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The name of the opened template appears in the Name parameter. Using the same parameter, you can 

open another template by selecting its name from the list. The selected template name can be modified 

using the [Rename] button. 

Once a template is opened, you can view, define and edit its contents and properties.  

The contents of the report template is displayed in the preview pane located at the bottom part of the 

command’s dialog. It appears as plain text usually containing the document variables. The names of 

variables shall appear in the text within braces. The template contents can be edited directly in the 

preview pane, using context menu commands, or in a separate text editor window. To access the editor 

window, use the button [Edit…]. 

The Preview checkbox at the bottom of the command window allows viewing the report in the 

command’s dialog pane exactly as it will be written to a file (with or without substituting variable values, 

depending on property settings defined for the report template). 

The method of storing the report is described by the following group of parameters: 

Output Path. This parameter defines the file name for saving the report. The button  allows 

browsing for another file. 

Auto Save. With this flag set, the report will be automatically saved each time the drawing is saved. 

Substitute variables. Defines the method of writing variables to the report. When the parameter is 

set, the actual current values will be substituted for the variables in the text. When the parameter 

is turned off, the contents of the template will be written to the report files without replacing 

variable names by values. 
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To delete the current template from the document, use the button [Delete]. Upon clicking the button, 

you would need to confirm the deletion. 

A created template can be written to the report file right from the command dialog, by clicking [Save]. 

The following text will be written for the example shown on the figure: 

Parameters of the machined part for conductor: 

 

Part length: 90 

Part height: 50 

Number of holes: 1 

Hole diameter: 7 

Surface slope angle: 10 

Chamfer length: 5 

Example of Using Report for Unfolding the Clipped Cylinder 

As a simple example of using the report mechanism together with the command AN: Animate Model, 

consider the solution to the task of constructing a clipped cylinder unfolding. 

To create the unfolding, a line tilted with respect to the vertical is created at the cylinder’s end face. The 

line parameter (angle) is defined by the variable “alpha”. A horizontal line is constructed through the 

intersection point of the former line and the circle. A segment is constructed along the intersection line 

of the horizontal line and the side outline edge of the cylinder. Its length is read into the variable 

“Length” by means of the function “get”. 

 

 

Additionally, a report template was defined in the document for saving the values of the variables “alpha” 

and “Length”. After that, the entire drawing was animated by varying the value of the variable “alpha”. In 

the course of the animation, the variable values were output to the report. 
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Based on the generated report, a database was created in Excel, which was later used for creating a 

function in T-FLEX CAD defining the unfolding contour. 

Report (the 

file 

“Report0.rep”)  

0  81 

1  80.9957 

2  80.9826 

3  80.9609 

… 

179  24.0043 

180  24 
 

PROFILES  

When a part being designed is intended for further processing, which might involve use of CNC centers 

and creation of numerical control procedures, or for certain other purposes, then the information about 

the part profile geometry can be saved to a file. 
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A profile is defined in the commands that create and edit hatches. To designate a 

hatch as a profile, you would need to set the parameter Profile in the hatch properties 

dialog. If, at the same time, there is no need to fill inside of the profile contour with 

hatching, then you can designate it as an invisible hatch by selecting the filling method 

“Invisible”. 

 

Profile parameters are output to a file by the command PR: Write Profile: 

 

Icon Ribbon 

 

Tools → Special Data → Profile 

Keyboard Textual Menu 

<PR> Tools > Special Data > Profile 

 

After calling the command, select the hatch profile by clicking . If the drawing contains a single profile, 

then it will be selected automatically upon calling the command. The command parameters dialog 

window appears after selecting the profile. 

In this dialog window, first of all you need to select which profile parameters are to write to file: 

Properties. This saves information about the profile in one 

of the selected formats (AutoCAD DXF, AutoCAD DWG, 

Dragon, EIA); 

Geometry. This outputs on the screen or to a file the profile 

geometrical characteristics (area, perimeter, moments of 

inertia, etc.). 

The Output Path: parameter defines the name and the path to the 

file, in which the profile information will be saved. The file 

extension will be set automatically, based on the selected 

parameters and output format. To browse for the file, you can use 

the button . 

If the general profile properties are selected, then the parameter 

Output format allows selecting the desired file format from the 

list: 

 

AutoCAD DXF (*.dxf). The profile information will be written in the DXF format of AutoCAD 

system. 

AutoCAD DWG (*.dwg). The profile information will be written in the DWG format of AutoCAD 

system. 

DRAGON (*.drg). The profile information will be written in the DRAGON system format. 

EIA (*.eia). For this format, you can specify the format options by clicking the button [Options…].  
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The EIA format parameters dialog window will appear on the screen: 

Coordinate system. Defines the point, with respect 

to which the profile coordinates will be counted. You 

can select from the list: From (0,0), From contour 

beginning, Incremental. 

Code for clockwise circles. Sets the code for 

identifying arcs defined as clockwise. 

Code for counter-clockwise circles. Sets the code for 

identifying arcs defined as counter-clockwise. 

Number of leading digits. Sets the mandatory 

number of digits before the decimal point when 

writing numbers to a file. 

Precision. Sets the rounding precision for writing 

numbers to a file. 
 

Number of trailing digits. Sets the mandatory number of digits after the decimal point. 

Reverse direction. This lets you get coordinates of the profile in the direction opposite to the 

specified one. 

Use decimal point. This parameter is required for defining a fixed format without the decimal 

point. 

Upon clicking [OK], the profile information will written to the file in the selected format. 

Upon selecting “Geometry” option, the Geometry group of parameters becomes accessible. Then, you 

need to select the necessary geometrical characteristics of the profile: General characteristics or 

Moment about axis. Upon clicking [OK], the selected characteristics will be displayed in the dialog 

window. Additionally, if the Write to file flag is set, the characteristics will also be saved in an external file 

“*.pro”, defined by the parameter Output Path. 
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General characteristics include the following profile properties: 

Area and perimeter of the profile; 

X and Y of area center of the 

profile; 

Central inertia about X and Y; 

Inertia about (0,0); 

Principal moment of inertia X and 

Y; 

Principal inertia axis tilt X  the 

tilt of the principal axis of inertia 

with respect to the X axis; 

Minimum radius of inertia; 

Inertia moment of torque. 

 

 

When selecting a moment of inertia about an axis for examination, 

after clicking [OK] in the command’s parameters dialog, you need 

to additionally specify the straight line, about which the moment 

will be calculated. At that time, the following option will be 

available in the automenu:  
 

 <L>  Select Line 

After selecting the axis, the dialog window will display the calculated moment. 

ASSEMBLY DOCUMENT STRUCT URE  

The command SS: Save Model Structure allows building the structure of a T-FLEX CAD assembly 

document. The result can be viewed in the command's window or written to a text file “*.str”. 

The command is called as: 

Icon Ribbon 

 

Tools → Special Data → Structure 

Keyboard Textual Menu 

<SS> Tools > Special Data > Structure 

After calling the command, the dialog window appears on the screen for defining parameters of the 

structure building process. 
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First of all, one needs to select the method of 

displaying the resulting structure – in the 

command's dialog or in a separate text file. For 

this, set the appropriate option  either Show 

in Dialog or Write to File. 

If writing to file was selected, then you need to 

specify the following additional parameters: 

File name. This parameter specifies the 

file name and location, in which the 

document structure will be written. 

The button  allows browsing for 

an existing file to write to.  
 

Output Fragments of. This parameter allows selecting the nesting depth of the 

fragments included in the assembly structure – either only the fragments at the 

First level of nesting or the entire tree of fragments (All levels).  

Besides the assembly structure proper, additional information can be written to the file that 

relates to the enclosed fragments of the first level of nesting. Its availability and contents are 

determined by the state of the flags Output Fragment comments, Output fragment marked 

Variable values, Output fragment marked Variable comments. 

Upon defining all parameters, click the [OK] button to get the document structure. If outputting to a file, 

the system will write the results of the document structure analysis to the specified external file, and then 

exit the command. 

If in the dialog display mode, a window will appear that will contain the document structure. 
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This window displays the hierarchical document structure in the way of a tree of fragments, which can be 

browsed with the help of  or the <Up>, <Down> keys. The tips box above displays the information 

about the contents of the selected fragment. In the case of first nesting level of fragments, the external 

variable values are displayed in the pane on the right hand side. The not found fragments and the 

fragments that were opened with errors are displayed by the following icons:  for 2D fragments, and 

 for 3D fragments. 

The button [Open] opens the selected fragment document in a separate window. The button [Detail] 

opens the selected fragment in the detail mode (see the chapter “Creating assembly drawings. Using 

fragments”). 

To get done with the command, click the [OK] button in this window. 
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DRAWING TITLE BLOCK 

The drawing title block module is an application that can be 

launched from the command Customize > Applications. 

This application starts by default, as indicated by the 

availability of the Title Block textual menu item. 

The drawing title block commands are also available in the 

group “Title block” of the main toolbar.  

CREATING T ITLE  BLOCK  

To create a title block, use the command Insert Title Block: 

Icon Ribbon 

 

Title Block → Title Block → New  

Keyboard Textual Menu 

 
Title Block > Title Block > Insert 

 

After calling this command, a dialog window appears on the 

screen, which lists all types of title blocks provided with the 

system. You can manually add to this list the title blocks of 

your own design (see the section “Customize”). 

Select the title block type from the provided list, which you 

intend to apply to the drawing. After that, a window will 

appear for filling the title block. This window is a standard 

window for editing values of fragment external variables 

and will display by default the dialog created in the title 

block document using the interface control elements. Upon 

enabling the Variables List, flag this window is displayed as 

the external variables editor. 

 

Any field that has the  graphic button next to it can be filled using the list of values. You will be able to 

create and/or modify the list of values using the context menu commands. 
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When applying the title block, its fields Drawing Number and Title are automatically bound to the 

hidden variables of the current document. The same variables define the data for the BOM. Therefore, 

when inputting data in these fields of the format frame, the corresponding data is automatically entered 

in the BOM. 

 

Additional parameter Color sets the color of the title block lines and text. 

To edit the contents of the title block fields, use the command Edit Title Block: 

Icon Ribbon 

 

Title Block → Title Block → Edit 

Keyboard Textual Menu 

 
Title Block > Title Block > Edit 

You can reassign the title block type with the command Change Title Block Type: 

Icon Ribbon 

 

Title Block → Title Block → Change Type 

Keyboard Textual Menu 

 
Title Block > Title Block > Change Type 
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To modify the format frame position, use the command Move Title Block: 

Icon Ribbon 

 

Title Block → Title Block → Move 

Keyboard Textual Menu 

 
Title Block > Title Block > Move 

 

After calling this command, the title block starts rubberbanding on the 

screen. Point the cursor at the desired point in the 2D window and click 

 - the title block will be moved to the new position. 

You can change the title block type and move the title block by 

selecting the respective item in the context menu, which appears on 

right-clicking  the title block fragment. 

The title block can also be filled directly in the drawing. To do that, place 

the text cursor in the title block field, which needs to be filled, and click 

. A blinking cursor will appear in the selected field, indicating the 

readiness to input text, and a button with an arrow will appear next to 

the selected field, serving to select a value from the list. Initially, the list 

is empty (except for the fields in the “Date” column). If you need to fill in 

the list in order to have list values available in the future, then in the 

selected field enter the necessary text, and then select the “Add to List” 

item in the context menu. 

Since the title block is a drawing fragment, there is another way to apply 

it - by using the command FR: Create Fragment. 

 

Please note that, when inserting several title blocks into the current document (for example, for drawings 

located on different pages), the data from all title blocks will be bound to the same variables of the 

current document. As a result, the contents of the fields “Drawing Number” and “Title” of all title blocks 

will be same. As you edit fields in one title block, the text will be changing in all the rest of them. To 

disable this mode, you need to cancel the established relation with the hidden drawing variables, and 

then define the new field value. To do this, you need, regardless of the variable editing technique, call the 

context menu for the respective field. In the menu, clear the check in the “Insert Variable” item. After that, 

you can edit the text value in the current field. To relate this field with a new variable, call the same 

command again and define the name of the new variable in the upcoming “Insert Variable” window. 
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When editing the title block using the dialog for editing fragment external variables, you have another 

alternative. If you enable the “Variables List” flag in this dialog, then, instead of a dialog with interface 

control elements you'll see the standard list of the format frame fragment external variables. Find the 

“$Drawing_Number” and “$TITLE” variables in it (the fields “Drawing number” and “Title”), and replace 

their values with constants. 

In some cases, you may need to suppress automatic binding of title blocks variables with the 

variables of the current drawing. This may be needed, for example, when frequently creating 

documents containing several different drawings. In such a case, it is more convenient to edit the 

title blocks document itself, to have the automatic variable bindings suppressed on inserting it 

into the current document. To do this, open the format frame document, go into the variables 

editor and delete the contents of the “Assembly Variable Name” parameter from the above-listed 

variables. 

T ITLE  BLOCK F IT TING  

The commands below serve to define the size of the format of the drawing, and therefore the title block. 

Keyboard Textual Menu Icon 

 
“Title Block > Title Block Size > 

Standard”  

The command picks the format of the closest standard size. 

Keyboard Textual Menu Icon 

 
“Title Block > Title Block Size > 

By Drawing Limits”  

In this case, the format size is determined by the drawing dimensions in the 2D window. 

Keyboard Textual Menu Icon 

 
“Title Block > Title Block Size > 

By Current Window”  
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If this command is selected, then the format size will be determined by the dimensions of the current 2D 

window. 

In the latter two cases, the automatically calculated format height and width will be entered in the 

drawing status (the command ST: Set Document Parameters). The format itself will be assigned the 

“Custom” value. 

DRAWING NOTES  

You can enter the mode of creating drawing notes with the command Insert Drawing Notes: 

Icon Ribbon 

 Title Block → Technical Requirements → New 

Keyboard Textual Menu 

 
Title Block > Drawing Notes > Insert 

Upon calling this command, a pane is displayed on the screen, in which you can enter the drawing notes. 

The drawing notes are a paragraph text by default, therefore the automenu provides the same options as 

those available when working with paragraph text (see the chapter “Text”). It is possible to insert 

fragments of frequently used text from dictionary, and also use variables and their respective values (the 

option <F8> – Insert Variable tab). Note that if the “Transparent Text Editing” option is set (the ST: Set 

Document Parameters command, the View tab), then you can edit text and variable values by pointing 

the cursor to the text pane and clicking . 

Icon Ribbon 

 Title Block → Technical Requirements → Edit 

Keyboard Textual Menu 

 
Title Block > Drawing Notes > Edit 

The Edit Drawing Notes command serves to edit the contents of the drawing notes. 

Drawing notes location on a page, its format and initial contents are defined by the special hidden 

“Text” created preliminary in the title block. This Text is named “DrawingNotes” and created the 

way that its position and size are dependent on the position and size of the title block. 

Technical requirements for the document can also be specified without initial reference to a specific 

drawing. For example, they can be created in the document that contains only a 3D model, and then they 

can be used on the drawing. Such technical requirements constitute a formatted numbered text which is 

related to the entire document.  For example, it can be specified in the prototype. 

For specifying/editing technical requirements of the document the special command is used: 
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Icon Ribbon 

 Title Block → Technical Requirements → Drawing Notes 

Keyboard Textual Menu 

 
Title Block > Drawing Notes > Technical Requirements 

When invoking this command, the text editor window similar to the one used for creation of multi-line 

and paragraph texts is displayed on the screen.  

  

The list of technical requirements specified in this editor is stored inside the document as a multi-line 

text. If we invoke the Create technical requirements command later on, this text will automatically be 

inserted into the text of technical requirements of this command. The user can delete extra lines, which 

are not necessary for the given page, manually. 

Technical requirements created with the help of the command Formatting > Technical Requirements > 

Tech requirements of document… can also be inserted into the standard text (see the “Texts” chapter of 

this user’s manual).  

UNSET ROUGHNESS SYMB OL  

Icon Ribbon 

 

Title Block → Unspecified Roughness → New 

Keyboard Textual Menu 

 
Title Block > Unspecified Roughness > Insert 
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After calling this command, the roughness parameters window will appear (see the chapter “Roughness 

Symbols”). Once the parameters are defined, the roughness symbol will appear on the drawing. 

Icon Ribbon 

 

Title Block → Unspecified Roughness → Edit 

Keyboard Textual Menu 

 
Title Block > Unspecified Roughness > Properties 

This command serves to edit roughness properties. 

Position of the unspecified roughness symbol is defined by the special hidden “Roughness” 

element created inside the title block document. 

VARI ATIONS TABLE  

You need to create variations of detail/assembly to fill in a variation table. Variations are created in the 

FCE: Model configurations and variations command. 

More information about the command can be found in “Auxiliary tools for 3D assemblies 

modeling” chapter. 

Use the following command to create a variation table: 

Icon Ribbon 

 

Title Block → Variations Table → New 

Keyboard Textual Menu 

 
Title Block > Variations Table > Create 

Variations table window appears after calling the command. Model external variables, subtitles and a 

row of string sequence number that may be used as columns are located in the left part of the window. 

For this purpose you need to select variable and move it to the right part of the window using 

Drag’n’Drop. 

The variation table window is located to the right. It contains columns that will be used in variation table 

on the drawing. 
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You can change the order of columns. Move column header for this purpose. Two red arrows show 

where your column will be located. The column, moved from the left side of the window using 

Drag’n’Drop, can be arranged in the same way. 

 

You can change strings sequence. You need to select string and move it to a new position. 

 

Options for the variations table are located on the toolbar in the upper part of the window. 

 Insert row. The option adds empty string to the end of the list. 

 Update sequence number. The option updates sequence numbers in the “n/n” column. The option 

is used when strings are moved and sequence is broken. 

 Reset. The option cancels all changes and returns table to the original state. 

 Delete row. Deletes selected string from the list. 
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The table appears on the drawing after pressing [OK] button. You can move it using marker in the upper 

left corner. 

  

Further, you can manage the created table as a text document. 

Use the following command to run a variation table editor: 

Icon Ribbon 

 

Title Block → Variations Table → Edit 

Keyboard Textual Menu 

 
Title Block > Variations Table > Edit 

 

More information about working with text can be found in “Text” chapter. 

You can add a new column or make any other changes in the table using command: 

Icon Ribbon 

 

Title Block → Variations Table → Change 

Keyboard Textual Menu 

 
Title Block > Variations Table > Variations Table… 

 

After using the command, the Variation table window appears. 

All changes in the variation table existing on the drawing will be discarded after pressing [OK] 

button, and table will be updated. It is recommended to insert all changes in the Variation table 

window. 

UPDATING T ITLE  BLOCK  

While working on a drawing, you may need to modify some layout parameters, for example, move the 

title blocks into a new position. In such a case, the position of the applied drawing notes and unset 

roughness symbol will remain unchanged. To have such elements positioned according to the new title 

blocks position, there is the command: 
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Icon Ribbon 

 

Title Block → Options → Update 

Keyboard Textual Menu 

 
Title Block > Update 

 

When this command is called, a window appears, in which you can mark the layout elements that you 

need to update (Title Block, Drawing Notes, Unset Roughness Symbol). 

PARAMETE RS  

To set up layout parameters, there is the command: 

Icon Ribbon 

 

Title Block → Options→ Options 

Keyboard Textual Menu 

 
Title Block > Options 

 

After calling this command, a dialog window appears on the screen with two tabs. 

"Title Blocks" tab 

This tab contains the list of title block types used for layouts. You can edit this list using the buttons 

[Edit], [Add], [Delete]. The first two buttons call the same dialog window, only in the first case it is used 

for an existing type, and in the second - for a new one. 

Title. Specify the title block 

name in this entry, which will 

be entered in the list of title 

block types. 

File name. Specify the path to 

the format frame file in this 

item entry. 
 



Drawing Title Block 

1127 

The "Title Block Parameters" tab 
 

Serves to define the 

parameter values that will 

be displayed by default 

when filling in the title 

block. 
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MACROS 

T-FLEX CAD design process often involves performing various calculations. Some tasks can be handled 

by using the variable editor. However, the variable editor offers only limited calculation capabilities. For 

example, it does not support use of loops. This limits the scope of tasks that can be handled directly 

within T-FLEX CAD. 

Another design issue that users face is much time spent for performing repetitive tasks. For example, it 

might be necessary to create a set of layers in one drawing that is similar to a set of layers in another 

drawing, and distribute the objects of the former drawing on the newly created layers. Such a task 

requires certain concentration, especially considering that the number of layers in the document may be 

large. 

Such issues can be easily addressed with the help of «macros». 

GENERAL INFORMATION  

Macro in T-FLEX CAD is a program written in one of the programming languages, using T-FLEX CAD 

Open API functions. With the help of macros it is possible to automatize execution of various operations 

with documents of the T-FLEX CAD, reducing the number of the user-performed operations to minimum. 

A macro is executed as a single command, that is, by launching a macro once, the whole set of actions 

will be performed that are contained within the macro (calculations, handling of T-FLEX CAD objects, 

displaying results etc.). 

A detailed description of API functions can be found in the section Help “Help on Open API…”. 

Macros can be used for working with 2D drawing as well as with the elements of 3D model. Let us give 

one more example. When working on creation of three-dimensional assembly model, the user has to 

create slots and holes at the fastening location for assembling parts and insert fastener fragments with 

certain parameters. It is possible to reduce the number of user's operations by writing a special macro 

upon launching of which it will be sufficient to just select the LCS. The rest – creation of holes in a part, 

selection of required fastener set with certain parameters and the insertion of fastener into the assembly 

– will be done by the macro. In this case the large number of operations which the user had to execute 

manually is replaced by two operations only: launching a macro and selection of LCS. 
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Those are just a few examples where macros can be used. 

Macros are created and stored inside the T-FLEX CAD files with extension *.grb. From the point of view of 

programming, the file *.grb, inside of which the macros are created, is defined as a Project. Each Project 

may contain an unlimited number of macros. 

A special service window “Macros” is used for viewing available for execution macros and their launching. 

To make the macro available for usage and visible in the window “Macros”, the document containing the 

macro must be opened in the T-FLEX CAD. 

Storing a macro within a particular *.grb file does not imply that this macro can only be used in the given 

document. The user can launch any macro contained in the Projects presently open in the T-FLEX CAD 

(no matter which document is presently active in the T-FLEX CAD main window) 

It is possible to make the macros of some Project available for execution even without opening the 

Project's file in the T-FLEX CAD window. To make that possible, it suffices to place the Project's file in a 

special folder “…T-FLEX CAD/Program/Macros/”. The macros of the files located in this folder are 

accessible all the time. 
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By default the folder “…T-FLEX CAD/Program/Macros/” contains only standard macros included in 

the package. The user can create one's own macros library by placing the files from Projects with 

macros to the folder «/Program/Macros/». 

«MACROS»  W INDOW  

By default, the service window for working with macros – the window “Macros” – is not shown in the 

T-FLEX CAD window. It can be made visible with the help of the following command: 

Icon Ribbon 

 

View → Window → Tool Windows → Macros 

Keyboard Textual Menu 

<Alt><5> Customize > Tool Windows> Macros 
 

This window can be also invoked from the context menu by clicking  

in the zone of toolbars of the T-FLEX CAD window. 

The main purpose of the window “Macros” – display of the macros 

available for execution. For launching a macro it is required to select it 

in the window and double-click  . 

The icon preceding the macro marks its current state: 

 – Nonactive macro; 

 – A selected macro; 

 – A running macro. 

 

The user can launch any macro displayed in this window. For example, the project “Macros Examples.grb” 

is located in the folder “/Program/Macros/”. The macro “Export2DPicture” of this project exports the 

image of the active 2D page of the current document as an internal picture to the new T-FLEX CAD 

document. When launching this macro, the dialog for saving the file will be invoked. After indicating the 

name, a new document containing an internal picture is automatically created and opened in the T-FLEX 

CAD window. The new document will contain an internal picture whose image duplicates the contents of 

the active 2D page of the source document. 

Launching a macro can be carried out automatically as well when working with the user-defined 

dialog (if this operation is defined for the control element “Button”). Moreover, to launch a macro, 

the user can define a special user-defined command and add it to the text menu or the toolbar. 

This option is described in more detail in the chapters “Controls. Creating User-Defined Dialogs” 

and “Customizing System” (Section “Adding User-Defined Commands”). 

The standard macros included in the T-FLEX CAD package have a simple structure which does not make 

use of namespaces. In the window “Macros” they are displayed as a list of macros of each Project. The 

Projects with more sophisticated hierarchy can be displayed as a multilevel structure of the namespace 
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(the folders with the icon ), classes (the folders with the icon ) and macros contained in these classes 

. 

 

MACRO EDITOR  

Window of Macro Editor 

A special Macro editor is provided for creating macros. It is a macro development environment 

integrated in T-FLEX, which contains the full set of editing and debugging tools. Writing a macro does 

not require any application or programming environment. All tools are packed within the Macro editor. 

The macro editor can be opened by the command: 

 

Keyboard Textual Menu Icon 

<WM> Tools > Macro Editor  
 

 

The Macro Editor works with the main T-FLEX CAD window synchronously. That is, when the 

window of Macro Editor is open, the user can execute various operations in the window of the 

T-FLEX CAD application itself (for example open/close documents). 

The figure below depicts the main tools of the macro editor. 
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The text menu “View” allows the user to control the display of the service 

windows and toolbars of the Macro Editor. 

The placement of all service window s of the Macro Editor can be 

customized in the same way as it is done for service windows of the 

T-FLEX CAD main window. In particular, it is possible to “attach” the 

service windows to the edges of the main window, make them “popup” 

or put them into the “floating” mode. To save the working space of the 

screen, several windows can be combined into a single group window. 

The service windows which are not used can be turned off. 

Projects accessible for editing are shown in the window “Projects”. These 

are the files opened in the T-FLEX CAD window, and also the documents  

 

contained in the folder “…/Program/Macros”. With the help of this window, the user can view the 

structure of the Projects and also perform various operations with their elements (create modules/forms, 

open them for editing, etc.). 
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The window “Projects” of the Macro Editor and service window “Macros” are synchronized. Closing 

a Project (document) file in T-FLEX CAD also makes it close in the «Projects» window of the macro 

editor. Similarly, a macro that has been created and made executable in the Macro editor 

consequently appears in the «Macros» window of T-FLEX CAD. 

Creating/editing the codes of modules and the contents of the forms of the Project is performed in the 

“working” window of the Macro Editor. This is the main window of the Macro Editor. The code of each 

module or form of the Project is opened in a separate window. For switching between the windows of 

modules and forms it is possible to use the tabs of these windows located in the upper part of the main 

window of the Macro Editor. The windows of codes can be combined into vertical or horizontal groups. 

The windows “Properties” and “Tools” are required for creating/editing graphical forms of Projects. The 

windows “Break Points” and “Output data” are used during compilation and debugging of the created 

module. 

Managing Projects. Project Structure 

The window “Projects” in the Macro Editor is used for managing Projects. When opening the Macro 

Editor, this window shows all currently accessible Projects. These include all documents opened in the 

current T-FLEX CAD application, and also Projects stored in the special folder “…T-FLEX 

CAD/Program/Macros/”. It is possible to work on several Projects synchronously. 

Each Project is displayed as a hierarchical structure which includes the sets of modules, forms and 

references. 
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A so-called modular programming approach is used when writing macros in T-FLEX CAD 

environment. Modular programming is the way of structuring a program as a union of small 

independent blocks, called modules, whose structure and behavior are governed by certain rules.  

Module is a program unit which includes various components (types, constants, variables, namespaces, 

classes, procedures and functions). From the point of view of program code, the macro is a procedure – a 

part of the program used for executing a separate, specific task. 

Form is the dialog box of a macro, within which control elements can be placed (such as text, buttons, 

text input boxes, radio groups etc.), used for operating the macro. More details on working with this 

window will be revealed in the topic «Creating macros with screen forms» of this chapter. 

References are required for accessing properties, methods and events of a particular object and for using 

this object while programming a macro. For example, to use T-FLEX CAD commands in a Project, you 

would need to reference TFlexAPI.dll. At the time of creating a new project, main references are already 

added to it for using system's objects and also data and objects of the T-FLEX CAD. 

The Project can contain any number of modules, forms and references. In turn, each module of the 

Project can include any number of macros. 

To avoid problems associated with repetitions of names of the 

macros in the complex Projects, the namespaces can be used. 

For any object of the Project's tree (Project, folder of modules or 

a separate module, form, reference), the context menu with a 

collection of special commands is available. These commands 

allow the user to rename a selected Project, add a new module 

or a form into it, etc. Some of these commands can be also 

invoked from the text menu “Project” and from the toolbar 

“Project”. 

 

 

Creating Project. Project Properties 

To create a new Project, open a new document in the T-FLEX CAD. In the window “Projects” in the Macro 

Editor a new Project will appear automatically. The structure of this Project will contain only references.  

The programming language C# is used by default for any new Project. If it is desired to use another 

programming language, it should be specified right after creating a new Project. The change of 
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programming language after creation of modules and forms leads to throwing into the discard of already 

existing modules and forms. In this situation it will be required to remove all modules and forms of the 

Project, and then create them again. 

 

The programming language of the Project (macro) is indicated in the dialog of Project properties: 

Keyboard Textual Menu Icon 

<WM> Project > Properties…  
 

The dialog of Project properties can be also invoked from the context menu of the Project in the 

window “Projects”. 
 

After calling this command, a dialog appears with the properties 

of current Project. The Project name is displayed in the “Project” 

box of the dialog. The field “Document” displays the name of the 

T-FLEX CAD file that contains the current Project. 

The “Language” combo box provides selection of the 

programming language, which will be used in the current Project. 

Currently, the polling programming languages are available for 

selection: Visual Basic, C#.  

An additional parameter Debug Method is used only in the mode of debugging a macro. If the debug 

mode is not used, this method does not have to be selected. 

To specify a method to be debugged, it is required to press the button [Edit…]. As a result, the dialog 

with the list of methods of the current project will be invoked. Manipulation with this dialog is described 

in the section “Debugging Macro”. 

Creating Modules. Window of Module's Code 

After selecting a Project's programming language, the user can start creating required modules and 

forms. 

Creating a new module in the Project is simple. For that, it is sufficient to place a cursor on the title 

“Modules” in the Project's tree (window “Projects”), click  and select the command “Add” from the 

appeared context menu. You can also call the command from the text menu or from the toolbar “Project” 

of the Macro Editor: 

Keyboard Textual Menu Icon 

- Project > Add Module  

As a result, in the main window of the Macro Editor a new window with the code of the module will 

appear. In this window, a part of the code will be created automatically; references, namespace, class and 

procedure will be declared. 
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To create a simple macro, it is sufficient to write one procedure and compile a Project. 

 

Note that, by default, the new Project contains only standard references to four libraries. If, in the macro, 

you use the library the reference to which does not exist in the standard list, you must add it to the list of 

references independently. To do that, use the command: 

 

Keyboard Textual Menu Icon 

- Project > Add Reference  

This command can be also invoked from the context menu of the window “Projects”. To do that, select 

the section “References” in the tree of the current Project and click . The command Add can be found in 

the appeared context menu. 

 

Managing Windows of Modules' Code 

The code of each module of the Project is displayed in a separate window. 

The tabs located in the upper part of the main window are used for 

switching between the modules' windows. The windows of the code can be 

combined into vertical or horizontal groups. 

The commands of the text menu “Window” are used for managing the 

modules' windows. 
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Settings of Code Editor 

The window of modules' code is a text editor with the standard text editing 

capabilities (“Copy”, “Paste”, etc.). Commands for working with the text can 

be invoked from the context menu, the toolbar “Standard” and from the 

text menu “Edit”. In addition to that, in the dialog of main window settings, 

you can define specific settings of the code editor: automatic line 

numbering, automatic creation of indents, highlighting various syntax 

entities of the code with different color, etc. 

 

Settings of module's code editor are specified with the help of the command: 

Keyboard Textual Menu Icon 

- View > Editor Options… - 

When this command is invoked, the window of code editor settings is opened. 

The following parameters are specified on the tab 

“Editor”: 

Group of parameters Window Settings: 

Vertical scrollbar and Horizontal scrollbar. 

These parameters control the view of the 

scrollbars in the windows of code; 

Line Number. Parameter controlling the 

display of line numbers in the code; 

Selection Margin. This parameter controls 

the view of the margins of the assigned 

bookmarks and breakpoints at the left side 

of the windows of code; 

Collapsible Nodes. This parameter 

shows\hides nodes that allow collapsing 

code sections. 
 

Auto indentation. If this parameter is checked, each newly created line of the code will have the 

same indent as the previous line; 
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Virtual space. When this parameter is turned on, the cursor can be moved to any place in the 

code's window. When this parameter is turned off, the cursor is located within the boundaries 

of the existing text; 

Syntax Colorization. Parameter allows highlighting various syntax structures of the code with 

different colors. Color palette is specified on the tab “Syntax Colors” of the given dialog; 

Parameter Tabs/Tabs size sets the length of tab symbols used for creating automatic indentation 

of lines of code. The width of the space symbol serves as a unit of length; 

Group of parameters Overwrite Caret defines the view of the cursor in the text replacement 

mode. 

The last parameter of the given tab – Automatic reload of externally modified files – is used in 

cases when the document of the Project is open simultaneously in several applications of the T-

FLEX CAD. When this flag is checked, the Project will be automatically synchronized in all 

applications.  

Two other tabs of the dialog of settings – tab “Editor Font” and tab “Syntax Color” – define font 

parameters used for displaying the code and parameters of color highlighting of various syntax 

structures of the code. 

Using Bookmarks 
To make the work with the large code more convenient, in the window of the code editor it is possible to 

define bookmarks on specific lines of the code. The bookmarks allow the user to quickly move inside the 

code's window from one marked line of the code to another. 

To add a bookmark it is required to place a cursor at the required line of the code and call the command 

Toggle Bookmark: 

Keyboard Textual Menu Icon 

<Ctrl><F2> 
Edit > Bookmarks > Toggle 

Bookmark  

After invoking this command, in the code's window a bookmark  will appear to the left of the chosen 

line (if, in the code's window, the margin of bookmarks is activated). 
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After “placement” of bookmarks it will become possible to quickly move across the module's text with 

the help of the following commands: 

Keyboard Textual Menu Icon 

<F2> 
«Edit > Bookmarks > Next 

Bookmark»  

<Shift><F2> 
«Edit > Bookmarks > Prev 

Bookmark»  

The active bookmark (i.e., the bookmark located on the line of cursor's present position) is highlighted 

with the color – . 

To delete the bookmark, call twice the command Toggle Bookmark for the marked line of the code. 

Example of Macro 1 

As an example, let us create a macro which will automatically build a construction line – a circle and a 

text string attached to a node of this circle. 

To accomplish that, create a new 2D document in the T-FLEX CAD. In the Macro Editor select its Project 

in the Project's tree (window «Project Tree”) and create a new module inside the Project. In the window 

of module's code insert the following text: 

 

// Declaring references 

using System; 

using TFlex; 

using TFlex.Model; 

using TFlex.Model.Model2D; 

 

// Declaring class 

    public class NewMacroClass 

    { 



T-FLEX CAD Brief Introductory Course 

1140 

// Declaring procedure (macro name) 

    public static void CreateText() 

    { 

// Creating document object – the currently active document 

        Document document = TFlex.Application.ActiveDocument; 

// Opening block of document changes 

        document.BeginChanges("Creating text"); 

// Creating text object– string text 

        LineText text = new LineText(document); 

// Creating free nodes in the document, with the coordinates (150,100) and (150,140) 

        FreeNode node1 = new FreeNode(document,150,100); 

        FreeNode node2 = new FreeNode(document,150,140); 

// Creating circle by the center and a point to pass through 

        CircleConstruction circle = new CircleConstruction(document); 

        circle.SetCenterAndNode(node1,node2); 

// Defining object text parameters 

        text = new LineText(document); 

        FontStyle style = text.FontStyle; 

        style.FontName = "Arial"; 

        style.Bold = true; 

        style.Italic = true; 

        text.Color = 1; 

        text.Node = node2; 

        text.Circle = circle; 

        text.TextValue = "Text on circle"; 

        text.HorizontalAlignment = TextHorizontalAlignment.Center; 

// Closing block of document changes 

        document.EndChanges(); 

     } 

   } 

Once the code of the macro is written, you need to compile the Project. 

DEBUGGING,  COMPIL ING AND RUNNING MACROS  

Compiling Project 

To start compilation, use the following option: 

 <Ctrl><F7> Compile 

Project compilation is a required action before executing the macro. When compiling, the system 

analyzes the macro code and finds errors. Messages about found errors are shown in the window 

“Output data”. 

Compilation errors occur when the system fails to interpret the input text. Those errors could be due to 

incorrect syntax of an instruction or due to specifying an incorrect method or property. 
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«Output» Window 

The «Output» window is located at the bottom of the macro editor. It serves for displaying messages 

about the current state of the Project. Errors and warnings resulting from Project compilation are 

displayed in this window. 

 

An error message displayed in this window contains information about the error location in the code 

window (line and column number) and the error number. 

To jump to an error location in the code window, you can either double-click  or call the command Go 

To Error from the context menu accessible by right clicking . 

The error type and information about the error can be found in the Microsoft Developer Network 

(MSDN) application development guide by the code displayed within the error message in the «Output» 

window. 

 

Upon a successful project compilation, the macro will be added into T-FLEX CAD “Macros” window and 

can be executed thereafter. 

The figure below depicts the result of running the macro that creates a construction circle and a text 

string wrapped on the circle. The code of this macro was shown above as part of the module's code 

window description. 
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Debugging Macro. Breakpoints 

If, after executing a macro, it is evident that it does not work correctly, it is possible to use the macro 

debug mode to find the errors in the code. 

In the debug mode the macro is compiled (if necessary) and then launched for execution with the 

possibility of stopping at the intermediate points - breakpoints. At the moment of the stop the user can 

check the current state of the objects of macro with the help of the command “Evaluate expression”. 

Specifying Breakpoints 
To create break points use the command Toggle Breakpoint: 

Keyboard Textual Menu Icon 

<F9> Debug > Breakpoint  

A breakpoint is placed on the line of the code containing the cursor at the moment of starting the 

command. That is, to create a breakpoint the user has to place the cursor on the line of the code before 

which the execution of macro must be discontinued and press <F9> (or call the command in a different 

way). To the left of the selected line of the code, in the margin region, a symbol of the breakpoint –  

will appear; the line itself will be highlighted with a color. To create one more breakpoint, place the 

cursor on the next line and call again the command Toggle Breakpoint, etc. 

The list of all selected breakpoints is shown in the window “Breakpoints”. 
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To delete a breakpoint, it is sufficient to place the cursor on the line with the breakpoint and call twice 

the command – Toggle Breakpoint. 

Starting Debug Mode 
The user can start the mode of debugging a macro with the help of the following command: 

Keyboard Textual Menu Icon 

<F5> Debug > Start Debug  

Since the module can contain several macros (procedures), the user will need to specify in advance which 

procedure must be launched. To accomplish that, in the command “Project properties” (before the start 

of the debug mode) select the default method (macro). 

If the default method is not specified in advance, after starting the debug mode, the dialog “Macros” 

prompting the user to select the method (macro) to be debugged will appear on the screen. The method 

can be selected either from the displayed list of methods of the current project or entered manually after 
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pressing the button [Set Manually]. When the button is pressed, the dialog “Set Macro” is opened in 

which the user will need to specify the namespace, class and name of the procedure that will be 

launched. 

        

After selection of the method, it will be launched. If, before the launch of the method, the code of the 

module was modified, the system will prompt the user to recompile the project when the command 

“Start Debug” is activated. 

Working in Debug Mode 

After the start, the execution of macro reaches the first breakpoint in the code and stops. Execution of 

macro is passed to the macro editor at the line with the code located before the breakpoint. The main 

window of the T-FLEX CAD becomes inactive. At this moment, you can call the command “Quick Watch”: 

Keyboard Textual Menu Icon 

<Ctrl><Alt> 

<Q> 
Debug > Quick Watch  

This command allows you to check the value of any object during the stop of macro. The object can be 

both of the system type (string, integer, real, etc.), and user-defined type. 

      



Macros 

1145 

The user can resume the execution of macro (until the next breakpoint) by calling twice the command 

“Start Debug”. For complete execution of macro, this command must be called as many times as the 

number of breakpoints created in the code. 

 

For quick execution of the macro (without stops at breakpoints) use the command Stop Debug: 

 

Keyboard Textual Menu Icon 

- Debug > Stop Debug  

CREATING MACROS WITH SCREEN FORMS  

In certain situations, the user needs to be able to input certain element parameters in the dialog while 

running a macro. To realize this capability, the macro editor supports creation of screen forms that can 

contain controls. Follows below is the overview of the macro editor tools supporting creation of macros 

with screen forms. 

 

Creating Form 

To create a form in the current Project, use the command: 

 

Keyboard Textual Menu Icon 

- Project > Add Form  

This command can be also invoked from the window «Project Tree”. For that, place the cursor on the title 

of the section “Forms” in the tree of the current Project and click . In the opened context menu select 

the command Add.  

 

After the new form is added to the Project, in the main window of the macro editor the window of the 

new form will be opened automatically. It contains a blank template of the form ready to be filled with 

controls. Title of the window includes a name of the form with the clarification in brackets – “(Design)”. 

In addition, along with the window of the form, the service windows “Properties” and “Tools” are 

automatically opened. 
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When adding a form to the Project, two new references: “Systems.Windows.Form” and 

“Systems.Drawing” are automatically added to the list of references. 

«Tools» Window 

The window “Tools” is opened automatically when the new form is 

created. You can invoke the window “Tools” independently from the 

text menu of the macro editor: View > Tools. 

The “Tools” window contains a set of control elements that can be 

placed on a form. The elements appear in this window only when 

the form is active. Otherwise, the window will be empty. 

 

«Properties» Window 

The window can be called via the textual menu of the macro editor: View > Properties. It serves for 

viewing and specifying properties and events (methods) of a form and elements placed on the form. This 

window remains empty until a form or an element located on the form is selected. 

Control element properties are the parameters defining an object's characteristics (name, color, position 

etc.). 



Macros 

1147 

Events of control element are the actions performed over the object of a control element, such as 

clicking a «Button» control element. While a program (macro) is running, a control element event gets 

bound to executing certain commands. For example, the event of clicking a «Button» control element can 

be bound to creating a T-FLEX CAD object.  

The upper part of the «Properties» window contains the list with form elements. To view and modify 

properties of a form element, select it in the list or select the element on the screen form itself by . 

The «Properties» window works in one of the two modes: 

If the «Properties» option  is active on the window toolbar, then the window will be displaying 

element properties. 

If the «Events» option  is active, then the window displays events. 

The «Properties» window is divided into two parts. The left column displays the names of the object 

properties. The right column displays property values. 

If the window is in the mode of showing events, then the right hand side column of the window displays 

the events attainable for the given element type. The left-hand side column shows the names of the 

functions that are currently used for the given element and event. 

The buttons  and  allow sorting the list of object properties alphabetically and by categories, 

respectively. 

 

 

 
 

List  
of objects 

Property 
values 

Property  

description 

Event  
description 

 

Names of 

procedures 
for handling 

events 

Event 

names Names of 

the object 
properties 
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For some properties, you can specify only strictly defined 

values. In such a case, the value input field will be 

represented by a combo box; when accessed, this combo 

box displays the property values available for selection. 

  

Placing Control Elements on Form. Specifying Parameters of Control Elements 

To place control elements on a form, you need to 

complete the following steps: 

 

Select the form to which you need to add a control. 

Select the desired element in the “Tools” window. 

 

Next, you can choose any of two options. The first 

option – click  on any point of the form. After that, a 

selected control element of standard size will be 

added to the form. Then, you can move the control to 

the desired place on the form and modify its 

dimensions. 

 

 

The second option – by clicking twice  indicate location of opposite angles on the diagonal of the 

rectangle of control element. In this way, the location and dimensions of the control are defined right 

away. 

 

The user can also specify parameters of the controls placed on the form with the help of the window 

“Properties”. The user can select the element to be edited directly in this window (in the drop down list at 

the top) or in the form with the help of . After selection of the element in the window “Properties”, 

parameters of the element will be displayed. 
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If necessary, you can view automatically generated code of creation of form's graphic image. This can be 

done with the help of the command View Design (Code) found in the context menu of the given form in 

the window «Project Tree”. The window with the form's design code is also opened in the main window 

of the macro editor. The header of the window includes the name of the form with the clarification in 

brackets – “(Design)”. 

 

The name of the window with the form's design code coincides with the name of the window of 

form. They have different icons:  – for the window of form,  – for the window of the form's 

design code. 

After placing all necessary elements of the form, you can start creating the code of the form. 

 

Writing Procedures for Control Elements on Forms 

After placing control elements on forms, you need to bind those elements to the executable code. 

The code of the form is created in a separate window similar to the window of module's code. The 

header of the window includes the name of the form with the clarification in brackets – “(Code)”. 
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The user can invoke this window in two ways: 

In the “Projects Tree” window, call the command “Open Code” from the context menu of the selected 

form. Doing so opens the window containing executable code for the form, so that you can add 

procedures for processing control element events in this form. 

Call the command “Open Code” from the context menu available for any control element of the form. 

    

Double-click  the control element on the form. This brings up a window and automatically creates a 

procedure there for processing the driving method of the respective element. Default events are defined 

for each control element. 

You can switch between the form window and the code window either by the context menu commands 

of this form (“Open Design”, “Open Code”), or with the help of the respective tabs located above the 

code window. 

The window of the form's code, as the windows of the modules' code, is a text editor. By default, the 

window of the form's code contains only one procedure of form initialization. 

The form's code usually consists of form initialization procedure (it is created automatically when you 

open the window of the form's code for the first time) and procedures for handling events of control 

elements of the form. 

To create a procedure of handling the event for an object of the form, the user needs to select a required 

element, activate the mode “Events” for the window “Properties”, select a desired event in the list and 

double click . A blank procedure of handling the event for the given element of the form will be 

automatically added to the window of the code. The body of the procedure is blank, it is filled by the 

user. 

For some control elements you can also use double clicking  on the element of the form. After that, 

the procedure of handling the main event of the given control element is added to the form's code. 

Example of Macro with Screen Form 

Let’s review an example of a macro written in the Visual Basic programming language. Executing the 

macro creates a segment between two 2D nodes. Coordinates of those nodes are entered via a dialog. 

Initially, a form “LineForm” was created in the Project “CreateLine.grb”, and then controls were placed on 

it, which will be used for defining 2D nodes coordinates. Another control element was added to the form 
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– a button, clicking which would launch the function creating the 2D nodes and the segment between 

them. 

 

 

 

Upon placing control elements on the form, one needs to define processing of the event of clicking the 

control element – the button. To do this, select that element on the form, switch to the “Properties” 

window and set the latter window into the event mode . In the right hand side column of the “Click” 

event, press , which will create the procedure “button1_Click”. The same result could be achieved by 

double-clicking  the control element – the button. 
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In the coming up form code window, one needs to write the procedure “button1_Click”. 

The figure below depicts the form code window containing the function “button1_Click”, in which the 

variables “X1”, “Y1”, “X2” and “Y2” are assigned values from control elements – the textBox1, textBox2, 

textBox3 and textBox4 input boxes, and “CreateLine” function (macro) is called. 

 



Macros 

1153 

Next, create a module in the Project. The module's code will consists of two functions. The function 

“ShowDialog” (a standard function of the development environment) will be displaying the screen form 

upon launching the macro. The previously defined function “CreateLine” creates 2D nodes, whose 

coordinates are the values specified by the user via the “FormLine” form dialog, and the segment 

between those nodes. The module’s source code is shown below.  

 

Declaring references 

Imports System 

Imports TFlex 

Imports TFlex.Model 

Imports TFlex.Model.Model2D 

 

‘Declaring namespace 

  Namespace NewMacroNamespace 

 

‘Declaring class 

  Public Class NewMacroClass 

 

‘The function, which will display the screen form «form» when executed 

    Public Shared Sub ShowDialog() 

       Dim form As Form1Namespace.LineForm 

       form = new Form1Namespace.LineForm() 

       form.ShowDialog() 

    End Sub 

 

‘The function with parameters (the macro), which creates a graphic line between two 2D 

‘nodes. Coordinates of those nodes are input in the function as the dialog parameters 

    Public Shared Sub CreateLine(ByVal NodeX1 As String, ByVal NodeY1 As String, ByVal 

                                              NodeX2 As String, ByVal NodeY2 As String) 

       Dim document As Document 

       document = TFlex.Application.ActiveDocument 

‘Opening block of documents changes 

       document.BeginChanges("Creating graphic lines ") 

 

‘Creating graphic line and 2D free node objects 

       Dim line As ConstructionOutline  

       Dim node1 As FreeNode 

       Dim node2 As FreeNode 

       Dim X_1, Y_1, X_2, Y_2 As Double 
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       X_1 = System.Convert.ToDouble(NodeX1) 

       Y_1 = System.Convert.ToDouble(NodeY1) 

       X_2 = System.Convert.ToDouble(NodeX2) 

       Y_2 = System.Convert.ToDouble(NodeY2) 

 

‘Creating 2D free nodes 

       node1 = new FreeNode(document,new Parameter(X_1),new Parameter(Y_1 ))  

       node2 = new FreeNode(document,new Parameter(X_2),new Parameter(Y_2 ))  

‘Creating graphic line between two nodes 

       line = new ConstructionOutline(document,node1,node2) 

‘Closing block of document changes 

       document.EndChanges() 

    End Sub 

  End Class 

  End Namespace 

When the macro is executed in T-FLEX CAD, the “LineForm” dialog appears. Upon clicking the control 

element – the “OK” button, a segment will be created between the two nodes in the drawing area. 
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HANDLING EVENTS OF  DOCUMENTS WITH THE HELP OF MACROS  

Macros can be executed not only from commands of the user but also upon the start of some event of 

the document. To define relation of the events of the document with the macros you can use the dialog 

of the command “Message Handlers…”: 

Keyboard Textual Menu Icon 

- Project > Message Handlers…  

When calling this command, the dialog “Message Handlers” is opened. In this dialog there are events the 

start of which can be related to the execution of macro: 

Closing Document – event arising before closing document; 

Document Full Regenerated – event arising after document regeneration; 

 

Document Open – event arising after opening document; 

Document Saved – event arising after saving document; 

Dynamic Analysis Simulation After Step – event arising after executing a step in solution of the 

dynamic analysis problem; 

Dynamic Analysis Simulation Before Step – event arising before executing a step in solution of 

the dynamic analysis problem; 

Dynamic Analysis Simulation Finished – event arising after completing solution of the dynamic 

analysis problem; 

Dynamic Analysis Simulation Started – event arising after starting solution of the dynamic 

analysis problem; 

New Document Created – event arising after creation of new document; 

Saving Document – event arising before saving document; 

View Activated – event arising after activating 2D or 3D window of the document; 
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View Deactivated – event arising after deactivating the image of document. 

To specify the handler of some event, the user needs to select the desired event in the list and press the 

button [Set] or double click . The dialog with the list of macros of the given document will appear on 

the screen. 

STARTING MACRO FROM USE R-DEFINED D IALOG  

As it was mentioned earlier, the macro can be launched 

from the window “Macros”, from the macro editor in the 

debug mode or automatically upon the start of some 

event of the document. However, there is one more way 

to launch a macro. It can be done from the user-defined 

dialog of the document if the function of launching the 

macro is appointed to the control element “Button”. 

 

More detailed information on actions of control element “Button” can be found in chapter 

“Controls. Creating user-defined dialogs”. 
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CONVERTING DOCUMENTS CREATED IN EARLIER 

VERSIONS OF T-FLEX CAD 

The newer versions of T-FLEX CAD use different data format than the older ones. If this is the case when 

opening an old file in a newer version, full model regeneration is recommended for saving information in 

a new format. 

When working with assemblies, saving just the assembly document is not enough. In this case, you need 

to subsequently open and resave in the current T-FLEX CAD version all model documents, starting with 

“bottom most” fragments and finishing with the top level assembly document. This task might be 

possible to do manually for a small model. However, it becomes quite difficult for very large assemblies 

with deep fragment nesting. 

The “Old version documents converter” helps solve this problem. This command saves the whole active 

assembly in the format of the current T-FLEX CAD version. When converting, the whole model structure is 

analyzed. Conversion is performed according to the fragments hierarchy: the bottom level fragments are 

opened and regenerated first, then the next level is handled, and so on up to the top assembly 

document. The user can manually add any T-FLEX CAD documents to the list of files subject to the 

conversion. Those files will also be converted according to their hierarchy. 

A report file is created as the conversion progresses, reflecting on the performed tasks (warnings, 

information messages, errors). The original files can be saved as backup copies. 

USING THE APPLICATION “OLD VE RSION DOCUMENTS CONVE RTER”  

Startup of Documents Converter 

The converter is called just like any other system command: 

Icon Ribbon 

 

 → Document Converter 

Keyboard Textual Menu 

<AC> File > Document Converter 

After calling this command, the converter window will appear on the screen. It is divided into 3 areas: 

- Area with the list of files (upper left); 

- Area with the service information and buttons (upper right); 

- Area of diagnostics and display of messages about the progress on the conversion process (the 

lower part of window). 
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Specifying List of Converted Documents 

The list of files selected for conversion is shown in the upper left field of the converter dialog. By default, 

the list of files is empty. 

If some documents were open in T-FLEX CAD at the time of calling the command, 

the system will prompt you for closing them (this is required for successful 

converter operation) and will automatically add them to the list of files to be 

converted. If necessary, the user can remove some files from the list and/or add 

other T-FLEX CAD documents to the list. 

To add files to the list, the buttons  (“Add files”) and  (“Add folder”) found 

on the toolbar of the converter can be used. These commands can be also called 

from the textual menu. 

 

The first button allows adding separate documents to the list, while the second one – all T-FLEX CAD 

documents in the selected folder. If the selected folder has subfolders, the system will ask you, whether 

to add those to the list. 

To delete a file from the list, select it in the list and press the button  (“Delete Files from List”) or the 

button <Del>. To complete creation of the file list for conversion, press the graphic button [Next>]. 

In the progress of conversion, the system may automatically decide to add to the conversion list the 

necessary fragment files of the assemblies being converted, upon analyzing the structure of the model to 
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be converted. This behavior can be controlled by a conversion parameter (see section “Customization of 

Converter”). 

Performing Conversion 

After forming the list of converted files, press the button [Next>] in the right part of the converter 

window. After pressing this button, the contents of the upper left area of the converter window will be 

modified. The list of the converted files will be replaced by the list of the T-FLEX CAD libraries. At this 

stage, a user has to indicate the elements of which libraries should be subject to transformation, if they 

are found in the structure of the converted documents. The libraries the elements of which can be 

converted are marked with a “tick” in the list of the libraries (to mark it, point with the cursor at the 

symbol  next to the name of the library and press ). 

 

Parameters shown at this step in the right part of the converter window duplicate parameters in the 

conversion options dialog (see section “Customization of Converter”). 

After specifying libraries the elements of which can be modified upon conversion, press the button 

[Next>] again to proceed to the next step. 

To return to the step of selecting documents (for example, if you need to modify the list of selected files), 

use the graphic button [<Back]. 

At the next step, the structure of relations of converted files will be shown in the upper left area of the 

converter window. If necessary, additional files are added to the list, that correspond to the fragments of 

the assemblies being converted. 
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To start regeneration of selected files, press the button [Next>] again. 

The step of library selection and viewing the document connections structure can 

be skipped, if for proceeding to the next step of the conversion process, a user 

does not press the button [Next>], but rather calls the command  (Preview) 

and  (Convert) found on the toolbar or in the textual menu of the converter. In 

this case, for the library elements the default settings will be used (by default, 

conversion is allowed only for user-defined libraries; standard libraries supplied 

with the system are not converted). 
 

In the process of regeneration of selected files, the information on the progress and results of the 

converter actions will be displayed in the lower part of the converter window, whereas in the upper left 

area a user can view again the list of the files being converted in which the current state of working with 

each file is shown. 
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After completing the file transformation, in the lower part of the converter window, the message about 

the process completion and indicating the number of occurred errors will be displayed. 

To close the application press the graphic button [Exit]. 

Customization of Converter 

Dialog of options of the conversion process can be invoked with the help of the button  on the 

toolbar of the converter or from the textual menu Options > Options…. 
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The group of parameters When Error 

Occurred defines the system response on the 

occurrence of errors during regeneration or 

saving of the documents: 

Stop – stop the conversion; 

Save – saved the document despite 

the errors; 

Do Not Save – do not save a 

document if errors occurred during its 

regeneration; 

Ask – display a dialog box with the 

error message and ask the user about 

further actions. 

The group of parameters Backup Copy allows 

turning on the mode of creating backup 

copies of all the files with the specified 

extension. 

 

The group of parameters Log is provided for controlling the information displayed in the lower part 

of the converter window and in the protocol file. 

The flag Save Log allows saving the information about the conversion process in the protocol file. 

The name and the path of the protocol file can be specified to the right of this flag. If this flag is 

disabled, the protocol file is not saved. 

The parameters Output List of Documents with Errors and Output List of not found Fragments 

control the output of certain information into the log. 

The group Multithreading has only one parameter Number of Treads Limit:. It allows a user to 

limit the maximum number of simultaneously started processes upon the conversion. 

Upon conversion, the T-FLEX starts several processes in which simultaneous regeneration of not 

depending on each other files takes place (if they do not have relationship parent/child in the 

assembly). While doing it, by default, to achieve the maximum effectiveness, the number of 

started processes is equal to the number of processors on the computer (this allows engaging all 

resources of the computer). This parameter allows put a limit on the number of processes and the 

computer resources used by the processes. 

Don’t Check Documents Versions (Resave All). If not set, the documents in the up to date version 

of T-FLEX CAD format will not be converted (except the assemblies, whose fragments were 

converted). If set, all files will be converted, regardless of the format. 

The following group of parameters is used only when converting documents containing 3D models: 
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Use geometry search. With this parameter turned on, if errors occur during the model element 

regeneration (for example, an error regenerating a 3D node created at a body vertex, or an error 

regenerating an edge or face blend), the geometry search procedure is launched, that allows 

restoring the lost geometry references. 

Use of the mode “Use geometry search” is strongly recommended with the files of the versions 

earlier then 7.2. However, in some rare cases, use of this procedure may result in establishing 

incorrect references within the model. 

Use geometry search on projections. This parameter turns on handling of the regeneration errors 

that occur in the elements based on 2D projection lines. The error handling procedure restores 

references of these elements. 

Regenerate drawing projections. With this parameter set, all 2D projections are regenerated 

regardless of the projection parameter setting “Update”. Regeneration of projections and 

sections of complex models may take considerable time, therefore it should be unchecked if 

desired. 

Update BOMs. This parameter controls recalculation of all BOMs of the document and also 

updating tables of databases. By default it is disabled. 

Recalculate All Model Configurations. If this parameter is set, then the configurations present in 

the document being converted are resaved when converted. This parameter has higher priority 

than the respective parameter in the document being converted (command ST: Set Document 

Parameters tab Save parameter Model Configuration Regeneration on Save item don’t 

regenerate model onfigurations. 

To return to the step of selecting documents for conversion (for example, if you need to modify the list 

of selected files), use the graphic button [<Back]. Pressing the button [Finish] launches the process of 

the document conversion. 

The application analyzes the structure of the specified files and creates a tree of dependencies for the 

documents. If necessary, additional files are added to the list, that correspond to the fragments of the 

assemblies being converted. 

Thereafter, the files are converted according to the determined hierarchy. As the file conversion 

progresses, the log is displayed in the application window, reflecting on the accomplished tasks. Upon 

the completion of the file conversion, the message is displayed in the application window about 

finalizing the process, showing the number of the encountered errors. To close the application, once 

again press the graphic button [Finish]. 

RECOMMENDED ORDER OF STEPS W HEN CONVE RTING MODELS 

FROM OLDE R VERSIONS OF T-FLEX  CAD 

To insure successful conversion of the models from earlier T-FLEX CAD versions into the current version 

format, the following order of steps is recommended: 
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1. Make sure that the full model regeneration completes without errors in the previous T-FLEX 

CAD version, while opening the assembly – without messages about not found fragment files. 

2. Make a backup copy of the assembly.  

3. Start the converter with default settings (the modes “Use geometry search”, “Regenerate 

drawing projections” and “Use geometry search on projections” turned on).  

4. If problems were encountered during the step 3, such as not found model elements – not 

found edges, faces, etc., or the conversion took too long time, then you may want to restart 

the converter with the unset flags “Use geometry search on projections” and “Use geometry 

search”. 

5. When converting crowded drawings of extra-large assemblies on the computers with limited 

performance resources, an out of memory error may occur. In this case, you can try to 

convert the model with the drawing projection regeneration turned off (postponing this to a 

later manual handling). 

6. When converting crowded drawings of extra-large assemblies on the computers with limited 

performance resources, an out of memory error may occur. In this case, you can try to 

convert the model with the drawing projection regeneration turned off (postponing this to a 

later manual handling). 
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